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Introduction to Xara Designer Pro X
Welcome to Xara Designer Pro X
Xara Designer Pro X is a powerful and easy to use graphics and document creation tool,
able to produce everything from top quality web graphics and websites to highly detailed
illustrations and multi-page documents for print and PDF output.
If you're working with photos, then Designer Pro can handle everything from a simple
one-click auto-enhance of your photo to impressive digital photo compositions. If you're
creating a website, then Designer Pro can help you produce everything you need, from
simple buttons and landing pages to complete websites. If your task includes drawing
then this is a great tool for everything from simple logos to cartoons and astonishingly
detailed illustrations. And since Designer Pro is equally at home with drawing, photos
and text it is the perfect solution for design work from cards and invitations to posters,
adverts and multi-page brochures.

Getting Help

Getting Help
Support
If you can’t find the answer in this guide, we highly recommend viewing the Designer
movie tutorials http://www.xara.com/movies/. It is the ideal way to get to know Xara
Designer Pro X and get an overview of its features, allowing you to make the most of the
program.
Here are some other sources of information and help from Xara and the Xara community
that may be of use:
 Program help - Choose "Xara Designer Pro X Help" from the "Help" menu to open
Xara Designer Pro X Help (containing hundreds of pages of information).
 Status bar - Try reading the text on the status bar at the bottom of the main Xara
Designer Pro X window. It always describes what actions are currently possible and
what they will do (even during drags), and helps you learn to use the Xara Designer
Pro X tools. It also gives details of what buttons and controls do as you move the
pointer over them. See Status Bar (on page 36) for more details.
 Tooltips - If you hold the mouse pointer over a button or control for a short while, then
a short message appears telling you what it does.
 Menus - If you want to know what a menu item does, highlight it and press "F1".
 Dialog boxes - If you want to know what a dialog box does or how to use it, click HELP .
 Movies - Use the menu option "HELP " > "MOVIES " or click here
http://www.xara.com/movies/ to view a list of available movies.
 The TalkGraphics forums - Post your question in the popular, dedicated Xara forums
at TalkGraphics.com (
 .talkgraphics.com), where you can ask other Xara Designer Pro X users for advice or
suggestions – available 24x7. You can share tips and ideas, ask questions or offer
solutions to other users.

MAGIX Support
Dear MAGIX customer,
Our aim is to provide convenient, fast and solution-focused support at all times. To this
end, we offer a wide range of services:
 Unlimited web support:
As a registered MAGIX customer, you have unlimited access to web support offered
via the convenient MAGIX service portal on http://support.magix.net, including an
intelligent help assistant, high-quality FAQs, patches and user reports that are
constantly updated.
The only requirement is that you have registered your product.
 The online community - on-the-spot support and a platform for exchange:
MAGIX customers have free and unlimited access to the online community at
www.magix.info, which includes approx. 120,000 members and offers the opportunity
to ask members questions concerning MAGIX products as well as use the search
function to search for specific topics or answers. In addition to questions & answers,
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the knowledge pool includes a glossary, video tutorials and a discussion forum. The
multiple experts, found round-the-clock on www.magix.info guarantee quick answers,
which sometimes come within minutes of a question being posted.
 Email support for MAGIX products:
For every new MAGIX product you will receive, as of date purchase, 12 months of
email based customer service.
Please note: To be able to use the Premium email support and free product email
support via the Internet, you have to register your MAGIX product using the serial
number provided. This can be found in your purchase confirmation email, or on the DVD
case or box.
 Additional telephone service:
Besides the large number of free customer service offers, we also offer a fee-based
telephone customer service available to customers that have purchased from Magix.
Here you can find a summary of our technical support telephone numbers:
http://support.magix.net http://support.magix.net/
Mail (Europe): MAGIX Development Support, P.O. Box 20 09 14, 01194 Dresden,
Germany
Mail (North America): MAGIX Customer Service, 1105 Terminal Way #202, Reno, NV
89502, USA
Please make sure you have the following information at hand:
 Program version
 Configuration details (operating system, processor, memory, hard drive, etc.), sound
card configuration (type, driver)
 Information regarding other audio software installed
MAGIX Sales Department
You can reach the MAGIX Sales Department workdays for help with the following
questions and problems:





Orders
Product consulting (pre-purchase)
Upgrade requests
Returns

Europe
Monday - Friday, 09:00-16:00 GMT

Getting Help
U.K.: 0203 3189218
Denmark: 699 18149
Sweden: 0852500858
Finland: 09 31581630
Norway: 0210 30665

North America
9 am to 4 pm EST Mon-Fri
Phone: 1-305-722-5810

Document info
> DOCUMENT INFO" displays information about the selected document such as its
size and any fonts or plug-ins used. This is a good way to find out if you are missing a
required font or plug-in that could prevent the document from displaying correctly.
"FILE

Anything you type into the comment field is stored as part of the file. This comment is
displayed whenever you display the document info dialog box.

About Xara Designer Pro X
Choose "HELP" > "ABOUT XARA DESIGNER PRO X" . This displays general information about
the program. If you contact the support, you may be asked for this information.

Designer Pro terminology
This section describes some of the terminology used in Designer Pro.

Document
You can think of a document in Designer Pro as you would a conventional sheet of
paper. Like a sheet of paper, you can draw lines and curves on it, place objects like
shapes, clipart and photos and write and erase text. You can save the document for later
use, or print it, or export it for the web, or for a variety of other uses.

Page
This is the white area in the document. You can place objects on the page margin, on the
page, or overlapping both. However, only objects on the page are printed. A document
can contain one or several single pages or double page spreads. A double page is like
two separate sheets of paper placed next to each other.
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Lines, shapes, and objects
A line can be straight, curved or a mixture
of both. A line must have a start and an
end, thus it is always open. You can apply
a thickness and color to a line.

These are all lines

These are all shapes

A shape is a solid or closed object. The
difference between a line and a shape is
that a shape has no start or end. Because
a shape is a closed object, you can fill it
with a color or leave it empty with no color.
You can apply a thickness and color to the
line around the shape.
Object is a general term. This manual uses
it to describe lines, shapes, bitmaps,
photos and text.

These are all objects

Many operations in Designer Pro apply equally to a single object or a collection or group
of objects. "Object" can refer both to one object and to several objects.
In postscript terminology, a shape is a closed path. Designer Pro sometimes uses
"shape" as shorthand for "line or shape".

Attributes
The various characteristics that describe the look of objects on the page, such as color,
line width, fill style etc are all called ATTRIBUTES of the object.
The Attributes of objects can be copied and pasted between different objects using the
Paste Attributes (on page 104) menu command. See Current Attributes (on page 102) for
more information.

Bars
There are three types of bars: the MAIN TOOLBAR , the INFOBAR, and then various other
button bars which are sometimes just referred to as control bars, e.g. the GALLERY button
bar.

Getting Started

Getting Started
This section gives an overview of the main functionality of Designer Pro. Later sections
go into more detail about each tool.

Program Layout
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Info Bar - changes with each tool
Zoom
Designs Gallery
Page & Layer Gallery
Selector Tool
Mask Tools
Photo Tools
Eraser Tool
Drawing Tools
Text Tool
Shadow Tool
Color Line
Tabs for all open documents - icon identifies document type.
Web Toolbar
Note: By default Designer Pro opens a new document showing just one page. To view all
the pages in your document, right click a page and choose MULTIPLE PAGE VIEW . You can
now scroll the Designer Pro window up and down to view all the pages in the document.
Note: All Designer Pro InfoBars now have improved text rendering for easier viewing, if
you have ClearType text enabled in your Windows Control Panel.

Zooming / Scrolling / Pushing your page
These common operations are made very easy:
 To Zoom in or out, hold Ctrl and use the mouse-wheel
 To push the page, press your mouse-wheel and push (yes it's a button as well)
 To scroll use the mouse-wheel (or the scroll bars of course)

Getting Started
Web documents are
displayed in single page
mode by default and print
documents in multi-page
view mode. Switch
between display modes by
right clicking on the page
or pasteboard and
selecting or deselecting
MULTIPLE PAGE VIEW from
the drop-down menu. An
example of multiple page
view is shown to the left.
You can drag and drop
items between pages.
When you make
document-wide Theme
color changes, you can
see how the changes
affect all pages.

The current page is marked with 4 corner brackets.

In this example you can see some items have been placed on the pasteboard area
beside the pages. When exporting to most export formats, off-page objects are not
included. The pasteboard area is useful as a place to keep temporary or working
graphics, photos or other objects.

Object Based Design
All the types of elements are collectively referred to as objects.
One of the unique benefits of Designer Pro is that you have complete freedom to place
any object anywhere on the page, and your document or website will faithfully reproduce
this.
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The SELECTOR TOOL can be used to select any object on the page, and to move
(just drag it), resize and rotate the objects.
You can adjust the stacking order (that is whether an object appears in front or behind
others on the page) using the ARRANGE menu options or right click and choose ARRANGE .
With the SELECTOR TOOL you can resize objects by dragging on the corner resize
handles. You can rotate any object by dragging just inside the corner selection handles.
Use the Text Tool to edit text and add new text. To add some text to your
document, select the TEXT TOOL and click anywhere on the page and start
typing.
You can also create text columns, by clicking and dragging horizontally in the Text Tool,
or text boxes by dragging diagonally. See the Text section below for more details and the
Chapter Text Handling (on page 209) for a complete reference of text functions of Xara
Designer Pro X
You can use the drawing tools to create rectangles, rounded
rectangles, circles and ellipses, and just about any shape you like
using the SHAPE TOOL . See the Drawing tools (on page 127) section
for more detail.

Layers
All items can be placed into named layers. Each layer can have any number of objects,
and has the ability to be turned on or off. When the layer is turned off all objects on that
layer become invisible.
The PAGE & LAYER GALLERY allows you to easily see and adjust the stacking order of
objects and layers. Objects are listed in order from front to back in the gallery. See Page
& Layer Gallery (on page 181) for details.
The layers are controlled from the
the right of the workspace.

PAGE & LAYER GALLERY

on the Galleries bar to

In website documents, layers are used to provide mouseover (sometimes called rollover)
features on your website. These include highlighting buttons (they highlight when you
move the mouse over them) and also other pop-up effects. See the Web Graphics
chapter of the help for full details.

Stacking Order
All objects on the page are placed one on top of another. The most recently drawn or
created object is always on top, that is, in front of any others. You can adjust the stacking
position by right clicking and choosing ARRANGE or using the ARRANGE menu options.
For example, when you draw a new rectangle it always appears to cover all the objects
behind it. By right clicking and choosing ARRANGE or pressing "Ctrl + B" (or the menu

Getting Started
"ARRANGE " > "PUT TO BACK ") the object is moved behind everything else. Similarly "Ctrl +
F" brings any selected object to the top, that is, in front of everything else.

These objects are stacked over each other.

All objects are collected into named layers, and each layer can be turned on or off to
show or hide everything on that layer.

Drawing Tools

Designer Pro provides all the graphics tools you need to create just about any graphical
object on your page, as well as a range of pre-designed graphical elements in the Online
Content Catalog and the Local Designs Gallery. There are several basic drawing tools
that let you create rectangles, ellipses, regular polygons stars or any shape you like.
Designer Pro provides vector drawing tools, which means you can resize, edit the outline
shape and re-color with no loss of quality. You can zoom in to see almost infinite detail,
and all edits can be undone. For details on drawing rectangles/squares, circles/ellipses
and other shapes, see Drawing Lines and Shapes (on page 127) and Shape Handling
(on page 152).
The SHAPE TOOL allows you to create detailed vector based shapes, and also
to edit the outline of any shape.
Refer to the section THE SHAPE TOOL to learn how to use this very powerful tool.
The STRAIGHT LINE & ARROW TOOL adds arrow heads and tails to any type of
line as well as drawing single lines. See the STRAIGHT LINE AND ARROW TOOL
for more information.
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The FREEHAND & BRUSH TOOL allows you to draw freehand as you would with
a pencil as well as creating brush strokes. See the FREEHAND & BRUSH TOOL
(ON PAGE 127) for more information.
The SHAPE PAINTER TOOL allows you to ‘paint’ with a ‘nib’ to extend an existing
shape or draw a new one. The strokes you draw with this tool are merged on
the fly to form filled shapes. See the SHAPE PAINTER TOOL (on page 132) for
more information.

Fill Tool
You can easily put a graduated color fill onto a shape using this tool
(and a lot more besides). Select the tool and just drag across your
object.
The fill arrow can be adjusted by dragging the ends to alter the direction, angle and
extent of the graduation.

Rounded rectangle with a graduated fill.

Transparency Tool

You can adjust the transparency of any graphic or photo to make it see-through. More
than this, Designer Pro supports graduated transparency. It works very like the
graduated color fill. In the Transparency tool just drag across your shape and you can
see the transparency fades. You can adjust the degree of transparency of each end of
the fill arrow, by clicking on either end of the arrow, and adjusting the Transparency
slider. See Transparency for more information.

Getting Started
Feather
This is a graphical term for blending the edges of objects. Designer Pro provides a
feather control that enables any object, graphics, text or photo to be feathered - giving
it a blurred edge that blends with the background. The Feather control is not a tool on the
left, but one of the controls on the top bar. See Feathering (on page 175) for more
information.

Shadow Tool
A very popular graphics effect is to create a soft drop-shadow under a graphic or some
text. This serves to lift the object away from the background.
The SHADOW TOOL lets you add a soft shadow to any object, text, graphics or
photo. Select the SHADOW TOOL and just drag on the object. You can adjust the
shadow blur and transparency using InfoBar controls.

Some text with a soft shadow.

To adjust the position of an existing shadow, go into the
shadow.

SHADOW TOOL

and drag on the

Example Graphics

This button combines many of the features described above - it's drawn by combining
just a few feathered shapes, and using graduated transparency (the white reflection
effect). The text has a slight soft shadow and the button has a glow shadow. The whole
thing is grouped. (You do not need to draw this button as it's provided in the Button
category of the ONLINE CONTENT CATALOG ).
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The huge benefit of vector graphics, compared to 'bitmap' graphics created in pixel
editing software, is that you can re-color, edit, rotate, and resize the button with no loss of
quality. Make it huge and it remains pin sharp:

On top of that you can re-color easily, Just select, click a color and choose the color you
want to replace from the list shown in the Color Replacement dialog that appears. And it
will even stretch as required - everything in Designer Pro remains non-destructive (which
means you can always edit it, with no loss of quality).

Something that would take skill and time to produce using alternative graphics software,
is trivially easy in Designer Pro.

Right-click context menus
When you right-click any object in the Xara Designer Pro X workspace, a drop-down
context menu lists useful operations that are relevant to the object clicked on. For
example, if you right-click a rectangle you've drawn previously, the drop-down menu
allows you to perform actions only relevant to a rectangle.
If you right-click a photo, however, some of the menu options that appear apply only to
photos, while others are similar to the actions you can perform on a rectangle. The
object-specific operations are listed towards the top of the right-click menu's list, e.g., in
the case of a rectangle the first three actions above apply only to rectangles.
You can also right click both the page and pasteboard to see a menu of page and
pasteboard background-related operations you can apply.
If you select more than one object and right-click, the menu lists actions specific to
multiple objects, such as group, align and combine, as well as the common operations
such as cut, copy and delete. Similarly if you right-click objects that you have previously
grouped, actions specific to a group are displayed.
It's recommended that you right-click any object or multiple objects in the workspace to
access the context menu specific to those objects. Once you've done this a few times
you will know which actions you can quickly perform with right-click menus.
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Using Templates & Clipart
Open the LOCAL DESIGNS GALLERY by clicking the Local Designs Gallery tab in
the Galleries bar or the ONLINE CONTENT CATALOG using "FILE" > "NEW FROM
CONTENT CATALOG" ).
These show folders containing collections of template designs, Smart Shapes, clipart and
web widgets. Some templates are intended for printing (photo albums, calendars,
newsletters, etc.), others for web use and most of the graphical clipart designs can be
used in any type of document.

The Online Content Catalog
The Online Content Catalog is essentially a "cloud" companion to the LOCAL DESIGNS
GALLERY (on page 27). That is to say, all the content is stored online and as such
requires you to be connected to the internet before you can import items to the Local
Designs Gallery. The catalog contains Designer Pro's full library of Stock photos,
SmartShapes, symbols, design templates, widgets and vector art, and provides an easy
and intuitive way to search all of the content.
When you import a piece of content from the Content Catalog it is downloaded to your
PC and remains available when you are offline as part of the Local Designs gallery.
To open the Content Catalog
 Click "FILE" > "NEW FROM CONTENT CATALOG" (Shift+Ctrl+Alt+K)
 Click "INSERT" > "FROM CONTENT CATALOG" (Shift+Alt+I)

The Online Content Catalog

The catalog is a resizable window - drag the edges or lower right corner to resize. You
can enter a keyword to search either all or individual categories, or else traverse the
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content categories on the left. A small pop-up preview appears as you traverse the
categories - click to select and that category is expanded and shown on the right side.
For categories that have many items there is a page control at the top right, allowing you
to flick to the next and previous pages of content.
Import an item either with a double click or by clicking the IMPORT button that appears as
you mouse-over the item. After the import, the catalog closes. If you want the catalog to
remain open after an import hold down the Shift key as you click.
An enhanced Online Content Catalog is included free for one year as part of our new
Update Service. It now offers: Regular updates to the templates as part of the Update Service
 Full keyword search of the entire catalog
 A new more logical structure to the content offering a better work flow
When using the free trial version, items shown in blue in the left content list are free to
use during the trial period. All items shown in grey are available instantly for free once
you've purchased and unlocked the program.

Stock Photos
One of the categories you will see on the left is STOCK PHOTOS . These are provided by an
external company called Pixabay and so the first time you import one of these photos
you will be asked to read and accept Pixabay’s Terms & Conditions. But you only need to
do this once on each computer you use, then you can import as many photos as you like.
The photos are released under a Creative Commons CC0 license and are totally royalty
free. You can use the images for personal or commercial use with almost no limitation.
There are thousands of photos available - just select STOCK PHOTOS on the left and then
enter keywords in the search field at the top to find them. Alternatively you can replace
an existing photo by right-clicking it in your document, and then choosing "REPLACE
PHOTO" > "WITH STOCK PHOTO" from the context menu.
When you import a stock photo into a print document you get the photo’s full resolution
into your design. The resolution of photos varies, but most are much higher than HD
resolution. When you import into a web document, as when importing local photos, the
resolution is still limited to HD because it’s rare to need any higher resolution than this for
a website.

Stock Illustrations
In addition to the STOCK PHOTOS , there is also a category of vector graphic STOCK
ILLUSTRATIONS . All the images have keywords so you can easily search for the graphic
you want. Because the original vector files vary enormously in size, graphics larger than
around 300px are scaled down. Also un-grouped images are placed in a group for ease
of manipulation. Because this is vector clipart, it’s re-sizable to any size without loss of
quality.

Getting Started
The Local Designs Gallery
This gallery is a local offline repository of content imported from the ONLINE CONTENT
CATALOG . As the name implies, this now shows only content that you have present
locally on your device, either because it was installed with the program using the optional
backup CD, or was downloaded from the CONTENT CATALOG . This makes it easier to find
and access designs you use regularly.
To open this gallery:
 Click the LOCAL DESIGNS GALLERY tab on the Galleries bar.
 Or choose "UTILITIES" > "GALLERIES" > "DESIGNS GALLERY" .

The top level folders are divided into four main categories.
 First Look
 Components
 Websites
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 Print
 Presentations
Add more content by browsing through the folders and clicking on + MORE ONLINE... This
will open the relevant folder category in the ONLINE CONTENT CATALOG for you to browse
and import content to the LOCAL DESIGNS GALLERY. The folder structure in the LOCAL
DESIGNS GALLERY mirrors that of the ONLINE CONTENT CATALOG and each folder in the
gallery has a link allowing you to jump straight into the corresponding folder in the
CONTENT CATALOG , so you can easily view what other content is available for download
into that folder. Whenever you open or import a design file from the Catalog, that file then
appears in the Gallery and so you can use it even when offline. The freshly imported item
is also opened in your current document as well.
You can download a whole category, so it's available offline, by right clicking on the
category name in the Gallery, and selecting the DOWNLOAD ALL option. The Gallery tab
informs you of the update status.
To open a template or piece of content from the Gallery as a new document double-click
on it. To import it into your current open document, drag it and drop it into your design.
Page templates are added as new pages to your current document when you do this.
Other templates and widgets are dropped onto your current page.
See Document Handling (on page 32) for more information on using galleries generally.

Photos
You can replace any photo by dragging and dropping it from your File Explorer onto any
photo in Designer Pro. If you drop it onto the background then it is imported and placed
where you dropped it. Photos larger than 500 pixels wide will be displayed at 500 pixels
wide, but you can of course change this to be any size in the usual way with the Selector
Tool.

Getting Started
There is also the option of importing stock photos from the Online Content Catalog. You
can either browse the catalog from the File menu. "FILE" > "NEW FROM CONTENT
CATALOG". Or you can replace a photo by right-clicking it, and then choosing "REPLACE
PHOTO" > "WITH STOCK PHOTO" from the context menu.

Drag and drop your photo over any existing picture to replace it. Drop onto the background to
import as a new photo

When you replace an existing photo, the Photo tool is selected and the
smartphoto adjustment handles (on page 351) appear on the photo.
You can use the adjustment handles to rotate and scale the picture, move it within its
outline frame, resize the frame and even round its frame edges.
See Photo Handling and The Photo Tools (on page 364) for more information, including
replacing multiple photos and importing large photos.
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Text
You can edit the text by selecting the TEXT TOOL and clicking on the text.

You have all the usual word processing facilities, and can paste text from the system
clipboard. Double click will select a word, triple click will select a whole line - which can
be useful for selecting all the text in a button. As usual the InfoBar provides a wide range
of controls for this tool. Alternatively you can right click within text and choose ADVANCED
TEXT PROPERTIES .

See Text Handling (on page 209) for more information on the font menu, creating new
text objects, bulleted and numbered lists, text repel, anchored objects in text, spell
checking, auto correction and more.

Page Size
You can set any page size you like by selecting the PAGE SIZE tab of the OPTIONS DIALOG
(right click > "Page Options" or choose Page Options from the File menu). The dialog
offers a range of commonly used page sizes in the drop-down list, some intended for
web use and others for print use. Or Choose the custom option to enter any other page
size.
You can directly adjust the height and width of your page by just dragging on the bottom
or right margin of the page. Go into the Selector Tool and hover the pointer over the
bottom edge of the page, and it will change to indicate you can now drag resize the page
up or down as required. This is normally only useful for web documents as print
documents usually need a fixed paper size. You will be prompted to choose whether the
change should apply to all the pages in the document or website, or just the current one.

Changing The Page Size of Templates
You can change the vertical size of the pre-designed web templates by just dragging on
the bottom edge of the page. As you do this, footer objects will automatically stay with
the bottom of the page and any background panels will stretch automatically also, so the
page design is maintained for any page length.

Getting Started
Saving & Exporting Your Work.
Use the SAVE or SAVE AS menu options to save your work in progress. This saves a file
with the .xar extension, which is the native file format for Designer Pro. You are
recommended to regularly save your work as you go along, particularly if you don’t have
the automatic backup facility turned on (see below). If you want to edit or update your
document in future, you must save a .xar file this way and use it to do further updates,
even if you've also exported it to different standard file formats.
To export your document, right click and choose EXPORT or use "FILE" > "EXPORT" and
choose the file format you want to export to from the list of formats shown. Use JPEG for
exporting photos for web use, PNG for web graphics, HTML to create a website, and
usually PDF is best if you want to print or distribute print work. You can also export to a
Word file or export a print document as a web viewable HTML document or "Web
document".
See the Importing & Exporting (on page 562) chapter for information on these and many
other export formats supported by Xara Designer Pro X.
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Starting a new document
Choose FILE > NEW
This opens a sub menu with several pre-defined but blank template documents to start
from.

Primarily, there are five different types of documents in Xara Designer Pro X.
Icon Document type
Print

Menu option
A4 PORTRAIT
A4 LANDSCAPE
A4 DOUBLE PAGESPREAD

Use for..
Creating drawings, DTP and text
documents (single or multi-page) that
you want to print or perhaps export as
PDF documents.

US LETTER

Website

WEB PAGE 640 PX
(VGA)

Creating complete websites or web
graphics.

WEB PAGE 760 PX
(SVGA)
WEB PAGE 955 PX
(XGA)

Presentation

955 PIX PRESENTATION

Creating web presentations.

Animation

ANIMATION

Creating animations such as a Flash
animation or animated GIF.

Document handling
Photo

BLANK PHOTO

If you load a JPEG photo into Xara
Designer Pro X it’s loaded as a photo
document. Photo documents are
used where the purpose of the
document is only to edit or produce a
photo.

Choosing the first entry A4 PORTRAIT creates a document based on the Designer Pro
default template.
Clicking the NEW button on the STANDARD control bar (shortcut "Ctrl
+ N") also creates a document based on the default template.
Tip: Ctrl + Shift + N opens a new animation document.
When your new document opens, its tab is added to the top of the workspace with an
icon showing which type of document it is, as shown in the example below.

You can save your own templates with the "File" > "Save Template" command – see
Changing the template document (on page 607) for details.

Opening an existing document
To open an existing document:
 Drag & drop a file. Select the file in Windows Explorer or on your desktop, and drag it
over an existing open document to import it into that document, or any other part of
the Designer Pro window to open the document.
 Or double click a Designer Pro file.
 Or to open a recently used file, select it from "FILE" > "OPEN RECENT"
 Or select "FILE" > "OPEN" (shortcut "Ctrl + O").
 Or click the OPEN button on the standard control bar.
The open dialog will be displayed. The dialog allows multiple file selection, "Ctrl
+ click" to select several files or "Shift + click" to select a range of files.
As in Explorer windows, you can switch the file display to a detailed or thumbnail
view with this button
If SHOW PREVIEW in the upper right corner is checked, the selected file is shown in an
even bigger preview (this does not work for a multiple file selection).
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Online editing in the Cloud
Designer Pro can now sync files via Dropbox and Google Drive. These services provide
free file storage in the Cloud, and a small desktop utility that can be installed on your PC
that will automatically sync files saved on your hard disk to the cloud.
Designer Pro will notice if files have changed, and will automatically reload updated files.
It means that you can have the same file open on multiple computers, and if you make
an edit, and save the file, then it will be updated in Designer Pro on the other computers.
Further, using cloud based file sharing, you can share the file with someone else, and
whenever they edit the file and save, your version will be updated, and vice versa.
This does not solve the problem of edit clashes. So if you edit the file and at the same
time someone else edits the same file, then Designer Pro will tell you there has been an
edit and give you the choice of opening the updated file in a new document.
For more details see the quick start guide for Xara Online Designer here
http://kovemi.xara.hosting/XOLDesigner-Intro/
Xara Online Designer, Online editing, Online, Document sync, Dropbox sync, cloud.xara

Selected document and title bar
You can have more than one file open at a time in Designer Pro, which displays all open
documents as tabs at the top of the workspace.
The current document is displayed in the workspace and its name is highlighted gray in
the document tabs. Right click on a document tab for a menu of document operations.
The current document type is indicated in the top left corner of the Designer Pro window,
next to the menu options. The current document receives all input. Any unsaved changes
in a document are indicated with a star after the file name.

Document tabs show all open documents, with the current document tab highlighted gray.

Control bars
These contain buttons that you can use to operate Designer Pro. You can customize
control bars in several ways, such as re-ordering, creating, and hiding bars.
The default window shows the standard button bar with commonly used buttons:

Document handling
You can customize the standard control bar in the same way as other control bars.
Those icons with a triangle indicator in the bottom right corner have "fly-out bars" on
them. Hold the mouse pointer over these icons and you’ll see the fly-out bar appear, with
more icons.
For information on customizing control bars, refer to "Customizing Designer Pro (on page
629)".

InfoBar
This is a special control bar. Its contents change when you select different tools. InfoBars
specific to certain tools are described in their relevant chapters.
You cannot customize the InfoBar.

The InfoBar for the Selector Tool
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Main toolbar
This is a control bar that initially contains all the tools available in Designer
Pro (see left). You can customize the toolbar, or move tools to other control
bars.
Some of the toolbar icons have a small triangle indicator in the bottom right
corner. This indicates that there is a flyout bar containing more tool icons.
Hold your mouse pointer over the icon to see the flyout bar appear.

You can then move the mouse pointer over each icon in the bar to see a
tooltip indicating what each one does. Click on a tool to select it (some tools
have keyboard shortcuts, too).
For information on customizing control bars, refer to "Customizing Designer
Pro (on page 629)".

The status line

Selected objects
Available options
Indicators
Mouse pointer X-Y
This appears at the bottom of the window. The status line tells you about the selected
objects, available options, live drag/snapping indicators, and the X/Y position of the
pointer.

The indicators
These appear on the right of the status line:
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Live drag indicator
This indicator shows whether live drag is active or not (it is active by default).
Double click the indicator to toggle live drag on/off. When active, if you
reposition, resize, or rotate an object, the whole object moves (not just an
outline), making it far easier to judge the effect of your edits in real time. Drawing
in the FREEHAND , STRAIGHT LINE , QUICKSHAPE , RECTANGLE and ELLIPSE TOOLS
(on page 153) is also live with this option on. If your computer is unable to cope
with a particularly complex document, it will automatically turn active drag off to
ensure editing remains fast and efficient.
Snapped indicator
This indicator is active when SNAP TO OBJECTS is enabled. Click the SNAP TO
OBJECTS button (shown left) to toggle off and on. Snap to objects allows you to
see potential snapping paths and points relative to other objects and the page
center and edges by showing blue snapping lines for snapping paths and red
dots for points as you drag an object. For more information on snapping, refer to
"Object Handling (on page 74)".

X/Y co-ordinates
Designer Pro shows measurements relative to the bottom left corner of the page area or
spread. However, this is configurable. For more information refer to OBJECT HANDLING
(on page 74).

Normal/full screen modes
In normal screen mode part of the window is occupied by the title bar, menu bar, and
scroll bars. This can be inconvenient if you want the maximum possible editing area.
Designer Pro has a second screen mode, fullscreen, which displays a more streamlined
screen. You can configure each screen mode as you wish. For example, each can have
its own configuration of the control bars. The configuration is remembered and applies
whenever you swap between screen modes.
Normal/full screen is controlled by "WINDOW" > "FULL SCREEN" or right click and choose
FULL SCREEN ("8" on the numeric keypad toggles between the two displays).
To display the menu bar in full screen mode, move the pointer to the top of the screen.

Opening a second window
You may want to open a second window onto the same document to:
 Get an enlarged or reduced view of the document;
 Show another part of the document;
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 Have two views of the same area at different quality settings (quality settings are
described later.)
Choose "WINDOW" > "NEW VIEW" to open another window. You can have several windows
open on the same document. Additionally, Ctrl+Tab will allow you to flick between
windows.

Changing the zoom value
It’s often useful to enlarge your view of the document to examine details or reduce your
view to get an overall impression. Scalings above 100% show an enlarged view (similar
to looking through a magnifying glass); below 100% a reduced view. The only change is
your view of the document; the size of the document itself and the objects in it are
unchanged (changing the document size is described later). To change the zoom value
you can use either the ZOOMTOOL , mouse, or control bars.
Some shortcuts are available for quick setting of zoom values: The plain numeric keys (1,
2, 3, 4) set the zoom to between 100% and 400%. The number 5 key sets it to 50%.

Using the Zoom Tool
To zoom:

 Select the ZOOM TOOL from the MAIN TOOLBAR .
 Or press "Alt + Z" to toggle between the current tool and the ZOOMTOOL .
 Or press and hold down "Alt + Z" to temporarily swap to the ZOOMTOOL (release "Alt +
Z" to return to the previous tool).
 Or press "Shift + F7" to select the ZOOMTOOL .

Changing the zoom value using the mouse
If you have a mouse wheel:
 Hold "Ctrl" and scroll your mouse wheel to change the zoom level.
You can also configure a mouse button to zoom in or out. Furthermore, you can change
the mouse wheel action between scrolling and zooming in "UTILITIES" > "OPTIONS" >
"MOUSE TAB (ON PAGE 616)" or right click and choose "PAGE OPTIONS" > "MOUSE" tab. The
opposite action is available then by pressing "Ctrl".
Alternatively, select the ZOOMTOOL , and
 Click to zoom in (enlarge).
 "Shift + click" to reduce the zoom value (to see more of the document).
 Drag the mouse diagonally to create a rectangle. When you release the mouse button,
the area within the rectangle is enlarged to fit the window.
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Changing the zoom using the zoom InfoBar/control bar
There is a flyout bar on the standard toolbar which gives you quick access to zoom
functions, without having to go into the ZOOM TOOL . There is also a flyout bar on the
ZOOM TOOL icon on the main toolbar.
Hold the mouse pointer over the zoom icon on the standard toolbar to see the
flyout bar.
To change the zoom:
Shortcut "Ctrl + R". Click the PREVIOUS ZOOM button. This is the zoom value
before the current setting. Using this button lets you flip zoom in and out on the
document. This is useful for switching between examining an area in detail and
an overall view. The previous zoom value is stored for each window. You can
swap between windows and the previous zoom values are retained.

Shortcut "1" Click the Zoom to 100% button. The zoom factor is changed to
100%.
Shortcut "Ctrl + Shift + J". Click the ZOOM
shows all the objects in the document.

TO DRAWING

button. The window

Shortcut "Ctrl + Shift + P". Click the ZOOM
the entire page or pair of pages.

TO PAGE

Shortcut "Ctrl + Shift + Z". Click the ZOOM
object or objects fill the window.

TO SELECTION

button. The window shows

button. The selected

Type a value into the text box. Press "" to implement
the change, or select preset zoom values including those
above (page, drawing, selected, previous) in the dropdown menu.

Sliding the document within the window
The quickest and easiest way to move around the document is to use the middle mouse
button (normally the mouse wheel) if you have one. Click and hold the middle button
down and then move the mouse. Release the button to return to your previous tool.
To move the document within the window you can also:
 Use the scroll bars and arrows at the side of the window.
 Use the mouse wheel to scroll the document up and down ("Shift + mouse wheel" for
left and right)
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 Or select the PUSHTOOL from the main toolbar ("H").

 Or press the space bar or "Alt + X" to toggle between the current tool and the
PUSHTOOL .
 Or press and hold down the space bar or "Alt + X" to temporarily switch to the
PUSHTOOL (release key(s) to return to the previous tool). You can then use the mouse
to drag the document around in the window.
The PUSHTOOL InfoBar is the same as the ZOOMTOOL InfoBar (described above).
Displaying the scroll bars is optional. Choose " WINDOW" > "BARS" > "SCROLLBARS" to turn
them off.
You can change the mouse wheel action between scrolling and zooming in " UTILITIES" >
"OPTIONS" > "MOUSE" or right click and choose "PAGE OPTIONS" > "MOUSE" . The opposite
action is available then by pressing "Ctrl".

Changing the page size
You can change the size of the current page to a standard size:

1.
2.

Right click the page and choose "PAGE OPTIONS" > "PAGE SIZE" tab or choose
"UTILITY" > "OPTIONS".
Choose the required paper size.

Document handling

"Customizing Designer Pro (on page 607)" has full details of the options dialog box.

Paper size
You can either choose the CUSTOM option from the paper size list and then enter the
width and height, or choose a standard size. Or you can go into the SELECTOR TOOL and
drag on the bottom edge or right edge of the page to change the page height or width
respectively. If you use this method you will be prompted to choose whether the change
should apply to all the pages in the document or website, or just the current one.
Position the mouse pointer over the edge of the page –
you will see the mouse pointer change when you are in
the right position, then click and drag.
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The current page size is shown in the status bar as you drag.
Automatic Page Extension
Objects that have the PUSH option turned on (see right click menu, "PAGE POSITION" >
"PUSH" ) will make the page extend automatically if they extend over or close to the
bottom of the page. All the web page templates in the DESIGNS GALLERY use this feature
so that pages grow as required during editing. See the Push section in the Object
Handling (on page 74) chapter for details.

Orientation
 Portrait orientation displays the longest sides vertically.
 Landscape orientation displays the longest sides horizontally. If you entered a custom
page size, landscape turns the page sideways.

Outer margin
This lets you set the width of the pasteboard around the page or spread.

Bleed
To produce format filling print results printing shops use a larger format paper and crop it
to the target format after it has been printed. Due to mechanical tolerances inaccuracies
can happen during this process. For this reason, printing shops recommend including an
additional "safe area" around the actual print motif. This is often referred to as the
"bleed". This ensures that no important content is cropped and that no white borders
appear on the edges if the motif background is not white or a background pattern is used.

Without this "bleed" area a mechanical error during cropping can lead to white borders or
image elements that are too close to the edge being cut.
The bleed area is set in the Page area of the Page Options (on page 618) and in the
program it is displayed as a red rectangle around the page. Normally this bleed area is 1-
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3mm wide. When a PDF is exported for printing the final page size of the PDF will appear
based on the page size settings plus the bleed area beyond the actual page. For
example, an A4 page (29.7 x 21cm) with a 2mm bleed area will result in a format of 30.1
x 21.4cm.
The exact value depends on the print shop - so consult for details. Some online print
shops also request a file format that already contains the bleed area. Here is an
example: For a flyer in A6 format (14.8 x 10.5cm) the shop may request a file format of
15 x 10.7cm. This corresponds to a value of 1mm for the bleed area beyond the actual
page.
Make sure that the rectangle that contains the background pattern or color extends
beyond the page borders at least to the edge of the bleed area. It is also important to
make sure that all important page elements are at a safe distance from the page borders.
This distance should be at least the size of the bleed area.

The background image was extended to the edge of the bleed area (red frame) and the header
was made smaller. If a cropping error does occur, the background will still cover the entire
format and the heading will not be affected.

Auto-fit to Page...
The AUTO-FIT TO PAGE... button will open the AUTO-FIT TO PAGE dialog. This enables the
automatic repositioning and scaling of page content to fit a new page size. The dialog
also lets you fine tune the position of document content. This may sometimes be
necessary especially with items around the margins of the document like headers,
footers etc.
See the Auto-fit to Page (on page 111) section in the Object Handling (on page 74)
chapter for details.
.
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Multi-page Documents
Xara Designer Pro X supports multi-page documents to make DTP and website building
projects simple.
You can easily create documents that are comprised of many pages, for example
newsletters, PDF eBooks, brochures, small magazines or even complete HTML
websites. When working on a website document, each page in the Designer Pro
document is exported as one page of the website.
By default when you open or create a new web document, Designer Pro shows only
one page. Print documents however are displayed in multiple page view by default. Right
click a page and select/deselect MULTIPLE PAGE VIEW to toggle between display modes.

Double page spreads in multi-page documents
Your illustration may run across two facing
pages. This is called a double-page
spread.

Single

Double page

To switch between single or double-page spreads, right click the page and choose "PAGE
OPTIONS" , and then check or uncheck the " DOUBLE-PAGE SPREAD " option.
Note: If ALL PAGES IN DOCUMENT THE SAME (on the same Page Options tab) is turned on,
then any changes you make will apply to all pages in your document. So if you want only
some of your pages to be double-page spreads, turn off the All pages in document the
same option.

Document handling
If you change from a double-page spread to single pages in an existing document, your
spreads will be split into single pages. Similarly, converting to a double-page spread will
cause the pages in your document to be "paired up" into spreads.

The result of converting a double page spread document to individual pages, and then back
again.

Note: it is possible for objects to overlap the pages of a spread (i.e. on pages 1 and 2 in
the illustration above) but not over separate pages or spreads (i.e. 1 and 3; if you did
want to do this, you would need to copy the object from page1 and paste it on to page 3
so that it appears there as well).
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The current page
If you click a page in a multi-page document it will become the current page.
The current page is relevant when inserting, duplicating, or moving pages as
described in the following sections.
The current page in the document is shown by indicators on the page’s corners.

Inserting pages into your document
Right click a page and choose NEW PAGE or NEW DOUBLE PAGE SPREAD . A new blank
page is inserted after the page.
or
Right click a page and choose DUPLICATE CURRENT PAGE . A duplicate of the current page
is inserted after the page.
The new page will be the
same as the original page,
including its size and
orientation, and will include all
its content so that you can
use it as a template for new
content.
You can also use the Menu
items under "EDIT" > "PAGES"

In addition, the standard toolbar has a flyout bar which allows you to add, duplicate and
delete pages quickly.

Hold the mouse pointer over each icon in the bar to see a tooltip for each available
operation. You can add a new blank page, duplicate the current page or delete the
current page.

Copying and pasting pages
You can copy and paste whole pages in the current document or paste pages to another
document. This copies the page dimensions, layers and other page attributes in addition
to all the objects on the page.
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To copy the current page, clear any current selection by pressing Esc or by clicking on
an empty part of the page or pasteboard. The status line says "No objects selected".
Right click an empty part of a page and choose COPY PAGE (or press "Ctrl + C").
When you paste a copied page, it is added immediately following the current page. To
paste use "Ctrl + V" or right click the page and choose PASTE > PAGE from the context
menu.
Note: If the document into which you paste a page has the ALL PAGES IN DOCUMENT THE
SAME option enabled in FILE > PAGE OPTIONS , the dimensions of the pasted page will be
overridden by the page dimensions of the document. So the new page will be given the
same dimensions as all the other pages in the document.

New page from template
To insert a new page into your document using a pre-designed template, open the
DESIGNS GALLERY , drag your chosen page template thumbnail, and drop it onto
your document. The new page is added immediately following the page that you
drop on.

Automatic addition of pages
If the AUTOMATICALLY CREATE NEW PAGES option is turned on for a text area, a new page
will be added to your document automatically if you enter text into the text area so it
overflows.
Simply click on the arrow at the bottom of the text area and select AUTOMATICALLY
CREATE NEW PAGES. You can also find this option is in the Advanced text properties
dialog, which you can get to by right clicking in text and choosing ADVANCED TEXT
PROPERTIES…

With this option on you can add any amount of text to your document without ever adding
a page manually.
See Text areas (on page 219) for more detail.

Moving pages within the document
If you wish to change the order of pages in your document you can do so.
Right click a page and choose "MOVE PAGE/DOUBLE PAGE SPREAD UP" or "MOVE
PAGE/DOUBLE PAGE SPREAD DOWN" .
You can also change the order of pages in the PAGE & LAYER GALLERY .
Click the PAGES button in the PAGES & LAYER GALLERY so it shows a simple list of pages.
Then you can drag and drop pages up and down in the gallery to change the page order.
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You can also duplicate a page using the PAGE & LAYER GALLERY . Select the page and
click the DUPLICATE button. The new page is added after the current page.
Alternatively, to move the current page:
 Choose "Edit" > "Pages" > "Move page up" or right click and choose Move page up to
swap the current page with the one previous to it.
 Choose "Edit" > "Pages" > "Move page down" or right click and choose Move page
down to swap the current page with the one after it.
These options will be grayed-out of if you are on the first or the last page of the document
respectively.

Removing pages from your document
To delete the current page from your document right click and choose
PAGE/DOUBLE PAGE SPREAD" .

"DELETE CURRENT

Or to cut the current page, right click an empty part of the page and choose

CUT PAGE .

Or select the page in the PAGES & LAYER GALLERY and click the DELETE button. The
current page and all its content will be deleted. In the case of a spread, the entire spread
will be deleted along with its content.

Navigating between pages
As well as the usual methods of moving through your document (such as scrollbars and
the mouse wheel), there are also some other ways to navigate through the pages using
the set of keys to the right of your keyboard:
Page up: Moves up the document. The amount moved depends on your zoom level. The
further you are zoomed out the bigger the move.
Ctrl + Page up: Go to and center on the previous page.
Page down: Moves down the document. The amount moved depends on your zoom
level. The further you are zoomed out the greater the move.
Ctrl + Page down: Go to and center on the next page.
Or click the up or down arrow on the status line:
The status line is also useful for knowing what page(s) you are currently viewing.
Note: All of these movements are relative to the page you are viewing, not the current
page.
The PAGE & LAYER GALLERY also makes it easy to go to find a specific page in your
document. Click the PAGES button in the gallery, so it shows a simple list of pages. Then
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as you click on each page in the gallery, the document view is scrolled automatically to
show that page.

Pages with different sizes and layers
You can choose whether the pages in your document should be all the same size or not,
and whether or not all pages should have the same layers. See the Document section
(on page 619) on the PAGE SIZE tab of the UTILITIES > OPTIONS dialog or right click a page
and choose "PAGE OPTIONS" .

Naming pages
When creating website documents it is important to give each page a name, which is
then used to name the HTML file which is exported for each page. If pages are not
named the exported filenames will be distinguished from each other only by an index
number appended to the filename provided at the time of export. Eg. index.htm,
index_2.htm, index_3.htm, etc. Using page names makes it easier to identify each page.
You can set the name of the current page using the Page tab of the " UTILITIES" > "WEB
PROPERTIES" dialog. Set the PAGE FILENAME field. Or you can use the PAGE & LAYER
GALLERY . Click on a page name to select it, then click again to start editing the page
name.
Even if your document is not to be exported as a website, you may still wish to name
your pages in order to make them easier to find and identify using the Page & Layer
Gallery.
Note that page names are forced to lower case and some characters are disallowed.
These restrictions are intended to minimize the risk of web page filenames causing
problems with some web servers and to eliminate case sensitivity problems when linking
to the web pages.

Page & Layer Gallery
You can also use the PAGE & LAYER GALLERY to conveniently manage the pages in your
document. It allows you to view, add, duplicate, delete, re-order pages all from a single
view. For more information see PAGE & LAYER GALLERY (on page 181).

Saving the document
This section covers saving in Designer Pro’s own format (native format). Refer to
Importing and Exporting (on page 562) for details of exporting in other formats.
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We recommend that you always save documents regularly. A complicated document
may represent many hours of work and power failures or computer crashes always
happen at just the wrong moment. Make sure you have the automatic backup facility
turned on, so that regular backups are taken of your open documents as you work. See
the Automatic Backups (on page 51) section below for details.

Save option (on the File menu)
("Ctrl + S", or click the SAVE button on the standard control bar.)

This provides a quick way to save a document using the same file name. The option is
disabled unless the document has unsaved changes, i.e. you have made changes, but
haven't saved them yet.
For a new document that has not been saved, this option acts like "Save as" (described
below).

Save as (on the File menu)
This opens a dialog box letting you save the document under a different name or to a
different directory. This option is useful for making backups of Designer Pro documents.

Save all (on the File menu)
This acts like a series of SAVE or SAVE AS commands to save all currently open files.

Support folders
Some documents which are used to create websites need to reference external files
which cannot be embedded in the .xar design file. For example you may have a Flash
(.swf) file which is used on your website and so you’ll want to keep that file with the
design file because you can’t export a fully working website from the design file without
also having the Flash file.
So Xara Designer Pro X uses an optional “support folder” right alongside the design file
to hold these important external files.

Support folder naming
The design file and its corresponding support folder are tied together by their names. The
support folder for “mySite.xar” is always “mySite_xar_files”. This naming convention
makes it obvious which support folder belongs to which design file. So if you rename,
copy or move a design file, always remember to do the same to the corresponding
support folder, if it exists! And if you send a design file to someone else, send any
support files folder along with it.
If you load a design that has a support folder, and then subsequently do a SAVE AS to
save another copy of that design, Xara Designer Pro X will copy the whole support folder
too, if there is one.
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Support folder contents
When you use the Placeholder Tab (on page 464) of the Web Properties dialog to insert
a reference to an external file into your website design (using the Browse buttons), Xara
Designer Pro X will automatically copy that file into the design’s support folder for you. If
the support folder doesn’t already exist, it will be created.
Note that if you subsequently change a placeholder object to reference a different file,
the original file will not be automatically deleted from the support folder. So if a file is no
longer needed, you need to remove it manually.

Exporting websites with support folders
When you export a website document, any files in the corresponding support folder are
copied to the folder which contains all the generated images for your website. So if you
export “mySite.xar” to “index.htm”, then any files in folder “mySite_xar_files” are copied
into the “index_htm_files folder”.

Closing the document
To close the document:





Choose "FILE" > "CLOSE".
Or press "Ctrl + F4", or "Ctrl + W".
Or click the smaller, lower X of the two in the top right hand corner.
Or right-click on the document tab to view a context sensitive menu with a series of
save and close options for both individual and all open tabs.

Right-click on a tab to display multiple save and close options.

Automatic Backups
Xara Designer Pro X will optionally save regular backup copies of your open documents
while you work.
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To turn automatic backups on or off, open the " UTILITIES" > "OPTIONS" dialog and choose
the BACKUPS tab.

Backup open documents
To turn backups on select this checkbox and choose how often you would like backups
to be taken. The suggested period is 10 mins, which means each open document will be
backed up if it’s more than 10 mins since the last backup of that document was taken (or
since the document was created or opened).
Note that once the configured period since the last backup has expired, the next backup
is only saved when the program has been idle for at least 15 secs. This is to avoid
interrupting your work as much as possible and to avoid backing up the document while it
is being actively modified. In normal use it’s unlikely that there won’t be regular inactive
periods of 15 secs or more, allowing a backup to be taken soon after it is due. But note
that if you are actively editing for an extended period of time it could be significantly
longer than the configured backup period before the next backup runs.
The Automatic Backup facility does not save modifications to open ‘edit inside’ subdocuments. Only the parent main document is saved when a scheduled backup runs, in
its current state without the unsaved group edits. For this reason it's recommended that
you save ‘edit inside’ edits back to the parent document regularly.
When a backup is taken, you’ll see the save progress bar appear at the bottom of the
Xara Designer Pro X window while the save is completed.

Backup location
User the BROWSE button if you want to change the folder where your backups are stored.
You can access the backup documents saved here at any time using the " FILE" > "OPEN
RECENT" > "BACKUPS" menu option. This opens a file dialog onto your backup folder so
that you can browse, open, or delete any of your backup files.
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Revisions
By default up to 10 revisions of each design are kept in your backups folder, but you can
choose to change this number in the revisions field. Older revisions in excess of the
number chosen are deleted automatically. Each backup file is named using the name of
the document from which it is taken, suffixed by the date and time at which the backup
was taken.
Warning: Note that if you have multiple documents that share the same filename in
different folders on your computer, their backups will also share the same names in the
backups folder. Therefore try and use unique filenames for your designs to avoid the
backups of one design overwriting another with the same name.

Untitled documents
Documents that you have created and not saved are backed up using the name
"Untitled" followed by a number and the date/time. This name and number corresponds
to those shown in the titlebar when you are editing new unsaved documents.
Warning: Since all new unsaved documents are named Untitled1, Untitled2, etc.
backups of these documents are likely to be overwritten relatively quickly. Therefore you
should always save important documents with a unique name of your choice, so that you
can easily identify backups of that document in the backups folder.

Backup open documents on program close
The Backups tab in the Options dialog also allows you to turn on AUTOMATIC BACKUP
AND RESTORE . When this option is on, when the you close Xara Designer Pro X you will
not be prompted to save any modified documents that you have open. Instead all open
documents are backed up to the backups folder and the program closes. Then when you
next start the program, the same documents are automatically reloaded so that you can
continue working where you left off.
Note that if you have any "Edit inside" sub-document views open, these are silently
closed and saved back to the main document when the program is closed, and the main
document is backed up. The ‘edit inside’ sub-document views are not re-opened on next
program start. See editing inside groups (on page 96).

Recovering from abnormal program closures
If you have automatic backups turned on and the program closes abnormally (perhaps
due to a power failure for example) the program should detect this when it is next
restarted. It will then offer you the chance to restore the most recent backup version of
each document that was open at the time of the last backup.
Abnormal closure will not be detected if no automatic backup completed since the last
normal program closure.
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Backups on system shut down
If you shut down Windows without first closing the program, all open documents are
backed up to the backup folder even if ‘Backup open documents on program close’ is not
turned on. This allows system shutdown to proceed without Xara Designer Pro X
interrupting it by prompting you about unsaved or modified documents. On next program
startup you’ll be asked whether or not you want to restore the documents that were open
at the time of the system shut down.

Recovering backups
You can access your document backups using the " FILE" > "OPEN RECENT" > "BACKUPS"
menu option. This opens a file dialog onto your backup folder so that you can browse,
open, or delete any of your backup files. It’s a good idea to use this file dialog to clear out
any old unwanted backups periodically.
Note that when you load a backup document, it is not automatically associated with the
design file from which the backup was taken. It’s treated as an independent document in
its own right. Therefore if you decide to keep a backup document you should use " FILE" >
"SAVE AS" to save it elsewhere with a suitable name.

On-screen grid
To help you lay out your document, Designer Pro can display a grid on the screen (the
grid appears only on the screen; it is never exported or printed.) The grid helps you align
objects (similar to using graph paper as a drawing aid).
Right click and choose "SHOW GRID/GUIDES" > "SHOW GRID" to turn display of the grid
on/off or choose "SNAP TO" > "SNAP TO GRID" . You can also choose "WINDOW" > "SNAP TO
GRID" .
The grid points then act like magnets, and as you move objects, they snap to the nearest
grid point. By default web documents have "SNAP TO GRID" on, with a 1 pixel grid.
The type of grid (isometric/rectangular), the 0,0 point (the origin), and spacing of grid
points is controlled by the GRID & RULERS TAB (on page 613) of the options dialog box.
Any changes you make apply only to the selected document.
Magnetic object snapping is also enabled by default in web documents. Object snapping
is a very powerful way of accurately aligning lines, points and the edges of objects to any
other object so they exactly touch.
You can even use this to align the centers of objects, or align objects to the center of the
page, or align them horizontally and vertically anywhere in the middle of the page or
edge of the page.
To toggle object snapping, click the SNAP TO OBJECTS button or right click and
choose "SNAP TO" > "SNAP TO OBJECTS" . You can also choose "WINDOW" >
"SNAP TO GRID" .
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Refer to Object Handling (on page 74) for details on snapping to grid and snapping to
objects.

Rulers
Rulers are turned off by default. To turn them on:
 Right click and choose "SHOW GRID/GUIDES" > "SHOW RULERS" to turn display of the
grid on/off.
 Press "Ctrl + Shift + R".
 Or select "WINDOW" > "BARS" > "SHOW RULERS".
Designer Pro uses rulers to:





Control text margins, tabs and indents (on page 234) in the TEXT TOOL .
Let you know which part of the page you are viewing;
Show the current pointer X/Y position;
Apply guidelines. If "WINDOW" > "SNAP TO GRID" is active, guidelines snap to divisions
on the ruler. For more information on guidelines, refer to the guides & guidelines
section in "Object Handling".

As you create or scale objects, you can use the rulers to check their size. You can also
more accurately use the SELECTORTOOL (see "Selecting objects (on page 122)" for more
information).
Rulers are displayed at the left and top of the window. A dotted line on each ruler follows
the current pointer position.
The units and number of divisions on the rulers are the same as those set for
customizing the on-screen grid. These are set using the Grid & Ruler Tab (on page 613)
of the options dialog box. The current units and any scaling factor are displayed on the
right hand end of the top ruler.

Displaying/hiding rulers
Right click and choose "SHOW GRID/GUIDES" > "SHOW RULERS" ("Ctrl + Shift + R") to turn
rulers on/off. Any change applies to the current window and subsequent windows you
open. It does not affect other open windows.

Changing the ruler zero points
It is often easier to measure objects if you align the origin (0,0) point of the rulers with the
object. To move the origin (0,0) point, drag the square at the intersection of the two
rulers.
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You can drag vertically or horizontally along the rulers
or over any part of the Designer Pro editing window. As
you do, a dotted line will outline the new position.
This also moves the grid origin so that divisions on the
ruler always align with the grid.

You can also move the zero point under the GRID & RULER tab (on page 613) of the
Options dialog.

Measurement units
You can define the units in which to display measurements. The default display units are:
 points (1/72 of an inch) for text and line widths.
 centimeters for most measurements.
You can enter dimensions in the other units by using a suffix or prefix (dependent on the
unit type). For example, 2.5in for 2.5 inches. You can enter dimensions using two units.
For example, 2pi 4pt for a dimension of 2 picas, 4 points. Note that units entered will be
converted and displayed in your default unit.

Millipoints
A millipoint is 1/1,000th of a point (1/72,000th of an inch). All Designer Pro
measurements are stored internally in millipoints and then converted to the appropriate
units when displayed. Dimensions other than millipoints are rounded if necessary. If you
want to work in exact units without rounding, display measurements in millipoints.
"Customizing Designer Pro (on page 607)" has full details of the options dialog box.

Options dialog box
Measurement units for the selected document are controlled by the Options dialog.
Choose "UTILITIES -> OPTIONS" or right click a page and choose "PAGE OPTIONS - >
UNITS".

Changing the default display units
Display the options dialog box. If necessary, click the units tab.
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Font units are used for
text sizes.
Page units are used for
other measurements.

Creating a new unit
You may want to specify measurements in units not provided as standard. For example,
racecourses are measured in furlongs (220 yards). Or a financial diagram may use US$.
Display the OPTIONS dialog box. If necessary, click the UNITS tab.

1.
2.
3.
4.

Click NEW UNIT . The unit properties window will appear:
Type in the unit name (e.g. US dollars). This name appears in menus.
Type in the ABBREVIATION ($). This is used when entering or displaying the units.
PREFIX

SUFFIX
IS EQUIVALENT

TO"

For units that do not relate to distance (for example US$), type in an appropriate scaling
factor. For example, 10US$ as equivalent to 10 millimeters.

Deleting a unit
You can only delete a unit you have created, not a standard unit.
Display the OPTIONS dialog box. If necessary, click the

1.
2.

UNITS

tab.

Choose the unit you want to delete from the UNIT DEFINITION list.
DELETE UNIT
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Applying a scaling factor
For example, you may want to specify dimensions in kilometers when drawing a map.
You can apply a 1:10,000 scaling factor to kilometers. A line 10cm long on the map is
reported as a dimension of 1km.

1.
2.
3.

Choose "Utilities -> Options". If necessary, click the SCALING tab.
Select USE SCALE FACTOR .

Alternatively, type 1 into the drawing field and 10,000 into the real-world field.

Deleting a scaling factor
This is similar to applying scaling:

1.
2.
3.

Choose "Utilities -> Options". If necessary, click the SCALING tab.
Deselect "USE SCALE FACTOR" .

View quality slider
This slider (on the STANDARD control
bar) affects how the document
appears on the screen. It has no
effect on the actual document or on
printing.
There are 5 different quality settings:

Document handling
OUTLINE MODE ONLY .

This is now fully anti-aliased for higher quality screen display.

OUTLINE MODE WITH BLEND STEPS.

(no anti-aliasing).
HIGH QUALITY (full anti-aliasing and image smoothing)
VERY HIGH QUALITY Bi-cubic photo display considerably improves the quality of
scaled down photos.
The default quality level is VERY HIGH QUALITY which means the document is displayed
on screen exactly as it will be printed (except that the monitor is lower resolution than a
printer.) Anti-aliasing gives a much smoother and more accurate screen display,
especially when displaying small details. However, one of the consequences is that
sometimes objects can look slightly blurred.
FULL COLOR

FULL COLOR

shows the document colored, but with anti-aliasing turned off.

On the OUTLINE MODE setting only the outlines of the shapes appear (they are drawn as
wire frames). This makes it easier to select objects hidden behind other objects.
OUTLINE WITH BLEND STEPS

is particularly useful for seeing outlines of the various steps

of a blend.
You can also change these settings with "WINDOW ->
QUALITY ". There are toolbar buttons available for the five
quality settings on the Window toolbar (on page 629).
Refer to "Blends (on page 314)" for more on how the quality setting affects the display of
blends.

The constrain key
The "Ctrl" key has a special function in Designer Pro. It constrains the action of the
current operation in some way. For example, normally you can rotate an object to any
angle. But in Designer Pro,if you hold down "Ctrl" while you rotate an object, the rotation
is constrained to a subset of the possible angles. By default the object will rotate only to
multiples of 45 degrees plus any rotations where a significant straight edge in the object
becomes vertical or horizontal.
The black line on the left can be rotated to
any angle within the circle. On the right is
the same line, but with "Ctrl" held down it
can only be rotated to the positions
indicated.

Similarly, constraining a rectangle creates a perfect square and constraining an ellipse
creates a perfect circle. Release "Ctrl", and they will not be constrained.
The constrain angle feature is defined in "FILE" > "PAGE OPTIONS" > "GENERAL" > "ANGLE
CONSTRAINT (ON PAGE 612)"
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Galleries
Xara Designer Pro X uses galleries to provide convenient access to external libraries of
content like templates, fonts, colors, clip-art, line attributes, and bitmaps/photos. This
section of the manual gives general information on features which are common to
multiple galleries. Individual sections of this manual describe features specific to a
particular gallery.
When you create a new Designer Pro document, the following gallery tabs are displayed
in the gallery bar to the right of the workspace in the following default order.

Local Designs
Page & Layer
Animation Frame
Bitmap
Line
Fill
Font
Color
Name
Note: The ANIMATION FRAME gallery is only displayed in animation documents. When you
open an animation document, the ANIMATION FRAME gallery is displayed already open on
the right of the workspace.
Some galleries display objects held in libraries external to the document:
FONTS, LOCAL DESIGNS, FILL.

Other galleries relate to objects in the document, or options for those objects in the
document:
COLOR, BITMAP, LINE, PAGE & LAYER, NAME.

Displaying a gallery
To display a gallery:

1.

Click or hover the mouse pointer over the vertical tab for the gallery to the right of
the workspace (the gallery bar). The gallery opens automatically. When you move
the mouse pointer away from the gallery, it automatically closes.

Document handling
2.

Unpinned: gallery closes when you move the mouse pointer away from the
gallery.
Pinned: gallery stays open when you move the mouse pointer away, and can
also be moved and docked (on page 61) elsewhere.
Note: By default the Line, Fill, Fonts, Color and Name Gallery do not display their title,
just their individual icons, until they have been opened. Designer Pro always displays the
title of the last gallery that you have viewed.

Moving and docking a gallery
You can ‘detach’ any gallery from the gallery bar and move it to a more convenient
location anywhere in the workspace. You can also dock the gallery (or a gallery group,
see Grouping Galleries (on page 64)) in the top, bottom, left or right of the workspace.

You can move a gallery anywhere in the workspace

To move a gallery:
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1.

Open a gallery and click the Auto Hide button to pin the gallery. The button changes
to a downward-pointing pin to indicate that the gallery can be moved and pinned
elsewhere.

2.

If you move any of the following galleries, the others accompany it as a group.







Bitmap
Line
Fill
Font
Color
Name

Access an individual gallery by clicking its tab at the bottom of the group or click and
drag a gallery tab to move it away from the group.
When you click and drag on an dockable gallery’s open title bar, a number of arrows
appear on the workspace, indicating where you can dock the gallery.

Dragging a gallery causes docking arrows to appear in the center, top, bottom, left and right of
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the workspace. Dock the gallery by dragging it to an arrow.

Example of a gallery that has been docked to the left of the workspace

To dock a gallery:

1.
2.
3.

Click and drag the gallery to the arrow pointing towards the location where you want
to place the gallery. For example, if you want the gallery at the top of the screen,
move it to the upward pointing arrow at the top of the workspace.
When the mouse pointer reaches the arrow, a gray transparent box highlights the
gallery’s new location.
Let go of the mouse button to dock the gallery. Now when you close or ‘auto hide’
the gallery, its tab will be displayed in the new location.

4.
Note: To move all galleries back to their default position, choose
WINDOW menu, click GALLERIES then RESET .

CONTROL BARS

from the
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Grouping galleries
You can also group galleries and move the whole group to a new location if, for example,
you are working primarily with 2 or 3 galleries that you want to be close to each other and
easily accessible.

Example of a gallery group with gallery tabs at the bottom - click and drag to add a gallery to or
remove a gallery from the group.

To group galleries:
 Disable the AUTO HIDE button (pin) on one of the following galleries: Bitmap, Line, Fill,
Font, Color and Name gallery.The gallery is automatically grouped with the other five
galleries, displayed as tabs at the bottom of the group. Click on a tab to open a gallery
in the group.
To group a gallery with one previously docked:
 Click and drag the second gallery to the four arrows in the workspace center. Let go of
the mouse when you are over the arrow pointing towards the previously moved (first)
gallery. The second gallery is now grouped with the first.
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To add a gallery to an existing group:

1.

Click and drag a gallery group over the center of the 4 docking arrows in the center
of the workspace. When you subsequently click and drag the gallery you want to
add over the group you want to add it to, the four docking arrows now appear in the
center of the gallery group.

2.

To remove a gallery from the group, click its tab and drag to move it away.
When you auto hide or close a gallery group, all gallery tabs in the group are displayed in
the workspace border nearest to the last docking location.

Using galleries
To fold or unfold a section in a gallery:
 Click the FOLD/UNFOLD icon.
 Or double click the title strip.
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 Or right click a section to display a pop-up menu. Select FOLD/UNFOLD section. The
pop-up menu also has options to scroll to the previous section or next section.

This illustration shows the gallery is unfolded. Other galleries are similar.

The buttons along the top depend on the gallery (e.g. FILL and TRANSP are specific to the
BITMAP GALLERY .) However, most galleries have these buttons:
APPLY
MORE





applies the selected item in the gallery. Click on an item to select it.

opens a menu from which you can choose from the following:

is described later in searching for an item name.
is described later in re-ordering items in a gallery.
PROPERTIES provides control over size of the icons and amount of information
displayed in the gallery.
FIND

SORT
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(clipart, fill, and fonts galleries) is described later in adding to a gallery.
(clipart, fill, and fonts galleries) is described later in deleting sections from a
gallery.

ADD

REMOVE

Selecting items
To select an item:
 Click an item to select it.
 Or click an item, then "Shift + click" on another item; all items in between the two
points will be selected.
 Or "Ctrl + click" to add that item to the selection.

Re-ordering items in the gallery
In some galleries, "MORE" > "SORT" opens a dialog box. You can sort by name and,
depending on the gallery, by other criteria. The primary key controls the initial sort. For
some sort parameters such as file type or name length, there may be two or more files
with the same type or name length. These files can be further sorted using the secondary
key.

Searching for an item name
You can search, for example, for all names containing the word red:

1.
2.
3.

Choose "MORE" > "FIND" .
Type "red" into the text box.
SEARCH NAMES & KEYWORDS"
SEARCH ALL INFORMATION"

Adding to a gallery
You may want to add extra items to these galleries ( LOCAL
galleries only). To do this:

DESIGNS , FILL

& FONTS

4.

For the LOCAL DESIGNS GALLERY these files can be any of a wide range of
vector or bitmap file types.
For the FILL GALLERY they can be any of the bitmap formats supported by
Designer Pro (listed in importing and exporting (on page 562)).
For the FONTS GALLERY they can be Adobe Type 1 or TrueType fonts.
5. In the appropriate gallery, click the "DISC DESIGNS /FILLS /FONTS" button. This opens
a dialog box.
6. Use the dialog box to select the directory you want to add.
-

7.

ADD"
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If you later want to add more items to the folder:

1.
2.
3.
4.

Copy the new files into the existing folder.
In the gallery, click "DISC DESIGNS/FILLS /FONTS" . This opens a dialog box.
Use the dialog box to select the folder you want to add.
UPDATE"

Deleting sections from a gallery
To delete a section from a gallery (CLIPART , FILL & FONTS galleries only):

1.
2.

Click on the title strip of the section or sections you want to delete.
REMOVE"

If you later want the section again, add its folder to the gallery (described earlier).

Closing a gallery
By default a gallery’s AUTO HIDE button is enabled (i.e., the gallery’s AUTO HIDE button in
the top right corner is unpinned), so that the gallery closes automatically when you move
the mouse pointer away from it.
However if you have disabled the
close the gallery manually.

AUTO HIDE

button (pinned the gallery), you have to

To close a free-floating gallery, click the CLOSE button in the top right of the gallery. The
gallery closes and its tab is displayed in the gallery bar.
To close a docked gallery, click the AUTO HIDE (pin) or CLOSE button in the top right of the
gallery. The gallery closes and its tab is displayed in the workspace border where you
docked it.
To re-open the gallery, hover over or click on its tab.
Note: To remove a gallery completely, choose
choose the gallery you want removed.

GALLERIES

from the UTILITIES menu and

The Name Gallery
The NAME GALLERY gives you information about the current document, and is an easy
way to manage the various elements of your document. It lists:
 Names – you can name objects using either the NAME GALLERY or the NAMES DIALOG
(via NAMES BUTTON in the SELECTOR TOOL).
 Fonts used – if you have text in your document, then the used fonts will be listed.
 Bitmaps used – a list of bitmaps currently used.
 Colors used – The USED COLORS section of the NAME GALLERY lists the colors used.
 Styles used – Use this section of the gallery to select text on the current page that
uses a given style.
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Note: In the case of multi-page documents, the Name Gallery lists the items usage by
the current page. All Names are shown anyway, because a Name can be present in the
document without actually using it. In the case a Name is not applied to an object on the
page, the little selection circle (see below) is not present before the Name.
To display the NAME GALLERY :
 Choose "UTILITIES -> NAME GALLERY" ("Ctrl + Shift + F9"),
 Or click the NAME GALLERY button on the GALLERIES bar.

With the commands on the buttons you manipulate names, for some commands to work,
a name, a property like color or font and/or an object has to be selected:



is used to give names to objects.
opens the NAMES dialog (on page 70) to apply a new or existing name to the
selected object(s).
APPLY
NEW
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DELETE

deletes a name from the NAME GALLERY and from any objects using that

name.


INTERSECT

selects the objects that have all the selected items (name, font, bitmap or

color).


deletes a name from any objects using that name, but does not delete it from
the NAME GALLERY .
 RENAME changes the name shown in the NAME GALLERY .
 REDEFINE changes which objects use a name.
 MORE reveals some more options:
SELECT selects (in the document) the objects that have any of the selected items
(name, font, style, bitmap or color).
EXPORT exports the selected named objects.
HELP shows the according help article
REMOVE

Naming objects
You can apply names to any object in Xara Designer Pro X using the “Apply,
remove or inspect names of objects” button on the SELECTOR TOOL InfoBar.
Alternatively right click an object and choose NAMES from the drop-down list.

Naming is a general mechanism which has a variety of uses, some of which are
described below. Most commonly names are used to form loose sets of objects.
Example uses of names
 Record information about the objects, e.g. what they are used for;
 Select the objects. This is particularly useful if the objects are widely separated in the
drawing or in a complicated drawing. One click and you can select just those objects
that share a name;
 Selectively export parts of the document. This is particularly useful for web pages with
complex graphics, which are often split into "slices" (or small parts) on the web page;
 For linked stretching where one named object can automatically stretch another
named object. For example, changing the text on a button can automatically change
the width of the button.

Document handling
 Animations - names are used in animations to mark objects which are to be tweened
by the exporter. See the Animations chapter (on page 519) for full details.

This dialog is modeless, so you can change the selection while the dialog is displayed. It
shows the names for the current selection. The text field at the top of the dialog shows
you how many objects are currently selected.

Adding names
To add a name to an object, select the object and open the NAMES dialog using the
button on the SELECTOR TOOL InfoBar or right click on the object and choose NAMES...
Type the new name into the APPLY NAME field, or use the drop down list on the same
field to select a name which is already used elsewhere in the current document. Click
ADD . You should see the name appear in the NAMES APPLIED list.

Names applied
The NAMES APPLIED field shows you the names applied to the current selection. If more
than one object is selected, a list of names is only shown if all objects in the selection
have exactly the same set of names applied. Otherwise “<many>” is displayed, indicating
that there are differences in terms of the names applied to different objects in the
selection.
To remove a name from the selected object(s), click the name in the
to select it and then click the REMOVE button.

NAMES APPLIED

list
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Exports, slices, and stretches properties
In this list box you can select which property of the used names are
shown in the Name Gallery.

Exports

These options are used when exporting graphics as a series of slices (on page 576) and
for batch exporting.
A click on the arrow displays a dialog box that lets you select the file name, destination
folder and file format to export in. By default the file name is the same as the name in
the Name Gallery. Note that clicking "APPLY" just stores the selected options, and that it
doesn't save a bitmap; do this by exporting the image with the MORE > EXPORT option.
(Extension displayed depends on the file format chosen.) Click the box to open the
"Export dialog (on page 596)" to specify more details. Click "APPLY" to store the
selected options.

Slices

When you choose the SLICES check box those named objects slice underlying objects.
For more information on image slicing read Image slicing (on page 576)

Document handling
Note: When exporting images as slices, the chosen destination folder from the exports
property is ignored. All the sliced graphics must be in the same folder, and the
destination folder is that selected for the HTML file when you export the slices.

Stretches
You can use named objects to stretch other named objects, e.g. the text on a button.
Both the text and the button are named objects, with the text flagged as stretching the
button. When you change the length of the text (for example by typing in more
characters), the button automatically resizes to match.
When you choose STRETCHES properties, a check box to the right of object names shows
those objects you want to stretch. The arrow to the right of the check box shows if the
stretching options are set up (solid arrow) or not (hollow arrow). Click the arrow to display
the EXTEND DIALOG BOX which lets you select those objects from the list of named objects
to control the stretching. For each direction you can select if the size changes in the
same direction as the controlling object (EXTEND ) or equally from the center (SCALE ).

Undo and Redo
The undo command
"UNDO " cancels the effects of the last operation. To undo an operation:

 Click UNDO on the standard control bar.
 Or choose "EDIT" > "UNDO " (the exact wording tells you what the next undo step is, i.e.
undo scale).
 Or press "Ctrl + Z".
 Or press the comma key (in any tool except the TEXTTOOL ).
You can repeat the undo command to step back through the sequence of previous
operations.

The redo command
Redo cancels the last undo command. To redo the last operation:
 Click the REDO button on the standard control bar.
 Or choose "EDIT" > "REDO" (the exact wording tells you what the next redo step is, i.e.
redo scale).
 Or press "Ctrl + Y".
 Or press the period (full stop) key (in any tool except the TEXTTOOL ).
You can only redo immediately after undo. You cannot redo after changing the document
(for example, by moving or adding an object).
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Object Handling
Moving objects
To slide an object across the page

1.
2.

Choose the SELECTORTOOL .

The constrain angles are user definable. Refer to "Customizing Designer Pro (on page
607)"
Hold down "Ctrl + Alt" and you can drag the selected object even if the pointer is not over
it. This is useful when the selected object is hidden behind another object or part of a
group. Release "Ctrl" and "Alt" after you start the move unless you want to constrain the
move.
You can also move objects using the arrow cursor keys. This is described on the next
page.
Object snapping is a very powerful way of accurately aligning lines, points and the edges
of objects to any other object so they exactly touch. It also helps you align to the
horizontal and vertical center lines of the page.
To toggle object snapping, click the SNAP TO OBJECTS button or right click and
choose "SNAP TO" > "SNAP TO OBJECTS" . You can also choose "WINDOW" >
"SNAP TO OBJECTS" .
Click and drag on the object you want to snap. As you drag, Designer Pro displays a
magnet icon whenever you are near a "point of interest" or potential snapping site
relative to a visible object on the page.
To snap in a path relative to the page center (both horizontally and vertically), move the
object over the lines that appear as you drag on the page. A red dot on the line also
indicates potential "point to path" snapping points, so that you can snap the object to a
point such as the center or center line of the page.
See Snapping (on page 88) for details on snapping to grid and snapping to objects.

Object Handling
Drop copy
During a move (and while still holding the left mouse button down) click the right mouse
button or press + on the numeric keypad to drop a copy of the object. The original object
doesn’t move. You can do this as many times as you wish to create a series of
duplicated objects.
You can also hold down the right mouse button and drag a copy of the object. Left click
to leave a copy at the current mouse position.

Fills
Usually, moving an object also moves the fill with it:
Normal move left to right with a linear filled object.
This also applies to rotating, skewing, scaling and
stretching objects.

Designer Pro can also move the object but not the fill origin.
To do this click the "−" key on the numeric keypad during
the move.
The same move, but pressing "−" (minus) during the drag.

Nudging objects
Usually you can move an object a small amount by using the arrowkeys to nudge the
object (these keys sometimes have other uses, especially in the TEXTTOOL ).
Nudging is not affected by either magnetic or grid snapping (snapping is described later).

Nudge modifiers
To modify the nudge distance, use these key combinations while using the arrow keys:






Ctrl
nudge 5 times the normal distance
Shift nudge 10 times the normal distance
Ctrl + Shift
nudge by l/5th the normal distance
Alt
nudge by 1 pixel
Alt + Shift
nudge by 10 pixels

You can change the normal nudge distance under the GENERAL tab in "UTILITIES" >
"OPTIONS ". Refer to "Customizing Designer Pro (on page 612)".
Nudge works in most tools.
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Cut, copy and paste
These let you move or copy an object in the same document or between different
documents. The procedure is:

1.
2.
3.

Select the object.
To remove the object, choose "EDIT" > "CUT " (or "Ctrl + X"). To copy the object but
not remove it, choose "EDIT" > "COPY " (or "Ctrl + C"). Either option puts the object
(or a copy of it) onto the clipboard.
EDIT"

PASTE

INSERT

Note that if the objects you copy are all on the same layer, then you can paste those
objects to any layer by first making it the current layer and then choosing "EDIT" >
"PASTE" > "PASTE IN LAYER" or "PASTE IN PLACE IN CURRENT LAYER" . The layer from
which the objects were copied is ignored in this case.
However if the objects you copy are on several different layers, then the layer structure
is maintained when you paste.
This allows you to copy layered data within a document or to a different document. Any
layers which are missing in the target document are created automatically by this
operation. So for example if you copy a mouse-over button, which has one object on the
MouseOff layer and another object on the MouseOver layer, to a new document, the
MouseOff and MouseOver layers will be created if they don’t already exist and the button
objects copied onto them.
"Ctrl + Shift + V" or "EDIT" > "PASTE IN PLACE" pastes the clipboard contents into the
same X/Y position from where they were cut or copied or the same position relative to
the bottom of the page in the case of footer objects. This only applies to objects cut or
copied from within Designer Pro. Objects imported from other programs are always
pasted into the center of the current view.
The object remains on the clipboard so you can paste the same object several times.
You can paste the clipboard content into multiple pages of your document by simply
selecting the pages in the PAGE AND LAYER GALLERY. A simple "Ctrl + V" paste will place
the object in the center of the page when you have more than one page selected.
If there is a choice of formats on the clipboard, Xara Designer Pro X will display a PASTE
SPECIAL dialog which allows you to choose the format you want to paste in (eg. When
pasting in text you may have the choice of pasting in unformatted text or Rich Text).
In addition you may see the following paste options, depending on the clipboard
contents:

Paste unformatted text
Pastes any text on the clipboard into your document without any formatting.

Object Handling
Paste in place (Ctrl+Shift+V)
The same as Paste, except your object will be pasted in the exact same position from
which you copied it. This is useful for moving objects from one layer or page to another,
without changing its X/Y position

Paste format/attributes (Ctrl+Shift+A)
Preserves the format (e.g., font and font size) or style attributes (e.g., line and fill color) of
the pasted object. It is a quick way of applying multiple attributes. When you Paste
Attributes, the attributes of the objects on the clipboard are applied to all the objects
currently selected

Paste position
This option applies the position of a copied object on the clipboard to a currently selected
object, which moves to the exact same position as the copied object.
If multiple items have been copied to the clipboard, Designer Pro treats them as if they
are a group and moves the currently selected object to the position of the copied group
as a whole.
The currently selected object is pasted or moved into the center position of the copied
object or group of objects.

Paste size
This option applies the size of a copied object on the clipboard to a currently selected
object, which resizes around its center to the exact size of the copied object.
If you have multiple items selected when you ‘paste size’, each of those objects is made
the target size, instead of the selection as a whole. So for example if you copy a 200x200
pixel photo, then select 10 other photos and ‘paste size’, all 10 photos each become
200x200 pixels. This gives a quick way to make a bunch of objects a particular size.

Paste size and position
As the name suggests, this option applies both the size and exact position of the object
on the clipboard, to the selected object. This useful for making text areas have the same
size and position on each page of your document, if you have previously made them
different.

Paste replacing selection
This is similar to PASTE POSITION , except that the copied object on the clipboard replaces
the currently selected object and retains the deleted item's position.
The copied object is pasted into the center position of the deleted object.

Paste in current layer
The same as PASTE IN PLACE, except your object will only be pasted into the current
layer.
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This is useful if you want to display or hide just your pasted object when layers above or
below are displayed.

Paste in place in current layer
The same as PASTE IN CURRENT LAYER, except your object will be pasted into the current
layer in the exact same position from which you copied it.

Paste opacity mask (Ctrl+Shift+M)
See Opacity Masks

Paste opacity mask in place
The same as PASTE OPACITY MASK , except your opacity mask will be pasted in the exact
same position from which you copied it. This is useful for moving opacity masks from one
layer or page to another, without changing its X/Y position.

Paste on all pages
Pastes the copied object at the same size and position on all pages of the document.

Cut, copy and delete with a mask
If there is an active mask present, it modifies the behavior of the cut, copy and delete
operations. Only the unmasked area of the selected objects is cut, copied or deleted.
This provides a quick way of cutting up photos or whole drawings.
See Operations That Use a Mask (on page 310) for more details.

Removing objects from the document
First select the objects you want to remove. You can then either cut the objects to the
clipboard or delete them.

Cutting objects
Choose "Edit" > "Cut", or press "Ctrl + X".The contents of the clipboard are overwritten
and you can paste the deleted object(s) somewhere else if desired.

Deleting objects
Right click and choose DELETE or choose DELETE from the EDIT menu, or press
the "Delete" key, or click the DELETE button on the STANDARD control bar.
In this case the deleted objects are not put onto the clipboard. If you accidentally delete
an object, undo retrieves it.

Object Handling
Duplicating and cloning
Both these options create a copy of the selected object. The original object is deselected
and the duplicate or clone becomes the selected object.
You can also duplicate an object during moving, rotating, scaling, or skewing. During the
drag action (and while still holding the left mouse button down) click the right mouse
button or press "+" on the numeric keypad to drop a copy of the object. The original
object doesn’t move. You can do this as many times as you wish to create a series of
duplicated objects.
So an easy way to create one or more copies of an object that is exactly horizontally or
vertical aligned, is to drag the object, hold "Ctrl" to constrain the movement, and right
click (or press "+" on the numeric keypad) for each copy required.

To quickly create a line of objects, draw one, then drag while holding "Ctrl" and right click for
each copy required.

Duplicating
Choose "Edit -> Duplicate", or press "Ctrl + Alt + D", or select the object in the PAGE &
LAYER GALLERY (on page 177) and click the DUPLICATE button. The copy is displaced
slightly, usually down and to the right, from the original.
The duplicate distance is user definable, see "Customizing Designer Pro (on page 613)"

Cloning
Choose "Edit" > "Clone", or press "Ctrl + K". This
places a copy exactly on top of the original. Cloning is
an easy way to create concentric shapes.
This example uses an original large letter "A" with a
black fill and a 4pt thick white outline and a clone with
no fill and a 1pt black line.
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Moving objects forward and backwards
Complex documents have objects stacked on top of each other, such as this target:

The target on the left is made from three circles stacked on top of each other.

To ensure that objects overlay each other in the correct order, you often need to
rearrange their order from front to back. The front object always covers lower objects,
and objects always cover other objects which are further back. Each new object you
create is always created on top of older ones.

Object Handling
The PAGE & LAYER GALLERY is useful for viewing and manipulating the stacking order of
objects. It shows you the objects in their stacking order. The order of objects in the
gallery from top to bottom, mirrors the stacking order of those objects in the design from
front to back. So the target design above looks like this in the Page & Layer Gallery (on
page 177):

And you can change the stacking order of objects using the Page & Layer Gallery by
simply dragging them up and down. So for example in the target design, dragging the
blue circle in the Page & Layer Gallery, and dropping it above the green circle will bring
the blue circle to the front. The ARRANGE menu gives you four options:


("Ctrl + F"): This makes the selected object the front object, and it will
hide any other object it covers.
 MOVE FORWARD ("Ctrl +Shift + F"): This moves the object up a level towards the front
rather like climbing a staircase one step at a time.
 MOVE BACKWARD ("Ctrl +Shift + B"): This moves the object one level towards the back.
 PUT TO BACK ("Ctrl + B"): This moves the object to the back.
BRING TO FRONT

These options move objects forwards and backwards within their layer . MOVE TO LAYER
IN FRONT and MOVE TO LAYER BEHIND lets you move objects between visible layers
(invisible layers are skipped when moving objects).
Read more in "Page & Layer Gallery (on page 177)"
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Rotating objects

This is part of the SELECTOR TOOL .
When in rotate mode, the transformation center (around which the object rotates)
initially appears in the center of the object, as shown by a small target like this.
Simply click on a object again to put the selector into rotate mode, or click the ROTATION
HANDLES button on the InfoBar.

To move the transformation center:
 Drag the transformation center target where required.
 Or use the 3x3 matrix on the InfoBar for accurate positioning.

 This moves the transformation center to the corners, the center or the side mid-points
of the object or selection. The transformation center aligns with the outer edges of the
object. This means that if the object has a thick line applied, the transformation center
can be outside of the object.
Attention: If the rotation center is moved, it remains in this location for any selected
object until all objects are deselected, at which point it returns to the center of any
selected object.

Rotating using the mouse
The SELECTOR Tool must be in rotate/skew mode (the selection handles are arrow
shaped).
Dragging the side handles stretches the object. This is described in Stretching and
squashing objects (on page 170).
Drag on a corner arrow. As you drag, the object rotates around the transformation center.
The InfoBar shows the current rotate angle.
"Shift + drag" to rotate the object around its center (the transformation center is ignored).

Object Handling
Hold down "Ctrl" to restrict rotation to the constrain angles. Note that the set of constrain
angles includes those rotations which align the object with the screen. This makes it very
easy to ‘straighten’ any object with a straight edge – just hold down the Ctrl key and
rotate until the object snaps to the screen-aligned rotation you want.
The constrain angles are user definable. Refer to "Customizing Designer Pro (on page
612)".
To create a copy while rotating, click "+" on the numeric keypad while rotating, or click
the right mouse button.
To quickly create a fan like this, draw a single line, then position
the transformation center in the bottom right (click the bottom left
button of the 3x3 transformation center control on the InfoBar),
and then as you drag rotate the object, right click for each
successive line you require.

Rotating by exact angles (using the InfoBar)
Type an angle into the rotate box and press "". Positive angles rotate anti-clockwise
and negative angles rotate clockwise.
Click the arrows to the right to nudge the rotate angle.

Rotating objects in Resize Mode

It is possible to rotate and skew an object even if not in rotate mode. Using resize mode,
move the mouse pointer into the according small areas near the selection area handles
as illustrated above. The mouse pointer changes into a rotate or skew icon, showing you
that you are now able to rotate or skew the object by dragging with the mouse.
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Scaling (resizing) objects

This is part of the SELECTOR

TOOL .

Scale Line Widths button
The SCALE LINE WIDTHS button on the SELECTOR TOOL InfoBar is used in many
operations where the width and height of the selected objects are important. It controls
whether the line attributes (not just line widths) are taken into account when working out
the size and position of the selected object(s).
With the SCALE LINE WIDTHS button set, scaling an object also
scales its line widths. With this button unset, line widths remain
unchanged.
You can toggle this button during drags by clicking "/" on the numeric keypad.
If you have a rectangle with a 4 pixel line width, as you turn SCALE LINE WIDTHS on and
off you'll see that the X, Y W And H fields in the SELECTOR TOOL change as the effects of
the line width are included and excluded.
The following features are affected by SCALE LINE WIDTHS :







Position and size as reported on the SELECTOR TOOL InfoBar XYWH fields
Changing position and size by entering values into the InfoBar XYWH fields
Changing size by entering values in the W% H% fields
Scaling/stretching objects by dragging in the Selector tool
Alignment
Snapping

The line attributes that are taken into account when








SCALE LINE WIDTHS

is turned on are:

Line width
End caps
Join type
Dash pattern
Arrowheads
Brush style
Stroke type (inc. variable width strokes)

In general, if you are interested in the visual positions of objects you should turn SCALE
LINE WIDTHS on. If you're interested in the exact positions of lines (e.g. where the centers
of lines are, as is typical in technical drawings) then you should turn SCALE LINE WIDTHS
off.

Object Handling
Lock Aspect button
With the LOCK ASPECT button set, the width/height aspect ratio
remains constant as you scale the object.
In other words, the shape remains in the same proportions as the original. It’s
recommended that this button remains selected most of the time in order to ensure that
when you resize objects they do not become squashed.
With this button unset, you can change the aspect ratio as you scale the object, in other
words, you can stretch object one way or another when dragging a corner resize handle
or when entering a new size.
Note that this setting does not apply when scaling using the side, top and bottom
selection handles, since these are for deliberately changing the object width/height.

Scaling Photos (web documents only)
When dragging the SELECTOR TOOL'S side handles on a photo in a web document,
instead of squashing or stretching the image (which is rarely useful and almost always
spoils it), the photo’s cropping is modified. Again, if you really want the image to distort,
hold down Alt during the drag.

Scaling using the mouse
The SELECTORTOOL must be in
scale mode (the selection
bounds handles are squares). If
necessary, click on the object to
change to scale mode.
Drag one of the corner handles. The object scales as you move the pointer diagonally.
The InfoBar shows the current scaling. The object will scale between the dragged handle
and the opposite one. To use any other point of the object as the fixed point move the
transformation center to it and use the InfoBar buttons to scale (on page 86).
Hold "Shift" while dragging to scale the object around its center. This works
independently of the position of the transformation center.
"Ctrl + drag" scales the object in multiples of its original size (x2, x3, and so on).
To create a copy while scaling (leaving the original in place) right click, or press "+" on
the numeric keypad.
Dragging the side handles stretches or squashes the object. This is described in
Stretching and squashing objects (on page 170).
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Scaling using the InfoBar

Type into the SCALE TEXT boxes and press "".
 Scalings below 100% reduce the object. 50 halves the size of the object.
 Scalings above 100% enlarge the object. 200 doubles the object size.
If LOCK ASPECT is set, you can type into either text box to resize the object by the
desired percentage. If this button is unset, you can enter separate values for both
the width and height.
Alternatively, type the required size of the object into the W or H text boxes.
If the LOCK ASPECT button is on, this scales the object and maintains the aspect ratio.
You can enter the size in any unit, such as 1 cm.
Scaling with the InfoBar buttons (or number boxes) always scales around the
transformation center. You can position this anywhere else in the object, as described in
"Rotating objects (on page 82)".
If you scale a text area or text column using the SELECTOR TOOL , the text itself is not
scaled, only the dimensions of the area or column are changed. Use the TEXT TOOL font
size control to change the actual text size. However if the text is inside a Group, resizing
the group will scale the text.

Scaling text areas and columns
If you scale a text area or text column using the SELECTOR TOOL , the text itself is only
scaled if you use the corner control handles, if you use the other control handles the
dimensions of the area or column are changed.
Additionally you can use the TEXT TOOL font size control to change the actual text size.
However if the text is inside a Group, resizing the group will scale the text.

Scaling groups
If you scale a group using its side handles, an attempt is made to scale it smartly rather
than just squashing all members of the group. This is commonly useful when attempting
to make a narrower ‘mobile-friendly’ website variant of a wider website – you need to
make wide objects like headers and footers fit the smaller page width.
Take this footer group as an example:

Object Handling
The result you get should look something like this:

The text has remained the same size and the rounded corners have been preserved.
This works better for some groups than others, depending on the design and complexity
of the group. If instead you want a simple ‘squashed’ result, where each member of the
group is simply scaled, all you need to do is hold down the Alt key while performing the
drag.

As you can see the text has been squashed and the rounded corners are no longer
round. But this can be useful for some groups, typically graphics that don’t include any
text or rounded corners.

Perimeter & Area
The 2 controls on the right of the Selector tool InfoBar show the
perimeter and area of the current selected shape(s). Perimeter is
shown in the current units for the document and area is shown in the
current units squared. These fields are not editable.

Flipping objects
This is part of the SELECTORTOOL . Clicking on the FLIP buttons flips the
object vertically or horizontally around the transformation center.
The scale and aspect ratio do not change; the object just flips.

Stretching and squashing objects
This is similar to scaling objects except that the object is scaled in one direction only.
Stretching and squashing are basically the same action — stretching makes the object
larger, squashing makes it smaller.
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Stretching/Squashing using the mouse
The SELECTOR TOOL must be in scale mode. (The selection handles are squares.) If
necessary, click on the object to change to scale mode.
Use the side, top and bottom handles, instead of the corner handles, to stretch or squash
a shape in one dimension only. Note that these handles are shown only on rectangles
which are not photo filled, because stretching other objects in one dimension rarely
produces useful results (photos become distorted).
Drag one of the side handles. The
object scales as you move the
pointer in the appropriate direction.
The InfoBar shows the current
scaling.
The LOCK ASPECT button is ignored.

Right click or press "+" on the numeric keypad while dragging to stretch or squash a copy
of the object, leaving the original in place.

Stretching/squashing using the InfoBar
The LOCK ASPECT button must be unset (if it is set, you scale the object instead of
stretching or squashing it).
Type into either the width or height text box (as appropriate) and press "". Alternatively
enter a % scale (width or height). So entering 200% into the top % scale box will make
the object twice as wide, but the same height.
If you scale a group using its side handles, an attempt is made to scale it smartly rather
than just squashing all members of the group. If instead you want a simple ‘squashed’
result, where each member of the group is simply scaled, all you need to do is hold down
the Alt key while performing the drag. See Scaling groups (on page 86) for more info.

Snapping
Snapping makes it easier to position edges, or specific points on objects, exactly where
required. It can be used to align edges to a specific point or line, or to evenly space
objects, using the grid.
Xara Designer Pro X offers three types of snapping.
 Snap to grid
 Magnetic snapping (snap to objects)
 Snap to guidelines or guide objects

Object Handling
Grid snap is useful for making objects evenly spaced, or making the sizes exact multiples
of a given value. Guidelines are useful for aligning edges (although it’s a lot more
powerful using guide objects) and lastly magnetic snap is a general purpose way of
accurately positioning lines, points or object edges relative to other objects or to the page
center or edges.

Snap to grid
When SNAP TO GRID is selected, grid points act like magnets. Right click on the
pasteboard and choose "SNAP TO" > "SNAP TO GRID" or use the menu option "WINDOW" >
"SNAP TO GRID" , (or press "." (decimal point) on the numeric keypad). You can control the
grid spacing from the options dialog (right click and choose PAGE OPTIONS or use the
menu command "UTILITIES " > "OPTIONS ") on the Grid and Ruler tab.
When dragging objects the edges will snap to grid points. If the size of the object is such
that opposing edges can't both be snapped, the edge that snaps depends on the
direction the object is dragged in.

This shows a coarse grid with 5 subdivisions between major divisions. The shape has a very
thick gray outline. Because the object has been dragged down and to the left, the lower and
left outside edges are snapped to the nearest grid point.

Note: The default grid spacing is 50 pixel spacing for major grid lines with 50
subdivisions. This means the grid is spaced at exactly one screen pixel and so may
appear not to be working at a normal 100% zoom. If you zoom in to say 500% then you
can see it does snap correctly.
Alternatively, change the grid values to have, say, 10 subdivisions which means that the
grid points are on 5 pixel boundaries.

Snapping and line widths
The SCALE LINE WIDTHS control on the SELECTOR TOOL
InfoBar affects whether snapping happens to the bounds of
objects including their outlines.
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The above example shows a shape with a very thick gray outline. It also shows (thin
black line) the outline of the shape itself (you can see the thick outline is drawn equally
on either side of the center line so that it partly overlaps the inside of the shape and
partially goes outside).
With scale line widths on, the width of the outline is deemed to be important and so ‘snap
to grid’ will snap the bounds of objects, including outlines, to the grid. Snap to objects will
allow you to snap using the bounds or the outline center lines. If the outlines as they
appear on screen are small, so there is little difference between these two snapping
positions, bounds snaps are favored. So zoom in if you want to snap outline centers in
this case.
With scale line widths off, ‘snap to grid’ and ‘snap to objects’ will snap the center lines of
objects, ignoring the outline widths.
Because snapping honors the Scale line widths switch it means that the bounds used by
snapping are always the same bounds that are reported in the SELECTOR TOOL InfoBar.

Magnetic object snapping (snap to objects)
Magnetic object snapping makes it much easier to accurately position objects relative to
each other or relative to the page center or edges.
So, for example, if you want several lines to start at exactly the same point, or want a line
to exactly join the edge of a circle, then using "magnetic object snap" is useful.
You can even use this to align the centers of objects, or align objects to the center of the
page, or align them horizontally and vertically anywhere in the middle of the page.
Magnetic snapping works when either moving or scaling objects using the
TOOL .

SELECTOR

To toggle Magnetic snapping to objects on and off, click the SNAP TO OBJECTS
button in the top toolbar. Alternatively right click the pasteboard and choose
"SNAP TO" > "SNAP TO OBJECTS ", or use the menu option "WINDOW" > "SNAP TO
OBJECTS ". You can also toggle it on/off during dragging by tapping ‘s’.

Click and drag on the object you want to snap. As you drag, Designer Pro displays a
magnet icon, blue lines and red points whenever you are near a "point of interest" that it
has snapped to.

Object Handling
Snap indicators

Snap indicators are shown whenever a snap occurs. That is whenever a point of interest
on the object you are dragging comes in range of a point of interest in the document
(which could be on another object or be part of the page). Designer Pro snaps to the
point of interest and the mouse pointer changes to show a magnet symbol so you know a
snap has happened. Also further indications are shown dynamically on screen to help
you see what snap has occurred.
 A red dot indicates that a specific point has snapped
 A blue line indicates a snap to some feature of another object (e.g. to the edge of a
rectangle).
 An orange line indicates a snap to a page feature (corners, edges, center)
The snap indicator lines pulse to show that they are temporary "live" indicators and to
help them be seen over different background colors.
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The snapping distance is controlled by the MOUSE tab of the OPTIONS dialog box
("UTILITIES" > "OPTIONS " or right click a page and choose PAGE OPTIONS ).

You can specify two snap distances in the "Magetic snap radii" section, which control
how close things need to be before they will snap together. The size of a circle around
points (point) and the distance either side of lines (lines). It's usually best to make the
point value larger than the line value, so that it's easier to snap to the end points of lines.
Customizing Designer Pro (on page 607) has full details of the Options dialog.

Snapping modes
You can change the behavior of snap to objects while dragging by tapping a key to
toggle different modes on and off. These mode changes are effective only for the
duration of the current drag.
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S

Toggle ‘snap to objects’ on and off. This temporarily overrides the Windows>Snap to objects setting.

G

Group snapping. By default, to minimise the complexity and numbers of
snapping lines shown, objects inside groups are ignored and only the bounds
and centre of the whole group are considered for snapping. Pressing G turns on
group snapping so that objects inside groups also contribute to snapping just as
if they were not grouped.
Angled snapping. See Angled snapping below.

A

Snapping to original position
When ‘snap to objects’ is on and you drag an object to move it, the bounding box of the
original position of the object is indicated by a red dashed rectangle. This also
contributes to snapping making it easy for you to (for example) move an object in one
dimension only. However note that you can also constrain the angle of any drag by
holding down "Ctrl" while you drag.

Angled snapping
Xara Designer Pro X is not restricted to axis-aligned snapping. With Angled snapping
turned on, the snapping system can snap parallel lines, whatever their alignment, and
find the intersections between crossing line constraints. So for example you can snap the
edge of a shape that runs at 30º with the edge of another running at the same angle.
Angled snapping is not on by default, because in most cases it’s not useful. To activate it
while dragging, simply press the ‘A’ (for Angle) key. Press again to turn off.
Snapping notes
Note: Only the objects that are fully or partly visible in the current view are considered for
snapping. You cannot snap to objects outside the view (except the page).
Note: Snapping distances are measured in screen pixels so if you have several snapping
positions close together it’s best to zoom in to make sure you snap to the one you want.
Note: When snapping text to text, the baseline of the text is favored over any other snaps
that are within snapping distance. This makes it easy to vertically align one text object to
another with matching baselines, which is normally more useful than snapping the
centers or bounding boxes of text for example.

Guide Objects and Guidelines
Guide objects and guidelines are objects on a special layer, the guides layer. A guide
layer is automatically created when you create a guideline (see below), or you can create
one manually by right clicking in the PAGE & LAYER GALLERY and selecting CREATE GUIDE
LAYER (see "Page & Layer Gallery (on page 181)" for more information on layers).

93

94

Object Handling
Use SNAP TO GUIDES in the Window menu (or key 2 on the numeric keypad) to turn on
snapping to guide objects.
Any object placed on the guides layer becomes a guide object. These can be any object
type including lines at any angle, irregular shapes, and quickshapes. You can create,
scale, and delete objects on the guides layer as usual, but they always appear as thin
dotted red outlines; any applied line width or fill color is ignored. This information is
retained, and if you later move the object from the guides layer to a normal layer, line
thickness, and colors are shown again.
You can use guide objects to draw construction lines such as lines passing through a
vanishing point for perspective drawing.

Placing objects onto the Guides Layer
First ensure there is a guide layer in the PAGE & LAYER GALLERY, see above. You can
create objects directly on the guides layer by selecting it and creating objects as usual.
You can also cut or copy
objects from another layer
and then paste those objects
into the guides layer. To
paste the objects in the same
relative position on the guides
layer use the keyboard
shortcut "Ctrl + Shift + V".

The Page & Layer Gallery showing a guides layer above
two other layers, and selected.

and MOVE TO LAYER BEHIND on the ARRANGE menu (or right
click and choose "ARRANGE" > "MOVE TO LAYER IN FRONT/BEHIND") will skip the guides
layer and so cannot be used to move objects onto the guides layer.
MOVE TO LAYER IN FRONT

Creating a guideline
Guidelines are vertical or horizontal lines and are a quick and easy way to align a series
of objects on the page.
 Turn rulers on ("Ctrl + L").
 Drag from a ruler onto the page.
Or
 Double click on the ruler to create a guideline aligned to the click point.
This automatically creates a guides layer and puts the guidelines on that layer.
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Or, using the Page & Layer Gallery (on page 177):

1.
2.
3.
4.
5.

Right click in the Page & Layer Gallery and choose PROPERTIES.
If necessary, click the Guides tab.
Select horizontal or vertical.
Click new.

Deleting a guideline
Using the SELECTOR TOOL drag the guideline onto the appropriate ruler (the vertical ruler
for vertical guidelines, horizontal ruler for horizontal).
Or, right click on the guideline and then choose DELETE .

Grouping and ungrouping objects
The Shadow and Transparency Tools offer different results depending on whether
objects are grouped or not. For more information see "Transparency" and "Shadows (on
page 298)".
You will often create complex shapes from several different objects. The " ARRANGE" >
"GROUP " menu option (or right click selected objects and choose GROUP ) lets you lock
those objects together to form what appears as a single object. You can then select the
grouped objects and copy, rescale, move or perform any other operation on the entire
group.

To create a group
1.
2.

Select all the objects you want in the group.
GROUP

GROUP

ARRANGE

Ungrouping objects
1.
2.

Select the group.
UNGROUP

UNGROUP

After this, all the individual objects in the group remain selected.

To add more objects to a group
1.
2.
3.
4.

Select the group.
Ungroup ("Ctrl + U")
Select the extra objects.

ARRANGE
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You can also incorporate a group into a second group by omitting step 2. Designer Pro
remembers the original grouping information. If you ungroup the objects later, the original
group remains.

Removing objects from a group
1.
2.

Ungroup the objects.

You can then choose "ARRANGE " > "GROUP " to regroup the remaining objects.

Selecting a single object from within a group
This feature called SELECT INSIDE, is useful for changing an object's color, for example.
"Ctrl + click" on the object (you can also use this to select a "group within a group").
Pressing "Tab", or "Shift + Tab" moves the selection within the group, to the next, or
previous object. Once you have selected an object inside a group, you can also use "Alt
+ click" to select the object under the selected one.

Editing inside groups
If you want to edit the objects inside a group, there are broadly two ways to approach
this. You can either select the objects inside the group and work on them directly in your
document, or you can double click on the group to open its contents in a separate
document view.
Selecting inside
If you hold down Ctrl and click on an object in the Selector tool, that object will be
selected even if it’s inside one or more groups. That’s called a "select inside" operation.
Also some tools will let you directly select objects relevant to them inside groups, just by
clicking on them. For example in the Photo Tool you can just click on a photo to select it,
even if it’s in a group.
It is just as easy to replace symbols as which are part of a group as well, either with a
replacement symbol or an image, just right-click on the symbol and select REPLACE from
the context menu.

Editing group contents
If you want to edit several objects inside a group, it can get tedious having to keep
Ctrl+clicking on each one first. So instead you can instantly open the group’s contents in
a separate sub-document view, to make editing much easier.
Double click on a group and a new document view opens (or right click on it and choose
Open from the context menu). It contains only the contents of the group and not the
group itself, so you can select all the direct children of the group just by clicking on them.
You can also draw new objects and these will be added to the group when you save your
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changes back. Since the sub-document contains only the contents of the group, you
won’t see the effects of any group attributes in the sub-document view.
Once you’re done editing the group, hit "Ctrl + S" to instantly close the sub-document
view and save your changes back to the parent document. Or you can close the view
using the close button in the top right of the window, just as you close ordinary
documents, and you’ll be prompted to save or discard any changes you’ve made.
If the group you are editing contains other groups (because the parent document had
multiple levels of nested groups) you can double-click on them to open those in a subdocument too.
Live Copies & Repeating Objects
You can edit inside a Live Copy just as if it was a normal group – just double click it to
open in a sub-document view. As with all edits made to the objects inside a Live Copy,
when you save the changes back, all copies of that Live Copy will be updated. And
similarly you can edit a repeating object the same way.
Molds

You can edit the contents of a mold, which is something that is not possible using direct
selection inside (molds do not allow objects inside them to become selected). Right click
on the mold and choose OPEN MOLD from the context menu.
Limitations
Groups cannot contain layers and so if you introduce any layers while editing a group,
those layers will be ‘flattened’ when you save the changes back to the parent document.
In other words all the objects will be moved to the original single layer on save and any
layer structure you introduced lost.
Similarly a group can’t contain multiple pages and so any pages you add while editing
will be ignored and lost when you save back – only the first page is relevant.
The Automatic Backup facility does not save modifications to open sub-documents. Only
the parent main document is saved when a scheduled backup runs, in its current state
without the unsaved group edits. For this reason it’s recommended that you save group
edits back to the parent document regularly.
If you close the program or shutdown Windows while you have group sub-documents
open with unsaved changes, when you next start the program, the main document will be
loaded and it will include all the group edits that were unsaved at the time of closure.
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Other types of groups
Special types of group are used by some tools and functions to keep objects together
and/or to give an object some special behavior.
When you anchor an object to text for example, the object is placed in an Anchored
Group, as shown on the status line when you select such an object. Similarly when you
make an object repeating (see Repeating Objects (on page 106)) or make it a Live Copy
(see Live Copies (on page 109)) the objects are placed inside a "Repeating group" or
"Live copy group" respectively.
When one of these groups contain a single object, you can directly select that object
instead of selecting the group that encloses it. Look at the Status Line (on page 36) and
the Page and Layer Gallery (on page 181) to see this in action.

Soft Groups
Ordinary Groups as described in Grouping and un-grouping objects (on page 95) sit on a
single layer, they cannot span layers. SOFT GROUPS are an alternative way of linking
objects together where the objects can be across several different layers.
Selecting one member of a Soft Group also selects all other members of the same Soft
Group – even members that are on invisible or locked layers. This means when you
delete, move, rotate or otherwise transform one member of a Soft Group, all the other
members are similarly modified.
The status line indicates when a Soft Group is selected.
Soft Groups are useful for keeping closely related objects together. For example the
MOUSEOFF and MOUSEOVER states of a web button are Soft Grouped together, so that if
one state is moved or transformed, so is the other state.

Creating Soft Groups
To create a Soft Group, select all the objects that are to be included in it and then choose
“ARRANGE > APPLY SOFT GROUP ” (or press “Ctrl+Alt+G”). Note that if the Soft Group is to
include members on invisible or locked layers, you’ll need to make those layers
temporarily visible and editable using the Page & Layer Gallery in order to select the
objects and Soft Group them.
An object cannot be a member of more than one Soft Group and Soft Groups cannot be
nested (soft groups as members of soft groups).

Removing Soft Groups
To disband a Soft Group, select it and choose “ARRANGE" > "REMOVE SOFT GROUP ” (or
press “Ctrl + Alt +U”). The objects don’t get deleted, they are just no longer linked
together by a Soft Group.
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Text Synchronization
In some circumstances text objects in a soft group are kept synchronized so that if you
edit the text of one, the others update too. This feature was added before support for LIVE
COPIES was introduced and LIVE COPIES are much more flexible and powerful, so this
feature is less useful than it used to be. But it’s still relied upon by many of the templates
and elements included in the ONLINE CONTENT CATALOG and is commonly used for
mouse-over buttons, where both the off and over states of the button need to show the
same label at all times. When the button off-state label is changed, the mouse-over state
changes to match.
Also sometimes "shadow-like" effects can be achieved by placing two or more copies of
text very close to each other, but slightly offset. Again, editing one causes them all to
change in sync.
To stay synchronized, the text objects must:
 Be all in the same soft group.
 And have exactly the same text on them at the time when the soft group is created.
 And either have overlapping bounding boxes, or be on different layers or different
animation frames.
If you need text to stay synchronized in other circumstances, use

LIVE COPIES (ON PAGE

109).

Alignment
This lets you accurately align or distribute two or more objects.

Quick aligning
Select the objects you want to align, and right click the selection to choose
the drop-down menu, and then do one of the following:

ALIGN

from

 Align the objects vertically by choosing LEFT EDGES , CENTERS, DISTRIBUTE CENTERS or
RIGHT EDGES .
 Align the objects horizontally by choosing TOP EDGES , CENTERS, DISTRIBUTE CENTERS
or BOTTOM EDGES .

Aligning and distributing space
If you want to distribute space between the objects as well as align them, select the
objects, right click the selection and choose " ALIGN" > "ALIGNMENT" to display the Object
Alignment dialog. Alternatively choose "ARRANGE" > "ALIGNMENT " ("Ctrl + + L").
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The small diagram at the top of the dialog box shows
you the effect of selecting each option. The selected
objects in the document do not change until you click
APPLY .
The alignment dialog is a non-modal dialog, which
means you can keep it on screen and continue to work
on the document at the same time. So you can change
tools, draw, and change your object selection, and then
easily select from the various alignment options.
If you’ve got your selection wrong, you can change the
selection, and just click the APPLY button to apply the
last alignment settings again. This can be a real-time
saver.

Within
This section of the dialog controls the boundaries within which you align or distribute the
objects. The options are:
SELECTION BOUNDS :

The boundaries are the outer
edges of the selected objects. Their relative position
on the page or spread has no effect.

BOUNDS OF BACK OBJECT :

The boundaries are the
outer edges of the backmost selected object. This
object is not affected by the alignment.
You can use this to define the "reference" object when
you want to align several objects in a row, for instance.
With the normal "Selection bounds" options on the
leftmost object is the reference object (the one that
won't move)
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PAGE :

If the objects are on a single page, the
boundaries are the edges of the page. (This lets you,
for example, center objects on the page or align
against the page edge.)

WHOLE PAGE :

In most cases, this is the same as PAGE
unless you have a double page spread, in which case
it will use the bounds of both pages.

Aligning
To align objects, for example, so their left edges are aligned to the left.

1.
2.

Select the objects and right click the selection.
ALIGN

LEFT EDGES

The selected objects move to align the left edges.
Alternatively:

1.
2.
3.
4.
5.

Choose "ALIGN " > "ALIGNMENT" or press "Ctrl + Shift + L" or choose
from the ARRANGE menu to open the Object Alignment dialog.
Select the required WITHIN option, e.g. Selection bounds.
Select ALIGN LEFT for horizontal positions.
Leave vertical positions to NO CHANGE.

ALIGNMENT

APPLY

The selected objects move to align the left edges.
All the align options act in a similar way. For brevity, only the left align option, shown in
the illustration of the dialog box is described. Experiment to learn about the other options.
To quick-select any combinations of vertical and horizontal alignment click with the
mouse in the diagram:
 A simple mouse click aligns horizontal and vertical positions to the clicked position to
any of the nine combinations of top-centrally-bottom/left-centrally-right.
 "Ctrl + mouse click" leaves the horizontal position unchanged and arranges the objects
in a to a top, centrally, or bottom aligned row.
 "+ mouse click" leaves the vertical position unchanged and arranges the objects in a
left, centrally, or right-aligned column.
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Distribute
The distribute options will position all the selected objects evenly across the "Within" area
(usually within the selection bounds, but it could be the PAGE or WHOLE PAGE ).
Again all the distribute options work in a similar way. The following examples show how
the different vertical position options align objects:
TOP EDGES DISTRIBUTION :

the tops of the objects are
evenly spaced. BOTTOM EDGES distribution is the
inverse—the bottom of the objects are evenly spaced.

CENTERS DISTRIBUTION :

the centers of the objects are

evenly spaced.

EQUI-SPACED DISTRIBUTION :the

objects are evenly

spaced from each other.

The horizontal position options are similar but operate in the horizontal direction.
So, for example, to distribute this collection of randomly positioned ellipses, so they are
all equally spaced and aligned to the top edge:







Select the shapes
Display the Alignment dialog ("Ctrl + + L")
Ensure WITHIN shows SELECTION BOUNDS
Select Horizontal positions: Distribute centers
Select Vertical position: Align top
Click APPLY

And they will now look like this, all equally spaced horizontally
and aligned to the top.
Remember if you make a mistake you can always undo the operation.

Current attributes
An ‘attribute’ is some characteristic of an object which you can modify in Xara Designer
Pro X. For example a shape’s attributes include its color, its outline width and its outline
color.
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You can change the attributes of an object after you’ve drawn it, by selecting it and then
changing its fill color, line width, or any of its other attributes. But Xara Designer Pro X
also keeps track of the ‘current’ attributes, which are the attributes that get applied to
newly drawn objects as they are created.

Setting current attributes manually
If, for example, you want the next rectangle you draw to be red, make sure you have
nothing selected (press "Esc" or click an empty part of the page) and then click red on
the color line. You’ve now set the current fill color attribute to red. Now when you draw a
new shape, it will be filled red. You can set other current attributes the same way – by
first making sure nothing is selected before changing the attribute’s value.

Setting current attributes automatically
By default, Xara Designer Pro X automatically updates the current attributes for you, to
match the object you last drew, or last selected. So for example if you draw a rectangle
and then make it green, the next shape you draw will also be green. If you have a blue
rectangle in your design and you wish to draw another one just like it, first select the blue
rectangle (this makes its attributes current) and then the next shape you draw will also be
blue. So by simply clicking an object, you set the current attributes to match that object.
This allows you to use existing objects as a ‘palette’ of available styles. Click an object to
select it, then draw new objects in that style.
You can turn off this behavior in the GENERAL TAB (on page 609) of the "UTILITIES" >
"OPTIONS" dialog. Select the GIVE NEW OBJECTS MOST RECENT ATTRIBUTES (GNOMRA)
checkbox. Now the current attributes will only change when you set them manually, as
described above.

Attribute groups
Many designs consist of a combination of closed filled shapes and open shapes (lines
where the start and end points are not coincident). Normally it wouldn’t be desirable to
have the attributes of an open shape used for a closed shape, nor vice-versa. Therefore
the attributes for open and closed shapes are kept separate – these are known as
attribute groups. Setting the values of one group does not affect the other group. So for
example, selecting a filled rectangle with no outline will not change the current line width
to zero for open shapes.
For the same reasons, text attributes make up a third attribute group. The text attribute
group is only set when you select text objects, or when you set the attributes manually
while in the text tool.

Exempt attributes
Some attributes do not get set as current automatically even when ‘Give new objects
most recent attributes’ is on. This is because some attributes can cause problems if they
become current.
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For example if you applied a 10 pixel feather to a large object (to blur the edges) and
then drew a new 10 pixel sized shape, that new shape would be invisible if the feather
attribute was copied to it, due to the amount of feathering!
Other attributes can adversely affect the way designs export, or significantly increase the
time taken to render the design and so should not be applied unnecessarily.
Examples of attributes which are copied automatically:
 Fill colors, fill styles, line width, line color, line style, line join style, line endcap style,
arrow heads/tails, text font, text font size, text margins.
Examples of attributes which are not copied automatically:
 Feather, transparency, shadow, bevel, contour, 3D extrude, live effects.

Resetting current attributes
You can reset all current attribute groups instantly by pressing "Esc" when you have no
objects selected. If you have objects selected, pressing "Esc" clears the selection, so just
press "Esc" again to reset the current attributes back to their default values.

Copying Styles: Paste Attributes
This lets you copy attributes (such as line pattern or fill color) between objects. It is a
quick way of applying multiple attributes to an object.
The square has a specific color, shadow,
line and fill style. Copying it and then
pasting its attributes on to the circle in the
middle, results in the circle to the right.

1.
2.
3.
4.

Select the object from which you wish to copy the attributes.
Copy the selection to the clipboard. ("EDIT" > "COPY" , or "Ctrl + C".)
Select the object(s) to which you want to apply the attributes.
EDIT"

PASTE FORMAT/ATTRIBUTES

The object remains on the clipboard until overwritten by a cut or copy operation. This lets
you repeat paste attributes as many times as required.

ClipView
ClipView lets you hide or ‘clip’ parts of a shape within another larger shape. The effect is
similar to the Intersect shapes option, described in the chapter on Shape handling (on
page 165). The difference is that the Intersect shapes option actually cuts the objects,
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whereas ClipView just hides the parts outside the ClipView object. What’s more you can
then adjust the position of the objects inside the ClipView.
To create a ClipView:

1.

2.
3.

The ‘window’ object must be behind the other objects
in the ClipView. If necessary move it backwards. In this
example the dark ellipse is the window object.
Alternatively draw the ‘window’ shape on the mask
layer (on page 307).
Select all the objects you want to be inside the
ClipView (including your ‘window’ object unless it is on
the mask layer).
ARRANGE

APPLY CLIPVIEW

Setting the ClipView background color
The fill color of the original object used as the ClipView is the background color. So either
set this to the desired color before setting the ClipView or perform a "select inside" ("Ctrl
+ click") on the background, and then adjust the color.

Select clipping shape
This selects only the shape that you used to do the clipping. Effectively this is the
‘window’ through which you see the other object(s) in the clipview. Once it’s selected you
can move it around or otherwise transform it, to adjust your clipview.

Select clipped objects
This selects all the objects in the clipview that are being clipped. Therefore once these
are selected, you can drag them around inside the clipview to adjust their position
relative to the clipping shape.

Selecting objects in the Clipview
You can perform a "select inside" by holding "Ctrl" and clicking on the desired object.
This is very like selecting objects inside a group described earlier in this chapter
(ClipView objects are a type of group). You can now perform most edit operations on the
object.

Removing a ClipView
Just select the object and the menu "Arrange -> Remove ClipView", or press "Alt + Q".

Soft edged ClipView
With the whole ClipView object selected, you can adjust the FEATHER slider control on
the top bar, to give the whole clipped object a soft feathered edge.

105

106

Object Handling
Note: You can have ClipView objects inside ClipView objects.

Repeating Objects
It's common to have items like navigation buttons, headers or logos repeating on all
pages of your website. Or to have the same logo, header or footer on each page of a
printable document.
Xara Designer Pro X provides the ability to repeat any item in the same place across any
of your pages in a document. When you update one of the copies, Designer Pro
automatically replicates those changes across all pages.
On most of the template designs the main navigation bars are repeating. You can make
any object such as a button a repeating object by right clicking it and choosing
"REPEATING OBJECT" > "REPEAT ON ALL PAGES" . The object is copied to the same place
on all pages, displaying the repeating symbol icon in the top right hand corner. If you
make any further changes to this item all the copies will be automatically updated.
Note: This uses the current page as the source of the repeating items to copy across all
the other pages. So make sure you're on the right page before updating objects. The
current page is the one you're working on, and is shown with markers around the page
corners. Just click anywhere on the page (or even outside it) to make the page current.
Or click the page in the Page & Layer Gallery.

The red box highlights the repeating object symbol, shown on every instance of the repeating
object
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If you don't want a copy of the repeating object on a page, just delete it from that page.
When edited, the repeating object is only automatically updated to those pages that
already have it. This means you can choose which of the pages in your document should
have the repeating object and which should not.
If you want a repeating object on just a few pages of a large website, you can:

1.
2.
3.
4.

First make your object repeat on all pages of your site, using " ARRANGE" >
"REPEATING OBJECT" > "REPEAT ON ALL PAGES" .
Select one of the repeating objects and copy it to the clipboard ("Ctrl + C").
Hit the Delete key and choose the DELETE FROM ALL PAGES option when prompted.

Editing the contents of a repeating object
When Designer Pro creates a repeating object, the repeating items are placed in a
containing 'repeating group', similar to a normal group. If you drill down to a layer
containing a repeating object in the PAGE & LAYER GALLERY , you can see that there's a
repeating group containing each repeating object on that layer.

Designer Pro places each repeating object inside a repeating group

If you want to edit an item inside this repeating group, press "Ctrl + click" on the item to
select it inside (on page 124) the repeating group. Alternatively if you go into a specific
tool you can usually click directly on any object that is applicable to that tool and it will be
selected inside its repeating group (or any other type of group). So for example you can
select a rectangle that’s inside a repeating group by simply going into the Rectangle tool
and then clicking on the shape.
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If the repeating group consists of a single object you can directly select that object
instead of selecting the repeating group that encloses it.
As with any other edits made to a repeating object, any edits you make inside a
repeating group are applied to all instances of that repeating object on other pages.

Locking a repeating object
You can lock a repeating object right clicking it and choosing LOCK REPEATING OBJECT .
Once locked, the object is not selectable. But editing any other copies of that repeating
object on other pages, which aren’t locked, will change all copies, including the locked
copy.

Stopping objects repeating
Right click an object and choose "REPEATING OBJECT" > "STOP REPEATING" to turn off the
repeating nature of an object, or all of its copies in your website. Choosing STOP
REPEATING from the "ARRANGE" > "REPEATING OBJECT" menu also allows this.
You’ll be asked whether you want to just stop the selected object repeating or all copies
of the object in the website. Choose the ALL option. Now the different copies of that
object can be independently edited and the next time one is changed it won’t update any
of them.
Use this if, for example, you’ve used REPEAT ON ALL PAGES to copy an object to all pages
of your website, but then you want to make those objects different on each page so that
they are no longer tied together.
is also useful if you want to make a copy of a repeating object (eg. a
footer or logo) on one page and you don’t want that copy to be updated. In this case
choose the JUST THIS COPY option when prompted.
STOP REPEATING

Note that you can’t use STOP REPEATING on NavBars which have the SITE NAVIGATION
BAR option turned on in the NAVBAR DIALOG . That’s because site navigation bars always
update across the whole website. See the Navigation Bar chapter for more information
on site navigation bars.

Deleting repeating objects
If you don't want a copy of the repeating object on a page, just delete it from that page.
Xara Designer Pro X displays a prompt asking whether to delete just that copy or all
copies of that repeating object.
Pressing "Ctrl + Delete" will delete just the selected repeating object without asking
whether you want to delete all instances or just this one.

Object Handling
Live Copies
Live Copies give you a way of having multiple copies of an object that are linked together
so that if one copy is changed they all change. However each Live Copy can be
transformed independently, so for example you could have larger and smaller versions of
the same Live Copy, or perhaps copies with different rotations.
Live Copies are similar to Repeating Objects, but more powerful because you can have
multiple Live Copies on the same page and they do not share a common position in the
way that Repeating Objects do.

Live Copies are Groups
In common with Repeating Objects and many other advanced object types in Designer
Pro, Live Copies are a special type of group. The object or objects that constitute the
Live Copy reside inside a ‘Live Copy Group’. You can see this structure if you examine a
Live Copy in the PAGE & LAYER GALLERY where it’s called a “Live Copy Group”, but on
the status line when selected the shorter term “Live copy” is used.
When your Live Copy consists of a single object, you can directly select that object
instead of selecting the group that encloses it. Look at the STATUS LINE or the PAGE &
LAYER GALLERY to see this in action.

Local and Global Edits
The objects inside the Live Copy Group are common to all the linked Live Copies. So if
you change objects inside the group those changes are reflected in all the linked Live
Copies. These are “global edits”, because all copies of the Live Copy get the same
changes.
However if you transform a Live Copy (move, scale, rotate or skew it using the SELECTOR
TOOL ) the change is not applied to other copies. These are ‘local edits’, so you can
transform each copy differently if desired.
As with all groups, you need to select the object or objects inside the Live Copy to edit
them directly, so that the changes are reflected in all copies. Many tools will do this select
inside for you automatically if the object you click on is recognized by the tool. So for
example in the QUICKSHAPE TOOL , clicking on a Quickshape that is inside a Live Copy
will select the Quickshape inside, so that you can immediately start modifying it with the
QUICKSHAPE TOOL .
So for example if you have a photo as a Live Copy, any edits you perform with the PHOTO
TOOL on the photo inside the Live Copy group are global edits - all copies of the Live
Copy will get the same photo edit. But if you select the Live Copy, instead of the photo
inside, and make it bigger by resizing it with the SELECTOR TOOL , only that Live Copy is
resized. Other copies do not change in size.
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Creating Live Copies
You can turn any object or group into a Live Copy. Just select the object and choose
"ARRANGE" > "LIVE COPY" > "CREATE LIVE COPY" . A second copy of the object appears
and the two copies are ‘linked’ in that if either one is edited the other copy updates to
match. But you can move and transform the two objects independently, placing them on
the same page or on different pages.
You can make more copies of the Live Copy the same way you copy normal objects,
using copy/paste, duplicate, right-click drag, etc.. Each copy you make belongs to the
same ‘family’ of Live Copies and so editing one also changes all the others.
Try this with an example:

1.
2.
3.
4.
5.

Draw a hexagon using the QUICKSHAPE TOOL and make it red.
Go back to the SELECTOR TOOL . With the hexagon selected, choose "ARRANGE" >
"LIVE COPY" > "CREATE LIVE COPY" . Or right click and choose "LIVE COPY" >
"CREATE LIVE COPY" from the drop-down menu.
A second copy of the hexagon appears and selecting either copy shows “1 live
copy” on the status line.
Make several more copies of the object, using copy/paste, or any other means.
Note that each is a “live copy” according the status line when you select them.
Go back into the QUICKSHAPE TOOL and click on any one of the red hexagons. Note
the status line says “1 Quickshape ‘inside’”. That shows that you’ve selected the
Quickshape object inside the Live Copy group.

6.

Advanced
 You can apply transparency to a Live Copy and this is treated as a ‘local edit’ and is
not applied to all linked Live Copies. That’s because transparency can be applied to a
group and not only to the objects inside the group (see Applying transparency to
several objects (on page 288)). This allows you to put different transparencies onto
different Live Copies if desired. The same goes for other operations that can actually
be applied to a group and not just to its children, like feather and shadow.
 Live Copies force SCALE LINE WIDTHS and TRANSFORM FILLS switches to be on within
themselves. So for instance, a thin line in a Live Copy will always become wider when
you scale the Live Copy up, even if the SCALE LINE WIDTHS switch is off. This is done
to ensure that Live Copies can be reliably updated from each other without
unexpected changes.
 It's not possible to select objects inside two Live Copies at the same time.
 Live Copies cannot be nested. So if you select an existing Live Copy and choose
"ARRANGE" > "LIVE COPY" > "CREATE LIVE COPY" , the result is that the object becomes
part of a new Live Copy family.
 Pressing "Ctrl + Delete" will delete just the selected Live Copy without asking whether
you want to delete all instances or just this one.

Object Handling
Auto-fit to page...
The AUTO-FIT feature enables you to create flexible documents that adapt to almost any
size change you might want. This means you can design social media documents once,
and then easily deploy to a variety of sizes and aspect ratios. You can convert
documents from A5 to A4, or A3 or vice versa. And even change orientation, from portrait
to landscape.

Re-sized Facebook, Instagram and Twitter post templates.
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The feature is controlled by the AUTO-FIT TO PAGE dialog which you can access by rightclicking on any item on the page and selecting AUTO-FIT TO PAGE… You can also find it in
"UTILITIES" > "AUTO-FIT TO PAGE..." .

The Auto-fit dialog controls how items move or stretch as the page size changes

The AUTO-FIT ALL OBJECTS checkbox controls the automatic behavior of all items in the
document. The dialog defaults to AUTOMATIC for all items in your document, but you can
control the behavior of individual objects using the settings in the lower panel.
The AUTO-FIT ALL OBJECTS checkbox turns the feature on. Bear in mind that even if this
option is un-checked existing documents that had items marked as footers, or to stretch,
will continue to behave as usual. This option just enables a more comprehensive,
automatic positioning of items on the page.

Width only or Width & Height
There are two distinct use-cases where you might want automatic positioning of items on
the page:

Object Handling
1.

Websites, particularly ‘blog’ style websites where the pages are of variable length,
depending on how much text you have. Here you do not want the position of items
on the page (typically at the top of the page) to be moved as the page grows. In
this case select the WIDTH ONLY option. This means things will be repositioned when
you change the page width, but not when the page height changes.

2.
WIDTH & HEIGHT
AUTOMATIC FIT

So to summarize for most document types, print, presentations and social media, select
WIDTH & HEIGHT . For websites choose the WIDTH ONLY option.
Click APPLY to effect the change - you can now test the result by dragging the right or
lower page edge to see how things move as you adjust the page size. Or alternatively in
the PAGE OPTIONS (on page 40) dialog, select from drop-down list of common page sizes.

Auto-fit for individual page objects
Once you have enabled the AUTOMATIC FIT option you can control the behavior of
individual objects on the page. By default everything is marked as AUTOMATIC.

To control the behavior of individual objects just select the item you want to control, uncheck the AUTOMATIC checkbox - which will enable all the lower panel settings. You can
now set the position rules for your selection.
Again click APPLY to effect the change - and now test the result by dragging the right or
lower page edge to see how things move as you adjust the page size. Or alternatively in
the PAGE OPTIONS (on page 40) dialog, select from drop-down list of common page sizes.
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The options are...

The TOP , MIDDLE and BOTTOM options for vertical adjustment and the corresponding
LEFT , CENTER and RIGHT , for horizontal adjustments will keep the items the same size (so
won't be stretched, enlarged or shrunk) and at the same position relative to the edge or
center of the page.
So items marked to be TOP , will stay at the same current absolute position to the top
edge. Items marked as LEFT will remain positioned at the left edge of the page.
So if you want a footer to remain at the exact same vertical size and vertical position
relative to the bottom of the page, set the vertical options to be BOTTOM . Similarly if you
want an item, perhaps a logo, to remain at the exact same offset in the top right corner,
irrespective of page size, then set it to be TOP and RIGHT .

% Position

Items marked with either of these options will not change size as the page is enlarged or
shrunk, just be moved to remain at the same relative position on the page. For example
an item that is 1/3rd of the way across the page will always be 1/3rd across the page.

% Scale height or width

This is like the AUTOMATIC option - but applying to the selection only, where position and
stretch occurs with page width or height change.

Maintain edge offsets

This option is useful where you want a fixed gap between the edge of the page and the
item.

Scale (Locked Aspect Ratio)

Object Handling
Items enlarge or shrink as the page size enlarges or shrinks but retain the same aspect
ratio.

Reset all objects
This button will remove any and all manually auto-fit settings you have on everything in
the document. This puts everything back to the Automati C setting.

An Example
This is a relatively simple social media graphic that is adaptable to just about any page
size. With the AUTOMATIC options it would work, but the border width and height would
not remain the same. So in this case specific items on the page have been marked to
behave differently.

Photo: set to STRETCH - MAINTAIN EDGE OFFSETS .
Center text panel: AUTOMATIC - text is set to center vertically and horizontally.
Background rectangle: set to AUTOMATIC .
Footer text panel: set to BOTTOM and % SCALE WIDTH.
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Previewing and testing Auto-fit pages
A great way to test the adaptability of your page design is to preview and test using the
PAGE SIZE dialog - right click on the page background - select PAGE OPTIONS... (ON PAGE
40) and then the PAGE SIZE TAB.

In the Page Options dialog - the Paper size field has a drop-down list of common page sizes.

So you can select a preset paper size from the drop down, but a much easier way is to
unlock the page, which allows you to drag the width and height to any desired value. To
enable page size dragging, just un-check the LOCK PAGE SIZE option. Now if you move
the mouse pointer near the right or bottom edge of the page, the pointer changes to
indicate you can drag the edge to resize.

Resizing picture and text
It’s important to understand that when a page is stretched (e.g. if you drag the right edge
of the page to be wider), text items and images are resized, but the program does not
distort the text or images. There’s nothing worse than a photo that has the wrong aspect
ratio, or stretched text.

Object Handling
So in the case of text objects, when the container of the text is resized, the text just reflows within the new container size. So, for example, changing a page from A4 portrait to
A4 Landscape the body text is not stretched, it remains the same point size, but the text
frame is stretched.

In the example above the page is made wider (and less tall). The text remains the same point
size, but the text frame, and other items on the page have been resized in proportion.

This is the out-of-the-box behavior when everything is set to AUTOMATIC . Using the
manual controls you can optimize the behavior, so that for example the width or height of
items can be fixed. In the above example you can see the height of the header and footer
has become reduced as the page height has reduced. This might not be what you want,
and this is where the individual HORIZONTAL and VERTICAL controls come into play - as
described.

Resizing text
If the page is made taller AND wider, then the text will be resized. The example below
shows a small page on the left, and a much larger Facebook post size version, with
approximately the same aspect ratio on the right. If we did not scale the text, then the
Facebook one would have unreadably small text.
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Tip:Always design for the smallest page size, it's easier to enlarge a format than to shrink
it.
Tip: Don't fill up your text boxes - leave room for content to flow.

Object Handling
Push objects
Push objects are mainly useful in page templates, to help maintain the design of a page
as text is extended or contracted. Push objects are not allowed to overlap with other
push objects and so if one extends or moves so as to encroach on the space of another,
it ‘pushes’ that other object down the page out of the way. And if a push object is pushed
off the bottom of the page, the page automatically extends to accommodate it.
To make an object into a push object, right click on it and choose
menu. The PUSH dialog appears.

PUSH...

from the context

Select the Push checkbox to turn on Push for the selected object(s). Then you can
optionally change the top and bottom margins. By default the top and bottom margins are
locked together – just click the lock button if you want to set them independently. The top
margin value determines how close another Push object is allowed to get to this one,
before this object will move down out of its way. So it stops other Push objects coming
too close. Similarly the bottom margin value specifies how close to another Push object
below it, this object is allowed to be before it starts to push that object out of the way, It
also defines the minimum distance that must be maintained between it and the bottom
edge of the page (the page will extend when required) because often you don’t want the
object to be right up against the edge of the page.
The EXTEND SIDES field allows you to make the Push object behave as if it was wider
than it actually is. This means it can be made to push objects below it (or be pushed from
above) even if there is some horizontal separation between the objects. So for example a
100 pixel wide rectangle set to push with EXTEND SIDES set to 50px, will behave as if it
was 200 pixels wide in terms of its push behavior.
As mentioned above, as a Push object gets longer it will push other Push objects below it
out of the way, down the page, and if necessary the page will extend. But what if the
Push object subsequently gets shorter again (perhaps some text is deleted from a text
object)? Now there is space for the Push objects below it to move up the page again. So,
as long as the objects started off close together before the text was removed, that’s
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exactly what happens – the lower Push objects move up, closing the gap that would
otherwise have been introduced. Similarly where appropriate the bottom of the page will
move up, making the page shorter.

Adding Hyperlinks
Use the Link button to open the Link Dialog. With this dialog you can apply
hyperlinks to selected text or any other object like photos or graphical elements.
When exporting your document to PDF (on page 577) this link is preserved. When you
click the link in the exported PDF file an internet browser will open and display the
specified web address.
Note: The links are ignored when exporting to bitmap files or when the document is
printed

The settings on this tab apply to the selected object(s) or selected text. To add a link to
just some of the words in a paragraph of text, go into the Text Tool and drag over the text
you want to link to select it. Then set up the link in this dialog.
Enter a web or email address to link to that address. If you leave the “CORRECT
AUTOMATICALLY ” checkbox selected, your address will be adjusted if required when you
click OK or APPLY . For example, if you enter "www.example.com" it will correct it to
"http://www.example.com/".
Select the LINK TO: option to link to another page in the current website. The drop-down
list allows you to select which page or step to link to. You can also choose this option to
link an object to the top of the page - creating a rapid jump from the bottom of a long
page to the top.

Object Handling
Select the LINK TO ANCHOR: option to jump the visitor to a specific part of any page in
your website.
To setup an anchor point, first go to the page and object you want to be jumped to.
Select the object and add a name to it by right clicking and choosing the NAMES... option.
Then select the object to which you want to add the link and choose the anchor name
you added from the list provided with the “Link to anchor” option.
When you have created a link to an object you can quickly change its behavior by just
clicking on the object. A pop-up will appear with the link's details and options to Change
or Remove the link.

Conflicts in page layouts
When too many objects on the page are trying to affect each other's positions or sizes in
too many ways an error message is displayed which says...
"THE REQUESTED CHANGE IN PAGE LAYOUT IS TOO COMPLEX TO PROCESS. PLEASE
SIMPLIFY THE PAGE AND TRY AGAIN"

To fix this, it is necessary to reduce the interactions between objects on the page. This
means doing things like:
 Grouping (on page 95) or Soft-grouping things that should move together
 Removing push where it's not needed especially on objects that are also stretching or
have "Footer" or "Auto" (on page 118) page positions
 Setting page position to "Fixed" or "Footer"
 Removing stretching markup
 Removing repelling (on page 237)
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Selecting Objects
The Selector Tool
The SELECTOR Tool is the main tool for selecting, moving, scaling, and rotating
objects. It is typically used more than any other tool and is the central tool for
manipulating documents.

The Selector tool InfoBar - left side

Show bounds
Show edit handles
Show fill handles
Show rotation handles
Rotation center
Position of selection
Dimensions of selection
% size controls
Lock aspect ratio

The Selector tool InfoBar - right side

Rotate & Shear
Flip horizontal
Flip vertical
Scale line widths
Apply, remove or inspect names of objects
Perimeter and area indicator
To use the SELECTOR Tool:
 Click on the SELECTOR Tool on the MAIN TOOLBAR .
 Or press "Alt + S", "V", or "F2".
When switching to the SELECTOR TOOL , if there are objects selected inside a group or
other composite object type, the parent object (group) becomes selected instead.

Selecting Objects
The InfoBar
All the buttons on the InfoBar are described in the following sections except:




which is described in "Drawing lines".
which is described in "Fills".
APPLY, REMOVE OR INSPECT NAMES OF OBJECTS which is described in "Document
handling (on page 70)".

SHOW EDIT HANDLES
SHOW FILL HANDLES

The first two buttons let you edit the outlines and fills of objects without the need to
switch tools.

Alt + S
Because the SELECTORTOOL is the most used tool, there is an additional shortcut that lets
you switch to the SELECTOR TOOL to perform a selection or other operation, and quickly
switch back to the previous tool. If you are using another tool, you can easily switch to
the SELECTOR TOOL :
 Press and release "Alt + S" to switch to the SELECTOR TOOL . Press again to return to
the previous tool.

Selecting objects
To select a single object, click on any visible part of the object.

Change object selection
Once an object is selected, you can use the following keys to change the selection:





End selects the back object.
Home selects the front object.
"Tab" selects the next object towards the back.
"Shift + Tab" selects the next object towards the front.

Front and back objects are described in "Object handling (on page 74)".

Marquee selection
To select multiple objects, press and hold down the mouse button. Dragging the mouse
draws a selection rectangle, by default all objects wholly within the selection rectangle
are selected.
If you have an object in the way which is preventing you from drawing a rectangle
because you end up moving the object, hold down "Shift" while dragging out the
selection rectangle.
By default, dragging a selection rectangle selects only those objects which are
completely inside the rectangle. This behavior can be changed so it's compatible with the
way selection works in other applications, whereby the objects touching the rectangle
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outline also become selected. Hold down "CTRL" while dragging to include those objects
touching the selection rectangle in the selection.
The "UTILITIES > OPTIONS " (on page 609) dialog (General Tab) enables you to change the
default setting for marquee selection. So you can choose to have objects touching the
selection rectangle selected, without having to hold down "Ctrl" during the drag. In this
case, holding "Ctrl" down while dragging selects only the objects wholly inside the
rectangle.

Extend Selection
To select additional objects:
 "Shift + click" on them.
 Or "Shift + drag" the mouse pointer. This draws a selection rectangle and adds objects
within the rectangle to the selection.

Select under
Hold down "Alt" to select objects hidden by other objects. By "Alt + clicking" you can step
through several overlapping objects.

Select inside
You can select an object that’s inside a group or other container object by holding down
"Ctrl" while you click on it. This is called selecting inside. The object you click on will
always become selected, even if it’s deep down inside several levels of nested groups.
When you have such deep nesting of groups, sometimes you may want to select one of
the nested groups (a group inside another group). If you hold down the "Alt" and "Ctrl"
keys while you click you can do this easily. The first such click will select the top level
group (just as an unmodified click does). Click again and the next group down in the
hierarchy will be selected instead. Continue clicking to ‘drill down’ into the group structure
until the group you want becomes selected.
Note that some operations are not permitted with select inside. For example, you are not
permitted to delete the end object of a blend (because the blend would then be
meaningless).
Marquee selection does not work for select inside, because "Ctrl" is used to toggle the
two marquee selection modes.

Scribble Selection
In the Selector Tool, drag with "Alt" held down and instead of dragging a box, a freehand
line is draw. Every object that is touched by the line becomes selected. Hence you can
drag the mouse around the page, touching all the objects that you want to select. This
also works in conjunction "Shift" for extend selection (on page 124) and "Ctrl" for select
inside (on page 124).

Selecting Objects
Moving objects selected under or inside
If you need to move a selected object that’s either under others or inside a group, then
just dragging doesn’t work as it will select and drag a different object. To overcome this
hold "Ctrl + Alt" and start dragging. This will always drag the existing selected object. You
can let go of the keys once you’ve started dragging.
Or you can use the arrow keyson the keyboard to nudge the object.

Selecting and layers
You cannot select objects in locked or invisible layers.
See "PAGE & LAYER GALLERY (on page 181)" for more details on layers.

Selecting Photos and SmartShapes
When you select a photo or SmartShape with the SELECTOR TOOL , you see SmartPhoto
handles (on page 351) rather than the usual bounds handles. This allows direct editing of
the photo or SmartShape without having to first switch into the Photo Tool or Quickshape
Tool.
You can revert to showing the normal selection bounds handles using the toggle
button on the left of the SELECTOR TOOL INFOBAR.

Selecting all objects
To select all objects:
 Choose "EDIT" > "SELECT ALL ",
 Or press "Ctrl + A".

Deselecting an object
To deselect all objects:
 Click anywhere on an unused part of the document,
 Or choose "EDIT" > "CLEAR SELECTION ",
 Or press "Esc".
To deselect one object from several:
 "Shift + click" on the object. This deselects that object. Other objects remain selected.

Selecting with Soft Groups
When you click on an object which is a member of a soft group, all members of the soft
group become selected. This is one of the main purposes of Soft Groups – to keep
closely related objects together even when they are on different layers. If you want to
select just one member of a Soft Group, use Ctrl to select inside, as described above.
See the “Soft Group (on page 98)” section in “Object Handling” for more information.
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Double-click shortcuts to tools
For some types of object, double-clicking on them will take you into the tool which is most
applicable to that object. So for example if you want to edit some text, double click on it
to go into the Text Tool, so you can start editing it immediately. The following table
summarizes the available shortcuts for different object types:
Double click on

Selects this tool

Text

Text Tool

Photo

Photo Tool

Rectangle

Rectangle Tool

Ellipse

Ellipse Tool

Shape

Shape Editor

SmartShape

Quickshape Tool

Group

Starts an ‘edit inside’ by opening the contents of the group
in a separate sub-document view

Drawing Lines and Shapes

Drawing Lines and Shapes
The Drawing tools

You can use any of these tools to draw lines and shapes:
 The FREEHAND & BRUSHTOOL ("F3").
 The STRAIGHT LINE & ARROW TOOL
 The SHAPE TOOL ("F4").
 The SHAPE PAINTERTOOL
The FREEHAND & BRUSHTOOL is the easiest way to draw simple lines, curves, and
shapes, and it acts rather like a pencil.
The STRAIGHT LINE & ARROW TOOL is best if you want to draw single segment straight
lines, or add arrow heads and tails to any types of lines.
The SHAPE TOOL is best for drawing precise curves and lines. It is also the main tool to
edit lines and shapes.
The SHAPE PAINTER TOOL allows you to draw new shapes, or extend existing shapes, by
‘painting’ on the page with a round or elliptical ‘nib’.
Note: Although it is not in the Drawing Tools toolbar, you can also use the PEN
TOOL to create precise shapes. It has limited functionality and works like the line
tool of other drawing programs. To use the PEN TOOL , choose CONTROL BARS
from the WINDOW menu and click the BUTTON PALETTE checkbox. Then click the
PEN TOOL icon in the Button Palette.

The Freehand & Brush Tool
You can use this tool to draw in a freehand manner, as you would with a pencil.
It can also be used to create brush strokes described below. And it includes the
option to draw variable width lines using a compatible pressure sensitive drawing
device such as a graphics tablet. While using this tool the status line provides
reminders on how to use the tool.

1.
2.
3.
4.

Position the pointer where you want the line to start.
Press and hold down the mouse button. (or draw with your graphics tablet or other
connected device).
As you drag the pointer around the document, your line is drawn in real time.
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Smoothing

Re-fit Indicator

After you’ve drawn a freehand line you
can control how smooth the curve is (i.e.
how many control points) by adjusting the
smoothing control slider on the InfoBar.

Low values make the line follow your mouse movement more closely by creating more
control points, and higher values produce smoother curves with fewer control points.

Low values are less smooth

Higher values produce a smoother curve

You can change the smoothing at any time until you make further edits to the line (the refit indicator on the InfoBar tells you when you can still change the smoothing.)

Erasing while drawing
Before you release the mouse button you can erase part of the line by holding "Shift".
The pencil icon reverses so the eraser at
the end is downwards. You can now
erase back along the line. Release "Shift”
and you can continue drawing.

Drawing straight segments in the Freehand Tool
While drawing a freehand line hold down "Alt", move the pointer to a new position and
release "Alt" to draw a straight line. You can continue drawing a line or hold down "Alt"
again to draw another straight segment. Remember, you can use "Ctrl" to constrain the
angle of the line. If you only want to draw lots of single segment straight lines, use the
STRAIGHT LINE TOOL described below.

Extending a line
Make sure the line is selected (a single click on the shape or line in the FREEHAND &
BRUSH TOOL will do this). Now if you move over the end of the line, a small + sign next to
the pencil icon will indicate you can just draw to add a new freehand section to the line.

Joining two lines
Select both lines, ("Shift + click" on the second line to add it to the selection) and you can
now just draw from the end of one line to an end of the other. A small + sign next to the
pencil icon (appearing after a pause) indicates you are over the end.

Drawing Lines and Shapes
Creating a shape
A shape is a closed object with no start or end handle. Only shapes can be color filled.
To close a shape:

1.

2.
3.

Create an open object with the end point handle
close to the start handle. All the point handles
(except the end handle) should be in their required
positions.
Position the pointer over the end handle.

Or:

1.
2.

Create an open object with all the control handles
in their correct positions. Do not create the final
line segment.
Move the pointer over the start point. A + appears
to the right of the pointer when it is over the start
handle.

3.

Or:

1.
2.
3.

Choose the SHAPE TOOL .
Click on an end point to select it.


Or you can use the FREEHAND & BRUSH Tool to create the final segment.
Any of these closes the shape. If there is a current fill color, the shape is filled with that
color.

Editing lines/shapes with the Freehand & Brush Tool
You cannot directly modify shapes created by the QuickShape, Rectangle, or Ellipse
Tools. First convert them to editable shapes using " ARRANGE" > "CONVERT TO EDITABLE
SHAPES ". See "Shape handling (on page 168)" for more information.
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You can use the FREEHAND & BRUSHTOOL

TO EDIT LINES (OR OUTLINES OF SHAPES) BY

SIMPLY REDRAWING THE SECTION OF LINE YOU WANT TO REPLACE. FOR EXAMPLE:

To edit the object:
Select the object that you wish to edit.

Move the freehand pencil over a part of the line. A ~ shows when
the pencil is in position.

Draw the required line, then move the freehand pencil over to the
second point of the existing line. Again, a ~ shows when the
pencil is in position.

Release the mouse button, and the section of line is replaced.

Sketch Mode
Located on the InfoBar this option is useful if you are rapidly sketching lots of
separate lines close to each other, perhaps using a drawing tablet.
Hold the mouse pointer over an existing line, or end point, and you’ll notice that there is a
short pause before the mouse pointer changes to indicate that the line will be edited or
extended. This pause means you can still edit existing lines if you want, but you won’t do
so unintentionally when you actually mean to sketch new lines.

Pressure sensitive drawing
Xara Designer Pro X supports pressure sensitive drawing using a compatible
tablet device that supports pressure sensitivity. This option is located on the
InfoBar.

Drawing Lines and Shapes
Most modern tablets should be compatible. This allows you to draw variable width
strokes - the more pressure you apply the wider the stroke.

High Pressure

Low Pressure

To draw a variable width stroke using your tablet:

1.
2.
3.
4.

Enable pressure sensitive drawing by pressing the ENABLE/DISABLE PRESSURE
RECORDING button on the Freehand tool InfoBar.
Clear the current selection (click an empty part of the canvas, or press Escape).
Choose a suitable line width from the line width dropdown list on the top bar. The
width you select will be the width of the line that is drawn when you are applying
maximum pressure.
An alert appears asking if you want to make the selected line width the default for
new objects. Press the Set button to confirm.

5.

There is a special entry in the stroke shape dropdown list on the InfoBar entitled
"Pressure" to indicate that the selected line has a custom profile. To convert a pressuredrawn line into an ordinary stroke simply choose an alternative stroke profile from the list.
This deletes all the pressure data that was recorded for the stroke.

Brush styles
The FREEHAND & BRUSH TOOL can also be used to apply different brush stroke styles
along the path of the line. Instead of being a solid, fixed-width line, you can change it to
be a variable-width line, or one of a huge range of fancy brush styles, like airbrush, felt tip
marker, and many more. See Brushes (on page 147) for more details.

The Straight Line & Arrow tool

This tool makes it easy to draw single segment straight lines and to add arrow heads and
tails to any lines in a way that is much easier and more powerful than doing the same
thing with the LINE GALLERY (on page 144).

Drawing & editing straight lines
Simply click and drag on the page to draw a straight line. You can click on any existing
line to select it, and once selected you can click-drag on either end to move the end of
the line around.
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Adding arrowheads & tails
The InfoBar has two dropdown lists on the left which allow you to choose an arrow head
or tail style for each end of the selected line.

Arrow head
Arrow tail
Arrow head/tail size
Reverse path
The slider on the InfoBar allows you to change the size of the arrow head and tail on the
current selected line. Or you can enter a percentage value into the size text field to the
right of the slider.
Enter a value less than 100% to reduce the size of the arrowhead (and tail), or greater
than 100% to increase. Although the slider only takes the size value up to a maximum of
800%, you can enter percentage values larger than this into the size text field.

Reverse path
Press the REVERSE PATH button on the InfoBar to switch around the head and tail
of the selected line.

Shape Painter tool

This tool enables you to ‘paint’ onto an existing shape to enlarge it, add new areas or
adjust the shape or outline. It does this in a vector way, and is much more direct and
often easier way than using the vector SHAPE TOOL . You can adjust the size of the ‘nib’
as well as its aspect ratio and rotation angle.
If you use one of the liquify plugins you can also choose from a range of effects to adjust
outlines of shapes, lines and rectangles.
To use the tool in standard PAINT mode, simply select the tool from the DRAWING TOOL
(on page 127) flyout menu. If a shape is already selected, or you click on a shape to
select it, then strokes on the page will adjust the outline of the selected shape. If there is
no shape selected, or you click on the background to clear the selection, then new
strokes will create new shapes.
If multiple shapes are selected the Painter tool will join them if the nib shape touches
them during the drag. The resulting joined shape has the attributes of the topmost shape.
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Quickshapes are automatically converted to editable shapes if the nib touches them.
The InfoBar for this tool provides controls over Nib size,the Roundness, Nib angle and
the Softness, as well as a smoothing control which adjusts how accurately the nib follows
your mouse movement (this is exactly like the Freehand tool smoothness control).

Nib Size - fixed or zoomed, plus nib size control slider
Nib Roundness, Angle and Softness settings sliders
Edge Softness - set a profile to control the softness at the nib edge
Smoothing - adjusts how accurately the nib follows the mouse
movements
Enable/disable pressure sensitive drawing device (if attached)
Liquify Plugins dropdown menu.
Nib Size
Control the nib size by dragging the slider. Use the Size button to control whether the nib
size zooms in when you zoom into the page or stays the same size. If you keep the nib
size the same then it effectively becomes smaller relative to the objects on the page
allowing you to erase smaller details.
You can also conveniently adjust the nib size by holding down the Alt key and using the
mouse wheel.
Note: this tool only works in a vector way (i.e. editing the shape vector outline) if the
softness control is set to zero. If the softness setting is anything other than zero, then this
will always add a new feathered shape to the page.
Note: This tool can be used on Photos, but it’s only useful to enlarge an already edited or
cropped photo outline.
Note: The softness control is really just changing the Feather value applied to the stroke,
and you can adjust the softness afterwards using the Feather slider (on page 175).
Liquify Plugins
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The Liquify plugins, accessed from the dropdown menu on the InfoBar allow you to use a
wide range of effects to modify the outlines of simple shapes, lines and rectangles. The
plugins allow you to do this in an intuitive and painterly way without having to think about
individual control points and curve handles as you would with the Shape Tool.
The plugins take on the roundness, angle and softness settings of the nib and sit
beneath the main PAINT setting.

Line (left) modified by the Warp fast Liquify plugin (right)

Select a plugin, and then just slowly drag the nib over the edge of your line or shape to
see it in action.

The Shape Tool
The SHAPE TOOL is the main tool used for both creating precise curves, lines,
and shapes, as well as editing or altering lines and shapes.

Drawing Lines and Shapes
Add/Change/Edit Indicator
Make curve
Make line
Smooth join
Sharp join
Break at points
Delete points
Reverse paths
Positions of handles
Smoothing
The InfoBar, shown above, provides a wide range of controls as well as precise numeric
control.
All lines and shapes in Xara Designer Pro X are made from a sequence of curve and line
sections. Curves are sometimes called "Bézier" curves after the mathematician who first
described them.
Although this section describes the SHAPE TOOL , you
can also edit lines and shapes using the SELECTORTOOL
if you have the SHOW EDIT OBJECT handles button
selected on the SELECTORTOOL InfoBar.

The sections or segments of a line are marked by small black point handles. You can
drag, add and delete these handles to manipulate the shape of the line or outline.
Some objects such as quickshapes, rectangles, ellipses, and text have to be converted
into editable shapes before you can use the SHAPE TOOL on them. Select the "ARRANGE"
> "CONVERT TO EDITABLE SHAPE" menu ("Ctrl + Shift + S") to do this.

To draw a straight line segment
Using the SHAPE TOOL , start a straight line:

1.

Click where you want to start the line. You can start a line at either end; you don’t
have to work left to right, or top-to-bottom. This creates a point handle, and is
displayed as a red square to indicate that it is the selected handle.
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2.

MAKE LINE

Either click where you want the next point
handle to be, or click and drag, and then
release the mouse button when the line is
correct. This creates a line segment and
selects the new end point handle.

Mixing curved and straight lines
To create an object which is a mixture of straight and curved segments, just switch
between the MAKE CURVE and MAKE LINE buttons as you create the object (you can also
press "L" or "C" on the keyboard.)
Note: You can also use the keyboard shortcut "X" to create a Cusp Join or "S" to create
a Smooth Join while using the SHAPE TOOL . These affect the way two line segments
come together. A Cusp Join creates 2 independent Bezier control handles that you can
edit separately. With a cusp join, you can create a sharp angle. A Smooth Join creates a
symmetrical join that works like a see saw. If you drag one Bezier control handle down,
the opposing control handle goes up.

To draw a curved line segment:
This is similar to starting a straight line (described above).

1.
2.
3.

Click where you want to start the line.
If necessary select the MAKE CURVE button (shortcut "C".)

A curve segment has CURVE HANDLES associated with
the selected point handle. You can drag these to
adjust the angle and radius of the curve.
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Extending the line
Make sure an end point handle is the selected handle (red outline) and then just click
again to add a new line or curve section. Each successive click places a new point
handle and draws a new line segment to the selected point handle.

Adding a new point handle
The SHAPE TOOL has three modes, depending on whether no point handles are selected
(a click will start a new line), an end handle is selected (a click will add a new section), or
one or more other point handles are selected (you can drag or change the handles).
The InfoBar shows the current mode.





NEW :

Click to start a new line,
Click to extend the line,
CHANGE : Drag or delete point handles to change.

ADD :

This applies to the SHAPE TOOL only.

To the end of a line:
Make sure the line is selected, then:

1.

If necessary, click on the end point to
select it.

2.

To the middle of a line:
Make sure the line is selected, then;

1.

Click on the line to add a new point handle
into the line

2.
To the start of a line:
If the end point is selected, clicking on the start point closes the shape (this is described
in "Closing a shape (on page 129)” ). To add a new control handle to the start of a line:

1.
2.
3.

Finish the line using "Shift + click".
Click on the start handle.
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Selecting multiple point handles
You may want to select several point handles to delete them, move them as a group, or
change a region of points to curved or straight lines. To do this:

1.
2.

Select one point handle in the normal way by clicking on it.

-

Or "Ctrl + Shift + click" on a point handle to select all point handles on the line.
Or drag the mouse pointer diagonally to create a selection rectangle. All point
handles in the rectangle are selected.
Or "Shift + drag" diagonally to create a selection rectangle. This adds all points
within the rectangle to those already selected.

3.
-

End moves the selection to the end of the line.
Home moves the selection to the start of the line.
Tab moves the selection to the next point handle towards the end.
"Shift + Tab" moves the selection to the next point handle towards the start.

The start and end points are significant when applying arrows (on page 144).

Deleting points
Select the point handle(s) as described above and either click the
DELETE POINTS button (SHAPE TOOL InfoBar), or press "Del".

Moving point handles—Shape Editor Tool

You can move one or more selected handles:
 Drag the handles using the mouse.
 Or use the arrow keys on the keyboard.
Or to move a single handle, type new values into the text boxes on the InfoBar (see
below).
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Using the text boxes on the InfoBar
The center pair of text
boxes always shows the
X/Y co-ordinates of the
selected point.

The surrounding X/Y fields show the co-ordinates of the curve handles on either side of
the selected point.
X/Y co-ordinates are relative to the bottom left corner of the page by default for print
document and top left for web documents. You can change this in the Grid and ruler (on
page 613) tab in the options dialog.
If the selected point is on the end of a straight line section, the left fields show the length
and angle of the line. You can adjust either by entering a new value and pressing return.

Length and angle for straight line
Position of selected point
Position of curve handle

Smoothing a line
Imported shapes or shapes from tracers may have unnecessary points on a line. Lines
with too many points can be unwieldy and can slow down rendering. Xara Designer Pro
X can smooth the line to remove unnecessary points.
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Select all the points on the part of the line you want to smooth (see above). Drag
selecting around the region in the SHAPE TOOL is probably the easiest way to select a
large number of points.
Drag the smoothing slider on the end of the SHAPE
TOOL InfoBar.

Tip: to make sure important points are not deleted, make sure they are not selected
("Shift + Click" on a selected point deselects it).

Constraining the line
When dragging a point handle, holding down the
constrain key ("Ctrl") will constrain the movement to
multiples of the constrain angle (controlled from the
OPTIONS dialog, GENERAL tab). When dragging a curve
handle the angle is constrained.

Changing curves
Using the curve handle
Dragging the curve handle will adjust the curvature of the adjoining curve segments.
Move the curve handle towards or away from the point
handle to pull the curve in the required direction.
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Dragging the line segment
You can also change the curve by dragging the line segment between points.

Notice the difference between dragging the line to change its shape, and clicking on the
line to add a new point handle. Dragging a straight line segment changes it to a curved
line segment.

Making sharp corners
Normally, Xara Designer Pro X draws a smooth curve through a point handle. For this,
the two curve handles either side of a point handle are linked. Moving either curve handle
also moves the other.
Sometimes you will want a sharp corner, and to achieve this, you need to unlink the
curve handles:

1.
2.

Double click the point handle,

Click the CUSP JOIN button, or press "Z".

You can now move each curve handle independently.

Making smooth curves
To convert a sharp join into a smooth curve:

1.
2.

Double click the point handle,

Click the SMOOTH JOIN button, or "S".

The two curve handles become linked and move to opposite sides of the point handle.
This may change the shape of the curve.
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Balancing curves
Balancing makes the two curve handles the same distance from the point handle, which
gives smoother, more symmetrical curves. To balance a curve, select the point handle,
then drag one of the curve handles with "Shift" held down. As you drag one curve handle
the other one will move to be exactly opposite it and the same distance from the point
handle.

Changing a straight line to a curve (and vice versa)
1.

Select the point handles at both ends of a line segment. For several line segments
select all bordering point handles.

2.

After changing the line type, you may need to move the curve handles for a smooth
transition between curved and straight line segments.
You can select several line segments and convert them all. The point handles at both
ends of the segment must be selected.

Splitting a shape
If you want to split (break) a line or shape: Either select an existing point handle on the
line or outline of the shape, or create a new one where you want to break the line. Just
click on the line in the SHAPE TOOL(SEE ABOVE).
Click on the BREAK AT POINTS button, or press "B".

If you split a line, there is no visible change. However, if you move the point handle, then
only part of the line moves. If you split a shape, it changes to being a line. Any fill
disappears.
Note: "Slice shapes" (part of "ARRANGE" > "COMBINE SHAPES ") also lets you split shapes
into two separate shapes. This is described in "Shape handling (on page 166)".
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Changing the line width (thickness)
To change the line thickness or the outline thickness of a shape, first select the object or
objects:
Type a new line width into the text box on the STANDARD control bar or
choose the default line thickness from the menu.
Line thickness is traditionally measured in points, abbreviated to pt. 1 point is 1/72 nd of an
inch (about 0.3mm), which is slightly less than the thickness of one screen pixel when
viewed at 100% zoom.
You can enter the thickness value in any unit, and Xara Designer Pro X will convert it to
the correct number of Points. E.g. you can enter 0.5cm, and you will get a line half a
centimeter thick, but it will show just over 14pt in the line width field.
If you have no object selected and you change the line thickness value, this changes the
default for all new lines.
Note: A zero width line is a special case, and should not normally be used. This draws a
line one device-pixel wide. The actual size will therefore depend on the device the
drawing is displayed on. On a monitor screen one pixel is clearly visible and is never
shown anti-aliased. On devices such as printers and particularly on image setters, which
have a much higher resolution, the line is almost invisible (zero width lines in imported
files are converted to 0.25pt).
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Variable width lines
From the FREEHAND & BRUSH TOOL InfoBar you can select a drop-down menu that shows
a selection of alternative variable line thickness profiles. As you move the mouse over
the selection, an enlarged preview is shown on the right.

Selecting one of the styles will change the line (or outline of a shape) from being a
constant thickness line, to a variable thickness. This is great for creating pen and ink
style artwork, and is often used in the creation of cartoons.
The line width dropdown still should be used to change the overall thickness of the line.
To restore a constant line width, select the top left corner item from the menu.
The special "PRESSURE " profile in the dropdown menu is used to indicate when a line has
a custom profile as a result of being drawn with a pressure sensitive device, with the
pressure sensitivity drawing (on page 130) option turned on.

Line Gallery

The LINE GALLERY can be used to apply a range of line styles or attributes, such as brush
strokes, dash patterns, arrow heads, and more.
To display the LINEGALLERY :
 Choose "UTILITIES" > "LINE GALLERY "
 Or click the LINE GALLERY tab on the GALLERIES tab.
The LINEGALLERY is split into sections. To open or close any section, click on the small folder
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icon in the gallery window.

Line Width
Join type
Line cap
To apply any line style or attribute from the gallery you can:
 Drag and drop the required style from the gallery onto the shape or line.
 Or double click on the required style in the gallery.
 Or select the style and then click the APPLY button.

Line width
The text box at the top of the gallery duplicates that on the standard control bar.

Brush strokes
There are several sections that show a selection of various brush styles.

Dash pattern
This section provides a selection of line dash styles.
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Arrowheads
The best way to apply an arrowhead is to use the STRAIGHT LINE TOOL (on page 131), as
described earlier in this chapter. However you can also use the line gallery. Drag and
drop the arrowhead from the gallery onto the appropriate end of the line.
Alternatively, to apply an arrowhead:
 Double click on the arrowhead in the gallery.
 Or select the required arrowhead and click APPLY .
Designer Pro has two types of arrowhead designs: beginning and end. If the line already
has a beginning arrowhead, applying an end arrowhead automatically places it at the
opposite end of the line.
If the line has no arrowheads, and you use the APPLY button or double click a style to
apply it, then the arrowhead will be placed at the end of the line.
The size of the arrow head is related to the thickness of the line. Thicker lines have
proportionally larger arrowheads.
If you hold "Ctrl" down and double click an arrow head or tail style, it will apply it to the
other end of the line.

For general information about galleries see document handling (on page 60).

Change join type
This control on the top of the LINE GALLERY sets the style of corners.
To change an existing line, select the line.
To change the current join type, deselect all lines and
select the required type from the menu.

Change line cap
This control at the top of the LINE GALLERY sets the style of the ends of the line.
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To change an existing line, select the line.
To change the default line cap, deselect all lines.
Select the required type from the menu.

Brushes
Brush strokes control the appearance of lines - for example, to apply an airbrush effect.
There are two types of brush in Designer Pro.

1.

SCATTER

2.

ART

brushes repeatedly stamp or scatter shapes from the brush definition at
intervals along a line - you can use feathering, text, extrusions, etc. in scatter brush
definitions.

Art brush (left) Scatter brush (right)

Using an existing brush
To use a brush, click on the

FREEHAND AND BRUSH TOOL

Now on the InfoBar choose a brush and a stroke profile.
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Select a brush
Select stroke shape
There is a wide range of both SCATTER and ART brushes. For ease of identification, the
Art brushes have an (A) following the name in the preview window. Draw a line, and it will
use your chosen brush and stroke shape.
You can also browse different brush types using the LINE GALLERY (ON PAGE 146). It’s
easier to browse brushes in the Line Gallery because they are categorized into folders.
You can also select an existing line in the document and then choose a different brush or
stroke shape, to change the appearance of the line.

Creating a new brush
To create a new brush type:

1.
2.
3.
4.

Design your desired brush shape in Designer Pro, then select it and go into the
FREEHAND AND BRUSH TOOL .
Click CREATE BRUSH .
A dialog box will appear - give your brush an appropriate name and then decide
whether it is to be a SCATTER or ART brush.
CREATE.

You can then draw with your new brush straight away. Your new brush appears as the
first entry in the brushes dropdown on the FREEHAND AND BRUSH TOOL InfoBar, and in the
first DOCUMENT BRUSHES folder in the Line Gallery (on page 144).
Brushes are stored in the document. If you want to re-use a brush in another document,
you have to load the document containing your custom brush first. Only the default
brushes are always available.
Important: Although you can edit a default brush, you cannot save the edits into this
brush for use beyond the current session. The default brushes are always restored when
the program is started. If you want to edit one of the default brushes, then you have to
save it as a new one, using the Save As buttons in the brush setting dialogs.
Guidelines for new brushes
If brushes are created from bitmaps, then the bitmap should be clipped to remove as
much empty space from the outside edges as possible. This means the brush will not
introduce redundant invisible parts to the strokes you draw with it, and it can also reduce
the chances of rendering problems. If there is invisible space at the ends of the brush
then lines won't terminate exactly at the points where you start and end the strokes. And
if there is empty space along the top and bottom edges then the line won't appear to be
of the correct width, it will appear narrower.
Brushes should be more or less horizontal. Otherwise strokes will tend to deviate from
the line you draw.
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Brushes should ideally be defined from fully saturated colours. This ensures that when
you change the colors of brush strokes the stroke color achieved more closely matches
the chosen color, rather than just being a shade of it.
Coloring brush strokes
By default when you select a brush and draw with it, the line you draw has the same
color(s) as the brush. But you can change the color of your line by simply selecting it and
clicking a color on the color line (on page 190), or using the Color Editor (on page 193).
Any new lines you draw subsequently will use the same brush and line color. To draw
new lines that have the same characteristics as an existing line, just click on that line and
then the next line you draw will look the same.

Editing a Scatter brush
You will see a different dialog depending on whether you are editing a Scatter or Art
brush.To access advanced editing options for a Scatter brush:

1.

Select the Scatter brush line that you wish to edit with the

FREEHAND AND BRUSH

TOOL

2.

EDIT BRUSH

You will see the following dialog - you can alter:







SPACING :

Gap between the objects in
the brush.
OFFSET : Distance between the
original line and the objects in the
brush.
SCALING : Size of objects in the brush.
ROTATION : Rotation of the objects in
the brush as they follow the line.
TRANSPARENCY : Transparency of the
brush.
FILL PROPERTIES : Miscellaneous
options, including color options.

Transparency is described in "Transparency" and colors are described in "Color handling
(on page 189)".
If you use a pressure-sensitive graphics tablet, the transparency and scaling options
allow you to configure the brush’s sensitivity levels. If you do not have a pressuresensitive graphics tablet, you can mimic the effects using brush shapes (on page 144).
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Save your edits with the SAVE button, with the SAVE AS NEW button a new brush is
created.

Editing an Art brush
To edit an Art brush:

1.
2.

Select the Art brush line that you wish to edit with the

FREEHAND AND BRUSH TOOL.

EDIT BRUSH

You will see the following dialog:

The SCALING options determine how the brush is made to fit your line.


- by default the brush is stretched along the line to fit
the stroke.
 Choose the SCALE PROPORTIONATELY option if you want to keep the brush design in
proportion, ignoring the line width.
 REPEAT ALONG STROKE - rather than being stretched along the brush stroke, the brush
shape repeats along the stroke, precisely following its course and orientation.
STRETCH TO FIT STROKE LENGTH

The LINE COLOR options allow you to determine how the brush uses the current line color
attribute. For example, if your current line color is set to red and you choose a green
brush, do you want a red brush stroke or a green brush stroke?


This is the default option. The current line
color will be ignored when you draw with this brush and you’ll get the natural colors of
the brush. You can still change the line color of this brush stroke later if you want to,
using the Color editor (on page 193) or clicking a color on the color line (on page 190).
 MIX LINE COLOR WITH DEFINITION COLORS This option is intended for brushes that have
a strong hue, as in some of the default brushes provided. The strong hues in those
brushes will be replaced with your chosen color, but greyscale tones such as blacks,
whites, and greys remain unchanged.
IGNORE (USE COLORS IN DEFINITION ONLY)
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This option is intended for greyscale brushes.
Shades of grey and shades of other colors in the brush will be replaced by
corresponding shades of your chosen line color. When you create a new grey brush,
this coloring option is selected for you by default.
MIX LINE COLOR WITH DEFINITION GREYS

Brushes are shared between documents - so when you change any of the above options
you are asked if you want the changes to apply to all the lines in all currently loaded
documents that use that brush - or just lines you have currently selected.
Use the SAVE AS button to make a new brush instead of modifying the current brush.
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Shape Handling
Shape drawing tools

Use any of these tools to create regular shapes.




("M")
("L")
QUICKSHAPE TOOL ("Shift + F2")

RECTANGLE TOOL
ELLIPSE TOOL

The RECTANGLE TOOL creates rectangles and squares.
The ELLIPSE TOOL creates circles and ellipses.
The QUICKSHAPE TOOL creates polygons, stars, and SmartShapes.

Creating rectangles and squares
To create a rectangle
Use the Rectangle Tool ("Shift + F3", or "M"). On the main toolbar.

Click and drag on the canvas to draw a rectangle.
To create a square rather than a rectangle, hold down "Ctrl" while dragging.
You can also enter width and height
dimensions in the EDITABLE ITEMS menu
on the InfoBar.

Creating rounded corner rectangles
To give your rectangle rounded corners, select it and then press the
“Curved corners” button on the RECTANGLE TOOL InfoBar.

Shape Handling
You can then drag on the selection handles shown on the corners to adjust the diameter
of the rounded corners.

You can resize rectangles using either the RECTANGLE TOOL (by dragging on the handles
shown at the corners) or the SELECTOR TOOL .
Note that if you change the aspect ratio of a rounded corner rectangle using the
SELECTOR TOOL (by stretching it in one dimension only) the aspect ratio of the rounded
corners is not stretched, it is maintained. However if you have multiple objects selected,
or if you’re stretching a group containing a rounded corner rectangle, the aspect ratio of
the corners is not maintained.
TIP: When rotating rectangles or any shape with straight edges, hold down Ctrl to easily
rotate so that one of the straight edges is exactly horizontal or vertical.

Creating circles and ellipses
To create an ellipse or circle:
Select the ELLIPSE TOOL ("Shift + F4", or "L") from the main toolbar.

The RADIUS AND DIAMETER buttons on the InfoBar automatically create circles.
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Radius
Diameter
Bounds creation
Select the RADIUS option to draw circles. The start point of a drag determines the circle’s
center.
Select the DIAMETER option. Now the start point of a drag determines the position of the
edge of the circle.
With the BOUNDS CREATION button selected, drag on the canvas to draw an ellipse. Hold
down "Ctrl" while dragging to create a circle rather than an ellipse.
You can convert an ellipse into a circle at any time by double clicking on a control handle.

SmartShapes
SmartShapes are a way enhanced functionality can be added to Designer Pro.
SmartShapes are plug-ins. Each SmartShape incorporates its own editing controls,
usually in the form of small handles you drag to adjust the shape.
Find SmartShapes throughout the ONLINE CONTENT CATALOG and under the INSERT
MENU . For example choose "INSERT" > "SHAPE" from the main menu to choose from a
selection of simple SmartShapes.
Or with the QUICKSHAPE

TOOL

selected, click on the INSERT button on the InfoBar.

Simple SmartShapes - Frame, Variable corners, Ring segment, Spiral, Text box and Triangle

Although there are simple SmartShapes that are just a single shape, the underlying
SmartShape architecture supports much more complex examples, including charts,
percentage segment indicators, Photo grids and text panels which can all be customized.

Shape Handling
See the topic Photo Grids (on page 323) in the Photo Handling (on page 322) section for
more detail on editing the Photo Grid smartshapes.

Chart and photo grid SmartShapes

Editing SmartShapes
You can edit a SmartShape simply by clicking on the shape in the Selector tool.
Alternatively, select them using the QuickShape (or rectangle or ellipse) tools from main
tool bar.
When selected the SmartShape will show a set of control handles on and around the
shape, like this:
This is a simple Text Panel
SmartShape. The blue
circular handles on the sides
allow you to stretch the panel
to be any size. The top right
corner handle will rotate the
whole object. The bottom
right will enlarge or reduce
the size of the whole
SmartShape.

Each SmartShape has its own set of control handles. Hold the mouse-pointer over any
handle for a handy tool-tip. The Status Line (bottom of window) also provides some
description of the function of each handle. In this example the top left orange handle
adjusts the rounded corner of the panel background (and most rectangular SmartShapes
have a similar function). The inset handle at the top right, in this case, adjusts the margin
around the text. Where SmartShapes contain text, you can edit the text - change its size
and font, etc. just as for any other text, using the TEXT TOOL .
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This percentage segment SmartShape has controls
to drag either end of the segment (doing so will
update the value), or using the Text Tool you can
edit the value, in which case the segment bar is
changed. The handle mid-way around the arc allows
you to adjust the thickness of the band.
The top right handle will rotate the whole thing, the
lower right will resize it.

To change the colors in a smartshape, you can select the shape and click the colors on
the color line or open the COLOR EDITOR (on page 193). Or drag and drop colors from the
color line onto it. Where there are multiple colors in the shape, the Color Replacement
(on page 199) dialog will appear allowing you to choose which color you want to change.

Timeline SmartShapes
Timelines are common in many types of documents and particularly in presentations.
The Timeline Smartshape consists of a line with an object (or group of objects) repeated
along its length with regular spacing. You can increase or reduce the number of objects
on the line, adjust their spacing, size, vertical alignment, etc. using the SmartShape’s
handles.

Timeline Smartshape with editing handles

To insert a Timeline, use "INSERT" > "FROM
"PRINT & WEB COMPONENTS" > "TIMELINES"

CONTENT CATALOG"

> "COMPONENTS" >

Shape Handling
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Timeline Handle Summary
END HANDLES
SPACING
ADD/REMOVE

VERTICAL

Drag either end to change the length of the line, or rotate the whole line.
Drag to adjust the spacing of the objects on the line and therefore determine
how much of the line sticks out on each end.
Click to add a copy of the rightmost object, or drag to add or remove multiple
objects. If nothing happens when you try to add a copy, that means there is not
enough space on the line to fit another copy. Try reducing the size of the
objects using the Size handle, or extending the line length by dragging it out.
Drag to adjust the vertical positioning of the objects on the line.

OFFSET
DELETE
LINE WIDTH
SIZE

Delete an object from the line.
Drag to adjust the width of the line.
Change the size of the objects on the line.

Text Editing
Many of the timelines include text, which of course you can edit using the TEXT TOOL . If
you find you can’t fit the text you want into the space available, try increasing the size of
the objects on the line using the Size handle and then select the text and reduce its font
size, so you can fit more text in. If the change the font size of all the text on one object,
you should see the text on all the other objects update too, to help you choose the size
that fits best.

Symbol Replacement
Some timelines include symbols that you will want to replace. Select the symbol inside by
holding down Ctrl and clicking on the symbol. Then right-click and choose REPLACE
SYMBOL from the context menu.

Chart SmartShapes
With the chart SmartShapes - see "INSERT" > "CHARTS…" You can just edit the values
and labels on the charts using all the usual TEXT TOOL attributes, and the graphics
update accordingly.

Bar Chart, Column Chart, and Percentage Ring

As with all SmartShapes, double-click to go into the QUICKSHAPE TOOL and you will see
the SmartShape handles appear. Move the mouse pointer over each handle for a tip on
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what each does. On the bar and column charts there are handles for adjusting the bar
width, chart width/height, the spaces between the bars, the roundness of the bar corners
and of course for adding/removing bars. Each bar also has a handle for changing its
position in the chart and a handle for changing its value by dragging. If you need more
resolution or accuracy, just zoom in and drag. Alternatively you can enter any precise
numeric value, even with decimal places, using the Text Tool.

Customizing Bar & Column Charts
You can change the colors of charts easily just by selecting the whole chart and clicking
a color on the COLOR LINE . The REPLACE COLORS dialog appears to let you choose which
of the colors in the chart you would like to replace with your chosen color. Similarly you
can use the COLOR EDITOR (on page 193) to edit the colors - the list of replaceable colors
appears at the top of the color editor, so select the color you want to edit from that list.
Sometimes you may need to do more than just replace or edit the existing colors in the
chart. You can select a specific bar or column by Ctrl+clicking on it in the SELECTOR
TOOL . That selects just that bar/column inside the chart. Then you can change its color
directly, or its outline, or even change the type of its fill using the FILL TOOL (on page
273). If you want to copy the style of one bar onto the other bars, first copy (Ctrl+C) the
selected bar to the clipboard. Then select one of the other bars and use "EDIT" > "PASTE"
> "PASTE FORMAT/ATTRIBUTES" .

Changing label and value text styles
The Chart labels and values can be edited using the TEXT TOOL - you can apply the usual
text attributes, to adjust the appearance of the text. When you change the appearance of
a chart label, such as changing the font, font size or color, that change is immediately
replicated across the other labels for each bar. However this only happens if those other
labels have the same text style applied (usually BAR CHART LABELS ). So if you want one
of the labels to be different, perhaps to highlight one of the bars, simply give it a different
style or use the NO STYLE option in the styles menu to remove the style. The same
happens with the value text.
Chart, Bar chart, Column Chart, Graph, Line chart, Pie Chart, Diagram.

Shape Handling
Text Panel Smartshapes
Find the Text Panel SmartShapes in the ONLINE CONTENT CATALOG under
"COMPONENTS" > "PRINT & WEB COMPONENTS" . Or under the "INSERT" > "SHAPE" > "MORE
TEXT PANELS… " menu.

You can freely edit the text using the TEXT TOOL . If you display the SmartShape controls
(click on it using the SELECTOR TOOL or the QUICKSHAPE TOOL ) you can adjust the width
and height (and the text re-flows), the margins around the text and the corner
roundedness of the whole panel. You can also rotate the whole object and it remains fully
functional.
These text panels are smart in that they grow to accommodate whatever text you put in
them - drag the bottom centre or top centre handles to change the vertical panel height. If
you ever add more text than can fit into the panel at that height, the panel will grow to
accommodate the additional text. But if you later remove text, the panel will shrink back
no further than the height you last set using the height adjustment handles. This helps to
keep panel sizes consistent, which is useful where you have a panel occupying a defined
space or aligned vertically with other panels or objects of the same height.
There is also an additional handle that allows the vertical alignment of the text to be
changed between "top", "centred" and "bottom". Just click the handle in the bottom left
corner to toggle the alignment.
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If the panel is full of text with no empty vertical space, then it will look the same no matter
which of the three alignment options are selected. But the alignment setting also
determines how the panel grows and shrinks, as text is added or deleted, so the setting
is still relevant even for ‘full’ panels. Top aligned panels will always grow and shrink from
the bottom, with the top edge staying fixed. Bottom aligned panels are the other way
around - they grow upwards with the bottom edge fixed, so these are commonly used at
the bottom of pages. And centered panels will grow and shrink equally at the top and
bottom, so the center of the panel is fixed.
A collection of similar panels containing both photo and text can be found in the
CONTENT CATALOG under "IMAGE RESOURCES" > "PHOTO PANELS" .

ONLINE

Chevron Bar and Arrow SmartShapes
The Chevron Bar and Arrow smartshapes are useful in presentations. See "INSERT" >
"SHAPES" > "ARROWS..."

Chevron Bar smartshape

Drag on the different handles to add/remove chevron shapes, re-order, change the arrow
angles, etc. And of course just click on the text in the TEXT TOOL to edit the labels.

Arrows smartshapes

Most of the arrows in the Arrows folder "INSERT" > "SHAPE" > "ARROWS…" can be
changed to use a variety of different head and tail designs. Click or drag on the green
style selection handles to cycle through all the available styles.

Shape Handling
Flowline SmartShapes
Great for flowcharts, diagrams, exploded views, etc. The Flowlines behave just like
Arrows, in that you can change the heads and tails, apply rotation, thickness and so on as well as having 90° segments which you can drag to reposition. Find them in the
Arrows folder - "INSERT" > "SHAPE" > "ARROWS…"

Creating polygons and stars
Use the QUICKSHAPE Tool to quickly create almost any regular, symmetrical shape with
sharp or rounded corners. You can then drag the edges to bend the sides, and at any
time you can change the number of sides or make the object an ellipse, a polygon, or a
star.

1.
2.
3.

Select the QUICKSHAPE Tool ("Shift + F2") from the main toolbar
flyout.
Select CREATE POLYGONS or STARRED SHAPES from the InfoBar.
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Creation Modes: Radius/Diameter/Bounds
Polygon
Ellipse
Starred shapes
Round corners
Restore edges
Number of sides
Editable items menu
Editing fields
Insert SmartShapes
To create the polygon or star drag in exactly the same way as for a circle or ellipse using
the Radius, Diameter and Bounds Creation buttons to control the origin point of your
shape.
 From the center outwards (RADIUS button),
 Or from an outside edge (DIAMETER button),
 Or diagonally to create an imaginary rectangle enclosing the polygon ( BOUNDS
CREATION button) letting you distort the polygon or star.

Polygons or stars with rounded corners
Select the ROUND CORNERS button or
double click on a corner point.

The polygon has extra handles (radius
handles) where the rounding starts. To
increase or decrease the radius, drag any
of the radius handles.

To remove the round corners:
 Click the ROUND CORNERS button.
 Or double click a control handle.

Editing polygons and stars
The SELECTOR Tool lets you move, rotate, resize, and skew the shapes as normal. The
SELECTOR Tool is described in Object handling (on page 74).
Using the QUICKSHAPE Tool, you can resize or rotate:
 Drag the corner handles.
 Or select SIZE & ROTATION in the EDITABLE ITEMS menu. Type the required values into
the text boxes.

Shape Handling
Size
Rotation
You can also nudge the values using the buttons to the right.
To move:
 Drag the handle in the center of the shape.
 Or use the arrow keys on the keyboard.
 Or select CENTER in the EDITABLE ITEMS menu. Type the required X/Y values into the
text boxes.

Apply or remove rounded corners by clicking the

Change the polygon to an ellipse by clicking the
double clicking the polygon's center.

ROUND CORNERS

CREATE ELLIPSE

button.

button or

Make a polygon star-shaped by clicking the STARRED SHAPES button. Or by
double clicking on a side.
Drag the sides to make them curved. Move the pointer over the edge of the polygon (it
changes to an arrow shape). You can now drag the sides.
On the left are the original polygons. Just drag on
the sides to create curved sides.

"Ctrl + double click" on a side, or click the
straight again.

RESTORE EDGES

button to make the sides

Change the number of sides by typing the number into the menu or
selecting from it.

Editing stars
To increase or decrease the depth of stellation:
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Drag a star handle or select STELLATION RADIUS &
OFFSET on the EDITABLE ITEMS menu. Type the
required values into the text boxes.
The original shape is on the left.

Or drag the sides to make them curved:

The original shape is on the left.

You can also nudge the values using the buttons to the right.
Offset from center
Angular offset
"Ctrl + drag" one side of a star moves all the sides symmetrically. "Ctrl + Shift dragging"
moves pairs of sides as mirror images. "Ctrl + double click" on a side, or click the
RESTORE EDGES button to make all sides straight again.

Combining shapes
The COMBINE SHAPES option (select the objects, right click and choose COMBINE SHAPES )
provides you with a range of advanced options to combine shapes to make new shapes,
such as adding, cutting, or slicing. You can use combine shapes on any type of object,
including bitmaps.
When subtracting, intersecting and slicing, you can either use the topmost selected
shape to do the “cutting” of the lower shapes, or you can use one of the Photo Region
tools.
Select one of the Photo Region tools to draw your cutting shape over the lower
shapes. The selected area will be outlined with a dashed 'marching ants' effect.
Then RIGHT CLICK and choose COMBINE SHAPES and then one of the options. The Photo
Regions shape is used to cut the shapes underneath.
See Photo Regions and Masks for more information on the Photo Regions tools.

Shape Handling
Creating holes in shapes

Right click and choose "COMBINE SHAPES" > "SUBTRACT SHAPES" . This is similar to using
join shapes (described above). The differences are:
 The top shape (or mask shape if the mask layer is used) becomes a hole through the
other shapes.
 The line attributes and colors of the underlying shapes are unchanged.
 Combine shapes physically alters the lines. The only way to restore the original
shapes is by using undo.
 The number of overlapping shapes has no effect.

Merging several shapes into one
For example, to produce the shape on the right from the three shapes on the left:

1.
2.
3.

Create the two circles and the rectangle.
Select all three shapes.
COMBINE SHAPES" > "ADD SHAPES"

The new shape takes line attributes and colors from the top shape (in this case the
rectangle in the illustration).

Intersecting shapes
With the INTERSECT SHAPES option, the new object is created from those parts of lower
shapes that are covered by the top object, or by a mask shape using one of the Photo
Region or Mask tools (on page 307).
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Select the shapes you want to mask and the front
(mask) shape. Or put the mask shape on the mask
layer.

Right click and choose "COMBINE SHAPES" >
"INTERSECT SHAPES" . This creates a new shape. The
top shape or mask disappears.

The line attributes and colors of the underlying shapes are unchanged. Areas not
covered by the top shape or mask are discarded. The top shape can be a group for more
complex subtracting. Groups are described in Object handling (on page 95).

Slicing shapes
Xara Designer Pro X lets you easily slice shapes into two or more pieces, and you can
use either a solid object or a line for slicing. For example, to cut a segment from a circle:

1.
2.
3.

Create a circle and put a triangle on top or on the mask layer.
Select them both (not required if using the mask layer).
Right click and choose "COMBINE SHAPES" > "SLICE (CUT) SHAPES" .
The edges of the triangle cut the circle into two shapes. The
triangle disappears.

4.

You can also use a line to cut an object:
The line should be drawn completely though the object
and extend beyond it (as shown in the illustration). If the
line is too short, this operation cuts out a thin slice.

Slicing complex shapes
When you use the INTERSECT ALL SHAPES option, selected objects are sliced along their
lines of intersection.

Shape Handling
Three selected rectangles, with a 1px
border.

> "COMBINE SHAPES" >
slices the shapes
along the intersected lines. The 1pt
borders show the outlines of the new
shapes.
"ARRANGE"

"INTERSECT ALL SHAPES"

You can then pull the rectangles apart to
reveal the new shapes.

The line attributes and colors of the intersected shapes are unchanged.

Joining shapes
"Arrange -> Join shapes" lets you create holes in solid shapes. Because overlapping
parts of the same shape are drawn with no fill color (i.e. you can see through the
overlapping parts), you can use this effect to create holes in shapes but retain the ability
to break them apart later.
For example, to create a donut shape:

1.
2.
3.
4.

Create an ellipse (described later).
Create a second ellipse over the first. (The color of the second
ellipse has been changed to make it obvious.)
Select both.

This creates a single shape with a hole in it.
You can combine or join several shapes.
The cutout is made using the top object. If that object is a group, you can make several
holes in one operation. For example, a group of three stars can make a hole in this
rectangle shape:
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Groups are described in Object handling (on page 95).

When several shapes overlap:
 The top shape (or top group) becomes a hole through the other shapes.
 The line attributes and colors of the other shapes change to those of the top shape.
 If several shapes overlay:
an even number of shapes overlapping becomes a transparent area;
an odd number of shapes overlapping becomes a solid area.
 The numbers on this example of three circles show how many shapes overlay in each
area:

The joined shape on the left shows the number of segments which overlap. On the right are the
original three circles shown unjoined.

Breaking joined shapes
Choose "Arrange -> Break shapes". This breaks the joined shape into separate objects,
but the original attributes will not be restored to the separated objects. You can also
break several joined shapes in one operation.

Making shapes editable
Choose "ARRANGE -> CONVERT TO EDITABLE SHAPES " ("Ctrl + Shift + S") to convert
predefined objects like rectangles, ellipses, QuickShapes, SmartShapes, and text into
shapes. This lets you edit their outline like a normal shape.
This has several applications:
 You can manipulate just a part of predefined objects after making them editable.
 You can manipulate text in almost unlimited ways, adding new curves and
ornamentation almost at will. Note that you cannot edit text converted to shapes as it
ceases to be text.

Shape Handling
 You may want to send a .xar file to someone who does not have that particular font.
As converted text is just a collection of lines and curves; it does not need to use the
original font.
However, the disadvantage is that you can no longer edit the objects with their original
tools.
For more information on text refer to "Text handling (on page 209)".
You can also convert lines (open shapes) to the equivalent closed shape, by selecting
the line and then "ARRANGE" > "CONVERT LINE TO SHAPE ". If you have a straight line with
a 10 pixel line width, converting it to a shape will change it into a filled rectangular shape
with no outline width.
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Stretching and squashing objects
This is similar to scaling objects except that the object is scaled in one direction only.
Stretching and squashing are basically the same action — stretching makes the object
larger, squashing makes it smaller.

Stretching/Squashing using the mouse

The SELECTOR TOOL must be in scale mode. (The selection handles are squares.) If
necessary, click on the object to change to scale mode.
Drag one of the side handles. The
object scales as you move the
pointer in the appropriate direction.
The InfoBar shows the current
scaling.

Right click or press "+" on the numeric keypad while dragging to stretch or squash a copy
of the object, leaving the original in place.

Stretching/squashing using the InfoBar
The LOCK ASPECT button must be unset (if it is set, you scale the object instead of
stretching or squashing it).
Type into either the width or height text box (as appropriate) and press "". Alternatively
enter a % scale (width or height). So entering 200% into the top % scale box will make
the object twice as wide, but the same height.
Note that text in text areas and columns does not squash or stretch when adjusted with
the SELECTOR TOOL , unless it’s in a Group that is being scaled. Instead the width/height
of the area or column is adjusted.
If you scale a group using its side handles, an attempt is made to scale it smartly rather
than just squashing all members of the group. If instead you want a simple ‘squashed’
result, where each member of the group is simply scaled, all you need to do is hold down
the Alt key while performing the drag. See Scaling groups (on page 86) for more info.

Distorting Objects
Skewing objects
This is part of the SELECTOR Tool.

Left is the original object, to the right with a horizontal
skew

Skewing using the mouse
Switch the SELECTOR Tool to rotate/skew mode. (The selection handles are arrow
shaped) by clicking on the object.
Drag a side arrow to skew the object.
As you drag, the object skews in the direction of movement
(vertical or horizontal).

The InfoBar shows the current skew angle.

"Shift + drag" to skew the object around its center. Hold down "Ctrl" to restrict the skew to
the constrain angles. Right click, or press "+" on the numeric keypad as you drag to
create a copy, leaving the original where it was. Or right-drag with the mouse to create
instant copies, additional copies by left clicks.
You can also skew an object in the Selector Tool's resize mode using the skew areas.
Read more under Rotating objects in resize mode (on page 83).

Skewing using the InfoBar
To skew horizontally type an angle into the skew text box and press "".

To skew vertically:
1. Click the center-right button on the 3x3 matrix on the InfoBar.
2.
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The Mold Tool
The MOLD Tool is used to distort shapes. It is used for both perspectivizing (that
is, rotating in three dimensions) and enveloping (like distorting a rubber sheet).

Mold tool InfoBar

Mesh
Remove mold
Detach mold
Rotate mold
Copy mold
Enveloping
Paste envelope mold
Perspectivizing
Paste perspective mold
The InfoBar contains two sets of preset mold shapes. Just click a button to apply the
preset mold. The left-hand button in each group is the default "no distortion" mold which
you can then manually edit after applying it.

Perspective
The MOLDTOOL lets you perspectivize shapes to
give an impression of depth.
You can perspectivize all types of objects
including text and bitmaps. Note that bitmaps
lose perspective if you later blend them or
convert them to editable shapes.

1.
2.
3.

Select the object or objects.
Select the MOLDTOOL (shortcut "Shift + F6").

The right-hand button (paste perspective) is described later.
Designer Pro draws a rectangle around the object or selection. You can drag the control
handles at each corner of the rectangle to produce the perspective effect.
You can rotate, resize and skew the perspectivized object using the

SELECTORTOOL .

Distorting Objects
You may want to move control handles without redrawing the perspectivized object
(doing this speeds up screen redraws).
To do this select the DETACH MOLD button. To refit the object, deselect the
button.

Using vanishing points
As you reduce the size of the sides of the perspective mold, you see a "vanishing point"
target. This is similar to vanishing points in conventional perspective drawings.
You can use vanishing points to obtain consistent
perspective for several objects.

All three objects share a common vanishing point at the small cross.

The perspective mesh
This button paints a faint series of dots in a grid to preview the degree of
perspective distortion of an object.

Using molds
You may want to apply the same perspective to several objects. To do this you create a
mold shape, copy it to the clipboard and then use it to perspectivize the other objects. A
perspective mold shape must have four straight sides:

This is acceptable as a mold
shape

These are not acceptable. The object on the left has too
many sides (must be four). The object on the right has
curved sides (must be straight).

Removing perspective
Click REMOVE to remove perspective.

If the selected object has more than one perspective or envelope mold applied, only the
most recent mold is removed.
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Rotating the object within the mold
Sometimes you will find that the mold is the correct shape but the object needs
rotating within it. You can rotate the object by clicking the rotate object button.

Enveloping
The MOLD TOOL lets you envelope shapes in a wide variety of ways.

The effect is similar to a rubber sheet or balloon that you can stretch in any direction.
You can envelope all types of objects except bitmaps.

Sample enveloped text

Enveloping is similar to applying perspective. That is:

1.
2.
3.

Select the object or objects.
Select the MOLDTOOL (shortcut "Shift + F6").

The right-hand button is similar to paste perspective described earlier.
The left-hand button does not initially alter the object. The other buttons immediately alter
the object.
After applying the mold, to edit it:

1.
2.

Drag any of the corner handles.

The above example shows the 4 curve handles of the corners have been dragged
outwards to bend the content of the mold.
You can also rotate, resize and skew the enveloped object using the

SELECTOR

TOOL .

Distorting Objects
The mold mesh button
The Mesh button displays a series of faint dots which can help preview the
distortions that the envelope mold is giving.

Envelope molds
You can create an envelope mold from any four sided shape, which you can distort as
you require, and then use as an envelope mold by clicking the PASTE ENVELOPE button
on the MOLD TOOL InfoBar.

Editing mold shapes
You can edit the contents of a mold (essentially a group) using editing inside groups (on
page 96). Editing is not possible using direct selection inside (molds do not allow objects
inside them to become selected). To edit a mold inside, right click on the mold and
choose OPEN MOLD from the context menu.
You can edit the shape of envelope or perspective molds with the SHAPE TOOL (or the
edit handles with SELECTOR TOOL , if shown). According to the nature of molds, there are
some restrictions:
 You cannot add point handles to a perspective or envelope mold, because it has to
stay a four-sided shape
 You cannot change a straight line of a perspective mold into a curve.

Feathering
Sometimes you want to blur the edges of an object so it blends, or fades, into a
background object. This is called "feathering". An example is merging two photos
together when you want to avoid a sharp edge between them.
The feather control is on the right side of the top bar.
To feather an object:

1.
2.

Select the object or objects you want to feather.
Or
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Feathering blends or blurs the edges of objects.

If you have multiple objects selected, the feather appears around each object. If you
group the objects, the feather appears around the outside of the group.
You can also change the feathering profile. Normally a linear
transition across the feather produces the best effect, but you
may want to change this.
Select the PROFILE button to display the PROFILE dialog and adjust the sliders.

Page & Layer Gallery

Page & Layer Gallery
The Page & Layer Gallery
By default the PAGE & LAYER GALLERY is displayed on the right hand side of the Designer
Pro window when you open the program. You can pin, move or dock the gallery - see
Galleries (on page 60) for more information.
You can open and close the gallery by clicking the PAGE & LAYER GALLERY tab
on the Galleries bar, or press F10.
The PAGE & LAYER GALLERY lists everything in your document, from the pages and layers
right down to each individual item on the page. It provides a way to select, hide, lock and
re-arrange these items.
It works at many different levels: PAGES , LAYERS, PRESENTATION
The hierarchy of items is like this:

STEPS

and OBJECTS.

Pages
Layers/steps
Page items, which may include
groups
Group contents
Some of the key features of the

PAGE & LAYER GALLERY

include:

Page control
 Displays a list of pages
 Pages mode displays a narrow list of page thumbnails for easy page navigation
 Add new page, duplicate, cut, copy and paste or delete pages.
 Re-arrange the page order by dragging
 Rename pages (right-click > RENAME PAGE )
Layer control
 Displays a list of all layers on each page, from the bottom (usually background layer)
to the top most layer
 In a presentation document, displays a list of all presentation steps and layers on each
page, from the first to the last
 Create new layers, delete, re-order and rename layers
 Hide or show layers
 Lock layers (which makes the layer non-editable)
 Solo a layer - turn all other layers off
Object control
Display a list of all items (objects) on the page in the stacking order they appear on the
page, bottom to top.
 Hide or show any item
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 Move up and down the stack
 Lock any object so it becomes non-editable
 Locate and highlight any object in the gallery by clicking it on the page when in 'Locate'
mode - toggle the LOCATE button on (enabled) and off (disabled)
 Solo an object - turn all other objects off
 Move objects into or out of a group using drag and drop, or move an object from one
group to another. (Note this is only supported for ordinary groups, not anchored or
repeating groups for example).
 Rename objects (right click > RENAME OBJECT )

Page & Layer Gallery
In addition the PAGE & LAYER GALLERY shows a thumbnail of each page and a tiny
thumbnail of each item on the page. Hover the mouse pointer over an item to view a
larger thumbnail.

This shows the MouseOff layer has been expanded to show the contents of that layer. T his
shows a NavBar group and other various groups, text line and text column items, and a couple
of shadow group items.
Hovering the mouse pointer over the tiny thumbnails will display a larger one so you can easily
identify each object on the page.
Note the right two columns indicate (and control) whether the items are editable (a pale arrow)
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or locked (padlock icon) and whether they are visible on the page (pale open eye icon) or
hidden (darker closed icon).
Clicking on these icons will change the visibility and / or the locked or editable nature of each
object.

Pages
Clicking the PAGES button on the top of the PAGE & LAYER GALLERY (or right clicking in
the gallery and choosing SHOW PAGE LEVEL ) will open pages mode, displaying only the
pages in the document and collapsing all other opened levels.
When in pages mode and the gallery is docked, the width of the gallery is reduced to its
minimum, to take up as little space as possible. Also the number of buttons at the top of
the gallery is cut down to just those applicable to pages. To leave pages mode, simply
expand one of the pages to reveal its layers. The gallery returns to its full width and the
full button set is restored.
You can select multiple pages in the gallery by Ctrl+clicking on pages to add them to the
selection, or by holding Shift down to select a range of pages. Then you can copy,
paste, delete or re-order multiple pages at once. You can also paste objects from your
clipboard to the selected pages.
You can re-order pages by dragging on the selected pages in the PAGE & LAYER
GALLERY , or by right clicking a page and choosing MOVE PAGE UP/DOWN .
You can change the page transitions for multiple pages at once by first selecting them in
the gallery and then changing the settings on the Page tab of the "Utilities" > "Web
Properties" dialog. This is particularly useful to quickly change the page transition effect
used for all pages in a presentation at once.
You can rename a page by right clicking it and choosing RENAME PAGE . As well as being
a useful way to identify pages in long documents, the page name is used when exporting
your document as a website.

Layers
Everything in your document has a stacking order but with more complex documents that
have dozens, maybe hundreds or thousands of items, your work area can be become
cluttered.
Using layers you can group a collection of items together and then turn the whole
collection on or off (make it visible or hidden) in one easy operation. Layers can be made
invisible, to hide parts of your document. You can give layers names, and you can easily
create new layers or delete them. And you can open a layer and view its contents.
When you select any object, the layer it's on is shown on the status line at the bottom of
the window.

Page & Layer Gallery
The Current Layer
When you create any new object on the page, it's placed in one of the layers, called the
active layer or simply the current layer. On a blank document this will either just be called
Layer 1 or, in the case of web documents, it's called MouseOff. The current layer is
shown with a selection arrow .
Important: All new drawn items, shapes, photos, text, and all pasted items, are placed
on the current layer marked with the symbol.
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You can change the current layer simply by clicking on its row in the PAGE & LAYER
GALLERY . It's important to understand that you can have a selected object on any layer
or even multiple layers, and these need not be the current layer. The current layer, with
the arrow, only indicates where new items will be placed.

This example PAGE & LAYER GALLERY shows the current layer is called MouseOff (the current
page is called news). So if you draw anything new it will be placed on the MouseOff layer.
It also shows a shadow group item selected in the document (highlighted in blue) inside
another group which is on a completely different layer called Holiday photo 2.
Four layers are hidden (called Holiday photo 4, Holiday photo 3, Holiday photo 1 and
MouseOver). The 'Page background' layer is locked.

Page & Layer Gallery
Make the current layer always visible
It's possible that the current layer can be hidden or even locked. Just clicking on a layer
to select it and making it the current layer does not normally change its visible or locked
state. But there is a preference in the General (on page 609) tab of the Options dialog
(right click a page and choose PAGE OPTIONS or choose OPTIONS from the UTILITIES
menu) to make the current layers always visible and editable (unlocked). If you select this
option then whenever you select any layer in the PAGE & LAYER GALLERY it's made visible
and unlocked. Moving to another layer will restore the previous visible and locked state of
the layer you just moved from.

Layers in PDF documents
Layers are useful for producing overlays. For example on a floor plan of a building, you
might have overlays showing the fire points, power outlets or wiring. By putting such
items on named layers you can easily show or hide them. When saving a document as a
PDF (on page 577), you can select to enable layers in your PDF document, and so then
using the Layers control in PDF reader you can turn the layers on or off.
To enable layers in your PDF file: When exporting as a PDF, select the Advanced option
on the export screen, and then choose Adobe Reader 6 or higher (PDF version 1.5 or
higher) from the PDF Version list. And then on the Layers tab of the same dialog, select
the 'Enable Reader layers..' option. When you view your PDF file in Adobe Reader there
is a Layers control available.

Soft Groups and Layers
Soft Groups (on page 98) are unusual because they are groups of objects that can span
different layers. (Normal groups have to be contained within one layer). When you select
any part of a soft group the other parts are also selected, even if they are on hidden or
locked layers. The PAGE & LAYER GALLERY will show all selected items highlighted in
blue, but in the case of soft groups these items may be on other layers that you've not
expanded, and so are not immediately visible.
See the section on Soft Groups (on page 98) in the Object Handling chapter to find out
more.

Layer Operations
Clicking the LAYERS button on the top of the Page & Layer Gallery (or right clicking in the
gallery and choosing LAYER MODE ) will display only the layers on the current page. This is
a mode - the Layers button stays depressed. While in layers mode, as you move to
different pages the layers for the current page are always shown and all other page
nodes are collapsed. Click the LAYERS button (or right click and choose LAYER MODE )
again to turn off layers mode.
You can re-order the layers, that is, the stacking order on the page, by using drag and
drop on the layers in the Page & Layer Gallery.
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You can rename a layer by performing a second (slow) click on the layer name. (The first
click would select the layer.) This is very like file renaming in Windows Explorer.
Alternatively right click the layer and choose RENAME LAYER .
Clicking the small right arrow or double clicking anywhere on the layer row will expand
the layer to show its contents. Doing the same again will collapse and hide the layer
contents.
Holding the mouse pointer over the small layer icons
contents of the layer.

will show a thumbnail of the

The NEW LAYER button will create a new blank layer and place it at the top of the stack.
You can re-arrange the order by dragging it to the required position.
The DUPLICATE button will copy the layer and its contents and place it on top of the stack
- that is on top of all other objects on the page.
Right clicking the layer and choosing NEW LAYER , DUPLICATE LAYER or DELETE LAYER
performs the same functions.

Layer Properties
This opens the Layer Properties dialog.

Page & Layer Gallery
Creating layers and editing layer properties
Using the Layer tab you can:





Create a new layer or edit an existing one.
Make the layer editable and visible by default.
Define the layer as a web page background that will not appear when printed.
Specify that all objects in the layer will only repel text objects (on page 237) within the
same layer. This prevents text on the layer being repelled by objects in other layers
and is useful for popup layers in web pages.

Using guidelines
The Guides tab allows you to create layer guidelines at precise numeric values and
choose a color for guide layer objects.
See the GUIDE OBJECTS & GUIDELINES section in Object handling for more information on
using guidelines.

Pop-up settings

Note: The PRESENTATION LAYER checkbox is only enabled if you are in a presentation
document. To convert a web document into a presentation document, see Web
Presentations (on page 498).
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Using this tab you can apply animated transition effects to a layer, if it’s used as a pop-up
layer on a web page, or if it’s a presentation layer. The layer then appears with the
transition effect when it’s revealed in the exported web page. Use the slider to set a
transition time from 0-5 seconds.
In a presentation document, a layer can be set as a presentation by checking the
PRESENTATION LAYER checkbox. See Website Presentations (on page 498).
Note: Turning off the PRESENTATION LAYER option will remove the step from the
presentation.
By default when a transition is applied, objects will only slide in/out to the edge of the
web page. If you would like objects to start from the browser window edges, rather than
the web page edges, deselect the CLIP TO PAGE edges checkbox in the Website tab (on
page 452) of the Web Properties dialog.

Special Layers
There are several special types of layer. They appear in the Page & Layer Gallery and
can be turned on and off as usual, but behave slightly differently.
are non-printing layers that appear at the bottom of the document,
under everything else. When you apply a color to the page background (drag and drop
color from the color line) this will create a PAGE BACKGROUND layer automatically.
Normally this is locked.
BACKGROUND LAYERS

You can also set the color of the pasteboard (the area around the page) by dragging a
color from the color line and dropping it on the pasteboard. This creates a PASTEBOARD
BACKGROUND layer automatically. Again, this layer is locked.
When saving a document as a website, background layers are converted to web page
backgrounds. See the Web Graphics & Websites chapter for more details on setting web
page backgrounds and using the background layers.
The GUIDES LAYER is where guidelines or guide objects are placed. When you create a
guideline this automatically creates a Guides layer. See Guide Objects and Guidelines
(on page 93) in the Object Handling chapter to find out more.
The MASK LAYER is where mask objects are drawn. This is created and turned on (made
visible) automatically when you turn mask mode on. See masks (on page 307) to find out
more.
are layers that are steps in a 'slide show'-style presentation presentation documents only. Presentations steps can contain multiple objects and have
transitions applied, the same as layers, but steps can be displayed by the viewer using
the right/left keyboard arrow keys. See Website Presentations (on page 498) to find out
more.
PRESENTATIONS STEPS
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Hiding Layers and Objects
The rightmost two columns of icons in the Page & Layer Gallery control the visibility and
locking of layers and all objects on the page.
Clicking on the open eye
will turn to a closed eye

icon will hide the layer or object on the page, and the icon
. Clicking again will revert the layer or object to be visible.

When any item is hidden, it becomes invisible on the page and can no longer be seen or
selected. The way to get hidden items back is to click its closed eye
icon.
Alternatively you can click the MORE... button and select SHOW ALL ON PAGE option, which
un-hides all items on the current page.

Locking Layers and Objects
Clicking the open padlock icon
on the right end of an object or layer row will lock the
layer or object (icon changes to a closed padlock ). Now you cannot select this object
or any object on that layer. Any clicks on locked items will go straight through it, as if it's
not there, and select items underneath. Clicking the padlock icon will unlock that object
or layer again. Alternatively you can click the MORE.. button and select the UNLOCK ALL
ON PAGE option.
Soft Groups
There is one exception to the locked rules. If a locked item (or item on a locked layer) is
part of a Soft Group (on page 98), then selecting and operating on that soft group will
also select and operate on any locked items in that soft group (this is the intended
operation of soft groups).

Solo Mode
If you click any of the
icons in the column next to each layer, it will 'solo' this layer
which means it hides everything else, except this layer. You can now work on this layer
in isolation. Clicking the
icon again will restore everything back to how it was before.
You can also click and drag down the column of
layers in isolation from everything else.
To exit the Solo mode, click the

Show All & Unlock All

button again.

icons to quickly browse through the
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These two controls on the top of the PAGE & LAYER GALLERY are a short-cut to show all
items on the current page or unlock all items. They are a temporary override of all the
individual object and layer settings. Clicking the controls again will restore the previous
state. So this is a quick way of showing or unlocking everything, on all layers, performing
some operation, and then restoring the previous state.
The Unlock all button is useful if you have a locked object on the canvas that you want to
unlock, without having to first locate it in the Page & Layer Gallery. Turn on ‘Unlock all’,
then right click on the object on the canvas and choose the Unlock option from the
context menu. Then you can turn ‘Unlock all’ off again.
When either button is selected (the buttons are shown pressed in), then it's not possible
to change the state of individual items. Un-select the buttons to enable the normal
operation of the layer visibility and locking state.
Clicking the MORE button will display menu options to SHOW ALL ON PAGE and UNLOCK
ALL ON PAGE .

Moving Objects Between Layers
There are several ways to move objects between layers. First select the object or objects
you want to move, then;


the object ("Ctrl + X" or right click and CUT ). Ensure the target layer is the current
layer (shown with , click the layer if it's not) and then right click and choose PASTE or
PASTE IN PLACE . Note that if you cut or copy multiple items that are on different layers,
the layer structure is preserved when you paste. Items are pasted to the same layer
they were copied/cut from, instead of being pasted to the current layer. If you want to
paste all such items to the current layer, ignoring the layer structure, use the PASTE IN
CURRENT LAYER option instead. If you want to retain layer structure, choose PASTE IN
PLACE IN CURRENT LAYER. These paste options are also in the clipboard fly-out bar on
the top bar, as well as the EDIT menu.
 Right click and choose ARRANGE then MOVE TO LAYER IN FRONT / MOVE TO LAYER
BEHIND to shift the selected objects one layer up or down.
 Ensure the target layer is selected as current, then find the selected item in the PAGE &
LAYER GALLERY (click the LOCATE button), right click and select MOVE TO CURRENT
LAYER .
CUT

Color Handling

Color Handling
Xara Designer Pro X gives wide control over applying, creating and altering the colors of
objects. For simple documents, you can just choose colors from the on-screen color
palette, the Color Line. More advanced color operations are described later.

The color line
The Color Line is displayed at the bottom of the window. It shows you the current fill and
line colors, provides access to the color editor and provides a palette of pre-defined
colors including a special "no color".

Color swatch:The outer rectangle of the color swatch shows the line color and the
center rectangle shows the fill color. These are the colors of any selected objects,
or the current color attributes if no objects are selected.
This button provides access to the COLOR EDITOR.
Color picker: Use the eye-dropper to pick a color from any part of the document or
any part of the computer screen. See Using the eye-dropper to pick colors (on
page 194) for details.
NO COLOR: Clicking this applies a "no color fill". Shift-clicking applies "no color" to a
line. Note that this is not the same as 100% transparent. "No color" and
transparency are different. A shape with transparency applied remains a solid
shape whereas a shape filled with "no color" is effectively hollow. The NO COLOR
button can also be used to restore the original colors to a photo which has had a
contone color applied.
Current Fill color - the fill color of the currently selected object (displays a
diamond marker on top left).
Current Line color - the line color of the currently selected object (displays a
diamond marker on top right).
If the length of the Color Line exceeds the window, you can scroll through the Color Line
with the scroll bar below or by "Alt + dragging" the Color Line.
Xara Designer Pro X provides several options for the displayed size of the Color Line
(described in Customizing Designer Pro (on page 628)).
If you do not want to display a Color Line, deselect "WINDOW > BARS > COLOR LINE" .

Colors on the color line
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The Named Colors appear with their complementary Linked
Colors (if present in the document, see below).
LINKED COLORS are represented differently on the color line by smaller rounded
rectangles. When editing templates, to change the color scheme of the design you
should only normally edit the Named Colors (large squares) and leave the Linked
colors unchanged.
SPOT COLORS: If your document contains spot colors (on page 551), they appear
on the Color Line (and in the Color Gallery) as circles.
PALETTE COLORS: By default, there is a 'Standard Palette' of 46 pre-defined colors.
There are 5 shades of 7 standard hues and 10 shades of gray, black and white.
Standard Palette colors are not editable (i.e they are not Named Colors) and are
designed as a simple, limited selection of colors to apply to objects (either by
dragging on to the object or clicking). Use the Color Gallery (on page 205) to show
other palettes like Web Colors or Pantone® Colors (if available).
Little markers in the color icons shows which of the named colors (if any) or palette
colors have been applied to the selected object(s).
NAMED COLORS:

Diamond markers show the colors used by the selected objects. A diamond
in the top-left corner indicates the fill color, in the top-right corner indicates
the line color.
Cross-shaped markers show the current color attributes if there are no
objects selected. Line color on the right, fill color on the left.
Triangular markers show the colors of a fill type (on page 273) if you have
applied one (linear, circular, elliptical, etc).
This works also when choosing a color with the color picker from existing objects, see
Using the eye-dropper to pick colors (on page 194). The color line markers update
immediately and indicate the color of the object under the eye-dropper as you're dragging
around.

Re-ordering colors on the color line
Only named colors can be re-arranged on the Color Line. "Ctrl + drag" colors along the
Color Line. This also reorders the COLOR GALLERY (on page 205).

Color line context menu
Right click on a color on the Color Line to show a context sensitive menu with the
following options:

Color Handling
EDIT

Opens the color editor with the selected color (not
available for palette colors)

REPLACE COLOR

This option is shown only when the selected object has
multiple component parts or multiple colors, such as a
button group.
Set the fill or line color of the selected object with this
color
Set the the color for a text background - like a
highlighter.
Rename a named color (not available for palette
colors)

SET FILL COLOR / SET LINE
COLOR
SET TEXT BACKGROUND
RENAME

DELETE

Delete a named color (not available for palette colors)

OPTIONS

Opens the "PAGE OPTIONS" > "VIEW" tab where you
can change the appearance and attributes of the Color
line.

If the selected object is a bitmap, the fill and line color options are supplemented with SET
CONTONE DARK COLOR / SET CONTONE LIGHT COLOR. See Bitmap coloring (on page 277)
for more information.
When right clicking the “no color” swatch, the fill and line color options are replaced by:
CLEAR FILL COLOR / CLEAR LINE COLOR . This sets the selected object's relative attributes
to "no color". When applied to a contoned photo/bitmap, this restores the original image
colors.

Applying fill & line colors by drag & drop
 To apply a fill color to an object (selected or unselected), drag a color from the Color
Line and drop it into the center of the shape. Alternatively right click and choose FILL
COLOR to display the color editor.
 To set the line or outline color, drop it on the line, not the center.
 To change the page background color, "Ctrl + drag" a color onto the page background.
When dragging colors an indicator beside the pointer tells you what effect dropping the
color will have:
Set flat fill color (seen when you drag over an object) or the intermediary colors of
a multi-color fill (on page 279)
Set line color (seen when you drag over a line).

Set start color of graduated fill (seen when dragged over start of fill).
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Set end color of graduated fill (seen when dragged over end of fill). For three and
four-color fills, a number is added to mark the according end color handle.
Set page background color (seen when you drag a color onto the page).

Instead of drag & drop, if you have an object selected, you can just click on the Color
Line. If only open shapes or lines are selected, this will set the line and the fill color. In
any other case, you can alter the line color by "Shift + clicking" on the Color Line.
If a bitmap or a bitmap-filled shape is selected, then clicking on Color Line will contone
the bitmap. That means, the bitmap is converted to greyscale (black and white) and the
used color is used as a contone light color. The contone dark color is usually black. You
can set both contone colors via the Color Line context menu (see above). See Bitmap
coloring (on page 277) for more information.
To set a fill or line to no color (clear), perform the
operations as outlined above but use the "No color"
option instead of a color.

Applying a Text background color
To apply a text background color - in effect a highlighter-style background color...

 Highlight some text using the TEXT TOOL (ON PAGE
the SELECTOR TOOL
 Right-click on a color in the COLOR LINE
 Select SET TEXT BACKGROUND

209)

or select text object(s) using

To get rid of the background color...
 Select your text
 Right-click on the 'NO COLOR' swatch on the COLOR LINE
 Select the CLEAR TEXT BACKGROUND option

Editing an object’s color
To edit the fill color of the selected object(s):





Choose "UTILITIES" > "COLOR EDITOR" ("Ctrl + E").
Or click the EDIT COLOR icon on the Color Line.
Or right click the object and choose FILL COLOR
Or double click on the current line and fill color icon on the Color Line (the edge of the
leftmost panel).

Color Handling
To edit the line color of the selected object/s
 "Shift + click" on the EDIT COLOR icon
 Or double click on the current line and fill color icon (the edge of the leftmost panel).
This displays the COLOR EDITOR which allows you to select from any color of the
spectrum. Unlike most graphics programs the Color Editor can remain on screen while
you continue to work. It changes to reflect the color of the selected objects, and the fact
that you can also drag the lower right corner to resize the COLOR EDITOR window means
that you can easily and precisely adjust the color of the selected object.

The Color Editor in detail
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Shows what you are editing
New named color
Show/hide advanced options
Eye dropper color picker
Previous color
Current color
Color panel (Color model dependent)
HSV hue selector
Numeric values (Color model dependent)
RGB hex color value
Color model (HSV, RGB, CMYK or grayscale)
3D editor mode option (only RGB & CMYK)
No color patch (only available when editing local color)
Make Named Color local to Frame/Layer
Rename named color
Color editor help
Type of color: Normal, Spot (if available), Tint, Shade or Linked
The illustration shows the full version of the COLOR EDITOR . Click HIDE ADVANCED
OPTIONS to display the smaller, simpler version.

Using the eye-dropper to pick colors
Instead of selecting hues and shades on the COLOR EDITOR you can instead pick a color
from any part of the document or any part of the computer screen—even from other
windows and programs.
To do this just click and drag on the eye dropper icon. As you drag you see the color
editor continuously picks up the color under the eye dropper. Release the mouse button
when you have the desired color. This is an easy and quick way to use the same color
again or copy colors from photos or from one object to another.
If the object under the mouse pointer is complex (eg. has transparency applied) and the
color cannot be determined, screen RGB color is applied.
The color sampler shows a small popup at the mouse
pointer which indicates the color that is being sampled at
that point. This will either be the palette color name, the
name of a named color, or the color model and color
value.

Previous and Current color
As you drag on the color editor the two small color swatches in the upper right of the
color editor show the current color and the previous (before you started changing the
color). This is useful if you want to make a small change and want to compare the old
and new colors.

Color Handling
3D color editor
When editing RGB or CMYK colors the editor can be put into an advanced 3D mode that
displays colors in a color cube. Some people may prefer to work this way.

Specifying colors in the Color Editor
You can enter precise RGB (or HSV or
CMYK) color values in a number of
ways. The most common requirement
for web graphics is to enter a
hexadecimal RGB color.
You can do this with the color editor
showing either HSV colors (the default)
or showing RGB colors.
To select the RGB picker, right click on
the dialog and select RGB. This allows
you to enter RGB values as
percentages or 0-255 values.

Shows the expanded color editor, with the HSV
picker on the left, RGB picker on the right.

Percentages are used by default, but Designer Pro allows you to change which format is
used. To do this:

1.
2.
3.

Display the UNITS tab of the OPTIONS dialog box (UTILITIES -> OPTIONS ).
Click the appropriate radio button in the COLOR UNITS section.
OK

Limit to Browser palette
When clicked this button will shift the selected color to be one of the 216 common web
browser palette colors. This is a legacy system that is no longer particularly important or
relevant, as nearly all computers can display millions of colors, and there’s no benefit in
restricting web graphics to only this limited palette.

Colors on the screen and on the printer
One problem with computer screens is that their colors do not match the available colors
on a printer. Screens emit combinations of red, green, and blue. The brightness control
has a dramatic effect on displayed colors. Printed images reflect combinations of cyan,
magenta, yellow and black.
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As an example, pure green on computer screen is a fluorescent bright color that is
impossible to reproduce accurately on any printer. Similarly pure blue on a computer
screen will often print as a much darker purple-blue. Technically, the range of colors on a
computer screen (known as the "color gamut") is far greater than that on a printer. So
there will always be differences between screen and print colors.
Xara Designer Pro X provides the ability to simulate how printed colors will look. Select
the "WINDOWS -> SHOW PRINTER COLORS -> SIMULATE PRINT COLORS" menu to get a
better idea of how your colors will look when printed. This is an approximation only since
printers vary slightly, but it is far more accurate than normal screen colors.
Tip: To get bright blue on a printer, select a color on screen that is almost pure cyan
(printer’s cyan is much more blue than screen cyan).

The color models
Color models let you define a color in terms of different color components. RGB and HSV
are typically used for screen use. If you know your document is going to be printed and
require very specific CMYK color values, then you can use CMYK colors.
Unlike some graphics software, Xara Designer Pro X allows you to mix RGB, HSV and
CMYK colors in the same document.
Models provided by Designer Pro are:





RGB (Red–Green–Blue),
CMYK (Cyan–Magenta–Yellow–Key),
HSV (Hue–Saturation–Value),
Grayscale.

RGB and HSV colors are stored within Designer Pro in 24-bit format. This gives you 16.7
million possible colors.
CMYK colors are stored in 32-bit format. When printed or output as EPS or PDF they are
output in CMYK format.

Local colors and Theme colors
Designer Pro has two types of color:


are used in only one place in the document. Each object has a
separate color and nothing is shared. This is useful if you want to change the color of
an object without affecting other objects. Local colors are the easiest method and best
for simple documents that use relatively few colors. "Applying color" and "Editing an
object’s color" above describe local color handling.
LOCAL COLORS

Color Handling


can be used again and again in the document. (As
such, they are like styles in a word processor.) Any edits you make to a Theme color
are immediately reflected on all objects and parts of the drawing that use that color.
You can also copy Theme colors between documents. Theme colors appear on the
Color Line and in the COLOR GALLERY . If there are any Theme colors already present
in the design and you import or paste templates from the Designs gallery containing
Theme colors with the same name, you will be asked if you want to match the actual
color of the imported Theme colors to the existing ones. The Theme colors in most
templates are consistently named so when you import elements from different themes
colors are matched perfectly.
THEME COLORS (OR NAMED COLORS)

If you just select an object on the page that has a NAMED COLOR applied to it,
and alter it with the color editor, this will always turn it into a LOCAL COLOR instead of a
NAMED COLOR (because it is assumed that if you try to edit the color of the object that’s
what you mean to do. If you really want to change the NAMED COLOR so this and all
occurrences of the color change, then you should do so by editing the named color).
IMPORTANT:

Theme color schemes
Many of the web themes offered in the ONLINE CONTENT CATALOG include alternative
color schemes which can easily be applied to websites which use the same theme, to
transform the color scheme instantly. The color schemes are normally found in the
Online Content Catalog in each theme under WEBSITE THEMES , after all the page layouts
and separate graphic elements that make up the theme. They all have "Color scheme" in
their titles in the Online Content Catalog, so they are easily identified.
To apply a color scheme to your website, simply drag the scheme from the Online
Content Catalog and drop it on your page. You can try applying the color schemes of one
theme to a website created from the templates of another theme. But you will get mixed
results doing this and some schemes will not work acceptably with some themes. So for
best results stick to the color schemes of the theme that you used to create the site.
One of the color schemes provided with each theme matches the default colors used by
that theme. This allows you to easily return to the original colors if you prefer, after
experimenting with the alternate schemes.
Of course you don’t need to use the provided color schemes to re-color your website.
You can customize the theme colors yourself and choose a combination of colors that
you think work well together. See "Editing named colors (on page 201)".

Creating your own color schemes
It’s very easy to create your own color scheme files, which you can pass on to other
Designer Pro users for them to apply to designs created with the same theme.
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1.
2.

Load one of the page templates for the theme. Choose one which shows off all the
colors of the theme most effectively. You can add more elements to the page if
required, to help show off the range of theme colors.
Edit the named colors of the theme one at a time, as described in the ‘Editing
named colors’ section (on page 201) below.

3.

FILE"

SAVE AS"

To test your color scheme, drag and drop it from File Explorer onto a page that still has
the default theme colors. The page should be instantly re-colored using your color
scheme.

Creating new named colors
If you want to use the same color in different parts of the drawing, and there is any
chance you might want to change that color in future, it is highly recommended that you
create a NAMED COLOR . This is easy in Xara Designer Pro X:
Select an object whose color you want to use and then click
COLOR EDITOR .

NEW NAMED COLOR

in the

Color Handling
Click to create a new named color

Give the color a suitable
name, like "car color" and
click create. You will see
the new color added to the
COLOR LINE .
You can now apply this
color to any object the
usual way, by dragdropping it from the Color
Line or just clicking (or right
clicking to use it as a line
color) to apply as the fill
color.
When you edit a named
color, all objects that use
this color will change.

Replacing colors
Designer Pro makes it easy for you to recolor complex grouped objects such as buttons,
text panels, navigation bars etc, by listing the colors used and prompting you to choose
which one you want to replace.

The color replacement dialog lets you select which color to replace in the group.

Recolor an item in one of the following ways:
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 Drag and drop a color from the color line onto the item.
 Select your item and then click a color on the color line.
 Select the item and then bring up the COLOR EDITOR (ON PAGE

193)

(Ctrl+E).

The editor will display a list of the item's colors in the drop-down menu at the top of the
editor. Select the one you want to edit and then use the color editor as normal to edit it.
Note that when replacing colors in graphics this way, you can replace the use of named
colors with unnamed/local colors, or vice-versa. So for example you could take a button
that uses Theme Color 1 and replace Theme Color 1 with Theme Color 2. From then on,
editing Theme Color 2 in your document would change the button color too. Or replace
Theme Color 1 with a local color, so the button is no longer linked to any theme colors at
all. And you can use this facility to quickly apply named colors to graphics that were not
originally designed to use named colors at all.

The pen item is selected and the Color Editor displays the range of color replacement options
available.

Note that when an object with multiple colors is selected, the dropdown list in the color
editor lists only those colors in it. The Local fill color, Local line color and list of named
colors are not included in the list in this context, to avoid making the list too long and
potentially confusing.

Color Handling
Changing background colors
Drag-drop colors from the color line onto the page or pasteboard background to set the
color of either. If there are multiple colors in the background, the Replace Colors dialog
will be shown to let you choose which color to replace. It works the same way as
described above for groups with multiple colors.
To use the color editor to change the background colors, right click on the page and
choose "PAGE BACKGROUND" >"EDIT PAGE COLOR" , or on the pasteboard background and
choose "PASTEBOARD BACKGROUND" >"EDIT PASTEBOARD COLOR" .

Editing named colors
There are four ways to display the color in the COLOR EDITOR (on page 193) so it can be
edited:
 Choose from the menu in the COLOR EDITOR .
 Or right click on the color on the COLOR LINE and choose EDIT from the menu that
appears.
 Or drag & drop a color from the Color Line onto the COLOR EDITOR .
 Or drag & drop a color from the COLORGALLERY (described later) onto the COLOR
EDITOR .
You can then edit the color as required. All objects that use this color are automatically
and immediately updated to show the new color across all pages of your document.

Renaming named colors
While editing a NAMED COLOR, right click on the COLOR EDITOR and select RENAME
 Or select the color in the COLOR GALLERY and select the NAME button, or
 Or right click the color on the Color Line and select RENAME .

Deleting named colors
To delete a named color:

1.
2.

In the COLOR GALLERY , select the color or colors you want to delete.
DELETE

COLOR GALLERY

Or:
Right click on the color on the Color Line and choose DELETE .
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Importing named colors
When a design is imported into the current document (e.g. import from the ONLINE
CONTENT CATALOG , import a XAR file or paste objects in from another design) if there are
any named colors in the imported design which have the same names but different color
values as colors in the current design, an alert appears as follows:

If you want the imported objects to inherit the colors of your current design, choose the
“MATCH ” option. This makes all objects using a given named color use the existing
instance of that color as it appears in the current document.
Alternatively if you want the imported objects to keep their own independent colors,
select the “DON’T MATCH ” option. This adds new named colors into your design, with a
number appended to the color names to distinguish them from the colors already in the
current design. This allows the imported objects to keep their original colors.
Note that if you import objects from lots of different designs and choose “ DON'T MATCH ”
each time, you will end up with a large number of separate Named Colors on your color
line. This is rarely useful. So a better option is to use the Replace Color facility described
above to change the colors of objects where you don’t want them to pick up the theme
colors of your document.
The same prompt is shown if there are Text Style definition differences between the
document and the imported design. So seeing this prompt does not necessarily mean
that there are different named color definitions – it could just be due to Text Style
differences. See the Text Styles section of the Text Handling chapter for details.
The match prompt above includes a “DON’T ASK ME AGAIN ” checkbox. If you check this,
the option you choose will be assumed for all future imports, without asking you again.
However this only applies during the current session, so after a program restart you will
be asked again on the next import if there is a color clash.
Using the MATCH option means that you can choose a template, change its theme colors
and then import more templates of the same theme and the imported designs will
immediately pick up your modified theme colors.
For example, import a red graphical button from the ONLINE CONTENT CATALOG , change
its main theme color from red to green, then import a red logo graphic of the same theme
and choose the “MATCH” option. When the logo appears in your design, instead of being
red it will have picked up your chosen green theme color automatically. Since most

Color Handling
themes have their main theme color named “Theme color 1”, you will also usually get
good results when importing graphics from different themes and matching the colors.

Make Named Color local to Frame/Layer
When you click this button, a new named color is created which is identical to
the one you have selected.
This new color is then applied to all objects in the current frame or layer that use the
selected named color. This means that with one click you can localize a color to the
frame/layer. You can then independently edit the original color and this localized color.
This feature is useful when you are creating animations and you want an object's color to
change part way through the animation.
This button is dimmed unless you are editing a named color that is also used in another
frame or layer.

Normal colors, Tints, Shades and Linked colors
Normal colors
These are the normal stand-alone colors you apply to objects.
Xara Designer Pro X can also define colors that are linked to another color, that is when
the parent color changes the linked color will change as well. There are three ways you
can link a color to its parent TINTS , SHADES, and LINKED COLORS . These are very powerful
techniques that allow, for example, single-click re-coloring of complex shaded drawings.
Some of the example clipart uses this technique.

Tints
Tints are based on other colors (called the parent color) and are always a paler version
of the parent. They have two main uses:
 Where you have paler shades of a parent color and you may want to change the
parent color in future with the tints automatically updating.
 To extend the range of colors available from printing inks.
For example, a 25% red tint gives a pink color. Therefore using just a red ink you can
have both a pure red and a pink using only one ink. Similarly, if just using black-andwhite printing, it’s often useful to be able to use tints to create various shades of gray.
If you are printing with a limited range of colors (it’s usually cheaper to print one or two
color, instead of full or four color printing).
A tint can be based on any type of color, including another tint.
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Any changes you make to the parent color also change tints based on it. For example,
you might define the color pink as 50% of a red parent color. Changing the parent color
to orange automatically changes pink to light orange.

Shades
These allow both lighter and darker colors to be created all based on a parent color.
Changing the color of the parent changes all associated shades. For example, a drawing
of a car might use shades for the highlight and shaded regions of the car body. A single
edit to the parent changes all the colors of the entire body but keeps the shading correct.
Setting up shades this way is more time consuming but it is a very powerful way of
altering colors.
For best results, the parent color should be a "pure" saturated color. When using the
HSV color mode, saturation and value should ideally be 100%. When viewed in the
COLOR EDITOR (on page 193) the cross should be in the top left-hand corner.

Linked colors
Linked colors are similar to shades but give greater flexibility. These are also based on a
parent color but you define which attributes you want the linked color to share with its
parent. For example you can create a linked color that is a more or less saturated version
of the parent, but the hue and lightness / darkness follow the parent.

Creating a Tint, Shade or Linked color
TINTS , SHADES

and LINKED COLOR have to have a master "parent" color, which needs to
be a named color, so that when you change this parent color, the tint will change as well.
So, if necessary, first create a named color (see Creating new named colors (on page
198)).
To create a tint, shade or linked color:

1.
2.
3.
4.
5.

Select the object or objects to which you want to apply the color.
Open the COLOR EDITOR showing the advanced options.
Select the "normal color" drop-down menu and select the TINT , SHADE, or LINKED
option.
From the PARENT dropdown menu, select the named color that you want this color
to be linked to.
TINT SHADE

LINKED COLOR

Color Handling

On the left you can see the new color is a tint of the parent "yellow" and so the editor provides
only paler tints of the parent color. On the right, if you select a shade, you get to choose any
lighter or darker shades of the parent color.

If you want to use this color in many places in the document it’s recommended that you
also make this a Named Color, so it appears on the Color Line, for easy picking. Just
click on the NEW NAMED COLOR label icon on the top of the Color Editor and give it a
name. It will now appear on the Color Line where you can pick it for use on other objects.

Editing the parent color
The key point of using tints, shades and linked colors is that they track any changes to
the parent color. To see this working try editing the NAMED COLOR that is the parent (drag
it from the COLOR LINE to the COLOR EDITOR and alter the color). You will see the objects
with the tint, shade or linked color change in sync with the parent.
NOTE:

Be careful not to edit the color of objects on the page to which you’ve applied
or LINKED COLORS as this will change them to LOCAL COLORS .

NAMED , TINTS , SHADES,

The Color Gallery
The COLOR GALLERY displays all the NAMED COLORS used in the current, and other open
documents. It also lets you create, edit, copy and delete NAMED COLORS .
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To access the COLOR GALLERY :
 Choose UTILITIES -> GALLERIES -> COLOR GALLERY ("F9").
 Or click the COLOR GALLERY button on the GALLERIES bar.

Buttons at the
top are dimmed if
they are not
available, for
example, if there
is no selected
color, or more
than one color is
selected.
The REDEFINE
button redefines
the selected
color in the
gallery to be that
of the selected
object.

The Color Gallery shows colors for all documents currently loaded.

Document handling (on page 60) has general information about galleries.

PANTONE® Colors
PANTONE COLOR BRIDGE gives access to a wide range of standard pre-defined colors
that you can use when creating materials that will be professionally produced using litho
printing. Using PANTONE color numbers enables a more reliable way of reproducing
known colors. For example, the Scottish Parliament has defined that the blue color used
in the Scottish flag be PANTONE 300. This means anyone reproducing the flag can be
sure to get the correct shade of blue.
PANTONE colors can be used two ways. The "spot color" expensive way involves your
commercial printer using special inks that are exact PANTONE colors. So when you
specify, say PANTONE 120 (a shade of yellow), the printer purchases an ink that is
exactly this shade of yellow. This is expensive because it requires special inks to be
used. It’s usually only economically viable if you require large or very large production
runs. This is sometimes referred to as PANTONE solid or spot colors.

Color Handling
The alternative, less expensive way, is to use PANTONE 4-COLOR PROCESS colors,
which use a mix of the standard CMYK inks to re-create a given color, sometimes called
a Process Color. This is less exact because mixing CMYK inks to create a given color is
not as reliable as using a solid pure ink of the required color. However it provides a way
of ensuring much more accurate color reproduction than judging colors by eye or
assuming your computer monitor screen or inkjet printer is accurate (computer screens
and desktop printers vary quite considerably).
Xara Designer Pro X also supports both type of PANTONE color system. You can use
them as spot or solid colors or use the PANTONE 4-COLOR PROCESS library which
defines exact mixes of CMYK colors. You can find the PANTONE color libraries in the
COLORGALLERY .

Using a PANTONE color
To use a color from a library either:
 Just drag & drop the color from the COLOR Gallery onto the object to which you wish to
apply the color (for other ways of applying colors from the COLOR Gallery, see Color
handling (on page 189)).
 Or in the COLOR Gallery, drag the color you want to use from the library section up to
the section for your current document. This lets you copy several colors in one
operation. (See Galleries (on page 60) for details of selecting items in a gallery.)
This copies the library color into the document and displays it on the color line.
You cannot delete, rename or redefine colors in the color libraries. However, you can
change copies of colors used in your document.
Note: Altering a PANTONE COLOR BRIDGE color will cause it to become a process
(CMYK) color.

Important notes when using PANTONE colors
PANTONE colors (and CYMK colors in general) are useful for reproducing a known
color. There is no other reason to use CMYK or PANTONE colors, and for all normal use
we recommend using HSV or RGB colors.
If you use any of the Xara Designer Pro X transparency effects on or over any CMYK or
PANTONE color, the color will be modified by the transparency process (which mixes
any transparent colors with those underneath the object) and will not produce the
expected PANTONE color. This is an unavoidable consequence of the way transparency
works.
So a simple rule if you require a PANTONE COLOR BRIDGE color or a specific CMYK
color value (and that includes the use of pure K shades of gray) is to not use
transparency, feathering, soft shadows, bevels or Live Effects on or over these objects.
Doing so will result in that object or portion of the object being processed as RGB colors
and so will result in color shifts.
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Viewing print colors on screen
There is a huge difference between screen and printed colors. Computer monitor
screens can reproduce a much wider, much brighter range of colors. Printers use CMYK
inks instead of RGB colors, and so the method of reproducing color is entirely different.
As an example, pure bright RGB green on screen is completely impossible to reproduce
on any printer.
Technically speaking the screen color gamut is much larger than available on printers.
Xara Designer Pro X provides a simple way to simulate the printer colors, which adjusts
all on-screen colors to more closely match that of a typical printer. Select WINDOW ->
SHOW PRINTER COLORS -> SIMULATE PRINT COLORS to adjust the screen colors.
Note: This does not alter the actual RGB or CMYK color values, it just adjusts the screen
color gamut to more closely match that of your printer.
Note: Some Adobe software, such as Photoshop and Illustrator, handles printer colors
very differently. They only support one color model at a one time and will convert all
colors to the current color model. e.g. when operating in CMYK mode, all RGB colors are
converted to CMYK colors. They also show all CMYK colors as "printer simulated". Xara
Designer Pro X, on the other hand, supports mixed color models (you can use CMYK
and RGB color in the same document) and does not alter the actual color value.

Text Handling

Text Handling
The Text Tool
Use the TEXT Tool ("F8") to enter or edit text.

Text Tool InfoBar Left Side

Font
Font Size
Style

Bold
Italic
Underscore
Strikethrough

Text Tool InfoBar Right Side

Justify
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Subscript/Superscript
Line Spacing
Bulleted Lists
Numbered Lists
Outdent
Indent
Spell Checker / Auto correction
Columns
Space before paragraph
Space after paragraph
Show / Hide Advanced text bar (toggle on/off)

Advanced text bar

Baseline shift
Tracking/Kerning
Aspect ratio
Auto Hyphenation toggle on/off
Paragraph Options
Vertical Text Alignment (text areas only)
Open Type Ligatures
Xara Designer Pro X supports three basic type of text objects
 Simple text lines: Click on the page, and type.
 Text columns: Click and drag to create a column, and type.
 Text areas: Click and drag diagonally to create a rectangular area, and type.
After you’ve created any text object you can transform it (rotate, scale, skew) and can
apply all the normal attributes, fill color, transparency, feather etc, using the normal tools.
You can also attach it to a curve. The text will remain editable.

Text Handling
The Font Menu
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Live font size pop-up
Fonts used in the current document
Web safe fonts
Style variants available for the selected font. Not all fonts have such variants
Google fonts
All fonts installed
Font type - usually either OpenType or TrueType as designated by the
accompanying symbol.
The font menu lists all installed fonts, and is split into four sections. The top section
displays those fonts that are currently used in the document. The second section shows
the “web safe” fonts. These are the fonts you can safely use in web pages, because all
commonly used web browsers will support these fonts. The third section shows the
available Google fonts and the final section displays an alphabetical list of all other
installed fonts. Each font name is displayed in the menu using its own typeface, making
font selection easier.
Those fonts for which multiple font styles are available are shown with small black
triangles against them on the right hand side of the menu. Simply hold the mouse pointer
over such a font name for a second or two and a small sub-menu appears to the right of
the main menu, listing the available variant of that font. While this sub-menu is displayed,
you can move the mouse pointer over it to select the desired font variant.

Web Safe Fonts
These fonts are safe to use in websites because the vast majority of computers and
other devices will have these fonts installed. You can also use any of the hundreds of
Google fonts in your website. And you can even use other fonts you have installed if the
font license permits it.

Live Font Preview
As you move the mouse pointer over any entry in the font menu, the selected text in the
document is instantly updated to preview the font. This is not a permanent change until
you actually click on the required font. Moving the mouse pointer over the menu will
revert back to the initial font until you move over another entry. This is great for very
rapidly previewing large numbers of fonts.
If you hold down the "Shift" key while traversing the font menu, then the font selection is
not updated instantly, there is a short pause before it is updated. This is useful if you find
that instant preview slows down your traversal of the menu (perhaps if you have a large
amount of text selected).

Text Handling
Live Font Size preview
Next to the font size menu is a small pop-up slider control, like that used elsewhere in
Designer Pro. This provides a direct, live font size control, and will adjust the font size of
the selected text in real-time as you drag the slider.

Click to display font size pop-up

As with the pop-up sliders used elsewhere this can be used two ways. "Click + release"
on the arrow and the pop-up will appear and stay on screen. You can now drag the
slider, or use the mouse scroll wheel over the control to rapidly adjust the values. So in
this case, this provides a fast way of adjusting the point size using the mouse wheel to
see the results directly on the page of the document as you work.
The alternative method of using the pop-up slider is to "click + drag + release" on the
button and slider. This is a slightly more direct way of adjusting the control (requires less
clicks).

Instant font menu navigation
While the font menu is displayed, you can type the initial characters of the font name,
and the menu will be scrolled to that section of the list. E.g. if you type "ver" it will
instantly scroll and locate the Verdana font.

Google fonts
Designer Pro also gives you the option of using one of the hundreds of Google fonts.
These are free, open source web fonts that have the advantage of being hosted by
Google so you don't have to upload font files with your document when it's exported as
HTML - the visitor's browser will automatically fetch the fonts from the Google font
hosting servers.
The fonts are fully integrated within Designer Pro so you can browse and search through
the font list using the FONT FINDER to download and install the fonts to your own
computer.
To start using Google fonts simply click

ADD

on the font menu to pull up the Font Finder.
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Google Font Finder showing some of the available fonts and font families.

You can search for fonts by typing the font name into the search box, or else scroll down
through the list to find a suitable font. Qualify your search by selecting font styles from
the checkbox lists on the left and use the live preview slider to see the font at a different
sizes.
Click on your chosen font and you will be asked if you want to download and install the
selected font. On many Windows computers, and depending on your Windows settings,
you’ll be prompted by Windows to give permission for the installation, which is performed
by a separate FontInstall program that is launched. Each font you install will appear in
the Google Fonts section of the font menu.
Some Google fonts, such as Exo, provide a wide range of weights. In these cases the
‘Bold’ option changes subtly. Font weight values can be from 100 (typically very light or
skinny fonts) to 900 (very heavy or black fonts). Instead of always selecting a given bold
weight, applying Bold (selecting the B button, or using Ctrl+B when editing text) works as
follows:

Text Handling
Main Text weight

Weight selected when ‘B’ is applied

100 to 300 (Thin/Extra Light/Light)

400 (Regular)

400 to 500
(Regular/Medium)

700 (Bold)

600 to 900 (DemiBold/Bold/Extra etc)

900 (Black)

Of course you don't have to use the fonts exclusively for webpages, because the fonts
are TrueType they can also be used with any print document - a PDF for example.
If you send another Designer Pro user a .xar or .web file containing a Google font then
they will be asked upon loading the document whether they wish to download and install
the font.
Note: some browsers do not render Google fonts as effectively as others, so it's always a
good idea to test your webpages with a variety of browsers to ensure the font quality is
acceptable.

Font replacement
It’s often useful to be able to completely replace one font with another across your entire
document or website, especially if you don’t have a particular font installed and want to
replace it with a font you do have.
In the Text Tool (on page 209) just right-click in the text with the font you want to replace
and choose the REPLACE FONT WITH … option from the context menu.
All variants of the font are replaced across your document, each with the matching
variant and size of your chosen font.

Symbols
The symbols are a huge range of scalable icons which are regularly updated as new
ones become available. Consisting of both Font Awesome symbols and Google Material
Design Icons - you can either insert them into text as a character font or insert them into
your document as a standalone graphic.
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The symbols are divided into various categories such as Web Application Icons, Brand
Icons, Text Editor Icons, Directional Icons and so on, and can be found on the INSERT
menu. "INSERT" > "SYMBOL". They also appear in the ONLINE CONTENT CATALOG under
the SYMBOL FONTS category. Just scroll down to see the full list.

Some of the Font Awesome Symbols.

There is a SEARCH function - for example type ‘Pay’ and it will show you Shopping cart,
Credit card, PayPal and other related symbols.
You can easily replace symbols as they appear in your documents, either with a
replacement symbol or an image, just right-click on the symbol and select REPLACE. This
works even if the symbol is inside a group
This also works for symbols in bulleted lists (on page 251) - simply right click on any
bulleted list with the text carat and select LIST PROPERTIES... from the context menu, and
then REPLACE WITH SYMBOL from the dialog.
You will be alerted if an updated version of a symbol font is released, or when we add
more symbol fonts. Installation of the new or updated fonts is automatic. It’s important
that you choose to accept these updates because the symbol picker and Content
Catalog always show symbols from the newest font versions, so if you’re not up to date
you may find symbols you choose to insert don’t work on your device if it has an out of
date version of the font.
The Material Icons font symbols are designed so that the symbol glyphs sit higher than
those of Font Awesome. You can see this if you insert a Font Awesome symbol and a
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Material Icons symbol next to each other in text. You can correct this in text by selecting
the symbol in the TEXT TOOL and adjusting the baseline shift (on page 264) downwards.
When using these symbols in bulleted lists (on page 251) you can adjust the vertical
position using the VERTICAL OFFSET function within the LIST PROPERTIES dialog. Rightclick on a list item and select LIST PROPERTIES... from the context menu, and then adjust
using VERTICAL OFFSET.

Inserting Symbols into text
Place the TEXT TOOL carat at the point in your text where you wish to place the icon and
then click on an icon in the collection. The symbol character is inserted into the text.
When you insert a symbol into your document this way, the symbol characters use either
the Font Awesome or Material Icons fonts. If you later publish your document as HTML,
you’ll see a warning telling you that the font will be published with your document or
website. This is not a problem, because the font licenses permit such use.

A symbol inserted as a font using the Text Tool

Inserting Symbols as graphics
To insert the icon as a scalable vector graphic simply make sure that the text caret is not
present before you click on the symbol to be inserted. To clear the text caret, switch to
the Selector Tool or any other tool except the Text tool.
The symbol will appear in the center of the workspace (be aware this may be behind the
symbol dialog). Use the Selector tool to move it to where you want it in your document, or
resize it, etc.
When you insert a symbol this way, your document does not need the appropriate font
anymore because it’s been converted to a graphic on insertion. So if you publish to
HTML you won’t see the font warning mentioned above.

A symbol inserted as a scalable graphic
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Simple text
If you wish to type a small amount of simple text, position the pointer where you want to
enter text and click. A red cursor appears where you clicked and you can now start typing
on the keyboard.
If you make a mistake, use "Delete" and "Backspace" in the usual way.
Pressing "Enter" completes the line and starts a new line of text below it. The inter-line
spacing is controlled by the line spacing text box on the InfoBar.
Simple text is not suitable for large paragraphs of text because there is no automatic line
wrapping (because the width is unlimited). Use a Text Column or Text Area instead (see
below).
By default text has no outline color. "Shift + clicking" on a color on the Color Line will give
the selected text an outline color - the thickness of which can be controlled by the line
width control, as usual. You will probably want to set the Line join type (on page 146) to
be rounded to give it a more smooth appearance (control at the top of the LINE GALLERY ).
Line width is described in Changing the line width (thickness) (on page 143). Applying
color is described in Color handling (on page 189).
You can continue to enter text even after rotation, color filling or placing it on a curve.

Text in a column
If you are entering larger amounts of text, over multiple lines, using a column is more
useful. Changing the width of the column will automatically re-flow the text.
To type a column of text:

1.
2.
3.
4.

Select the TEXTTOOL .
Move the mouse pointer where you want the column to start.
Drag right to create a horizontal line the width of the column. This green/red dashed
line just shows you the width of the column and the fact that the column is active. It
is never exported or printed.

Text Handling
NOTE :

If you click away or change tools before you start typing, the green/red dashed
column line will be replaced with a green line to indicate that you that you have an
inactive text column. To reactivate the column just click on it again with the Text Tool, the
line will return to its active state and you can start typing again.
Instead of typing in the text you can create the text in a separate text editor or word
processor, copy it to the clipboard and paste it into Xara Designer Pro X. Copy and paste
supports RTF-formatted text.

Changing the width of the column
Drag either of the two red handles at the ends of the line. If you switch to the SELECTOR
TOOL and drag one of the corner control handles the font size will scale together with the
size of the column.

Changing the angle of the column
"+ drag" either of the red handles at the end of the line to change the angle of the
column. Alternatively, "Ctrl + drag" to restrain the line to the constrain angles. Or
alternatively you can use the SELECTOR TOOL to rotate the object in the usual way.
For more on constrain angles, see Introduction to Xara Designer Pro X (on page 59).

Text areas

In the TEXT TOOL if you click and drag diagonally on the page you will create a
rectangular text area. The blinking cursor will be positioned in the top left corner and you
can type or paste text.
A text area can contain a "flowing" text story. This is where a single piece of text flows
from one text area to another. It’s called flowing text because, like water, as you add or
remove text in one area it overflows into connected text areas or flows back from text
areas.
If the text overflows the bottom of the text area the overflowing text is shown gray,
although you can continue to edit this text as usual.

Connecting text areas—text flow
When text overflows the bottom of the text area, a red flow arrow is shown on the bottom
of the area. If you drag this over any other text area, the overflow text will flow into the
new text area, and the two areas become connected. This is shown with a flow arrow.
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Overflowing text area with red
flow arrow.

If the text cursor is in an area with overflowing text, then just click-drag on the page to
create a new text area. The new text area is automatically connected and text will flow
into the new area.
Tip: You can flow text from one area to another on any page, even earlier pages. If you
need to flow into an area many pages away, it’s probably easier to use the above
method, although if you zoom out to a small page size you can drag the overflow arrow
across pages.
To disconnect one text area from another, just drag on the overflow indicator and drop it
away from any text area. Or click on the flow arrow at the bottom of the text area and
select UNLINK TEXT FLOW .
If you delete a text area that is connected to another only the area is deleted, the text will
simply re-flow into the remaining text areas.
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Automatically flowing text areas
You can make a text area flow onto a new page
automatically when the text in it overflows. This
feature can be turned on for any text area and it is
on by default in the text areas in the COLUMN
templates available under "FILE" > "NEW" .
To turn this feature on for a text area, click on the
black arrow at the bottom of the text area, and
select the AUTOMATICALLY CREATE NEW PAGES
option.
When a new page is created using this feature, it's
placed immediately following the current page. The
new page is just as it would be if you’d added it
manually (it will have the same background and
repeating objects of the current page). But in
addition it will also have a copy of each of the text
areas on the current page that are linked to the
current text flow and they will be linked together
similarly. So for example if you’re editing a 2
column page, the new page it flows into will be a
similar 2 column page.
Therefore you can continue entering text into the
text flow and new pages will be added as required
to accommodate it, just as in a word processor.
The text flows automatically from the top text area to
the bottom with both areas automatically linked.

Changing linked text areas together
Often your document will have similar layouts of text areas across multiple pages. If you
make a change to a text area on one page, you may want that same change to be
reflected for all similar areas in the same flow. So if you move or resize a text area and
there are similar areas in the same flow on other pages (that is, they have the same size
and position on the page) Designer Pro will ask you if you want to change those areas
too.
Note that if you choose not to have an area change applied to all similar areas in the
flow, the modified area will no longer match those in the rest of the flow. Therefore any
subsequent changes you make to that area will not trigger the prompt.
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Multi-column pages
You can use two or more text areas on your page, linked together as described
above, to make a multi-column page layout. But Designer Pro provides a much
quicker way to do this.
Select the text area that you want to make multi-column, or place the text caret
in it, then click the COLUMNS button on the TEXT TOOL InfoBar. Or right-click on
the text and choose COLUMNS… from the context menu.
The Columns dialog
appears...

Columns dialog

By default the number of columns shown will match the number of linked text areas you
have on the current page. But you can change this number to match the number of
columns you would like. So enter 3 for a 3 column layout. You can also specify the size
of the gap you would like between your columns. When done, press CONVERT. Your text
areas are transformed into a set of matching columns equally spaced.
The overall width of the set of text areas is maintained when you use the Columns dialog,
so if your original text areas cover only the left half of the page, so will the set of columns
created. Therefore if you want the columns to span the full width of the page, move
and/or resize the text areas so they do cover the full width and then use the Columns
dialog again to give them all equal size and spacing.

A 1 column page transformed into a 3 column page.
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You can of course also use the Columns dialog to reduce the number of columns on the
page if required.
Where you have exactly the same column arrangements on multiple pages (where they
are in the same text flow), you will be asked if you want the column changes to be made
to all those pages too, as described for manual text area changes. Therefore using this
Columns dialog you can instantly convert an entire document from single column to
multi-column, or back, if there is just a single text flow.

Column breaks
Insert a column break into a text area by using the TEXT TOOL to right-click at the point in
the text where which you want the break to occur. Then select "INSERT" > "BREAK" >
"MOVE TO NEXT COLUMN" . Or use the shortcut (Ctrl+Shift+Enter).

A break inserted mid-way through the middle column (left) shifts the text into the next column
(right).

All the text after the column break now appears in the next linked text area in the current
flow, whether that area is on the same page or the next page.

Vertically aligned text
You can align text vertically within text areas, so it’s top, center or bottom aligned. This is
useful wherever you want to align multi-line text vertically with other features on the
page, especially text that you want to edit regularly so the number of lines varies.
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Text areas with top, center and bottom alignments

To change the vertical alignment of a text area, place the text caret in the text and select
the VERTICAL TEXT ALIGNMENT button on the advanced text InfoBar.

This reveals a menu allowing you to choose the vertical alignment. This option is not
available for text columns or simple text lines.

No repelling
Note that unlike normal top-aligned text, centred and bottom aligned text cannot currently
be repelled. So objects with REPEL TEXT UNDER turned on will have no effect on such text.

Page breaks
Insert a page break into a text area by using the the TEXT TOOL to right-click at the point
in the text where you want the break to occur. Then select "INSERT" > "BREAK" > "MOVE
TO NEXT PAGE" . Or use the shortcut (Ctrl+Enter).
All the text after the page break now appears in the first linked text area on the next
page.

Resizing text areas
Using the TEXT TOOL , you can click and drag on any of the corner control handles. The
text in the area will be reformatted to fit the new size. If you resize a text area using the
SELECTOR TOOL , using the corner control handles, the text itself is scaled as well, but use
any of the other control handles and the text area size is changed and the text reflows in
it to fit the new size.
You can also change the size of the text in the text area, by going into the TEXT TOOL ,
select all the text with Ctrl+A and change the font size on the TEXT TOOL InfoBar.

Text Handling
You can rotate a text area, using the SELECTOR
through the rotated text area normally.

TOOL

as normal, and the text will flow

Text flow is unaffected if you rotate any of the text areas

Hold down "Ctrl" while rotating to constrain the text rotation angle to 90° angles and
screen aligned angles.

Word count
The word and character count total of the current text is shown in the status line. This
also shows the number of overflowing words. If any region of text is selected, it shows
the count of this selection instead.

Text along a curve
To place text along a curve of your choice:

1.
2.
3.

Create either basic text, text in a column
or a text area (see above).
Select your text object and one curve.
"ARRANGE"

FIT TEXT TO

CURVE"

Alternatively, select a curve or line and then in the TEXT TOOL, click on the line, where
you want the text to start, and type. This automatically fits the text along the line. When
you reach the end of the line the text will wrap onto a new line, immediately below the
start of the previous one.
If you do not want the text to wrap to a new line, "Shift + click" on the line.
To hide the curve so it’s not visible, select the SHAPE TOOL and set the line color to
NO COLOR or a width of NONE . You can also edit the curve as usual this way.
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To hide the curve so it’s not visible, select the SHAPE TOOL and set the line color to NO
COLOR or a width of NONE . You can also edit the curve as usual this way.
Applying color is described in Color handling (on page 189).

Adjusting the left and right margin of text on a curve
If you just start typing or place a column of text on a curve, you can change the start and
end position of the red handles. Just drag them along the curve as required. If you
center text it will be between these two margins.

Swapping sides of the line
Right click on the text and select the

REVERSE TEXT ON CURVE

menu option.

Alternatively, if you reverse the direction of the line (SHAPE TOOL , REVERSE PATHS button
on the InfoBar), then the text will move to the other side of the line or, in the case of a
closed shape, move from the inside to the outside of the shape.

Editing text
Double clicking on a text object in many of the tools takes you into the
places the cursor at the click position in the text.

TEXTTOOL

and

All the normal word processor-style cursor and mouse operations can be used. For
example:






Click where you want to place the cursor.
Use the left and right arrow keys to move left, right, up or down.
Use "Ctrl + left and right arrow keys" to move left or right one word.
Press "Home" or "End" to move to the start or end of the line.
Press "Ctrl + Home", or "Ctrl + End" to move to the start or end of the text object.

Text selection:







"Shift + any" of the above keys to select text
Double click to select a word
Triple click selects a whole line of text, or "Ctrl + L"
Quadruple (4x) click selects a paragraph of text
Or just drag across the text in the Text Tool to select the text
"Ctrl + A" will select all the text in the text object (you must be in the TEXTTOOL .)

If you have a text selection any attribute change will apply only to the selected region of
text. If you have only the cursor in the text, then any attribute change, say selecting a
new color, will only appear when you type new text.
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Selecting the whole text object
There is a quick shortcut for selecting the whole text object. Instead of using "Ctrl + A" or
dragging across all the text, simply press the " ESC" key. This removes the cursor but
selects the whole text (the status line will confirm 1 text object). This makes it easy to
apply an effect or attribute to the whole text selection.
For example, to change the font size of the whole text object, just press " ESC" and select
the new size from the InfoBar.

Switching case
Use the context menu to change the case of selected text, so right click and choose from
the following options..
 "CHANGE CASE TO" > "LOWER CASE"
 "CHANGE CASE TO" > "UPPER CASE"
 "CHANGE CASE TO" > "SENTENCE CASE"
Additionally...
Pressing "Ctrl + Shift + F1" will make selected text toggle between all uppercase and all
lowercase. So, if you've accidentally typed a section of text with the caps lock key on,
just select the text and press "Ctrl + Shift + F1".
Pressing "Ctrl + W" will swap the case of the character after the cursor and move the
cursor on. You can swap the case of a selected region of text, the same way. Uppercase
characters will become lowercase and vice versa. The cursor will not be moved.

Smart Quotes

When you type quote ' or double quote " characters, Xara Designer Pro X will
automatically convert these into the more appropriate and aesthetically accurate opening
or closing quotes. It is also smart enough to understand the use of single quotes within
words to signify missing characters.

Entering special characters
There are a number of useful shortcuts to allow insertion of special characters, like © or
™. See Special characters (in Text Tool) (on page 658) section in "Menus and keyboard
shortcuts".
All these shortcuts (with the exception of the hard space) are compatible with Microsoft
Word.
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Entering dummy text ('Lorem Ipsum')
You can insert a paragraph of dummy "Lorem ipsum" text by pressing "Ctrl + Shift + L"
("L" for Lorem) while using the TEXT TOOL . To insert a larger block of text, just press the
key combination a few times.
The function is also available on the main INSERT menu or else as part of the right-click
context menu. "INSERT" > "LOREM IPSUM TEXT"

Spell checker
The TEXT TOOL (on page 209) includes a spell checker, click on the "SPELL
CHECKER / AUTO CORRECTION" icon on the Text Tool InfoBar, and you will see a
dropdown menu.
To use the spell checker select “CHECK SPELLING
AS YOU TYPE ”. Now all unrecognized words - both
in your document - and as you type, are shown
with a red dashed underline.
To correct a misspelled word, right-click on it, and
the context menu will suggest alternative
replacements. Simply select one of the
suggestions to replace the underlined word.
ff

Language selection
The menu shown when you click on the Spell Checker icon on the InfoBar lists all the
languages for which you have dictionaries installed.
To change the language associated with all the text objects in your document, choose
the required language from the "DOCUMENT LANGUAGE" submenu. Now all the text
objects in the document will be checked against the dictionary for the language you
chose.
To change the language associated with an individual text object, select the text object
with the TEXT TOOL and choose the required language from the Spell Checker menu.
Now the text object will be checked against the dictionary for the language you chose.
When you change the current document language, you will be asked whether all existing
text in the document should also be set to the chosen language, or left unchanged.
If you don't want any of the text objects in your document spell checked at all, then select
"DOCUMENT LANGUAGE" > "NO LANGUAGE (IGNORE)" . And If you have individual text
objects which you don’t want to be spell checked, select the object using the TEXT TOOL
and choose the "NO LANGUAGE (IGNORE)" option from the Spell Checker menu
When you open an older document, the document language is automatically set
according to the language on the Normal text style in that document. Newly created
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documents have their document language set to match the language setting of the
current device, as with previous versions of Designer Pro.

User dictionary
Words that you use regularly which are not in the dictionary provided with Xara Designer
Pro X can be added to your own personal dictionary. Right click on the word and choose
“ADD TO USER DICTIONARY ”. Now the word is no longer shown as being misspelled. The
user dictionary applies to all documents that you use on your computer and it applies to
all languages.

Auto correction
Click on the SPELL CHECKER / AUTO CORRECTION icon on the TEXT TOOL InfoBar,
to use the auto correction feature. Select AUTO CORRECTION OPTIONS... from the
dropdown menu.
A dialog will open allowing you to add and replace words as well as keyboard symbols
with symbols from the symbol (on page 215) catalog. The feature is always on by default
but you can turn it off within the dialog.
There is a selection of useful items already listed, and you can add your own. Click on
ADD to create a new field and then type a word or a character in the REPLACE column,
then click in the WITH column to either type a replacement, or click on PICK SYMBOL to
choose a replacement from the symbol catalog. The symbol you've chosen appears in
the WITH column. Close the dialog by clicking OK .
Now when you type a word or character listed in the options it will be replaced with your
alternative word, character or symbol.
So for example if you want to be able to type “Rwd” and have that instantly replaced with
“Responsive Web Design”, simply press the ADD button and enter “rwd” in the REPLACE
field, and “responsive web design” in the WITH field. All text in the dialog is forced to lower
case but the replacement tries to be smart about use of case.
So if you type...
 "RWD" will be replaced with "RESPONSIVE WEB DESIGN"
 "rwd" will be replaced with "responsive web design"
 "Rwd" will be replaced with "Responsive Web Design"

Hyphenation
Words only split across lines if they contain a hyphen character (minus key) and while it
is possible to do this manually using the keyboard (see below), Designer Pro enables
you to do this automatically using the auto hyphenation feature.
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Auto hyphenation is a paragraph attribute - like line spacing and paragraph styles. You
can have hyphenation on in some paragraphs and off in others, all in the same text flow.
Just place your text caret in the appropriate paragraph.
To turn the Auto hyphenation feature on or off - click on the HYPHENATION
button on the Advanced text bar. Or enable it from the dropdown menu of the
SPELLCHECKER / AUTOCORRECTION / HYPHENATION button.
To change the hyphenation settings click on the HYPHENATION SETTINGS...
option on the dropdown menu of the SPELLCHECKER / AUTOCORRECTION /
HYPHENATION button.
The settings dialog will appear, allowing you to control how hyphens are inserted into
your document.

You can decide the SMALLEST WORD to which a hyphen will be applied, and the position
of the hyphen within that word.
Adjusting the HYPHENATION ZONE will change the degree of "raggedness" before
hyphenation is applied. So for example, with left justified text this would be the size of the
margin to the right that would be empty without trying to fit in more text using automatic
hyphenation. With right justified text this would be the margin to the left, and with fully
justified text this would be empty areas - "rivers of white" between words.
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Increasing the zone allows less hyphenation - and consequently more white space. The
Hyphenation zone can be expressed as an absolute value as in pixels, mm's, or as a
percentage of the width of the text object (the default is 5%).
Use the CONSECUTIVE HYPHENS fields to limit the number of consecutive lines ending in
hyphens. The ATTENUATION setting creates a "soft" limit on this, so that you can set a
balance between having consecutive hyphenated lines and lots of white space on
following lines. A useful value is between 5% and 10%. Values higher than 20% often
inhibit consecutive hyphens so much that they no longer occur at all.
The final three checkbox options allow you to hyphenate ALL-CAPS WORDS , CAPITALIZED
WORDS , and the LAST WORD IN A PARAGRAPH . These are options which you would
normally leave unchecked as they generally look odd when hyphenated, but there may
be instances where you want them to be hyphenated.
Lastly you can create your own hyphenation list. Click on EDIT DOCUMENT HYPHENATION
LIST... to open the DOCUMENT HYPHENATION LIST dialog, and add words that you want to
hyphenate in a specific way. Place a tilde (~) where you want the hyphen to appear. You
can also add words that you don't want hyphenated to the list. Just add the unhyphenated word.

The list remains with the document so that if you share the document the hyphenation
preferences remain active. You can also import your own list to a document, which will
add your own preferences to the list.
Inserting hyphens manually
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If you type "Ctrl + -" (minus key) it inserts a soft hyphen which is a hyphen that only
appears if the word can wrap at the end of a line. It's called a 'soft' hyphen because when
the word appears in the middle of a line the hyphen vanishes (unlike a normal dash or
minus character), so it intelligently hyphenates the words only if it needs to.
When editing the text a soft hyphen is treated as an invisible character (it takes no
space), but you can tell it's in the text by moving the cursor left/right over where the
invisible character is.
A hard hyphen can be inserted by typing "Ctrl + Shift + -" (minus key). A hard hyphen is
one that will not cause a wrap at all. This is useful in situations where you have dashes in
words that you do not want split at the end of lines.

Find & Replace
The Find & Replace function performs live search so that as you type the search query
the text is searched and highlighted in real-time.
To search for some text select the menu "EDIT" > "FIND/REPLACE..." or "Ctrl + Alt + F" and
the following dialog is displayed:

Enter the search term and it's shown highlighted in the text. You can choose to search
just the current text flow, or the whole document (all text flows on all pages).
The WHOLE WORD option will only search for whole words that match the search term.
E.G. searching for 'met' will not find 'metro'. The CASE SENSITIVE option will match only
the exact case. E.g., with this option on, searching for 'aBc' will not find 'abc'.

Inserting a Table of Contents (TOC)
The option "INSERT" > "TABLE OF CONTENTS…" builds a table of contents (TOC)
automatically and inserts it at the text caret.
This operation works by finding all the headings in your document that use a Heading
text style (Heading 1, Heading 2, etc.). It won’t find headings that you have formatted
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manually, for example by just making text bold - you must have a heading text style
applied to the headings. When you invoke this operation, the following dialog appears...

Table of Contents dialog

Level
This lets you choose which headings should be included in the table. If you only want
your top level heading (usually Heading 1) to appear in the TOC, set the level to 1. The
default is level 3 so that's Headings 1, 2, and 3, although you can go right up to level 9 if
you really need to. The table of contents indents each heading according to the
heading’s level, so you get nested headings.

Include page numbers
Select this option if you want to include page numbers in your table. The page number
style is chosen to match the style of page numbers you have in the same document, if
there are any. Otherwise it uses the default number style. The table includes tab stops on
each line so that the page number appears over near the right edge of the text column or
area.

Use common website link colors
Each entry in the table of contents is linked to the appropriate heading in the document.
So this option lets you choose how the links appear in the table. If selected, the links will
use the document’s link colors, as specified on the WEBSITE (ON PAGE 445) tab of the
"UTILITIES" > "WEB PROPERTIES" dialog.

TOC Text Styles
When your table of contents is generated, a new text style is created for each level of
heading included in the table. TOC1 for Heading 1, TOC2 for Heading 2, etc. These
styles make it easy for you to customize the appearance of your table.
By default each of these styles is based on the Normal text style, so the table text should
look like the main text in your document. To change the style of any level within your
table, just make the change you want to one of the headings in your table, then select the
UPDATE option in the text styles menu to update the TOC style for that level of heading.
See Text Styles (on page 251) for more info on applying styles.
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Updating a Table of Contents
As you update a document, adding and removing headings, you will soon need to update
your table of contents. To do this place the text caret anywhere in the table, right-click
and choose "TABLE OF CONTENTS" > "UPDATE" . The table is updated, while preserving
any changes you made to the TOC styles.

Changing properties or removing a TOC
The right-click TOC context menu also includes a REMOVE option, for removing the table.
It also has a PROPERTIES option, which brings up the same dialog you used to create the
table. This allows you to change the properties of an existing table, for example to turn
page numbers on or off.

Synchronising text across multiple text objects
Sometimes you may want the same text to appear in multiple text objects and for those
objects to always have the same text, so that if one is edited they are all updated. You
can achieve this using LIVE COPIES if the only difference between the text objects is in the
way they are transformed (ie. only their position, scale, rotation or skew needs to differ).
See LIVE COPIES (ON PAGE 109) in the Object Handling chapter for details. In some
circumstances you can also use SOFT GROUPS to achieve text synchronization. See the
SOFT GROUPS (on page 98) section of the Object Handling chapter for details.

Tabs, Margins and Indents
Rulers
To adjust tabs, margins and indents you need to turn on rulers in your document.
To do this:
 Choose "WINDOW" > "BARS" > "RULERS" or right click a page and choose "SHOW
GRID/GUIDES" > "SHOW RULERS".

 Or press "Ctrl + (Shift) + R".
 Or press "Ctrl + L" (when not in the TEXT

TOOL ).

The enhanced text features will only appear on the ruler when you are using the
TEXT TOOL and when the text cursor is in a text story or the text object is selected
when in the TEXT TOOL .
In the TEXT TOOL when you drag the margins or tabs on the ruler, you get a temporary
vertical guide to make it easier to align the tabs or margins to objects elsewhere on the
page. In addition when dragging tabs or margins, if you have magnetic snap switched on,
these will snap to each other making it easier to position tabs and margins.
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Margins and indents
Any changes you make are made to the current paragraph of text. (i.e. the paragraph
containing the text cursor) or, if you have a selected region of text, to the paragraphs of
the selected region.
You can apply changes to all text in a text story by selecting all the text within that story
("Ctrl + A"). To change more than one text story, select the text objects while in the
SELECTOR TOOL then change to the TEXT TOOL and make the required changes.
Left margin. Drag this to change the left margin of the text.
First line margin. Drag this to change the left margin for the first line of the
paragraph (useful for lists, as shown below).
Right margin. Drag this to change the right margin of the text.

Demonstrating the left margin and first line margin
Demonstrating a right margin

Tabs
By default, text stories are created with tabs set 0.5 cm apart. This means you can just
press "Tab" and your text will be moved along to the next tab stop. You only need to
define new tab stop positions if you want alternative tab spacing.
These default tabs are shown as faint Ls on the ruler:

Standard tabs, indicated by faint "L"s

Custom tabs
To create a custom tab position, just click on the ruler where you wish to place the new
tab. It will replace default tabs up to that point on the ruler.
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For example:

The triangle indicates a custom
tab

 To set more than one tab click multiple times on the ruler.
 To move a custom tab drag it along the ruler.
 To remove a tab drag it off of the ruler (default tabs will come back).

Custom tab types
You can set different types of custom tab. By default, custom tabs are left align tabs. This
means that text will be aligned with the tab on the left of the text.
To change the tab type, click the tab icon on the ruler.
The following custom tab types are available. You are not
limited to just one type in a story, and can choose a different
type then set additional tabs.

Left align: The text will be aligned with the tab to the left.

Right align: The text will be aligned with the tab to the right.

Center align: The text will be centered on the tab.

Decimal point align: The decimal points in the text will be aligned with the tab. This
is useful for lists and, however long the number, the decimal points will be tabaligned.
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How to creating hanging indents
Hanging Indents, as they are known, are where the first line of a paragraph has a
negative margin or a margin that hangs to the left of the normal left margin. Numbered or
bulleted lists are examples of hanging indents.
To create hanging indents:

1.
2.

Drag the left margin inwards.
Click on the ruler away from the left margin (creates a new tab stop) and drag this
tab stop to be exactly over the left margin.

3.

Repelling text objects
You can make any object in Xara Designer Pro X repel text so that text underneath it
automatically flows around the object, instead of appearing underneath it. This makes it
easy to lay out pages containing long passages of text combined with photos and
graphics. Once you've set them to repel, you can adjust the positions of your graphics
and photos and the text will automatically adjust and reflow around them.
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You can also choose to only repel text within a layer, which stops objects within a layer
from repelling text on other layers and also stops text on the layer being repelled by
objects on higher layers.

Making an object repel
To make an object repel text, right click it and select the REPEL TEXT UNDER option. Any
text object in the same layer but below the repelling object (look in the Page and Layer
Gallery (on page 181)) will be repelled with a default margin of 5 pixels between the text
and object. Note that repelling text objects only repel text that is underneath the objects,
not any text that is on top.
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Alternatively right click on the object and select REPELLING & ANCHORING to display the
TEXT REPELLING & ANCHORING dialog.

Click the REPEL TEXT AROUND THIS GRAPHIC checkbox. And if you want the text to repel
as a rectangle around an object, click the RECTANGULAR REPELLING option as well. With
this option what happens is that the text repels around the rectangular bounding box of
the object, ignoring its outline. This is also more efficient if your document or website has
long text flows and has a lot of repelling objects that are also anchored to the text. It is
also the default option when you turn repelling on for rectangular objects.

Text repelling around an object (left) and rectangular repelling (right).

If desired, set a repel margin for the object to set the space between the text and the
object. If you want a different height and width for the repel margin, click the padlock
symbol and enter the margin height in the H (horizontal) box and width in the V (vertical)
box. Click OK .
To turn off repelling right click the object and choose the REPEL TEXT UNDER option again
to deselect it. Or right click and select REPELLING & ANCHORING to display the Text
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repelling & anchoring dialog again. Click the
to deselect it and click OK .

REPEL TEXT AROUND THIS GRAPHIC

checkbox

Note that single lines of text do not respond to repelling objects, only text areas and text
columns do.
To only repel text within the same layer as the repelling object, see Layer Properties (on
page 184).

Anchored Graphics
You can position any graphic, or group, so it's tied (anchored) to a position in some text,
so that as the text moves because of editing, the graphic object will move to remain at
the same relative position. However anchoring should only normally be used for objects
that sit outside the margins of the text (eg. A photo sitting to the right or left of a text
column), or behind the text. Use Embedding for objects that sit within the text bounds
(see below).

1.

2.
3.

4.
5.
6.
7.
8.

The quickest way to anchor a graphic or group is to right click it and choose the
ANCHOR TO TEXT option. However, if you also want to edit anchoring properties, you
can right click on the object and select REPELLING & ANCHORING to display the TEXT
REPELLING & ANCHORING dialog.
Click the MOVE GRAPHIC WITH TEXT checkbox.
By default MOVE VERTICALLY ONLY is also selected, so that your anchored graphic
will only move vertically as the text is edited. This is usually the most useful option –
if you want the object to track the anchor position horizontally as well, embedding
the object is usually a better option.
An anchor symbol appears in the top left of the object, indicating it's now anchored.
Using either the SELECTOR TOOL or TEXT TOOL , click and drag the anchor symbol so
that a red arrow appears.
Move the arrow head and drop it in the location in the text where you would like the
object anchored. A red caret (inverted 'T' mark) indicates the anchor position.
As you edit the text around this caret mark, the anchor point and anchored object
moves with the text.
When an anchored object reaches the bottom of the text area to which it is
anchored the text to which the object is anchored flows to the next page or column,
taking the anchored object with it. This is the default behavior for newly anchored
objects. However it’s controlled with the AFFECT TEXT FLOW checkbox in the
REPELLING & ANCHORING dialog, so you can turn this off if required. For legacy
documents the setting is turned off to avoid changing the way these documents are
formatted.

Text Handling

An anchored object displays an anchor symbol and an arrow pointing to the anchor point,
shown as a red caret mark.These disappear as you type, unless you're close to the anchor
point.

Note: If you drag the anchoring arrow to a place on the page where there is no text, the
arrow turns into a red anchor that indicates the object's anchoring properties will be lost if
it's dropped here. This also happens when the arrow is dropped on the object itself.
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This is an example column of text with various graphic elements hanging to the left. Each of
these is anchored to the start of a line of text immediately to its right.

It's possible to anchor any graphic object or group, including groups containing text, such
as the example side-panel, shown above. If the group consists of a single object you can
directly select that object instead of selecting the group that encloses it. Look at the
STATUS BAR and the PAGE & LAYER GALLERY to see this in action.
It's also possible to anchor objects to appear on top of, or below the text. The example
pale blue flower graphic, shown above, is anchored this way and will flow with the text.
NOTE :

If an anchored object is also set to repel, only the text that the object is anchored
to is repelled.
NOTE :

Repelling is restricted for repeating objects: Text inside a repeating group is only
repelled by repelling objects inside the repeating group. Individual repelling objects inside
a repeating group only repel text that is also inside the repeating group. Repeating
groups as a whole can repel any text stacked below on the page.

Text Handling
Moving Anchored Objects
As new text is added or deleted, the object moves as the text flows, but will always
maintain its new position relative to the anchor point. You can move an anchored graphic
by dragging on it as usual. This changes its position relative to the anchor point, but does
not move the anchor point, which remains visible at the end of the anchor symbol arrow
as you click/move the graphic.
If you want to move the anchor point to another location within the text, click and drag on
the anchor symbol again to create a new arrow and drag it to the new location.
If you cut and paste the text containing the caret mark, the anchored object is also cut
and pasted.

Viewing the anchor point
The anchor point of an anchored object is only visible if you click the anchored object in
the SELECTOR TOOL or click in the surrounding text area in the TEXT TOOL .
When you click in a region of text with the TEXT TOOL , it shows any anchors points within
an inverted 'T' symbol, and also draws an arrow from the anchor point to the anchor
symbol in the top left of each anchored object. So the easiest way to see all the anchor
points for any text is to click in it with the TEXT TOOL .
However, when you start to edit the text, the red caret, arrow and anchored symbol
temporarily disappear until you stop typing. If you are close to the anchor point, Designer
Pro displays the caret mark, along with an arrow pointing to the anchor symbol, to let you
know when you're close.

Removing an anchor
To remove an anchor from an object, right click it and choose ANCHOR TO TEXT again to
disable the option. Now when you click the object in the SELECTOR TOOL or in the text in
the TEXT TOOL , the anchor symbol is no longer displayed.
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Embedding Graphics
If you take a graphic, a photo or other object you can paste it "embedded" into text. You
can control how the text is formatted around embedded objects, and have the object
resize automatically according to the width of its containing text area or column. This is
particularly useful when you have the same text content with embedded graphics
appearing in columns of different widths in multiple variants of a website. See mobile
websites (on page 410).

An embedded graphic reformatted and resized for a main (left) and mobile (right) variant.

To embed an object, copy or cut it to the clipboard, go into the Text Tool and place the
text caret at the point in the text where you want to insert it, and then paste. Now if the
object you insert is wider than the text area or text column, the object is automatically
resized down to the width of the text column. Right-click on the embedded object and
choose "EMBEDDED GRAPHIC OPTIONS..." from the context menu - or in the ARRANGE
menu.

Text Handling
A dialog appears with the following options...

The SCALING options allow you to specify how the embedded graphic should behave if
the width of the text column/area is changed, or if the graphic flows into a text area with a
different width.


- With this option (the default), the object will resize
down if it’s too wide for the text column, but it will not grow up above its original size if
the column is wider than the object.
 RESIZE RELATIVE TO COLUMN WIDTH - This option allows you to specify that the
embedded object should always be a fixed % of the column width.
 FIXED SIZE - This option turns off the automatic resizing, so the object will never
change its size.
 SCALE ONLY IN HORIZONTAL DIRECTION - This option is useful mainly for simple divider
or Rule-off graphics, where you want the object to just stretch horizontally without
getting taller or shorter depending on the column width. It’s useful only for very simple
RESIZE FOR NARROWER COLUMNS
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designs because more elaborate graphical divider designs are not likely to stretch well
without looking distorted.
Add a simple Rule-off divider at the carat position using the "INSERT" > "RULE-OFF" menu
option.
The POSITIONING options allow you to choose how the graphic should be formatted into
the text.


INLINE WITH TEXT

- This is the default option. The graphic stays inline with the text with

no text wrapping, like this
, and behaves as though it's a large text character in the
text.
 TEXT WRAPS RIGHT - The graphic will be positioned to the left of the text column with
text wrapping to the right.
 TEXT WRAPS LEFT - The graphic will be positioned to the right of the text column with
text wrapping to the left.
The MARGINS options allow you to add some space around your graphic, so it doesn’t
appear too close to the text or to the edge of the column. You can specify different values
for each of the 4 sides of your graphic, or use the lock
buttons if you want to have the
same margin top and bottom, or left and right, without entering the same values
repeatedly.
Additionally in the "INSERT" menu, the "BREAK" > "MOVE BELOW EMBEDDED GRAPHIC"
option enables you to force the next paragraph of text to start below the graphic when
you have text flowing to the left or right of the embedded graphic.
When you embed a single object in text, you can directly select that object in the text
instead of selecting the “Embedded group” that encloses it. Look at the Status Line (on
page 36) and the Page & Layer Gallery (on page 181)! to see this in action.

Bulleted and Numbered lists
Bullet Lists
You can turn any text into a bulleted list by selecting the text and then selecting
the bulleted list button on the InfoBar.
Each paragraph of text becomes a separate bullet. If you press return to finish a line at
the end of one bullet point, the next line starts with a bullet point too. If you hit backspace
immediately after the return, the last empty bullet is removed, text cursor remains at the
same position and allows you to continue adding text to the previous bullet point.
To finish entering a bulleted list, hit return on the end of the last bullet and then
immediately hit return again on the new bulleted line. This removes the last empty

Text Handling
bulleted line and allows you to start entering normal text again. Or you can just turn off
the list button on the InfoBar.
You can nest bulleted lists by pressing the indent button on the InfoBar. This
indents the current bulleted line and changes the bullet character to a different
style, to distinguish it from the parent bullet.

Example of a nested bulleted list

To move a bullet point from a sub-list into its parent bulleted list, simply place
the text caret in it and press the outdent button.
So it’s easy to make and edit arrangements of nested bulleted lists using the indent and
outdent buttons.

Numbered Lists
You can create and edit numbered lists in just the same way as described for
bullet lists above, using the numbered list button.
You can choose the numbering scheme to be used for each list, using the NUMBERED
LIST section of the LIST PROPERTIES dialog. Place the text cursor in one of the numbered
list points, press the right mouse button and choose ‘LIST PROPERTIES… " from the context
menu. The dialog is modal, which means it will stay open as you make edits to your list
items and you can instantly see your changes as you make them.

Numbered list dialog
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In the dialog you can choose from a variety of numbering schemes and also enter the
value that should be used for the very first entry in the list. Then the number is
automatically incremented for the second and subsequent entries in the list.

Editing List items
If you want to make edits to the bullets or numbers themselves, perhaps a color, font size
or position change, the LIST ITEM section of the LIST PROPERTIES dialog lets you do this.
Place the text caret in one of the list points, press the right mouse button and choose
LIST PROPERTIES… from the context menu.

List properties dialog

Link to previous list of the same level
You can link separate lists so that the list item attributes of a second list continue from
the previous list at the same level. This allows you to insert gaps, graphics, paragraphs
etc. in the middle of lists. With numbered lists the numbering of the second list carries
from the last number used of the previous list.

Text Handling
The option also works with sub-lists, so when checked, the current list picks up its
settings from the previous list at the same level and of the same type. So set this option
on a bulleted sub-list and it will pick up the bullet symbol, margin, indent, color, etc.
settings from the previous sub-list of the same level.
Just place the text carat in the second list and check the
SAME LEVEL checkbox to link to the previous list.

LINK TO PREVIOUS LIST OF THE

A linked numbered list

Indent
The indent is the space between the numbers/bullets and the start of the list text. Use the
Indent controls to adjust this spacing for the list at the caret position.

Indent examples

Margin
The margin field controls the space to the left of the bullet/number. Use these controls to
adjust the horizontal offsets of sub-lists.

Margin examples
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Size
Adjust the font size of the bullet or number. Enter a value, use the dropdown menu or
use the slider that appears when you click the arrow to the right.

Color
Create a custom color for the bullet or number by clicking the Edit button to bring up the
color picker. (on page 193) Once you have opened the color editor in this way you can
also click on any of the colors on the color line, if you want to choose a standard color.
Use the dropdown to stick with the default color or pick out one of the current document's
named colors (on page 199) should it contain any.

Vertical offset
Move the bullets or numbers up or down relative to the text list. This is particularly useful
for bullet symbols because the vertical positions of these can vary, so depending on
which symbols you choose for your bullets you may need to adjust the position.

Replace with symbol
For bullet lists only - choose a replacement symbol from the Symbol picker (on page
215). Click to open the picker. If you choose any of the MATERIAL ICONS symbols, you will
probably need to adjust the vertical position of the symbol - see above.

Replace from clipboard
Designer Pro allows you to use any graphic for your bullets or numbers in lists. REPLACE
FROM CLIPBOARD performs the same function as the PASTE AS LIST BULLET operation in
the context menu. See the GRAPHICAL BULLETS AND NUMBERED LISTS section below, for
more info.

Reset to default list items
Revert to the default bullet/number settings.

Text Handling
Graphical Bullets and Numbered Lists
You can use any graphic or symbol for the bullet or number in a list. You can design your
own bullets and numbered lists by using any of the normal drawing or text tools, or use
one of the many bullet designs from the Online Content Catalog. Create a simple circle
using the ELLIPSE TOOL for example, give it a fill and copy it to the clipboard. Then
highlight the list you want to apply the style to using the TEXT TOOL . Right click the list
and choose PASTE AS LIST BULLET from the menu. The design will now appear as a bullet
for each of the list items.

For a numbered list it's exactly the same procedure except you select or group a text
item with your graphic and then select PASTE AS LIST NUMBER to replace all the numbers
or text items in your list. The text object in the group is used to show the number.
Both paste options are also available within the LIST PROPERTIES dialog (Right click the
list and choose the LIST PROPERTIES... option and select REPLACE FROM CLIPBOARD ).
(Note that you cannot currently use graphical bullets and numbers with List text styles
(on page 253) - you'll receive a warning prompt if you try)

Text Styles
are a powerful way to alter the appearance of text throughout a document
with a few clicks.
TEXT STYLES

A TEXT STYLE is a named collection of attributes, such as font, size, color, line spacing
and other text attributes. For example, the main heading at the top of this document
might have a style called ‘Heading 1’, whereas the smaller sub-headings could have a
style called ‘Heading 2’.
By updating the definition of ‘Heading 2’, say, to be a different font, then every similar
heading throughout the document will be updated instantly.
Similarly the main text, sometimes called the ‘body text’ of a document is also a particular
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style, which Designer Pro calls the "Normal text" style. By updating that style to be, say,
12 point Times New Roman, then all "Normal text" throughout the document can be
changed in one go, without having to select and apply the same font change over and
over again.
are, therefore, rather like the "Named Colors" feature that Designer Pro also
supports, where you can update "Theme Color 1" to be a new color and all parts of the
document using that Named Color take on the new color.
TEXT STYLES

Text Styles InfoBar
There is a Styles drop-down menu on the TEXT TOOL INFOBAR, that allows you to create
Styles, apply them to any text, and to update the definition of the Style.

By default there is a small set of pre-defined Styles, including ‘Normal text’, and three heading
styles - Heading 1,2,3.

Paragraph Styles and Character Styles
Text Styles come in two varieties. Paragraph Styles and Character Styles.
A Paragraph Style is denoted by a ¶ symbol on the style menu. An
Character Style.

A

symbol denotes a

Paragraph Styles apply to whole paragraphs, and are also typically used for headings.
It’s not possible to apply a Paragraph Style to a smaller section than a paragraph, so you
cannot, for example, apply a Paragraph Style to a single word within a paragraph. If you
try, then the whole surrounding paragraph will take on this Style.
Just place the text cursor anywhere on the line and select a Paragraph Style from the
style menu, and the whole paragraph will take on that style.

Text Handling
Character Styles, on the other hand, can be applied to any selection of text, from a single
character upwards. For example, if you wanted to highlight certain words in your text in a
different color a Character Style would be ideal. The advantage is that you can then
change the color (or font, etc) of all these highlighted words with a single Style update.
Create a Character Style by clicking CREATE STYLE in the Style menu dropdown and
checking the CHARACTER STYLE option from the dialog as you create a new text style.
See Creating new Styles (on page 255) for more info.
Paragraph styles can define all text attributes even bulleted/numbered list properties.
Character styles can only define text attributes that can be applied to individual
characters, such as text color, font size, font weight, etc.

List Styles
You can also apply Styles to bulleted and numbered lists. The style will take on all the
attributes of the bullet or numbered list. Once you have applied a style to a list a "."
appears in the Style menu to indicate that it is a List Style and to enable you to
distinguish it from a Paragraph or a Character style.

To make a list style, first create a list and customize it using the LIST PROPERTIES (on
page 248) dialog. Then place the text caret in the list, or select part of the list, and
choose CREATE STYLE … from the text styles dropdown list. Choose a name for your list
style and click ok.
List styles include all the list settings you see in the LIST PROPERTIES dialog, from indents
to bullet symbols and colors. Each level within a list can have different settings and these
are also all recorded in the list style. The example below has only 2 levels of list, but you
can have as many levels as you like.

To update a list style, simply modify a list that uses the style and then use the UPDATE
option in the styles list, the same way you update ordinary Paragraph styles. The list will
update whatever list level the text cursor is placed in - or all selected levels if you have
more than one level selected - with the UPDATE option reflecting your choice.
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Note: Graphical lists (where you can use any graphical object as the bullet or number)
are not yet supported with list styles.

Next paragraph style
This is one of the settings for a text style - look at the list's PROPERTIES… option in the
style menu.
For Paragraph styles it determines what style should be applied by default to a new
paragraph created following the current paragraph. For example, heading styles normally
set the NEXT PARAGRAPH style to NORMAL TEXT , because that’s usually what you want
immediately following a heading. With a list style however, it’s more likely that you want
another list item to be added when you hit return at the end of a list item. So for list styles
the NEXT PARAGRAPH setting is only used when you end a list. End a list by hitting return
once to add an empty list item, then hit return again. The new non-list paragraph will then
use whatever NEXT PARAGRAPH style you chose for the list style.
For more detail on editing lists see Bulleted and numbered lists (on page 246)

Updating Text Styles
To update an existing Text Style:

1.
2.
3.

Select some text already in the style you want to update.
Apply whatever changes you require, say an alternative font, or font size, or maybe
in the case of a list style a bullet or number style change.
"UPDATE 'STYLE NAME' TO MATCH"

For example to change all the NORMAL TEXT to be a different font, select a few words in
the NORMAL TEXT Style, change the font (and any other attribute) and then Select UPDATE
'NORMAL' TO MATCH from the Style Menu on the Text Tool InfoBar.
When you are working on a web document with RWD variants, it is possible to update a
Text Style for an individual variant. This is useful for example when you need the text in a
mobile variant to be a larger and/or different font. To update the style for an individual
variant, change the text as above and then select UPDATE 'STYLE NAME' IN THIS VARIANT
from the Style drop down menu on the Text InfoBar. This is an additional option that is
shown in the STYLES menu when you are working in a document that has multiple
variants.
See Responsive Web Design (on page 410) for more information about variants.

Redefining Text Styles
Sometimes you may want to make an existing text style to look like some text that does
not already have that text style applied. Perhaps some text that you imported from some
other document. You can’t just apply the existing style to that text, because you would
then lose its appearance. Instead use the UPDATE OTHER STYLE TO MATCH… option in the
style menu.

Text Handling
1.
2.
3.
4.

5.

Place the text cursor within the text (or select some of the text).
Select UPDATE OTHER STYLE TO MATCH... from the Style drop-down menu on the
Text InfoBar.
Choose the Style you wish to update from the UPDATE STYLE TO MATCH... dialog.
Tick the appropriate checkboxes to decide if you want the Text Style to match only
the new text, and/or all similar text in the document. Uncheck APPLY TO ALL SIMILAR
TEXT IN THIS DOCUMENT if you only want the Style to be applied to the paragraph
containing the text cursor.
APPLY.

The APPLY TO ALL SIMILAR TEXT IN THIS DOCUMENT option is useful for applying text styles
to existing documents that don’t already use text styles, such as imported PDFs. For a
style to be applied to all similar text within the document, the text must have the same
font and font size over more than 50% of a paragraph, and it must also have the same
justification and indentation settings (within a small tolerance).

Styles based on other styles
In Designer Pro, you can base one style upon another. For example, if you wanted
another variant of Heading 2 style, that was identical in every respect, except a different
color, then when you create the new style you would make it based on "Heading 2" in the
CREATE STYLE dialog. This means that if you update "Heading 2" to be, for example, a
new font or size, your new Style would also take on that new font or font size.
New Character Styles are typically based on the "Underlying Paragraph Style", but just
with the changes you want. So this means if you have a Character Style that just sets the
text color and nothing else, applied to a single word, then when you altered the
Paragraph Style of the paragraph, this word would change to match, except its color.

Creating new Styles
To create a completely new Style, change a selection of text to appear how you want and
then select the CREATE STYLE... option from the Style list drop-down on the TEXT TOOL
INFOBAR .
If you want to create a new Paragraph Style it’s recommended that you select and apply
your changes to a whole paragraph, before selecting the CREATE STYLE... menu option.
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Clicking CREATE STYLE... shows the following dialog...

This dialog shows a new style, (NewStyle2) being created that is a PARAGRAPH STYLE ,
based on an existing HEADING 2 style. The NEXT PARAGRAPH option determines what
style will be used for the subsequent paragraph when typing.

Text Handling
The OUTLINE LEVEL is used to set the outline level of a heading style when inserting a
table of contents (on page 232). The level determines the indentation level in the table
and you can specify the maximum level of heading that should be included in the table.
For example you might want to only include levels 1 and 2 (Heading 1 and Heading 2), to
keep the size of the table down.
The lower section of the dialog shows the complete definition of this Style. In this case
you can see it’s based on Heading 2, with only a color change.
To create a Style that is based on no other Style, that is to say, it inherits no attributes
from another style, select (NO STYLE) from the BASED ON: option, as below.

This dialog shows the creation of a NewStyle2, that is a Paragraph Style and based on
no other style. The lower section lists all the attributes that make up this Style. The
attributes listed have been taken from selected text, so this Style consists of a complete
definition, listing all possible text attributes.
In this case when entering text in this Style, the
pressed) will be in the same style again.

NEXT PARAGRAPH

(i.e. when Return is

Removing Styles
The STYLES list in the STYLES menu includes the entry NO STYLE . Selecting this removes
the Style (Paragraph and/or Character Style) from the selection whilst retaining the same
appearance. When you select the option a dialog appears informing you of this. Click on
the dialog's CLEAR STYLES button to proceed with the operation. Now your selected text
looks exactly the same as before, but has NO STYLE applied to it.
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Deleting Styles
To delete a style select DELETE STYLE from the STYLES menu, the DELETE STYLE dialog
opens. Now choose the text style you wish to delete from the dropdown menu in the
dialog. The style will be deleted from the menu as will all references to the style, and the
style will be returned to its base style. However, the returned style will still retain the
deleted style's attributes and appearance. So for example a deleted style based on
HEADING 1 WILL appear as HEADING 1+ to indicate this.
If your style was based on nothing, ie NO STYLE then the style will revert to No style
appearing as NO STYLE + in the menu and again retaining the same attributes and
appearance.
Note that you can't delete the default styles and you also can't delete styles which have
other styles based on them. You will receive a warning prompt should you attempt to do
so.

Hidden Styles
Text styles can be marked as HIDDEN in the STYLE PROPERTIES dialog, which means they
won’t appear in the main styles list unless the text caret is located in text that uses that
style.
This is useful to help avoid the styles list becoming too long in documents that use a lot
of different styles. Some SmartShapes such as the bar and column charts have their own
text styles and these are now automatically made hidden styles, so they don’t appear in
the main styles list. Similarly the TOC styles used for Tables of Contents are also hidden.
Use the SHOW HIDDEN STYLES option in the styles menu to have all styles included in the
styles list.
Additionally hidden styles can’t become current, so any new text you add to a design
should never use a hidden style by default.

Style Properties
If you want to change the definition of a style, such as the style it’s based on, or just look
at its definition, use the PROPERTIES… option in the style menu. You need to select some
text that has the style applied before you do this, to indicate the style you want to edit.
The STYLE PROPERTIES dialog appears, which looks the same as the CREATE STYLE
dialog shown above.
The style description at the bottom of the dialog describes how the style differs from the
style on which it is based. So if you want to see all of the style’s attributes, just
temporarily select NO STYLE from the BASED ON list, to see a full description. Don’t forget
to reset this to the correct BASED ON style, or click cancel in this dialog, if you don’t want
to change the style!

Text Handling
Applying text attributes
Changing the font size
There are several ways to change the font size:






Type a new value into the size text box on the InfoBar and press .
Or select from the FONT SIZE drop-down list on the InfoBar.
Or use the Font size pop-up slider (on page 213).
Or manually increase/decrease font size with the "Ctrl + Shift + >" and "Ctrl + Shift + <"
keyboard shortcuts. This applies only if all selected text parts are of the same font
size.
 Or use the SELECTORTOOL to scale the whole text object.

Bold & Italic
Click the BOLD or ITALIC button on the InfoBar ("Ctrl + B" or "Ctrl + I")

This applies the bold or italic variant of the current font.

Text Underlining
Click the underline button on the InfoBar to apply an underline to the selected
text.
The underline color and size is automatically derived from the text color and size.
Underlining links
When you add a web address URL to some text, see the Web address dialog. You can
decide to automatically underline all links. This is a check box option on the web address
dialog ("Ctrl + Shift + W"). If you select this all linked text throughout the document is
underlined, and the underline command does not affect this.
If you apply a URL to a group that contains some text, then the text will not be
underlined.

Text Strikethrough
Click the strikethrough button on the InfoBar to apply a strikethrough to the
selected text.
The strikethrough color and size is automatically derived from the text color and size.

Highlighting text
To apply a text background color - in effect a highlighter-style background color...
 Highlight some text using the

TEXT TOOL
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 Right-click on a color in the COLOR LINE
 Select SET TEXT BACKGROUND from the menu
See Applying a Text Background color (on page 192) for more details.

Justification or text alignment
Justification always applies to the complete line. Any selected region is ignored.

justification: Align the left-hand edge of the text to the initial click position.
justification: Centers the text around the click position.
RIGHT justification: Align the right-hand edge of the text to the initial click position.
FULL justification: This only applies when text is along a curve or in a column and
when there is at least one full line of text to justify.
LEFT

CENTER

When using simple text the initial click position on the page is taken as the origin for text
justification.

Ligatures

A ligature is a connection between two or more characters to improve legibility or for a
stylistic flourish. The linked sequences of characters then appear as a single glyph.
Ligatures, where they exist, are contained within the font file and can be displayed
according to the settings on the OPEN TYPE LIGATURES button on the InfoBar. The ligature
settings can be used in text styles just like other text attributes.

Ligatures: L to R, Standard, Discretionary and Historical

Text Handling
The various options are...
STANDARD
DISCRETIONARY
HISTORICAL
SELECT ALL
CLEAR ALL

Only the default set of ligatures provided by the font designer will be
displayed.
The discretionary ligatures are decorative - to be applied at the
discretion of the user.
Historical ligatures are mainly ornamental suggesting a historical
context.
All available ligatures for a particular font will be displayed.
No ligatures will be displayed.

You can choose which groups to turn on or off independently for any range of characters.
Select a character range in the Text Tool and then click on the Ligatures button.
There is a further option, STYLISTIC SETS - some fonts include alternative sets of ligature
characters that the user can choose from, allowing more flexibility. If any sets are
available for any of the characters in the current text selection, they are listed under the
STYLISTIC SETS sub-menu, where they can be turned on and off independently.

Gabriola (left) and with stylistic set applied (right)

Subscript & superscript
Click the appropriate button on the InfoBar.
Normal text

superscript
subscript

Adding page numbers
To quickly add page numbers into your document - use the INSERT menu to select PAGE
NUMBER and choose a number format and a page position from the INSERT PAGE NUMBER
dialog. They will appear as Repeating Objects (on page 106) throughout your document.
By default the first page of your document will be 1, but if you have pages which you
don't want numbered at the start of the document, like contents or acknowledgments
pages, then you can get round this by giving the first page a - (minus) value. So if you
have three pages of content that you don't want numbered, enter -2 into the FIRST PAGE
IS: field, and then the pages you want to be numbered will start at 1. The sequence will
be...
-2, -1, 0, 1 etc.
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Then delete the minus and zero page numbers from your document. If using numeral
values the - (minus) number will be replaced by a #.

Insert page number dialog

If you want to be more precise use the TEXT TOOL to click in your document page at the
place you want the page number to appear. Right click and select INSERT. Then select
one of the available number formats from the dialog box.
If you use this method you will need to make the page number a repeating object for a
page number to appear on every page of your document. After inserting the page
number on one page, select it using the SELECTOR TOOL and then select "ARRANGE" >
"REPEATING OBJECT" > "REPEAT ON ALL PAGES" , to place it in the same position on all
pages. As you add pages to your document the page numbers will update incrementally.
You can still delete the number from some pages if you don’t want the number to appear
on every page.
If you move or change the style of the number on one page then those changes will be
applied to all pages automatically.

Line spacing
Line spacing allows you to change the space between two lines
(so affects vertical spacing).
Line spacing is measured in percentages (120%) or points (12pt). You can either type
the line space value in the text box or click the arrows to nudge the values.
A percentage setting has the benefit of scaling accordingly if you change your font size. If
a percentage is applied to a line of text with more than one font size, the largest font size
is used. For example, if a line contains 90% and 100% text, the line spacing is calculated
on 100%.

Text Handling
Indents and Outdents
Indent a paragraph of text.

Outdent a paragraph of text.

Paragraph Spacing
The last two fields on the end of the TEXT TOOL InfoBar allow you to set
the spacing above and/or below paragraphs.
This is particularly useful where you want half line spaces between paragraphs.
Like Microsoft Word, when you use both spacing above and below paragraphs, the
spacing between paragraphs is whichever is the greater value (it's not
cumulative). Paragraph spacing above paragraphs will move the first paragraph down in
a frame of text.

Keep With Next Paragraph

On the Advanced text bar - this paragraph option is typically used to prevent the heading
preceding a paragraph appearing right at the bottom of a page, with the first line of the
following paragraph text appearing at the top of the next page. When this option is
switched on for a heading, the heading will flow to the next page/column if there is not
enough space for at least one line of text following it.
The option is on by default in the heading styles of all the blank print templates (under
"FILE" > "NEW" ), so you don’t need to turn it on for new blank documents you create.
Whenever you have a print document with text flowing from one page to another, you will
normally benefit from having this option turned on for all your heading styles. To update
an existing document to use the feature, first select a heading and turn the option on.
Then update the heading style for that heading, using the update style option in the Text
Styles (on page 251) menu. Do the same for each different heading style you use, to
make sure you are never left with a heading on its own at the bottom of a page.

Keep Lines Together

On the Advanced text bar - this paragraph option prevents a paragraph from being split
across a page or column boundary. For example if you have an important 2 line
paragraph such as a long heading, you wouldn’t normally want the second line of text to
flow to the next page, leaving the first line at the bottom of the previous page. Turning
this option on makes sure that the 2 lines will always stay together.
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As with KEEP WITH NEXT PARAGRAPH , this option is on by default in the heading styles of
all the blank print templates. Update the heading styles in your existing documents in the
same way as described for KEEP WITH NEXT PARAGRAPH , above.

Baseline shift
On the Advanced text bar - Baseline shift allows you to move part of
a line up or down. Positive values move the text upwards, negative
downwards.
The baseline is the imaginary line at the bottom of characters.
Select the characters for which you wish to change the baseline shift then enter a value
in the BASELINE SHIFT text box.

The effect of selecting D-H and then applying an upwards baseline shift (i.e. 5pt).

Baseline shift is measured in points but you can use any of Designer Pro’s standard
measurement units. Note that baseline shift is an absolute value, in points, and does not
change if you change the font size.

Tracking
Whereas kerning (see below) changes the spacing between two characters, tracking (on
the Advanced text bar) changes the spacing equally within a region of text. An EM is the
width of the capital letter "M" in the current font and font size. It is therefore relative to the
font size and not a fixed value.

1.
2.

Select the region to which you want to apply tracking.
TRACKING

From the keyboard you can increase or decrease the tracking by pressing "Alt + Right
arrow", or "Alt + Left arrow". Each key press changes the tracking by 10/1000.

Kerning
On the Advanced text Bar - Kerning lets you alter the space between
two characters (so affects horizontal spacing).
Most good fonts have auto-kerning which means they already move appropriate pairs of
characters together slightly, as you can see from this diagram:

Text Handling
Auto-kerning off

Auto-kerning on

Manual kerning

Kerning is measured in "ems" (enter values in 1/1000ths of "ems".) You can either type
the kerning value in the text box, or click the arrows to nudge the values.
It shares the same key shortcuts as above. If there is just a cursor, it alters the kerning,
but if there’s a selected range of text, then it alters the tracking. Each key press alters it
by 10/1000ths of a em.

Condensing and expanding characters (aspect ratio)
The aspect ratio (on the Advanced Text Bar) is the ratio between the height and width of
the text. Ratios over 100% make the text wider than normal; under 100% make the text
narrower.
To change the aspect ratio:
Type a new value into the ASPECT text box on the InfoBar and press "".

Or use the SELECTOR Tool to stretch or squash the complete line of text.
It is not recommended to use values below 80% or above 130%. Better to use a special
condensed variant of the font family if available. Alternatively use the tracking control to
adjust the spacing without distorting the actual shapes of the characters.
IMPORTANT: When creating websites, avoid changing text aspect ratio or tracking
because these changes will not be reflected in the text of your website.

Advanced text properties
Right click on a text object and select "ADVANCED TEXT PROPERTIES… " to bring up the
Advanced text properties dialog.

Here you can turn off auto-kerning on the selected text object if desired. See the kerning
section above for information on kerning.
You can also specify that the selected text should be converted to shapes before being
sent to the printer, which is useful if there are any problems printing with the font used.
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Text links
You can apply a link to any part of a text object, so that when the document is exported
as HTML the text shows as a clickable link in web browsers.
Use the TEXT TOOL to select the words or characters that you want to apply the
link to, then click the link button on the WEB toolbar.
This brings up the WEB PROPERTIES dialog, with the LINK tab selected. On this tab you
can choose whether to link to a URL, to another page of your website, or even to a
heading or a pop-up layer.
By default when you apply a link to some text, the text is shown as underlined and with
the text link color that is defined for the current document. You can change the link color
and whether or not the links are underlined, on the WEBSITE tab of the WEB PROPERTIES
(on page 445) dialog (right click and choose WEB PROPERTIES or choose WEB
PROPERTIES from the UTILITIES menu). You can also set the color to be shown when the
user moves the mouse pointer over a text link in a web browser (“Mouse Over Color”),
and the “Visited Color” which is used to display links which the viewer has already visited
with their web browser.

Text inside groups for websites
When a document is exported as a website, all groups get exported as images. So any
text inside groups can’t be selected and copied as text by a visitor to your site.
For graphical buttons, headings, logos etc. this is usually desirable as the text just forms
part of the graphic. But you may have more substantial pieces of text inside groups which
you want to remain as text in your exported web page. To arrange this, all you need to do
is apply the special name “HTMLText” to your text object. The easiest way to do this is as
follows:

1.
2.
3.
4.

Go into the TEXT TOOL and click on your text to insert the text cursor.
Press escape so that the whole text object becomes selected.
Open the Name dialog ("UTILITIES" > "NAMES..." ).
HTMLTEXT

APPLY NAME

“ADD”

Now, when you export your website, your text will remain as text and the rest of the
group will be converted to an image. All the text panels provided in the ONLINE CONTENT
CATALOG already have this name applied to the text objects inside them, so the text on
the panels will export as text.
Browsers can’t render rotated text, so you can’t use this name to force rotated text to be
exported as text. The name is ignored in this case.

Text Handling
Copying text appearances
It’s easy to copy the style of any text to any other region of text using the
FORMAT/ATTRIBUTES feature:

PASTE

 Select the source region from where you want to copy the style. This can be as little as
a word (just double click).
 Select "EDIT" > "COPY " ("Ctrl + C").
 Select the region of text to which you want to apply the style.
 Select "EDIT" > "PASTE FORMAT/ATTRIBUTES " ("Ctrl +  + A").
If you just have the text cursor positioned in some text when you PASTE
FORMAT/ATTRIBUTES the paragraph attributes will be pasted to this paragraph.
If you have a region of text selected, then PASTE FORMAT/ATTRIBUTES will paste all the
visual attributes of the source text.

Applying attributes to whole text stories
When you have the cursor in a simple or column text object, pressing "Esc" will select the
whole text object. You can then apply an attribute, say a color, and the whole text object
is altered. This is often quicker than performing "Select all" ("Ctrl + A").
With text areas this method only works if all text areas of the story are selected. You can
do this in the SELECTOR TOOL clicking and "Shift + clicking" on the different text areas to
select them. But this method is only possible if the text areas are on a single page. If your
text story flows over several pages and you want to change all the text, then it’s
necessary to "Select all" ("Ctrl + A"), and then apply the required attributes.

Copying/Pasting formatted text (RTF)
You can copy "rich text" (as it's sometimes known) from other applications such as word
processors or editors and paste into Xara Designer Pro X as text, and the fonts, margins,
line spacing and text links will be preserved. This makes it dramatically easier to retain
the style and appearance of your text.
When you paste "Rich Text Format" (RTF) from other applications you are given the
choice of pasting the text in as "Unformatted text" which means it will appear in the font
and style at the cursor where you paste, or "Rich Text Format", i.e. it will retain the style
of the source text.
This also works the other way around. You can copy text in Designer Pro and paste into
other applications that support rich text editing and the style (font, size, colors, margins
etc) will be retained. This will only work if you select and copy a single text object or from
a single text flow.
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Changing text into editable shapes
You may want to convert some text into editable character outlines for further
manipulation or if you wish to give the document to someone who does not have the
fonts used in your document.
To do this:

1.
2.
3.

Change to the SELECTOR TOOL.
Select the text.

This converts the individual characters into a series of straight and curved lines. To
manipulate individual characters, select the text then select "ARRANGE -> UNGROUP " (Ctrl
+ U) twice. All characters will then be separate objects.
Note: you cannot edit the text with the TEXT TOOL after you have converted it, so make
sure the text is correct before you convert it.

The Fonts Gallery
The FONTS GALLERY serves a number of useful purposes:
 It’s an easy way to preview the style of all fonts on your system.
 It lists all the fonts included on the Xara Designer Pro X CD (whether or not they are
installed).
 You can install fonts from the CD (or hard disk), or un-install fonts
 You can apply fonts by drag-and-drop
To display the FONTS GALLERY click its tab in the galleries bar to the right of the
Designer Pro window. Or you can toggle display of the FONTS GALLERY by
choosing UTILITIES > GALLERIES > FONTS GALLERY or pressing "Shift + F9".

Text Handling

The fonts are grouped into several categories:
 At the top are fonts installed on the computer (i.e. all the fonts in your Windows/Fonts
folder).
 Next are all fonts (installed or available on the Designer Pro CD) grouped by
appearance (for example: script, decorative, sans serif)
 Last is a complete alphabetical list of all fonts, installed or ready to install.
The Document handling (on page 60) chapter has general information about galleries.

Applying a font from the Fonts Gallery
This is an alternative to using the

TEXT

Tool INFOBAR . You can either:

 Select the font in the gallery and click APPLY to apply to the selected text object, or
double click a font
 Or drag & drop the font name onto any text (selected or not). The pointer changes
shape when in position.
If you apply a font that is not installed it asks if you want the font installed.
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Installing or uninstalling a font
The first part of the gallery shows fonts already installed. Remaining sections show fonts
on the CD (either from the CD or from the hard disc made at install time).

1.
2.

Click on a font name to select it. You can select additional fonts by either "+
clicking" to select a group or "Ctrl + clicking" to add an individual font to the
selection.
INSTALL

UNINSTALL

You can also click GET FONTS to download a selection of fonts, but this is only useful if
you haven’t installed the fonts from the Designer Pro CD.
Fonts from other suppliers can also be installed using the Windows Control Panel
(described in the Windows Help and Support section of Windows).
Note that to install fonts from the Font Gallery Xara Designer Pro X must be running with
Administrator privileges.

Fonts and PDF
When you create a PDF ("FILE -> EXPORT… "), you get the option to embed fonts into the
PDF file. Font embedding ensures that anyone who receives the PDF can view and print
the document with the correct font, but it does make the PDF files larger.

PDF Export options

This is only possible for those fonts that are marked by their creators as having
permission for embedding. You are warned if it’s not possible to embed fonts.

Text Handling
Document Font embedding
Xara Designer Pro X stores the character shapes of all the fonts used in your document.
This means if you give someone else your design file, or transfer the file to another
computer, the text will still look exactly right, even if the correct fonts are not installed on
that computer.

Website font embedding
Most website documents use only ‘web safe fonts’, which are fonts that the vast majority
of computers and other devices will have installed and so which can be safely used on
any website. However you can use just about any font on a website providing the font
permissions allow it, and Designer Pro can automatically publish the font with your site in
a way that means text using that font will appear correct to everyone viewing it, whether
or not they already have that font installed.
To help your website load faster, only Western characters are included in the embedded
font, unless your document uses other characters also.
When you export or preview a website document that uses fonts that aren’t web safe,
Designer Pro will show you a warning, listing those fonts that will be embedded in your
website. This helps to remind you that your site includes embedded fonts. You can also
see which fonts a document is using, together with its permissions by viewing "FILE" >
"DOCUMENT INFO..." See Font permissions (on page 271) for more info.
Some fonts do not permit embedding in a document or website. Designer Pro detects
such fonts and will show you a separate alert if you attempt to use any such fonts in your
website document. You should change to a different font that is either web safe, a
Google font or a font that does permit embedding.

Font permissions
When embedding fonts there are four levels of font permissions, that is to say four levels
of usability depending on how the font has been licensed. The four levels are...

1.
2.
3.
4.

Installable - the most permissive level. Allows the font to be embedded in the
document and installed permanently on the guest computer.
Editable - Allows the font to be embedded in the document but only allows it to be
used temporarily on the system.
Print and Preview - Allows the font to be embedded in the document but only for
printing and preview purposes.
Restricted
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Apart from the warnings Designer Pro shows you listing those fonts that will be
embedded in your website, it is also possible to view their permissions levels by looking
at the DOCUMENT INFO . Go to "FILE" > "DOCUMENT INFO" .

Fills

Fills
The Fill Tool
Creating a graduated color fill
The process of creating a different fill is almost identical for all the fill types:

1.
2.
3.
4.

Select the object or objects to which you want to apply the fill.
Select the FILL Tool ("G").
Select the fill type from the dropdown menu.

Xara Designer Pro X provides a smooth interactive live preview of the fill as you drag.
As you drag a fill arrow is created indicating the direction of
the fill. Fill handles can be selected and dragged to adjust
the position and angle of the fill.

Coloring fills
Select one of the fill handles and click a color on the COLOR LINE or bring up the COLOR
EDITOR and choose a new color. You can press "Tab" to alternate between the fill
handles.

Fill Tool InfoBar

Fill type
Fill tiling
Fill effect
Bitmap name
Profile
Fill handle/resolution
Handle color/Grain
FILL TYPE

selects the type of fill. Selecting from this menu:
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 with a selected object, applies the fill to the object;
 without a selected object, sets the current fill type which will then be used for newly
drawn objects.
is used when applying bitmap and fractal fills. The options are described later
in bitmap fills. Fill tiling changes the repetition of the fill effect. The options are:
FILL TILING

 Simple-the fill is used only once, regardless of the size of the object.
 Repeating/repeating tile-repeats the effect so that it fills the entire object.
 Repeating tile inverted-only available on fractal and bitmap fills. This is similar to
repeating tile, but every other tile is inverted.
Fill tiling options are not available for
conical. All other fill types can be made
to repeat. This can produce some
useful effects.

A repeating elliptical fill inside an ellipse shape

is used for all fill types, except 3 and 4-color fills. It controls how the fill colors
fade from the start color to the end color:
FILL EFFECT




FADE :

Fades between the two colors in a linear fashion
Blends along the shortest edge of the HSV color wheel. For example, a
blend from yellow to cyan runs yellow-green-cyan.
RAINBOW:

This option has no effect when the two colors are black, white or gray.


ALT RAINBOW :

Similar to rainbow except the blend is along the longest edge of the
color wheel. For example, yellow to cyan runs yellow-red-magenta-blue-cyan.

BITMAP NAME

displays a pop-down menu showing thumbnails of all the bitmaps in the
and is an easy way to select the required bitmap for a bitmap fill.

BITMAP GALLERY

you can change the rate of the color transition between the start and end
of fills. This applies to all fill types except flat, three color, four color and bitmap (unless
it's a contone colored bitmap).
FILL PROFILE -

To change the profile of a fill:

1.
2.
3.

Select the filled object.
On the FILL Tool InfoBar click PROFILE . This opens the PROFILE dialog box.

Fills

Three different black-to-white graduated color fills and their corresponding profile dialogs. The
center, default, is a linear black-to-white transition.
FILL HANDLE :

Indicates if the start or end handle is selected. This field is blank for flat fills.

(bitmap and fractal fills only) Shows the resolution of the bitmap (as long as
you don't have a fill handle selected). You can type in a new resolution to change the
size of the bitmap. Low resolutions show the individual pixels of the bitmap. You rarely
need a resolution greater than 150 DPI, even for typeset output.
RESOLUTION

FILL HANDLE COLOR:

(except bitmap fills) Indicates the color applied to the selected fill

handle.

Changing the colors in a fill
To change a color in a fill:
 Drag & drop the color from the COLOR LINE onto a fill handle (you do not have to select
the handle first.)
 Or, drag & drop the color onto the object. Each fill has an imaginary center line halfway
along the fill arrow. Dropping the color on the start handle side changes the start
handle color, and the end handle side changes the end handle.
 Or, if one of the end handles is selected (it's shown highlighted) just click on a color.
You can press "Tab" to select the other fill handle, and click the color required for the
other end
The Color Line is described in Color handling (on page 189).
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Each method changes the color of one handle only; they do not change any other
selected fill handles, or:

1.
2.
3.

Select the required handle (or handles, also works with multiple objects).
Choose the required color from the Color Line.

Moving the start or end handle of the fill
To change the direction and extent of the fill:

1.

Move the pointer over the handle you want to move. When over the
handle, the pointer changes shape.

2.

Bitmap fills

Fill Type
Fill Tiling
Not used
Bitmap name
Resolution
Not used
The BITMAP GALLERY is described in THE BITMAP GALLERY (on page 331) in the Photo
Handling chapter, for the FILL GALLERY see below (on page 280).
Bitmap fills are one of the most powerful fill types. It allows any photo or texture to be
used as a fill for any shape and you have direct immediate control over the size, angle,
position and tiling. You can color bitmap fills. You can use any type of bitmap as a fill,
including JPEG photos, and alpha-channel (semi-transparent) bitmaps.
When you import a photo file into Xara Designer Pro X (eg. a JPG or PNG file) it appears
as a shape with a bitmap fill type. When such an object is selected the status line shows
it as a “photo”, but it is just the same as a shape that has had the photo applied as a
bitmap fill.
To fill a shape with a bitmap or photo fill, do one of the following:
 Drag any bitmap from the BITMAP GALLERY or from your Windows File Explorer over
any shape, hold "Shift" and drop, or
 Drag any fill from the FILL GALLERY onto the shape (there is no need to hold "Shift" to
drop in this case)

Fills
 Select 'Bitmap' from the left side drop down menu of the FILL TOOLINFOBAR , and then
select the required bitmap from the dropdown menu of bitmap names (this only shows
bitmaps that are or have been previously loaded).
You can fill an object with single or multiple tiles (repetitions of the bitmap image).

Single tile (photo)

Repeating tile

Repeat inverted-the tiles fit together
perfectly.

The fill has three handles. Use it for Resizing and re-positioning bitmap fills. An
alternative way to set the size of the bitmap is to type in a resolution into the InfoBar field.
You first have to un-select the fill handle by clicking anywhere on the image away from a
fill handle, then just type a new dpi resolution.

Replacing Bitmap Fills
If a shape already contains a bitmap, or is a photo, then you can just drag and drop a
new bitmap from any source, such as Windows Explorer, and it will replace the existing
bitmap. The new image is ‘best fitted’ into the shape so that it just fits in. By default,
doing this will also replace all other instances of that photo on the current page, if they
are in the same soft group.
Holding down SHIFT while replacing a photo in this way causes the position, scale and
rotation of the bitmap fill to be preserved.

Bitmap coloring
You can color any bitmap or photo fill by just clicking on a color on the COLOR LINE (make
sure no fill handles are selected, by just clicking on the image). This will create a
Contone (technically a Duotone) which uses colors between black and the selected color.
Alternatively right click on the object and choose CONTONE > SET LIGHT COLOR or
CONTONE > MAKE BLACK AND WHITE . You can also right click the color line and select
either the 'SET CONTONE LIGHT COLOR ' or 'SET CONTONE DARK COLOR '.
So, for example, to make a picture black and white, just requires you to click on the
White color patch on the color line.
To cancel any applied color, apply NO COLOR to either fill
handle. This restores the bitmap to its original bitmap colors.
The RESOLUTION box on the INFOBAR shows the resolution, which can be altered by
moving the fill handles or typing in a value.
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Resizing and re-positioning bitmap fills
If you hold down Shift and click and drag on a shape which already has a bitmap fill, a
new bitmap fill is created centered on the click point. If you hold the "Ctrl" key down too, it
limits the angle, so this makes it easy to create an upright bitmap fill.
Once the fill has been created, you can drag
anywhere on the image to re-position the fill inside
the shape.

When you mouse over the outer fill handles the
mouse pointer changes into a “rotate” mouse pointer.
Dragging on these handles will stretch and rotate the
bitmap fill with the current aspect ratio locked; hold
down "Shift" while dragging to change the horizontal
and vertical size independently and to skew the fill.
The InfoBar shows you the resolution of the bitmap fill
(you can adjust this, and thus the bitmap size, by
entering a new value).

Fractal fills
Xara Designer Pro X supports two types of fractal fill which are mathematically created
naturalistic fill patterns. They are great for simulating sky and clouds or other natural
textures.
Each time you create a new fractal fill a new pattern is created. To replace an existing
fractal with a new pattern choose fractal from the fill menu again.
The GRAIN control on the INFOBAR
provides control over the graininess of
the pattern. Low values give a smooth
flowing pattern, and high values give a
grainy pattern.

Fills
You can adjust the size and position of the fractal fill in the usual way by dragging and
adjusting the fill handles. De-select the fill handles (click on the fill away from a handle) to
show the above resolution and grain controls.

Fractal clouds fill. On the left a grain of 1, on the right a grain of 50.

Fractal plasma fill. On the left a grain of 5, on the right a grain of 50.

Note the difference between grain and resolution. Grain controls the flow of the pattern.
Resolution sets the size of the fractal bitmap and how noticeable the individual pixels are.
You can change the start and end colors of a fractal fill. Select the center or outer
handles and then apply a color using either the Color Line or COLOR GALLERY . To cancel
any applied color, apply no color.

Multi-stage color graduations
Many of the graduated color fill types support multi-stage graduation fills, which means
instead of just fading from one color to another, you can go through a number of different
color fill stages.

To add a new color stage to a graduation, select the Fill Tool so the fill arrow shows and
then:
 Either drag a color onto the fill arrow where required.
 Or double click on the fill arrow to create a new fill handle, and now click a color or
display the COLOR EDITOR .
You can re-position the fill handles by dragging.
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With one fill handle selected pressing "Tab" will select the next. If the
open, this is updated to reflect the new fill handle

COLOR EDITOR

is

To remove a fill stage handle, just click on it to select, and press "Del".

The Fill Gallery
The FILL GALLERY contains bitmap textures suitable for use as bitmap fills. Only when
you use a fill is it copied into the document.
To display the FILL GALLERY :
To display the FILL GALLERY click its tab in the galleries bar to the right of the
Designer Pro window. Or you can toggle display of the FILL GALLERY by
choosing UTILITIES > GALLERIES > FILL GALLERY or pressing "Shift + F11".

Fills

- imports the selected bitmap into the document. A copy of the bitmap then
appears in the BITMAP GALLERY . You can also drag-and-drop the bitmap onto a blank
part of the page. This is usually easier than clicking IMPORT .
IMPORT

FILL

- imports and applies the selected bitmap as:

 A bitmap fill to the selected object (if any).
 Or, if no objects are selected, it inserts the bitmap into the document as a new photo
object.
You can also drag-and-drop the bitmap onto an object to apply a bitmap fill.
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There are some differences between either dragging a bitmap from the BITMAP or FILL
GALLERY: When dragging bitmaps from the FILL GALLERY and dropping on shapes to
create a bitmap fill, the fill will be tiled and the bitmap won’t be best-fitted into the shape.
This different behavior to that seen when dragging from the BITMAP GALLERY is because
normally textures are applied from the Fill Gallery and these should normally be tiled and
not best-fitted.
TRANSP

- (transparency) imports and applies the selected bitmap as:

 A transparent bitmap to the selected object (if any).
 Or sets the current transparency attribute.
GET FILLS

- download free fills from Xara.

BACKGROUND
REMOVE

- set the selected fill as the page background.

- delete the selected fill or folder.

DISC FILLS

- add new fills from your hard drive or a CD.

- lets you select the size of the preview icons and whether full information about
the bitmap is shown, as well as find and sort the fills.
MORE

- if you have a slow connection and find getting fills from the Internet
too slow, you can stop downloading them and then resume later.
STOP DOWNLOADING

Find & Sort are described in the Document handling (on page 60) chapter.
Document handling (on page 60) includes general information about galleries.

Transparency

Transparency
Introduction
The TRANSPARENCY Tool lets you specify how much of the underlying colors
and objects appears through an object.

Shape
Transparency type
Tiling
Bitmap name
Profile
Handle/Resolution
Amount of transparency
You have control over the level of transparency from fully opaque to fully transparent.
Designer Pro goes further than other drawing packages by offering a wide range of
different graduated transparencies.
You can apply flat and graduated transparency to all types of objects including bitmaps.
Some uses of transparency:
 Simulating water or glass.
 Anywhere you want objects to fade to parts of objects to fade or blend with the
background. Clouds or mist-fractal transparencies are particularly good for this.
 Using the special type of transparency you can lighten, darken and apply special
effects to objects and photos.

283

284

Transparency
 Creating highlights and reflections.

The windshield is created with multiple overlaid objects with different transparency. T he
reflection is 100% opaque white in the center fading in an elliptical fashion.

Applying flat transparency
It's called "flat" transparency because all parts of the objects have the same
transparency, as opposed to graduated transparency.

1.
2.
3.

Select the object or objects
Select the Transparency Tool ("F6")

Xara Designer Pro X provides live-preview. As you drag the transparency slider the
objects on the document are changed so you can see the effect immediately.

Applying graduated transparency
Graduated transparency works in a very similar way to graduated color fills. You just drag
on the objects in the Transparency Tool to create a fading transparency. You have a very
similar range of transparency shapes, the simplest being linear, but you can also have
circular, elliptical, conical, fractal and bitmap transparencies, and others. To create a
graduated fade:

1.
2.

Select the object or objects
In the TRANSPARENCY TOOL , drag across the objects to create a linear fade across
the object.

3.
You can select and adjust the position and transparency strength using the "fill" handles
shown on the object.

Transparency
Refer to Fills (on page 273) for more information on manipulating fill handles and the
different fill shapes (in this case transparency shapes)

Multi-stage graduated transparency
Just as you can add multiple stages to a graduated fill, you can do the same with a
graduated transparency. This allows you to fade, for example, from opaque to 50%
transparent then back up to 25% transparent, back to opaque, etc.
You can set the level of transparency at each stage, by selecting a handle and then
adjusting the transparency slider. Add additional stages by double-clicking on the
graduated transparency line then adjusting the slider.
See the Fills chapter (on page 273) for more information on manipulating the handles.

Transparency types
Designer Pro supports the main types of W3C transparency used by many other
applications and include the following types:
Normal (Mix)
The color of the object mixes with the color of underlying objects. The effect is similar to
spraying a thin coat of color (or paint) over underlying objects.
Multiply (Stained glass)
The effect is similar to viewing underlying objects through colored glass. It is useful for
the simulation of glass and selectively darkening objects. The colors of objects with
Multiply applied are:
 White - no effect on the colors of underlying objects.
 Gray & Black - darkens the colors of underlying objects.
 Other colors - darken underlying colors towards saturated color (light red over light red
results in mid-red: green over red results in black).
Technically the process is subtractive in RGB color space.
Screen (Bleach)
Screen has no clear analogy in the physical world. It is useful for highlights when the light
source is not white. The color of the object with Screen applied:
 Gray & White - lightens the colors in underlying objects.
 Black - no effect on the colors of underlying objects.
 Other colors - lighten underlying colors towards unsaturated color. (Light-red over
light-red gives a pale-red: green over red gives yellow.)
Technically the process is additive in RGB color space.
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Transparency
Overlay
Overlay is a combination of Screen and Multiply and generally used to boost the contrast
in an image. The areas of the top object where the underlying objects are light becomes
lighter and the areas of the top object where the underlying objects are dark becomes
darker.
 Gray (darker than 50% gray) will darken and add contrast to the underlying image.
 Gray (lighter than 50% gray) will lighten and add contrast to the underlying image.
 Other colors - lightens and adds contrast to unsaturated colors and darkens and adds
contrast to saturated colors.
Hard Light
The same as Overlay, but with the base and overlying objects swapped.
 White - no effect on the colors in underlying objects, the whites remain completely
white.
 Black - no effect on the colors in underlying objects, the blacks remain completely
black.
Soft Light
This is a less extreme version of Hard Light. Again works similarly to Overlay although in
a softer and less harsh way than Hard Light.
Luminosity
Luminosity affects the "lightness" of the image. It blends the lightness values of the top
objects with the lightness values of the underlying objects, whilst ignoring the color
values.
Color
Color is a combination of hue and saturation. Almost the opposite of Luminosity, the
colors of the top objects are blended with the colors of the underlying objects whilst
ignoring the luminance values.
Color burn
Similar to Multiply. Burns or darkens the overlying objects, The image will be generally
darker.
Color dodge
Simlar to Screen (Bleach). Dodges or lightens the underlying objects, The image will be
generally lighter.
For all these, the slider controls the amount of transparency from opaque (0%
transparent) to fully (100%) transparent.
Applying a flat transparency to an object also applies transparency to the line around the
object. It is not possible to set different transparencies, but you can remove the line by
setting it to no color or by selecting "None" as the outline width. To create an object with
a transparent fill and a non-transparent line, use a non-flat transparency type.
For more information on colors see Color Handling (on page 189).
Enhance
See Enhance below for more information on Enhance transparency.

Transparency
Note that for legacy reasons, Designer Pro documents which contain older transparency
types will still refer to those types by their original names, even though those types are
no longer supported in Designer Pro. Look for (old) in the transparency type list to
identify them.
Blends, Blend modes, Blending

Enhance
Enhance transparency allows you to modify any part of your design using the Enhance
Photo Tool, just as if it was a photo. For example you can draw a shape over any part of
your design, apply enhance transparency to it and then adjust the brightness of just the
area of your design which is covered by the shape.

Applying Enhance transparency
To apply enhance transparency:

1.
2.
3.
4.
5.
6.

Draw or select the shape to which you want to apply the enhance transparency
effect.
Go into the TRANSPARENCY TOOL and select "ENHANCE " from the TRANSPARENCY
TYPE list on the InfoBar.
The shape seems to have disappeared from your page! That’s because it will only
apply enhancements to objects underneath it, and you’ve yet to specify the
enhancements it will apply. The object should still be selected however.
Switch into the PHOTO ENHANCE TOOL . Turn up the brightness using the control on
the InfoBar. Now you can see that the area covered by your shape is brightened
compared to the area outside the shape.
You can adjust brightness, contrast, saturation, temperature and hue.

Normally you’ll also want to apply some feathering to the shape using the FEATHER TOOL
(on page 175), to soften the edges of your shape and blend it into your design.

Profile
You can change the rate of change of transition between the start and end of
transparencies. This applies to all single stage graduated transparency types except
three point and four point (where the option is not available).
To change the profile of a transparency:

1.
2.

Select the object.
On the TRANSPARENCY Tool InfoBar click PROFILE . This opens the PROFILE dialog.
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Transparency
3.

The Transparency profile dialog

Handle/resolution
If you have a handle selected, this box tells you what handle it is. With no handles
selected, and when using a bitmap transparency, it controls the DPI.

Bitmaps
BITMAP & FILL GALLERIES

are described in Photo Handling (on page 331) and Fills (on

page 280).
When you select a transparency type of BITMAP , a default bitmap is initially used. Click
on BITMAP NAME in the transparency InfoBar, or use the BITMAP or FILL GALLERIES to
change the bitmap used (click the TRANSP button in the gallery or drag-and-drop from the
gallery).
By default, the lighter colors in a bitmap are the most transparent (you can, of course,
alter the relative amounts of transparency later).

Applying transparency to several objects
If you group objects and apply transparency, the whole group is treated as one object
and the entire group is made transparent. But if the objects are not grouped and you

Transparency
apply transparency, each individual object is given a separate transparency and you get
an entirely different effect when the objects are overlaid.

Individual transparency (left) or group transparency (right)

Mixing individual and group transparencies
You can combine the methods above to create complex transparency combinations. For
example you could set an object to 50% transparency, then group it and apply a
transparency to the group as well. You are also able to apply a transparency to a group
first, and then later apply attributes to individual objects within a group. Just hold down
"Ctrl", click the individual object and change its attributes.

Group transparency on blends
For more on blends see Blends (on page 314).
When adding a transparency to a Blend object, the transparency will be applied to the
blend as a whole. It is treated like group transparency.

If you want the transparency to be applied to each individual step of the blend, first make
the objects transparent, and then blend.

Opacity Masks
As described above, the Transparency Tool allows you to apply either flat or graduated
transparency to any object or group. But sometimes you need more advanced control
over the transparency (or opacity) of an object. Opacity masks are a very powerful way of
achieving this.

289

290

Transparency
The Opacity Mask system takes any object, or group of objects, and uses the color
(usually black to white shading) of these objects to define which parts of any other object
are transparent or opaque.

Original watch design

Watch applied as an opacity mask to a rectangle

First draw the shapes you want to define the opacity (the opacity mask). It can be
anything from a simple shape, or blend, to a complex grouped drawing. Any black color
will become 100% transparent, while white will be 100% opaque and shades in-between
will create varying degrees of transparency.
You can apply the opacity mask to other objects in your design in two different ways
(both give the same results). Also if you use the SHAPE ERASER tool with a soft nib
setting, it will create an opacity mask using your erase strokes to achieve the erasing
effect on the selected objects.

Applying using the clipboard
Select the object which is to be the mask and copy it to the clipboard. Then select the
object, photo, or group to which you want to apply this mask and select EDIT -> PASTE
OPACITY MASK . There are two options, the first will position the opacity mask into the
center of the selected object. The second option 'Paste opacity mask in place' will paste
it into the selected object based on the original position of the mask.

Apply directly
Place the object to which you want to apply the mask behind the object(s) that you want
to apply as a mask. Then select both the mask object(s) and the object to which the
mask is to be applied, and select ARRANGE ->APPLY OPACITY MASK .
The backmost object is taken as the target for the mask and all other objects in the
selection make up the opacity mask. So if you want to apply a mask to multiple objects
this way, you need to group them first and place them behind the mask objects.
You now have a special type of group called an 'Opacity mask group'.

Transparency
Soft erasing using the Eraser tool

Just select the object(s) you want to erase, go into the ERASER TOOL and make the
softness setting on the infobar a value greater than 0 (when softness is 0 a ‘hard erase’
is performed, which is used for permanently cutting objects and this does not use an
opacity mask). Choose an appropriate nib size on the infobar and draw over the objects.
An opacity mask is created automatically and your erase strokes are used as the mask.

Editing inside an opacity mask group
You can select objects inside the OPACITY MASK Group directly on canvas. Ctrl+click
operations will select the objects that are being masked, not the mask objects that form
the mask itself. To select the mask objects directly, use Ctrl+Alt+click. The first
Ctrl+Alt+click selects the whole opacity mask group. Ctrl+Alt+click again and it will select
the group of mask objects, so you can then drag around the whole mask inside.
Ctrl+Alt+click again and it will select individual mask objects.
You can also select any of the objects inside an opacity mask group using the Page &
Layer gallery, which lets you see the structure of the group in its entirety.
It can be difficult to make changes to the masked objects or to the masking objects as
they appear on the canvas. So you can edit either of these in a separate sub-document
view, just as you can edit inside normal groups. Right click on the opacity mask group
and choose OPEN OPACITY MASK GROUP to edit just the objects that are being masked (or
just double click on the opacity mask group). Or choose OPEN OPACITY MASK from the
same right click menu (in the OPACITY MASK sub-menu) to edit just the objects that are
forming the mask.

Advanced options
If you right click on an opacity mask group, the context menu includes an
MASK" sub-menu with the following operations.

"OPACITY

Open opacity mask
This is described above – it allows the masking objects to be edited in a separate
document view.
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Transparency
Invert opacity mask
This inverts the nature of the transparency in the opacity mask group, so transparent
parts become opaque and vice versa. This operation actually just changes the Clipped
and Inverted settings described below, since fully inverting the opacity mask group
involves changing both those settings.

Intitial opacity mask

Inverted

Detach opacity mask from selection
This operation extracts the masking objects from the opacity mask group, making them
become normal objects on the page and makes the opacity mask group into an ordinary
group.

Clipped (Ctrl+Alt+C)
This option makes the opacity mask group be clipped to the outline of the mask object(s).

Unclipped (default)

Clipped to mask object

Uses only alpha (Ctrl+Alt+A)
This makes the rendering of the opacity mask ignore color saturation levels and use only
transparency levels in the mask object(s) to set the transparency on the opacity mask
group.

Transparency
Inverted (Ctrl+Alt+V)
This inverts the nature of the transparency produced by the mask objects, as
demonstrated by this simple example.

Default

Inverted

See the Photo Handling chapter for an example of opacity masks in action and for other
tips.
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Bevels
The Bevel Tool
The BEVEL Tool (shortcut "Ctrl + F3") gives objects an appearance of depth
instead of being flat on the page.
Bevels are resolution-independent so you can scale them without losing quality.

Bevel type
Slider type list
Slider and numeric value for selected parameter
Outer bevel
Inner bevel
Join style
You can apply bevels to most types of object. The exceptions are:
 Part of a block of text (such as a single letter)-the bevel is instead applied to all the
text.
 To the curve in text along a curve.
 Contoured objects.
 Live effects (the bevel is applied to the object before the effect is applied if the effect is
live, or to the bounding box of the effect if the effect is locked).

Applying a bevel
To apply a bevel to a single object:

1.
2.
3.

Select the object
Choose the BEVEL Tool.
BEVEL TYPE

NONE

Modifying a bevel
You can change the angle and elevation of the light and change the shape, direction and
size of the bevel edge.

Bevels
Bevel direction
Bevels can be inside the object or outside. Outside bevels make objects larger; inside
bevels do not change the object size.
To change bevel direction:

1.
2.

Select the object.
INNER

OUTER

Changing the bevel light source
The bevel effect is created by a light shining across the object and highlighting the shape
(profile) of the bevel. You can change the direction and height of the light and its strength
(the contrast).
Changing the light angle (horizontal direction):

1.
2.

Select the object.

You cannot move the center of the arrow, only the arrowhead.

For precise angles, select LIGHT ANGLE from the SLIDER TYPE list. Then drag the slider or
type into the text box.

If you have several beveled objects selected, light angle changes all bevels. Dragging
the arrow changes just the bevel (or bevels) to which the arrow refers.

Changing the light strength (contrast)
To change the light strength:

1.
2.

Select the object.
CONTRAST

SLIDER TYPE

If you have several beveled objects selected, any changes apply to all the bevels. The
colors used in the bevel affect the contrast. For example, strong (saturated) colors
require more contrast than weak colors to get the same effect. For best results, you will
probably have to adjust the contrast for each object.
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Bevels
Changing the light elevation (vertical angle)
This lets you move the light anywhere from immediately above the object (90º) to the
side of the object (0º).

1.
2.

Select the object.
LIGHT ELEVATION

SLIDER TYPE

For rounded bevels we recommend a light elevation of 30º. At this angle the bevel blends
smoothly with the object.

Changing the bevel size
How to change the bevel size:

1.
2.

Select the object.

Alternatively:

1.
2.
3.

Select the object.
From the SLIDER TYPE list choose SIZE .

Changing the bevel shape
1.
2.
3.

Select the object
Choose the BEVEL Tool.
BEVEL TYPE

Changing the bevel color or fill effect
After applying a bevel to an object, you can change the bevel's color or fill effect. You can
apply any of Xara Designer Pro X's color effects including multi-stage fills.
For more on colors and the Color Line, refer to Color handling (on page 189).
How to change the bevel color:

Bevels
 The easiest way is to drag-and-drop a color from the Color Line onto the bevel (make
sure you drop the color onto the bevel and not the object.)
Alternatively, this method is slightly more complex but you have full control over the
color:

1.

Select the bevel using the SELECTOR Tool (make sure you select the bevel and not
the object.)

2.

COLOR EDITOR

Changing the bevel join style
After applying a bevel to an object, you
can change the shape of the corners
(joins).

How to change the bevel join style:

1.
2.

Select the object.
BEVEL

Miter

Round

Bevel

Removing a bevel
To remove a bevel:

1.
2.

Select the object(s) from which you want to remove the bevel.
BEVEL

Choose NONE from the BEVEL TYPE list.
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Shadows
The Shadow Tool
The SHADOW Tool (shortcut "Ctrl + F2") lets you apply, remove, and modify
semi-transparent (or "soft") shadows.
The transparency of soft shadows increases towards the edges, which gives a very
realistic effect. Shadows are resolution independent so you can scale them without losing
quality.

No Shadow
Shadow Types
Shadow Blur
Shadow Transparency
Profile
Shadow Position
Xara Designer Pro X has three shadow types:
 Wall where the shadow is cast on a wall behind the object
 Floor where the object appears to be standing upright on a surface.
 Glow where the shadow is used to add a halo effect around the object

Applying a shadow
Applying a shadow
To apply a shadow:

Shadows
1.
2.
3.

Select the object.
Choose the SHADOW Tool.
Select the WALL, FLOOR OR GLOW button on the
SHADOW Tool InfoBar.

4.

Alternatively to create a wall shadow you can:

1.
2.
3.

Select the object.
Choose the SHADOW Tool.

Blur the edges of the shadow
This changes the size of the shadow. A small
blur gives the effect of a sharp light source, a
large blur, a diffused or distant light source. It
is recommended that shadows are always
blurred slightly as this is more realistic.

To blur the shadow edge:

1.
2.
3.

Select the object
Choose the SHADOW Tool.
SHADOW

Change the transparency of the shadow
A semi-transparent shadow is more
realistic than a solid shadow. But you can
change the transparency level of the
shadow to suit your needs.

To change the transparency:

1.

Select the object
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Shadows
2.
3.

Choose the SHADOW Tool.
SHADOW

Changing the shadow profile
After applying a shadow, you can change how the shadow transparency changes across
the blur. You can have a linear transition (which is the default profile and usually gives
the most realistic results) or a profiled transition.
To change the shadow profile:

1.
2.
3.

Create the shadow.
In the SHADOW Tool, click PROFILE . This opens the PROFILE dialog box.

Changing the shadow color or fill effect
After applying a shadow to an object, you can change the shadow's color or fill effect.
You can apply any of Xara Designer Pro X's color effects including multi-stage fills.
How to change the shadow color:
For more on colors and the Color Line refer to Color handling (on page 189).
The easiest way is to drag & drop a color from the Color Line onto the shadow (make
sure you drop the color onto the shadow and not the object). Alternatively - this method is
slightly more complex, but you have full control over the color:
1.

Select the shadow using the SELECTOR Tool (make sure you select the shadow
and not the object).

2.

Use the COLOR EDITOR to edit the color.

Converting shadows to shapes
You can convert a shadow into a group containing the shadow and the object (or objects)
casting the shadow. The shadow is converted to a simple shape and, after ungrouping,
can be edited. Note that after converting a shadow to a shape, you cannot use the
SHADOW Tool to edit it, as it is no longer a shadow.
To convert a shadow to shapes:

Shadows
1.
2.

Select the shadow or the object (or objects) casting the shadow.
ARRANGE

CONVERT TO EDITABLE SHAPES

Or to convert a shadow quickly, right-click on the shadow or the object (or objects)
casting the shadow. This opens the pop-up menu. Choose CONVERT TO EDITABLE
SHAPES .

Removing a shadow
To remove a soft shadow:

1.
2.
3.

Select the object
Choose the SHADOW Tool.
NO SHADOW

SHADOW

Copying shadows onto other objects
Once you've got a shadow looking how you want it on one object, you can copy it onto
other objects using "PASTE FORMAT/ATTRIBUTES ". Simply copy the object that has the
shadow ("EDIT" > "COPY" ), select the object or objects you want to paste the shadow onto
and choose "EDIT" > "PASTE FORMAT/ATTRIBUTES" .
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Contours
The Contour Tool
The CONTOUR Tool ("Ctrl + F7") lets you create interesting effects around the
edges of objects. The CONTOUR Tool creates a series of concentric outlines
either on the inside or the outside of a selected shape.

Edit distance between steps
Number of steps
Remove contour
Color effect
Contour width
Outer contour
Inner contour
Position profile
Attribute profile
Inset path
Join types

Contouring objects
To contour an object:

1.
2.
3.

Select the object.
Choose the CONTOUR Tool.

 Drag any of the eight handles that surround the selected
objects. As you drag, you see the outline of the contour.
 Or drag the contour width slider.
 Or type a new value into the text box.

Contours
Contours can be either inside or outside of objects (outside contours make the objects
larger).
To swap the contour direction:

1.
2.
3.

Select the contoured object.
Choose the CONTOUR Tool.

 Drag any of the eight handles that surround the selected
objects (drag the handles inside or outside the objects to
swap).
 Or click the INNER or OUTER contour buttons.
Note that objects cannot have both a contour and a bevel.

Changing the number of steps in a contour
Contours are initially created with five intermediate steps. You can increase the number
of steps to make each step less obvious. Alternatively, you can reduce the number of
steps so you can clearly see each step. You can either enter the number of intermediate
steps or enter the distance between steps.
To change the number of steps in a contour:

1.
2.
3.

Select the contoured object.
Choose the CONTOUR Tool.
Select either distance or number of steps by pressing one of the two buttons on the
left side of the InfoBar.

4.
CONTOUR



If required, Xara Designer Pro X rounds the distance to give a whole number of steps.

Changing the contour color
After applying a contour to an object, you can change the contour's color.
For more on colors and the Color Line refer to Color handling (on page 189).
How to change the contour color:
The easiest way is to drag-and-drop a color from the Color Line onto the contour (make
sure you drop the color onto the contour and not the object).
Alternatively this method is slightly more complex but you have full control over the color:

1.

Select the contour using the SELECTOR Tool (make sure you select the contour and
not the object).
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Contours
2.

COLOR EDITOR

Note that you can also select the contour using the CONTOUR Tool. Click on the contour
to select it.

Changing the contour join style
After applying a contour to an object,
you can change the shape of the
corners (joins).

How to change the contour join style:

1.
2.

Select the object.
CONTOUR

Miter

Round

Bevel

Changing the contour attribute profile
After creating a contour you can change how the attributes (such as color or line
thickness) change. You might want a regular rate of change or a more pronounced
change towards one end or the center.
To change the attribute profile:

1.
2.
3.

Create the contour.
In the CONTOUR Tool click ATTRIBUTE PROFILE . This opens the PROFILE dialog box.

Changing the contour position profile
After creating a contour you can change how the intermediate steps are spaced. You can
have regular spacing or closer at one end than the other or closer in the center.
To change the position profile:

1.
2.

Create the contour.
In the CONTOUR Tool click POSITION PROFILE . This opens the PROFILE dialog box.

Contours
3.

Applying a contour to several objects
If the objects are grouped,
overlapping contours merge
together. The contour color is
the same as the rear-most object
in the group.

If the objects are ungrouped, each object has a separate contour. The contour color is
the same as the object color.
The contour steps are not separate objects. To make them selectable, you need to
convert the contour to editable shapes (see below).

Using contours to resize objects
You can use contours to change the size of objects by making the outline thicker or
thinner. This has advantages over resizing for shapes like the letter "C":
On the left is the original object. The center letter
is resized using a contour, the right letter is
resized by scaling the object up.

To resize using contours:

1.
2.
3.
4.

Select the object.
Choose the CONTOUR Tool.
Give the object a contour of the required size.
INSET PATH

CONTOUR

Converting contours to shapes
You can convert a contour into a group containing all the contour steps. Each step is
converted to a shape and, after ungrouping, can be edited. Note that after converting a
contour to shapes, you cannot use the CONTOUR Tool to edit it as the object is no longer
a contour.
To convert a contour to shapes:

1.
2.

Select the contour.
ARRANGE

CONVERT TO EDITABLE SHAPES
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To convert a contour quickly, right-click on the contour to open the pop-up menu and
choose CONVERT TO EDITABLE SHAPES .

Removing a contour
If a contour does not give the desired effect, you can easily remove it:

1.
2.

Select the contoured object.
CONTOUR

Click on the Remove button on the CONTOUR Tool InfoBar.

Photo Regions and Masks

Photo Regions and Masks
In Xara Designer Pro X the Mask tools are not presented on the main toolbar at startup.
If you want to use these tools you can find them in the Button Palette.
To open the Button Palette choose CONTROL BARS ... from the WINDOW menu and scroll
through the list to the bottom. Then click the checkbox next to the Button Palette item.
(Or right-click on an empty area of any button bar and choose Button Palette from the
pop-up menu.)
If you want to use these tools regularly you can move them out of the Button Palette by
dragging them onto the toolbar. (Hold down Alt, then drag the button and drop it onto the
toolbar, over one of the existing icons).

Masks vs Photo Regions
A mask is used to protect part of a photo from a photo operation. For example when
using the CONTENT-AWARE SCALE/ZOOM (on page 387) tool to stretch or zoom a photo,
you often want to ‘protect’ part of the photo to stop it being distorted by the operation.
You use a mask to mark that area of protection.
Conversely the Photo Region tools are used to select areas of a photo upon which you
wish to perform a photo operation. This might involve a Photo enhance operation to
brighten or tweak the color of a particular area of a photo, or you might want to just
perform a simple crop, or cut and paste part of a photo.
Regions and masks are actually interchangeable and the difference between them is
only really one of presentation. A region identifies the part of a photo you want to operate
on, while a mask works the other way around and identifies part of an image you don’t
want to operate on (the masked area is protected from the operation). And in fact if you
have drawn a region using a region tool and you switch to the mask painter tool, the
region becomes a mask. And similarly if you start with a mask and switch to a region tool,
the mask becomes a region.
Masks have the advantage of being able to show levels of ‘softness’ whereas regions are
indicated only by a hard outline. So if, for example, you use the Feather Tool (on page
175) on a region, you won’t see any change to the region as you apply the feathering.
But when you use that feathered region to enhance your photo, you’ll see that the
enhanced area is indeed feathered. If you use a mask instead, the pink fill of the mask
shape will show the feathering.

307

308

Photo Regions and Masks
Creating Regions and Masks
To create a photo region use the REGION PAINTER TOOL , MAGNETIC LASSO (on page 343)
or RECTANGLE REGION TOOL from the PHOTO REGIONS AND MASK TOOLS flyout bar to draw
round the area on which you wish to perform an operation. The selected area will be
outlined with a dashed 'marching ants' effect.
To create a mask choose the MASK PAINTER TOOL from the PHOTO REGIONS AND MASK
TOOLS flyout bar and use it to draw a pink mask over your photo on the parts of it you
want to protect.
The masked areas are shown with a pink fill and have a dashed 'marching ants' effect
around the outside. Any part of the objects covered by the pink area will be protected
when performing a mask compatible operation.

The Photo Region and Mask tools
The Photo region and Mask drawing tools can be found on the Photo region and
Mask tool flyout on the main toolbar.

The region and mask tool flyout bar

The REGION PAINTER tool allows you to 'paint' over an area or object that you want
to select. Choose an appropriate nib size from the InfoBar and create a shape by
stroking over the object.
The MAGNETIC LASSO allows you to easily trace round objects in a photo to cut
them out. This mode is enabled by default on the MAGNETIC LASSO mode toggle
on the InfoBar. Disabling the mode lets you draw closed shapes around the areas
or objects you want to select in much the same way as you would a pencil. It has
a smoothing control and you can also hold down the 'Shift' key to erase your line
as you draw. The MAGNETIC LASSO (ON PAGE 343) is described in detail in Photo
Handling (on page 322).
The RECTANGLE REGION TOOL tool lets you drag a rectangular selection around an
area or object. You can modify your shape using the width and height settings on
the InfoBar.
The MASK PAINTER TOOL allows you to 'paint' a pink mask over an area or object
that you want to protect. Choose an appropriate nib size from the InfoBar and
create a mask shape by stroking over the object.
Use the SHOW MASK OR REGION button to toggle the mask or region on or off.
Turning off a mask/region in this way does not delete it, so you can get it back at
any time by turning it on again, but while turned off it won’t affect any
mask/region-aware operations.

Photo Regions and Masks
The INVERT MASK OR REGION button inverts the masked area or selected region so
that everything but the selected or masked areas are selected or masked instead.
Use the CLEAR MASK OR REGION button to remove all the shapes on the mask
layer.
The INVERT and CLEAR functions also appear on the InfoBar.
On the InfoBar there is also a toggle for turning mask/region outlines on and off. This is
only normally useful when using these tools to edit regions inside Photo Groups. All it
does is turn off the outline, so this toggle is Not the same as the SHOW MASK OR REGION
button described above, which turns on/off the whole mask/region. See Photo Groups
(on page 323) for details.

Both the Region and Mask painter tools allow you to change the nib size quickly by
holding down Alt and using the mouse-wheel. However the easiest way to work is usually
to just zoom in where you need to paint a smaller area.
For more on nib selection see the Shape Painter tool (on page 132). And for more
information on the smoothing control feature see the Freehand and Brush tool.

Editing Regions and Masks
Both the Region and Mask painter tools can be used to erase unwanted parts of region
and mask shapes. Hold down the Shift key and your left mouse button and drag the
pointer around the area you wish to erase.
You can also edit region and mask shapes using the PAGE & LAYER GALLERY to access
the mask layer. This is useful for the fine detail editing of mask shapes, or if you want to
move the position of a mask, or else to create a soft mask.

1.
2.
3.

Click on the selector tool and open the PAGE & LAYER GALLERY .
Click on the mask layer to unlock it.
Select the mask or region shape you wish to alter and reposition/ resize the shape
as required.

4.

SHAPE TOOL
RECTANGLE REGION TOOL
RECTANGLE TOOL.

It's easy to switch between the Regions and Mask tools - if you created a selection using
one of the Regions tools and you want to turn it into a mask instead just click on the
MASK PAINTER tool and the selection will now be a pink masked area instead. And the
reverse is also true, create a mask shape using the MASK PAINTER tool, then click on one
of the Regions tools and the mask will now be a selection.
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Soft Masks
A soft mask is a mask that includes varying levels of masking, instead of consisting
simply of just masked parts and unmasked parts. For example part of an image may
have a 50% mask applied, so that a subsequently applied operation has only a 50%
effect on that part of the image. Or a mask shape could have a graduated mask that
smoothly graduates from 0% masking to 100% masking. If such a mask is then used with
the PHOTO ENHANCE TOOL to brighten the photo, the effect of the brightening would be
similarly graduated.
Not all operations support soft masks. For example Content Aware Scale, Clone/Magic
Erase and Clipview creation will ignore any softness in the mask.

Creating a Soft Mask

You can create soft masks by applying the TRANSPARENCY TOOL to your mask shapes on
the mask layer.
Having firstly created your mask shapes;





Switch to the selector tool and open the Page & Layer Gallery
Expand the page to view the layers and click on the Mask layer to make it active
Click on the mask shape on the canvas and select the transparency tool
Drag across the mask shape to create a linear graduated soft mask

It may be preferable to draw your mask shape using one of the drawing tools rather than
the MASK PAINTER TOOL . This is particularly useful when working with soft masks, where
you are applying different levels of transparency to the mask objects. With the mask tools
deselected, select the shape, and copy, or cut it. Now click on the MASK PAINTER TOOL
and use "Paste in Place" in order to paste the shape in exactly the same place it was
copied from.

Operations That Use A Mask
ClipView
You can clip your drawing or photo to be inside a selected shape.

1.
2.

Select one of the region tools from the PHOTO REGIONS AND MASKS TOOL flyout bar
and draw whatever shape you require.
ARRANGE" > "CLIPVIEW"

Photo Regions and Masks
ClipViews are live and non-destructive in that the whole drawing is retained inside the
Clipview object. See Object Handling (on page 104) for more details.

Cut, Copy, Delete
These operations are useful when used with the PHOTO REGION
from photos, but you can use them on any objects.

1.
2.
3.

TOOLS ,

to cut pieces

Select one of the region tools from the PHOTO REGION AND MASK TOOLS flyout bar
and draw whatever mask shape you require.
Now select an option from the EDIT menu to perform a Cut/Copy/Delete operation.
SELECTOR TOOL

The Rectangle Region tool is used to create a selection (left). Cut or Delete then removes the
selected area of the Photo (right).

On the left example the selection has been inverted. Now when you Cut or D elete only the
cat's eyes remain, everything else is deleted.

You can use the PHOTO REGION AND MASK tools on top of any drawing or photo.
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If you use these operations with soft masks, an Opacity Mask is created using the soft
mask. See the Opacity Masks (on page 289) section of the Transparency chapter for
details on Opacity Masks.

Duplicate, Clone
This will copy only the selected part of the drawing or photo. The Clone option places a
copy exactly on top of the original.

Content Aware photo scaling
To protect part of a photo from being scaled;

1.

Select one of the mask tools from the Regions and Masks tools flyout bar and draw
whatever mask shape you require around the area you wish to protect.

2.

See the Content Aware Scaling (on page 387) feature for more information.

Photo enhance tool

Use one of the Enhance tools to apply brightness, contrast, saturation, temperature and
blur/sharpen changes to any part of a photo.

1.
2.

Select one of the Region tools from the Regions and Masks tool flyout bar and draw
whatever shape you require around the area you wish to enhance.
Now go into the Enhance Photos tool (Photo tool fly-out bar on the main toolbar)
and click on the photo.

3.
Advanced users may wish to use Soft masks to introduce graduated effects to the photo
enhance operation. See the Photo Tool and Photo Handling chapters for more
information.

Photo clone tool

The clone tool will take a mask shape and convert it into a clone shape, which copies
one part of a photo to another part. See the Clone Tool section (on page 377) of the
Photo Tool chapter for details.

Photo Regions and Masks
Combine Shapes
There are a set of operations under the "ARRANGE" > "COMBINE SHAPES" menu that allow
you to combine shapes in a number of different ways. You can also use these with the
region tools.
For example to slice a piece of a photo out (cookie cutter style),

1.
2.

Select one of the regions tools from the PHOTO REGIONS AND MASKS tools flyout bar
and draw whatever shape you require.
"ARRANGE"

"COMBINE SHAPES"

"SLICE"

Copying Shapes To The Mask Layer
You may prefer to draw mask shapes using the ordinary drawing tools instead of the
mask tools, or to use an existing shape on your mask layer. This is particularly useful
when working with soft masks, where you are applying levels of transparency to the
mask objects. In the SELECTOR TOOL , select the shape, and copy, or cut it. Now switch
into one of the mask tools and PASTE . Use PASTE IN PLACE if you want the shape to
appear in exactly the same place it was copied/cut from.
To copy shapes from the mask layer to any other, do the reverse. Select the shapes
while in a region or mask tool, then switch to the SELECTOR TOOL , and paste.
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Blends
Blends
This operation blends one object into another by a series of intermediate objects. This is
sometimes known as interpolation, in--betweening, tweening, or morphing.

A five-stage blend of a star into an
arbitrary shape.

Blends have several different uses. This section describes firstly some of the uses and
then using the BLEND Tool.
A blend is treated like a group and you can move and copy the blend as you would a
group.
Groups are described in Object handling (on page 95).

Uses of blends
 To create a repeating design, such as a series of rules:
For this you’d typically create an object, duplicate it to create the
end object and then blend between them.

Or a pattern:

 To transform one object into another. The star to shape blend above is an example of
this. By using more intermediate stages you can create complex shading and
highlighting effects.
The blend does not just blend the shapes but also other attributes such as line thickness,
line and fill colors and transparency. So when blending from an object of one color to an
object of another color, the intermediate steps will take on intermediate colors.

Blends
Using the Blend Tool
To create a blend:

1.
2.
3.

Select the BLEND Tool ("F7")
Move the pointer over a visible part of the start object.
Drag the pointer over the end object. As you drag the pointer a "blend line"
appears.

4.
For object-to-object blends the blend line is colored black. When blending
between control handles, it is colored red.

The Blend Tool InfoBar

Edit distance between steps
Edit number of steps
Steps in blend
Remove blend
Blend color effect
Position profile
Attribute profile
1:1 node mapping
Anti-alias blend steps
Blend along a curve
Rotate blend steps along the curve
is the number of intermediate stages in the blend. At lower settings the individual
steps are apparent. This is useful for object transforms. At higher settings the steps
merge together. This is more suitable for highlight effects. Experience shows that you
rarely need more than 50 steps even in a complex blend.
STEPS

The two objects can have different numbers of control handles and can be different types
(for example, shapes to lines).
When Xara Designer Pro X blends, it has to have a "start" handle on one object that
maps onto an equivalent "start" handle on the other object.
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If you create a blend by dragging from the filled interior
of one shape to the other, then Xara Designer Pro X will
automatically choose the bottom-left control handles to
match. However, you can force a blend to use any
control handle as the starting handle by dragging
exactly from one control handle to another.
Blending between different control handles gives
different blend patterns.

A second way to adjust the blend is to
add control handles to one object. The
left-hand example is a blend between
two triangles. The right-hand example
has an extra control handle in the
lower triangle. The blend was then
made to that control handle.

A third way is using the 1 TO 1 NODE MAPPING button.
This only has an effect if the two objects have the same number of control
handles. Usually Designer Pro adds or removes handles as necessary to
transform one shape into another.
When blending with shapes that have the same number of handles (such as copies or
duplicates) this can sometimes produce strange results. In this situation, the 1:1 button
prevents extra handles being added. You can still control the start handles by dragging
exactly between control handles as previously described.
The left-hand example is a normal blend
between the rectangles. The right-hand
example uses 1:1

Selecting the start or end object
After creating the blend you may want to change some attribute of either the start or end
object such as its color or line width or position.
To change an object’s attributes:

1.
2.
3.

Select the SELECTOR Tool.
"Ctrl + click" on the start or end object to "select inside"

Blends
The Selector Tool is described in Selecting objects (on page 122).
To change the color, drag-and-drop the color from the Color Line onto the object. You
can’t select intermediate steps of a blend, unless you CONVERT TO EDITABLE SHAPES –
see later.

Multi-stage blends
You are not limited to blending between only two objects. Designer Pro can blend
between several objects.

The original three objects, left, and the resultant blends right
(It also shows blending between different types of object.)

The produce a multi-stage blend just blend from the fist to the second, and then again
from the second to the third, etc.

Producing highlight effects
By increasing the number of blend steps you can create some complex highlight shading
effects. One of the most powerful features of Designer Pro is that it allows blends from
just about any shape to any other shape, with dissimilar numbers of handles.
However, blends between objects with sharp corners can produce unwanted twists in the
blend.

The two shapes have different numbers of handles, and a blend from one to the other
produces the result on the right. It has a twist in the top right corner.
You can control exactly which point handles map, when creating the blend, by dragging
from the point handle of one shape to a corresponding handle on the other shape. You
will need to have both shapes selected in order to see the control points.
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The left example has the top right handles mapped so now there is no twist in the right
side. In order to get the exact desired effect it’s sometimes necessary to experiment by
mapping between alternative points or adding or removing point handles to one of the
shapes. The Apple drawing on the front of this chapter is an example of complex
highlights created entirely from blends.

The number of steps
To change the number of steps in your blend, just enter a
value in the STEPS box.
It is also possible to change the distance between steps, but this option is only available
when creating a blend along a curve (see below).

The Anti-Alias button on the InfoBar
When producing highlight effects, anti-aliasing the intermediate steps has no visible
benefit. However, it slows down screen redraws by up to 30% on slow computers.
Therefore, deselecting the ANTI-ALIAS button means that Designer Pro never antialiases the intermediate steps of this blend.

Profiles
lets you select how to space the intermediate steps in a blend.
You can have regular spacing or closer at one end than the other or closer in the
center.
ATTRIBUTE PROFILE lets you select how attributes (such as transparency, colors or
line thickness) change in a blend. You can have a regular rate of change, greater
change at one end, or greater change in the center.
POSITION PROFILE

Changing profiles
To change a profile:

1.
2.

On the BLEND Tool INFOBAR click either POSITION PROFILE or ATTRIBUTE PROFILE .
This opens the required profile dialog box.

Blends
Blending along a curve
To make your blend follow a curved line or
shape:

1.
2.
3.

Select both the blend and a line or shape.
Select the BLEND Tool.
BLEND ALONG A CURVE

You will most likely want to hide the line or shape, and just leave the items going along
an invisible curve. To do this:

1.
2.
3.

Select the blend.
"Ctrl + click" (select inside) to select just the line, or choose the
TOOL . This selects just the line or shape.

NO COLOR
Color handling

SHAPE

Rotating along a curve
If you have blended along a curve, you can make
the objects rotate to match the curve.

To do this, select the ROTATE ALONG CURVE button on the BLEND Tool INFOBAR .

Blends and PDF or PostScript files
When printing or exporting to a PDF file, using a large number of blend steps can result
in large files (megabytes in some cases) which can be very slow to print or view. If
necessary reduce the number of blend steps.

Editing the shapes in a blend
The intermediate steps of a blend are calculated on-the-fly and are not selectable or
editable. Use the menu, ARRANGE -> CONVERT TO EDITABLE SHAPES to convert the
individual blend steps to separate objects. (The result is grouped so you would need to
ungroup before editing the individual steps.) Doing this is less efficient because to
change the blend you will have to re-blend from the start object to the end object.
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Color Blend Effect
The COLOR BLEND EFFECT menu on the BLEND Tool InfoBar gives you a control over
intermediate colors:



FADE :

Fades between the two colors.
Blends along the shortest edge of the HSV color wheel. For example, a
blend from yellow to cyan runs yellow-green-cyan. (This option has no effect when the
two colors are black, white or gray.)
 ALT RAINBOW : Similar to rainbow except the blend is along the longest edge of the
color wheel. For example, yellow to cyan runs yellow-red-magenta-blue-cyan.
RAINBOW :

The HSV color wheel is described in Color handling (on page 189). This menu is identical
to the fill effect menu in the Fill Tool.

Viewing blends as outlines
WINDOW

-> QUALITY controls how blends are displayed:

 At OUTLINE only the start and end objects appear. The intermediate objects are not
drawn.
 At OUTLINE WITH BLEND STEPS start, end and intermediate objects are drawn as
outline.
 At FULL COLOR the outlines and fill colors of the intermediate objects are drawn.
 At HIGH & VERY HIGH QUALITY all the information is shown anti-aliased if the ANTI-ALIAS
button (described above) is active. If not, the intermediate steps are not anti-aliased.

With the view quality slider in the second position you can see all the intermediate steps of a
blend as outlines.

Blends
Removing blends
Removing a standard blend
Select the blend, then click

REMOVE

on the BLEND Tool InfoBar.

Removing blend from a curve
Select the blend, then deselect the BLEND ALONG A CURVE button.
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Photo Handling
Non-destructive photo editing
Photos are an integral part of almost all creative work nowadays, from websites, to flyers,
brochures, DTP work and more.
Photo handling in Designer Pro is very different to other graphics programs that you may
be used to.
In Xara Designer Pro X you can color, crop, copy, blend, enhance, clone, feather (fade
the edges of) photos as much as you like. The object oriented, non-destructive nature of
the photo handling means that, for example, when you resize a photo, you are not really
altering the original photo, but just resizing a visual copy. The original imported image is
saved in the .xar file, so that you can later edit, and resize again, or apply any of the
Photo Tool editing options, with no loss of quality. You can even un-crop cropped
photos.
This is fundamentally different to the way most photo editing programs work (which are
destructive - i.e. they alter the actual pixels of the image).
The photo handling is astonishingly fast. You can open a 50 Megapixel photo, and
perform any of the enhance operations, and rotate the full resolution image in real-time.
This chapter covers the basic principles of manipulating photos and bitmap images in
Xara Designer Pro X. The operation of the Photo Tool is covered in the separate Photo
Tool chapter.
*Benchmarks based on photo compositions created with multiple hi-res JPG digital photos

Photo Objects
In Designer Pro photos (or bitmaps) are just another type of object on the page. You can
drag and drop photos onto the page from your Windows file explorer, and then you can
resize, rotate, copy and move them around just like any other object. Importantly you can
adjust the transparency, even graduated transparency, feather edges and clip and cut
shapes out of photos with ease. The transparency feature lets you blend, merge or
create composite photos.
Where you might have to use layers in other photo tools, every object in Xara Designer
Pro X is on its own layer and, just as with any object on the page, you can move it
forward to be in front, or backwards to be behind other objects.

Photo Handling
Photo Groups
If you edit a photo using some tools such as the integrated Red Eye tool or Clone Tool
(on page 377), the photo becomes grouped with other objects that modify the image in
some way. For example with the Red Eye tool, the ellipse shapes that are used to modify
the red eye areas of the photo are grouped with the photo itself. This is called a PHOTO
GROUP and you’ll see this on the status line when you select such a modified photo.
Similarly - if you enhance a photo while you have an active Mask or region, an enhance
region is placed inside the Photo Group
Just like an ordinary group it keeps the photo together with the other objects that have
been added to modify it, but unlike a group it is still treated as if it was an ordinary photo
by the Photo Tools and other tools. Normally photo groups are automatically placed
inside a clipview object, which clips any objects which overlap the edge of the photo, to
the boundaries of the photo itself. That’s why when you select a photo group the status
line usually shows you have a "Clipped photo group" selected.
If you want to convert a Photo Group into an ordinary photo object, you can use
"UTILITIES" > "OPTIMIZE PHOTO" . But note that this is destructive in that thereafter you will
not be able to modify any of the photo edits you’ve applied to the photo. Some other
operations such as content-aware scaling, photo background erase and contoning also
convert photo groups into flat photos, because these operations aren’t able to preserve
the photo group structure.
You can also duplicate/clone (Ctrl+K) objects within photo groups - the cloned object
then appears as the topmost object in the Photo Group (look in the Page and Layer
Gallery (on page 181) to verify!)

Photo Grids
There are essentially two types of Photo Grid, which are a compact array of photos:
STATIC PHOTO GRIDS , and SMART PHOTO GRIDS .
You can find these in the ONLINE CONTENT CATALOG under "COMPONENTS" > "IMAGE
RESOURCES" > "PHOTO GRIDS ". All the SmartShape photo grids (as opposed to the Static
ones) have ‘smart’ in the title.
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Static Photo Grids
These are aesthetically pleasing arrays of photos, but in a fixed arrangement. You can
replace any photo by dragging a photo file (typically a JPG or PNG) from your Windows
file explorer on top of any image in the grid. You can then use the Smart photo handles
(on page 351) to adjust the image with its frame, but it’s not recommended you change
the crop or size of the individual images

A static Photo Grid.

Smart Photo Grids
This is a more flexible SmartShape that lets you display any collection of photos, even
those with different shapes and aspect ratios, in a compact grid. You can adjust the
number of photos on each row, or number of rows, drag to re-order the photos, and
adjust the gap between all the photos.

Photo Handling
To show these SmartShape control handles, click on the grid. As you hover over each
handle a little info tip appears.

Drag the blue handles in the centers of images to re-order images.
Adjusts the gap between the images.
Rotate the whole grid.
Click a green edge handle to add a new image to the row. This will add a
placeholder image onto which you can drag a new photo.
Resize the whole grid, alternatively, use the Selector Tool. Hold down shift
to resize the grid around its center.
Drag down to add another row of images.
Click an interior green handle to delete the image. This will reshuffle and
resize the other images on the row.
You can also use the Smart Photo handles on individual images, by going into the PHOTO
TOOL and clicking on an image. Each time you replace an image, it puts you into this
Photo Tool mode. To get back to the SmartShape handles use the QUICKSHAPE TOOL
(Shift+F2) or go back to the SELECTOR TOOL (on page 122) and click again.
Adding & Replacing images
To replace an image with your own photo, just drag and drop a photo file from Windows
Explorer (or from the BITMAP GALLERY (on page 331) if the photo is already in the current
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document). The image in the grid that you drop onto is replaced with your photo and the
grid automatically updates to accommodate your photo.
To add more images click the green "Add photo" handle on the right end of each row, or
drag the "Add / remove rows" handle at the bottom left of the grid to add a complete row.
Note: The height of a row is calculated by fitting the number of images in this row into the
width of the grid. So the more images per row, the less tall that row is, especially if the
images are wide such as panorama photos. Similarly rows containing just a single image
will usually be taller.
Border
There is a "Border width" handle on the top left photo in the grid that lets you adjust the
space between each photo. You can have no space at all if you choose, but when you do
have a border it’s simply empty space between the photos so you see whatever is behind
your photo grid. Therefore if you want to see something other than the page background
behind, just draw a rectangle behind and set its color or fill to give the border effect you
would like.
Photo grid, Grids, Stacked photo grids, Smart grids, Smart photo grids.

Photo Handling
Importing Photos
Xara Designer Pro X supports a very wide range of photo or bitmap types including
JPEG, PNG, TIFF and RAW digital camera images, as well as many more types. The
term "bitmap" is the general term encompassing all types, but interchangeable with the
word "photo".

The easiest way to open an image is to drag the photo or bitmap file from your Windows
file explorer onto the Designer Pro Window. The photo is imported at the position you
drop it. Or you can select the "FILE" > "OPEN" or IMPORT menu options.
You can select multiple photo files in the file dialog by clicking with Shift or Ctrl held down
to add to the selection, just as in Windows Explorer, to open or import multiple photos.
You can also import stock photos from the Online Content Catalog through the File menu
"FILE" > "NEW FROM CONTENT CATALOG". Or you can replace a photo by right-clicking it,
and then choosing "REPLACE PHOTO" > "WITH STOCK PHOTO" from the context menu.
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Replacing photos
If you drag and drop a photo file (from Windows Explorer or from the Bitmap Gallery)
onto an existing photo it will replace that photo, but keep the same container or frame
size.
The same is true if you replace an existing photo with a stock photo from the Online
Content Catalog - right click on your photo and select "REPLACE PHOTO" > "WITH STOCK
PHOTO".

This makes it very easy to replace photos on templates. You can use the photo
adjustment handles to quickly adjust the scale, rotation, and position of the photo inside
its outline, as well as being able to resize, rotate and even add rounded corners to the
frame itself. This is not true for photo documents (on page 358), where dropping a photo
on the page will always import it as a new photo document.
When replacing a photo or bitmap this way, it is sized to best fit in the existing picture
outline.If you hold "Shift" when replacing a photo, the new one will inherit the same scale
and rotation as the old photo, instead of being ‘best fitted’. This is useful where you've
manually adjusted the scale or rotation of a fill and then want to replace the image with
another which has the same aspect ratio.
When you drop a new photo onto a Photo Group (on page 323), the entire Photo Group
is replaced, leaving you with a photo object showing the new image.

Using photos as fills
You can also use any bitmap as a fill style for any drawn shape. Simply drag the file over
the shape (which can be from your file system, or from the Bitmap or Fill galleries), and
hold the "Shift" key down before you drop. This will replace the existing color fill with a
bitmap, fitted to the object. Again you can use the smartphoto adjustment handles to
change the scale, angle, position etc.

Optimization on import
When importing high resolution photos (anything above 1920 pixels either wide or high)
into a web document, Xara Designer Pro X automatically resizes the photo down to HD
screen size without asking you if you want to import a lower resolution version. For a web
document, even at the reduced size, there should be more than enough resolution in
your photos for high quality results on your website, so it’s rarely necessary to import
digital camera images at full resolution for web use.
However, if you are importing a large photo into a print or animation document, Xara
Designer Pro X asks you if you want to import a lower resolution version of your photos.
If your document is to include many photos, you may want to choose this reduced
resolution option. Otherwise with large photos you may find that your saved design file is
much bigger than it needs to be (because it contains a copy of each of your photos) and
you may not have enough memory in your computer to load, edit and export your
documents.
Automatic conversion to JPEG

Photo Handling
The JPEG image format is usually the best choice for photo images, because it
maintains high quality with smaller file sizes. So when you import non-JPEG photo files,
Xara Designer Pro X will examine the image to see if it would be more appropriate as a
JPEG. If so, a prompt is shown giving you the option to convert it to JPEG on import.
This reduces the size of your document files and reduces memory usage when editing.
When pasting in images from the clipboard, the same analysis is done and the image is
imported as JPEG if that’s appropriate. This is done silently with no prompts. This is
particularly useful when copying and pasting in images from web browsers because
although the images are often JPEGs in the web page, some browsers don’t
communicate this to the clipboard.

Initial Photo size
When you import a photo into a document, by default if it’s bigger than 500 pixels wide
the photo is automatically scaled down to 500 pixels. This is because it’s rarely useful to
drop a huge digital camera photo into a drawing document and have it displayed at its full
size, so it’s scaled down to a more manageable size. You can change this behavior on
the VIEW tab of the UTILITIES > OPTIONS dialog:
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You can choose a different size to which photos should be scaled, or elect for them to be
imported at 96dpi (default screen resolution) so that at 100% zoom they are displayed at
1:1. Or you can choose to have photos imported at the dpi which is indicated in the photo
file itself. Note that some digital cameras set this dpi value wrongly and so this third
option may not always give you the results you expect.
When importing at 96dpi each pixel of the photo takes one pixel of screen, so you're
seeing the full resolution image when viewing at 100%.
However because most digital photos are very high resolution, this means you may only
see a small part of your photo, so initially Xara Designer Pro X will automatically alter the
zoom scale to zoom out so you can see the whole image. This also means that a typical
digital photo will be far, far larger than your page size (your screen is probably only about
1200 pixels across, and a typical digital photo is 3 or 4 times as wide, sometimes a lot
more)
To reduce the size, just drag one of the photo adjustment handles, or one of the
SELECTOR TOOL , corner handles or enter a new width in the SELECTOR TOOL InfoBar
width field.

Photo resolution
One fundamental difference between Xara Designer Pro X and other photo tools is that
when you resize a photo it retains the full resolution. Scaling an image to be smaller, just
increases the dpi or ppi (pixels per inch). In other words no pixels are lost, they are just
made smaller.

96ppi image on the left when scaled down to half size becomes twice the resolution, 192ppi.

Photo Handling
The status line shows the resolution of any selected image. Retaining the full resolution
is important because it means you can see all the detail when you zoom in, and that
when printing the maximum resolution is sent to the printer. Also it means you can
enlarge all or part of the image and Designer Pro retains the original maximum quality.

Zero-memory Copies
One of the most revolutionary differences between Designer Pro and other software is
that when you copy any photo on the page, it doesn't really make a complete new copy
of the original imported photo but instead just displays another 'view' of the original
image. Designer Pro's rendering engine is fast enough that it can display any number of
copies of the same image 'on the fly' this way. This saves huge amounts of memory and
dramatically reduces files sizes.
This doesn't detract or limit what you can do with each copy, and they can be treated as
completely separate independent copies. Each copy does not have to be identical. You
can manipulate each as required, resizing, rotating, cropping. coloring, feathering, or
applying a wide range of photo and transparency effects. All for no memory or native file
size increase.

This shows separate copies of the same image, each manipulated in a different way.
Each retaining the full resolution of the original imported JPEG, as you can see from the
right image. The memory (RAM and file size) is no more than the original JPEG size.

The Bitmap Gallery
The Document handling chapter (on page 60) has general information about galleries.
The BITMAP GALLERY shows all the bitmaps or photos used in any document, along with
information about its pixel size and file size.
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You can open it by clicking it in the Galleries bar, or from within the "UTILITIES" >
"GALLERIES" menu, or "F11".

The following useful information is displayed about the original image:
 Filename of the original JPEG
 The file type, in this case a JPEG, and the file size, 1,006K. (This is the original size of
the file, and also how much of the .xar file will be taken up by this image.)
 The pixel dimensions of the original, the Megapixel size (in this case just under 2MP)
 The color depth, in this case "24 bit" which is sometimes called true color.
 The original resolution of the image, in these cases 96dpi
The BITMAP GALLERY always contains a default bitmap, with the gray default image. This
is used as the default bitmap for bitmap fills and in cases where other bitmaps are
missing. It's useful to have as a placeholder as well.
As with all galleries, you can drag the objects from the gallery onto the page to create a
new copy. Or you can select an image in the gallery and click one of the buttons across
the top. The following section details the operation of the BITMAP GALLERY controls, most
of which are for the more advanced user.

Photo Handling
Filling shapes with a bitmap
Select the shape on the page, then select the bitmap in the gallery and click the fill
button. Alternatively drag the image from the BITMAP GALLERY and drop it onto any shape
while holding "Shift". You can adjust the size, angle etc using the smart photo adjustment
handles.

Setting a Bitmap Transparency
This is for the more advanced user. You can use any bitmap as a transparency mask on
any filled shape or bitmap. The lightness of the bitmap affects how transparent the
selected object is. The bitmap transparency size, rotation and tiling can be controlled
from the TRANSPARENCY TOOL InfoBar.

Deleting images from the Gallery
When you delete a bitmap from the page, it remains in the BITMAP GALLERY . Any unused
bitmaps will be deleted from the file when saved and re-opened. However you can force
the deletion of any bitmap by selecting it and pressing the DELETE button. If the bitmap is
used in the document, it will be replaced by the standard X bitmap.

Setting the page background to a bitmap
Select the bitmap in the gallery and click the BACKGROUND button. This reveals a menu
allowing you to choose between setting the PASTEBOARD BACKGROUND or the PAGE
BACKGROUND . When setting the pasteboard background, if the image is narrower than
the page, it’s assumed you want to have the image tiled to fill the whole browser
background. Otherwise the image is applied single tiled. You can change these settings
by right clicking on the pasteboard and looking under the Pasteboard Background submenu.
You can also apply an image to the background without using this gallery – just right click
on the image and see the options in the context menu.
See Website Backgrounds (on page 431) for more information.

Save
Select the bitmap and click SAVE will save the original image. In the case of an
embedded JPEG this will save the original JPEG file. Other bitmap types are best saved
as PNG bitmap type.

Bitmap Properties
The PROPERTIES button will display information about the selected bitmap in the gallery. It
also provides a way to stop image smoothing when bitmaps are enlarged. Usually all
bitmaps are smoothed when enlarged, or zoomed into, on screen. There is a check-box
option in the Properties dialog to turn this feature off, so that individual pixels are visible
when you zoom in.
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Note that this option only affects scaled up bitmaps. Note also that
VIEW tab of the OPTIONS dialog box overrides this check box.

NEVER SMOOTH

in the

It also provides information about the Animation properties of the bitmap. This is only
really applicable to animated GIF images
GIF ANIMATION:




(the time this frame is left on screen)
The Animated GIF Restore setting sets what happens between each frame
in an animated GIF. Nothing means no action is taken. Many browsers take this as
meaning the same as the Leave As Is option. Leave As Is displays the frames one on
top of another - this leaves many frames visible in a stack if some are transparent.
Some browsers clear the animation before it loops again, some do not. Background
restores the area covered by the graphic to the background color of the GIF (usually
white). Restore Previous restores the area covered by the frame to what it was before
the frame was displayed. This is interpreted by some browsers to mean that the frame
should be cleared to the background before each frame is displayed and by others to
mean that the frame should be shown on top of the previous frame. As browsers
interpret these values in different ways, you may need to experiment to achieve the
desired result.

DELAY

RESTORE:

Embedded JPEG files
JPEG files are hugely compressed from their original state, being up to 10 times smaller
than the original uncompressed image. In the above example, the original
uncompressed image requires more than 7mb of memory, but as the BITMAP GALLERY
shows, this JPEG file is only 1mb. A very significant reduction. This is why JPEG images
are the standard file type for digital photography and use on the web.
When you drag and drop a JPEG file (or use the "Open" or "Import" menu options) the
JPEG (reduced in size if it was large) is stored in the document, and this is what is saved
in the .xar file when you save your document.
It's important to understand how this differs from other graphics tools, both vector
drawing software and photo editing programs. Other products will typically un-compress
the image and store the un-compressed "raw" image in memory and the native file when
you save to disc. What's more each copy you make is typically a complete copy of the
original raw image, as mentioned above. Make four copies of your photo and save your
file - it will be four times larger. In Xara Designer Pro X the file is no larger, no matter how
many copies you make.
So by embedding the JPEG file instead of saving the un-compressed image, that's a file
size saving of more than 7:1 compared to other graphics editors. The fact that there are
four complete copies of the image means that in this particular case the memory used is
more like 30 times less. So this represents a huge file size (and time) saving over other
graphics tools*.
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*This is easy to test. Import a JPEG into your favourite graphics editor, make four copies,
perhaps change each one slightly, to be colored or blurred or rotated. Then save the native file
and compare it against the original JPEG size, and the equivalent .Xar file. A .Xar native file is
about the size of the original JPEG, no matter how many copies of the ima ge are made.

Extracting the original JPEG
Right click on any image in the BITMAP GALLERY and select the SAVE menu option to
save the original JPEG back to your file system.

Blending & Merging photos
By making copies of photos on top of each other, and applying different effects to the
copies, combined with Designer Pro's advanced transparency controls, you can easily
create blended photo compositions. For example to selectively blur parts of a photo takes
a few seconds.

By placing the blurred copy with the 'hole' created by the transparency effect over the
sharp original, the blended result shows the sharp face area through.
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Creating copies of any object requires a single key press, or click (drag with right mouse
button). Blurring a photo takes a single drag on a blur slider of the PHOTO TOOL , applying
a gradated transparency is just another click-drag in the TRANSPARENCY TOOL , and finally
positioning the photos on top of each other takes a second. So the whole process takes
a few clicks, drags and just a few seconds in Xara Designer Pro X.

An Example Using a Photo Region

The left picture is rather under exposed on the right side of the girl's face. The version on
the right has had just the right side of her face brightened.
These are the steps to re-create this effect:
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Select the REGION PAINTER TOOL from the PHOTO REGIONS AND MASKS flyout, and paint
over the region you want to adjust. It doesn’t need to be especially accurate. It’s usually
best to make the region slightly larger than the area you want to adjust because later we
will use feather to blend the edges.
The selection region is shown with an animated ‘crawling ants’ outline.
Now select the PHOTO ENHANCE (on page 364) tool and adjust the brightness slider (you
can also adjust contrast, saturation, temperature and blur/sharpen).

This is what the photo now looks like, with a rather obvious brightened area. Using the
Transparency tool you can adjust the strength of the effect.

In this example the transparency has been graduated across the area, so the effect
fades right to left.
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Just select the TRANSPARENCY TOOL and adjust the main transparency slider. To create a
graduated fade like in this example just drag across the image in the TRANSPARENCY
TOOL . This shows an arrow indicating the direction and size of the graduated
transparency. You can adjust this by just dragging either end of the arrow and you can
adjust the strength of the effect at each end using the transparency slider.
The final step is to blend the edges of the brightened area with the
175) tool. This gives the final result as shown top right.

FEATHER

(on page

Note: The region or mask is an editable vector shape and you can edit the vector outline
to be as exact as you want. But using the Feather effect to blend the edge means you do
not have to be that exact.
Secondly, as with most tools in Designer Pro, these are non-destructive edits. Not only
can you adjust the effect (and the region it covers, or any enhance effects) at any time in
the future, but you can delete the effect to restore the original image.

Photo display quality

Xara Designer Pro X can display photos in one of five useful quality levels. The top two
settings smooth the screen pixels so avoiding visible pixels or rough sections along the
edges (anti-aliasing). Change the quality level using the QUALITY entry in the WINDOW
menu.
VERY HIGH
QUALITY
(DEFAULT)
HIGH QUALITY

FULL COLOR

OUTLINE WITH
BLEND STEPS
OUTLINE

Displays images using bicubic sampling. This displays images at the
best quality, particularly for large hi-res images that are scaled down
or zoomed out a lot.
Anti-aliasing on, but images are rendered faster and at lower quality.
No anti-aliasing, thus showing individual pixels. This can be useful
when you're zoomed in and you need to clearly see the separate
image pixels. The downside is that images generally look poor
when reduced or enlarged resulting in clearly visible pixelation and
jagged "staircase" edges, especially if you rotate the image.
Is particularly useful for seeing outlines of the various steps of a
blend. Blends are not supported in Xara Designer Pro X but
imported .xar files could contain blends.
Only object outlines are shown. This is useful for finding and
selecting objects that are difficult to see due to other objects in front
of or behind them.

There is an additional control that allows you to stop all image smoothing or anti-aliasing
on images that are scaled up or zoomed in. In other words, instead of a smoothed image,
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you see all the pixels when zoomed in. Open the BITMAP GALLERY and right click on the
image and select "properties". In the dialog un-check the "Smooth when scaled up"
option. Now, no matter what viewing quality you select the image (and all copies) will
always show the un-smoothed pixels when enlarged or zoomed in.
Note: If you use the PHOTO TOOL sharpen / blur control then images have to be displayed
at maximum quality. So if you think the viewing quality has stopped working, it's almost
certainly because you have sharpened or blurred the image with the PHOTO TOOL .

Saving & Exporting Photos
Selecting the SAVE option will always save a native .xar file file (unless you’re editing a
Photo document – see Photo Document section below). To save a photo as a JPEG,
PNG or other image file type, it's necessary to use the EXPORT option, or the shortcut
"Ctrl + Shift + E".
You may select from a very wide range of file types, such as JPEG, PNG, GIF, TIFF,
PDF, PSD, Flash (.swf), BMP, as well as other lesser well known types.
There are two icons available on the top bar that are short-cuts to save
the selection as JPG or PNG. These are in the flyout bar shown when you
move the mouse pointer over the Export HTML icon.
For photos we recommend saving as JPEG (sometimes called JPG) as this offers the
greatest compatibility and the best size / quality compromise.
When you export a JPEG or PNG, there is a Settings option on the Save Dialog.
Selecting this provides many advanced export options, as well as compare side-by-side
alternative settings or even alternative file types such as PNG.
When you export a JPEG, an export preview dialog is shown where you can adjust many
export options, as well as compare side-by-side alternative settings or even alternative
file types such as PNG.
The Export Preview dialog allows you to adjust the size, resolution, JPEG quality and
even select from 3 alternative export file types if you so wish. The default values should
be fine for all normal purposes and you can just click the export button to save your
photo.
Things to remember when exporting:
 First select the object or objects you want to export
 The default exported size of the image will be the size you see on screen at 100%
zoom.
The Export Preview dialog (on page 596) is described in more detail here.
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Tip: You can control the JPEG quality in the Export Settings dialog on the Options tab.
The default and recommended value is 85%
The JPEG system is designed so that a setting
of 85 is the optimum value. We recommend
you do not save JPEGs at 100% quality, as the
results are visually identical to the 85% quality,
only the file size and memory use are
dramatically increased with no benefit.

When saving for use on the web it's quite possible to reduce the quality below 85 to
increase page view speed. The preview window shows the quality of any value you
select.
Tip: If you expect you may want to perform any further edits on your exported image, for
example to create the image again at another size, we strongly recommend saving the
.xar file as well. This will preserve the lossless master image along with all its edits and
changes.

Example: To resize a photo and save as a new JPEG
This process is very quick and simple:
 Drop your photo onto Xara Designer Pro X (either onto a blank page or onto the title
bar to create a new document)
 In the Selector Tool either drag a corner handle to resize the image, or enter the
required width or height into the "W" or "H" field on the InfoBar. Check the image size
is correct at 100%
 Type "Ctrl + Shift + E" to start the export process
 Enter a filename, and ensure JPEG is selected from the file type dropdown
 In the preview dialog simply click the export button
To save any image as a PNG go through the same process except choose the PNG file
type.

Photo Edit Attributes
All edits performed using the PHOTO TOOL (on page 364), such as any altering of the
brightness, contrast, color, blur or sharpen values, or even the more advanced levels
adjustment, are all just stored on the photo as attributes. See the terminology section (on
page 16).
Just as you can alter the color of a shape or line without altering the underlying shape, so
Photo Tool attributes alter the visible appearance of the photo without affecting the
original image (this is called non-destructive editing). Another way of looking at this is
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that Xara Designer Pro X just stores a list of edits applied to your photo, and you can
change, remove or add new edits. You can always recover the original untouched photo,
even after the brightness, resizing, even clipping or cropping.
Attributes can be copied and pasted between objects. Not only does this apply to
traditional attributes such as line color and thickness, it also works with all the PHOTO
TOOL attributes including the LEVELS settings. So this means you can easily copy all the
enhancements made on one photo to any other using the copy / paste attribute feature.
For example to apply the same white balance adjustment (made using the levels control)
to another photo, just copy the edited photo to the clipboard and then select the "EDIT ->
PASTE ATTRIBUTES" menu on any image to which you want to apply the same
corrections.
This also applies to some other attributes of the photo, such as line width and shadows,
etc.; all these can be copied from one photo to another using the same technique.

Editing the outline of Photos
You can use the SHAPE TOOL (on page 152) to directly adjust the outline shape of a
photo. Similarly you can apply outlines the same way as for any shape, and shadow,
etc.
Using the SHAPE TOOL you can push or pull on the
sides. This example also has a black outline and
soft shadow added. To restore the image back to
its original rectangular shape, select the "Un-clip"
in the clip mode of the PHOTO TOOL InfoBar.
When photos are edited this way, they are treated
like any normal vector shape, containing a bitmap
fill. This is why you can use the normal line and
shape editing features, and indeed you can use the
Photo adjustment handles (on page 351) to adjust
the size, angle and position of the photo "fill" inside
the shape.
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Cropping photos
The easiest way to crop a photo is to just drag on one of the smart photo
adjustment handles (on page 351) which appear when you select a photo using
the Photo tool or the Selector Tool. Simply hover over one of the handles to see a
function information flag.
For more advanced cropping control, select the CLIP BUTTON on the PHOTO TOOL
flyout bar which provides aspect ratio control and precise numeric clipping control.
This also provides an Un-clip button that will remove any clip rectangle and restore the
original image.
One important feature is that this crop feature is really a dynamic clip, in other words it's
a non-destructive crop, and you can adjust the crop boundary afterwards to reveal
hidden parts of the photo. If you want to really crop - i.e. make this a destructive crop,
that really removes the invisible parts of an image then use the Optimize Photo feature.

Cropping photos with the Eraser Tool
The ERASER TOOL (on page 401) lets you crop a photo by dragging a nib over it. If you do
this with the softness setting set to 0 (hard erase), the crop is permanent, just as when
using the clip tool discussed above. Although you can put back erased parts of the image
using the SHAPE PAINTER TOOL (on page 132).
If you use a soft nib with the erase tool you get soft edges wherever you erase.
Technical note: This is achieved by applying an Opacity Mask to the image – see the
Transparency Tool Chapter for information on Opacity Masks.

Cropping photos with a mask
If you want to make non-rectangular photo shapes or cut pieces out of a photo, use a
mask. First select the photo and then choose the MASK PAINTER TOOL from the Mask
tools flyout bar.
Use the MASK PAINTER TOOL to paint around the section of photo you wish to
crop.
Switch to the SELECTOR TOOL and select the photo underneath the mask, or clear the
selection (press "Esc"). Now if you copy ("Ctrl + C") you will copy just the unmasked part
of the photo to the paste buffer. Hit "Delete" and you'll delete the unmasked part. Or
press "Ctrl + X" to cut it. You can also use the mask to apply "ARRANGE " > "COMBINE "
shapes operations with it.
See the Photo Regions and Masks chapter for more information on using masks.
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Magnetic Lasso

The Magnetic Lasso allows you to semi-automatically trace around objects in a photo to
create a region. Once the region has been created you can copy or cut the object out, or
apply an effect, or enhance the region.
Find the tool on the Photo Regions and Mask Tools (on page 308) flyout.
The tool is on by default - but you can toggle the auto-trace properties on or off using the
toggle button on the InfoBar or by pressing T on your keyboard. Click the ? button next to
the MAGNETIC LASSO toggle to bring up a step by step guide.

Magnetic Lasso InfoBar

Smoothing
Invert/clear outline
Show/hide outlines (Ctrl + H)
Toggle Lasso on/off (T)
Help guide

Tracing
To start - trace a dotted line around the edge of an object in your photo.
There are two ways to do this - Click and drag around the edge. Start on the edge you
want to follow. As you drag around the item you’ll see the dotted outline snapping to any
nearby edge. You can press Shift to erase back along the path if things go wrong.
Additionally pressing the space-bar will ‘anchor a point’ at the current pen position.
Pressing T while dragging this way will toggle the magnetic snap off or on.
Alternatively - click on the edge - then click again a short distance further along, to trace
the edge between the two click points. Continue clicking around the edge to trace around
the object.
If at any point the dotted line misses the edge you wanted to follow, hit Backspace or
Undo (Ctrl+Z) to undo the last click point. Then zoom in and click closer to the last point,
on the edge you want the trace to follow. You will need to move in smaller steps along
any parts of the edge that are less clearly defined, but where the edge is clear against
the background you can move along the edge in much bigger steps.
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For both methods, pressing the Alt key while clicking or dragging will draw a straight line
section from the last point to the current position. Pressing T will toggle the magnetic
aspect off or on. With no Magnetic snap, then dragging acts exactly drawing with the
Freehand tool. Clicking with no magnet snap will just add a straight line segment to the
current point.

Following the photo edge
Sometimes you may want the outline to follow the edge of the photo. To do this, click just
outside the photo edge.

Finishing
When you get back close to where you started, click on the start point again to complete
a closed outline (the mouse pointer will change to show a + sign when you are over the
start point) .
Once you have a complete closed outline, you can now copy (Ctrl + C), cut (Ctrl + X) or
delete the selected part of the photo. You'll notice that as you perform the operation the
SELECTOR TOOL is automatically selected.

Feathering
Once you have cut out an object, you can usually improve the edges by applying a small
amount of feathering (on page 175) using the feather control on the top InfoBar.
Magnetic Lasso works well on images where there is a high contrast between the object
you want to cut out and its background. Also if you have an image with lots of fine detail like hair or fur for example then you will get a better result if you use the Background
Erase (on page 402) feature instead.
Photo cut out, cutout, magic lasso

Screenshots
In combination with a built-in screen capture feature you can easily capture and create
screen shots.You can either use the SCREEN CAPTURE UTILITY which is included in Xara
Designer Pro X or use the screenshot capability built into Windows.

Using Windows to capture screenshots
 Press the "Print screen" button on your keyboard. This places a screen capture of the
whole screen on the clipboard. Alternatively, select "Alt + Print screen" which will
capture just the current window.
 In Xara Designer Pro X select "Ctrl + V" to paste, and select "Bitmap" to have the
results pasted onto the page.
You can now crop, add text annotation, resize as required and save the results. It's best
to save this type of image as a PNG file.
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Screen capture utility
This utility offers some advantages over the method above, including the option to
capture the mouse pointer in the image. Open it by choosing UTILITIES > SCREEN
CAPTURE.

Here you can choose the screen area you would like to capture. You can
capture the full screen, the active window in its entirety, or just the content of the active
window without the window border.
SCREEN AREA:

Here you can choose whether or not the mouse pointer is included in the
screenshot. Also choose whether you just want to capture one screenshot or whether to
keep the utility turned on for the session so you can take successive shots each time you
press the assigned key shortcut.
OPTIONS:

The output section lets you choose how to handle the captured screen image. By default
it will be directly inserted into the current Xara Designer Pro X design. Alternatively you
can also save a BMP (Windows Bitmap) or PNG file for each screenshot into any folder.
The files created are named "ScreenCapture", "ScreenCapture1", "ScreenCapture2", etc.
Choose the TARGET FOLDER for the files using the BROWSE... button.
You can define almost any hot-key combination (Shift, Alt, Ctrl + key) to trigger the
screenshot. Just click in the key shortcut field and then press the desired key
combination, e.g. “Ctrl+S”. The chosen shortcut appears in the key shortcut field. If it
clashes with any defined Designer Pro shortcut, you'll be warned with a message
appearing at the bottom of the dialog, but this doesn’t matter if you will have other
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windows active when taking the screenshots. Press
selected shortcut.

RESTORE

to return to the previous

Instead of using a shortcut key to take the screenshot, you can instead use the TIME
option. This is useful in cases where any keyboard activity can change the display you
want to capture, such as a pop-up tooltip which may disappear if you were to press a
key. Select the time option and enter a delay value in seconds. The screenshot will then
be taken for you automatically once the specified period of time has elapsed. The timer
starts as soon as you click the START button.
Pressing the START button closes the Screen capture dialog and activates the systemwide hotkey. Switch to the window you want to capture and press the chosen key
combination, or wait for the chosen time period to elapse if the timer option was chosen.
The screenshot is taken and inserted into Designer Pro or saved to file, depending on the
option chosen. If you selected the “Capture always” option you can take additional
screenshots by pressing the key combination again (this is unavailable with the timer
option). To deactivate the utility if you chose this option, close down Xara Designer Pro X
to end the session. Alternatively return to the Screenshot dialog, choose the “once only”
option and take one more screenshot.

Coloring photos
With any photo selected just click on the Color Line to apply a color to any photo.
Clicking the white color patch will turn the image black and white. Technically this is
called a "contone" (it's a continuous tone from black to white), or sometimes a "duotone".
Simply click a pale yellow color on the color line to create a yellow contone picture.
Or, right click on the Color Line which shows a context menu for you to apply the
selected color as either the light or dark color.
You can also use the color
editor to select any color
as either the light or dark
contone colour. Right click
the photo and choose
CONTONE > LIGHT to
display the color editor
("Ctrl + E"). Select the light
or dark contone from the
dropdown menu at the top
of the color editor.
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You can restore the original color of a photo by clicking the cross-hatched "no color"
patch on the left of the Color Line, or right clicking on it and selecting the "Restore color"
option.

You can also use the ENHANCE TOOL to provide a direct and very fast way of adjusting
the brightness, contrast, color adjustment levels and sharpening of photos, You can also
adjust the individual colors and tints within a photo as well as the shadows and highlights
- even for ultra high-resolution images.

Photo Filter Presets
The PHOTO FILTER PRESETS allow you to instantly apply professional photo effects to your
photos. Find the filters in the Content Catalog under "COMPONENTS" > "IMAGES
RESOURCES" > "PHOTO FILTER PRESETS" . They are grouped into categories and there is a
wide range of moods and themes to choose from.

Some of the Photo filter presets in the Online Content Catalog

To apply a filter to a photo, first select the photo and then click the IMPORT button on your
chosen filter in the Catalog. The preset filter is then applied to your photo and also
imported to your LOCAL DESIGNS GALLERY .
Note: You can keep the Catalog open after an import by holding down the Shift key as
you click the Import button. Useful if you want to try a range of filters.

Using presets from the Local Designs Gallery
Once you’ve imported one preset, you can optionally download all the presets to your
Local Designs Gallery, for easier access.
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Right click on the "COMPONENTS" > "IMAGE RESOURCES" > "PHOTO FILTER PRESETS"
folder in the gallery and choose DOWNLOAD ALL . Re-open the folder and now you can
drag and drop any of the effects onto your photos, or select the target photo and double
click an effect in the gallery.

Using multiple filters
There are multiple different ‘classes’ of filters and overlays that can be applied together.
The set of filter presets is divided into two folders under "COMPONENTS" > "IMAGE
RESOURCES" > "PHOTO FILTER PRESETS" . The FILTERS folder contains presets that affect
the overall look of your photo. It would not be useful to apply more than one of these
presets to a photo and so these will replace each other. In other words, only one of these
presets can be applied to a photo and applying a second will automatically remove the
first.
However the OVERLAYS folder contains various different classes of presets that can be
applied in addition to any of the presets under the FILTERS folder.

This photo has had the "Softlight" filter effect applied from "Filters" > "Effects" and also the
"Stripes" pattern, from "Overlays" > "Patterns".

Each of the presets in the same sub-folder under OVERLAYS will also replace each other,
because it wouldn’t be useful to have for example two different patterns applied. But you
can mix presets from each of the other folders under OVERLAYS as much as you like. So
you could for example apply a check pattern from the PATTERNS folder, a texture from the
TEXTURES folder and a transparency effect from the TRANSPARENCY folder all to the same
photo.

Replacing photos and removing presets
If you drop a replacement photo onto a photo with a filter applied the filter preset will be
maintained. And if you have any existing photo edits in place, for example if you used the
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or PHOTO HEAL (on page 377) tools then the applied filter will merge with these
edits too.
RED EYE

When you right-click on a photo, you will see a PHOTO FILTER option in the context menu
that appears. This option has a sub-menu, which allows you to apply filters to your photo
and remove filters that are already applied.
The APPLY FILTER… option opens the CONTENT CATALOG onto the PHOTO FILTER PRESETS
folder so you can apply a filter to the selected photo. Following this option in the menu,
you will see REMOVE options for each of the filters you currently have applied to the
photo, so you can remove any of them.
The final option in the menu allows you to clear all applied filters from the photo.

Editing Photo Filter Presets
Most of the preset filter effects modify the image by adjusting the same settings that you
see in the PHOTO TOOL and the BRIGHTNESS LEVELS DIALOG . Therefore remember that
applying an effect may remove any photo enhancements you have applied manually
beforehand, using the PHOTO TOOL . Similarly if you apply a preset filter and later adjust
the settings in the PHOTO TOOL , if you later remove the preset it may also remove your
enhancements.
Similarly, the overlay effects under "OVERLAYS" > "TRANSPARENCY" work by applying
transparency effects to your photo directly. You can see and modify these effects by
selecting your photo and going into the TRANSPARENCY TOOL.
Applying presets to your photo and then examining the settings in the PHOTO TOOL and
BRIGHTNESS LEVELS DIALOG is a great way to learn about the capabilities of the PHOTO
TOOL .

Integration with external Photo Editors
While Xara Designer Pro X provides a great many photo editing and compositing
features, it is not a "pixel editor", and for these purposes you may want to use a separate
program. Xara Designer Pro X makes integration with these easy. You can configure any
external program to be launched when you double click a photo while in the Photo Tool,
and after editing, for the photo to automatically be transferred back into your Designer
Pro document.
Double clicking a photo when you are not in the Photo Tool, selects the Photo Tool so
you can edit the photo using Xara Designer Pro X’s integrated editing features. Double
click the photo while in the Photo Tool to invoke the external editor.
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To choose an external editor, select the PHOTO EDITING tab in the Options dialog.

XPE is a basic picture editor. Most of its functionality is now provided by the Photo Tool
directly and so this tool provides little benefit. It's here mostly for back compatibility
reasons.
Alternatively, if you select the "Edit bitmap with this program" option and browse to select
an external program, then this can be launched by double clicking on any image when in
the Photo tool (you will probably need to browse to your program files folder on your local
hard drive and select the program executable .exe file).
It should be understood that images transferred to and from external editors are
transferred as uncompressed images (to avoid compression / decompression cycles)
and so this will increase the file size of your .xar file.
When editing a photo in a separate program in this manner, you can carry on using Xara
Designer Pro X as normal. Each time you save the image from the photo editor (or just
close the program and click the Save option) Xara Designer Pro X will automatically pick
up the changed version and replace the original image. This means you can just continue
editing the photo in the external program, and to see how this looks in context in your
Designer Pro document, just click "Ctrl + S" (or whatever the normal saving shortcut in
your photo editing software).
Note: Xara Designer Pro X always sends the original un-clipped whole photo to the
external editor. Any images that are enhanced (e.g. brightness altered) or clipped with
the photo clip, or have any live effects applied, will have these changes missing when
you edit them this way. However, when the edited image is returned, the clip and photo
attributes are re-applied to the edited image. For this reason, it's not recommended that
you alter the size or crop images in an external editor.
You can, of course, Undo any external edits you've applied by using the usual Designer
Pro Undo feature (it always stores a copy of the 'before' image). However when you save
and re-open the .xar file all Undo information is lost.
Editing images this way is a destructive edit. i.e. the image is permanently altered by the
external Photo Editing Tool, and the original cannot be recovered once the file has been
saved and closed.
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Resize, rotate and position a photo within its frame

The shape of your photo is really a fully editable outline around the image contained
inside. So when you crop, or edit the outline shape, you're not affecting the fill, which is
clipped inside the shape.
Photos and bitmaps on the page are always contained within an outline shape. Not only
can you change the shape of the outline, you can also adjust the scale, rotation and
position of both the photo and its frame using the smart photo adjustment handles, which
provide a quick and easy way to perform the most common photo editing tasks.
The handles automatically appear whenever you select a photo with either the Selector
Tool (on page 122), the Photo Enhance Tool or the QuickShape Tool.

For example, to scale, rotate and round the image on the left, just drag on the
appropriate adjustment handle. A little info flag will appear as you hover over a handle.
As you drag the handles to adjust an image, a 'ghost' copy of the full uncropped image is
shown behind. This makes it easier to make adjustments because you can see parts of
the image that fall outside the crop area, as you drag the handles.
 To rotate and scale drag on the white circular top right icon - the degree of rotation is
displayed
 To move the image within the frame drag the "hand" icon on the bottom left
 To round the frame edge drag the orange corner handle
 To rotate the entire frame drag on the blue circular top right icon
 To scale the frame drag on the bottom right + handle (hold down the shift key to scale
the image from the center)
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To reset a photo back to it’s ‘best fit’ state, double click on the rotate/scale handle. To
centre the image in its frame, double click on the “hand” icon. The handles on the edges
of the photo allow you to change the shape of the photo frame (hold down the shift key to
resize around the centre). These operations are smart and the image inside is
automatically cropped, scaled or moved in order to preserve the correct aspect ratio.
Double click any of the edge handles to change the frame to fit the whole photo exactly.
These smart photo operations also work with photos of any shape, not just rectangular
photos, and unlike the Fill Tool they also work with PHOTO GROUPS (on page 323) and
CLIPVIEWS (ON PAGE 104).

For more control over cropping use the CLIP TOOL

"Smartphoto handles", "Photo handles" "Smart photo" "Adjustment handles"

Horizon Straighten

Using the smart photo adjustment handles as previously described it's easy to straighten
the horizon of an askew picture.
 Select a photo - this will show the adjustment handles, which allow you to scale, rotate
and position the fill inside the shape.
 Drag on the rotation handle to rotate and scale as required.

Photo Handling
The following shows a landscape (created using the panorama stitching feature of
Designer Pro) that has a sloping horizon.

Drag on the adjustment handle (circled) to rotate and scale the photo within the frame the degree of rotation is displayed. You can also reposition the photo within the frame
using the move photo "hand" icon (bottom left).
The handles on the edges of the photo allow you to change the shape of the photo
frame. Again these operations are smart and the image inside is automatically cropped,
scaled or moved in order to preserve the correct aspect ratio. Double click any of the
edge handles to change the frame to fit the whole photo exactly.
To reset a photo back to it’s ‘best fit’ state, double click on the rotate/scale handle. To
centre the image in its frame, double click on the “hand” icon.
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Viewing a scaled photo at its full size

The ZOOM TO 1:1 button on the PHOTO TOOL InfoBar adjusts the zoom so that the selected
image is shown at full size, which is where each pixel of the image is mapped to each
screen pixel. This is useful if you want to edit an image that’s been scaled down on the
page, but want to see it at its full size while you work on it.

Making a photo its full size

The SCALE PHOTO TO 100% button on the PHOTO TOOL InfoBar takes the currently
selected photo and scales it to its full size on the page. So for example if the selected
photo is scaled down to 500 pixels wide, but the original imported photo was 1000 pixels
wide, the photo on the page will be scaled up to 1000 pixels wide. When the document
zoom is 100%, that means that each pixel of the image is mapped to each screen pixel.

Optimizing Photos and Bitmaps
With the ever increasing resolution and file size of digital camera JPEGs, if you have a
document containing many images, the file size can quickly become very large. For
example, a multi-page document containing 20 full resolution JPEGs, each of 5mb,
would produce a .xar file of over 100mb*.
Furthermore, these photos are often unnecessarily high resolution. Reducing a photo
from a 8 megapixel digital camera to be 2 inches (5 cm) wide on the page will result in
this image being around 1500 dpi. Whilst a very high resolution image gives greater
flexibility for printing (and you can zoom in, or enlarge small parts of the photo), this is far
higher than required for even the best quality commercial printing, and even more so for
web graphics or HTML production.

Photo Handling
If you clip to a small part of the image, or cut-out only a small part of your photos, there
could be large parts of hidden image outside the visible area. For editing purposes this
"live crop" is a great feature, as you can un-crop, alter the size, position and scale and
everything remains as sharp as possible. But for finished documents you may want to
remove the invisible parts.

The cut-out butterfly image still has the rest of the photo attached. If you go into the FILL
TOOL you can easily see this by resizing the fill inside the outline. So the parts of the
image outside the butterfly will probably be superfluous in your final document.
Right click a photo and choose OPTIMIZE PHOTO or choose "UTILITIES" > "OPTIMIZE
PHOTO..".. This dialog performs three important functions:
 Removing invisible parts of photos
 Reducing resolution of photos
 Converting PNG or bitmaps to embedded JPEGs to optimize file size
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Selecting this menu option for any bitmap will display the OPTIMIZE PHOTO dialog.

The default resolution depends on the type of document you are working on:
 192 dpi
 150 dpi
 96 dpi

Web documents with Retina hi-definition images.
Print documents.
Other documents.

When optimizing non-JPEG images, Designer Pro will automatically decide whether it’s
best to optimize to a PNG or JPEG, depending on the nature of the image itself.
You can click the SETTINGS button on this dialog, if you want to change any settings such
as the image format used for the optimization, JPEG quality, etc.
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You can change the resolution used in this dialog, by either choosing the physical size
you want for the optimized image (width/height in pixels), or by entering a different dpi
(eg. perhaps 150dpi if you want print quality).
If you choose the dpi option the value you enter is remembered and becomes the default
just for the current session. You can also maintain the photo's current resolution by
choosing CURRENT from the PPI list.
You can also choose to optimize as a PNG (produces much larger images, but better
quality for graphics and text images) or change the quality used for JPEG optimization
(higher quality means larger JPEG sizes).
If your photo is cropped, only the visible part of the image is preserved in the optimized
image.
For printing, a photo resolution of 150dpi gives very good results, whilst 300 dpi will
provide the highest quality commercial printing (most people cannot tell the difference
between 150dpi and 300dpi, but the 300dpi requires four times as much memory or file
space).
Warning: "OPTIMIZE PHOTO " is a "destructive" operation. When you save the file the parts
of the image removed are lost, and the resolution changed permanently (you can of
course undo the changes while the file is open for editing).
You can optimize multiple photos at once if you want them to all have the same dpi.
Select the photos you want to optimize and then choose the OPTIMIZE operation as
described above. If your photos have different dimensions, the option to optimize by
pixel size is disabled and you must just choose the required dpi.
Or you can use the "UTILITIES" > "OPTIMIZE ALL IMAGES" facility to optimize all the bitmap
images in your document in one operation.
The optimization process will convert large non-JPEG images to smaller JPEG images if
it decides that the image can be stored and exported as a JPEG without an unacceptable
loss in quality.
Note that after optimizing the original unoptimized and now unreferenced photo remains
in the BITMAP GALLERY (ON PAGE 331). This means it is still in memory and so the memory
requirements of your design will not have been reduced. Simply save your design and
reload after optimizing, to eliminate the original large images.

Converting objects or drawings to bitmaps
You can easily create a bitmap from any object, or part of your drawing, including from
other bitmaps. The bitmaps can be any size or resolution and can contain transparency.
You can also create bitmaps with reduced numbers of colors which can be useful for web
use.
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To create a bitmap from objects:

1.
2.

Select the object/s on the page.
Right click and choose CREATE BITMAP COPY or choose CREATE BITMAP COPY from
the ARRANGE menu ("Ctrl + Shift + C").

3.
For maximum quality select a color depth of true color, or if you want transparency to be
included select "true color + alpha" (alpha transparency is the technical term). You can
create bitmaps with fewer colors by selecting a color depth of 256 colors or less. This
also provides control over the dithering and palette options. These options are described
in the section on exporting bitmaps (on page 596).
Note this always creates PNG images, which are the highest quality image type.
However for full color photo purposes, these require a lot of memory and file space. Use
the optimize photo option to convert PNG images into embedded JPEG images to
reduce the file size.

Photo Documents
Sometimes it's useful to work on one photo alone, rather than as "objects on a page".
This is called a photo document or "photo mode" in Designer Pro, and it behaves more
like a traditional photo editor. You can create a photo document in a number of ways:
 Drag a photo file from your file explorer onto the title bar or toolbar of Designer Pro
 Select "FILE " > "OPEN " and select a photo file
 Create a blank photo document by selecting "FILE" > "NEW" > "BLANK PHOTO"
Photo documents are characterized by the following behavior differences compared to
traditional Designer Pro documents:
 There is no visible white page. In fact the page dimensions are set automatically to
match the photo plus any other objects you've added.
 Photo documents have a 1 pixel grid by default and snap to grid is turned on. This
makes it easier to get pixel-accurate crop or clip regions.
 The Pasteboard (the area around the photo) is a darker color. This makes it easy to
distinguish at a glance between photo documents and drawing documents.
 The document zoom is set so that the photo fills the view and the PHOTO TOOL is
automatically selected as the current tool.
 Dropping additional photo files on top of an existing photo just adds a new photo to the
document instead of replacing the photo in its frame. And the view will zoom out so
you can see the whole image.
 Images are not resized to be 500 pixels on import as they are in normal documents,
but are imported at 1:1, so that at 100% zoom you're seeing the image at full size.
 The pixel smoothing options are altered. By default it selects the "Very high quality"
display mode, which is best for images scaled down or zoomed out. It also has pixel
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smoothing turned off when zooming in, so you can see the pixels are very large zoom
factors.
 If you’ve opened a JPEG photo file as a photo document, when you save changes
your JPEG file will be overwritten. See Editing Photo Files below for details.
In all other respects Photo Documents behave like normal Xara Designer Pro X
documents. You can use all the normal drawing and text tools as usual. If you want to
create a photo document of a given size, you can alter the "canvas" or page size by
selecting "UTILITIES" > "OPTIONS" and the "PAGE" tab and entering the required
dimensions.

In Photo Documents two extra controls become enabled. The PREVIOUS and NEXT button
will move onto the Previous or Next image in the folder from which this image was
opened. This will close the current image, so you may be prompted to save the file.

Editing Photo Files
You can use Xara Designer Pro X to easily edit your JPEG photos and save back the
modified JPEG. And unlike with most photo editors, you can do this multiple times
without loss of quality, even though the JPEG format is a lossy format. That’s
becauseXara Designer Pro X is able to save your edits in a lossless way, along with the
original photo. Here’s how it works.
First open the JPEG, using "FILE" > "OPEN" , drag and drop, or in Windows File Explorer
right click and choose Xara Designer Pro X from the "open with" list. The photo is opened
as a Photo document.
Edit the photo using the PHOTO TOOLS as described above.
If you then do "FILE" > "SAVE" ("Ctrl + S"), the JPEG file you loaded will be overwritten
with the modified image. However by default Xara Designer Pro X also saves your photo
in its native .xar format. This file is placed into a "Masters" folder alongside your JPEG
file. It has the same name as your photo file but with a .xar extension. The .xar file
includes within it your original photo without the modifications applied, and of course
details of your edits.
In future if you load the modified JPEG file in order to edit it further, Xara Designer Pro X
will look in the Masters folder to see if there is a .xar file available for that photo. If so, the
.xar file is loaded instead of the JPEG file and you can continue editing from where you
left off. When you next save, the JPEG file is again overwritten and an updated .xar file
also saved into the Masters folder.
Of course if you don’t want to overwrite your original JPEG file with your changes, you
can use "FILE" > "SAVE AS" , to save the modified photo elsewhere, or use the many
export facilities to export your photo into different formats.
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You can get hold of the original photo from the .xar file by opening it, opening the
GALLERY , right clicking on the photo and choosing the SAVE option.

BITMAP

In the Photo Editing tab of the "UTILITIES" > "OPTIONS" dialog you can choose to change
the saving behavior described above. You can choose to not have a .xar file
automatically saved for you into the Masters sub-folder, or you can choose to have the
original photo file saved there instead.
Note if you turn off this original photo preservation, you'll lose the original photo when you
do a Save!

Tracer
"UTILITIES " > "BITMAP EDITOR " allows you to trace a bitmap, converting it to editable
vector shapes. The tracer is typically used to trace two types of artwork-photographs and
simple line art or logos. The tracer can be used for either type of work and selecting the
correct trace mode is the easiest way to control this.

Original bitmap
Traced output view
Bitmap name
Trace mode
Initially, the tracer shows:

Photo Handling
 If there is a selected bitmap or, if you copied a bitmap from the
GALLERY , that bitmap.
 Otherwise, the default bitmap.

BITMAP

or FILL

You can select a different bitmap:
 From the dropdown list,
 From the BITMAP GALLERY (click the "TRACE" button), or
 By clicking on any bitmap in any Designer Pro document.
By default, the tracer does a "photographic" trace. That is, it produces a drawing with lots
of colored shapes to simulate the photographic bitmap being traced. If you want to trace
a black-and-white scanned bitmap, such as a logo or symbol, select one of the other
trace modes such as monochrome or 256 colors. These are optimized for producing
simpler but generally more precise tracings.
Click "INSERT" to copy the tracing into the document.
Click "TRACE" to start the trace operation.
Press "ESC" to abort a trace operation.

Trace mode
This lets you specify the maximum number of colors in the final object:





Monochrome-2 colors.
Grayscale-256 shades of gray.
256 color-256 colors.
Photographic-16 million (24 bit) colors.

Selecting more colors than exist in the original bitmap is usually not beneficial. The only
time increasing the colors is useful is when tracing a heavily dithered 256-color bitmap
and you want near-photographic quality.
Each of these modes can have different settings for passes, color tolerance and so on.
To restore the settings to their saved defaults click "RESET SETTINGS" .
To make the current settings the default, click "SAVE SETTINGS" .
To restore the settings to the factory defaults, click "DEFAULTS" .

Passes
(Range 1-5)
The greater the number of passes, the longer the trace operation takes and the greater
the resultant file size, but the final result is closer to the original.
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With each pass, the tracer attempts to more closely match any shading in the original
bitmap. Obviously, this increases the memory required for the final object. You may
require an object with minimum shading and just broad areas of color. Use one pass for
this.
Alternatively you may require color shading to closely match the bitmap. Use multiple
passes for this.

Remove noise
If you scan a photograph you often scan small specks of dust sticking to the photo's
surface. These produce "noise", or small, unwanted areas of a different color.
Also many bitmaps try to improve the look by "dithering" pixels and this introduces
unwanted noise (especially common for 256 or fewer color bitmaps).
When tracing 256-color bitmaps that are heavily dithered, you should set remove noise to
high (if you zoom into the bitmap in the document, you can see if it is dithered).
This control removes noise and dithering by ignoring very small areas of color.

Minimum area
Areas smaller than the size set in this control are ignored (size is in pixels). Examples are
scanned photographs with a lot of fine detail such as blades of grass.

Initial and final color tolerance
Color tolerance is how great a color change is required before the tracer considers two
areas to be of a different color.
Initial color tolerance is used for the first of multiple passes. It is similar to the broad
brush strokes used to create the underlying colors on a conventional painting.
Final color tolerance is used for the last pass. It is similar to merging the edges of color
transitions to simulate shading.
On multiple passes, the tracer gradually reduces color tolerance from the initial value to
the final value. Thus, initial color tolerance should always be set higher than final color
tolerance. On a single pass, only the final value has any effect.

Accuracy
This controls how accurately the tracer follows the outlines of the original bitmap. The
more accurately it traces the outlines, the more control handles are required on each
shape and hence the more memory is required for the final object.
This option has no effect on corners, only on smooth curves.

Photo Handling
Smoothing
This controls how accurately corners (sharp changes of direction) are traced. Increasing
the smoothing takes longer to trace the image but can reduce the final file size.
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The Photo Tools
Using the Photo Tools
To access the PHOTO TOOLS , move your mouse pointer over the Camera icon in
the main toolbar on the left of the window. A flyout bar appears with icons for
each of the available photo tools.

If you’re in the SELECTOR TOOL a double click on a photo will switch into the

PHOTO TOOL .

Common photo functions
The following buttons are available on the InfoBar when you are in the
RED EYE or CONTENT-AWARE SCALING photo tools.

ENHANCE , CLIP ,

Rotate by 90° controls

The two rotate icons will rotate the selected photo or photos by 90 degrees anticlockwise or clockwise.

Previous & Next

When you 'open' a photo using Xara Designer Pro X the photo is loaded into a new
Photo Document, because Designer Pro assumes you want to edit or view the photo
itself rather than use it as part of a drawing or other document. When you've opened a
photo you can use the 'Previous' and 'Next' buttons on the PHOTO TOOL InfoBar to close
the current photo document and open the next (or previous) photo in the same folder as
the current photo. This allows you to browse through the photos in a folder, without
having to open and close each one individually. If you've made any unsaved changes to
the photo you'll be asked if you want to save the changes when you press previous or
next.
See Photo Handling for more information on Photo Documents.

The Photo Tools
Zoom 1:1
Select a photo and click the Zoom 1:1 button.

The ZOOM TO 1:1 adjusts the zoom so that the selected image is shown at full size, which
is where each pixel of the image is mapped to each screen pixel. Use this option if you
want to work on a photo at full size in a document where you have scaled the photo
down.

Scale photo to 100%
The SCALE PHOTO TO 100% operation takes the currently selected photo and
scales it to its full size. It also puts the photo onto the pixel grid.
So for example if the selected photo is scaled down to 500 pixels wide, but the original
imported photo was 1000 pixels wide, the photo on the page will be scaled up to 1000
pixels wide. When the document zoom is 100%, that means that each pixel of the image
is mapped to each screen pixel.

Enhance Tool
Click the Camera icon to enter the ENHANCE TOOL .

The Enhance Tool provides a direct and very fast way of adjusting the brightness,
contrast, color adjustment levels and sharpening of photos, You can also adjust the
individual colors within a photo, even for ultra high-resolution images.
The tool provides:
 One-click auto-enhance your photos; this is particularly good for dull, underexposed
images.
 Manually adjust the brightness, contrast, color saturation, color temperature, hue, and
blur or sharpness of photos.
 Manually adjusts the brightness of the shadows in a photo.
 Manually adjusts the brightness of the highlights in a photo.
 Display a brightness levels histogram of your photo.
 Adjust the brightness levels curve for more advanced levels control.
 Correct color casts or white balance.
 Enhances the individual colors of a photo.
 A single-click "Compare" function to quickly compare changes against the original.
 Crop images. This is "live crop" so you can un-crop and adjust the crop at any time.
 Easy copy / paste all photo enhance edits between different images.

365

366

The Photo Tools
All these operations are interactive with live update. As you adjust the values, the image
is updated instantly. They are also all non-destructive, meaning that your original image
is not altered and you can always adjust or remove any adjustment.

The first six InfoBar buttons to the left (not shown above) are commo n to all tools and are
described above

Auto-Enhance
Brightness
Contrast
Shadows brightness
Highlights brightness
X-Process effect
Color saturation
Color temperature
Photo hue
Blur / Sharpness control
Compare current with original settings
Brightness levels dialog
Photo colors enhance
You can either enter values directly into the text fields or use a small pop-up slider for
adjusting the values interactively.

Pop-up slider controls
The pop-up sliders can be used in one of two ways:

1.

Click and release the pop-up arrow. The slider control now remains on screen and
you can adjust the values as many times as you like by dragging the slider control.
Alternatively, if the mouse is held over the control, the mouse-wheel can be used to
make small adjustments up or down. The slider will hide when you click anywhere
else in the document.

The Photo Tools
2.

Auto Enhance
Clicking the "ENHANCE" button will analyze the overall brightness and contrast of the
picture and automatically adjust the enhance values to obtain the best image. It is
particularly effective with under-exposed (dark) images. After applying automatic
enhancement to a photo you can adjust the values that were chosen, using the controls
to the right of the "enhance" button. Clicking the "COMPARE" button will restore the
original, clicking it again restores the last enhance values.

Brightness/Contrast/Color Temperature/Saturation/Hue
Brightness

Contrast

Saturation

Color Temperature

The image is altered as you adjust these values. The saturation alters the color intensity.
At the minimum setting of -100 this will make a picture black and white. The Color
Temperature control makes a picture more ‘warm’ or ‘cool’. The Hue control applies a
particular color tint to the image and allows you to control the intensity of the selected
color.
Hue
The HUE slider lets you choose
the color to apply and the
STRENGTH slider sets the
intensity of the color change
applied.

Shadows brightness

The Shadows brightness control allows you to bring out the detail in the shadows (darker
areas) of your photo without affecting the rest of the image.
The slider is initially positioned on the far left of the slider scale as it is assumed that you
would always want to increase the shadow detail.
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Highlights brightness

The Highlights brightness controls the intensity of the highlights (bright areas) in a photo.
This allows you to bring out the detail in the highlights which might not normally be
visible. Bear in mind though that there may be areas in certain photos which have all the
detail in the highlights "crushed" or totally burnt out, in which case the control will have no
effect.
The slider is initially positioned on the far right of the slider scale as it is assumed that
you would always want to decrease the intensity.

X-Process effect

Cross processing simulates a photographic processing technique which historically used
the 'wrong' chemicals to develop film - thus resulting in some dramatic contrast and
saturation effects. Designer Pro and other photo editing programs achieve this by
manipulating the red, green and blue color channels. Use the slider to experiment.
xprocess, crossprocess

Blur/Sharpen

This control blurs images if the slider is dragged to a value below 0, and sharpens
images when dragged above 0. For sharpen it's recommended that only small values be
used, and typically only on images that have been reduced in size a lot. You can enter
blur values larger than the -100 maximum value available on the slider. E.g. entering 400 will produce a very blurred image.

Enhance photo colors

Normally the ENHANCE controls will apply to the whole of a selected photo - but if you just
want to make changes to a particular color within your photo then use the ENHANCE
PHOTO COLORS option. You might want to change the color of the sky or tweak the
brightness and contrast of a patch of grass for example. Additionally there is also the
option to make a selected color transparent.

The Photo Tools
Just click on the SELECT COLORS TO ENHANCE button on the Enhance tool InfoBar to
switch into Enhance Photo Colors mode. Now you can click on the part of the photo you
want to adjust.

Cross positioned over the color to be selected.

The color at the click point determines the color that gets selected in the photo - you will
see a brief flash of a chequerboard pattern on your photo, indicating how much of your
photo has been selected.
Also a red color point appears at your click point.

Red color point at click point

You can click-drag on this to move it around, if you didn’t quite hit the color you wanted to
select. As you drag, the chequerboard pattern appears again and it updates dynamically
as you do so, so you can see what parts of the photo have been selected. Or to review
what you have selected, just click and hold over a point without dragging it to reveal the
chequerboard pattern again.
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If you haven’t selected all the colors you wanted, you can simply click again to add
another selection point. So for example if you are trying to select all of the blue sky in
your photo, there may be various different shades of blue in the sky and so you may
need to click on several different parts of the sky to capture them all so that the
chequerboard pattern covers the whole sky. You can do this as many times as you want,
to extend the selection.

Chequerboard pattern indicating color selections

You may also find that you’ve selected parts of the photo you didn’t want to select. There
are two ways to help solve this problem. You can adjust the extent of the color selection
by adjusting fade and tolerance values, and/or you can use a region or mask to limit the
area of the photo to which the color selection is applied. See sections below.
Note that enhance photo colors mode is turned off automatically when you leave the
Photo Tool or switch to another document.

Applying Enhance
Now choose any of the Enhance functions to alter the selection.








Brightness
Contrast
Photo saturation
Photo temperature
Hue
Sharpness
Brightness levels

Or else to make the color selection transparent use the option on the right-click context
menu.
Even after you’ve started to enhance your color selection, you can still go back and
modify the selection as described above, by moving points, adding more points, etc.

The Photo Tools
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Context Menu
If you move the mouse pointer over a color selection point and right-click the mouse
button, a context menu appears with the following options.
DESELECT

DELETE COLOR
SELECTION

Deselect the current color selection so you can start a new color selection.
You can also deselect by pressing the Esc key.
Delete the color selection to which the point you clicked on belongs.
Therefore all the points that are part of the same color selection will
disappear.

POINT

Delete only the point you clicked on. Any other points in the same color
selection remain.

MAKE TRANSPARENT

Makes the current color selection transparent. You can toggle on or off.

DELETE THIS COLOR

.

Using masks or regions
If you want to just enhance a particular area of your photo, first use one of the Photo
Region tools to mark the region of the photo you want to modify. Or use a Mask tool to
protect parts of the photo you don’t want modified.
Then switch to the Enhance Tool and make your changes. The mask or region is used to
limit the parts of the photo the enhance operation is applied to and afterwards you are left
with a region inside the Photo Group. Whenever this region is selected inside the Photo
Group, its outline is shown with "marching ants". To select such a region inside a Photo
Group, Ctrl+click on it or select it from the Page and Layer gallery (on page 177) where it
will appear as a Region within a Photo Group (on page 323). Looking at the Status line
(on page 36) will also clearly show you when you have a region or mask selected inside
a Photo Group.
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Note that you should almost always apply feathering to a region inside a Photo Group, to
soften its edges and blend the enhance effect seamlessly into the photo. Hard-edged
regions are rarely useful. See the Feather tool (on page 175) for details. You can apply
and adjust the feathering on the region inside the Photo Group once it’s selected inside,
or you can apply feathering to the mask or region before you apply the enhance effect.

Left photo in partial shadow, right photo enhanced with brightness and feathering to soften and
blend the outline.

If you want to make adjustments to the shape of a region inside a Photo Group then just
switch back to a mask or region tool and make your changes ensuring that the region or
mask is selected (shown with marching ants outline). Again, even while in the
Region/Mask tools, you can select regions inside a Photo Group using Ctrl+click.
If you want to be able to work on selected regions inside a Photo Group without
seeing the marching ants outlines, you can temporarily turn off the outlines
using the button on the InfoBar of the region and mask tools.
The outlines are turned on again as soon as you clear the selection or move to a different
photo or document.

Resizing color points
Selected color points are shown in red and have resize handles shown around them.

Color points with resize handles
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Drag on the resize handles to change the size of the color point. This is useful if you
need to be very accurate with your selection and you find that it’s difficult to place a color
point over just the color that you want to select. Make the point smaller to make this
easier.
The color selected by a color point is the average color over the area it covers, so by
using a smaller point size you can control this color more accurately.

Enhancing different colors
As described above, when you are trying to select a color in your photo you can click as
many times as you want to keep extending the selection. Each point appears in red to
show it is selected and is part of the same color selection. But what if you want to start
selecting a different part of your photo so you can apply different enhance settings to
that? For example, after adjusting the sky you may want to start work on another part of
the picture.
To start a new color selection, you first need to deselect the first color selection you’ve
been working on. Do this by right-clicking on one of the red color points and choosing
"DESELECT" from the context menu, or just press the Escape key. Now you see the color
selection points you’ve already added are shown in black instead of red. This shows you
they are no longer selected.

Now you can start clicking again on a different part of your photo and new red points
appear. This is a new color selection and you can extend and adjust it just as you did for
the first, then start enhancing it.
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So now you have two separate color selections. To modify or extend either of them, just
click on one of the points. All the points in that color selection turn red to show that color
selection is selected. Clicking on the photo will add more points to that current color
selection and the enhance controls on the InfoBar show the current settings for that color
selection.

So in summary, clicking on a photo to add new points will add them to the current color
selection (whose points are shown in red) . To start a brand new color selection, first
make sure you start with all existing points shown in black (not selected), by choosing
DESELECT from the context menu. Then you can start adding the new color selection.

Adjusting tolerance and fade

Tolerance and Fade slider controls.

You can adjust the extent to which colors are selected using the Tolerance and Fade
controls. These are available from the button next to the Enhance Photo Colors button,
but this only appears when you have ENHANCE PHOTO COLORS mode turned on. The
Tolerance slider affects the range of a particular color selection - capturing a wider range
of hues and tones of the selected color, whilst the Fade slider controls the extent to
which the selection bleeds into the adjacent areas.
Tolerance: This value determines how colors are treated that are close to, but not the
same as, the sample point color. If the tolerance is set to 0, only colors exactly matching
the color at the sample point are selected. As the tolerance is increased, colors further
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and further away from the color of the sample point are also selected, just as if they
matched the sample color exactly.
Fade: This value determines how colors that fall just outside the color tolerance are
treated. If fade is 0, then colors are either selected or not, depending on whether they fall
inside or outside the tolerance. This can result in ‘hard edges’ since every color is either
fully selected or not at all. So as this value is increased, colors outside the tolerance are
partially selected, proportionally to how far outside the tolerance they are. This gives a
softer color selection.

Easy crop
While in the Enhance tool you can drag on the adjustment handles shown around the
edge of the selected photo to quickly adjust the cropping of the photo without needing to
go into the Clip Tool.

Clip Tool
Alternatively you can enter CLIP TOOL by selecting the Clip icon on the PHOTO TOOL flyout bar. This provides a range of additional crop options. You can enter exact pixel
values, and select from various crop aspect ratios
For interactive clipping and some more options regarding aspect ratio, enter the
CLIP TOOL with the CLIP TOOL button.
This alters the InfoBar to look like this:

As you drag over the photo, the clip rectangle is highlighted.
 You can adjust the region by dragging on the corner or side handles
 You can push the region around by just dragging inside the clip region
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 Select the CLIP button or just double click inside the clip region to perform the clip
operation.

You can tell whether a photo has been clipped or not from the status bar which will
describe it as a "clipped photo".

Clear
Press the "CLEAR" button, or just click outside the marked clip region to clear the current
clip rectangle.

Un-clip
Press the UN-CLIP button with any clipped photo selected, to restore the original photo.
This restores the clip rectangle, which you can adjust or clear by clicking outside it.
The UN-CLIP button in the CLIP TOOL will change the outline of any clipped photo, and
also arbitrarily formed shapes with a bitmap fill, to that rectangular outline of the complete
photo or bitmap used as the fill. You may have to select the Clear button to clear the crop
rectangle (or click outside the rectangle).

Adjusting the clip region
Because the un-clip button restores the clip rectangle (showing the area outside faded),
you can easily make fine adjustments to a clipped photo. Just select the photo, press the
Un-clip button and adjust the sides of the clip rectangle as required. Double click inside
the photo to clip it again.

Width / Height
After drawing a clip rectangle, you can enter values directly into the width and height
fields on the InfoBar to set the clip rectangle dimensions to exact values.
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Lock Aspect
Select the "LOCK ASPECT" check-box to constrain the clip rectangle to a specific aspect
ratio as you drag. The radio buttons to the right of the check-box determine the aspect
ratio used. Select "CURRENT" to maintain the aspect ratio to that of the photo before the
clip. Note that the clip rectangle automatically changes between landscape and portrait
orientation as you drag a corner of the rectangle. So if you drag sideways it tends to
create a clip in landscape orientation. If you drag downwards more, then it will create a
clip region in portrait orientation.
The common preset crop aspect ratios are available of 4:3 (most consumer digital
cameras and old-style TVs and monitors), 3:2 (that of traditional film cameras and higher
end SLR digital cameras), and 16:9 (aspect ratio of widescreen TVs).
You can override the lock-aspect option by using "Ctrl" while dragging. So if you're
dragging out a clip rectangle (or adjusting one) without aspect ratio lock, then holding
"Ctrl" will lock the aspect to the last selected aspect ratio. Similarly if you have lock
aspect option on then "Ctrl" will temporarily un-lock the aspect ratio.

Clipping in Photo Documents
In photo mode, there is a one-pixel grid applied to the photo (when at 96dpi, the default
resolution) and the clip rectangle snaps to this grid. This makes it very easy to get pixel
exact clipping. For highly accurate or exact pixel snapping, it's recommended to operate
in photo mode and to zoom in so you can see the pixels clearly.
See Photo documents (on page 358) for more information.

Photo Clone Tool
This is a tool (on the Photo Tool fly-out) that rapidly and effectively erases
objects from images. The CLONE TOOL allows you to either copy or ‘clone’ parts
of a photo and replace the unwanted objects with the cloned area, effectively
erasing the objects.
You can either automatically clone parts of the same photo (by allowing
Designer Pro to choose the most suitable area of the photo to clone) or
manually (by choosing the area from the same or another photo yourself).

1.
2.
3.

In the CLONE TOOL draw a freehand line around the area you want to erase, which
is shown as a 'marching ants' dotted outline surrounded by 8 resize handles.
To automatically clone an area of the same photo to replace this selected area (or
‘clone area’), click the MAGIC ERASE button in the CLONE TOOL InfoBar.
Designer Pro replaces the clone area with another part of the photo. Drag on the
resize handles to increase or decrease the area you want to replace. If you move
the mouse pointer over the clone area, the CLONE TOOL displays an ‘M’, indicating
that you have used Magic erase (which disables the ability to drag on the clone
area to choose another portion of photo – see step 5).
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4.
5.

If you don’t like this replacement, just click the MAGIC ERASE button again to see
another replacement. You click the Undo button in the standard toolbar (or press
"Ctrl + Z") to go back to the replacement you prefer.
To manually clone an area of the same or another photo, in step 2 drag anywhere
on the photo outside the clone area to pick the new source for the clone area, which
updates to display the portion of the photo you have just dragged on. You can also
now drag within the clone area to pick a new part of the photo.

6.

Note that as you apply more clones, the new clones are made using the final image that
you see on the page, not from the original image. This means once you erase a feature
from your photo it won’t re-appear in subsequently created clone shapes.

Clone Tool Infobar

OUTLINES ON OR OFF

With outlines on all clone shapes on the selected photo are shown with a dotted
outline. The current or selected clone shape is shown with an animated
'marching ants' outline, resize handles and an arrow pointing from the source
point.
SIZE SLIDER

This allows the clone shape to be enlarged or reduced. This is particularly useful
if you use a larger feather value (which blends the edge of the clone shape
inwards) in that you can compensate by enlarging the clone shape.
FREEHAND SMOOTHING

After you've drawn your freehand clone shape, you can adjust the smoothness
of the line. This is exactly equivalent to the Freehand tool smoothness control.
This is only active immediately after you've drawn the clone shape. If you edit
the clone outline using the other tools such as the Shape Editor, this control
become disabled.
MAGIC ERASE

Click this button to allow Designer Pro to automatically select areas of the same
photo to copy and clone into the clone shape. Continue to click to view all other
possible automatic replacements.
FEATHER CONTROL

This pop-up slider adjust the blending of the edges of the selected clone shape.
It replicates the main feather tool.
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Clone Tool Operation Summary
To erase a part of a photo, select the CLONE TOOL and draw around the area you want to
erase. Then either:
 Click the Magic erase button in the CLONE TOOL InfoBar to allow Designer Pro to
automatically select areas of the same photo to clone into the clone shape.
 Drag outside this area on the same or another photo to set the source point for the
copy.
You can switch on or off visible outlines for the clone shapes with this icon on the
CLONE TOOL InfoBar.
 You can adjust the feather of the clone shape using the InfoBar’s feather control slider
and the size of the clone shape by dragging on one of the resize handles.
 A click on a clone shape will select it. The selected clone shape is shown with an
animated dotted outline (assuming outlines are on using the above control), 8 resize
handles and an arrow indicating the source point of the cloned area (if you chose it
manually rather than clicking Magic erase). .
 You can push the contents of the selected clone by dragging on the clone shape (if
you selected the copied/cloned area manually). This is an alternative method of
adjusting the fill position or fill source point for manual cloning.
 When setting the source point of a clone shape manually, if you drag over another the
photo you can copy regions of one photo onto another.
 Dragging on the 8 resize handles around the shape will enlarge or reduce the clone
shape size
 Dragging the feather slider control on the InfoBar, or the main feather control on the
top bar, will adjust the edge blend.
 You can delete a clone shape by selecting it and pressing the Delete key
 The clone copy will always be made from the image you see on the page, including all
previously applied clones and other edits already made to the image.
 Clicking on the background photo will de-select all clone shapes so allowing you to
draw a new clone shape if required.
 Clone shapes are normal vector editable shapes, and once selected you can switch
into any of the normal line or shape editing tool to make further adjustments of the
outline.
 A photo with clone edits, is stored as a new 'Photo Group' structure. This acts like a
normal photo for many purposes (you can resize it, rotate it, enhance it etc, and it will
act as a single photo object). But using 'select inside' (Ctrl+click) or using the Page &
Layer Gallery to view the group structure, you can select and edit the individual clone
objects within the Photo Group.

Photo Heal tool
Use the Photo Heal tool to instantly remove unwanted objects and artifacts from
your photos.
Select the tool and then choose a nib size from the InfoBar.
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See the Shape Painter tool (on page 132) for a more detailed explanation of nib size.
Simply position the nib over the over the area you want to heal and then click. Select
larger areas by click-dragging over them and then releasing the mouse button to perform
the erase.

Just select the tool and click on any blemish - it's instantly removed.

If you are not satisfied with the results then click the MAGIC ERASE button on the InfoBar
to generate alternative results. You can compare different results by shuttling backwards
and forwards using the UNDO/REDO buttons or else using Ctrl+Z/Ctrl+Y on the keyboard.
The ‘patches’ created by the Heal Tool are compatible with the PHOTO CLONE TOOL (on
page 377), so if you switch to the CLONE TOOL you will see all your patches shown with a
dashed outline. So you can select and delete or re-generate (using the magic erase
button) any of the patches.

Effect Painter Tool

The EFFECT PAINTER TOOL (on the Photo Tool flyout) provides an easy and intuitive way
to retouch photos and images. You can apply photo enhancements to particular areas of
a photo by painting directly onto the image using a nib. It’s based on the Shape Painter
Tool (on page 132), so it shares a lot of the same controls such as those for choosing the
size of the nib, smoothing the painted shape and softening (feathering).
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Selecting and applying an effect
Choose the effect you want to apply from the list on the left of the InfoBar. For example
the Desaturate effect will reduce the saturation (color) on the areas of the photo you paint
onto.

Choose a nib size using the Size control. Note that by default, as in the SHAPE PAINTER
TOOL , the on-screen nib size stays the same as you change the zoom, which makes it
easy to zoom in and work on intricate parts of the photo without also having to change
the nib size. However if you prefer you can switch to an absolute nib size by clicking the
SIZE toggle button.

Use the SOFTNESS control to give your strokes some feathering, so they blend into the
photo, instead of having a hard edge (Softness = 0%). Start painting onto your photo to
apply the effect. This creates a new region shape on top of your photo.
Your stroke shape will be outlined with a "marching ants" effect to indicate that it is a
current or active shape. Toggle the "ants" on or off using the shortcut "Ctrl + H"

Adjusting painted effects
After painting, the new effect region you created on top of your photo remains selected,
so you can adjust it if required. You can adjust the strength of the effect by using the
TRANSPARENCY slider and you can adjust the softness/feathering on the region using the
feather (on page 175) slider on the top InfoBar. You can also carry on painting to extend
the selected region, or hold down Shift and erase parts of the region.
You can even switch into the PHOTO TOOL with the region still selected and adjust the
brightness, contrast, etc. of your region.
Back in the the EFFECT PAINTER , to paint a new region, first deselect the existing selected
region. You can do this by just clicking away from the photo or by hitting Esc. Now when
you paint you will create a new region, on the same or on a different photo, and it will
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have the same attributes as the last region you had selected. Or of course, just select a
different effect in the Effect control.
At any time you can select an existing region by Ctrl + Clicking on it. Once selected, you
can modify it as described above and if you then deselect it and draw a new region the
new region will have the same attributes.
Photo enhance, retouching, spot effects, photo effects

The Red Eye Tool
Select the RED EYE TOOL from the PHOTO TOOL flyout bar.
The RED EYE TOOL allows you to quickly remove red eye effects from faces in
your photos.

Click the icon shown above to enter red eye mode. Then:
 Zoom into the red eyes in your photo using the

ZOOM TOOL (ON PAGE 38) OR JUST

USING "CTRL + MOUSEWHEEL".

 Click and drag from the centre of the red eye outwards, to drag a circular red eye
patch. The red color is removed from the area within this circle.

The Photo Tools
 Repeat the above for each red eye in your photo.

You can select any red eye patch you’ve applied to a photo by just clicking on it while in
the RED EYE TOOL . Then you can hit the delete key to remove the selected red eye patch.
Or go into the QUICKSHAPE TOOL and you can edit the selected red eye patch
just as you edit normal ellipse shapes in your documents.
Therefore if required you can make the red eye patches elliptical if that makes them fit
the red eye area better. See the Quickshape tool section for information on using this tool
to edit ellipses. However for most photos the default circular red eye patches are good
enough for removing red eye effects.
The edge of the red eye ellipse has a 3 pixel feather applied by default, so there is no
hard edge to the area from which the red is removed. You can easily adjust this feather
value by selecting the red eye ellipse (as above) and adjusting the feather value with the
main feather control (on the right hand side of the top bar), in the same way that you edit
the feather values of ordinary shapes.
After applying the RED EYE TOOL the red eye patches are grouped with the photo inside a
PHOTO GROUP . This is so that as you move the photo around in your document, or
otherwise transform it, the red eye patches move with the photo. Note that this means if
you want to select a red eye ellipse when you are not in the RED EYE TOOL , you need to
hold "Ctrl" down while clicking on the ellipse (which is called a ‘select inside’ operation).
See the Photo Handling chapter for information on Photo Groups (on page 323).
Click the CLEAR ALL button on the RED EYE TOOL InfoBar to delete all red eye ellipses
from the current selected photo.
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Live Effects

Live Effects are bitmap effects that can be applied to any object using Xara Picture Editor
tools or Adobe® Photoshop® plug-ins.
The LIVE EFFECTS TOOL is located on the PHOTO TOOL flyout.
Browse through the list of available Live Effects by clicking the NEW button on the Live
Effects InfoBar.

Add a new Effect
List of effects applied, in order
Edit the selected effect
Live effect resolution
Delete current effect
Lock/unlock all effects
Delete all effects
Configure to find plug-ins

Applying a Live Effect
To apply a Live Effect:

1.
2.
3.

4.
5.

Select the object or objects in the usual way.
Select the LIVE EFFECTS Tool.
Click the NEW button on the left side of the InfoBar. This displays a partitioned list of
available effects in a menu. The first set of effects listed in the menu are PICTURE
EDITOR effects. The second set are effects provided by the built in Xara Designer
Pro X FEATHER (ON PAGE 175) and SHADOW (on page 298) Tools. The third set of
effects are "New-style" Photoshop plug-in effects and the final set are "Old-style"
Photoshop plug-in effects (see below for an explanation of these di FFERENT TYPES).
Select the effect you want to apply from the list.

Click OK when you're done to return to Xara Designer Pro X.
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Editing shapes
If you apply a Live Effect to a shape or text, the object remains fully editable. Each time
you edit it in any way, the Live Effect is automatically re-applied to the object. For locked
effects this is not possible, and you must remove the effect using the DELETE button on
the Live Effect InfoBar, edit the shape, and then re-apply the effect.

Locking effects
When you resize or rotate an object which has a Live Effect applied, Designer Pro takes
this to be an edit and re-generates the effect. This may not be what you want, so it's
useful sometimes to be able to lock an effect.
Old-style Photoshop plug-ins are LOCKED as soon as you apply them. This means the
underlying shape can't be edited. You can also lock a Live Effect and then when you
resize or rotate the object the effect remains fixed, as if you were resizing/rotating a
bitmap.
As an example of this, imagine a plug-in that always applies horizontal ripples (the
"Television" Live Effect shown does something similar). Apply this effect to a shape, and
you'd then see horizontal lines across it. If you then rotated the shape, would you want
the ripples to rotate with it? If so, lock the effect before the rotation. Or would you want
the horizontal ripple effect to be re-applied to your now rotated rectangle? If so, leave the
effect unlocked.

When a Live Effects is locked the effect rotates with the object (left).

When giving designs to other people to load, if they do not have the plug-ins that are
used in the design, then they won't see the effects applied. To get around this problem,
you can lock the effects. Locked effects are saved as bitmaps in the document so
anyone can see them, even if they don't have the plug-ins that generated the effects.
To lock an effect, select the object or objects and in the LIVE EFFECTS InfoBar
click the PADLOCK icon. To unlock an effect that has been locked this way, just
click the PADLOCK icon again.
You can still alter the resolution of the effect. For printing, you may want to use a higher
resolution than if the work is just for screen use.
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Live Effect resolution
For screen and web use it's best to leave the resolution at the default 96 DPI; the same
as the screen resolution. If you require a higher resolution image, for example if you're
printing or wanting to export a high-resolution bitmap, then you can increase this to 150
DPI or even higher. The higher the resolution, the longer it takes to generate or regenerate the effect (because it has to work with a much larger bitmap) and the more
memory is required.
You can set the resolution of a Live Effect to "Automatic", instead of choosing a fixed DPI
value. With this setting, the effect will be automatically re-generated when required, at
the most appropriate resolution. For example, if you print a design containing Live
Effects, any effects set to AUTOMATIC will be re-generated at print resolution if they are
not already at that resolution or higher. In a large design with many effects, note that this
can make printing much slower as each effect has to be re-generated at high resolution.
You can change the resolution that's used to render effects in THE EFFECTS & PLUG-INS
tab of the OPTIONS dialog. For more on the Options dialog see Customizing Designer Pro
(on page 607). To change the resolution of an effect that has already been applied, use
the DPI control on the LIVE EFFECTS toolbar.

Saving and transferring files
When you transfer a file to someone else, unless they have the same plug-ins installed
on their computer, they will not see the effects (this is similar to the problem of fonts; the
recipient needs to have all the fonts used in the design to see an accurate representation
of the text in the document). In order to guarantee that recipients can see the effects in
your design, lock them before saving.
Because locked effects are saved in the design file as a bitmap, this means the files are
much larger than for unlocked Live Effects.

Copying Live Effects
For more on Copy and Paste, see Object Handling (on page 76).
You can copy Live Effects in your design from one object to another using PASTE
ATTRIBUTES , just as you can copy other object attributes. Simply select the object with
the effect(s) you want to copy and select "Edit -> Copy". Select the object or objects you
want to copy the effects onto, and select "Edit -> Paste Attributes".
Note that you cannot copy "old-style" Photoshop plug-in effects in this way because
those effects do not have the ability to re-apply themselves.
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Content Aware Photo Resize
Designer Pro includes the ability to stretch photos using a new technique that retains the
proportions of key aspects of the photo.
The human eye is particularly sensitive to changes in aspect ratio of everyday objects,
and most people can tell something is wrong with images that are even slightly squashed
or stretched.

Here is an example photo of the famous
Torii Gate in Japan. Clearly the gate itself is
the main subject of this picture.

Here the photo has
been stretched using
the normal stretching
method of the
SELECTOR TOOL .
Even with this
moderate stretching
it's obvious the
proportions of the
gate have been
badly distorted.

Stretching using Content Aware Scaling. It still looks perfectly natural. The gate proportions are
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intact, even at this extreme stretch, which is twice as wide as the original. The stretched
coastline remains looking natural.

Preparing Your Photo
The content aware scaling feature is part of the PHOTO TOOLS .
Select your photo and from the Photo Tool fly-out bar. Select the CONTENT
AWARE SCALING BUTTON. The right end of the InfoBar will now show a set of
buttons.

Select a photo, go into the PHOTO TOOL , and the InfoBar should look like this;
First click the PREPARE button to prepare the photo for the scaling. This starts an analysis
of the photo to calculate which parts of the image can be stretched and which parts
should be kept. This process can take some time depending on the resolution of the
photo, and how many processors your computer has.
For really high resolution images it's recommended that the image resolution be reduced
if you do not require the maximum resolution. Do this before you select the Prepare
buttons. To reduce the resolution of your photo select the OPTIMIZE button and enter a
pixel width or dpi resolution into the dialog. The image size on the page will not change,
only the resolution or number of pixels inside the photo changes.
Once you've prepared the image, new resize arrows will appear on the sides of the
photo. Just drag on these to stretch or squash the image in the desired direction.

Content-aware photo zoom
An alternative to content aware scaling is the whereby the photo remains the same size
and the content is intelligently zoomed inside it. Here's an example of the effect.

Use the zoom slider on the InfoBar to control content-aware
photo zoom.
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The picture remains the same size, but the program automatically detects and scales
(zooms) the 'interesting' content. Note this is not just a crop of the girl, but that every
element, cloud, and grass that appears in the original is still there in the zoomed version.
The program automatically detects the girl is the 'region of interest' and so enlarges her
only.

Using Masks With Content Aware Scaling
Using the MASK PAINTER TOOL you can provide further control by protecting areas of the
picture from being distorted. Masked areas will not be distorted at all. See the Masks
(on page 307) chapter to find out more about masks, but here's a brief summary of how
to use masks with Content Aware Scaling.
To protect one or more areas of the photo from being distorted;
1.

Select the MASK PAINTER TOOL from the Mask tool flyout bar and mark the
part or parts of the photo you wish to protect.

2.

Now go into the CONTENT AWARE PHOTO RESIZE TOOL and click on the
photo.

Now when you use the PREPARE button this area will be protected from distortion. You
may need to select the photo to enable the PREPARE button.
Note: You can't mask more than half the image. The prepare operation will give an error
if you try this.

Adjusting a mask, or adding a new mask
You can't add a mask to an image that has already been stretched. Instead, if you want
to add a new mask or adjust an existing one, you have these options:

1.
2.

Click the RESET button and draw a new mask
Click undo as many times as necessary to get back the mask, and then use the
mask painter tool to adjust the mask shapes.

3.

PREPARE
RESET

MASK PAINTER

TOOL

There is another alternative that you can 'fix' a stretched image using the OPTIMIZE
feature, and then apply a new mask. This is not recommended in most cases because it
will produce lower quality results than resetting the image and applying a mask to the
original image.

Alternative Content Aware Scaling
When stretching photos there are two alternative ways to scale the image. The method of
just dragging the size arrows sometimes doesn't work so well with some image types.
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However by holding the "Alt" key when dragging one of the side handles in the CONTENTAWARE PHOTO RESIZE TOOL (on page 387) performs a different intelligent scale using an
alternative algorithm.

Content Aware Scaling notes
 You can only compress an image to half its initial width or height
 If you save a document with a photo that has been prepared for Content Aware
resizing, then it saves the resizing information in the document. The advantage of this
is that you can later re-adjust the photo using the Content Aware feature. There is a
significant file size overhead of saving photos like this.

The Brightness Levels Dialog
Click the Levels Tool icon on the Photo Tool fly-out bar.

The LEVELS TOOL provides detailed control over the brightness levels of photos. It's a
very powerful, multi-purpose tool that not only shows a histogram of the brightness levels
of the photo, but provides a greater degree of control than the simple brightness or
contrast controls. It can lighten shadows without affecting other parts of the picture. It can
adjust the white balance of a picture and also the black and white points.
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Channel selector
Auto (= Auto-Enhance in the ENHANCE TOOL )
Reset
Toggle curve
Input levels and Brightness value (Gamma)
Histogram
Visual input levels and brightness adjust (black point, brightness, white point)
Output levels
Black/gray/white point picker
Visual output level adjust
The red histogram graph shows the distribution of brightness levels in the selected
picture, ranging from the blackest shades on the left to lightest (white) shades on the
right. The height of the red graph indicates the amount (i.e. the number of pixels) of each
shade used in the picture. Typically a correctly exposed photograph would show a
spread of brightness levels across the range, dark to light, as in the above example. Here
are some pictures and example histograms.

1.
2.
3.

The first image shows a good spread, from the darkest to lightest shades, with a
predominance of mid-brightness shades.
The second image is obviously very dark, and the histogram reflects this with peaks
at the dark (left) end.
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Adjusting brightness
Dragging on the center gray triangle adjusts the brightness (technically this is altering the
gamma). It does the exact same thing as the brightness slider on the InfoBar.
The brightness slider alters the darker shades in a picture more than it does the lighter
shades, so it is particularly good for revealing details in shadows.

Selecting the black, gray and white points

The three eye-dropper icons can be used to pick the black, gray or white points on the
photo, and adjust the three controls for you automatically. These tools have the
advantage that they also adjust the white balance or color cast that your photo might
have.
 Click and drag one of the icons from the levels dialog over your photo. As you do this
you will see the photo change. Release the mouse buttons when you're happy with the
change.
So to set the black point automatically you'd drag the black eye-dropper over the blackest
part of your photo. Similarly, you'd drag the white eye-dropper over the whitest part of
your image.
Note: These are buttons which can be dragged - they do not work by selecting the button
and then clicking again on the photo. Instead you must drag them over the photo. These
are interactive, so as you drag the picture is changed.

Color cast - fixing the white balance
The middle of the three eye-droppers sets the gray point and this is mostly useful for
altering the white balance of your photos. You drag it from the LEVELS Dialog, like the
others, but drag it over any point in the picture that is meant to be gray. In doing this the
balance of colors is altered to try and make the item under the mouse pointer a pure
shade of gray, and thus alters the color balance of the whole picture.
If you have a photo taken with the wrong light setting, they will come out orange or blue.
This control can help fix this, although in bad cases it will never be possible to make
them perfect.
Tip: If there are no gray objects in the picture, find anything that is meant to be white and
look for an area that's in shade or less than bright white.
Tip: If you have multiple pictures taken with the same color cast, you can copy the
correction from one to another using the Copy / Paste Attributes feature.

The Photo Tools
Here is an example, a snow scene, that is badly under-exposed, and with a strong blue
cast. Its histogram on the right shows the white levels are poor.

By dragging the white eye-dropper from the Levels dialog over the whitest part of the
image, it not only restores a better overall histogram, but also corrects the blue cast so
that the white snow really is white.

The corrected histogram now shows a much better balance (it's largely at the white end,
but that's to be expected in a snow scene).

Auto Levels
The AUTO button will automatically adjust the white and black points to correspond to the
lightest and darkest shades in the selected picture. This works better for some images
than others (the above snow scene works perfectly, so in fact this can be corrected with
a single click).

Reset
The "RESET" button will reset all levels parameters back to their starting values. The
"COMPARE" button on the Photo Tool's InfoBar also does the same thing, but has the
advantage that pressing it again restores the altered settings.

393

394

The Photo Tools
Advanced Levels - The Green Line
For the more advanced user, the levels control is really mapping the range of input
brightness levels to an alternative set of output levels. Overlaid on the red histogram is a
green line that represents the mapping function.

The default straight line means no change, so dark shades are mapped to dark, and light
to the same light shades. But as you alter the controls the green line is altered to reflect
the new mapping. So, for example, increasing the brightness or gamma control will
change the line like this;

You can see now that it's no longer a straight line mapping, and that the darker input
shades will be mapped to corresponding lighter output shades.

Using one of the low contrast examples above, this is the altered histogram, showing the
before, after and altered green mapping function line.
You can see the black and white points are moved inwards. This is reflected in the green
line which shows that mid-shades are now mapped to dark, and the lightest white points
(about 80% along the horizontal) are now mapped to white. Thus the narrow range of
input shades is mapped to the full dark-to-light range of output shades.

The Photo Tools
Output Levels
The two lower controls adjust the minimum (black) and maximum (white) final output
levels. Adjusting these has the effect of reducing the contrast.
Tip: It is usually recommended that for printing purposes the photos do not contain pure
white, but instead have a maximum "whiteness" of around 90%, especially when printed
in black and white. The histogram makes it easy to see if there is a lot of pure white
(peaks at the far right end), and by adjusting the white output level slider you can easily
control this.

Dragging the "White output level" slider inwards slightly alters the green line:

Meaning the maximum white value is brought down slightly.

Brightness Curves
In the Levels dialog you can create a manual brightness curve which provides very
detailed control over brightness levels for any photos.
To create a manual curve just click or drag on the histogram area, and you will see a
control point added and a curve.
Right click on a control point to delete it. Use the TOGGLE CURVE BUTTON
temporarily disable the curve.

to
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The Curves control is used in combination with the other Levels controls, such as the
central gamma control, and the black and white input and output levels. This means you
can have both a manually entered curve, and still make general adjustments such as
adjusting the gamma, or even the contrast on the main Photo Tool InfoBar.

This example shows a manually entered curve with three control points. In this example the
mid to dark shades have all be lifted (lightened), but the brighter shades of the photo (right
side of the curve) have not been altered at all.

The histogram graph shows both the original histogram (dark red) of the unmodified
photo and the modified histogram (pale red overlaid) that is the result of the adjusted
curve.

Levels Tool notes
1.

2.

The LEVELS dialog works in conjunction with the BRIGHTNESS and CONTRAST
SLIDERS . You can use both sets of controls together or separately. All will alter the
overall brightness levels, and all changes are reflected in the histogram and green
mapping line.
LEVELS

Compare & Restoring the original
The COMPARE button can be used to reset all the ENHANCE and LEVELS Tool values back
to their defaults, returning your photo to its original state. Press the compare button a
second time, your previous values are reinstated. Therefore you can use the compare

The Photo Tools
button to quickly toggle between your edited photo and the original photo so you can see
the effects of the changes you've made.

Panorama Stitching
Xara Designer Pro X includes a tool that can automatically stitch together up to
8 photographs into a single wide, high-resolution panorama.
Creating high-quality panoramas can be a very complex and technical process, often
requiring special equipment or lenses and accurately exposed and aligned photographs.
The panoramic stitching feature built into Xara Designer Pro X requires none of these,
and can use an every-day digital camera so that anyone can create outstanding quality
panoramic images in a few minutes.
This tool features:






Automatic estimation of the focal length to warp the images to reduce fisheye effects
Automatic barrel, pin cushion and vignette adjustments
Automatic exposure correction
Automatic detection of shared overlap points and seamless blending of joins
Automatic cropping of the final result.

To create a panorama you need to take a series of separate photos from a central
position. Ideally each photo would overlap the next by approximately 30%, although it will
work with more or less overlap.
The process of creating a panorama is very straightforward:

1.
2.
3.

Import each of the photos. There is no need to try and position the overlaps
correctly
Select all the photos you want to stitch together, they don't have to be in order.
PANORAMA

PHOTO TOOL
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It will start the process of stitching and continue as a background process. A popup
status window shows the progress through the various stages, although you can
continue using Xara Designer Pro X like normal while this happens. When the process is
complete the resulting panorama image is imported onto the page. Note that it does not
replace the original images, which you can delete if you no longer require them.

Three example photos of a landscape. Each overlaps the other (in this case a bit more than
necessary).

The resulting single panorama image, with seamless integration.

Optimizing images
Xara Designer Pro X will always stitch photos at the full resolution, even if you reduce the
size of the image on the page. This is often a desirable thing since it produces the
maximum quality, highest resolution results. But it does mean that the stitching process
can take a few minutes. So sometimes you may prefer to reduce the resolution of the
images before you stitch them together, especially if you only require a medium
resolution final result, perhaps for the web.
To reduce the resolution of any image, reduce its size on the page to the required size
and then use the "UTILITIES " > "OPTIMIZE PHOTO " option. Note that the panorama stitcher
works better with higher resolution images (it's easier for it to find matching points on the
photos).

The Photo Tools
When you get the stitched image back, this is stored as a PNG image in Xara Designer
Pro X. This is the highest quality, but takes a lot of memory and file space, especially if
it's a high-resolution panorama. (The BITMAP GALLERY will show you how much).
Therefore you can usually benefit from reducing the resolution of the final image and
converting it to a JPEG instead. Again use the "UTILITIES" > "OPTIMIZE PHOTO" option for
this.
Notes:
 The panorama stitcher expects the images to be the same resolution and size.
 Try to avoid taking pictures with moving objects in. These can confuse the system
since the same object might appear in different places, or not at all.
 Try to keep the horizon at the same approximate position on each photo
Hint: By taking photos in a portrait orientation, you can get maximum vertical coverage.

Perspective Correction Tool
This tool is available on the Photo Tool fly-out. It's designed to be a simple oneclick way to automatically correct common perspective effects.

The image on the left, taken inside a very large Roman Basilica, shows the common
perspective effects of photos taken with a camera close to the ground. To get a 'straight
on' photo would require it to be taken from a height of probably 30 feet. The perspective
correction tool can create a similar effect automatically (right example).
Simply select the photo, and then the Perspective Correction tool. The process can take
some time, depending on the resolution of the image.
Tip: The resulting corrected photo is in a raw BMP format which can take a lot of
memory and so you are recommended to optimize your photo to be a JPEG format to
reduce the memory and file size. Select the menu UTILITIES -> OPTIMIZE PHOTO...
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Advanced users: This utility provides no user interface or controls. However there is a
stand-alone program called ShiftN that does provide more control over the perspective
correction parameters. This is program available from inside the installed files folder of
Designer (e.g. C:\Program Files\Xara\ShiftN)

EXIF Tool
With the EXIF button in the Photo Tool fly-out bar you open the EXIF dialog. This
dialog shows the embedded EXIF values of a JPEG photo.
This dialog is mostly transparent (so it doesn't
get in the way too much). By clicking the small
down arrow on its title bar you can configure
which actual EXIF values are shown and how
transparent the dialog is.
EXIF data is now preserved on export of JPEG
photos and across an Optimize Photo
operation.

Eraser tool

Eraser tool
Using the Eraser Tool

The ERASER TOOL is used to erase parts of anything from photos to vector shapes. It
provides a ‘hard erase’ which will permanently ‘cut’ shapes and photos, or it can be used
with a ‘soft’ setting that is non-destructive and produces soft edges. There’s also a
powerful facility for intelligently erasing the background from a photo, which makes it
easy to cut objects out of a photo where there is a good contrast between foreground
and background.

.
The InfoBar for this tool provides controls over NIB SIZE , the ROUNDNESS , NIB ANGLE and the
SOFTNESS , as well as a smoothness control which adjusts how accurately the nib follows your
mouse movement (this is exactly like the FREEHAND tool smoothness control).

Nib size

Control the nib size by dragging the slider. Use the Size button to control whether the nib
size zooms in when you zoom into the page or stays the same size. If you keep the nib
size the same then it effectively becomes smaller relative to the objects on the page
allowing you to erase smaller details.
You can also conveniently adjust the nib size by holding down the Alt key and using the
mouse wheel.
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Erasing backgrounds
This feature is particularly good for removing or changing the background behind
complex shapes such as fur, hair, trees etc, that would be tedious, or impossible to mask
manually. You only need to indicate the approximate areas to erase (with the ERASER
TOOL ) and the areas to protect (with the MASK PAINTER TOOL ), and then click the ‘ERASE
BACKGROUND’ button.
1.

Use the ERASER TOOL to roughly paint over the parts of the picture you want to
erase (the background).

2.

Select the Mask Painter Tool and paint over some of the parts of the
foreground you want to keep.

3.

Select the ERASER TOOL again and then click on ERASE BACKGROUND on the
top InfoBar.

If the foreground is all a similar color you only need to cover part of it with the mask. If the
foreground has differing colors, then paint the mask over each of the differing color
areas. Use zoom (Ctrl+mouse wheel) to mask more or less detail and try not to mask
over any background color or regions.
If you make a mistake hold Shift to un-paint the mask. If you aren't happy with the results
you can UNDO (Ctrl+Z) and change the mask, or the erased parts, and try again. In this
way you can gradually improve the result by undoing, adjusting the mask and erased
parts of the image then pressing Erase Background again. To improve the results for a
particular part of an image, make the masked and erased areas more accurately indicate
the foreground and background in that part of the image, to improve the result in that
area. There is also a handy ? button on the top InfoBar which you can click to show a
step by step guide for this feature.
This image has a white
background which you
want to remove.

Eraser tool
Use the MASK PAINTER tool
to indicate the part of the
image to you want to
protect (pink area).
Then use the ERASER TOOL
to roughly mark the area
you want to remove (white
area).

Click on the ERASE
BACKGROUND button on the
Eraser tool InfoBar and the
white area disappears.

ff

Soft erase
If you adjust the Softness slider to be non-zero, this tool now becomes a soft eraser, and
strokes over any object (which can be any shape, text or photo) will erase, that is make
transparent, the stroked area. The softness control adjusts how hard or soft the edge of
the nib stroke is.
Note: You can use the erase tool over any object, including text, blends or 3D extrudes.
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Softness set to 0% - hard erase permanently
changing the shape/photo outline.

Softness set to 50% - soft erase.

Shape editing
Set the softness setting to 0 (the default) to erase with a hard edge. This cuts shapes
and photos, permanently changing their outlines. It’s a fast and direct way of adjusting
the vector outline of a shape inwards. If you stroke around the edge of a shape with your
mouse, it just moves the outline inwards.
First select the shape you want to erase by clicking on it, then hold the left mouse button
down and stroke over the shape to erase. Clicking on the backdrop will clear the
selection.
If you erase a shape so as to fragment it into separate pieces, it will still remain as a
single selectable shape. If you want to break it into separately editable shapes, use
"ARRANGE" > "BREAK SHAPES" .
If you click and hold (i.e. not perform a stroke), it will simply cut a hole in the object in the
shape of the nib.
Erasing across Text, 3D extrudes, blends etc
For some complex object types, it’s not useful to perform vector erasing, and so in this
case the erase tool will always perform a non-destructive erase even when softness is
set to 0. This means you can still edit (for example) the text or 3D extrude you’ve erased,
by doing a SELECT INSIDE (on page 124)

Eraser tool
Non-destructive editing
It’s important to understand that, as with most features in Designer Pro, the soft erase
feature is not destructive, that is it doesn’t change the underlying erased shape or photo
at all.It’s also important to realise the soft erase feature is resolution independent. The
‘softness’ value is a mathematical vector value, and the nib strokes are fully editable
vector paths. You can select, adjust or remove any earlier stroke, and for advanced
users the full vector structure can be seen in the Page & Layer Gallery (on page 177).
Advanced user: When you apply a soft erase operation to an object it becomes an
‘Opacity Mask Group’. In the Page & Layer gallery you can see the group contains an
opacity mask object, and inside that is the shape or shapes you used to erase with. You
can even select them using the Gallery and perform further edits on them.
Once an object becomes an Opacity Mask Group then further erase operations, whether
soft or hard, are applied as soft mask operations inside this group.
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3D Extrude Tool
Extruding a shape
To turn a 2D shape into a 3D extruded object, go into the EXTRUDE TOOL on
the main toolbar and simply click and drag on your object to rotate it in 3D
space.
Initially, your extrusion is given a default depth. The face color of the 3D shape is
determined by the fill color of the original shape and the color of the extrude (or side) by
its line color. After creating an extrude in this way, move your mouse pointer around over
the 3D object. You'll see that the mouse pointer changes as follows to indicate what will
happen if you click and drag at any point:
This is shown when the mouse pointer is over the front or back face of the
object. Clicking and dragging rotates the object in 3D space.
This is shown when the mouse pointer is over the extrusion (the side) of the
object. Clicking and dragging changes the depth of the extrusion.
This is shown when the mouse pointer is over the extrusion and "Ctrl" is held.
Clicking and dragging changes the bevel size (see below)
You can also rotate an extrusion by holding down the Alt key while dragging on the
extruded side. This is useful when only the side of an extrude is visible and so you aren’t
able to drag on the face in order to rotate it. As when dragging on the front face, Ctrl and
Shift can also be used to constrain the rotation.

Extrude Tool InfoBar

3D Extrude Tool
Extrude on/off
Slider type list
Slider and numeric value for selected parameter
Bevel type
Bevel size slider and value
Lights on/off
Gloss/matt
Rounded/mitred corner
You can adjust a 3D extruded object by manipulating it directly on the page as described
above, or by selecting it and using the controls on the InfoBar of the Extrude Tool.

Turning extrudes on and off
EXTRUDE ON/OFF

Once a shape or other object has been extruded, there are only limited modifications that
can be made to the original object with the extrusion in place. For example, if you've
extruded a shape, it's not possible to then edit that shape in the SHAPE TOOL (on page
152) because it's no longer a simple 2D shape that you can interact with. However, using
this control you can temporarily turn the extrusion off, so that you can see and modify the
underlying object using other tools, before turning the extrude on again. After making a
modification and turning the extrusion on again the extrusion is re-applied to your
modified 2D object, with all the same 3D attributes that it had when you turned off the
extrude.
Note that in some cases if you dramatically change the form of the object while the
extrusion is turned off (such as changing it to a completely different type of object), the
3D extrude attributes you applied may not be preserved. In such cases you should be
able to use PASTE FORMAT/ATTRIBUTES to copy the attributes from a copy of your original
extrude before the modification. See Copying styles: Paste attributes (on page 104).

Extrusion depth
The easiest way to adjust the depth of an extrusion is to simply click and drag on it, as
described above. However, you can also use the slider on the left of the EXTRUDE TOOL
InfoBar to adjust it. Make sure that EXTRUDE DEPTH is selected in the dropdown list to the
left of the slider (this is the default setting) and then use the slider to adjust the extrude
depth. The current extrude depth is shown in a numeric field to the right of the slider, and
you can also enter extrude depth values directly into that field to set an exact extrude
depth.

Bevel Type & Size
The bevel type determines the profile of the extruded side of your 3D shape and of its
edges and corners. By default it's set to rounded which gives a flat side with rounded
corners. The bevel type dropdown list contains a large selection of different bevel types
you can choose from. You can adjust the size of the bevel using the slider to the right of
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the bevel type list. To the right of the bevel size slider is a numeric field showing the
current bevel size and you can enter exact bevel sizes into this field.
An alternative shortcut to adjust the bevel size is to drag on the side of the 3D object
holding "Ctrl" (while in the EXTRUDE TOOL ).

Lights
LIGHTS ON/OFF

You can adjust the lighting of your shape in 3D space by turning on the lights. There are
3 lights, each of which can be given their own color and position in 3D space around the
3D shape.
In this example the face color of
the shape is set to white. But you
can see that it appears green
because there is a green light
shining almost directly onto the
front face of the shape.
By adjusting the colors of the face
and extrude and the positions and
colors of the three lights, you can
enhance the realism of the 3D
objects in your design.

Behind the object is a beige / orange colored light and another that is a purple color. Both
lights cause reflections down the side, and changing the color, or direction of the lights
behind will change the reflected highlights.
To move a light around the 3D object, simply drag on the light arrow. If you happen to
drop a light so that it is behind the 3D object and therefore isn't selectable, you can
retrieve it by using the left slider on the Extrude InfoBar. Select one of the light angles
from the dropdown list to the left of the slider (e.g. "Light 2 Angle 1") and then adjust the
slider. The light moves around the 3D object in your design. The various "light angle"
options in this dropdown list allow you to move any of the lights in any direction in 3D
space to achieve the positions you want. However for most purposes you can achieve
good results most easily by dragging the light arrows directly on the page.
To change the colors of the lights, you can simply drag colors from the color bar and drop
them directly onto the light arrows. To edit a light color with the color editor, double click
on the light arrow you want to change and the color editor opens with that light color
selected. You can now edit the light's color. With the color editor open, as you click on
the different light arrows, extrude face and extrude sides, the color selected in the color

3D Extrude Tool
editor dropdown list changes to match your selection, so you can quickly select the
different colors on your extrude to modify them.

Gloss / Matt
Use this toggle button to make the surface of a 3D object more or less
reflective. With the gloss option on lights placed at the correct position behind
the object will "bounce off" the sides to good effect.

Mitred corner / Rounded corner
You can choose either MITRED or ROUNDED corners for your 3D object.
"Mitre" gives square edges, while "Round" produces rounded edges.

Copying 3D extrude attributes
You can copy and paste the style of the 3D extrusion, from one 3D object to any other.
This works the same way as for all Designer Pro attributes. Simply copy the source
extruded object to the clipboard, and then select a new one and select " EDIT" > "PASTE
FORMAT/ ATTRIBUTES" . Note this will only paste the 3D attributes onto another 3D
extruded objects. So you will have to extrude any shape first before pasting the 3D
attributes.
This will copy all the 3D attributes such as the extrude depth, light colors, bevel type as
well as the face and outline colors.

409

410

Web Graphics and Websites

Web Graphics and Websites
Responsive web design
About RWD
With the increasing use of mobile devices for internet access there is an increasing
demand for website design tailored to mobile and tablet screen formats.
Although modern mobile devices such as phones have excellent web browsers able to
view any website, a mobile-optimized website should not require zooming to view the
text. So typically this means the main content would be a single column, in a larger point
size to be readable at a glance on a phone. Mobile websites often have reduced content,
and are navigable with single finger operation to scroll and navigate.
While you could create two separate websites, one designed for narrow screen mobile,
another for traditional wider desktop screens, replicating the content across two separate
websites would be tedious and time consuming, especially if you had to do this every
time you updated the text or images.
So Responsive Web Design is a technique that means your websites respond
dynamically to the screen size. Instead of having two separate websites, that is two
separate HTML pages, you instead have one web page that can vary its layout,
depending on screen size (and resolution) of the device being used to view the website.

Two variants of the same website. the first is how it looks on a wide screen display, the second
is for narrow screens such as mobile devices. The text column is narrower, and the pi ctures
and page elements re-arranged to suit a narrow screen.

Web Graphics and Websites
Responsive ‘Retina’ or HiDPI Resolution Control
Mobile and tablet devices differ from most desktop web browsers in that they support far
higher resolution graphics.Designer Pro supports this completely automatically, and will
produce both normal resolution and Hi-DPI or Retina resolution images for all graphics
and photos. The website then intelligently uses the correct version of the image
depending on the resolution of the browsing device.
Older browsers such as IE8 and earlier do not support RWD, so these will only show the
main variant of your website.

Multiple variants
Traditionally creating RWD sites can involve complex Javascript programming. But since
Designer Pro is a ‘zero programming’ designer focused tool, the user still has all the
power of freeform layout, ‘anything anywhere’ web design - and can also create multiple
variants of the same website. You can create one variant designed for narrow screen
mobile devices, perhaps another layout for intermediate small screen tablets, and
another variant for a traditional wide screen desktop.
The important thing is that the content - that is the text, the pictures, the graphics and
color schemes, are shared between all the variants. The second important point is that
the multiple layout variants for each page are not separate HTML files, but are all part of
one HTML file, that can dynamically and instantly change from one layout to another
depending on the browser width.
For each variant you produce you can customize the layout as much as you want. You
can resize and reposition elements on the page and these remain shared between the
variants. Edit the text for the narrow mobile variant and the text is updated for the other
variants. You can also choose to update the Text Style of a variant and have the
changes apply to that variant only. Or you can decide that you want different content or
graphics on one variant - mobile variants usually have reduced content.
When you add or delete a page in one variant, it automatically creates or removes the
page in the other variants. So your website always has the same page arrangement in all
variants.
Web pages have to be named (on page 49) in order to be shared across variants, if the
page is not named then one will be automatically applied.

Creating RWD Websites from templates
By far the easiest way to start using variants is to use one of the website template
designs from the ONLINE CONTENT CATALOG - Just import the website template to open it
and begin editing.
When you open a template you will see two document tabs, one will be the main website
document, referred to as the Main variant, and the other, narrower template will be the
Mobile variant. Designer Pro shows each variant in a separate tab, so you can quickly
and easily switch between the variants. You might find it helpful to organise your web
documents using the "WINDOW" > "ARRANGE VIEWS" menu option to line up your variants
next to one another.
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Creating RWD Websites from existing sites
To create a variant of an existing website you will need to open the
dialog - any of the following steps will do this:

WEBSITE VARIANTS

 Click "UTILITIES" > "WEBSITE VARIANTS" >"WEBSITE VARIANTS" .
 Right-click on the document tab and select "WEBSITE VARIANTS" to open the dialog and
also to view your variants.
 Right click anywhere in the document work area and select "WEBSITE VARIANTS" >
"WEBSITE VARIANTS" to view the dialog.

Website variants dialog

Click the CREATE button and choose a design width in pixels. The two variants above
describe webpages of 760 pixels for the larger Main variant, and a Mobile variant which
has default pixel width of 480 pixels. What happens is that a visiting web browser with a
width of 620 pixels or greater will see the Main variant, whilst a browser with a width less
than 620 pixels will see the Mobile variant.
You can view and edit the dimensions of the existing variants by clicking on the
PROPERTIES... button.
When you create a new variant, all the content of the main website appears, mostly
unchanged, but the page size has changed and the page background is adjusted. It’s
now up to you to re-arrange the layout as you wish for this new variant. You can move
items around the page freely, reduce the width of text columns, resize and re-position
images, and you have to do this for all the pages of your variant website.
You can change the title and the pixel width of a variant at any time by clicking on the
PROPERTIES and then UPDATE buttons in the dialog.
Note: The ‘breakpoint’ between two variants is half way between the widths of the two.
So in the above case for browser widths less than 620 it will show the narrow one and
widths above that it will show the wider one. Also note because most mobile devices
always try to fit the browser content into the screen, it doesn’t matter that your page is
wider than their screen pixels - it will be scaled down to fit by the browser.

Web Graphics and Websites
Sharing across variants
When you create a new variant, most of the content is shared or Liveshared across all
variants, but the size and position of that content is local to each variant.
 If you edit the text it will be changed in all variants.
 If you change the size of objects the change will apply to one variant only (it’s likely
that you will want objects to have different positions and sizes on the different
variants).
 If you drag and drop a photo onto an existing photo, it will be replaced in all variants.
 If you edited the shape of the photo or cropped it, or changed the fill (image size,
rotation or position inside the picture frame) then these are local to each variant. This
is useful because it means you can not only change the size and position of photos on
the variants, but change their aspect ratio and image crop.
Click on an object to see if it's Liveshared or not.
This photo has a double line marker,
top right, which indicates it’s
‘Liveshared’ on one or more variants.
You can resize, crop and adjust the
fill as required, and that will stay local
to each variant. but if you swap the
picture, say by dragging a new one
on top, then all variants will change.

When you create a new object - say a text area, photo or graphic, it's not initially shared
between variants. If you want to share it use the "UTILITIES" > "WEBSITE VARIANTS" menu
or just right click on it, and select "WEBSITE VARIANTS" > "SHARE WITH ALL VARIANTS" .
Select "STOP SHARING WITH VARIANTS" if you don't want an object to be shared across
variants. This menu also gives you the option of deleting the object from all variants.
Technical note: If you have different variants of photos, say a different size, crop or fill
position, then Xara has to create multiple versions of the photo for the published website.
However this does not have a significant performance overhead (it doesn’t slow down
your website), as the web browser loads the correct version initially, and then, in the
background, downloads the other variant images. So this means the initial version you’re
looking at (be in the mobile or desktop version) will always downloaded as fast as it can,
but that if you do change your browser width or orientation, it will instantly switch to the
other version.

Variants and repeating objects
When repeating objects (on page 106) like navigation bars, headers and footers appear
in variants they cannot be shared across the variants. Instead each variant has its own
separate repeating set of objects.
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Variants and Navigation bars
It’s likely that you will want a different Navigation bar design or layout on a narrow
variant. NavBars in each variant are independent, so you can customize them as
required, including changing the design of the bar by importing a NavBar design from the
ONLINE CONTENT CATALOG and dropping it on the existing bar in the variant you want to
change. You might for example want a horizontal bar for wide websites and a vertical
one for narrow devices.
One space-efficient solution for NavBars on a narrow mobile-friendly site variant is to
have just a single button NavBar with a menu of links to the other pages in the site,
instead of a bar with a button for each page. See Single button NavBars (on page 488)
for more detail.

Publishing variants
Publishing your site with variants is easy and no different to publishing an ordinary
website. Your website is able to automatically determine the resolution of the viewing
device and then serve the appropriate variant based on its width.
You can test this by changing the width of your web browser when previewing your site –
make it narrow and you should see it switch instantly to show the mobile variant of your
site.

High resolution images
High resolution images of the kind used by Apple's Retina(R) displays can be
automatically created by Designer Pro.
In order to take advantage of Retina type screens it is normally necessary to create all
your web photos and graphics at twice the normal resolution of 96 dpi - that is twice as
many pixels per inch both vertically and horizontally which is four times as many pixels
per square inch. The downside of this is that your files are now up to four times as large,
thus dramatically slowing down your website for all your visitors. For those visitors to
your website that do not have high-resolution screens this is an unacceptable penalty.
Designer Pro solves this problem by both automatically creating the high-resolution
photos and web graphics for you and also being smart enough to load the correct
resolution graphics for the browser being used.
So this means no speed or download penalty for the non Retina viewers, but for those
that do have high-resolution web browsers, they get to see the double resolution
imagery, and a much higher quality website.
This high-resolution creation of images is enabled by default - when you export your
website a Retina or high resolution viewer will see the larger resolution images and
graphics whilst a standard viewer will see images at a normal resolution. The only thing
you have to do - is to make sure that the images you want to appear as high-res are
saved in your web pages at a higher resolution than 100 dpi. as this is is the cut off
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point at which Designer Pro assumes you want an image to be rendered as high
definition. Images at a resolution below 100 dpi remain as standard definition images.
You would not normally need to worry about this as with the feature in its default enabled
state all images are optimized at 192 dpi in the OPTIMIZE PHOTO dialog and so therefore
well above the threshold for the creation of high resolution images.

Note that due to the much larger images and the fact that both normal resolution and
high resolution images are required, publishing Retina websites takes longer than
publishing non-Retina sites. If you wish to disable the feature go to the "WEB
PROPERTIES" > "WEBSITE" tab located on the UTILITIES menu, or else right-click on your
web document and choose "WEB PAGE PROPERTIES" > "WEBSITE" . Then uncheck the
RETINA (HI-DEF) IMAGES checkbox at the bottom of the dialog.
If you wish to re-format a standard definition site created in an older version of Designer
to one with high resolution images then bear in mind that you will have to import your
photos afresh to Designer Pro with the Retina feature turned on.
See Optimizing Photos and Bitmaps for more detailed information on image resolutions.

Website Toolbar
The WEBSITE TOOLBAR at the top of the Xara Designer Pro X window provides
convenient access to the main web functions you’ll use regularly.
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Preview web page/website
Link
Website Options
Publish Options

Move your mouse pointer over each button in the flyout bar to see a tooltip describing the
button.

Creating a website
There are two ways to create a new website. Either by starting with a pre-designed
template and then customizing this with your own text, photos and color scheme. Or by
creating a website from scratch, placing all the required elements, text, graphics, photos
and placeholders on the page as you require.

Using Templates, Clipart & Widgets
Open the Designs Gallery by clicking the Designs Gallery tab on the Galleries
bar or select "FILE" > "NEW FROM DESIGNS GALLERY" .
The “Web Theme” folders in the gallery contain collections of website designs and
associated graphic files that each follow a specific theme. Double click to open any file as
a new document.
Each theme section has a collection of alternative page layouts and some other useful
page elements such as buttons or expanding text panels. Each theme generally also
contains a complete website template and several ‘color schemes’. You can change your
entire site to a different color scheme (on page 197) by just dragging and dropping the
scheme from the gallery onto your page, or by just double-clicking on it. See the ‘Editing
Templates (on page 603)’ chapter for information on customizing templates.

Previewing Your Website
When creating your website in Designer Pro, your working document shows an accurate
static preview, but to check the behavior of pop-ups, mouseover effects and Flash and
other widgets it's necessary to use true Browser Preview.
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There are two preview options located on the web toolbar.

exports and previews only the current page. So it’s useful if
you have a large site which takes some time to export as a whole. You
can just quickly preview the page you are working on, without exporting
the rest of the site.
PREVIEW WEBSITE exports all the pages of your site and then brings up the
preview window. So all the pages and links in your site should be working.
PREVIEW PAGE

The navigation buttons in the top bar of the preview window allow you move back or
forward, just like in a web browser, and the Home button returns you to the page you
started the preview on.

You can preview your website or web page in full screen mode by clicking the
VIEW FULL SCREEN button at the top right of the preview window (press "Esc" to
exit or "F11" to enter and exit full screen mode). When you close the preview
window and next reopen it, Designer Pro displays the last mode you chose for
the window, i.e., normal, maximised or full screen.
If you’ve not yet exported your site, these previews export to a temporary folder on your
computer. Once you’ve exported, the same export location is used each time you
preview, so your exported site is continually updated as you preview.

Choose your preview browser
Although this internal preview uses a simplified version of the Internet Explorer browser
by default, you can choose one of the six most popular browser types to view your page
or website from the preview window.
To preview your website in your favorite web browser, click one of the following from the
bar at the top of the preview window:
Note: These buttons are only enabled if you have installed the browsers on your PC.
Previews your page or website in Google Chrome

Previews your page or website in Mozilla Firefox

Previews your page or website in Internet Explorer
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Previews your page or website in Opera

Previews your page or website in Safari

Previews your page or website in MS Edge (Windows 10 only)

When you click on one of the above buttons, the browser opens in the page that you are
currently viewing in the preview window.
If you want to preview your pages in a browser other than these types, you can right click
on the exported .htm file and select OPEN WITH... , or you can just drag and drop the file
onto an open browser window. Once you have exported then each time you click the
Preview buttons, the export is updated as well, and so it's just necessary to click the
Reload button in your browser (or press "F5").

Exporting a Website
To save your website, that is the HTML and associated files for publishing to
the web, use "FILE" > "EXPORT WEBSITE" or click this button on the top bar.
This saves a .htm file for each page and a folder alongside these which contains all the
graphic files that make up your website.
When you export a website, all the pages are exported together, and each page has _1,
_2 ... appended to the end of the name you give when you export. The _FILES folder
contains all the graphics and other files that go to make up your website. You can name
each page individually if you wish using the PAGE tab of the WEB PROPERTIES dialog, or
using the Page & Layer Gallery.
The default name given to your website is index.htm as this is the usual name for the first
page of a website.
You can preview your saved website in any web browser, by dragging the index.htm (or
any .htm) file from your Windows File Explorer onto a browser window.
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Web Animations
Using Web Animations
Web animations are a great way to add eye-catching visual content to your webpages.
You can take any object in your web document and quickly create an animated response
to an event like a mouse-over, a mouse-click or a screen touch. For example the items
can fade in when first displayed, can have a wobble animation as you mouse-over it, and
a different animation again when you click the item. You can also trigger pop-up layers
or pop-up text and you can have objects reveal themselves as you scroll down a page.
To animate an object, simply right-click on it and choose WEB ANIMATION from the drop
down menu, or go to "UTILITIES" > "WEB ANIMATION" .
Or click on the WEB ANIMATION button on the WEBSITE PROPERTIES flyout bar.
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This will bring up the WEB ANIMATION dialog...

The dialog has got tabs for Mouse-over events, Click/Touch events and Reveal/Scroll
events.
The Animation dialog is non-modal, which means it can stay on screen while you select
different items on the page. Click the APPLY button instead of the OK to keep the dialog
on screen. You can then select another item to change the animation on that without
having to re-display the dialog.
Preview your animations by clicking the PREVIEW CURRENT WEB PAGE button on
the web toolbar - to see them in the onboard browser.

Mouse-over features
With Mouse-overs - you can set a document default effect for the whole document - this
only affects items on the MouseOver layer like navigation bars, or buttons with a 2 state
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property (buttons with a link which change color as you mouse-over them). And you can
also set a mouse-over effect for an individual, selected object.
Click on the MOUSE-OVER tab dropdown menus to view and apply the effects.
 You can choose from one of six speeds for the animation effect ranging from VERY
FAST to VERY SLOW
 Enter some pop-up text which will appear when the object is moused over
 Have the mouse-over trigger a pop-up layer - another layer within your document, and
have that layer animate as well. Click the EFFECT button to bring up the Pop-up
settings dialog for the pop-up layer effect.
See Layers, Mouse-over & Pop-ups for more details.

Click/Touch animations
This tab allows you to choose an animation that will play when the object is clicked (or on
a touch device, touched). As with the Mouse-Over tab you can choose the animation
type and speed and can setup a default click/touch effect that will apply to all your
buttons that have a mouse-over graphic.

Reveal & Scroll animations
If you select the REVEAL/SCROLL tab of this dialog, you have the choice of applying either
a REVEAL ANIMATION or a SCROLL ANIMATION .
Reveal animations
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A REVEAL ANIMATION will make the object animate into view as it appears in the browser
window - either the first time, or every time it appears.

 Set an animation effect from the dropdown menu
 Set a speed for the effect using the SPEED slider
 Add a timed delay using the slider if so desired, so there is a pause before the object
reveals
Trigger object name
 Normally an object will be revealed as soon as it comes into view. However sometimes
you may want to have the object revealed only when some other object (the “ TRIGGER ”
object) comes into view.
 To name the trigger object just right click on it and choose NAMES... then apply a name
using the NAMES dialog. Now when you click on the TRIGGER OBJECT NAME: dropdown,
the name will appear for you to select.
For more information on applying names see Naming Objects (on page 70).
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Scroll animations
The SCROLL ANIMATIONS are similar to reveal animations, but they are linked to scrolling
of the document. So instead of the animations running once when the object appears
and then finishing, the object animates whenever the document is scrolled and the speed
of the animation is proportional to the scrolling speed. Scroll slowly and the object
animates slowly, as you scroll. Scroll faster and the object animates faster too. The
SPEED slider determines how fast the animation runs relative to the scrolling speed.
Parallax scrolling
The PARALLAX scrolling animation is where some objects on your page scroll at a
different rate to others, giving a parallax effect. PARALLAX appears near the top of the
scroll animation types. The speed slider determines how fast the object scrolls relative to
other objects on the page. If set very low, the object hardly moves at all as other objects
scroll past it. If set very high the object scrolls at almost the same rate as the other page
content, so the most useful speed values are towards the middle - try experimenting with
different speeds.
Note: If you have a low parallax scroll speed, items below the bottom edge of the
browser window may never appear.
Animations, Reveal animations, Scroll animations, Scrolling animations, Parallax
animations, Parallax

Object types and Animation combinations.
The table shows which object types work with which animations.
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Object Type

Reveal
Animations

Scroll
Animations

Mouse-over
Animations

Click Animations

Text

Yes

Yes

Yes

Yes

Images (including groups)
Placeholders/Widgets
Text Panels
Soft Groups
Stickies
Full width/height
Page Background layer
objects
Pasteboard Background
layer objects
Reveal Object Animations
Navbars
Objects on Pop-up Layers

Yes
Yes
Yes
Yes
Yes
No
No

Yes
Yes
Yes
Yes
No
Yes
No

Yes
No
No
Yes
Yes
No
No

Yes
No
No
Yes
Yes
No
No

No

No

No

No

N/A
Yes
Yes

No
Yes
Yes

Yes
Yes
Yes

Yes
Yes
Yes

Important: A few of the version 10 gallery widgets are incompatible with the new sticky
and animation features, if used on the same page or in the same supersite, and so may
need to be replaced with updated versions from the ONLINE CONTENT CATALOG . Click
here http://support.xara.com/index.php?/Knowledgebase/Article/View/816/ for details on
the support site.
"Animated Objects"
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Web Sticky and Stretchy Objects
Sticky Objects
Some websites have items on the page that stick on screen, and float over the page that
scrolls below, often navigation controls, or social network icons. These tend to be stuck
to the top edge of the browser window, sometimes to the left or right edge, and can’t be
scrolled out of the window. The benefit of sticky objects is that they are always visible. So
you can, for example, have direct access to page navigation without having to scroll up
the page.
You can make most types of object "sticky" whether it's a graphic, a bitmap (photo) or a
text object. And you can also add animations to your sticky objects. See Web animations
(on page 419) for more detail on this.

External links positioned as a sticky object on the far right of a browser window.

To make an object sticky or stretchy, first select it, and then click on the icon
on the WEB PROPERTIES (on page 445) flyout
 or choose the menu option "UTILITIES" > "WEB STICKY/STRETCHY..."
 or just right-click on it, and choose WEB STICKY/STRETCHY... from the dropdown menu.
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This will bring up the WEB STICKY/STRETCHY OBJECT PROPERTIES dialog. You can toggle
the function on or off using the checkbox.

Sticky Object Properties dialog

Stick at top
objects start off on the page and scroll with the page just like all your other
page content. But if you scroll the object’s position out of view, the object sticks to the top
of the browser window and so stays in view. Therefore it’s great for navigation bars.
STICK AT TOP

Sticky
For other STICKY objects - in the top half of your page, the distance between the object
and the top of the page determines the distance from the top of the browser window in
the published page. So if you place the object 20px from the top of the page, it will be
stuck to the browser window always 20px from the top, as the main page content scrolls
below it.
If the object is closer to the bottom of the page than the top, then it gets stuck to the
bottom edge of the browser window instead. So again, placing the sticky object 20px
from the bottom of the page will make it stick 20px from the bottom of the browser
window.
All sticky objects that you place on the page (or even just partially overlapping the page)
will be centered horizontally in the browser window, so they will always appear on the
page no matter how wide the browser window is, because the page is also centered in
the browser window. If instead you want the object to stick to the left edge of the browser
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window, place the object off the page to the left. Similarly if you want it to stick to the right
edge of the window, place it off the page to the right.
This is an illustration of items placed on and around the edge of a typical page.

The label text describes where an item placed at that location on the page, will appear on the
browser window.

And this is how that page will appear in the browser window.

Sticky items normally float on top of the rest of the page, so would normally be arranged
to be at the front of all the page content. However you can also have sticky objects
behind your page content if you place them on the Pasteboard Background (on page
435) layer.
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Preview the position of your sticky object in the on-board web browser by using one of
the web preview buttons.

Stretchy Objects
Stretchy objects help to create ‘pageless’ designs where there is no obvious page
boundary, where page backgrounds cover the entire browser window and stretch to fill
the browser width. The stretchy feature is designed to work only with rectangles and
photos and is unlikely to work usefully on any other shapes. You can make any rectangle
or rectangular image stretch to fill the browser window, either horizontally or vertically,
using the Stretchy dialog (the same dialog as the Sticky controls). These stretchy items
are normally intended as page backgrounds and so they appear behind everything else
on the page. You may even want to put them on one of the background layers (on page
431).
To create a Stretchy Object...
 Draw a rectangle on the page or select a rectangular image - typically you would make
this as wide or wider than the page and placed behind all other objects.
 Select the menu "UTILITIES" > "WEB STICKY/STRETCHY" or the equivalent option on the
right-click context menu
 Select the FULL WIDTH option.
As with Sticky objects you will need to preview the position (on page 416) of your
stretchy object in the on-board web browser before you can see your changes. You will
see it covers the entire width of the browser window.

Sticky/Stretchy properties dialog
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You may also want a sticky object to be full width or full height, so stretchy objects that
are also sticky appear in front of your main page content. For example you may want a
sticky header across the top of your web page, with a sticky navbar on top of it...

Both of these browsers have "stretchy" content which fills the width of the browser window.
The header/navbar is also "Sticky" as well as "Stretchy" and so the page content will slide
underneath it as it remains visible.

Stretchy objects can be set to either SCALE or TILE , using the option on the dialog. In
most cases you will want the stretchy object to scale up and down to fit the browser
window, so choose the scale option. This works well with photos and solid filled
rectangles.
If you have a rectangle with a textured fill you will normally want this to tile rather than
scale, so the texture looks the same with any browser window size. So select the tile
option in such cases. Also if you have a vertical graduated fill, choose the tile option.
Scaling Photos
You can make an image stretchy to occupy the full width of the browser window. In this
case the image will scale up as you increase the browser width, but it does so within the
height of the existing image (so it doesn't’t grow vertically and thus push everything else
down as you make the browser wider). This means that the image is progressively
cropped vertically, as it grows horizontally (the aspect ratio of the photo is never altered
as that would look poor).
If you want to use a photo as a stretchy item, make it at least the full width of the page,
and on the STICKY/STRETCHY dialog select FULL WIDTH . You can then decide whether
you want the image to scale around the top, centre or bottom of the image using the
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controls provided. The FULL HEIGHT stretchy works exactly the same way, but for vertical
stretched images (a lot less useful).
A Full width image can be scaled from the Top, Center or Bottom of the image.
A Full height image can be scaled from the Left, Center or Right of the image.
Resolution note: The photo needs to be a hi-res image (on page 414) because it’s going
to get stretched to fit the browser width - and that could easily be an HD screen size of
nearly 2000 pixels across. So using a low or even medium resolution image will result in
a blurred image when scaled to maximum width.
Sticky objects, Sticky animations, Stretchy animations, Stick at top, Scrolling navigation
bars,

Sticky and Stretchy object combinations
The table shows which object types work with which Sticky and Width/Height (stretchy)
combinations.
Object Type

Sticky

Width/Height

Text
Images (including groups)
Placeholders/Widgets
Text Panels
Soft Groups
Stickies
Full width/height
Page Background layer objects
Pasteboard Background layer objects
Reveal Object Animations
Scroll Object Animations

Yes
Yes
Yes
Yes
Yes
N/A
Yes
Yes
Yes
Yes
No

No
Yes
No
No
Yes
Yes
N/A
Yes
Yes
No
Yes

Navbars
Objects on Pop-up layers

Yes
Yes

No
Yes

Important: A few of the version 10 gallery widgets are incompatible with the new sticky
and animation features, if used on the same page or in the same supersite, and so may
need to be replaced with updated versions from the ONLINE CONTENT CATALOG . Click
here http://support.xara.com/index.php?/Knowledgebase/Article/View/816/ for details on
the support site.
"Sticky object combinations" "Stretchy object combinations"
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Website Backgrounds
Most of the page designs in the ONLINE CONTENT CATALOG have two types of
background. A wide Pasteboard background that extends across the background of the
whole browser window when your site is exported. And on top of this sits the Page
background with the various other elements that constitute the web page.
By default the ONLINE CONTENT CATALOG web templates have a Main variant and a
Mobile variant contained within the same web document.
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Pasteboard/browser background
Page background
Setting the Page and Pasteboard background colors
When you create a new blank document ("FILE " > "NEW ") the page defaults to being
transparent (no color) so you just see the pasteboard color behind it which is white by
default. This page area is where you place all the elements of your website. You will also
see a faint rectangle guide outline which shows the boundary of the page against the
pasteboard. You can turn this guide off should you wish - by right clicking on the page
and de-selecting "PAGE BACKGROUND" > "SHOW PAGE SIZE".
If you drag a color from the Color Line over the pasteboard, and drop it, the entire
background will be set to that color. This is because the page background in its default
state is transparent, thus reflecting the underlying color of the pasteboard. And this is
exactly what you will see in the web browser when you preview your page.
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However you can also make the pasteboard one color, as described above, and then set
the page background to a different color. Just drop a color onto the page background to
set its color. Now when you preview your page you’ll see the browser window
background color is set to the pasteboard color and you can see the page background
rectangle with its own color.

You can use the color editor to edit these colors. Right click on thepage and choose
"Page background" > "Edit page color" to bring up the color editor, then you can
edit the page color. To edit the pasteboard background color, right click on the
pasteboard and choose "Pasteboard background" > "Edit pasteboard color".
To reset the pasteboard background back to its default white color right click on the
pasteboard and choose "PASTEBOARD BACKGROUND" > "RESET" . To reset the page
background to its default clear or transparent state right click on the page background
and choose "PAGE BACKGROUND" > "RESET".
If you have more than one page in your website document and you want to apply
background and pasteboard colors globally, that is to every page in your website
document, then you can do this easily. Right click on either the pasteboard or the page
background and choose COPY PASTEBOARD BACKGROUND or COPY PAGE BACKGROUND
and then choose PASTE PASTEBOARD/PAGE BACKGROUND ON ALL PAGES.

Template Backgrounds and re-coloring backgrounds
Xara Designer Pro X allows you to import a range of pre-designed website backgrounds
directly from the ONLINE CONTENT CATALOG to your web document. Choose from the
selection of backgrounds in the WEBSITE BACKGROUNDS section of the gallery. You can
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then customize the textures with your own colors by dragging colors from the color line
onto the background or using a right mouse click on the background to bring up the
"PASTEBOARD BACKGROUND" > "EDIT PASTEBOARD COLOR" menu to display the color
editor.
When you change the color of a background that is composed of a range of colors you
will notice that Designer Pro will ask you which color it is you want to change. These
might be named colors - as would be the case if you were working from one of the readymade website template themes or colors that you had previously named yourself, or they
might be local colors which would be the case if you were changing your own choice of
color from an earlier selection. See Replacing Colors (on page 199) for more details.
Note that when you drag one of the stock website backgrounds onto the Pasteboard
Background it replaces all other objects currently on the Pasteboard Background layer
and so in this respect is a destructive operation.

Fixed, non-scrolling backgrounds
Normally if you have a long web page that can be scrolled in the browser, the browser
background scrolls with it, so the page content remains in the same place relative to the
background. But you can ‘fix’ the background so it doesn’t scroll with the page content.
Right-click on the pasteboard and select "PASTEBOARD BACKGROUND" > "FIXED" . Then
when you preview, the content slides over the fixed background as you scroll (to see this,
make sure your page is long enough so the browser shows a scroll bar!).
To switch back to the default, scrolling, behavior, select "PASTEBOARD BACKGROUND" >
"SCROLLING" .

Using photos as backgrounds
Creating photo backgrounds.
If you want to create your own photo or texture bitmap backgrounds rather than
customize the ready-made backgrounds from the ONLINE CONTENT CATALOG then it's
easy to do.
First, import the photo or texture into your document, just as you would to place it on a
page. Then right click on the photo and choose either SET PAGE AS BACKGROUND or SET
PASTEBOARD AS BACKGROUND, depending on which you want to set.
Tiling
Depending on the nature and size of the image, you may or may not want the image to
be ‘tiled’ repeatedly to fill the background. To change this setting, right click on the page
or pasteboard background (again depending on which you want to change) and select or
unselect the ‘tiled’ option in the Page Background / Pasteboard background sub-menu.
Fill browser window
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When using a photo on the pasteboard background (which becomes the web browser’s
background), there is a further option. You can opt for your photo to change size
depending on the size of the visitor’s browser window. As the browser window is resized,
the photo resizes to match. Right-click on the pasteboard and turn on "PASTEBOARD
BACKGROUND" > "FILL BROWSER WINDOW" .

Offsetting the top of your page
Normally if you just set the page and pasteboard to different colors, when you preview
you’ll see that the page extends right to the top of the browser window. You can’t see
any of the pasteboard color above your page. However you can add an offset so that
there is some space above your page in the web browser.
To add an offset, you change the page origin. Normally the page origin is set to be the
top left corner of your page. By moving the origin up 20 pixels, for example, you add a 20
pixel margin to the top of your page when it’s viewed in a web browser.
You can change the origin in two ways. The easiest way is to open the " UTILITIES" >
"OPTIONS" dialog (or right click a page and choose PAGE OPTIONS ), go to the GRID &
RULER tab and increase the value of the Y coordinate of the origin point. This is normally
set to the vertical size of your page, so just increase it by the margin size you would like.
So for example if your page is 700 pixels tall, change the Y value of the origin coordinate
from 700 to 720, in order to add a 20 pixel offset.
Alternatively you can set the origin point interactively. Turn rulers on by right clicking and
choosing "SHOW GRID/GUIDES" > "SHOW RULERS" or by choosing SHOW RULERS from the
WINDOW menu ("Ctrl + L"). Then click and drag on the crosshairs button, which is located
where the horizontal and vertical rulers join, at the top left of the canvas. Now you are
dragging around the origin position, so position it the appropriate distance vertically
above the top left corner of your page.
Changing the horizontal position of the origin has no effect on the horizontal positioning
of your page, so this should be left unchanged.

Page and Pasteboard Background Layers
If you open the PAGE & LAYER GALLERY you will see both the PAGE BACKGROUND LAYER
and the PASTEBOARD BACKGROUND LAYER. These layers hold the objects that make up
the two backgrounds in your document.
These layers are normally locked, so you can’t select and edit their contents. But you can
unlock them in the PAGE & LAYER GALLERY in order to perform some limited editing in
order to customize your page or pasteboard backgrounds. Just click on the lock symbols
next to the layers to unlock them. Once unlocked, you can make a background layer
current (so new objects are drawn on it) or edit the objects on them just as for normal
layers.
If for example you had chosen a different color for your page background, you’d see a
rectangle become selected (look at the status bar!) when you clicked on your page
background. You can now do some limited editing of this rectangle, such as give it a
graduated fill using the FILL TOOL , or give it rounded corners using the RECTANGLE TOOL .
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If you have placed items on the pasteboard - you might for example have graphics,
photos or other pieces of work in progress that you don't want to appear as part of your
web document - then these items won't appear when you preview the webpage. If you
do want them to appear as part of the background then you should move them onto the
PASTEBOARD BACKGROUND layer.

The two stars are on the PasteBoard Layer and so appear as part of the webpage when
previewed in the browser window.

Note that once you have unlocked a background layer it behaves exactly like any other
open layer. So for example when right-clicking on an object on the unlocked background
layer you'll see the normal layer menu which relates to the objects on the layer, and not
the menu relating to the background layer itself, which is what you see when the layer is
in its default locked state.
.

RWD Variants and Backgrounds
With a Responsive Web Design (on page 410) website, the main color or design of the
pasteboard background (the area around the page which determines the browser
window background when the page is published) can vary between one website variant
and another and each page and page variant is exported with its own pasteboard
rectangle.
The exceptions to this are vertical and horizontal Supersites (on page 470). Because
only one background can be displayed - only the pasteboard background from the first
variant of the first page is used.
You can place additional objects on the Pasteboard Background layer and these can
also vary between page variants. So for example you could have a shape overlapping
the page edge and this can be positioned differently in each variant, or be missing in
some variants.

Web Graphics and Websites
Links, Buttons & Navigation Bars
You can add a web link to any object, a button, graphic or some text.
Select the object and just click the link icon on the top bar to enter the web
address that you want to link to.

Enter the web address you want to link to in the highlighted field. You can also apply an
animated transition which the website will display when it opens.

The Link tab of the Website Properties dialog allows you to control what happens when
you click the linked object on the page. You can jump to any other web page (you can
quickly select to link to any other page within your website by using the LINK TO drop
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down) and you can control whether this opens the page in a separate window and/or with
a timed transition effect. You can also link to any pop-up layers or the previous or next
presentation step (presentation websites only) if you have created these; see Linking to
next/previous step (on page 505).
So to set one of your buttons to be a link, just select it (click on it in the
SELECTOR TOOL) , click the icon, and enter the web address, or just select one of
your pages from the drop- down list and click APPLY . That's it.
When you have created a link to an object you can quickly change its behavior by just
clicking on the object. A Pop-up will appear with the link's details and options to Change
or Remove the link.

You can also link to an anchor point anywhere in your website and link to any file. See
the Web Properties dialog chapter for more information.

Button Bars (NavBars)

Most websites, and so most of the template designs we provide, have a row or column of
buttons to navigate around the website or to other places. This is called a Navigation Bar
and Xara Designer Pro X includes special support for these bars. Read the Navigation
Bars Chapter (on page 484) for full details about Navigation Bars.

Layers, Mouseover (Rollover) & Pop-ups
All objects have a stacking order on the page - from the backmost to the frontmost item.
In addition, all items can be placed into named layers. Each layer can have any number
of objects, and has the ability to be turned on or off. When the layer is turned off all
objects on that layer become invisible.
The layers are controlled from the PAGE & LAYER GALLERY in the Galleries bar.
See the Layers & Page & Layer Gallery (on page 181) chapter for full details.
In website documents layers are used to provide mouseover (sometimes called rollover)
features on your website. These include highlighting buttons (they highlight when you
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move the mouse over them) and also other pop-up effects such as effects such as a text
panel containing a detailed product description.
You can also apply a transition to a layer, so that it appears on your web page in an
animated way.

Mouseover Effects
There are several types of mouseover effect you can control. Firstly the one used by
mouseover buttons, where any object with a web address can display an overlapping
graphic object that appears on a layer called MOUSEOVER . See below for more detail.
There also is a more powerful mouseover ability where you can make the contents of any
layer appear as your mouseover, or click any object on your page. This pop-up layer can
contain text, graphics, photos or any combination of these things. More below. You can
also add a wide range of animations effects see Mouse over properties for more details.

The MouseOff and MouseOver Layers
All the main objects on your website are placed on the bottom layer, usually called
MOUSEOFF . Buttons that highlight when you move the mouse over them on the web page
have an alternative graphic on the layer called MOUSEOVER .

If you open the PAGE & LAYER GALLERY you can show or hide any layer by checking or
un-checking the visibility icon (the eye symbol). This is a way of showing what your
MouseOver elements will look like on your page.
The current layer is always indicated with an arrow in the PAGE & LAYER GALLERY - the
MouseOff layer in the above diagram - and this is the layer that all new objects are drawn
on. To place objects on any other layers just click the required layer in the PAGE & LAYER
GALLERY , ensure the eye and the lock icon are open for that layer.
Note: The MouseOver layer must always be above, that is on top of, the MouseOff layer,
as shown in the above example.
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To edit the objects on a layer both the 'eye' and 'lock' icons have to be open - this means
you can see and edit the layer (as shown above in the MouseOff layer).

Mouseover (Rollover) Buttons
Almost all the ready-made buttons from the ONLINE CONTENT CATALOG have a
mouseover effect in Designer Pro. These are created by having two versions of each
button, the main one on the MouseOff layer and a 'highlight' one on the MouseOver
layer.
Normally you do not need to know or care about this because both buttons behave as
one - the changes you make to one, such as editing the label text, are reflected on the
other version. If you move, drag or resize a button on the MouseOff layer, the other
version on the MouseOver layer will change as well, even if you can't see it. This is done
using Soft Groups (on page 98).

Creating Your Own Mouseover Buttons
You can create your own mouseover buttons from scratch by drawing the necessary
elements from rectangles, text, etc. Just draw the main parts of the button on the
MouseOff layer (remember to group it) and place the corresponding 'highlight' version on
the MouseOver layer. As long as the MouseOff version has a web address link, then the
MouseOver version will automatically be displayed as you move the mouse over it on the
web page. (The MouseOver layer must be on top of the MouseOff layer).
In other words, you give the main object a web address using the link option, and
then select the MouseOver Layer in the PAGE & LAYER GALLERY , and place the
required mouseover versions of your button on this layer so it overlaps the linked
object.
Technical note: Any graphic object on the MouseOver layer will be displayed as long as
at least 50% overlaps with the object on the MouseOff layer. The two versions of
mouseover buttons are kept in sync by using the Soft Groups feature. When you select
the button on one layer, it automatically selects the Soft Grouped version on the other
layer, even if the layer is switched off. When you edit the text of the button on one layer,
it's automatically synced with the other version of the button.
To ensure the text on both the Off and Over states changes when you edit either, Soft
Group the buttons on both layers. To do this you will need to enable both layers in the
PAGE & LAYER GALLERY , and lasso select around both buttons. The status line should tell
you if you have everything selected. Select "ARRANGE" > "APPLY SOFT GROUP" . Now
when you edit the text on the Off layer it will also change on the over layer, even if it's
hidden. (Note this only works if the Off and Over text are the same to start with, and
relies on the objects being Soft Grouped).
Once you have a working button, you can easily turn it into a navigation bar. Select the
button (along with its MouseOver state if it has one) and then choose "ARRANGE" >
"CREATE NAVIGATION BAR" . The navigation bar dialog appears allowing you to configure
your bar. See the Navigation Bar chapter (on page 484) for more information on this,
including how to have different first and last buttons in your bar.
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Layer ordering in website documents
If your website document has mouseover effects, pop-up layers and perhaps even
mouseover effects on those pop-up layers, there are some important rules you need to
follow in terms of how you order the layers in your document.
Considering the layers in turn from background to foreground (which is working upwards
in the Page & Layer Gallery), first you must have all the static layers. These are layers
which are always visible and are not used as pop-ups. In most designs there will only be
one – the “MOUSEOFF ” layer. But some designs may have several, in which case they
must be the first layers in the layer stack.
Next comes the MOUSEOVER layer, if there are mouseover effects on the static layer(s).
This contains the mouseover states for all your mouseover buttons. This must be
followed by the “MOUSEDOWN ” layer, if you have mousedown effects on the static
layer(s).
Next you may have a pop-up layer. If the objects on this pop-up layer have mouseover
effects, then the next layer following the pop-up layer must be the layer holding those
effects. It must have a name that begins with “MouseOver”, E.g. “MouseOverPop-up1”.
And then if the pop-up layer also has mousedown effects, a layer whose name begins
with “MouseDown” must follow containing those effects.
Then you can have another pop-up layer, followed again by any mouseover and
mousedown layers for that pop-up layer. And so on - you can have as many pop-up
layers as you like.
MouseDown pop-up n
MouseOver pop-up n
Pop-up layer n
...
MouseDown pop-up 1
MouseOver pop-up 1
Pop-up layer 1
MouseDown
MouseOver
Static layer n
...
Static layer 2
MouseOff
Note that you only need to be concerned with these ordering rules if you are building
complex pages with multiple pop-up effects! If you are just using the template designs
provided in the Designs Gallery, you should not have any problems with layer ordering.

Pop-up Layers
A more powerful alternative allows you to display the contents of any layer as a result of
mousing over, or clicking, any object. This can be used for a range of different pop-up
effects such as pop-up photos, menus or detailed object descriptions.
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To do this, place all the objects you want to pop-up on a new layer (in the Page & Layer
Gallery click NEW - don't use the MouseOver layer), then set the Mouseover property
(WEB PROPERTIES dialog) of the original object to trigger the display of this layer when
you mouseover any other object. For example you can make a pop-up, like this, appear
as you mouse over some text:

Here are the steps to create a pop-up text block like this:

1.
2.
3.

4.

Select a layer in the PAGE & LAYER GALLERY and click NEW to create a new layer.
Draw a rounded rectangle with the RECTANGLE TOOL , click a (pale) color patch on
the COLOR LINE (on page 190) to give it a fill color. For good measure give it a soft
shadow (select the SHADOW tool and just drag on the rectangle).
Create a block of text on top of your rectangle. Select the TEXT TOOL and drag
diagonally across the rectangle. Type your text. You probably want to hide the popup layer now, so click the eye icon against your new layer in the Page & Layer
Gallery.
Back on the base (MouseOff) layer (click it in the PAGE & LAYER GALLERY to set this
as current layer) now select the text you want to trigger the pop-up, using the usual
method (in the Text tool). Then open the WEB PROPERTIES DIALOG (on page 445)
(Ctrl+Shift+W) and on the MOUSE-OVER tab select the new layer from the 'SHOW
POPUP LAYER ' drop down menu. Click OK.

5.
If you want the pop-up to only appear when you click, then select the same option on the
LINK tab of the same WEB PROPERTIES DIALOG (on page 445) instead.
Note: The mouseover layer appears and disappears as you move the mouse pointer on
and off the triggering object. If you use a click method to display the layer (from the Link
dialog), then the layer is revealed by a click on the object, and is hidden when you click
anywhere else on the page.

Thumbnail Photos With Pop-ups
You can very easily create small thumbnail photos that when clicked will show an
enlarged version. Simply resize your photo to be small, the usual way using the
SELECTOR TOOL .
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Select the small thumbnail photo, and select the POP-UP PHOTO option in the LINK
tab of the Web Properties dialog (click the LINK button in the WEB TOOLBAR ).
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Click the SETTINGS button next to the popup photo option, to change to the
the Web propertiesDIALOG.

IMAGE

tab of

There you can change how your pop-up appears. One option allows you to place a title
above each pop-up photo. Set the title for each photo using the TITLE field. You can also
optionally show a caption below each popup photo. Just set the IMAGE CAPTION (Alt text)
for the thumbnail on the same dialog. See the popup photo section of the Web Properties
Dialog chapter for full details of the options available.

Applying settings to popup layers
You can apply a transition to a popup layer to control how the layer appears, as well as
choosing how the popup layer closes.

1.
2.
3.
4.

5.

Click the layer in the PAGE & LAYER GALLERY and click the PROPERTIES button at the
top of the gallery.
Click the POP-UP SETTINGS tab of the Layer properties dialog.
Choose an effect from the TRANSITION EFFECT drop-down list and move the slider to
set a speed for the transition in seconds.
Choose how you want the popup layer to close using the check box. Leave it
unchecked if you want the popup layer to stay open until you close it manually, or
else check the box if you want it to close automatically when you click on another
part of the webpage.
APPLY
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Note: The mouseover layer appears and disappears as you move the mouse pointer on
and off the triggering object. If you use a click method to display the layer (from the Link
dialog), then the layer is revealed by a click on the object, and is hidden when you click
anywhere else on the page (or when you click on the pop-up layer’s close button if you
have turned off the "Close pop-up automatically" option shown above).

Web Properties Dialog
The Web properties dialog is a multi-tabbed dialog which allows you to add and configure
most of the web related features in Xara Designer Pro X and set different web properties
on objects, on pages and on your whole website. Open it by right clicking an object and
choosing WEB PROPERTIES or by using the “UTILITIES" > "WEB PROPERTIES… ” menu option
(shortcut Ctrl + Shift + W).
Each tab of the dialog is also directly accessible using the buttons on the Web Properties
flyout bar, available on the Website toolbar.
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Link Tab
Website Tab
Page Tab
Image Tab
Mouse-over properties (on page 419) (part of the Web Animation dialog)
Placeholder Tab
Web Animation dialog (on page 419)
Web Sticky/Stretchy dialog
Publish Tab
Analytics Tab (on page 468)
Edit NavBar
The dialog is modeless, so you can leave it open while you select different pages and
objects in your document. This makes it easy to quickly set properties on different objects
and pages in your website. Use the OK button to apply your changes and close the
dialog, or the APPLY button to apply your changes without closing.
Note that when you have an animation design as your current document, the WEB
PROPERTIES dialog appears in a modified form, with some controls different and many
others disabled because they don’t apply to animations. Refer to the Animations for
information about using this dialog with animation designs.
The following sections cover each tab of the dialog in turn.
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Link Tab

The settings on this tab apply to the selected object(s) or selected text. Typically you use
this tab to add a link to an object on your web page (eg. a button or photo), or to some
text, so that when a visitor to your site clicks on the object/text, they are redirected to
another page. You can add links to other pages in your website, to a URL (web address)
or even cause a pop-up window to appear.
To add a link to just some of the words in a paragraph of text, go into the TEXT TOOL and
drag over the text you want to link, to select it. Then set up the link in this tab.
The main section of this tab allows you to choose what should happen when the selected
object or text is clicked.

Link to web address
Enter a web or email address to link to that address. If you leave the “CORRECT ADDRESS
AUTOMATICALLY ” checkbox selected, your address will be adjusted if required when you
click OK or APPLY . For example, if you enter "www.Xara.com" it will correct it to
"http://www.Xara.com/".
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You can put an email address in the Link address field, in which case clicking the link will
launch the reader's email program with the To: field filled in. You can also optionally
specify the subject line to be used, add CC or BCC email addresses to be copied on the
email and even specify the default body text to be used. For example this sets the To
email address and all four optional parameters:
yourname@wherever.com subject:Email from website cc:another@wherever.com
bcc:yetanother@wherever.com body:Auto-generated email
Technical note: Xara Designer Pro X encodes your email address to reduce the
likelihood that SPAM robots will find your email address from the web page. This requires
Javascript to be enabled in the browser (currently >95% of browsers).

Link to...
Select this option to link to another page in the current website, or if you are in a
presentation document, to link to the next or previous presentation step. The drop-down
list allows you to select which page or step to link to. You can also choose this option to
link an object to the top of the page - creating a rapid jump from the bottom of a long
page to the top.
TIP: If you have many pages in your website document, giving each one a name makes
it much easier to set up and maintain your page links, because the page list will show the
page names instead of just “Page 2”, “Page 3”, etc.
See the PAGE TAB (on page 455) section below for details of how to setup page
names, or edit the names in the PAGE & LAYER GALLERY .
In addition to an entry for each page in your site, the dropdown list also contains the
special entries NEXT PAGE/PRESENTATION STEP, PREVIOUS PAGE/PRESENTATION STEP and
TOP OF PAGE .
Next/Previous page
Use these to add a link which leads to the next or previous page in your site. For the
purposes of such links, the page order is determined by the order of the pages as they
appear in Xara Designer Pro X. A “next” link on the last page links to the first page and a
“previous” link on the first page links to the last page.
Next/Previous presentation step
Use these to add a link which leads to the next or previous presentation step in your site,
if your website is a presentation document. The presentation order is also determined by
the order of the steps as they appear in Xara Designer Pro X, similarly to next/previous
page.
Top of page
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If you want to link back to the top of a particularly long page - create an object at the
bottom of your page (typically a button or a text object) and then select the "TOP OF
PAGE" link option. The link will then take you straight up to the top of the page.

Link to anchor
This option allows you to jump the visitor to a specific part of any page in your website.
To setup an anchor point, first go to the page and object you want to be jumped to.
Select the object and add a name to it by right clicking and choosing the NAMES... option.
Then select the object to which you want to add the link and choose the anchor name
you added from the list provided with the “Link to anchor” option.
Note that when you link to an object which is a long way down a web page, the web
browser automatically scrolls the page down so that your anchor object is visible.
NOTE :

You cannot apply a transition to a link to an anchor.

Link to heading
Link automatically to any of the headings within the document. This saves you the bother
of having to trawl through a long document when you want to link to a particular section.
Click on the dropdown to see the list of headings. Then choose the heading you want
your selected text or object to link to from the list. Bear in mind that the heading must
have a heading text style (on page 251) assigned for it to appear in the list.
The list is divided according to pages, and then subsequent headings with each heading
occupying an indented position according to its outline level.

Link to File
This link option is useful if you want to add a document, movie or any other file to your
website to make it available to your visitors. For example you may have a PDF document
that you want to make available.
Select the object or text that you want to link. Then turn on this Link to file option and
use the BROWSE button to browse for the file on your computer. The name of the file
appears in the text field to the left of the Browse button. Click OK and your link is applied.
As well as applying the link, Xara Designer Pro X has now taken a copy of your file and
placed it in the support folder for your design. This is a folder next to your .web or .xar
file. If your design is called "MySite.web", the support folder will be called
"MySite_web_files" alongside it. All the files in the support folder get published along with
your website and so that means your file will be published with your website and so the
link you just added will work. See the Document Handling chapter (on page 50) for more
information on support folders.
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Note: Because there is a separate copy of your file held in the support folder for your
design, you need to update that copy whenever you modify the file and want to publish
the modified version. Or you can just go through the above linking process again and
browse for your updated file. Also if you move or copy your website design to another
computer, or give a copy to someone else, you need to make sure the support folder
accompanies the design file, since it now contains an important part of your website!
NOTE :

You cannot apply a transition to a link to a file.

Pop-up layer
You can add any content you like to a separate layer on your page and have that content
shown as a pop-up only when your visitor clicks on a link. For example you could add
some descriptive text about a photo on your web page and have that text only shown to
the user if they click on the photo.
To add a popup layer, first you need to add the layer itself using the
LAYER GALLERY and add your pop-up content to that layer.

PAGE &

See the PAGE & LAYER GALLER y (on page 177) chapter for full details. Then you can
select the layer from the layer list provided next to the “Pop-up layer” option.
You can also add a transition effect which is applied when the layer appears. In the PAGE
& LAYER GALLERY , open the layer properties so that you can apply a transition directly to
a layer (on page 444) to achieve an animated effect when the layer contents appear. Or
you can click the Settings button next to the pop-up layer option in the Link tab, to access
the same layer properties.
Now when a visitor clicks on your object, the layer contents appear! By default, clicking
anywhere else on the page makes the pop-up disappear again. But you can make the
pop-up layer stay up until it’s explicitly closed by the viewer. Just unselect the CLOSE
POP-UP AUTOMATICALLY checkbox in the Layer properties dialog. Then a close button is
included in the top right of the pop-up, and it stays on screen until the close button is
pressed.
Note that you can also get to the Layer properties by clicking the "Settings…" button next
to the pop-up layer option in the Link dialog.
Note that all the content on the pop-up layer is loaded as soon as the visitor visits your
page. So if you want to provide a lot of pop-up photos, use the Pop-up Photo feature
described below instead.

Pop-up photo
This option gives you a very easy way to add pop-up photos and other photo gallery
features to your website, without adding any layers! Simply import your photo and use
the SELECTOR TOOL to scale it right down so it appears as just a small photo thumbnail
on your webpage. Then select it and choose this "POP-UP PHOTO " option.
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Click the SETTINGS button next to this option to go to the IMAGE TAB , where you can set
the size of the pop-up photo, add a title and caption, and choose from many other
options. See the Image tab section below (on page 457) for details. Selecting the pop-up
photo option on this Link tab, also selects the pop-up photo checkbox on the Image tab –
both turn on the same pop-up behavior.

Use common website link colors
This option lets you choose how the selected text link should be displayed. It is selected
by default, meaning that the text link will show with the link color you have defined for the
whole website. You can set this color on the Website tab (see Website Tab (on page
452) section).
If you uncheck this option, then the selected text link will keep the color that you give it on
the page. So you can give different links different colors if desired.

Open link in
This option does nothing if either of the “Pop-up layer” or “Pop-up photo” link options are
selected. But for other links it allows you to tell the web browser how the target web page
should be loaded. By default it is set to “Not specified” which usually means the browser
will open the link in the same browser window and frame as the link.
The dropdown list contains four options that cause the browser to do special things. You
can select one of these options, or type in the name of a frame:
NEW WINDOW OR TAB (_BLANK)
SAME FRAME (_SELF)

Open the link in a new browser window.

Open the link in this frame (the frame that contains this object).

PARENT FRAME (_PARENT)

Open the link into the parent window or frameset that contains

this frame.
SAME WINDOW (_TOP)

Open the link into the main browser window, replacing any existing

frames.
If you want the link to be loaded into a specific frame in the browser, type the name of the
frame in this field.

Clickable area
This option lets you specify what area of the object must be clicked on to invoke the link.
However it is not supported for HTML websites (the rectangle surrounding the object is
always used), it works only when exporting to Flash.
SHAPE OF OBJECT :

The user must click inside the exact outline of the object to invoke the

link.
RECTANGLE SURROUNDING OBJECT :

The user can click anywhere in the rectangle
surrounding the object (the bounding box) to invoke the link.
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Website Tab

The settings on this tab apply to the entire current document/website, so it doesn’t matter
what object or page is selected.
TITLE, DESCRIPTION & KEYWORDS :

These fields are just as described in the Page Tab (on
page 455) section. You can optionally set these fields here so that they apply to every
page in your site, unless overridden by the Page Tab settings for a page. So for example
a page that doesn’t have its own title set in the Page Tab will get the title you specify
here.
These buttons serve the same purpose as the
HTML code (head) and HTML code (body) buttons in the Page Tab section, and allow
you to enter and edit large amounts of HTML code to either the head or body sections of
all your website pages.
HTML CODE (HEAD) AND HTML CODE (BODY):
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If code is specified here in the WEBSITE TAB it is included in every page of your site in
addition to any code specified for each page in the Page Tab. This allows you to have
some code included on every page, while also adding other code to those pages that
need it.

Website Link Colors
This section of the Website Tab allows you to control how text links appear on your
website.
UNDERLINE TEXT LINKS :

Underlining is commonly used to highlight clickable links in text,
so this option is selected by default. Uncheck it if you don’t want your text links
underlined.
MOUSE OFF :

Here you can choose the color you would like to be used for all your text
links. You can either choose a named Theme Color from the dropdown list (if there are
any in your current document) or click the Edit button to open the Color Editor so you can
choose any other color.
MOUSE OVER :

Text links will change to this color when a visitor moves the mouse pointer

over them.
VISITED :

Text links that point to a page which the visitor has already visited will display
with this color instead of the Mouse Off color.

Clip to page edges
This option is enabled by default. If you have objects in your website that overlap the web
page borders, click this checkbox to crop these objects so that only the portion on the
page is visible. Deselect this checkbox if you would like the object to flow over the page
edge, so that even the portion that overlaps the pasteboard is displayed.
Note that if you have an invisible page (the default for new web documents, or if you’ve
applied ‘no color’ to your page), clipping to the page edge does not happen even when
this option is turned on.

Presentation website
Click the PRESENTATION WEBSITE checkbox to convert an existing website into a
presentation.
Note: If you created your presentation document by choosing PRESENTATION 955 PIX
from the NEW menu, the PRESENTATION WEBSITE check box is automatically selected.
Note: If you have transitions applied to a layer or presentations step transitions that slide
in from the sides, top or bottom of the page, disabling this checkbox causes the transition
to come in at the edge of the browser window, rather than the page edge.
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Retina (enabled by default)
When this option is on, Designer Pro will export high resolution versions of each image in
your website, in addition to images at normal screen resolution. This means devices with
very high resolution screens will see higher quality images.
See High Resolution Images (on page 414) for more information.

Web Export Options
The WEB EXPORT OPTIONS dialog allows you to choose how you want your website to be
published. You can choose between exporting your website as a CONVENTIONAL WEBSITE
(with a separate HTML file for each page), where you click through the pages using
conventional navigation, or a SUPERSITE (the whole site in a single HTML file) which lets
you present your website with animated transitions between pages, or as a vertical or
horizontal arrangement of pages, which users can swipe through on mobiles and tablets.
The default setting for the dialog is

CONVENTIONAL WEBSITE .

See Supersites (on page 470) for more details on adding transitions and display options.
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Page Tab

The options on this tab apply to the current page, not to the selected object(s). The
current page is indicated with black angle lines just outside each corner of the page. All
fields on this tab are optional; you do not necessarily need to fill in these fields for every
page of your site.
If you want the same title, description and keywords on every page of your site, you can
set these just once on the Website tab instead of setting them on every page here.
PAGE FILENAME :

Use this field to set the name you’d like to be used for this page when it
is exported. So if you want the page to be exported as “home.htm”, set this field to
“home”.
It’s usual to make the first page of a website “index.htm” or “home.htm”, because if a
visitor specifies a URL consisting of just a domain name with no page name (eg.
“www.xara.com”) this is usually automatically mapped by the web server to the index.htm
page if it is present. Note that characters entered in this field are automatically converted
to lower case and accented characters and some non-alphanumeric characters are not
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allowed. This is to reduce the chances of compatibility problems with different web
servers when you publish your website.
You can optionally choose a title for your page. If set, this is used by web
browsers to show a page title in the browser window frame, or tab. For example at the
time of writing the www.xara.com home page has the title “Graphics Software by Xara”
which you can see is shown by the web browser if you visit the site.
PAGE TITLE:

Advanced: The title is inserted into the page header using the ‘<title>’ HTML element.
PAGE DESCRIPTION :

This page description text can be shown by search engines within
their search results when visitors find your page with an internet search. The page
description may also be displayed by browsers and other web services.
Advanced: The description is inserted as metadata into the page header
(‘<meta name="description" …..).
Here you can enter keywords which you want to be picked up by
search engines to help visitors find your site. Enter words which potential visitors are
likely to search for if they are looking for pages or sites like yours.
PAGE KEYWORDS:

For those familiar with HTML, the keywords are entered into the page header as
metadata:Advanced: The keywords are inserted as metadata into the page header
(‘<meta name="keywords" …..).
Click to open the HTML Code (head) dialog, where you can paste or
type HTML code directly into the head of your web page. The code is inserted
unmodified just before the closing “</head>” tag.
HTML CODE (HEAD):

Click to open the HTML Code (body) dialog, where you can paste or
type HTML code directly into the body of your web page. The code is inserted unmodified
just before the closing “</body>” tag.
HTML CODE (BODY):

These dialogs must be used with care because inserting invalid code or script into your
page may cause serious problems to the web page as a whole.
If you need to insert exactly the same code on every page of your site, you can use the
HTML code (head) and HTML code (body) buttons on the Website Tab of this dialog,
instead of entering it for every individual page using the Page Tab.
You can only enable individual page transitions if your page is part
of a SUPERSITE . See the WEB EXPORT OPTIONS dialog on theWEBSITE TAB TO TURN ON
TRANSITION EFFECT:

THIS OPTION. ONCE YOU'VE DONE THIS CHOOSE AN INDIVIDUAL PAGE TRANSITION FROM THE
DROPDOWN MENU.

(on page 452)
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SPEED (SECS):

Drag the slider to choose a transition speed from 0 to 5 seconds.

By default when a transition is applied, objects will only slide in/out to the edge of the
web page. If you would like objects to start from the browser window edges, rather than
the web page edges, deselect the CLIP TO PAGE edges checkbox in the Website tab (on
page 452) of the Web Properties dialog.
Note that the individual transitions you set here at the page level take precedence over
the global transition settings in the Supersite settings.
Technical Note: Page transitions work by first loading the target page into a hidden
iFrame and then revealing that iFrame with the visual effect. Then the target page is
loaded again normally. This second load of the target page is usually not noticeable, but
depending on the speed of the viewer’s machine and the browser version they are using
(particularly older browsers), sometimes the page is seen to flash briefly at the end of the
page transition.

Image Tab
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Photo pop-up
This section of the IMAGE TAB lets you add pop-up photos and other photo gallery
features to your web page easily. Simply import your photo and use the SELECTOR TOOL
to scale it right down so it appears as just a small photo thumbnail on your webpage.
Then with the photo still selected, select the Pop-up photo checkbox on this tab. Choose
the size you would like for the pop-up photo by entering a value in the pop-up width field
(default 500 pixels). Preview your page and click on the photo thumbnail on your page, to
see the pop-up photo appear.
When you turn on the pop-up photo feature here in the IMAGE tab using the checkbox,
the corresponding option on the LINK tab is also automatically selected for you. That’s
because a click on the photo will show the pop-up photo, so you can’t also set any other
clickable link on the same object. So any link you previously setup on the object, using
the Link tab, will be removed.
One big advantage of these photo pop-ups over pop-up layers (as described in the LINK
Tab section above) is that the large photo is only loaded by the web browser when the
visitor clicks on a thumbnail. Therefore this method is much more suited to presenting a
large number of photos on a gallery page, because only the small thumbnails are loaded
initially, making the page load quicker.
Note that this feature works on objects other than photos, such as shapes and groups,
but can’t be used directly on text. You can put text inside a group (Ctrl+G) to work around
this restriction.
Pop-up title
Give the selected photo a title using this field and it is shown above the pop-up photo.
Note that you also need to turn on this title option in the Pop-up photo options dialog (see
below), because titles are not shown by default.
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Popup Photo Options
Click the OPTIONS button to bring up the POP-UP PHOTO OPTIONS dialog. Here you can
choose from a variety of options that change the way your pop-up photos are presented.

Popup Options
The following options change the appearance of the popup photo.
DIM PAGE WHILE POPUP IS OPEN :

With this option selected, the entire page is dimmed
whenever a popup photo is displayed. This helps emphasize the popup photo, so that it
stands out against the darker background of the page.
SHOW SHADOW BEHIND POPUP :

This option puts a drop shadow behind the popup photo
window, again to help make it stand out against the page background.
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SHOW IMAGE TITLE :

If you have entered title text (see above) for each of your photos, this
option causes that title to be above the popup photo.

Note that title text is separate to any caption text, which appears below the photo. See
below for information on setting caption text.
Gallery Options
The following options turn on gallery features for your popup photos.
SHOW GALLERY BROWSER CONTROLS :

Turn this on to show gallery controls on your popup

photo.

This appears on top of your photo whenever the mouse pointer is over the photo. It
allows your site visitor to view the other popup photos in the current page, without having
to close the popup window and click on the thumbnails for the other photos. The visitor
can move to the previous or next photo, or start and stop an automatic slideshow where
each photo is shown for a few seconds before moving onto the next.
SHOW THUMBNAIL STRIP AT BOTTOM OF PHOTO :

With this option on a strip of small photo
thumbnails appears below the popup photo window. This allows the visitor to jump to any
of your popup photos by just clicking on the thumbnails in the strip, again without having
to first close the popup photo window.
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AUTOMATICALLY START SLIDESHOW :

Turn this on if you want a slideshow to start as soon
as the user clicks on any of your popup photos. You can also choose how many seconds
each photo should be displayed for when the slideshow is playing.
Note that the only photos included in the photo gallery are those photos on the current
page which are setup as popup photos. Any other photos on your page will not appear in
the gallery, so make sure you use the Link tab of the Web Properties dialog to turn on the
popup photo option on any photos that you want to be included in the gallery.

Image Captions
You can optionally show a caption below each pop-up photo. Enter the caption text in
this field in the Image Tab.
Note that this feature works on objects other than photos, such as shapes and groups,
but can’t be used directly on text. You can put text inside a group (Ctrl+G) to work around
this restriction.
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For those familiar with HTML, this text is also used as the "ALT" text on the image that is
exported for the currently selected object, whether or not the image also has a pop-up.
Web browsers show this text on the page in place of the image, if the image can’t be
obtained for some reason.

Web image type
Due to the nature of HTML websites, most objects you see and can select on the page in
Xara Designer Pro X have to be converted to bitmap images during the process of
exporting your website. This all happens automatically for you when you preview and
export, but the controls on this tab give you some control over how these images are
created.
Remember that each group, shape, heading, logo, photo, panel background, etc. is
exported as a separate image. By looking at how the objects in your design are grouped,
you can control how many images are exported to make up your website. So for example
if you have 2 separate shapes in your design which are not grouped together, they will be
exported as 2 separate images. You can group the two shapes (Ctrl+G) and then a
single image is exported instead.
This section of the Image Tab lets you specify how the currently selected object should
be exported as an image. By default Xara Designer Pro X will decide for you. This means
that normally photos will be exported as JPEG (which is usually the best format for
photos) and other objects as PNG (which is usually best for graphics). Photos which
have been rotated on the page, or which have a semi-transparent shadow applied, are
exported as PNG because JPEG does not support transparency.
You can force the selected object(s) to export as a JPEG or as a PNG, by selecting the
appropriate option. When the JPEG option is selected, you can also choose the JPEG
quality to be used for that image. Higher quality means a larger JPEG file size.

Group images
Normally if you group multiple objects together, those objects are exported as a single
image in your published website. For example if you group a photo with its caption text,
the whole group appears as an image in your website, so the text is not selectable in the
web browser.
By default, existing groups and new groups are set to ONE IMAGE FOR WHOLE GROUP . But
if you change the setting to SEPARATE IMAGES FOR GROUP MEMBERS, then the grouped
objects will export individually as if they were not grouped at all.
It’s not advisable to use this option on very complex groups such as artwork that is made
up of tens or even hundreds of vector shapes. It’s more efficient for such groups to
export into the website as a single image. But for simpler groups such as a group of
photos, it’s best if they are set to export separately because then each object can have
its own individual settings. For example each photo could be set to be a popup, or have
its own reveal animation.
And it’s especially useful for groups containing text, so the text remains as text in the
published site.
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Once you have changed this new property on a group, so it’s set to SEPARATE IMAGES
FOR GROUP MEMBERS , it will then allow you to set properties on the objects inside the
group. You can use Ctrl+click to select objects inside the group and then apply links,
reveal animations, etc. to the objects.

Publish Tab
The PUBLISH tab of the WEB PROPERTIES DIALOG is where you configure or change the
settings which allow you to publish your website to the internet. However you don’t need
to visit this dialog before doing a publish – the publish operation will prompt you to enter
the required details, if you haven’t specified them already.

 Click a SETTINGS button to configure settings for either MAGIX ONLINE WORLD or OTHER
WEB HOST (VIA FTP).

 Click the SAVE PROFILE button to save the current details shown to a profile.
 Check the FAST PUBLISH (ONLY CHANGED FILES) box to republish only new files to your
website
 Check the SAVE PUBLISH SETTINGS IN DOCUMENT box if you want to retain the FTP
details for this particular document.
 Check the SAVE PASSWORD IN DOCUMENT box to store the FTP password with the
document (not recommended for normal use and not available for MAGIX ONLINE
WORLD ) .
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For full details on publishing your website see the main Website Publishing (on page
474) chapter.

Mouse-over properties (Web Animations)

Mouse-over properties are part of the WEB ANIMATIONS dialog. When you click this icon
the Mouse-over tab of the Web Animations dialog opens allowing you to specify what
should happen when a visitor moves the mouse pointer over the selected object. So for
example you can animate the mouse-over with a wide range of effects, pop-up some text
or a whole layer of content when a visitor hovers their mouse pointer over a photo or
other object on your web page.
See Web Animations (on page 419) for more details.

Placeholder Tab

The Placeholder tab is used to add and edit manually editable widgets. These are
widgets you insert onto your web page by manually pasting in HTML code for the widget
or by importing a Flash or movie file. You won’t normally need to use the Placeholder tab
on widgets that you’ve added from the ONLINE CONTENT CATALOG , because the code and
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files that make those widgets function are handled for you automatically. See the
Website Widgets (on page 510) chapter for full details.
To turn any normal object into a placeholder for a widget, select it and then open this tab
of the Web Properties dialog. Choose whether you want the widget to be based on a
piece of HTML code you’ve obtained from a widget website, a Flash file or a graphic file.
Browse for the file or paste in the HTML code. Click OK and now your object is a
placeholder object.
This means the object represents the dimensions and position of the content you’ve
added, but in your exported web page the object is replaced by the actual code or file
that you inserted.
However there is an easier way to add files or code to your site. Simply drag and drop
Flash or animated GIF files from Windows File Explorer onto your page. A placeholder
image is automatically generated for you and is placed on your page. A copy of the file is
added to the support folder of your design so that it gets exported and published with
your site. When you export and publish your site, the placeholder image is replaced by
the actual file you imported.
Similarly if you’ve copied some HTML code from a third-party widget website, you can
simply paste that code into Xara Designer Pro X (make sure you are in the SELECTOR
TOOL when you do this, not the TEXT TOOL or it will be inserted as text!). Xara Designer
Pro X detects the HTML and uses it to render a placeholder image which appears on
your page. You can also add a placeholder for HTML code directly into either the body or
head of a page by clicking the HTML code (body) and HTML (head) buttons, which bring
up a scrolling dialog where you can paste or edit large amounts of code, if necessary.
When you export/publish your site the placeholder is replaced by the actual code so that
your widget functions. See the Website Widgets chapter (on page 510) for more details.

Replace with Flash
Select this option to replace the placeholder object with a Flash animation. Use the
Browse button to locate the Flash (.swf) file you want to use.
The chosen file is automatically copied to the support folder for the current design, so
that when you export your website the file will be included in the _htm_files folder along
with all the generated images for your site. See the Document Handling (on page 50)
chapter for information about support folders.

Replace with graphic file
Select this option if you want to insert a graphic or image into your website in place of the
placeholder object (eg. a PNG, GIF or other web compatible image file). Use the Browse
button to select the file.
The chosen file is automatically copied to the support folder for the current design, so
that when you export your website the file will be included in the _htm_files folder along
with all the generated images for your site. See the Document Handling (on page 32)
chapter for information about support folders.
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Replace with HTML code
With this option you can paste HTML code which you’ve obtained from somewhere else
into the head and/or body sections of your page; i.e., between the <body></body> tags
or <head></head> tags. For example many sites provide widgets that you can add to
your page by pasting the HTML in here. Follow the instructions given by the provider. In
most cases you need to add body code only, but some widgets also require you to
include some code in the head, which is why the head code option is also provided.
As mentioned above, you can just paste the HTML code directly onto your page instead
of inserting it in this dialog (while in the SELECTOR TOOL ). And using that approach
automatically gives you a placeholder image that looks just like the actual widget, so it’s
the recommended way to insert widget HTML code.
Warning: You need to be careful to insert only code which you know is safe and from a
trustworthy source. Invalid or broken code will affect your published web page because
Xara Designer Pro X simply inserts the code as you provide it, unmodified and
unchecked, into your page when it is exported.
If the HTML code that you enter references external files which are expected to be found
in your website, then you need to copy those external files into the support folder for your
design. See the Document Handling (on page 32) chapter for information about support
folders. Once in the support folder, the files will be automatically copied to the _htm_files
folder of your website when you export. Therefore you also need to make sure that any
references to these files in the HTML code references them at the right location.
Let’s take a simple example to make this clearer. Suppose I want to insert a small piece
of HTML code which adds an image to my website. The HTML code I add will need to
reference the image file somewhere. First I copy the image file, say "myLogo.gif", into the
support folder of my document. If the document is "mySite.web", the support folder will
be "mySite_web_files". I know that when I export this website, It will export it to the name
"index.htm" because the default name for the first page of the web site is always
index.htm regardless of the name of the .web file. This means that all the generated
images for my site, and a copy of "myLogo.gif" which I put in the support folder, will be
exported to the folder "index_htm_files". Therefore I must make the HTML code I’m
inserting reference the image file in that location. So I may insert:<img src="index_htm_files/myLogo.gif" />
Note that this references the image file in the exported image folder location (_htm_files),
NOT directly in the support folder (_web_files), because only the exported image folder
gets copied to the web server along with my web page when the site is published.
Of course if I really only wanted to put an image on my website, it’s much easier to just
import the image into Xara Designer Pro X directly! But this is a simple example that
shows how to add HTML code which references an external file.
Check Embedding YouTube, Flash And Other Widgets (on page 482) for more
examples!
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Adding code to page head
Some code needs to be inserted into the head (<head> tag) section of the exported
HTML code, instead of to the body (<body> tag) section as it is by default.
To do this, click the HTML code (head) button in the Placeholder, Website or Page tab of
the Web Properties dialog and type in or paste your code.

Placeholder objects
The placeholder object is actually included in your website and it can be shown to the
visitor in some circumstances. For example if you’ve added a Flash animation, if the
visitors to your page do not have Flash installed in their web browser, or if they’ve
disabled Flash, the browser will show the placeholder image instead.
Therefore it’s sometimes a good idea to make your placeholder object more than just a
black rectangle, or an accurate image of the widget that appears on your page. You may
decide to use a group as your placeholder object, where the group includes a text
message asking the visitor to install Flash so that they can see your Flash content.
REGENERATE PLACEHOLDER IMAGE AUTOMATICALLY :

If this option at the bottom of the
is selected, then the placeholder image gets automatically generated
from the content you have added, whenever the content changes or when you resize the
placeholder object.
PLACEHOLDER TAB

When you paste code or import files directly onto your page, as recommended above,
this option is selected automatically for the placeholder image that gets generated.
Sometimes it’s useful to turn it off after inserting content this way, if you are happy with
the preview image and no longer want it to be re-generated if you change the content in
some way.
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Analytics Tab

Google Analytics Tab with some sample tracking code.

The Google Analytics tab gives you a quick and easy way to add tracking code to your
webpages allowing you to monitor your website's traffic using Google's reporting tools.
You need to have an account with Google to use the Analytics features - click the
"ANALYTICS WEBSITE" button to visit the site and create an account if you don't already
have one, or to administer an existing account.

Web Graphics and Websites
Follow the simple instructions to get your tracking code and paste it into the Analytics
Tab and you will then be able to track data via the Google Analytics website for your
published site.

Edit Navigation Bars

This button displays the NAVIGATION BAR PROPERTIES dialog when a navigation bar is
selected in a web document.
Here you can choose how many buttons you want for the bar, set labels, links and tooltip
text and even add menus to your buttons. You can also choose how your bar behaves
when button labels are edited and when buttons are added or deleted. For more
information see Navigation bars (on page 484).
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Supersites
About Supersites
Modern web browsers support many advanced HTML5 and CSS3 effects, allowing much
more dynamic and visually exciting websites to be created.
Supersites use these effects to allow you to add dynamic animated page transitions and
display options to your webpages as a user clicks through the navigation on your
website.
Supersite animations are hardware accelerated, which is supported by almost all modern
browsers, including those on phones and tablets, to ensure a fast and smooth animation.
Whilst Supersites are not appropriate for large or complex websites, they are especially
suitable for smaller sites, or for web documents, presentations and anywhere where a
slideshow style of content might be called for. Presentations (on page 498) are always
published as supersites.
Vertical or horizontal display options allow the viewer to scroll through the pages using a
mouse, or else swipe through pages when using a tablet or other mobile device. The
pages are presented as a single scrolling list. Alternatively a selection of Page
Transitions offer a large range of transitions to choose from.
"Single page website" "Scrolling website"
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Enabling Supersites
Open the WEB EXPORT OPTIONS dialog to view the SUPERSITE options. "UTILITIES" > "WEB
EXPORT OPTIONS" . Or else right click on your page and open the WEB PROPERTIES dialog
and then click on "WEBSITE" > "WEB EXPORT OPTIONS".

Web Export Options dialog

Select the SUPERSITE option and make your choice. You can select either the
or HORIZONTAL scrolling options, or the PAGE TRANSITIONS .

VERTICAL

If you choose a VERTICAL or HORIZONTAL scrolling option you can specify the space
between individual pages in units of pixels (1 to 1000px with a default distance of 8px).
The little preview windows will reflect your choice giving you an idea of the final output.
To apply a page transition select PAGE TRANSITIONS and then choose a TRANSITION
EFFECT from the dropdown menu. You can control the speed of the transition and also
have the pages SCALE TO FIT SCREEN so that they automatically resize to fit the browser
window. The transition effect you choose here will apply to all pages in your site. Again,
the little preview window will update to reflect your choice.
If you want to add a specific transition to an individual page then go to the PAGE tab of
the WEB PROPERTIES DIALOG and apply the transition there. Transitions set at the Page
level take precedence over those set for the whole site in WEB EXPORT OPTIONS .
Note that the SCALE TO FIT SCREEN option only really works well for short pages and
where all the pages of your site are the same height and width. If you use this option with
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long pages, the result is not good because the browser will shrink the page so that its
height fits into the height of the device/browser.
You need to preview your site in a separate web browser to see the transition
animations perform well - rather than just using the built in browser preview
window which does not show the animations smoothly. Click on the Preview
website button on the web toolbar, and then click on one of the browser icons at
the top right of the preview window to see the transitions in a separate web
browser that you have on your device.

Browser icon selection in the Web Preview window.

Supersites and PDFs
Perhaps the most common way of distributing print documents to a wider audience is via
PDF, often published on the web as a download. Websites and HTML have, by contrast,
been severely restricted from a design point of view. Different browsers wrap and flow
text differently, and limited font availability make it near impossible to ensure that what
you design is what your customer sees. This is why, even today, brochures, reports and
any type of document where the designer wants precise control over the design, fonts,
layout and pagination, are created as PDF.
But PDFs have a downside in that they require plug-ins or extra programs to be installed
to view them.Designer Pro introduces a new way of publishing ‘print' style, or DTP style
documents that does not involve PDFs and offers the following advantages:
 Font Freedom. The ability to use a vast range of fonts. Either use your desktop fonts
(the fonts are automatically embedded, assuming the license allows) or any of the
600+ fonts from Google Fonts.
 High resolution photo and graphics. Layout freedom: mix graphics and text, ‘anything
anywhere’ on the page.
 Pixel accurate WYSIWYG results. The document you design in Designer Pro is exactly
what all viewers see, with the exact same fonts, word wrapping and pagination.
 No plug-ins or separate readers required. Pages are created using HTML5. Your
Supersite is just a web document.
 Compatible with all modern browsers, including mobile and tablet devices where you
can simply swipe to smoothly and rapidly scroll through your whole document.
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A published Supersite
appearing as a single
continuous page when
viewed in a browser (vertical
scrolling option)

Publish your Supersites in exactly the same way as you would for a conventional
website. See Website Publishing (on page 474) for more details.
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Website Publishing
Publishing to Xara Hosting
To get your website onto the internet instantly, you can publish it to Xara Hosting or
MAGIX Online World (MOW) or to any other web space. Publishing to Xara Hosting is
simple because it’s integrated into Designer Pro.
Existing users of MAGIX Online World (MOW) can still publish to MOW in the usual way,
but new users can no longer register for this service - Xara Hosting being the preferred
option for new users wishing to use the hosting service. MOW users should click PUBLISH
TO AN ALTERNATIVE WEB HOST... and then follow the sign in instructions from the "MAGIX
ONLINE WORLD" > " SETTINGS" dialog.
Choose "FILE " > "PUBLISH WEBSITE " Or click the publish icon on the
website toolbar.
The first time you do this you'll see the Xara Hosting sign-in dialog appear.

Simply sign in using your Xara email and password - you will already have this if you
purchased or registered Designer Pro on the Xara website. Other users can click on the
REGISTER... button to get a username and password from Xara instantly. You can choose
to stay signed in which means that if you quit Designer Pro and then return, you will still
be signed in.
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Once you've signed in you'll see the following dialog:

Select your website address from the drop-down menu . You can optionally enter a subfolder name, such as "site1", and you’ll see this gets added to the end of your website
address in the field above. This is useful if you want to publish multiple sites to the same
Xara Hosting account – you can put each one in a different sub-folder. Also useful if you
want to add a password to protect a folder.
Click PUBLISH . Your website will then publish and you will see the data transfer window
indicating the progress of the publish. When the publish is finished you'll be able to
navigate to your website via the link which appears in the data transfer window.
Publishing to Xara Hosting automatically generates a sitemap which you will see as a
sitemap.xml file in your Xara Hosting webspace. This is a list of the pages on your
website, and helps search engines find and list all the pages in your site.
The PASSWORD PROTECT button will take you to Xara Hosting where you will be able to
control access to folders by setting passwords. You can create a list of contacts which
you can then organise into groups of users. Visitors to the password protected area will
have to provide an email address and a password to gain access.
The CONTROL CENTRE button will take you to Xara Hosting where you'll be able to
administer your account as well as being able to browse, view and delete files you have
uploaded to your web space.
Click the NEW WEB ADDRESS button if you want to choose a different web address for
your website. For example you could purchase your own domain name (eg. xara.com),
instead of having magix.net in your website address. If you do acquire other web
addresses, these will appear in the "Your website" dropdown list above, when you next
come to publish. Use the "Refresh" option in that list to update the list if it does not
include all the addresses you expect to see.

Publishing to an alternative web host
If you don't want to publish to Xara Hosting, simply select PUBLISH TO AN ALTERNATIVE
WEB HOST... from the dialog that appeared when you clicked the publish icon.
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on the top toolbar.
This will bring up the PUBLISH tab of the Web Properties dialog where you can configure
the FTP details of an alternate hosting company. You can also configure or change other
settings which allow you to publish your website to the internet but you don’t need to revisit these every time you perform a publish. Users of MAGIX Online World (MOW) can
also publish here using the MAGIX ONLINE WORLD SETTINGS dialog.
You will need to find out your FTP details from your web hosting company - these should
include...





Host Address
Username
Password
The full folder path - including sub-folders if necessary - that your web hosting
company requires you to publish to.
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Web properties dialog Publish tab

1.
2.

Choose which FTP host you wish to publish to. In this case you will choose
WEB HOST (VIA FTP) .
SETTINGS...

OTHER
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Other web host settings dialog

1.
2.
3.
4.
5.

6.

Choose how you want to connect from the drop-down menu - choose from FTP, or
one of the two more secure protocols - FTPS or SFTP.
In the FTP Host Address box, type in your FTP host address. If you have a domain
name this is often the same as your domain name. For example, for MAGIX Online
World users, this would be Ftp.MAGIX-online.com.
In the FTP username box, type in your FTP username.
In the FTP password box, type in your FTP password.
The optional Sub-folder box lets you publish your website into a sub-folder. If you
set a sub-folder here, then all the pages in your website will be published to this
folder. Whether or not you have to publish to a sub-folder depends on the
requirements of your web hosting some don’t require you to publish to a sub-folder
at all, while others require you to publish to a ‘public’ or a ‘www’ sub-folder, for
example. You must check the full FTP folder path that your own web hosting
company requires you to publish to before publishing your website, as requirements
vary widely. As an example, if your web hosting company wants you to publish to
‘http://yourdomain.com/public_html’, then you need to type ‘public_html/’ into the
Sub-folder box.
If you want a sitemap generated for your website, you need to enter the full URL of
your published website in the Website URL field. For the sitemap, a file called
sitemap.XML is automatically generated. This is a list of the pages on your website,
and helps search engines find and list all the pages in your site. If no URL is
specified here when you publish your website, no sitemap is created.
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7.
8.

Click the Explore web space button to browse, view and delete files you have
uploaded to your FTP server (Optional). You can also set a Sub-folder path which
will automatically appear in the the Sub-folder (optional) field.
When you are finished click OK to take you back to the Publish tab of the Web
Properties dialog.

9.

Publish details dialog

Transferring data
1.

After you have clicked Publish, Designer Pro displays a small window that shows
the progress of data transmission and tells you when the publish is complete. If you
entered your website's URL with the FTP details then you can go straight to it from
this location.

2.

Note: If you entered a sub-folder in the Publish tab of the Web Properties dialog, your
website is saved there.
Important: If you have not set any specific page names in the Page & Layer Gallery, then
the name you exported to last will be used as the basis for all the pages in your website.
E.g., if you open a template website, and export this as 'test' to your file system, and now
publish this, it will be published as test.htm to your web server, and all additional pages
will be test_2.htm, test_3.htm etc.
index.htm is the usual name for the first page of a website.
Note: Many web servers use case-sensitive filenames. So, for example, the web
address xara.com/products.htm is not the same thing as xara.com/Products.htm. To
reduce confusion and the likelihood of errors Designer Pro enforces that all page names
are all lower-case and contain only allowable characters. This means that spaces are not
allowed in page names. We suggest using an underscore as an alternative separator.
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Secure FTP Protocols
Apart from standard FTP (file transfer protocol) Designer Pro also supports the more
secure FTPS and SFTP protocols. Some web hosting require you to upload your site
using one of these instead of insecure FTP.
Click on the dropdown menu following CONNECT USING: on the OTHER WEB HOST
SETTINGS dialog and you will see the following options...

Choose from one of the three options - there is the normal FTP option and then the
secure FTPS and SFTP options. You will need to know which of the FTP protocols your
hosting company supports first - and then fill in your FTP details as described above.
Now normally what happens is that FTPS is assigned to Port 21 and SFTP is assigned to
Port 22 as part of the host's IP network address. This is not something you would usually
have to be concerned about as Designer Pro automatically manages this for you, but
sometimes in the interests of further security, a host's system administrator will assign a
different port number, and if this is the case you will have to manually enter the new port
number as part of the FTP host address.

In this example the port number has been changed to 22098 and has thus been added to the
host's address as :22098

For further information read our Knowledgebase http://www.xara.com/support/sftp/ article
on publishing using secure FTP protocols.

Explore web space
When you have completed the FTP host address, FTP username and FTP password
boxes, click the optional Explore web space button to browse, view and delete files you
have uploaded to your ftp server.
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You can view files and open folders to view subfolder contents and also set up a
subfolder path. You can also delete individual or multiple files. Select multiple files by
clicking and holding down Shift or Ctrl, as in Windows Explorer. Click on each column
header to sort files using that column's criteria.

Scroll through a list of files you have uploaded to your ftp server

Returns to the original file view that opened when you launched the Explore
web space dialog
Takes you up a folder level

Places the current folder path in the "OTHER WEB HOST SETTINGS" > "SUBFOLDER" field so you don't have to enter it manually.
Deletes individual or multiple selected files

Fast Publish (Only changed files)
Normally leave the FAST PUBLISH (ONLY CHANGED FILES) checkbox selected. This makes
re-publishing much quicker in most cases because only files changed since the last
publish are re-published.
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Save Publish settings in document
Leave the SAVE PUBLISH SETTINGS IN DOCUMENT checkbox selected to have the publish
details you have entered saved with the current document. That means whenever you
open the document, it will already have the publish details in it so you can publish
updates easily.
When you enable the Save Publish settings in document checkbox, the Save password
in document checkbox also becomes selectable (but this is not available for Xara
Hosting/MOW publishing). Select this checkbox to also save the FTP password with the
current document if you are sure that is what you want. This is not recommended
because it means anyone who gets a copy of your design file can publish to your website
without knowing or entering your password!
Switching between Xara Hosting / MOW accounts
You can only work with one Xara Hosting/MOW account at once, because you can only
be signed into one Xara Hosting/MOW account at any one time with Xara Designer Pro X
. Therefore if you want to publish a website to a different Xara Hosting/MOW account,
you need to sign out first, using "SHARE" > "SIGN OUT" . Then you can sign into the other
Xara Hosting/MOW account and publish as described above.
Similarly if you load a website document that contains Xara Hosting/MOW account
details that are different to the account you are currently signed into, you’ll see the Xara
Hosting/MOW sign in dialog appear if you try to publish that document so that you can
sign into the appropriate account for that document (this will automatically end your
current Xara Hosting/MOW session).

Saving profiles
Profiles allow you to save a set of publish details on your computer, so you can quickly
retrieve and use those settings again in future, without having to enter them again.
In the PROFILE drop-down list click the SAVE PROFILE button and enter a suitable profile
name. Now you can select the profile from the profile list at the top of the dialog, so you
can use them in other documents without having to re-enter them. You can save a profile
with either Xara Hosting/MOW settings, or FTP settings.
Note: You can delete a profile by selecting it in the PROFILE list and clicking the DELETE
button next to it.

Embedding Movies, Flash And Other Widgets
You can very easily embed movies, MP3 audio files, Flash animations, animated GIFs,
PDFs, photo gallery and unlimited types of other interactive widgets on your website with
Xara Designer Pro X. See the Website Widgets (on page 510) chapter for details.
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You can create your own Flash and GIF animations using Xara Designer Pro X. See
Animations (on page 519) for more details.
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Navigation Bars
Using template Navigation bars
The ONLINE CONTENT CATALOG contains a wide range of template Navigation bars for
you to use. There are both horizontal and vertical bars and they are fully customizable.
Just import a bar from the gallery to place it on your page. Or replace an existing bar by
dropping the new one onto it – the new bar takes on all the button labels, links and
menus of the bar it replaces.
When you drop the bar you may be prompted to match the color scheme of the
document if the bar does not have the same color scheme. You can also use the Color
replacement feature to change the bar's colors - all without having to ungroup the bar into
its constituent objects. Just select the bar and click a color on the color line, or bring up
the color editor and choose the color you want to edit from the color dropdown list.
See Theme color schemes (on page 197) for more about editing color themes, and look
at Replacing colors (on page 199) to see how to easily customize colors.
It is of course possible to create NavBars yourself from any button design - If you want to
create your own, see the later section in this chapter.
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Navigation bar properties dialog
The best way to edit the labels, links and other attributes of a NavBar, and to add or
remove buttons, is to use the Navigation Bar properties dialog. Double click on a bar to
bring up the dialog, or right click on it and choose ‘ EDIT NAVIGATION BAR ’ from the context
menu.

The upper half of the dialog allows you to set various properties of the NavBar. The lower
half allows you to add and remove buttons and menus and to edit the labels and links of
each button and menu entry.

Orientation
Choose whether you want your NavBar to be horizontal or vertical. For vertical NavBars
you will normally want to make all buttons the same width (the width of the widest
button), so you get a rectangular bar. See the "ADJUST ALL BUTTONS TO WIDEST LABEL "
option below, which controls this.

Justification
Choose how you want your bar to behave when its length changes as you edit labels and
add/remove buttons. A LEFT JUSTIFIED horizontal bar will grow to the right as you add
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more buttons or make the button labels longer. And the left edge of the bar stays in the
same place on the page. Similarly a RIGHT JUSTIFIED bar keeps its right edge in the same
place and grows to the left. And a CENTER JUSTIFIED bar grows to left and right equally.
Choose the centered option if, for example, you want a horizontal NavBar centered at the
top of your page.

Adjust button widths to labels
Turn this option on if you want your buttons to be stretchy, so they grow and shrink as
required to fit in the label text applied to the button. With this option off, your buttons will
remain the same size and so a label that’s too long for the button will extend beyond the
edges of the button.

All buttons the same width
This option is enabled only if the above ‘Adjust button widths to labels’ option is on.
Select this option to make all your buttons the width of the widest button in the bar. For
vertical NavBars this is almost always desirable so that you get a rectangular bar. For
horizontal bars it often makes the bar look neater with each button the same size, but it
requires more space and so you may not be able to fit as many buttons into your bar with
this option turned on.

Button spacing
Here you can choose to have some space between each button in your horizontal
NavBar, if you don’t want each button to sit right up against its neighbor. Simply enter the
number of pixels of space you would like and see the result on the canvas immediately.

Button order matches page order
Turning this option on makes the Navbar button order match the the page order in the
document. If you re-order pages in the PAGE AND LAYER GALLERY this also results in the
Navbar being similarly re-ordered. This is mainly useful for Navbars in presentation
websites, where the linear ordering of the pages is important and you want the buttons in
your bar to be in the same order as the pages in your presentation.

Site navigation bar
This is a very important option on the NAVBAR DIALOG , which turns on automatic linking
so that buttons and links are added to your bar for you, as you add pages. And all
changes you make to the bar are reflected on every page of the site as soon as you
close the NavBar dialog.
Normally you have this option on only if you want your NavBar to appear on all pages of
your website. However you can manually delete the bar from pages if desired.
The site navigation bar is also useful for automatically repopulating the menu items on a
single button NavBar after converting it from a multi-button NavBar. See Single button
NavBars (on page 488) for more info.
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Moving and transforming a site navigation bar
If you move a site navigation bar on the page, the bar is also moved on all the other
pages on which it appears. Similarly if you scale the bar to make it larger or smaller using
the SELECTOR TOOL , again the same transformation is applied to the copy of the bar on
the other pages. No other transformations of a NavBar using the SELECTOR TOOL are
supported (rotation, skew, scaling in one dimension).

Automatic page linking
Whenever you add a new page to your site, a link to that page will be added to your site
navigation bar for you and the new page will be given a copy of the bar, if it doesn’t
already have one. If your bar has an unused button on it, then the first such button will be
linked to your new page. If all buttons are already linked, a new button is automatically
added to the end of your bar and it is linked to the new page. In either case, the label of
the button is changed to match the name of the new page, if it has a name, or to "New
page" otherwise. Normally you will want to immediately edit this new label in the NavBar
dialog.
When you delete a page from your website, the button linking to it on your site navigation
bar is automatically deleted for you, on all pages of your site.

Turning site navigation bars on and off
When you turn the site navigation option on or off in the NavBar dialog, the change is
reflected in all copies of that bar on all pages of your website.

Deleting a site navigation bar from a page
If you don’t want the site navigation bar on a particular page of your site, you can simply
click on it to select it on that page and hit "Delete". You’ll be asked whether you want to
delete the bar from just that page, or from all pages.
However after removing the bar from one or more pages, note that if you subsequently
turn off the site navigation bar option (perhaps in order to edit the button design, which
can’t be done with the option on), and then later turn it back on again, the bar will be
added automatically to all the pages of your site that don’t have it.

Templates & Site navigation bars
All the single page templates in the ONLINE CONTENT CATALOG have their NavBars set to
be site navigation bars when you load them from the gallery to start a new website
document. This means you can rapidly build a small website with all pages linked to the
bar, without having to add buttons and page links manually. Similarly all website
templates have site navigation bars turned on. If you don’t want this behavior, simply turn
off the site navigation bar option on the NAVBAR DIALOG .
The standalone NavBars presented with each theme in the gallery do not have site
navigation turned on by default. This is because any user adding bars manually is less
likely to want that bar on every page of their site, with a link to every page. But again, the
option can easily be turned on in the NavBar dialog if required.
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Other points to note
If you delete a button which points to one of your pages, or change the link on it to point
elsewhere, no special action is taken to restore a button link to the page. It’s assumed
you decided that you didn’t want a direct link to that page in your site navigation bar. New
buttons and page links are only created when a page is added.

Single button NavBars
Sites designed to be viewed on small mobile devices have little space for horizontal or
vertical NavBars, so a more space efficient solution is needed. Using a NavBar with a
single button and a menu is one such solution that works well, no matter how many
pages are in the site.

Single button vertical NavBar

To make a single button NavBar from an ordinary NavBar, simply open the NAVIGATION
BAR PROPERTIES dialog (double click on the NavBar) and delete all but one of the
buttons. Then also remove the link from the button (click the URL field next to the button
in the dialog and choose DO NOTHING in the Link dialog). Now you can either start adding
menu entries to the button manually in the NavBar dialog, or a menu entry can be added
automatically for each page in your site. To add the links automatically, turn on the SITE
NAVIGATION BAR option in the dialog (or turn it off and then on again if it was already on).
You’ll see your menu becomes populated with a link to each page of your site. Edit the
names of each entry in the menu if you don’t want them the same as the page names.
There’s a selection of different NavBar designs in the ONLINE CONTENT CATALOG under
"COMPONENTS" > "NAVIGATION BARS" . Also each of the themes under Website Themes
(General) have their own NavBar designs. Change the design of your NavBar by
importing a new design from the Online Content Catalog and dropping it on your bar.
IMPORTANT: Note that some NavBars have first and last button designs that differ from
the design of their center buttons. These NavBars are unsuitable for single-button use
because the centre button design is unlikely to look good on its own, so the Navigation
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Bar Properties dialog will not allow you to delete the left and right buttons from these bars
to leave just a single button. So choose a NavBar design where all buttons on the bar
look the same.
All buttons the same - suitable for a
single button NavBar.
Different end button designs unsuitable for a single button NavBar.

To convert a single button NavBar back to an ordinary multi-button bar, just add more
buttons and delete the menu entries from the first button, if no menu is required.

Buttons & Menus
Edit the button labels, links and other button attributes using the table and tree controls in
the lower half of the NAVBAR DIALOG . Each row in the table corresponds to a button in the
bar, or to an entry in a menu under one of the buttons.

Adding & editing buttons
To add a button, double click in the first column where it says "Double-Click To Add
Button". A new row is added below the row for the last button. Or click the ADD button at
the bottom of the dialog to add a button following the selected button. You can
immediately start editing the label for the new button. Press return to complete the label
edit, or click away from the label.
You can edit any button label by first clicking the appropriate row to select it and then
clicking again in the first column to start editing the label.
To set the link on a button, double click on the URL field, or if the row is already selected
you can just single click on it. The WEB PROPERTIES LINK DIALOG appears. This should
look familiar as it’s the same Link dialog (on page 447) that you use for adding other links
to your page, so you have the same link options available. A few options are disabled
because they are not applicable to NavBar and menu links, such as the pop-up photo
option which only works when applied to a photo.
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You can also set the tooltip text for each button using the 3rd column. Edit the text the
same way as you edited the label text. In the exported web site the text entered appears
as a small pop-up tooltip when the mouse pointer is held over your button or menu entry.

Adding menus and sub-menus
In the first (label) column, you’ll notice that there is a plus icon
to the left of each label.
This is a tree control and clicking the plus icon next to a button label, expands that button
node, allowing you to add a menu to that button.
Click on the DOUBLE-CLICK TO ADD MENU ITEM text below the button to start adding a
menu. Or click the ADD button at the bottom of the dialog to add a menu item below the
selected item. A new row appears in the table for each menu entry you add. You set the
label, link and tooltip for each menu entry the same way you do for buttons. And you can
add sub-menus to any menu the same way – by first expanding the menu entry node of
the tree.

Note that users with touch screen devices will not be able to see menu items if the top
level button has a link attached. This is because a touch action on the linked button will
invoke the link rather than displaying the underlying menu. If this is the case, a warning
will appear to tell you that you have a button with both a link and a menu attached and
offering you the option to remove the button link.

Menu separators
You can add a separator into your menu by clicking the ADD SEPARATOR button at the
bottom of the dialog. The separator is added following the currently selected menu item.
Separators allow you to visually group together related items in your menu.
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Menu Styles
Click on the MENU STYLE… button to bring up the MENU STYLE DIALOG . This allows you to
change how the menus appear and behave on your NavBar.

Font
Choose a font to be used for the text on your menus. Only the web safe fonts are listed,
which are the fonts that all visitors to your site should have. There is also an option to
make the font bold and you can change the font size used.
NOTE: This doesn’t change the font used for the button labels of your bar, only the font
used on menus. To change the button label font, see the section about this later in this
chapter.
Direction
Choose the direction in which your menus should open. For horizontal NavBars you’ll
normally want this to be downwards and for vertical bars either left or right depending on
where on the page your bar is located.
Spacing
With this setting you can add space between the entries in your menu, spreading them
out and making the menu larger as a result.
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Border
Add a border to the panes of your menus by entering a border width in pixels.
Animation
By default menus will open instantly, but here you can choose to have the menu
animating as it opens.
Transparency
You can choose to have your menus semi-transparent, so that your page can be seen
through the menu panes. Enter the level of transparency you would like as a percentage.
Horizontal offset / Vertical offset
You can offset the menu panes horizontally or vertically from the buttons. Just enter the
number of pixels of offset required.

Updating your NavBar across all pages
As described above, if you have the SITE NAVIGATION BAR option turned on for a NavBar
then all changes that you make to the bar on one page are automatically applied to all
the other pages too, including the location of the bar on the page.
However if you don’t have that option turned on, set the navigation bar object to be a
repeating object (right click and choose " REPEATING OBJECT" > "REPEAT ON ALL PAGES" )
that appears on every page and all changes you make to any instance of the object
automatically update on all pages.
See Repeating objects (on page 106) for more information.

On canvas editing
You can edit your button labels directly on the canvas using the TEXT TOOL . Just
go into the TEXT TOOL and click in the label text to start editing it. You can also
change the button links directly on canvas – just click on a button in the
SELECTOR TOOL and then click EDIT in the link pop-up that appears.
All changes you make to the NavBar are automatically applied to the other copies of that
bar on other pages.

Changing the font on NavBar buttons
You can change the font used for the button labels on a NavBar easily. Select the bar by
clicking on it. Then go into the TEXT TOOL and select from the font list on the left of the
TEXT TOOL INFOBAR . As you move the mouse pointer over the different fonts in the list,
the NavBar updates immediately so you can see how that font would look. Select the
required font. If your bar has a mouseover state, it is also updated to use the same font.
Similarly you can change the size of the font using the font size control which is next to
the font selection list.
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Importing & pasting NavBars
If you import or paste a NavBar into your document, the site navigation option on that
NavBar is turned off automatically, if it was on. This is to avoid any conflicts with any
existing site navigation bar in your document.
However if the incoming bar is of the same theme and type as the existing site navigation
bar in your site (ie., are part of the same repeating group), it will immediately be updated
to match that existing site navigation bar. Hence in this case the bar will not appear on
your page in its original form.
If the bar is of a different theme or type (ie., are not part of the same repeating group), it
will appear unmodified.

Creating your own Navigation Bars
You can create a NavBar from any button design. The ONLINE CONTENT CATALOG
contains many different button designs, or you can draw your own. See the „Creating
your own Mouseover Buttons (on page 440)" section of the Getting Started chapter for
information on how to do this.The button may or may not include a mouseover state.
To create a NavBar, select the button and then select " ARRANGE" > "CREATE NAVIGATION
BAR" . The NAVIGATION BAR DIALOG appears and you can immediately add more buttons
to your bar, just as for other NavBars.
You can also create NavBars with more than one button design (so you can have
different designs for the first and/or last button in the bar). See the section below, which
describes how to do that.

Button design restrictions
There are some rules you must follow when creating your own buttons for use in
NavBars.
Stretchy button limitations
In order to get reliable results when your buttons are automatically stretched you are
advised to make sure that there are no path control points or graduated fill/transparency
control points in the horizontal area occupied by the button label text object.
Text in a button
Each state of the button design must be a group object containing a text object that can
serve as the button label. This text object should be a simple text object, not a text
column or text area. That is, it should be created in the TEXT TOOL by clicking on the
page and typing, not by first dragging a text line or text box.
Your button design cannot consist of text alone. It must include at least one shape in
order to be used in a NavBar.
Soft grouping button states
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If there are several states in your button, e.g., mouseoff and mouseover, they need to be
soft grouped together, so that they stay together when one state is moved or otherwise
transformed.

Button margins
In this section we refer to the „margins" as being the spaces between the button label
and the ends of the button. For stretchy buttons (those with the „Adjust button widths to
labels" option switched on) this is determined by the master button from which you
create the Navbar. By adjusting the margins on the master button, you set the margins
for the other buttons in the bar, which are based on it.
The easiest way to change the margin on the first button is as follows:

1.
2.
3.

4.

Open the NAVBAR DIALOG
Turn off the ADJUST BUTTON WIDTHS TO LABELS option, so buttons don’t stretch as
label text is changed.
Change the label on the master button (the first button unless you have multiple
button designs in your Navbar – see later section). Choose any dummy label text
which is the appropriate length to give you the margins you want on the master
button.
Turn the ADJUST BUTTON WIDTHS TO LABELS option back on again. All buttons get
the same margins you set for the master button.

5.

Original bar

Bar with a modified smaller margin

Bar with a modified larger margin

If your Navbar has different designs for the start/end (see below for how to achieve that),
then the start and end designs have their own margins that can be controlled separately.

Advanced - Editing a Navbar button design
However your Navbar was created, you can modify the button design it uses. For a
Navbar where all buttons are the same design, the very first button in the bar is used as
the master button from which all the other buttons are copied. Therefore by modifying the
first button design, you modify the design for the whole bar.
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Editing inside
For some bars you can do some editing of the button design directly on the first button,
using select inside. This allows you to select shapes inside the button group. See the
information about the SELECTOR TOOL in the Object Handling chapter (on page 124) for
details of select inside.
However you cannot do select inside editing, if either of the following options are turned
on in the Navbar dialog.



SITE NAVIGATION BAR
ADJUST BUTTON WIDTHS TO LABELS

If either of these options are turned on and you attempt a select inside, you’ll be
prompted and given the option of opening the Navbar dialog so that you can turn off
these options and then try again.
With the options off, you can use select inside and modify the shapes that make up your
button using the usual drawing tools.
IMPORTANT: Remember that the first button in your bar is the master button for your bar
(unless you have different start and end buttons – see below). So you must modify the
first button. Then your changes to the first button are immediately applied to the other
buttons in your bar. If you modify a button other than the master, the changes will not be
applied and will be lost as soon as you modify your bar.

Ungrouping, editing and regrouping
If you want to do any significant editing of a button design, it’s best to ungroup the
components that make up the Navbar and then regroup them again afterwards.
To ungroup your bar, select the Navbar by clicking on it on the canvas and then do a
normal ungroup operation ("ARRANGE" > "UNGROUP" or "Ctrl + U"). Or click the UNGROUP
TO EDIT GRAPHICS button at the bottom of the Navbar dialog.
Note: If your Navbar had the "Site navigation bar" option turned on, you’ll need to turn
that option back on again if required, after regrouping your modified bar.
Once your bar is ungrouped, it is no longer a navigation bar. You are left with a separate
button group for each button state. Also, if the " ALL BUTTONS THE SAME WIDTH " option
was turned on, ungrouping might change the button widths because this option is only
effective while the buttons are part of a Navbar. Although you should only make the
design changes to the master button(s), you’ll normally want to leave all the other buttons
on the page. They are used when you regroup your Navbar, to recover all your button
labels, links, etc., so that you don’t have to re-enter them again.
If you have a mouseover state, the 2 groups that make up the master button will be „soft
grouped" so that they stay together when you drag them around the page. Separate
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them using "ARRANGE" > "REMOVE SOFT GROUP" ("Ctrl + Alt + U"). You can then further
ungroup each button state on the MouseOff and MouseOver layers ("Ctrl + U"), in order
to work on their respective designs. See the "Creating your own Mouseover Buttons"
section of the Getting Started chapter (on page 440) for information on how to make
buttons.
Remember to regroup each of the button states and then put the soft group back to keep
the two button states together once you’re done editing. Do this by making sure both
layers are turned on in the PAGE & LAYER GALLERY (on page 181), select both button
state groups and then "ARRANGE" > "APPLY SOFT GROUP" . See the Object Handling
chapter for more information on soft groups (on page 98).
It’s a good idea to test your button works as expected by previewing your page, before
re-assembling the bar. To put your bar back together, select the modified button and
choose "ARRANGE" > "CREATE NAVIGATION BAR" .

Navbars with different first or last buttons
Sometimes you may want a bar which has different first and last buttons. For example,
perhaps a bar with rounded ends but with rectangular buttons in the middle.

Navbars like this need 2 (if just one end should look different) or 3 (if both ends should
look different) button designs. Position the button designs in order from left to right as
you would like them to appear in a horizontal Navbar. Or from top to bottom as you would
like them to appear in a vertical bar. Then select all 3 button designs (along with their
mouseover states if they have them) and choose " ARRANGE" > "CREATE NAVIGATION
BAR" .
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When you create a bar from more than one button like this, Xara Designer Pro X needs
to know how you would like those buttons to be used in the bar. Therefore a dialog is
displayed, asking you to choose from a range of options.

All buttons the same: Choose this option if you want all the buttons in your bar to be the
design of the first button you selected. This is the most common type of Navbar.
If the first button is to be of a different design to the rest of the
buttons in the bar, choose this option.
FIRST BUTTON DIFFERENT:

If the last button is to be a different design to the rest of the
buttons in the bar, choose this option. An example where this is necessary is a bar which
shows a divider between each button in the bar. All but the last button would need the
divider to appear on the right of the button design.
LAST BUTTON DIFFERENT:

The last button in this example is different, it has no divider at the right bor der

This option allows you to specify different button
designs for the first and last buttons, to give your bar end caps. Of course you must have
selected at least 3 buttons for this option to be valid.
FIRST AND LAST BUTTON DIFFERENT:
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Website Presentations
About Presentations
Xara Designer Pro X allows you to create web presentations - much like a Microsoft
PowerPoint® presentation but as a Supersite (on page 470) website with effects such as
animated step transitions within a page, and smooth animated page transitions.
Presentations are just normal HTML web documents, and are compatible with all modern
browsers as well as phones and tablets. They automatically scale to fit any browser
window size.
Viewers of your web presentation can move through it sequentially, step by step and
page by page, using the right arrow and Page Down key to view the next step or page,
and the left arrow or Page Up key to move backwards. There is also a pop-up navigation
bar, which appears at the bottom left corner of the presentation allowing easy on-screen
navigation of presentation pages.
You export your presentation in exactly the same way as you would for a conventional
website. If you host your presentation on MAGIX Online World - hosting is free, and you
can also password protect your presentation, so only invited authorized visitors can see
your presentation.

Steps and layers
Steps in a Presentation are really just layers, that are animated onto the page, one at a
time. If you open the Page & Layer Gallery (on page 177) you'll see all of the steps, as
layers, plus a few other layers.
The 'background' of each slide, in the Page & Layer Gallery, is called the MOUSE-OFF
layer. Above this there's another MOUSE-OVER layer that holds items that have mouseover behaviour, such as buttons, navigation bars, 'next page' arrows, etc. In addition
there is a PASTEBOARD BACKGROUND and a PAGE BACKGROUND which are special,
usually locked, layers.
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It's important to note you don't need to use the Page & Layer gallery to create or edit
your presentation. The main Presentation toolba (on page 500)r can be used to add,
delete and jump to any step in your Presentation.

Presentation steps in the Page and Layer Gallery - the arrow shows the current step.

You can re-order the steps in your presentation by re-ordering the layers in the gallery.
The step numbers update automatically.
The current step is indicated by the arrow symbol (in the above screenshot Presentation
step 2 is current). Simply click on a step to make it current.
On the canvas, only objects on the current layer and below are shown. This reflects how
your presentation will look when that step is reached in the presentation. So for example
in a 3 step presentation, if step 2 is current you won’t see any of the objects drawn on
step 3 until you make that step or higher current.
Additionally you can click on the "S" (Solo) icon next to the step you want to view, to
show only that step on the canvas. Click the icon again to return to normal view.
As with ordinary layers, you can click and drag an object to move it from one step to
another in the PAGE & LAYER GALLERY .
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The Presentation toolbar
Xara Designer Pro X automatically displays the Presentation toolbar on the right of the
standard toolbar when you create or open a presentation document.

The toolbar allows you to:
Make a new presentation step that contains any
currently selected objects. You can create steps
quickly by dragging or pasting objects on to the
page, selecting them and clicking this button.
Even if the currently selected objects are already
on a presentation step, clicking this button will
move selected items to a new step. If you have no
objects selected when you press this button, a
new empty step is created and made current, so
anything you subsequently draw or add will be
placed on that step.
Move the selected objects to the MouseOff layer,
so that they are not part of any presentation step
and so are permanently displayed as 'background'
objects.
Duplicate a presentation step (perhaps the easiest
way of creating a new step). The step containing
the selected object is duplicated in its entirety, not
just the selected object. The new step is also
made the current step.
Delete the current presentation step. The entire
step containing the selected object is deleted,
including any other objects on that step that may
not be selected.
Jump to any of the steps in the presentation as
well as the Background/MouseOff layer.

Displays the Web Transition tab of the Layer
Properties (on page 184) dialog, allowing you to
choose a transition type for the presentation step
that the currently selected object(s) are in.

Creating a presentation
There are three ways to create a new presentation:
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 Start with a pre-designed template and then customize this with your own text, photos
and color scheme.
 Create a presentation from scratch, bringing in all the required elements, text, graphics
and photos onto the page and ordering the content into the presentation steps and
pages you require.
 Convert an existing website/web document into a presentation.

Creating a presentation from templates
Open the ONLINE CONTENT CATALOG - "FILE" > "NEW FROM ONLINE CONTENT
CATALOG" .
Find the PRESENTATIONS folder in the catalog and double click to expand it.
The theme folders contain collections of presentation designs and associated graphic
files that each follow a specific theme. Browse through the various theme folders until
you find a design you like and double click on the first thumbnail, named 'Presentation'.
A new presentation document opens displaying all the template pages, already
populated with several pages, each containing a number of presentation steps that
already have content. A number of transitions have already been applied to the pages
and the steps.
Click PREVIEW WHOLE WEBSITE to open a preview window - then click on one of
the browser icons in the top right of the window to launch an external browser.
You need to preview your presentations in a separate web browser to see the
transition animations perform well. You can then use the arrows in the top left of
the presentation (or on your keyboard) to see the steps and transitions in action.
Also try moving the mouse pointer to the lower left corner of the Presentation
preview windows to see the pop-up navigation controls
Close the preview.
Customize the text and photos using your own content, just as when editing a website
document.

Creating your own presentation from scratch
This section describes the best workflow for creating a presentation page by taking you
through an example, to help you get started quickly.
Choose "NEW" > "PRESENTATION (WIDESCREEN)" or "NEW" > "PRESENTATION (4:3
NORMAL)" from the FILE menu depending on whether you want a widescreen (16:10)
presentation, or a normal (4:3) presentation.
Note: 16x10 is a better compromise for some wide-screen monitors and tablets that are
not exactly 16:9, and it’s not so squashed. But you can create any aspect ratio you
require of course.
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A new blank document window opens, displaying the presentation document
icon on its tab at the top of the document window.

The Presentation Toolbar also appears at the right end of the top bar. The buttons on the
toolbar are enabled only when you have something selected on the page.

1.

2.

Use the TEXT TOOL to add some text to your blank presentation, perhaps a heading
at the top of the page. Select this text object using the SELECTOR TOOL and look at
the status line at the bottom of the Designer Pro window. It will say that you have a
text object selected on the MouseOff layer. Everything on the MouseOff layer will be
permanently visible in your presentation, as if it’s part of the background. So
preview your page and you’ll see your text heading on the page.
Now add another new text object using the TEXT TOOL. Again, this will be placed on
the MouseOff layer and the status line will show you this when you select it with the
SELECTOR TOOL . But now let’s make this text appear as the first step in this
presentation.

3.

With the text selected in the SELECTOR TOOL , click the ‘foot’ button, which is the first
button on the Presentation Toolbar, called MAKE NEW STEP . Now look at the status
line – it now shows that the selected object is on "Presentation step 1" instead of
MouseOff.

4.

Preview the page again. Initially you can see only your initial text heading. Press the
right arrow key on your keyboard and the second text object will fade in. That’s the
first step added to your presentation!

5.

Step 1 is now the current step, so if you draw another shape or add some new text,
it will also be placed on step 1. Draw a rectangle using the RECTANGLE TOOL . Select
it with the SELECTOR TOOL and notice that the status line shows the rectangle as
being on Presentations step 1 which is also the current step.

6.

Preview your page again and you’ll see that when you click the right arrow key, the
text and rectangle fade in together.

7.

A quick way to create a new step from an existing step is to use the DUPLICATE
STEP button. Select the rectangle and press this button. The entire step is
duplicated, including the text that you didn’t select, but which was on step 1 along
with the rectangle. Select the new text or rectangle and the status line shows you
it’s on a new presentation step. The new step now becomes the current step Presentation step 2, and any objects you now create will be added to that step.

8.

If you want to move an object to another step, right click on it and you’ll see a
PRESENTATION sub-menu in the context menu that appears. That sub-menu itself
has a MOVE TO STEP sub-menu, that lists all the existing steps on this page. Just
select the required step. There’s also a NEW STEP option in the menu, that does the
same thing as the MAKE NEW STEP button you used above.
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9.

You can change the effect used by each step easily. Select one of the rectangles
you just added and then press the last button on the Presentation Toolbar titled
STEP TRANSITION EFFECT . This brings up a dialog that allows you to select a
different transition instead of the default "fade" transition. Choose SLIDE IN FROM
RIGHT . Preview your page again and this time when you press the right arrow key
the text and rectangle slide in from the right.

10. If you decide that you want an object to be permanently visible, instead of part of a
step, select it and choose the MOVE TO BACKGROUND button on the Presentation
toolbar. That puts the object back on the MouseOff layer. Try this on one of the
objects you placed on a step.

11. The ONLINE CONTENT CATALOG includes some useful components for presentations,
under "PRESENTATIONS" > "PRESENTATION COMPONENTS ". Just drag and drop a
component onto your page. Each component is added to the current step. If that’s
not what you want, use the presentation menu to move it to a different step, or to
the background (MouseOff) layer. (Note that the HEADINGS and TRANSITION
CONTROLS components are always added to the MouseOff/Background layer).

12. Remember as described above, the PAGE & LAYER GALLERY shows you all the
presentation steps on your page, in order, since each presentation step is in fact
just a separate layer. And only the current step and steps below/before it are shown
on the canvas.

Converting an existing website into a presentation
In the website document, right click a page and choose
the Web Properties dialog.

WEB PAGE PROPERTIES

to display

Click the Website tab and click the PRESENTATION WEBSITE checkbox to select it.
The document's tab at the top of the workspace displays the presentation
document icon.

Note: Layers within the document are not automatically turned into presentation steps
when you turn a website into a presentation. You have to manually convert each layer
into a presentation step - see Turning a layer into a step. However, when you turn a
presentation into a website, presentation steps are automatically converted to layers and
renamed 'step 1' etc.

Managing presentation steps
You can typically manage presentation steps by:
 Right clicking an object in a step and choosing PRESENTATION then choosing your
required option from the sub-menu that appears
 Using the buttons on the Presentation toolbar (on page 500)
 Using the PAGE & LAYER GALLERY

503

504

Web Graphics and Websites
Viewing step contents
Sometimes you may want a clearer view of exactly which objects are in a step. You can
either use the JUMP TO option in the Presentation toolbar to take you to a particular step
or layer, or else use the PAGE & LAYER GALLERY .
For ease of navigation, the JUMP TO menu will only display the Background/MouseOff
layer and the presentation steps. If you need to select another layer (MouseOver, Page
Background, Pasteboard Background) simply select it in the PAGE AND LAYER GALLERY
and it will be displayed as the current layer in the JUMP TO menu dropdown.
If you click on a step in the PAGE & LAYER GALLERY all the steps above your selected
step will be hidden and all the steps below will be visible thus giving you a precise view of
your position in the presentation as shown on the canvas. This is also true if you select a
step using the JUMP TO option. You can still hide or reveal any steps in the presentation
by clicking on the eye icon.
Additionally you can click on the "S" (Solo) icon next to the step you want to view, to
show only that step on the canvas. Click the icon again to return to normal view.
Note that the Background in the JUMP TO menu is referred to as the MouseOff layer in the
PAGE AND LAYER GALLERY.

Moving objects from one step to another
You can move objects from one step to another step in one of three ways:
 In the PAGE & LAYER GALLERY , click and drag the object(s) from one step to another or
right click the object(s) and choose MOVE TO CURRENT LAYER.
 Right click the object(s) and choose "PRESENTATION" > "MOVE TO STEP" then choose
the number of the step you want to move the object(s) to, or BACKGROUND if you want
to move the objects to the MOUSEOFF layer or NEW STEP to move to a brand new step.
 Use cut and paste to move objects from one step to another. Cut the object (Ctrl+X),
then go to the JUMP TO drop down menu on the Presentation Toolbar to select the step
you want and then paste (Ctrl+V) or paste in place (Ctrl+Shift+V).

Changing step order
The order in which steps are revealed is the order in which the steps appear in the PAGE
& LAYER GALLERY , as indicated by the step numbers. You can click and drag steps above
or below each other in the PAGE & LAYER GALLERY until all steps are in the order you
want.

Deleting objects from a step
Right click the object and choose CUT or DELETE , or in the PAGE & LAYER GALLERY right
click the object and choose DELETE or click the object then press the DELETE button in the
standard toolbar.
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When you delete an object and it's the only object in a step, Designer Pro will
automatically delete the empty step but only after a Save or a Preview operation. This
allows the addition of new objects to a step without disturbing the existing step order.
After a Save or Preview operation, empty steps will be deleted and the remaining steps
re-numbered accordingly.

Deleting a step
Select an object in the step and click the DELETE STEP button in the
Presentation toolbar or right-click and choose PRESENTATION > DELETE STEP .

Alternatively in the PAGE & LAYER GALLERY right click the layer and choose DELETE
LAYER .

Adding new presentation pages
Right click the Xara Designer Pro X pasteboard and choose NEW PAGE to add a new
blank page or DUPLICATE CURRENT PAGE to add a copy of the currently selected page.

Creating Number and Bullet lists
When you add bulleted or numbered lists to a presentation, each item on the list is
automatically made into a separate presentation step when you export your presentation.
This makes it much easier to create and edit animated list items. To add new list items
just hit return at the end of one of the existing items. The transition effect used for each
bullet point during the presentation is that set for the presentation layer on which the list
resides (you cannot set different effects for different points in the same list).
To turn the feature off, right click in the text area while the TEXT TOO l is selected, choose
PRESENTATION > PRESENT BY PARAGRAPH from the menu and deselect the option. Now
when you export/preview your presentation the list is no longer split into separate steps.
To find out more about creating bulleted and numbered lists see Text Handling >
Applying text appearances (on page 209)

Deleting presentation pages
Right click the page and choose DELETE PAGE . Or select the pages you want to delete in
the PAGE & LAYER GALLERY and hit Delete, to delete multiple pages at once.

Linking to next/previous step
You can easily add buttons/objects to a presentation page that reveal the next step in the
page. Just add or create your button, and use the LINK TO list in the Link tab (on page
448) of the Web Properties dialog to apply a link to the button/object that will display the
next presentation step.
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When the viewer has displayed all the steps on the page using a 'next presentation step'
link or the right arrow key, clicking the button or key again displays the next page.
Note: If you convert a presentation into a web document ( PRESENTATION WEBSITE
checkbox in Web Properties dialog Website tab), any next/previous presentation step
links automatically turn into next/previous page links. You cannot apply 'next/previous
presentation step' links to a web document.

Applying transitions to presentation step links
You can apply a link transition to any link object, such as a button, in your presentation
page in the same way as you can in a web document page, using the Link tab of the
Web Properties dialog. Link options for presentation documents also include
next/previous presentation step (on page 505).

Applying presentation step transitions
When you create a step, Designer Pro automatically assigns the Fade transition type to
it.
To change a step transition:
Open the Web Transitions tab of the Layer Properties dialog either by clicking
the Layer Transition Properties button in the Presentation toolbar or right click an
object in the step and choose PRESENTATION > TRANSITION. Or in the PAGE &
LAYER GALLERY , select the step and then click on the PROPERTIES tab.
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Choose a transition from the TRANSITION EFFECT list, drag the SPEED slider to choose a
transition time between 0-5 seconds, and click APPLY .

New steps you create get the transition effect of the last step in the presentation by
default. This means if you want the same transition on all steps, you only need to set it
once on the first step and then all subsequently added steps will use the same transition.

Applying presentation page transitions
Each presentation page can be given its own transition. To add a transition for the
current page, right-click on the page and select the PAGE TAB (ON PAGE 455) of the WEB
PAGE PROPERTIES dialog.
Then select a page transition type from the TRANSITION EFFECT drop-down list and move
the SPEED slider to apply a transition speed from 0 to 5 seconds.
Then when your website visitor navigates to the page with the animated transition, they
see the animated transition.
You can also set the page transition for multiple pages at once. Just select the pages you
want to change in the Page & Layer Gallery (use Shift+click and Ctrl+click to extend the
selection), then change the transition on the Page tab, as above.
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Note: The page transitions will only work for a website if it's set to be a Supersite.
Presentation documents are Supersites by default so there is no need to visit this option
in the WEBSITE TAB of the dialog.

Advanced presentation information
Pop-up layers and presentation layers
Presentation layers are just ordinary layers with the presentation option selected in the
Layer properties dialog. Once this option is turned on for a layer, any name the layer had
is overridden with "Presentation step (N)" in the PAGE & LAYER GALLERY , where (N) is the
step number.
You can mix popup layers and presentation layers in a presentation document, but of
course only the presentation layers will be revealed as the visitor steps through the
presentation by pressing the arrow keys.
Having both layers and presentation steps is useful if you want to keep features such as
popup layers in your presentation. You can change layers into steps (and turn steps back
into layers) by toggling the PRESENTATION LAYER checkbox in the Layer Properties (on
page 184) dialog's Web Transition tab.

When you create a new step, this checkbox is automatically selected.
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If you deselect it to turn a step into a layer, this removes the step from the presentation,
even though its contents and any layer transition remain. The converted layer, however,
will not be displayed when a viewer navigates through a presentation using either the
arrow keyboard keys or a next/previous presentation step link.
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Website Widgets
Widgets & placeholders – it’s all automatic!
In Xara Designer Pro X a widget is any object you can place on your web page that
displays some sort of dynamic content, that may also be interactive. That content may be
sourced from an external website (e.g., a news feed widget) or may be published with the
website (e.g., a slideshow widget cycling through a selection of photos). On the Designer
Pro canvas, a widget is represented by a static ‘placeholder’ image that defines the
position and dimensions of the widget on the page. And attached to that placeholder is
the HTML code and files (e.g., Flash, Javascript, photos, etc.) that make the widget
function in the exported page.
A placeholder is normally an image that looks like a static snapshot of the widget itself,
but it can be a simple rectangle or any other object. The placeholder usually has the
same dimensions as the widget, so that you can sensibly position it with respect to other
content on your page.
The good news is that placeholder images are normally rendered automatically for you
by Designer Pro.

Types of Widget
There are basically three types of widget, which differ in the way that you customize and
configure them in Xara Designer Pro X. A brief description of each type follows, but more
detail about each type is provided later in this chapter. However for all three types of
widget you can simply double click on the placeholder image to edit them.
 Web Editable Widgets
 Locally Editable Widgets
 Manually Editable Widgets

Widgets from the Online Content Catalog
Many of the elements under the COMPONENTS folder in the ONLINE CONTENT CATALOG are
widgets (as indicated in the titles).
To add a widget, just drag and drop it from the gallery onto your page. What happens
next depends on the type of widget. If it’s a Web Editable Widget, a browser window will
open to allow you to configure the widget on the widget provider’s website. If it’s a Locally
Editable Widget, a placeholder image will appear on your page. Double click on the
placeholder and a new document opens within Designer Pro, which allows you to
customize the widget.
See the website at xara.com/widgets for more information.

Web Editable Widgets
When you drop one of these widgets onto your page from the DESIGNS GALLERY , a
window opens which is actually an Internet Explorer browser running inside Designer
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Pro. This is similar to the preview window shown when you click the preview page and
preview website buttons on the web toolbar. However this widget window has some
additional buttons at the bottom – more about those later.

Example widget insertion window, showing Google News gadget.

The browser window opens onto the website of the widget provider. Here you can find
out more about the widget if required, provide any data the widget requires and in most
cases also customize its appearance. Usually the widget website will also show you a
preview of what your widget will look like, complete with any customizations you’ve
applied.

Inserting
Press the HELP button at the bottom of the window to see some information to guide you
through the process of configuring the widget and inserting it on your page. For most
widgets, you need to get to the point where the widget website offers you the HTML code
that needs to be inserted into your web page. As soon as this is visible, you can normally
click the Insert button at the bottom of the window. Xara Designer Pro X will then find the
HTML code and will insert it into your page for you.
For some widgets, Xara Designer Pro X is unable to retrieve the HTML code from the
site directly and you need to first copy the code to the clipboard. Select the code in the
browser window and press Ctrl+C. Many widgets make this easy for you by providing a
copy button next to the code. Once you’ve copied the code, click the INSERT button.
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Editing existing widgets
At any time you can double click the widget placeholder (or right click and choose EDIT
WIDGET ) in your Designer Pro's page to return to the widget provider’s website so you
can easily modify or replace the widget.
Those widget providers who give you an account, will normally also keep a copy of any
widgets you’ve created. This means you can sign into your account while going through
the insertion process above and then find, modify and insert a widget that you’ve created
previously. Inserting existing widgets is just like inserting newly created widgets – just
click INSERT when you are offered the HTML code, or copy the HTML code for the widget
to the clipboard and then click INSERT .

Automatic placeholder generation
When you press the Insert button, if Xara Designer Pro X found the widget code the
widget website window is closed and you will see an indication that Xara Designer Pro X
is busy rendering a placeholder image. After a few seconds an image of your widget
appears on your page. Now all you have to do is preview your web page and you should
see your new widget working on your page!

Widget site membership
Some widgets may require you to open an account with the widget provider, before you
can use them. Most are free, but some offer premium services over and above the free
offering. See each individual widget and the information on the widget provider’s site for
details.

Locally Editable Widgets
Some widgets that you drop onto your page from the DESIGNS GALLERY won’t open a
browser window as described above for Web Editable Widgets. These are Locally
Editable Widgets that you edit directly in Designer Pro using a separate document
window.
Editing
After dropping such a widget on your page, double click on it to edit. A new document
window opens in Designer Pro (we call this the widget’s "editing document"). What that
document window shows will depend on the specific widget, but typically you’ll see a
multi-page document that allows you to conveniently edit and customize all the content
for the widget.
Normally there will be some specific instructions shown to the side of or above the first
page, describing what aspects of the widget you can edit in the document and other
information about the widget. In most cases, you can edit the text you see using the TEXT
TOOL , but you can’t normally change the font or style of the text. You can replace photos
by dropping new photo files onto the images from Windows Explorer, just as you replace
photos in normal documents. And you can edit the photos using the PHOTO TOOL , adjust
photos using the FILL TOOL , etc.
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Look at each page in turn and customize the text and photos. Some objects may be
locked (clicking on them does nothing) which tells you that you can’t edit that aspect of
the widget, or perhaps it will be modified by changing unlocked objects on one of the
other pages. Any locked objects are present as a visual aid, to help make the context of
the unlocked editable parts of the design clear.
Adding more content
Some widgets will allow you to add more content to the widget by duplicating the pages
shown (right click on the page and choose DUPLICATE CURRENT PAGE ). A slide show
widget may allow you to add more photos to it this way. After duplicating a page, change
its photos or text as required. The instructions in the widget will tell you whether or not
you can duplicate pages in this way to add content.
If you make any changes that the instructions say should not be made, usually those
changes will be ignored. However you may cause a widget to malfunction so please
change only the aspects of the design that the instructions say can be modified.
Some widgets allow you to add clickable links - the instructions in each widget will make
this clear. Change any such links from their default values just as you would change links
in a normal website document.
Resizing
Some Locally Editable Widgets are resizable and others are not. Select the widget
placeholder in your website document and drag one of the corner handles to resize it up
or down. If the widget doesn’t allow resizing it will not change size when you drag a
corner. After a resize, normally you will see the program re-generate the placeholder
image for you, so you can see how the widget will look at its new size.
Saving changes
When you’ve finished customizing, close the document and you’ll be asked whether or
not you want to save the changes you’ve made back to your website document.
Alternatively, just hit "Ctrl + S" and the changes you’ve made will be saved and the
editing document closed, returning you to your website document.
The widget placeholder image should update. Preview your page to see the effects of
your changes on the working widget.

Embedding movie, audio, animation and other files
Xara Designer Pro X includes direct support for some types of file that you are likely to
want to add to your website. For these files you can simply drag and drop them from
Windows Explorer onto your page, or use "FILE" > "IMPORT" .
On import the file type is identified, an appropriate placeholder or link is added to your
page, and the file is copied into the support folder for your design. The support folder is a
folder which lives alongside your design file and is created automatically. If your design
file is called „MySite.web", its support folder is „MySite_web_files". The contents of this
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folder are included along with all the image files for your site, whenever the site is
exported and published.

MP4 & FLV movie files
These are the only movie files directly supported by Xara Designer Pro X.
Import an MP4 or FLV file and Xara Designer Pro X inspects the file to determine the
aspect ratio and other information about the movie. You are asked whether or not you
want the movie to start playing automatically as soon as the page holding it is loaded
(auto start). It then inserts the movie file, and some other files for a Flash movie player,
into the support folder of your website. A placeholder image resembling the movie player
appears on your page.
Position and resize the placeholder using the SELECTOR TOOL , and then preview your
page. Click on the movie player play button to start the movie. That’s it! The movie player
includes basic controls for adjusting volume, starting & stopping and for jumping to any
point in the movie.
Alternatively you can use some of the widgets in the ONLINE CONTENT CATALOG to
present your movies instead. This way you have more control over the presentation. See
"COMPONENTS" > "PRINT AND WEB COMPONENTS" > "AUDIO / VIDEO" .
See this Xara Knowledgebase article
http://support.xara.com/index.php?/Knowledgebase/Article/View/499/0/can-xara-importmovie-files-into-the-program for more information on importing movie files into your
documents.

Flash files
To include a Flash animation on your website, import the Flash file (.swf). You can simply
drag and drop the file from Windows Explorer onto your web page document or else use
"FILE" > "IMPORT" .
The Flash file is copied into the support folder of your design, so it will be exported and
published with your website. And a placeholder image is rendered and placed onto your
page.
You can resize Flash animations, so simply use the SELECTOR TOOL to resize the
placeholder image to the required size, and position it by dragging it around.
Preview your page to see your working Flash animation on your web page. You must
have Flash installed in order for it to play successfully.

MP3 files
Import an MP3 file to add audio to your web page. A prompt allows you to choose
whether the audio should start automatically when your page is loaded, or whether it
should only start when the play button is pressed on the player.
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As with the other file types above, a placeholder image showing the player is generated
and placed on your page and the MP3 file and all other files needed to make the player
work are copied to the support folder of your document and will be included in your
exported website. Preview page to see the player in action.
The player is simple and unobtrusive. You can start and stop the audio, click on the time
line to jump to different parts of the audio, adjust the volume (click on the volume
indicator line) and mute (click the speaker icon).
Technical note: The player uses the native HTML 5 capabilities of the web browser to
play the audio, if the browser supports it and if it also supports the MP3 format.
Otherwise Flash is used. This means the player will work in all major browser versions
(older browsers don’t support HTML 5 and even some modern browsers don’t directly
support MP3).

Animated GIFs
Add an animated GIF to your page just the same way as for Flash files. Import or drag
and drop the GIF file onto your page. It gets copied to your design’s support folder and a
static placeholder image is generated for it. Resize and position the placeholder, then
preview your page and you’re done!

PDF Files
You can import PDF files into a web document in two different ways. Either import it so
that the contents of the file are copied onto your page (as when importing a photo). Or
you can link to a copy of the file in your website and have the file published with your site.
When importing a PDF file a prompt is shown to let you choose between these two
options.
When adding a link, the PDF file is copied into the support folder of your design, so it’s
exported and published with the rest of your site. And a link is added which looks like this
on the page:

Clicking the link on your exported page normally opens the PDF file, but the exact
behavior varies depending on the user’s browser settings.

Word and other files
Use the LINK tab of the WEB PROPERTIES DIALOG to add a link to a Word document or any
other file. Select the LINK TO FILE button and then browse for the file.
When you publish your site, the document is published with it.
Clicking the link on your published page normally causes the browser to download the
file.
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Widgets from other widget sites
There are hundreds or thousands of sites offering widgets of some form or another and
the ONLINE CONTENT CATALOG offers only a tiny subset of what is available on the web.
Just about all widgets are provided to you in the form of a small piece of HTML code. The
widget provider will normally give you some simple instructions on how to insert the code
into your web page, but with Xara Designer Pro X it really is very simple.
Copy the code from the widget provider to your system clipboard, just as you copy text in
a word processor. Sometimes the widget provider may even provide a ‘copy’ button
which copies the code for you.
Then in Xara Designer Pro X go into the SELECTOR TOOL and then do a normal paste
operation (Ctrl+V). You’ll see that Xara Designer Pro X recognizes the HTML code and
immediately starts to render a placeholder image, just as it does when inserting a widget
from the ONLINE CONTENT CATALOG . The placeholder appears on your page, usually with
the most appropriate size for the widget. You can then preview your page to see your
working widget!
You can also paste widget code into both the head and body of your page using the
Placeholder tab (on page 466) of the Web Properties dialog.
NOTE: If you are in the TEXT TOOL when you paste the code, it will be pasted as text
instead of producing a placeholder! And once you’ve pasted the contents of the clipboard
as text once, it will continue to paste as text even if you switch to the SELECTOR TOOL and
paste again. If you get into this position, return to the widget website and copy the code
again. Then do the paste while in the SELECTOR TOOL .

Resizing widgets
You can resize the placeholder images for Flash, MP4 movies and animated GIFs to
similarly resize the content as it appears on your page, because this type of content is
scalable. Most of the Locally Editable Widgets are also resizable, but some are not and
won’t allow you to drag the resize handles of the placeholder image.
Some Web Editable Widgets will allow you to resize them even though the widget
content won’t scale. For these widgets the placeholder object merely determines the
bounds of the area in which the widget can render, so making the placeholder too small
for the widget will mean that the widget gets cropped in your web page. The placeholder
image gets regenerated whenever you resize it, so it will reflect any cropping of the
widget too, as shown in this example.

Placeholder with default size

Placeholder with reduced size
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Similarly making the placeholder larger for such widgets will merely result in empty space
around the widget, on the page and in the placeholder image. For widgets like these
which don’t resize correctly when you resize the placeholder, it’s best to stick with the
original default size.
There are some widgets which can be improved by resizing the placeholder, even if the
widget itself doesn’t scale. Some widgets will fill the container into which they are
inserted, which may mean they come out much bigger than required, with blank areas
filling the space. You can experiment by resizing the placeholder for such widgets in
each direction and this may make the widget smaller without losing the key parts of the
widget.
For example this Form widget has rendered much too wide and tall and so there is
wasted space below and to the right of the form controls. Resizing it down doesn’t
change the size of the form controls, it just results in the form being cropped. The result
is a much neater form placeholder taking up much less space on the page.

Placeholder with default size

Placeholder made narrower and shorter

Turning off placeholder re-generation
The placeholder image will be regenerated whenever you resize it or change the code or
file it’s attached to. Sometimes you may want to turn off that regeneration so that the
placeholder image won’t change again. You can do this by deselecting the checkbox at
the bottom of the PLACEHOLDER TAB in the "UTILITIES" > "WEB PROPERTIES DIALOG" .

Adding widget placeholders manually
If you don’t want Xara Designer Pro X to create a placeholder image automatically, you
can set one up yourself. First create a placeholder object (perhaps a rectangle of the
appropriate size or an imported image that you want to use to represent the widget on
your page). Select the object and then open the Placeholder tab in the "UTILITIES" > "WEB
PROPERTIES" .
Or press the placeholder button on the Web properties flyout bar on the top bar.

In this dialog you can choose to associate the selected object with a Flash file or other
file, or with HTML code that the dialog allows you to paste into the head or body of the
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web page. See the PLACEHOLDER TAB section of the Web Properties Dialog (on page
464) chapter for details on this dialog.
Normally you don’t want to select the "Re-generate placeholder" option if you want to
keep the placeholder object you’ve created yourself. Selecting the option will cause your
placeholder to be replaced with an image generated from the code or file you have
specified in this dialog.

Animations

Animations
Introduction
Xara Designer Pro X takes a traditional animator's approach to animation. You create
key frames (or "snap-shots") of your animation through time, and Xara Designer Pro X
automatically creates all the in-between frames for you, a process called ‘tweening’.

An example start frame

The next key frame has the star shape moved, rotated a little, reduced in size, and changed to
a different color.

Xara Designer Pro X will create a smoothly animated Flash or movie file automatically creating
the interim frames. This process is called "tweening".

What Flash can and cannot do
The Flash format does not support some of the advanced effects that Xara Designer Pro
X offers, for example complex graduated transparency, feathering and most of the
advanced color fill types.
However, it does support a range of effects that include simple transparency. So, for
example, if you fade the star on the 2nd key frame above to be 100% transparent, you'll
get an animation where the star moves, reduces in size, and then fades.

519

520

Animations
The same example, showing in-between frames, but with a transparency change.

Like Xara Designer Pro X, Flash is vector graphics-based, which means that you can
enlarge objects with no loss of detail. It also means that Flash files can be very compact,
which is of course ideal for the web!
To illustrate just how small and compact Xara Designer Pro X Flash animations can be,
the previous example animated over one second with 24 frames (so the movie plays at a
smooth 24 frames per second) creates a Flash file that's only 700 bytes.

The 6 core types of animation
In order to keep Flash files very compact, the types of shape tweening supported by
Flash are limited to six basic types of animation. These are sometimes called the 6 core
transforms, because these are the main ways you can transform an object from one key
frame to the next.

1.
2.
3.
4.
5.
6.

Move: Move objects from one position to another.
Scale: Enlarge or reduce objects in size.
Squash or skew: Squash or skew objects.
Rotate: Rotate objects.
Transparency: Adjust the overall (flat) transparency of the objects.

The last item, color changes, can be applied to contoned (colored) photos. You can’t
transform a full color photo into a contoned one, but you can change a photo with one
contone color into another color.
Note: the above six transform types are absolutely key to all Flash animations.
If you look at Flash animation examples on the web, you'll find that almost all consist of
just these effects. Objects fade in and out; they whiz from one position to another. They
sometimes spin, grow or shrink. That's the basis for almost all Flash animations, and it's
very easy to produce such animations in Xara Designer Pro X. It is also possible to
tween shape outlines and some PHOTO TOOL attributes in Xara Designer Pro X, but these
are less common and only applicable to specific types of object.
One thing that isn’t possible with Flash is to change the shape of an object between key
frames though this will work when exporting as a movie clip.

Animations
It’s not possible to change the shape between key frames in exported Flash animation s.

Because the shape changes (i.e. it morphs from one shape to another), this is not
possible in Xara Designer Pro X Flash animations.

What you can't do with Xara Designer Pro X Flash
Xara Designer Pro X does not support more complex Flash features such as scripting
(programming), audio, or embedded movies.
Additionally, since Flash vector rendering is relatively primitive compared to Xara
Designer Pro X’s, there are advanced Designer Pro effects such as feathering that
cannot be used in Flash. These are detailed in the "What Xara Designer Pro X Features
Does Flash Support? (on page 538)" section towards the end of this chapter.

Core Principles
In your animation you are likely to have some objects that remain static between key
frames (i.e. no tweening is necessary) and other objects you will want to animate.
To tell Xara Designer Pro X which objects you want to animate, it's necessary
to give each object a name (via the ADD NAMES button on the SELECTORTOOL
InfoBar).
For more information on naming objects, see section "Naming Objects" in the "Document
Handling (on page 32)" chapter.
Here is an overview of the typical process to create a new animation from scratch, which
this chapter will guide you through:

1.
2.
3.
4.
5.
6.

Decide what size you would like your animation to be and set the page size
accordingly (see "FILE " > "PAGE OPTIONS (on page 618)").
Draw your first frame. Name the objects that you want to animate.
Create a new key frame (usually done by copying the earlier frame).
Move and transform the objects as required.
Preview the results.

Your First Animation
To create a new animation:
Create a new animation document. To do this:
Choose "FILE" > "NEW" > "ANIMATION" ("Ctrl + Shift + N").
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A new document will open, and you will see the animation button bar appear that
contains some relevant buttons.

1.
2.
3.
4.

Draw a simple shape, such as a rounded rectangle with the RECTANGLE
TOOL (but it can be any shape).
Click the APPLY NAME icon on the SELECTOR InfoBar and name it "shape".
Click the COPY FRAME button to create your 2nd key frame.
Transform the shape as required. You can adjust it using any of the six
animation types described earlier in the chapter.
PREVIEW MOVIE

By default the display period for each key frame is half a second. To produce a longer
animation, see the "Movie Frame Rate and Tween Steps" section later in the chapter.
You are not limited to just one moving object; you can have as many as you like on each
key frame. And as long as they appear transformed in some way, on the next key frame
(and they are each given a unique name) they will animate.
Here is another example.

The first key frame has some simple text and a simple shape within a static rectangle.

On the next key frame the text has been enlarged and made darker, the blue rectangle has
been rotated 90 degrees and transparency altered to be mostly transparent.

This is how the animation is constructed.

Animations
Keyframe 1
Intermediate tween steps
produced by Xara Designer Pro
X
Keyframe 2

In this animation, the text object grows, and at the same time the rounded rectangle rotates
and fades.

Exporting a Flash File
To export your animation as a Flash file:
Select "FILE" > "EXPORT ANIMATION" and then choose Flash under SAVE AS TYPE .
Or click the EXPORT ANIMATED FLASH button.

This will save the finished SWF file into the location you choose.

Previewing a Flash file in Xara Designer Pro X
To view your animation as it would look in a web page, click the
button to instantly see a browser preview.

PREVIEW FLASH

The preview page will show your finished animation as well as useful information, such
as the animation’s dimensions, file size, etc. It also includes simple instructions on
inserting your animation into a web page.

Inserting a Flash file into your webpage
For those using Xara Designer Pro X you can simply drop the Flash file onto your web
page to insert it into your website. A static placeholder image is automatically created
and placed on your page. Preview your page and you should see your working Flash
animation!

523

524

Animations
Alternatively you can create a placeholder object manually. On your web page, create a
placeholder object, which can be anything such as a simple rectangle or an image or
screen grab even. Position and size your placeholder where you want your Flash
animation to appear.
Then in the WEB PROPERTIES DIALOG ("Ctrl + Shift + W") select the PLACEHOLDER TAB
and the REPLACE WITH FLASH Browse options to locate the required .SWF file. Click
APPLY .
Now when you preview your website, the placeholder is replaced by the Flash animation.
With either option above, the .swf file gets copied into a support folder next to your .xar
file, so that there is a copy of the file with your .xar file. Therefore if you subsequently
change your animation and export an updated .swf file that you want to use instead,
either browSE FOR THE NEW .SWF FILE USING THE "UTILITIES" > "WEB PROPERTIES" >
" Placeholder tab" as above, or manually replace the file in the support folder with the
updated file.
See the Support Folders section (on page 50) of the Document Handling chapter for
more information.

Inserting using a different web authoring tool
To place your SWF animation into your HTML click the VIEW HTML link on the Flash
preview screen to get code that you can paste into your web page using your preferred
HTML editor.
Note: You must change the SWF file name in the code to match the actual name of your
exported SWF file. You must also place your SWF file into the same directory as your
web page for the code to work. If you place the SWF file in a different directory, you will
need to change the HTML code accordingly.

Exporting animations as AVI
As well as exporting animations as animated GIFs and Flash animations, you can also
export in the .AVI file format.
In an animation document, choose EXPORT ANIMATION from the FILE menu, and choose
AVI ANIMATION (*.AVI) from the Save As Type drop-down list in the Export File dialog.
Click the OPTIONS button to choose the export settings, or just click the EXPORT button to
use the current or default settings.

AVI options
Codec selection
Use the dropdown list to select from the range of codecs that you have installed. This
determines how your AVI is encoded and compressed. Or choose the "uncompressed"

Animations
option if you want to export an uncompressed AVI. Note that this will give you a very
large file size!
Key frame every N frames
The default value is provided by the selected codec and it’s normally best to keep that
value. Reducing the number will tend to result in higher quality but larger files, increasing
it in lower quality smaller files.
Frame Rate
Leaving the frame rate at the default 25 frames per second will result in a smooth
animation, but you may be able to get away with a lower rate of say 12 or 15 frames per
second if your movie is fairly static with little fast moving action. This will reduce the file
size.
Configure
Pressing the CONFIGURE button opens a settings dialog specific to the selected codec (if
available), which may give you more configuration options. The ABOUT button tells you
more about the selected codec.
Make background transparent
Selecting this option will make your AVI have a transparent background, which is useful if
you want your animation to appear on top of a movie (for movie titling, for example).
When this option is on, the codec list is reduced to show only the "uncompressed" option,
because transparency can’t currently be supported using a codec. If you export an
uncompressed AVI with transparency, it will import into MAGIX movie editing software
and some other movie editing applications with the transparency.
Area to save
Choose whether to save a movie that is the size of your animation page or the size of the
animated drawing.
Click OK to export the AVI animation.

Creating animated GIFs
Animated GIFs are an alternative way to present animated sequences in the web. An
animated GIF is just a GIF file that contains a sequence of images, rather like frames in a
movie. Every Xara Designer Pro X-frame is one frame in the final animation, just like a
flip-book.
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Opening an animation document
To create an animated GIF, you must first open an animation document. To do this
choose "FILE " > "NEW " > "ANIMATION ". You will then have access to the FRAME GALLERY
(on page 528).

Creating the animation
To create an animated GIF:

1.
2.
3.
4.
5.
6.

Choose "UTILITIES" > "GALLERIES" > "FRAME GALLERY" , or click the FRAME GALLERY
icon on the GALLERIES toolbar.
Draw what you want to appear in this first frame.
In the FRAME GALLERY , click NEW to create the next frame.
Set the background and overlay flags as required.
Create the objects you want to appear in this frame.

Exporting the animation
To save the animation, choose "FILE" > "EXPORT ANIMATION" .

Animation properties
To alter the animation's properties, right click on a frame in the FRAME GALLERY (on page
528) and select PROPERTIES . You can then change a number of options detailed below.

The Frame tab
In the FRAME tab you can set:








NAME :

The name of this frame. This is just as a reminder to you, and is not exported
with the animated GIF.
BACKGROUND : If this is set, the frame covers all previous frames. This is useful if you
want to create a background and then build up an animation on top of this background.
Often the first frame in the animation is a background frame. If the first frame is not a
background frame, the animated GIF uses the page background as its background.
OVERLAY : If this is set, then the frame overlays the previous frame.
LOCAL DELAY : Set how long the frame is displayed for in the animation.
SHOW FRAME : When checked, the frame will be shown in the animation.
MOVING FRAME IN TIME LINE: This value determines the amount by which a frame time
is changed when the ‘MOVE FRAME FORWARDS/BACKWARDS' buttons are used in the
Frame Gallery.

Flash Options
Here are several options for Flash animations, most of them are described above

Animations





Link to be applied to whole animation (on page 540)
Flash Movie Speed (on page 536)
JPEG quality (on page 531)
Area to save (on page 533)

GIF Options
In the GIF OPTIONS tab you can set the color usage in GIF animations. (Not available for
Flash animations). Click OPTIONS in the Export Animation dialog to show the GIF OPTIONS
tab in the Animation Export Options dialog.


PALETTE COLORS :

Set the preferred color palette for your animated GIF. The help
guide contains more information on the difference between these options.
 NUMBER OF COLORS IN PALETTE : This option is available only when using optimized
palettes. For simple graphics you can reduce the number of colors in the palette. This
can produce much smaller files without losing quality. You may need to experiment to
find the right balance between file size and quality.
 DITHERING : You can select between three types of dithering.
 TRANSPARENCY : Select this to make the bitmap transparent where there are no
objects.

Animation Loop and Speed
In the ANIMATION LOOP AND SPEED tab you can alter the animation rate and frequency:



LOOP :

Lets you specify how many times the animation should repeat itself.
If you want the same delay between each frame in the
animation enter a value here. To specify a different delay for individual frames, use the
frame tab (described above). This field reads "many" if the animation has more than
one inter-frame delay time.
DISPLAY EACH FRAME FOR :

Preview in Browser
You can select options suitable for the graphic and then load it into your browser so you
can preview it:


BACKGROUND OPTIONS :

Alter the background of the animated GIF to see which gives

the best result.


ADDITIONAL INFORMATION :

The preview page will contain useful information such as
potential downloading times when placed in a web page.
 BROWSER PREVIEW : Press this button to launch a preview in your web browser.

AVI Options
Options: Select from a range of codecs you have installed
Quality: Set the quality value of the AVI (up to 100%)
Key frame every ...: Enable/disable the outputting of key frames and set the frequency.
Transparency: Select to make the AVI background transparent.
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Area to save: Setting the area to save to be DRAWING will create an AVI animation that is
only as large as it needs to be – i.e. the same as the outer bounds of the animation. This
can be useful if you don't need a specific page size.

The Animation Frame Gallery
By default the ANIMATION FRAME GALLERY is displayed open on the right hand side of the
Designer Pro window (next to the PAGE & LAYER GALLERY ) when you open or create an
animation document.
To toggle display of the FRAME GALLERY , choose "UTILITIES" > "GALLERIES" >
"FRAME GALLERY" , or click the FRAME GALLERY icon on the GALLERIES toolbar.
This shows a list of the
key frames in your
document. To view any
key frame just click its
name in the gallery.

A typical FRAME GALLERY . Frame 3 is selected and thus visible.

The ANIMATION FRAME
GALLERY shows frames
from the top down, so
the first frame is at the
top and the each new
frame you add gets put
at the bottom of the list.
You can re-order frames
by dragging them.
There are buttons to
perform the main
operations of deleting
frames, copying the
selected frame (it will
always get added to the
end) and creating new
blank frames.

Animations
The PROPERTIES button is very important, since it shows the ANIMATION PROPERTIES
dialog which controls many aspects of not just the selected frame but the whole
animation.

The Animation Properties dialog

A shortcut to display the Animation Properties dialog is to simply double click on a frame
name in the FRAME GALLERY
The ALL FRAMES VISIBLE (the eye) and EDIT ALL FRAMES (the padlocks)
buttons on the FRAME GALLERY are useful because they allow you to
view or edit all frames together, one on top of the other.
This is particularly useful if you want to select objects that are on multiple frames.
Note: When you copy a frame, it always copies the selected frame and places it at the
end. So in order to insert a new frame, say between frames 4 and 5, select frame 4, click
the COPY button, and then drag the new copy from the end to the desired position
between frames 4 and 5.
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Note: Frame names do not matter and can be anything you like. They do not have to be
Frame 1, Frame 2, etc. Animations always play the frames in the order top to bottom,
irrespective of the names.

Photos
Because Flash files usually consist of vector shapes, and the transforms are relatively
simple, the files can be very small. Photos and bitmaps can be embedded into Flash
animations, but unless you are careful it will result in huge animation files. You can
perform all core Flash transforms on bitmaps or photos (i.e. you can move, scale,
squash, rotate, fade and re-color.).
Flash files can include both PNG and JPEG images just as .xar files do, and Designer
Pro automatically creates photos of the right resolution when creating the Flash file. So
for example you can load a hi-res digital camera image, size this down to be say 200
pixels, and this means that a 200 pixel image will get included, and not the full hi-res
JPEG.
When higher resolution photos are converted down for inclusion in Flash files the JPEG
compression setting (Animation Properties dialog, Flash Options tab) can be used to
control how compressed your JPEG images are. See below.
When tweening bitmaps or photos, only one copy of the bitmap is stored in the Flash file,
so you can perform transformations of the bitmap with little overhead. In other words, just
because the bitmap appears on frames 1, 2 and 3 of your animation, this does not mean
three copies of the bitmap are embedded in the Flash file.

Non-JPEG Bitmaps
Other types of bitmaps, for example, BMP, TIFF, or PNG bitmaps, are usually a lot larger
and thus less suitable for use in Flash animations (for photos JPEG compression is a lot
better than PNG). However if you include a low resolution PNG image (that is one of
96dpi or less – the status line shows you the resolution of any selected image) then this
is kept as a PNG image in the Flash file. Higher resolution images (>96dpi) will be
converted into a JPEG (transparent JPEG if required) .
You can control the compression used for this automatic JPEG conversion using a slider
in the FLASH OPTIONS tab of the ANIMATION PROPERTIES dialog. The usual compression
value is 75%, but you can vary the quality, preview the animation and quickly see the
quality and size savings.

Animations

256 color or less bitmaps (such as GIF) are not encoded as JPEG and will be embedded
using PNG compression, which is usually the best compression type for these types of
images

Bitmap Quality
Flash Player version 8 and later has higher quality bitmap display. This is particularly
evident when rotating or scaling bitmaps and photos, whereas older versions of the
player tend to produce pixelated, and rather jerky movements.
You can tell which version of the Flash Player you have by right clicking on any Flash
animation in your web browser and looking at the About menu.
It’s therefore recommended to export your Flash animation as Version 8 if you’re using
bitmaps or photos. You can control this from the FLASH OPTIONS tab of the ANIMATION
PROPERTIES dialog.
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Animation Frame Rate and Tween Steps
Flash animations run at a fixed frame rate. The faster the frame rate, the smoother the
resulting animation and the larger the Flash file. Xara Designer Pro X animations default
to showing 24 frames per second, but you can change this.
When you create each key frame, you determine how long the period is until the next key
frame. For example, if a frame period is set to half a second, this means the animation
from that key frame to the next will take half a second. At 24 frames per second this
means there will be 11 intermediate steps generated by Xara Designer Pro X in the Flash
animation, so 12 frames in all. (These intermediate "tween" frames are not ever seen in
Xara Designer Pro X and are only generated when you create the Flash file.)
The FRAME GALLERY
always shows you the
display period for each key
frame. In this example
three frames are displayed
for one second each, so the
whole animation lasts 3
seconds before repeating.

To create a longer tween effect (in other words to slow the animation down) increase the
display period using the ANIMATION PROPERTIES dialog.
The easiest way to alter the display period for any frame is to just double click on the
frame name you want to alter to bring up the dialog, enter the new period in seconds,
and click OK or APPLY .
Move frame forwards/backwards
These buttons allow you to move a key frame forwards or backwards in the animation,
without changing the length of the animation. This is useful when working with
animations that are exported as AVIs and included in movies, particularly if you are trying
to track an object in the movie with your animation. By Default each click moves the
frame by 1/25th of a second, which corresponds to one frame of a 25fps movie. You can
change this value in the FRAME tab of the ANIMATION PROPERTIES dialog.
Move frame 1/25th sec forwards
Move frame 1/25th sec backwards
The length of the previous frame is adjusted in order to keep the overall length of the
animation the same, so effectively you are just moving the key frame forward or
backward in the animation.

Animations
Cropping, Clipping and Animation Size
Before long you'll start to consider creating some Flash animations like you see on the
web, say with some wording or a photo that whizzes in from one side.

To create an animation like this, all you need to do is set the page size in Xara Designer
Pro X to the size you want for your flash animation. So if for example you want a Flash
banner which is 468 pixels wide and 60 pixels high, set the page size in your animation
document to 468x60. To set the page size, go to the PAGE TAB of the OPTIONS DIALOG
(on page 618) (or choose "FILE" > "PAGE OPTIONS" ) and set the Width and Height fields
accordingly.
When exported or previewed, the flash animation is automatically clipped to the page
size you have set. So it’s easy to arrange your animation so that objects glide in and out
of the visible animation. E.g. by placing an animating object to the left of the page on one
key frame and to the right of the page on the next key frame, in the animation the object
will be seen to slide in from the left side of the design and disappear off the right side.
You can also change the page dimensions by going into the SELECTOR TOOL (ON PAGE
122)AND DRAGGING ON THE BOTTOM EDGE OR RIGHT EDGE OF THE PAGE, TO CHANGE THE
PAGE HEIGHT OR WIDTH RESPECTIVELY. SEE CHANGING THE PAGE SIZE IN THE DOCUMENT
HANDLING CHAPTER FOR DETAILS.

533

534

Animations
Note: When opening older documents created with earlier versions of Designer Pro,
these will not clip to the page (the page size was huge), instead they clip to the size of
the drawing. You can control this in the Animation Properties dialog.

Setting the area to save to be Drawing will create a Flash animation that is only as large
as it needs to be – i.e. the same as the outer bounds of the animation. This can be useful
if you don’t need a specific page size.

Animations
Animation Speed
When you create a new keyframe, it defaults to having a period of half a second. So the
animation from that keyframe to the next will take half a second. The longer you set the
period, the slower the animation. To set the frame period for any frame, first select the
desired frame in the FRAME GALLERY (click on it), and then click the ANIMATION
PROPERTIES button (or just double click the frame name).

Setting "Display This Frame For" to 2 seconds means the animation will take 2 seconds to
tween from this key frame to the next.

Note: The ANIMATION PROPERTIES dialog is non-modal and you can keep this on screen
all the time. By pressing the APPLY button instead of OK, the dialog remains on screen.
Its contents are updated as you select different frames, and for each of them you can set
the required display period.
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Animation smoothness
Flash movies play at a constant frame rate. The faster the frame rate, the smoother the
animation. Xara Designer Pro X defaults to showing 24 frames per second. To change
the rate select the FLASH OPTIONS tab of the ANIMATION PROPERTIES dialog.

The Flash Options tab, where you can change the movie speed as well as the Flash export
version.

Note: The faster the frame rate, the larger the resulting Flash file. You will find that if your
animation is mostly objects fading in and out with relatively little fast moving animation,
then you can reduce the frame rate to under 24 frames per second. If you have a lot of
fast action, it may be necessary to increase the frame rate, but it’s rarely necessary to
have it above 50 frames per second.

Animations
Rotation
Xara Designer Pro X calculates and generates the tween frames automatically by
working out how to transform the shapes from one key frame to the next. But sometimes
it's not possible to know exactly what type of rotation is required.
Take this example. Suppose you tween
from the first clock face to the second:

You might expect it to rotate clockwise,
but of course it could go counter
clockwise:

In fact there are other ways it could rotate. The above
examples assume the hand rotates around one end, but you
could tween from one state into the other by doing a straight
line rotation of the center of the object, which would result in
this:

If you look closely, the hand rotates around its center rather than one end, and the center
point moves in the straight line from one key frame to the next. By default, Xara Designer
Pro X rotates objects this way.

The Rotate command
To force the rotation to be around any other point you can use a special keyword "rotate"
appended to the front of the object name. Or you can use "rotate +" to force the rotation
to go clockwise or "rotate -" to make it go counter clockwise.
To take the simple two keyframes animation example shown on the previous page,
where the hour hand needs to move from 12 o’clock to 8 o’clock. If you name the hand
object "rotate + hand", you'll get an animation showing the clock’s hand moving
clockwise. If you name it "rotate - hand", then the hand will rotate counter clockwise.
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If there is no rotate command, then the tween takes the shortest direct path between the
object on one keyframe to the next, rotating around its center. With a "rotate" command
on the object name, it calculates the actual rotation point, which in the above example is
the "large end" of the hand.
Note: It's not possible to rotate an object by a full 360° between keyframes if the rotation
point is not the center. For example, to do a full rotation of the clock hands in the above
example, you would need to create an intermediate keyframe.

What Xara Designer Pro X features does Flash support?
The Flash vector rendering is quite primitive compared to Xara Designer Pro X's, and so
you can't use many of the more advanced Xara Designer Pro X features such as
feathering, complex transparency and fill types, bevels, soft shadows, or contours. Lines
(strokes) are limited to be being simple constant thickness, round ended lines. No line
dashing is supported. The minimum line thickness is one pixel—so thinner lines in Xara
Designer Pro X will be displayed one pixel thick in Flash.
There are two aspects to producing Flash-compatible drawings. The first is to limit
yourself to use only those features supported directly by the Flash player. Secondly,
when producing animations, there is an even more limited set of characteristics that can
be tweened or animated.
Xara Designer Pro X drawing features that Flash supports:
 All normal line and shape drawings (although Flash is a lot less precise than Xara
Designer Pro X and so sometimes you may notice inaccuracies in lines and shapes).
 Flat, linear, circular and elliptical gradient color fills.
 Multi-stage gradient color fills, including linear and elliptical fills. Eight color stops
maximum.
 Flat transparency. Mix type only.
 Graduated transparency is supported for flat color filled objects (non-graduated). So
you can have graduated color objects with flat transparency or flat color objects with
graduated transparency, but not both.
 Constant width outlines (stroked paths) with rounded end caps and line joins (version
8 Flash files support the other join and cap types).
 Text, including kerning. You can use any fonts you like. The outlines of the characters
of any used fonts are embedded into the Flash file. This is much more efficient than,
say, font embedding in PDF documents.
 Text on a curve. Note: the line used for the curve must be made invisible for the
animation to work.
 Bitmaps and bitmap fills.
 Contoned (colored) bitmaps and bitmap fills.
 Photo Saturation, temperature color and blur (but not brightness / contrast change).
 Fractal Cloud and Plasma fills will work, but are converted to bitmaps, so not efficient.
So you can't use, amongst other things:

Animations





Any transparency type other than mix.
Feathering.
All complex graduated fills (conical, diamond, 3 color etc).
All complex graduated transparency styles (as above). (You can use linear, and
elliptical transparency on flat color filled objects.)
 Live Effects.
The following object types will export in static Flash, but do not animate.






Soft shadows.
Bevels.
Contours.
Blends.
Molds.

So while some Xara Designer Pro X effects, such as soft shadows and bevels do work in
static files, these are exported as bitmaps into the Flash file, so they are not very efficient
and not suitable for animating.
What can be animated:
As listed at the start of this chapter, these are the golden rules as to what you can
change from one keyframe to the next:








Move: Move objects from one position to another.
Scale: Enlarge or reduce objects in size.
Squash or skew: Squash or skew objects.
Rotate: Rotate objects.
Transparency: Adjust the overall (flat) transparency of the object.
Color transform: Change the fill (flat) color of objects.
Or any combination of the above.

In addition, there are a few special cases of photo color transformations that are
supported by Flash. You can alter the saturation (so you can tween a full color photo into
a black and white one), You can also adjust the temperature color control (warm / cool),
and also the blur value. The latter enables you to tween a blurred photo into a sharp one.
But note this only works for blur values and not sharpen. Also there is a slight difference
in the way Flash blurs photos. Flash blurs the whole photo including the edge, whereas
the Photo blur in Xara Designer Pro X only blurs the inside of the photo and keeps a
sharp edge.
Secondly, another special case: you can animate text on a curve. This is special because
you can use this to seemingly morph text along one curve into text along a completely
different curve. In fact what it does is tween from the character position in one keyframe
to the corresponding character’s position in the next frame. This can produce some
interesting effects.
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Note: The line used for the curve must be made invisible for the animation to work.

Finally you can also tween outline thickness between one key frame and the next, but
only for shapes with a constant outline thickness (ie. It will not worked for shapes with a
stroked outline).

Color Transforms—Animating Color Changes
This is what you can and cannot do with color transforms in Xara Designer Pro X Flash:






You can animate simple flat color changes of objects from one keyframe to the next.
You can change the line color independently of the fill color.
You can change photo contone colors.
You cannot adjust the position of gradient fills.
You can use RGB, HSV or CMYK colors. These are all converted to RGB colors when
exported to Flash (which is the only color model Flash supports).

URLs in Flash
To make an object in your Flash animation a clickable link, just select the object you want
to make clickable and select "UTILITIES" > "WEB PROPERTIES ("Ctrl + Shift + W").
Enter the required URL. (If you require the link to open in a new browser window or
browser frame select the target web frame by selecting from the ‘ OPEN LINK IN ’ dropdown
menu).
If you want to make text clickable select the RECTANGLE SURROUNDING OBJECT option.
This ensures those that viewers of your Flash animation can click anywhere over the text
(rather than just on the actual letter shapes).
Making the whole animation clickable
In the "ANIMATION PROPERTIES" > "FLASH OPTIONS" tab you can set a URL to apply to a
whole animation. This is useful for banner ads where you want a click on any part of the
animation to go to a given web address.
clickTAG
clickTAGs are often used by advertising networks. Rather than hard-coding a URL into a
Flash animation, the clickTAG allows an organization to insert their own URL into the
animation, which is particularly useful for tracking advertising clicks.
If you need to use this feature, check the clickTAG option.

Animations
Advanced Flash Commands
Accelerating and Decelerating
Usually the tween steps are evenly spaced between keyframes, producing a linear
animation from one keyframe to the next. By appending < and > symbols to the front of
the object name, you can make objects speed up or slow down. So naming an object
>Name means that it starts fast and slows. The opposite, <Name, would start slow and
speed up.
You can even use these in combinations. So an object name <>Name would start slow,
speed up and then slow down towards the end of the frame period. In traditional
animator’s terminology this is called ‘easing’, so you can ease in or ease out, and the
command <> would be an ease in/out.
You can control the degree of acceleration or deceleration by using numbers from 0 to 9.
So <2Name would be a very gentle acceleration, while <9Name would be extreme
acceleration. Similar >2 in front of the name would give a slight deceleration. Using the
name >Name (with no number) is the same as >5Name.
Example: there is an example file called Pendulum in the FLASH EXAMPLES section of the
DESIGNS GALLERY (on page 27) (click the DISC DESIGNS button on the DESIGNS GALLERY ).
The pendulum group uses a combination of <> and the rotate command. Another
example called "Zoom.xar" is also worth examining.

Stop and Goto Commands
You can append STOP or GOTO commands onto the Frame names (separated by a semicolon ; ) to control the sequence flow. So for example if your first frame was named
"Frame 1;Goto Frame 6", then the animation sequence would jump to Frame 6 at the
start of Frame 1. This may produce tween errors, but these can be ignored. It also waits
for the specified period of the frame with the GOTO command on before jumping, but
frames with GOTO or STOP commands do not tween.
Similarly a frame name with ;STOP appended to the end of the name would stop when
the animation reaches this frame. Why is this useful? Because you can make the
animation jump to any other key frame with either a click or by moving the mouse over
objects. For example you might have an animation that waits for the user to click on or
move the mouse over an object before continuing.

Clickable Buttons & Mouse-over Effects
You can make the animation sequence jump to any keyframe either by clicking on an
object or just by moving the mouse pointer over any object.
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To do this select the object you want to use as the trigger, open the WEB PROPERTIES
dialog (Ctrl+Shift+W) and on the LINK tab, select the JUMP TO FRAME option.

If you want the jump to occur by just moving over an object, select the Mouse -Over tab instead
of the Link tab, and select from the similar ‘ JUMP TO FRAME ’ option.

Now in your animation if you click or mouseover the object the animation will redirect to
the the new frame and proceed from there. See the "River Thames" example file in the
DESIGNS GALLERY (on page 27). This uses a Goto command to loop from frame 4 to 3,
and a URL frame re-direct to jump to Frame 1 if you click the Replay link in the corner.
"Ctrl + Shift + W" is a quick way to open the Web Properties dialog.

Printing
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Show print borders
The "WINDOW" > "SHOW PRINT BORDERS" menu shows a yellow and red line around the
page (non-printing) showing the print margins and borders. The page boundary is shown
by a yellow rectangle and the printing area by a red rectangle. The printing area is
determined by the margins on the currently selected printer. Some printers let you adjust
the margins, but few let you print right up to the edge of the page.
If any objects on the page lie outside the red rectangle they are unlikely to be printed.

Selecting and setting up a printer
Select "FILE" > "PRINT" TO open the PRINT dialog box, then click the PRINTER... button.
This opens the standard Windows

PRINT SETUP

dialog:

Selecting a printer also selects a suitable paper size and paper orientation. Note that
these are the size and orientation of the sheets of paper used in the printer. They are
separate from the size/orientation of the document. PORTRAIT prints the page without
rotation. LANDSCAPE prints the page turned through 90° (these buttons are duplicated in
the PRINT OPTIONS dialog box, described later). We recommend leaving the
LANDSCAPE /PORTRAIT buttons on this dialog box on their default setting.
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Please note: We cannot give you advice about installing or configuring printers as these
are standard system operations. In case of difficulties, contact the supplier of your printer
or computer.

Properties button
This displays a dialog box letting you set options for the selected type of printer. This
dialog box is not controlled by Designer Pro.

Network button
If your computer is connected to a network, this lets you connect to shared printers on
the network. This dialog box is not controlled by Designer Pro.

The print dialog box
Choose "FILE" > "PRINT" ("Ctrl + P").

Print button
When you have selected the required options click this to start printing.

Printer… button
This opens the "PRINT SETUP" dialog box (described earlier).

Printing
Options button
This opens a tabbed dialog box that lets you set additional print options. These are
described later (on page 547).

Pages
ALL PAGES:

Prints every page of the document.

CURRENT PAGE(S):

Prints the currently selected page or spread.

This option is available when any objects in the document are
selected. When active, only the selected objects are printed. Note that other objects
within the bounds of the selected objects are not printed – only the objects which are
actually selected are printed.
SELECTED OBJECTS:

Hidden objects, objects on hidden layers and the guides layer never print. See Page &
Layer Gallery for more details.
Allows you specific control over which pages you wish to print. You can
type specific pages numbers, separated by commas, or page ranges by typing two
numbers with a hyphen in between them.
PAGE RANGE:

Page range examples:
2 will print just page 2.
1,3,5-7 will print pages 1, 3, 5, 6 and 7.
2,3,6-8,11-12 will print pages 2,3,6,7, 8,11 and 12.
The Options section of the dialog will indicate if your page range is OK or invalid.

Double page spreads
If the document comprises a double-page spread, you can print both sides or just the left
or just the right page.
This option is dimmed when the spread comprises a single page (see Document
Handling for how to select single or double-page spreads). Or the "PRINT/EXPORT
INDIVIDUAL PAGES " is active in the Page Options (on page 619), so that the two pages of
a double-page spread are treated as individual single pages.

Print to File
You can select the PRINT TO FILE option to create a document that you can give to a
printing company (if they are able to accept this type of file).
After checking this option, when you click PRINT Designer Pro displays the standard
Windows SAVE dialog box so you can specify a file name and location for the file.
Print files have a default extension of .prn.
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If you want to create a PDF file we recommend selecting the "File -> Export…" option
and selecting PDF. This produces a higher quality, and usually more compact PDF file
than you'd get from printing to a PDF file.
For more information on exporting as PDF refer to Importing and Exporting (on page
562).

Number of copies
Sets how many copies of the document to print.

Collated
This is dimmed except when printing multiple copies of a double-page spread as two
separate pages. With this option selected, pages are printed as left-right-left-right, etc.
With this option deselected, all the left-hand pages are printed then all the right-hand
pages.
Printers that hold a page image in memory take some time to process the image. The
printer can then print multiple copies at its maximum speed. For such printers it is often
faster to manually collate the pages after printing.
Other types of printers have to process the page for each copy. For these, select collate
copies and save yourself the chore of collating.

Printing
Print Options: Output tab

Print layers
There are two options:
 Print ALL FOREGROUND LAYERS .
 Print only the currently VISIBLE FOREGROUND LAYERS .
Note that only foreground layers are printed. Background layers are never printed.

Print As
NORMAL

is suitable for most types of document.

However some printers do not reproduce consistent colors when printing bitmaps or
vector objects that are the same color (this is a fault with the printer driver). This is
noticeable if objects overlap onto bitmaps or onto objects with transparency applied to
them. In this case, select BITMAP or ANTI-ALIASED BITMAP and retry.
The choice between BITMAP and ANTI-ALIASED BITMAP depends on the printer and
personal preference. Some printers give best results with anti-aliasing turned off
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especially when printing thin lines. As a rule, using anti-aliasing allows lower resolution
printing. For example, 150 DPI bitmap printing is usually good enough for all uses-even
typesetting. Without anti-aliasing, higher resolutions may be needed which gives much
slower printing.

Transparency resolution
When printing, Xara Designer Pro X's transparency effects are created using bitmaps.
This option controls the resolution of those bitmaps when sent to the printer. Automatic is
suitable for most drawings, and means Xara Designer Pro X automatically selects a
resolution suitable for the current printer. This might be unsuitable if printing to a very
high resolution printer such as image setting devices. In this case you may wish to
control the print resolution manually by entering the desired value.
Note that modern printers often claim to be able to print at over 1000 dots-per-inch, but
this is not the same thing as "pixels-per-inch", which is what you see on screen.
Generally, it's never necessary to print at more than 600 pixels-per-inch, and typically
300 pixels per inch produces perfectly adequate print results, especially if anti-aliased.

Fill quality
Using this option, you can choose how many steps make up the graduated fills in your
document when it is printed. The NORMAL setting is suitable for most purposes. This
option is dimmed for PostScript printers.

Text options
If your printer has problems reproducing fonts, select the PRINT ALL TEXT AS SHAPES
option. All text is then converted to vector shapes before the document is sent to the
printer. This may be slower, but will reproduce exactly what you see on screen.

Printing
Print Options: Layout tab

Most options in print layout are dimmed if you have BEST FIT or AUTOMATIC FIT selected.
We recommend using these options as they are the easiest way to print.
However you can choose custom options (see “custom fit” below).

Automatic fit
Your design will be orientated as necessary, but Designer Pro will not change the size.
We recommend this option if you are having any difficulty getting the orientation right
(there are at least four places where you can set the page orientation, sometimes more
for some printer drivers).
This option is best if you have a set size for your design and don't want it altered.

Best fit
Your design will be moved to the center of the page and it will be expanded or shrunk to
suit the paper size.
This option is best if you have a large or small design and want it to fit on one page.
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Custom fit
Allows you to have control over your print out, including orientation, size and margins.
The ORIENTATION buttons can be used to choose the orientation of the printout. The
scale can be altered using the SCALE field. The top and left margin fields can be changed
(these set where the top left-hand corner of the page appears on the printer's paper).
The WIDTH and HEIGHT fields give you an alternative way of setting the print scale (when
you change one of these settings, the other changes to ensure the page is always
printed with a 100% aspect ratio).

Multiple fit
To print multiple copies on one page, choose MULTIPLE FIT , enter a value for the number
of copies needed across the page (rows), the number down the page (columns), and the
distance between each (gutter).

Printing
Imagesetting
Spot colors
Normally four colors are used when printing, cyan, magenta, yellow and black (key)
commonly known as CMYK. But it’s also possible to produce spot colors. Spot colors are
not normally printed using the CMYK inks, and are instead additional inks.
Spot colors have two uses:
 Many simple jobs use only two or three ink colors (for example a simple newsletter
with black text and blue headings). Creating a spot color for each ink color can make
the job cheaper to print.
 Some complex jobs require either PANTONE COLOR BRIDGE colors or special inks
that cannot be reproduced in CMYK such as gold or silver. These special colors
require spot colors.
See chapter PANTONE colors (on page 206) for more on PANTONE COLOR BRIDGE.
Note: As each spot color is an additional ink and printing plate, it does increase printing
costs.
Spot colors appear as circles on the COLOR LINE and COLOR Gallery.
Spot colors are always Named colors.
Technical notes on color separations:
 Tints based on a spot color output on that spot separation. So if you require a lighter
shade of a spot color, define the color as a Tint (on page 203) of the spot color.
 Shades and linked colors based on a spot color output on the CMYK separations.
 Objects with transparency applied always output on the CMYK separations, not to the
spot separation.
For more information on how spot colors are affected by transparencies, fills and blends
see "Transparency and Color Separations" later in the chapter.

On screen printer plate previews
The process of printing requires that your artwork is separated into CMYK print colors. It
can sometimes be useful to see and understand exactly what inks are printed on each
printer plate, especially if using spot colors. Xara Designer Pro X can show a simulation
of the CMYK separation process on screen, showing a preview of each printer ink color
separation. Normally this would be the four CMYK colors, but if you use spot colors you
can preview these as well.
To preview any required plate or ink color, select "WINDOW" > "SHOW PRINTER COLORS"
and the required ink color.
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Simulating print colors on screen
Because printed colors are often a very different shade to those available on screen,
Xara Designer Pro X can adjust the screen color to more accurately simulate the printed
color. Simply select "Window -> Show Printer Colors -> Simulate Print Colors". See the
section "Viewing Print Colors on Screen" in PANTONE Colors (on page 206) for more
information.

Imagesetting dialog
The IMAGESETTING dialog gives control over printer’s marks and film settings.
To open it, choose "File -> Print Options", then select the IMAGESETTING tab. Or, from the
PRINT dialog, click "Options", then select the IMAGESETTING tab.

Output Printer’s Marks
This switches selected printer’s marks on or off in one operation. Printer’s marks provide
useful information when printing professionally, for example indicating the edge of the
document so that it can be cropped to the proper size after printing.
The default options that are then selected will be suitable for most print jobs. Only
change them if asked to do so by your print company.

Printing
As well as for printing, these settings also apply to PDF/X export if the INCLUDE CROP AND
PRINTER MARKS option is selected in the ADVANCEDOPTIONS , LAYERS tab of the PDF
export dialog.
See PDF Export (on page 577) for more information on exporting as PDF/X.
These are the various printer’s marks options that you can turned on or off.

1) Crop marks
These are used for jobs that will be trimmed to size after printing. They tell the print shop
where to cut the paper.
2) Plate information
This is information such as plate name, file name and date & time.
3) Registration targets
Registration targets appear in the same position on each separation so the print
company can align the separations when making printing plates and when printing.
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4) Registration stars
These are a further check that the separations are lined up.
5) Grayscale bar
This shows that the imagesetter or printer has rendered the full range of gray tones from
10% to 100%. It also provides the print shop with useful information during printing.
Useful for both monochrome and color work.
6) Progressive color bar
Similar to the grayscale bar. Provides the print company with useful information when
printing multicolor work.
7) Long registration targets (Not shown in the example)
These are an alternative form of registration targets. Some print companies may prefer to
work with this type of target. They replace the registration marks shown (option number
three) with this target type:

8) Overprinted color bar
Similar to the grayscale bar. If your document uses overprint, this provides the print
company with useful information during printing.

Print films
Films used to be used for press printing, but have been phased out by most print
companies in favor of PDF/X. But if you need to create films, these settings may be
relevant, and again only change them if asked to do so by your print company.
Emulsion down (reflect image): Creates a mirror image. This option, if enabled, will
only work when outputting to PostScript printers. The imagesetting material is coated
with photographic emulsion on only one side. With this option off, the emulsion is on the
top of the film when you can read it normally. This may be known as "right reading,
emulsion up". With this option on, the emulsion is on the back of the film as you read it.
Called "right reading, emulsion down" or "wrong reading, emulsion up".
Negative: Produces a negative image. This option, if enabled, will only work when
outputting to PostScript printers. Leave off if you are asked for "positive" or just "pos".
Turn on for "negative" or "neg".
Always overprint black: Overprints any objects that are over 95% Key (CMYK black).
Black is a relatively opaque ink and overprinting reduces registration problems. This
option is particularly useful if you have a lot of black text. If your document has large
areas of solid black, overprinting all black can cause problems with over-inking on the
press. Overprinting is described later in the chapter.
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Separations dialog
The SEPARATIONS dialog gives control over separations and PostScript settings.
To open it, choose "File -> Print Options" then select the SEPARATIONS tab. Or, from the
PRINT dialog, click OPTIONS then select the SEPARATIONS tab.

PostScript options
The settings give you control when sending to a PostScript printer. They are ignored by
any other type of printer. It is unlikely you will need to change these, but if asked to do so
you can change the settings described below.
Use printer defaults: Selecting USE PRINTER DEFAULTS uses the standard settings for
the selected printer. Generally these give good results, but if you want greater control
choose USE CUSTOM SETTINGS .
Use custom settings: Selecting USE CUSTOM SETTINGS lets you configure the printer
settings to suit your requirements. Note: No check is made whether the settings you
choose are suitable for the type of printer; it is assumed you know your requirements.
Target printer resolution: Specified in dots-per-inch (DPI).
Default screen frequency: Specified in lines-per-inch (LPI). Tints of the basic ink color
are printed as small dots called halftone dots. The dots are arranged in rows and the
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number of rows to the inch is the screen frequency. The lower the screen frequency, the
larger the individual halftone dots and the more noticeable they are. Your print company
may ask for “120 line screen” which would be a screen frequency of 120LPI.
Screen/dot type: PostScript printers can print halftone dots in a variety of shapes.
Generally round dots give the best results but some presses work better with a different
dot shape.

Print Color Separations
If you want to print all the colors in one pass through the printer, deselect
SEPARATIONS. This full color output is referred to as a composite output.

PRINT COLOR

If you want to produce output separated into the CMYK process colors and any spot
colors, select PRINT COLOR SEPARATIONS . If you have one spot color, for example, you
will get five printouts: one for each of the CMYK colors, and one for the spot color.
Your print company can advise you on whether they want composite or separated files.
Separating to a local printer is useful if you want to view each separation.
You can now set options for the individual separations.
To output a separation for an ink color, select the left-hand check box. By default all
plates are set to print.
You can also view each separation within Xara Designer Pro X with the "Window ->
Show Printer Colors" options.
To set an ink color to overprint, select the right-hand check box. Overprinting is described
later in the chapter.
To change the screen angle and
frequency, click on the ink name to
select it then click PROPERTIES .
This opens the SEPARATION
PROPERTIES dialog:

Angle: To change the screen angle for this color, type in a new value in degrees.
Frequency: To change the screen frequency for this color, type in a new value. This
overrides the default screen frequency (described in PostScript options earlier) for this
color.
Print this ink: This duplicates the check box in the main SEPARATIONS dialog.
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Overprint this ink: This duplicates the check box in the main SEPARATIONS dialog. It
protects the selected color from being knocked-out, so works in the reverse to objectlevel overprinting. Overprinting is described later in the chapter.
Print spot colors as process colors: Desktop printers and some printing processes
can only print process (CMYK) colors. Select this option to print any spot colors as their
equivalent CMYK color. Note: some spot colors look very different when output as
CMYK, and it removes the ability to use PANTONE COLOR BRIDGE (Xara Designer Pro
only) colors or any special inks. The main use of this option is when checking your
artwork on a local printer.

Overprinting
If you are producing color documents that will be printed on litho printing presses, you
may find overprint useful. Printing presses are mechanical devices with the inevitable
slight misalignments when they are running. Overprinting lets you overcome these
misalignments. For example, your job may have a black circle on a cyan background.
When the document is imageset, the circle appears on the black separation and the cyan
separation has a non-printing area under the circle (the technical term is that the circle
"knocks-out" the background). The knock-out is the same size as the circle.

A black circle knocks-out out the cyan background

If the two plates do not line up exactly during printing, the circle will slightly offset from
the knock-out (known as "out of register") and a small white gap can appear.
This example is exaggerated to illustrate the
out of register printing, but even thin lines can
be noticeable with dark colors.

Overprinting compensates for this problem. Xara Designer Pro X has two types of
overprinting: object level and ink level.
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Object level overprinting
You can separately specify overprint for the line and fill colors of an object.
To overprint the line on an object, select the object then:
 Right click and choose "IMAGESETTING" > "OVERPRINT LINE"
 Or choose "UTILITIES -> IMAGESETTING - > OVERPRINT LINE" .
 Or right click the object, then choose "IMAGESETTING -> OVERPRINT LINE" .
To overprint the fill on an object, select the object then:
 Right click and choose "IMAGESETTING" > "OVERPRINT FILL"
 Or choose "UTILITIES - > IMAGESETTING - > OVERPRINT FILL" .
 Or right click the object, then choose "IMAGESETTING -> OVERPRINT FILL" .
To turn off overprint on an object, just select the relevant option again. You can overprint
both the line and a fill on an object if required. The object’s fill and/or line will then not
knock-out the colors any colors below it. Overprinting the fill is most commonly used to
overprint dark colored text.
Overprinting the line is the normal way of avoiding out of register printing. The print
company can tell you the tolerance to allow (usually 0.5pt to lpt). The line color depends
on the background and object colors. Unless you want a specific line color, set the line to
the lighter color.

Ink-level overprinting
Xara Designer Pro X has two ink-level overprint options:
 Overprint everything, including tints, in the specified ink color. Set in the SEPARATIONS
dialog box (see above). This option is rarely useful, but works in the reverse of objectlevel overprinting. For example if you select Cyan to be overprinted, it will cause cyan
to not be knocked-out.
 Always overprint black (everything over 95% Key). Set in the IMAGESETTING dialog
box. Black is a relatively opaque ink and overprinting reduces registration problems.
This option is particularly useful if you have a lot of black text. If your document has
large areas of solid black, overprinting all black can cause problems with over-inking
on the press.

Printing on all plates
PRINT ON ALL PLATES

is known in some programs as REGISTRATION BLACK .

You sometimes want an object to appear on all separations. To do this, select the object
then right click and select "IMAGESETTING" > "PRINT ON ALL PLATES" or choose "UTILITIES
- > IMAGESETTING -> PRINT ON ALL PLATES".
The object color changes to black or gray, depending on its original color, to remind you
that PRINT ON ALL PLATES is applied.

Printing
To cancel PRINT ON ALL PLATES , select the option again.
Usually PRINT ON ALL PLATES is applied only to small areas such as additional printer’s
marks or lines of text. Do not apply PRINT ON ALL PLATES to large areas as this can flood
the printing press with excess ink.

Printing & color separating: technical details
Color separating
Xara Designer Pro X converts RGB, HSV and grayscale colors to CMYK for printing.
Because the inks in printers are not pure color, some color correction is required. For
example, theoretically 100% red in RGB is 100% magenta and 100% yellow in CMYK. In
practice, less magenta is required to get the right color. Also, in dark colors and grays,
black ink can replace a proportion of CMY. Color correction in Xara Designer Pro X is
entirely automatic.
CMYK colors do not need color correction and so are usually printed without
modification. The exception is areas where transparency has been applied. This is
described in detail below.

Transparency and color separations
Transparency helps create some outstanding illustration, but can also cause unexpected
results when color separating because PostScript imagesetters, and printers do not
directly support transparency. Areas covered by objects with transparency applied are
output as an RGB bitmap. This bitmap is then color corrected and separated to CMYK.
This process happens even to objects with 100% transparency.
This means that in objects under a transparent object:
 CMYK color values change. This is particularly noticeable with black and grays which
will then appear on all four separations rather than just the black separation.
 Spot colors (and PANTONE COLOR BRIDGE colors) are separated to CMYK (and
color corrected) (see PANTONE Colors (on page 206) for more on PANTONE COLOR
BRIDGE).
Watch out for:
Objects under totally transparent objects. Instead of using 100% transparency you can
use NO COLOR (see The color line (on page 189) for how to apply NO COLOR ).
 Text under a transparent object. Where possible, have text as the front object so these
problems don't occur.
Intermediate colors in blends and fills
This section applies to all blends and multicolor fills. That is, all fill types except flat.
Normally, a graduated color fill mixes colors using the RGB color model. The exception is
when both end colors are defined as CMYK. In this case, colors are mixed in CMYK. One
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advantage of this for grayscale blends. An RGB gray is printed as a mixture of the four
CMYK inks. Defining the gray as a tint of CMYK black gives better printed results.
Rainbow and Alt Rainbow mix colors using HSV.
Three-color, four-color, fractal and bitmap fills always output as RGB bitmaps and are
color-corrected. This means that any spot colors used in these fill types output to the
CMYK separations not to the spot separation.
Special rules apply for spot colors:
 In blends: If either end color is a spot color, you can do fade mixes but not rainbow
mixes (the reason is because you cannot alter the hue of a spot color).
 In fills: If either fill color is a spot color, you can do fade mixes but not rainbow mixes.
 In blends: If both end colors are the same spot color (or tints of the spot color), the
blend outputs only to the spot separation.
 In fills: If both fill colors are the same spot color (or tints of the spot color), the fill
outputs only to the spot separation. Note: this does not apply to three-color, four-color,
fractal and bitmap fills which output only to the CMYK separations.
If you blend or fill from a spot color to a non-spot color, Xara Designer Pro X creates the
requested blend. For example, if you blend from cyan (CMYK color) to gold (spot color)
the cyan separation shows a blend from 100% color to no color and the Gold separation
shows no color to 100% color. This is approximately what you see on screen (allowing
for differences between screen and printer colors).
If you convert the blend to editable shapes, the intermediate shapes lose all spot color
information. They separate only to CMYK. Only the final object prints as a spot color.

RGB and CMYK Blacks
Because shades of black and gray that are defined as RGB or HSV colors will separate
into a mix of all four CMYK process colors when printed, you can sometimes get less
than perfect gray shades. And any slight mis-registration of the CMYK color printing
process will sometimes be visible on the edges of black objects.
Although the theory is that an equal mix of CMY inks will give a perfect shade of gray, it
does not (and this is why the black "K" ink is added to the mix). So a gray that is defined
as an RGB or HSV gray will contain a mix of all four colors to improve the gray color. But
the best gray can be achieved by using only the K (black) ink plate. Thus if you require
perfect grays it’s better to use gray shades that are defined as a tint of a CMYK "pure"
black.
When creating documents based on the default templates designed to be printed, such
as US Letter or A4, then the shades of gray defined on the Color Line are defined to be
tints of pure "K" black. So if you use these gray colors from the Color Line, you will get
quality printed grays.
There is a corollary situation that a printed black that is based solely on the use of "K"
ink, is not that black. You can get far darker blacks by adding some of the other inks

Printing
printed on top of the black. So if you require really dark blacks for large objects or areas,
then you can define a CMYK color that has 100% K ink and a percentage of the other
colors (30% of each of the CMY colors is sometimes used).
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Importing and Exporting
General notes on exporting and importing
You may want to export Xara Designer Pro X documents to other applications, or export
them for use on a website. Or you may want to import designs from other sources. For
easy transfer, Designer Pro offers a wide range of import and export options.
Firstly, it is important to note the distinction between saving and exporting files:


deals with storing your work so that you can open it and work on it at a later
date. Xara Designer Pro X saves your work in the .xar file format. Think of this as the
"master document" format.
 EXPORTING deals with converting designs to other supported formats. Exporting allows
you to use and distribute your designs. For example, you may want to create a PNG
file for a website, or a TIFF or PDF file for a printing company. Exported files are no
substitute for saved .xar files because they are not a complete representation of your
Xara Designer Pro X design, so always save your design as a .xar file too.
SAVING

Recommended formats
The universal export formats, that can be read by the widest range of programs are the
bitmap formats, GIF, PNG and JPEG. These are also guaranteed to look exactly as you
see on screen in Xara Designer Pro X. PNG is the highest quality and can include
transparency support and is recommended for Microsoft Office applications.
PDF is the recommend export format for sharing files to be viewed or exported into
Adobe Illustrator. Xara Designer Pro X's PDF export is very high quality, is vector based,
and supports advanced features such as graduated transparency.
Export your document as HTML to export each page as a web page that can be
published and viewed using any popular web browser.

Other notes
With EPS and bitmap files you have a range of options on how to translate the data.
Some of these options can produce very large files (if, for example, your document has a
lot of graduated or radial fills or transparency).
File translation can take some time for a complex illustration.
Please note that other manufacturers can, and often do, change the specification of other
file formats. Information is given here in good faith but no guarantee is given that files
can be transferred between Designer Pro and any other package. Further, there are
often numerous different variations of a given file format, and Xara Designer Pro X
cannot support them all, especially if they are recent and non-documented formats.

Importing and Exporting
Because other programs do not support all of the features of Xara Designer Pro X, for
example, the advanced fill and transparency types, these have to be simulated, usually
by exporting these objects as bitmaps.

Import and Export Supported File Formats
You can change the order of supported import and export file formats in the FILE >
EXPORT and FILE > IMPORT dialogs by editing the FileFormats.xml file found in the
program folder where you installed Designer Pro.

Import formats
It is important that you use the three letter file extensions listed below when you
load files into Xara Designer Pro X.
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Bitmap Import Formats
.BMP Windows Bitmap
.CUT Halo CUT (256 color)
.DCM Digital Imaging and Communications in Medicine (DICOM) image format
.DCX DCX
.FAX Fax image from a fax received or created with fax software
.GIF Graphics Interchange Format
.ICO Microsoft Windows Icon (16 color)
.JPG JPEG
.JP2, .JPX, .J2C, .J2K, .JPF JPEG 2000 image format. An improvement to the standard
JPEG format that can compress image files using lossy or lossless compression.
HD Photo
.HPD, .WDP,.JXR Microsoft Photo HD / Windows Media Photo/ import (also known as
JPEG XR)
.MXB MAGIX Bitmap
.PAI MAGIX Photo Clinic Image
.PBM UNIX monochrome
.PCD PhotoCD
.PCT PICT
.PCX PCX Paintbrush
.PGM UNIX grayscale
.PNG PNG
.PPM UNIX color (up to 24 bit)
.PSD Photoshop (see importing (on page 567) and exporting PSD files (on page 572))
.RAS Sun Raster
.SGI Silicon Graphics Image
.TGA TrueVision TARGA
.TIF TIFF (RGB, RGBA with alpha-channel transparency & CMYK).
Xara Designer Pro X supports: fax TIFF files (black and white images. Multi-page faxes
will be imported as multiple pages); Mac or PC byte order TIFF files; TIFF with layers and
transparency (if saved from Photoshop the rules for blend mode compatibility are the
same as for PSD files); JPEG in TIFF (transparency is not possible in this case).
.XAR Designer Pro
.XBM X Windows (2 color)
.XPM X Windows (256 color)
.WBMP Wireless Bitmap Image. Black and white (1-bit) bitmap image format used by
mobile devices.
.RAW camera import formats (see RAW photo import (on page 569) for a list of
supported file types).
EPS Import Formats
.AI Illustrator EPS
.EPS ArtWorks EPS
.EPS Illustrator EPS
.EPS CorelDRAW 3 & 4 EPS
.EPS FreeHand 3.0 EPS
.EPS Photoshop EPS (For importing data from Photoshop into Xara Designer Pro X, use
PSD files instead of EPS files for best results).

Importing and Exporting
.EPS XaraX EPS
Other Import Formats
.ART Xara Studio
.WEB Xara Webster files
.AFF Acorn Draw
.CDR CorelDRAW (3,4 & 5)
.CDT CorelDRAW Template
.CMX Corel CMX 5 & 6
.DRW Acorn Draw
.HTM, .HTML Graphics on HTML pages, HTML files
.PDF (see importing a PDF file) (on page 472)
.WMF Windows Metafile (16bit)
.EMF/ .WMF Enhanced Windows Metafile
.ODP OpenDocument Presentation, Open Office Impress.
.PPTX Powerpoint (Microsoft Office 2007 Onwards)
.DOCX Microsoft Word Document
.RTF Rich Text Format
.SVG Scalable Vector Graphics
.XPS (beta level only)
.WIX For internal use by Xara
Palette Import Formats
.CPL CorelDRAW Palette
.PAL CorelDRAW Palette
.PAL Microsoft Palette
.PAL PaintShop Pro Palette
.ACT Adobe Color Table
.ACO Adobe Color Swatch
For information on how to import palettes, see Importing colors and palettes
Note: If you attempt to import the following file formats into Designer Pro, an error
message is displayed informing you that the movie format is not supported: AVI, DV-AVI,
MPEG-1, MPEG-2, MPEG-4, MXV, MJPEG, QuickTime™, WMV(HD). Click the More
Info button to go to a MAGIX web page displaying movie conversion options.
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Export formats
Bitmap Export Formats (see GIF, PNG, BMP and JPEG export dialog overview (on page
596))
.BMP Windows Bitmap
.DCX DCX
.PCX PCX
.GIF CompuServe GIF
.GIF Animated GIF files (see Creating animated GIF files (on page 525))
.JPG JPEG
.PSD Photoshop (see importing and exporting PSD files (on page 572))
.PCT PICT
.PNG PNG
.RAS Sun Raster
.TGA TrueVision TARGA
.JP2, .JPX, .J2C, .J2K, .JPF JPEG 2000 image format. An improvement on the standard
JPEG format that can compress image files using lossy or lossless compression.
.TIF TIFF (RGB and CMYK)
.WBMP Wireless Bitmap Image. Black and white (1-bit) bitmap image format used by
mobile devices.
EPS Export Formats
.AI Illustrator EPS
.EPS ArtWorks EPS
.EPS Illustrator EPS
.EPS Xara Xtreme EPS
Other Export Formats
.AVI AVI animation (animation documents)
.XAR CorelXARA
.XAR Designer Pro
.WEB Xara Webster files
.WMF Windows Metafile
.EMF Enhanced Windows Metafile
.CMX Corel CMX 5 & 6
.HTM Image map
.HTM, HTML Complete HTML websites and web pages
.PDF + PDF/X-4 Portable Document Format, High quality PDF files.
.SWF Flash (see Flash Animations (on page 519))
.DOCX Microsoft Word Document
.RTF Rich Text Format
.XPS Microsoft XML Paper Specification (on page 574)
.SVG Internet Scalable Vector Graphics
.WIX For internal use by Xara

Importing files

Importing and Exporting
To import a file:
 Select "FILE" > "IMPORT" - This normally merges the file's contents into the existing
document. With some formats you get the choice of importing the document into the
current page or adding it as a new page. With some other formats you are given the
option of either importing the file data conventionally, or adding a link to the file and
including it in your published website.
 Or select "FILE" > "OPEN" - This opens the file as a new document.
Xara Designer Pro X supports drag and drop import of files. If you drag a file from your
File Explorer onto an open Xara Designer Pro X document it will import the file and place
it on the current page, centered on the drop point. Or drag & drop a suitable file from
Windows Explorer onto any bar or the title bar of Designer Pro's window - it will open the
file as a new document.

Importing a Photoshop PSD file
To import a PSD file, import the file as normal with
drop the .psd file into Xara Designer Pro X.

"FILE"

> "IMPORT" , or just drag and

A dialog opens asking you if you want to import the Photoshop layers as objects - this is
the default, or if you want to import the layers as layers.
It’s recommended that you use the default option, where PSD layers become Xara
objects, because whereas in Photoshop effects like transparency are applied to layers, in
Xara layers are simply containers for objects and different objects on the same layer can
have different transparency and other settings.
The default DPI setting will be the one at which the PSD file was created.
The file will open on your workspace. View the file/object structure by opening the
LAYER GALLERY. (on page 177)

PAGE &

All the Xara transparency modes (apart from the Enhance mode) are compatible with the
equivalent Photoshop blends and will remain editable in in Xara Designer Pro X using the
TRANSPARENCY TOOL .
Photoshop calls it Opacity, but it’s the same thing as Transparency (just the other way
around), i.e. a 90% opacity value in Photoshop becomes a 10% transparency setting in
Xara Designer Pro X.
Tip: if you have separate objects in Photoshop that you wish to be able to move and
change independently of one another in Xara Designer Pro X, place them on separate
layers in Photoshop before exporting.
Attention: Only Xara Designer Pro & Photo & Graphic Designer can import PSD files
with 16bit colors or CMYK color model
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TIFF Import
Xara Designer Pro X TIFF import supports a much wider range of TIFF file types,
including:
 CMYK TIFF files.
 Fax TIFF files (black and white images. Multi-page faxes will be imported as multiple
pages into Xara Designer Pro X).
 TIFF with transparency (if exporting a TIFF from Photoshop (Save As) you can select
the SAVE TRANSPARENCY checkbox).
 Mac or PC byte order TIFF files.
 TIFF with layers and transparency (if saved from Photoshop the rules for blend mode
compatibility are the same as for PSD files).
 JPEG in TIFF (transparency is not possible in this case).
Usually TIFF files have a file extension of .tif.

PDF Import
PDF is a complex vector graphics format that has evolved over 10 years or more and
contains numerous sub-formats and options. PDF was designed as a portable document
format for viewing and printing only, and was not intended as a file format for transferring
data between applications. However Xara Designer Pro X should load the vast majority
of PDF files.
PDF is now the recommended way of transferring vector files from Adobe Illustrator to
Xara Designer Pro X. Save as PDF and then import the resulting file into Xara Designer
Pro X.
The following points are worth noting:
 Multi-page PDF files are imported as multi-page documents in Xara Designer Pro X.
 Text in PDF files is typically broken into many separate small text objects in the PDF
file. This doesn’t stop it viewing and printing, but means when imported what might
appear as one or more continuous paragraphs of text is not. Xara Designer Pro X tries
to re-assemble the lines of text into lines and paragraphs of editable text, but often you
will find the text broken into separate text objects.
 In order to make it easier to extract just the text of a PDF file, a new layer is created
containing just the text on that PDF page. Use the PAGE & LAYER GALLERY (on page
177) to view this layer.
 PDF files make liberal use of clipping. This appears in Xara Designer Pro X as
ClipView objects, and so it’s often necessary to use "Arrange -> Remove ClipView" in
order to edit the objects on the page.
 Any annotations in the PDF file are imported onto a separate layer called “PDF
annotations” in your Xara Designer Pro X document.
What might not work:

Importing and Exporting
 Many PDF files include embedded fonts. It’s not possible to legally extract and install
these fonts onto your system. So if you do not already have the fonts used in the PDF
file you will find alternative fonts have been substituted.
 Files that are encrypted or password protected cannot be imported.
 Any text in PDF files that use embedded subset fonts will not be readable or editable.
PDF is a highly complex format, and often can't be imported perfectly. The best way to
import it may depend on how you intend to use it. The "OPTIMIZE FOR VIEWING " option
attempts to make the imported result look as similar to Acrobat as possible, but it may be
more difficult to edit (it could have many nested clipviews for example). The alternative
“OPTIMIZE FOR EDITING " option strips out some constructs which are difficult to manually
edit (for example, nested clipviews).

Importing a Word document
You can easily import a Microsoft Word document (.docx). Simply drag and drop the file
from Windows Explorer, or else select "FILE" > "IMPORT" .

RAW photo import
You can import RAW digital camera files, either by using the Import menu option or just
drag & drop the file onto the Designer Pro window.
Supported file extensions include: *.crw, *.cr2, *.rw2, *.nef,*.mrw,*raf,*.kdc,*.orf, *.dng,
*.ptx, *.pef, *.anw, *.x3f
However there are many different extensions used for RAW files by different camera
manufacturers, so if you have a RAW file with a file extension not listed above it’s worth
trying to import it anyway.

Importing from a website
You can import text and graphics directly from web pages on the Internet into your
document, or copy and paste text and graphics directly from a web browser onto your
page.
To import from an online web page:

1.
2.
3.

Choose "FILE " > "IMPORT FROM WEB ADDRESS" (or "Ctrl + Alt + W").
Type in the web address (URL) of the page or graphic you want to import.

If the URL entered is that of a web page, all the text and images on that page will be
imported and positioned on your page in approximately the same positions as they are
on the web page. In other words, this function gives you a way to roughly import an entire
web page in terms of its text and graphics. However note that most modern web pages
are made up of a complex combination of text, graphics, JavaScript and other features,
so such imports are unlikely to give you a complete and accurate representation of the
page in Xara Designer Pro X.
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When importing from web pages, the length of your page in Xara Designer Pro X will be
automatically extended to accommodate the incoming text and graphics, if it is not
already long enough.

Exporting files
To export a file:
 Right click and choose EXPORT
 Or select "FILE" > "EXPORT" .
 Or press "Ctrl + Shift + E".
An EXPORT dialog box will appear. Choose a name for your file, and select the required
format from the SAVE AS TYPE dropdown list. Some of the supported formats are detailed
below.

Exporting as PDF
The PDF format is an ideal way to distribute your document for a variety of uses. It can
be used to supply artwork to a printing company, or it can be used to import in to other
programs such as Adobe Illustrator 9 and later. This is described in detail in the next
section.

Exporting to a Word document
Select "FILE" > "EXPORT" and then choose the MICROSOFT WORD (.DOCX) option from the
drop-down menu.

Exporting a Web document
Sometimes you will want to export a print document as a web viewable HTML page
rather than a PDF. This has the advantage of being lighter or smaller in size than a PDF.
and can make for a smoother viewing experience especially when viewed on a tablet or
iOS devices.
For more details see Web Document Publishing.

Exporting as Flash
You can export a drawing to Adobe's SWF Flash format (static). This is best suited to
vector designs, and can provide very small file sizes. You can then use the SWF in a
website, or import it into Flash for use in Flash animations.
You can also create animated Flash. See Flash Animations (on page 519) for more
details on Flash export.

Importing and Exporting
Exporting as AVI
Select FILE > EXPORT ANIMATION and choose the AVI type from the type list. Click the
OPTIONS button on the file dialog to change the codec and other settings used for the
export.

Exporting HTML
You can easily create multi-page websites with full WYSIWYG (what you see is what you
get) using the HTML export option. See the separate chapter Web Graphics & Websites
for a detailed description!
You can use "FILE" > "EXPORT WEBSITE" or press the ‘Export website’ button on
the Website toolbar to export HTML quickly, to save choosing HTML from the
long list of export formats shown in the File->Export dialog.

Exporting as Designer Pro EPS
This saves the document as an EPS file. It is the recommended EPS format for exporting
to (for example) DTP programs, as all information is retained.

Exporting as ArtWorks EPS
This saves the document so that you can load it into ArtWorks, Computer Concepts'
illustration program for Acorn RISC computers. Files in this format cannot be loaded into
other programs on the PC. Some features, such as transparency, do not exist on
ArtWorks.

Exporting as Illustrator EPS
This is recommended for older versions of Adobe Illustrator (for version 9 onwards we
recommend using PDF export, see above).

Exporting as Windows metafiles (.wmf)
Files in this format can be read by Word and several other programs.

Exporting as Extended Metafile Format (EMF)
Modern Windows applications support this enhanced type of vector graphic format. This
format is also available to applications that provide a Paste Special menu option.
Note that Xara Designer Pro X can contain features, such as advanced fill styles, that
cannot be represented in vector formats such as EMF. In this case parts of the image will
be exported as bitmaps. Those vector parts that can be exported as vectors are exported
as vectors.

Exporting as a bitmap
JPEG, GIF and PNG are universal formats supported by most modern computer
applications. PNG is the highest quality. JPEG is better suited to photographic work, but
can produce acceptable, compact files (you can control the quality and file size).
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GIF format only supports 256 colors, and although common on many websites, PNG is a
better format. PNG also supports semi-transparent graphics (use the True Color + Alpha
option), but this is not correctly supported by older Microsoft Internet Explorer versions (it
is by all other web browsers).
The fewer colors you have in a file, the smaller the file and the lower the quality.
However, when using 256 colors or less Xara Designer Pro X provides very advanced
techniques to simulate a much wider range of colors, and so you can get very high, near
photographic quality results using only 256 colors or less.
See also GIF, PNG, BMP and JPEG export dialog overview (on page 596).

Important
Bitmaps are output at the current view quality so for best results
make sure that "WINDOW" > "QUALITY " or the slider on the Standard
control bar is set to anti-aliased.

Exporting a Photoshop PSD file
Photoshop is a bitmap editor, so when exporting to PSD format all the vector objects in
Xara Designer Pro X are rasterized. You can select the resolution (dpi) when exporting.
Always save your work in Xara Designer Pro X prior to exporting. Then, if you wish to
alter your original objects in the future, just load Xara Designer Pro X, make any changes
and then export the required objects again.
To export as a PSD file choose "FILE " > "EXPORT " then select ADOBE PHOTOSHOP in the
SAVE AS TYPE list.

PSD Export settings
The PSD export dialog gives you several options.

Importing and Exporting
Resolution in DPI
A DPI of 96 is the normal Windows screen resolution, and so exporting at 96dpi will
appear in Photoshop at the same size at 100% as it does at 100% in Xara Designer Pro
X. For print work you should choose a higher DPI.
Export each object as a PS Layer
Xara objects are mapped to PS layers so each object becomes a separate layer in
Photoshop. This is a good fit between the two applications, because whereas in
Photoshop effects and blend modes are applied to whole layers, in Xara the same tools
are applied to objects, not layers. So it’s more useful to map Xara objects to and from
PSD layers where they will remain editable. This is the default option.
Export each layer as a PS Layer
Each Xara layer is exported as a separate layer in Photoshop. All objects on the same
layer (including the layer names) are exported as one bitmap. If you choose this method
and want to have objects like text and transparency (blends in Photoshop) remain
editable then they have to be placed on their own separate layers before export. If
objects using different types of transparency are combined on the same layer in Xara
Designer Pro X, an alert - warning you of this will pop up when you export.
Export just visible objects
Exports all visible objects on the page and pasteboard areas.
Export whole page area
Exports the whole page area together with visible objects on the page area only.

Transparency and layers
Xara Designer Pro X's transparency types are all compatible with Photoshop
transparency (blending mode) types (apart from Enhance mode). But because Xara
Designer Pro X is vector object-based, it’s possible for each individual object to have its
own transparency type and value. In Photoshop this is not possible, and you can only set
the opacity or blending mode for a whole layer.
If you are exporting using the legacy method of mapping Designer Pro layers to
Photoshop layers rather than the default option of exporting Designer Pro objects to
Photoshop layers - then combining objects that use different types of transparency on the
same layer in Xara Designer Pro X, will prompt an alert - warning you of this when you
export. This may look OK when you export.

Text
You can export text from Xara Designer Pro X to be editable text in Photoshop, but the
text must be on a layer on its own (on import you may be asked to update the text
objects for them to be editable in Photoshop.)
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Text that is on a layer with any other graphic objects will be rasterized into that layer, and
thus not be editable. So for this reason it is recommended that you choose the default
export option - EXPORT EACH OBJECT AS A PS LAYER .

Export DPI
You will be able to set the DPI of the bitmaps in the exported PSD file.
A DPI of 96 is the normal
Windows screen resolution,
and so exporting at 96dpi will
appear in Photoshop at the
same size at 100% as it does
at 100% in Xara Designer Pro
X.

For print work you should choose a higher DPI.
You can select to export the whole Xara Designer Pro X page area or just the areas of
the visible objects only.

Exporting as Microsoft XPS (XML Paper Specification)
This is an entirely new "page description" file format invented by Microsoft. Designed for
Vista, this is also supported on older versions of Windows by getting a free download.
The benefit of XPS format is that it is vector based, and so is ideal as a resolutionindependent portable document format. Fonts are embedded into the document and so
you are ensured very high quality WYSIWYG documents. If you’re using Windows Vista,
you can view and print these documents directly. If you’re using older versions of
Windows, you can obtain a free XPS Viewer download from the Microsoft website,
enabling the viewing and printing of these files.
It should be noted that the Xara XPS export does not use the Microsoft standard XPS
print system, but writes XPS files directly, which ensures far higher fidelity and far smaller
XPS files.

Importing and Exporting
XPS supports advanced vector features such as transparency, CMYK colors and
embedded fonts.

XPS export dialog

Font Subset: Any fonts used in your document are automatically embedded into the
XPS document to enable the viewer to correctly display all text. Selecting this option
embeds fonts containing only those characters used in the document. This can
significantly reduce the XPS file size.
View XPS when finished: This will automatically open the XPS viewer and display the
saved file.

Rasterization
XPS is a vector format, but it doesn’t support some of the advanced effects, fill and
transparency types supported by Xara. Files containing, for example, objects with
feathered edges will result in that object being rasterized, that is converted into an alphachannel bitmap. The resolution of this rasterization process is controlled by these fields.
Resample JPEG images
JPEG photo images contained in a Xara file are usually embedded as the full resolution
original JPEG file (and is thus a lossless process). However, for many applications this
might be overkill. E.g. a typical modern digital camera can easily create a 4Mbyte JPEG
file, 3000 pixel across or more. If this is placed on the page in Xara and scaled to be say
2 inches across, that photo would be at a resolution of more than 1500dpi – way more
than is required for any printing application. (The resolution of bitmap object is shown on
the Status line in Xara).
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You can therefore choose to resample JPEG photos to a lower resolution more suited for
viewing on screen (e.g. 96dpi) or printing (typically not more than 300 dpi)., and thus
reduce the size of the XPS file. The JPEG quality slider controls the quality of the
resampled JPG. The lower the quality, the smaller the resultant XPS file. A quality of 85
is the recommended setting which is actually a very high quality image.

Color Mode
XPS files, like Xara documents can contain a mix of both RGB and CMYK colors.
However, the XPS viewer shows CMYK colors as color corrected for the printer. Xara on
the other hand shows all colors (CMYK and RGB) as screen colors or printer colors
(depending on the Show Printer Color menu option). This slightly different approach to
displaying colors can result in significant differences between RGB and CMYK version of
the same color. In Xara, for example, cyan is shown as the same color on screen
whether it’s been defined as CMYK or RGB. XPS displays the same color completely
differently.
Selecting the RGB colors option will force all colors to be converted to RGB to provide
consistency with the way Xara displays colors. Selecting Native colors will export objects
using whichever color model you’ve used in Designer Pro, but this will likely result in
color changes where you’ve mixed RGB and CMYK colors in the same document.

Image slicing
Large, complex graphics for web pages can produce large files which take a long time to
download over the Internet. You can reduce this problem by "slicing" the image into
sections which can be downloaded separately.
Another use of slicing is optimization. For example, if you have a photo on a plain flat
color background, then you can optimize the graphic by exporting just the high detail
area (photo) as a JPEG or 256-color GIF, and the other areas as, say, a 2-color GIF.
This minimizes the amount of data to download.
To slice an image:

1.

Named objects control slicing, so give the part of the image to go on its separate
slice (for example, the photo) a name. Use the NAME GALLERY OR THE NAMES ICON
ON THE SELECTOR TOOL INFOBAR. (FOR MORE COMPLICATED IMAGES YOU MIGHT
WANT TO NAME MORE OBJECTS.)

2.

NAME GALLERY

EXPORTS
APPLY

For more on the Name Gallery refer to Document Handling (on page 68).

Export the graphic in slices
You do not need to specify how to slice the image as Xara Designer Pro X does this
automatically from the information in the NAME GALLERY .
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1.
2.
3.
4.
5.
6.
7.

Select the complete image including any slices
Select "File -> Export image in slices".
Select the file format (this will apply to all areas of the image other than your slice).
The file name is the HTML file that contains the HTML code for the sliced image.
You can change the file name if required.
Click SAVE .
Select the required save options (these will apply to all areas of the image other
than your slice).
EXPORT

To prevent specific named objects from slicing:

1.
2.

In the dropdown list in the NAME GALLERY , select SLICES .

PDF Export
The Portable Document Format (PDF) provides the best way to transfer drawings and
document to others. The free Adobe PDF Reader is very popular and enables anyone to
view and print your PDF document.
For very complex vector graphics, PDF can be very slow (sometimes 20 times or more
than Xara Designer Pro X), so drawings that take a few seconds to draw in Xara
Designer Pro X can take minutes, especially when printing. So sometimes it’s quicker to
convert complex vector graphics into a bitmap before exporting your PDF.
PDF files are vector graphics files-which means they are resolution independent, and are
great for printing on high resolution devices, and you can zoom in to view detail with no
loss of quality. Your graphics or document exported as a PDF should look exactly like it
does in Xara Designer Pro X.
There are different versions of PDF, including a specialized version, known as PDF/X
which was developed by the printing industry and has become a very popular way of
transferring files for commercial printing.
Xara Designer Pro X provides very comprehensive controls over many aspects of your
PDF output. These are just some of the options and features you can control in Xara
Designer Pro X PDF output. You can:
 embed fonts in the file which means all readers can be sure of seeing the file exactly
as you intend, but this makes the files larger. You can also select to embed only a
subset of the fonts (only the used characters) to reduce the PDF file size;
 set it to re-sample all images or photos to be any required resolution so they are not
unnecessarily high resolution;
 set it to convert bitmaps to JPEG or remain in their raw state;
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 make it so that layers in your Xara Designer Pro X drawing are visible and can be
switched on and off in Adobe Reader;
 select which version of PDF or PDF/X file you want to create;
 select which pages of a multi-page document are exported;
 make your PDF file password protected;
 even embed the original .xar file (or other files) into the PDF for the ultimate in
document portability.
To make life easier all the options have been distilled down to four easy choices. When
you export as a PDF you are presented with a choice of the following presets:





Draft quality.
Email distribution or Web download.
High quality.
Commercial printing (PDF/X). (Xara Designer Pro, Photo & Graphic Designer only)

You can customize the settings of any of these presets by clicking the
OPTIONS button.

ADVANCED

Exporting PDF files
PDF versions
PDF has evolved over the years as more features have been added. Typically, along
with each new version of PDF, a new version of Adobe Reader is released to support the
new PDF features. Unfortunately, the version number of PDF Reader and the PDF file do
not match. So, for example, Adobe Reader version 5 is required to read PDF versions
1.4.
PDF version 1.4 was the first version to support transparency and so is the minimum
generally recommended version to use. Later versions support some of the extra
features. For example, if you want to use the Layer feature (so you can switch Xara
Designer Pro X layers on and off in Adobe Reader), you need to export as a PDF version
1.5, or higher, and this requires Adobe Reader version 6, or higher.
You can export files in PDF version 1.3, 1.4, 1.5, 1.6 and 1.7 formats as well as the
following PDF/X standards:






PDF/X-1a:2001 (ISO 15930-1).
PDF/X-1a:2003 (ISO 15930-4).
PDF/X-3:2002 (ISO 15930-3).
PDF/X-3:2003 (ISO 15930-6).
PDF/X-4:2008 (ISO 15930-7).

Objects not supported by PDF
Some Xara Designer Pro X features do not exist in PDF, so the conversion to PDF has to
simulate these features, usually by converting to a bitmap or bitmap fill.
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Transparency
PDF version 1.3 does not support transparency. Any objects containing transparency will
be exported as bitmaps, a process sometimes called "flattening". Xara Designer Pro X
does this automatically. The resulting PDF file should still look correct however.

Transparency Types
Xara Designer Pro X supports a number of different transparency types and ten of these
have direct equivalents in PDF/X-4.











Normal (Mix)
Screen (Bleach) .
Multiply (Stained Glass).
Color Dodge
Color Burn
Hardlight
Overlay
Softlight
Luminosity
Color

Other transparency types in Xara Designer Pro X have no direct PDF equivalents, so
they are converted to bitmap in the PDF file.

Fill types
Fill types flat, linear, circular and elliptical are all mapped directly to equivalent PDF
types, but the other more complex fill types (Conical, Diamond, Three Color, Four Color,
Fractal Cloud fills and Fractal Plasma fills) supported by Xara Designer Pro X have to be
represented using bitmap fills in the PDF.

ClipViews
The PDF export filter does not directly support ClipViews comprised of lines or text.
Convert all lines and text to shapes to ensure that a ClipView that contains these objects
is properly converted.

Blends, Molds and QuickShapes.
Blends and Molds are not part of the PDF format. They are exported as individual
objects. All QuickShapes are converted to simple shapes.

Font embedding
The PDF filter includes support for embedding fonts within a PDF document where
permission has been granted by the font vendor for this purpose. Where fonts are not
embedded, if readers do not have the correct font on their system, then usually a "best
guess" font is substituted by the reading application, resulting in loss of fidelity.
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During the export of a PDF file, you are warned about missing fonts or where required
fonts could not be embedded. If you intend to distribute your PDF file or submit it to a
service bureau for printing it is recommended that you:
Ensure that the target platform has legal copies of any required fonts.

Flash Embedding
If you export to PDF version 1.5 or higher, you can include embedded Flash objects in
your document. Recent versions of Adobe Reader will play the Flash animation while
viewing the PDF. This feature is not supported by all PDF viewers however.

To export a PDF file
1.
2.
3.

Choose "FILE" > "EXPORT PDF"
The PDF OR PDF/X (*.PDF) option will appear as selected in the
EXPORT

SETTINGS

The four preset options will be suitable for most PDFs. They are:

SAVE AS TYPE

list.
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Draft quality (96 DPI, no font embedding)
The draft setting is typically used when proofing a design and offers the fastest mode of
PDF generation. The following settings are used:
 PDF version 1.4.
 No fonts are embedded.
 All bitmaps and photos are embedded as JPEG images at 96dpi.
This option will produce the smallest file, but note that because no fonts are embedded, if
you give the file to anyone they must have the fonts used installed on their system in
order to be able to see the document exactly as you intended.
E-mail distribution or web download (Adobe Reader version 5 and above)
This setting specifies filter options that are optimal for distributing PDF documents
through e-mail and the web. Fonts are included, so you can be sure your document will
be viewed exactly as you intended and all images are medium resolution suitable for
inkjet printing and viewing on screen
 PDF version 1.4.
 Fonts are embedded, and subsetted (meaning only characters used are embedded as
fonts).
 All bitmaps and photos are converted to JPG at 150 dpi.
High quality (300 DPI, larger PDF files)
The high quality setting includes options for rendering designs as PDF documents where
full fidelity is required at high resolution. This if most suitable for printing on inkjet printers
or viewing at high zoom. The following are the key settings:
 PDF 1.4.
 Fonts are embedded, and subsetted (meaning only those characters used are
embedded as fonts).
 All bitmaps and photos are passed through untouched, unless they are more than 300
dpi in which case they are sampled down to be 300 dpi but retain their existing type
(they are not all converted to JPG).
Commercial printing (PDF/X, 300 DPI images)
This setting specifies the options required for generating PDF/X documents that will be
submitted to a print company. The following are the key settings used:
 PDF version 1.3 (as required by PDF/X).
 Files are conformant to PDF/X-1a: 2001 (ISO standard 15930-1).
 Fonts are embedded and subsetted.
 Bitmaps are converted to CMYK in native (uncompressed) format according the ICC
Color Profile "US Web Coated SWOP".
 Bitmaps are limited to 300 dpi (high res bitmaps are sampled down).
 Crop and printer’s marks are included if these are switched on in the PRINT OPTIONS
dialog in Xara Designer Pro X.

Customizing PDF export using advanced options
If you select the ADVANCED OPTIONS button you can customize any of the above presets.
Once you have altered any of the preset values, the next time you export a PDF it
remembers the last settings, and the CUSTOM option will be shown. The following section
provides an overview of this feature.
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While the four presets included in the PDF Export Filter will cover most typical scenarios
for generating PDF output, situations may arise when greater control is required in order
to specify the properties of the resulting document.
To customize the output filter settings:

1.
2.
3.
4.

Select the preset that is closest to the desired type of PDF.
Click ADVANCED OPTIONS....
Modify the desired filter settings.
EXPORT

The modified settings will automatically be stored under the
that point on.

CUSTOM

option for use from

When the ADVANCED OPTIONS button is clicked, the PDF Export Filter options appear in a
separate dialog box grouped within the following categories: General, Objects,
Document, Layers, Pre-Press (only Xara Designer Pro) and Security.

PDFs for import into Adobe Illustrator (V9 onwards)
PDF is the best format to use if you need to transfer designs from Xara Designer Pro X to
recent versions of Adobe Illustrator. Vector shapes, bitmaps, text and the simple fill and
transparency types will all transfer with no loss of fidelity.

Layers
Adobe Illustrator 9 & 10 fully support editing of layers exported in PDF files. Unselect the
EXCLUDE INVISIBLE LAYERS option to make sure all layers in your design are included.
Illustrator CS & CS2 will not preserve design layering.

Text
In order to edit text in PDF documents in Adobe Illustrator 9 and 10, embedded fonts
must be installed on the host system. Also, you must unselect the USE UNICODE FOR TEXT
ENCODING option in the SETTINGS dialog.

Bitmap tiling
Adobe Illustrator 9 and 10 will not read the PDF if tiling is used, so unselect the
PRESERVE BITMAP TILING option. This is not necessary for CS or CS2 versions.

Groups
Select the PRESERVE GROUPS option in the export settings if your document contains
groups so that they are maintained in Adobe Illustrator.
Note however that because PDF does not natively support groups, clipping masks will
appear as part of imported groups in Illustrator CS & CS2. Therefore, when ungrouping
you also need to remove the clipping mask.
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PDF Export Filter Settings: General Options

The GENERAL OPTIONS tab in the PDF Export Filter provides a range of settings that can
be configured to specify PDF document attributes including version compatibility, how
content is encoded, and which pages are to be rendered.

PDF Version compatibility
.

Color Model
The color encoding standard for the PDF document can be selected from CMYK , RGB,
and NATIVE . The NATIVE option represents colors in the PDF file as they are specified in
the drawing using RGB and/or CMYK.
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When CMYK is selected as the color model for a PDF document, an ICC (International
Color Consortium) profile can be specified. Please refer to the section on Pre-Press
options later in the chapter for additional information.
Note: PDF/X documents are limited to CMYK color encoding.Our implementation allows
you to export a PDF/X-4 as CMYK color model or RGB Color model. CMYK is the default
option and allows you to select an output from the Pre-Press tab. If RGB is selected, the
options from the Pre-press are greyed out and a sRGB profile is automatically applied.
Note that Adobe Reader (and Adobe applications generally) display CMYK colors very
differently from their RGB or HSV equivalents. To preview what your colors will look like
when exported to PDF/X select the option "WINDOW" > "SHOW PRINTER COLOR" >
"SIMULATE PRINT COLORS" .

Options


Linearization of PDF files generated
by the export filter encodes the PDF for optimal transfer and viewing over the Internet.
Be default this option is enabled.
 EMBED FONTS WHEN PERMITTED. Select this option to include copies of fonts in the PDF
file that are not included in the PDF base 14 fonts supported by Adobe Reader. Note
that only those fonts that are not restricted by copyrighting restrictions will be
embedded in the PDF file. By default this option is enabled.
OPTIMIZE FOR FAST WEB VIEWING (LINEARIZATION).

Note: PDF/X documents require that all fonts are embedded in the resulting document.
When exporting PDF/X with font embedding turned on, all fonts are embedded. However
when exporting PDF the 14 base fonts are not embedded as these fonts are generally
available to all PDF readers.


This option can be used in conjunction with the EMBED FONTS
option to indicate that only those characters that are used within a
typeface will be embedded in the resulting PDF file. Selecting this option can reduce
the size of the PDF file that is generated however it will also limit the level of editability.
By default this option is unselected.
 VIEW PDF WHEN FINISHED. This option can be selected to automatically launch and view
the resulting PDF using the default application that is associated with the format under
Windows. This option is enabled by default.
 ENABLE CONTINUOUS SCROLLING IN ADOBE READER. Choose this option to have Adobe
Reader synchronize the scrolling of the PDF document with the movement of the scroll
bars in the viewing application. By default this option is selected. Note: this option only
applies to PDF documents that contain more than one page.
FONT SUBSET ONLY.
WHEN PERMITTED

Page Generation
When generating a PDF document from a multi-page design, Xara Designer Pro X
optionally allows a range of pages to be specified.
To specify which pages are to be rendered to the resulting PDF document:
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Select ALL to export all pages contained within the design
Select CURRENT PAGE to export the currently selected page or
Select SELECTED OBJECTS to print only those objects that are selected.
To export a range of pages within the design, select PAGES and enter the desired
range in the edit box. Specify individual pages by their number, separated by commas.
To specify a range, enter a starting and ending page. For example, to specify that the
first, third page and pages 5 through 12 of a design should be exported to the resulting
PDF document enter the following: 1, 3, 5-12. Note: pages will be exported to the PDF
document in the order in which they appear in the original design.

PDF Export Filter Settings: Objects Options

The OBJECTS tab in the PDF Export Filter provides a series of settings that can be used
to specify how design elements are rendered in a PDF document.
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Bitmap Compression
Choose the compression scheme for bitmapped images that appear in the document by
selecting from the options in the dropdown list. Supported compression schemes include:
NATIVE (use the bitmap compression in the document), NONE (do not apply compression),
JPEG and FLATE .
Flate is lossless compression, the same compression used in PNG graphic files or zip
archives. FLATE can give better results if the PDF contains lot of schematic drawings with
less colors, but not recommended for PDFs with many photos.

JPEG Quality
Use the slider control to set the JPEG quality index when using JPEG compression for
bitmapped images. Values range from 0 to 100, with higher values specifying increased
quality and lower values specifying increased compression and the loss of some image
fidelity. The default JPEG quality is 85.

Rasterization Resolution (DPI)
For Xara Designer Pro X graphic objects that cannot be exported as native vector PDF
objects (things like soft shadows, feathered objects, bevels), Xara Designer Pro X will
automatically rasterize, that is convert to a bitmap. This option allows you to choose the
DPI (dots per inch) for the rasterization resolution using the dropdown list, or click USE
CUSTOM DPI and enter a custom value by checking the USE CUSTOM DPI option and
specifying an integer value between 20 and 600. The default preset value for
rasterization is 150. The higher the resolution, the larger the PDF file. It is not usually
necessary, even for the highest quality printing to use a value above 300dpi.

Options
Select this option to preserve any objects containing hyperlinks in
the outgoing PDF file. By default, this option is selected for standard PDF documents.
This option is not selected and disabled for PDF/X documents, since hyperlinks are not
allowed.
INCLUDE HYPERLINKS:

Xara Designer Pro X supports a number of different link types and mouse-over actions,
which are used mainly when creating websites. Some of these features are also
supported in exported PDFs, but others are incompatible with PDF and/or not useful. Of
the many features available in the Utilities->Web Properties dialog, only the following are
supported with PDF: Ordinary links to URLs (the ‘open link in’ options do not apply)
 Page links. When viewing the PDF you can click these links to navigate to the different
pages of the document, if the PDF viewer supports this.
 Links to anchors
 Popup title text (See the Mouse-over tab of the Web Properties dialog).
The link color, as set on the Website tab of Utilities->Web Properties, is also used to
color links in the PDF. And you can override the link color for any specific link, by
unchecking the ‘Use common colors’ option on the Link tab and giving the link its own
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color. However the mouse-over and visited link colors on the Website tab are not
supported for PDF.
This option can be selected to convert all text content into
vector shapes. This option can be specified to preserve the appearance of text when
equivalent fonts may not be available on the target system or when font embedding is not
permitted. Note that the text in the resulting PDF file is translated into shapes and is no
longer editable as text. By default this option is not selected.
CONVERT TEXT INTO SHAPES:

This option can be used to select the method to be
used for encoding text in the resulting PDF document. By default, this option is not
selected and text is encoded using the ANSI encoding scheme. Selecting this option
specifies that text should be encoded using Unicode.
USE UNICODE FOR TEXT ENCODING:

This option determines the method that the export filter uses to
generate tiles in the PDF file. By default, the preserve bitmap tiling option is selected and
a series of individual bitmaps are used to fill the corresponding object. This option should
be unchecked when the resulting PDF files are to be used in Adobe Illustrator 9 and 10
or in any other application that does not directly support bitmap tiles as fills.
PRESERVE BITMAP TILING:

Use this option to maintain groups in the resulting PDF document.
Note that because the PDF format does not natively support groups, grouping is
emulated using clipping masks.
PRESERVE GROUPS:
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PDF Export Filter Settings: Document Options

The DOCUMENT tab contains items that can be used to specify authoring information and
how a PDF document will be opened within Adobe Reader.

Description
Within this section, the title, author, subject and keywords for the outgoing PDF
document can be optionally added. Select INCLUDE DOCUMENT INFORMATION to embed
these details in the resulting PDF file. By default this feature is not selected.

Initial View
Select from among the document viewing options in the dropdown list to specify the
magnification level of the resulting PDF file when it is viewed in applications that support
this feature. The default magnification level is 100%.
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Note: This feature is not available for PDF/X documents.

Reader Display Setup
When generating a PDF file that is intended for display in Adobe Reader, you can select
from among the display setup options in the dropdown list to specify how the viewer is
configured when the file is opened.
Options are included for displaying only the page, the bookmarks panel and page, the
pages panel and page, a full screen version of the document, the layers panel and page
(PDF 1.5) and the attachments panel (PDF 1.6). The display setup options for showing
the bookmarks, pages and the layers panel are particularly useful when generating PDF
documents in which layers are used.
The default Reader display setup option is PAGE ONLY .
Note: This feature is not available for PDF/X documents.

File Embedding
A unique feature supported by the PDF document format is its ability to embed files at
the document level. The Xara Designer Pro X PDF Export Filter allows one file of any
size and type to be added to the exported PDF. When the PDF document is opened by
applications that support file embedding (such as Adobe Reader or Acrobat), the
embedded file appears in the attachments list panel.
Embedding a file within the PDF document is particularly useful when distributing an
illustration or submitting it to a service bureau. Examples for the use of this feature
include attaching the original Xara Designer Pro X .xar file, a readme file outlining author
and copyright information or a high resolution rasterized version of the illustration to the
resulting PDF.
To embed a file within an outgoing PDF document, simply click the ellipses button [...] to
select a file from within a file open dialog or type in the path of the file manually.
Enable EMBED SELECTED FILE to add the file to the PDF document. By default this option
is not selected.
An optional description may also be provided for the embedded file. This description will
appear as a comment when the attachments panel is viewed in Adobe Reader and
Acrobat.
Note: File Embedding requires that the PDF Version compatibility be selected as 1.4 or
greater.
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PDF Export Filter Settings: Layer Options

The LAYERS tab within the PDF Export Filter provides a means to specify how layers
within a drawing are rendered for in the PDF document.

General Options
Exclude invisible layers. This option can be checked to exclude all invisible layers in
the outgoing PDF file. To eliminate guide layers from a PDF document, set the layer to
invisible in the Xara Designer Pro X Page & Layer Gallery and export the drawing with
this option checked.
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Layering Methods (standard PDF only)
Separate layers do not appear in the resulting PDF
document. This option is enabled by default.
DO NOT GENERATE READER LAYERS:

Layers are
rendered within the document on a single page, with layering labels included for display
within Adobe Reader's Layer Gallery.
ENABLE READER LAYERS IN A SINGLE PAGE (PDF 1.5 AND ABOVE ONLY):

Select this option to include bookmarks in the
resulting PDF document for each page of your document. A bookmark is generated for
each page, using the ‘Page title’ value as defined on the ‘Page’ tab of the Utilities->Web
Properties dialog. If no page title is defined, the ‘Page filename’ (as defined in the same
dialog) is used instead. If there is no page filename set either, then pages are named
simply “Page 1”, “Page 2”, etc. In Adobe Reader you can display the list of bookmarks in
the document and then just click on them to jump to each page.
GENERATE BOOKMARKS FOR EACH PAGE:

Crop and Printer’s Marks
Include crop and printer’s marks in the PDF document. Select this option to include crop
and printer’s marks in the outgoing PDF document. This feature is particularly useful
when submitting PDF files to be printed through a service bureau. By default this feature
is unselected. Note: to use this feature you must check the OUTPUT PRINTER'S MARKS
option and select the desired types of marks to be included within the Imagesetting tab of
the PRINT OPTIONS dialog.
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PDF Export Filter Settings: Pre-Press Options

The PRE-PRESS tab includes items for specifying characterization settings and the
embedding of ICC (International Color Consortium) color profiles for print production.
ICC profiles are files containing data that specifies how colors are to be rendered on a
particular output device. The use of an ICC profile is mandatory for PDF/X documents,
optional for CMYK-based PDF documents and not applicable for all other types of PDF
documents.
Specifying an ICC profile of use in PDF/X documents:

Output Intent Profiles
When generating a PDF/X document for print production, output intent profile settings
based on an ICC profile must be specified in order to ensure that the output is rendered
properly on the intended output device. Xara Designer Pro X includes presets for the
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most popular output intent profiles used in North America, Europe, and Japan. To specify
the use of one of the preset output intent profiles, simply select it from the list.

Custom Output Intent Profiles
If the output intent profile that is required for print production is not provided in the list
provide with Xara Designer Pro X, it is possible to enter the desired output by selecting
"Custom" in the intent profiles list. Here you may enter the optional Output Condition and
the required Output Condition Identifier that corresponds to the output device.
Note that for PDF/X compliance, Custom profiles must be embedded in the resulting
documents. Follow the instructions below for details on how to specify the location of ICC
profiles.

ICC Profile Embedding
The Xara Designer Pro X PDF filter includes provisions for embedding ICC files within a
PDF document. An embedded ICC profile is required for a Custom output intent if the
characterized printing condition is not in the registry of CMYK characterizations on the
ICC web site (www.color.org).
The output intent profiles included with Xara Designer Pro X are not embedded in the
resulting PDF/X document as they are readily available in workflow environments.
To embed an ICC profile within a PDF document:

1.
2.

Click the ellipses button [...] to select a file from within a file open dialog or type in
the path of the file manually.
EMBED THIS PROFILE

By default the file embedding feature is unselected.
Note: Please be sure to consult with your print service bureau to determine the
appropriate settings for all pre-press options.
Specifying an ICC profile of use in CMYK-based PDF documents: When a CMYK color
model is selected for standard PDF documents a profile may be specified from the
Output Intent Profiles list as a reference when performing the actual color conversion.
The output intent profiles included with Xara Designer Pro X may be embedded in the
resulting PDF document by clicking EMBED THIS PROFILE . If you wish to use a profile that
is not included in the list of presets, specify a Custom profile as described above and
select whether or not you wish to embed it in the document.
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PDF Export Filter Settings: Security Options

The SECURITY tab provides support for specifying security attributes and permissions
settings that determine how the PDF document can be used once it is distributed. These
options are only available for standard PDF documents and cannot be used when
generating PDF/X files.
To include these security settings in the outgoing PDF document, check "Apply security".
By default this feature is not selected.

File Open Password
To password-protect a PDF document, specify and confirm a password. This password
will be required when a user attempts to open the document for viewing.
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Note that it is strongly recommended that a document also be encrypted if a file open
password is applied as this security scheme is known to be relatively easy to
compromise. As a result, file open passwords should only be used as a means of
security to prevent inexperienced users from accessing sensitive documents.

Document Encryption and Permissions Password
To encrypt a PDF document, select an encryption method and specify and confirm a
password. This password will be required when a user attempts to make changes to the
document, including modifying security and permissions settings. The encryption
password is often referred to as the owner or master password and it may also be used
to open the PDF document.
Additional document permissions settings (outlined in the section below) may be applied
to determine the degree to which a user can interact with the encrypted document.
Four encryption methods are available:


This setting will not apply any document encryption. This is the default
encryption option for the document.
 40-BIT RC4: This setting will apply a 40-bit encryption algorithm to the document.
 128-BIT RC4: This setting will apply a 128-bit encryption algorithm to the document.
 128-BIT AES: This setting will apply the 128-bit AES encryption algorithm to the
document. If the PDF document contains confidential or highly sensitive material this
method of encryption is considered to be the most effective means of securing the
contents. Note: PDF 1.6 is required to support this encryption method.
NONE:

Document Permissions Settings
The document permissions settings section allows you to specify actions that can be
undertaken on an encrypted PDF document when it is rendered or processed by another
application.
Within the DOCUMENT PERMISSIONS SUMMARY section, check any of the following settings
to allow a user to perform the following tasks:
Printing: Selecting this option allows a user to print the PDF document. By default this
option is selected.
Extraction for accessibility: Selecting this option allows content to be extracted by
applications that assist users with impairments. By default this option is selected.
Commenting: Checking this option allows users to add comments and annotations to
the PDF document. By default this option is selected.
Modification: Enabling this option allows users to change the contents of the PDF
document. By default this option is selected.
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Document assembly (requires 128-bit encryption): Checking this option allows a user
to merge or append this document with other documents. By default this option is
selected.
Content copying or extraction (requires 128-bit encryption): Selecting this option
allows a user to copy or extract elements of the document, including text and graphics.
By default this option is selected.
Note: The PDF document must be encrypted in order for these permissions settings to
be applied. In addition, the responsibility for respecting these permissions settings is left
to the application that is used for processing the PDF document.

JPEG, PNG, GIF and BMP export dialog overview
The Export settings dialog has two
preview windows, IMAGE A on the left
and IMAGE B on the right, so you can
compare alternative export settings
or file types, side-by-side. Just click
on the left or right preview window to
change the active preview.
Above the preview window is a small
dropdown that lets you select from
the most common four export type,
JPEG, PNG, GIF and BMP.

When you have selected preview A or B you can then adjust a wide range of export
options using the five tabs below the preview. Some options, such as the Palette Options
are only applicable to some file types such as PNG and not relevant to JPEG type.
Other options under the OPTIONS tab change depending on the file type. e.g. when
exporting a JPEG this is where you can set the required quality.
So the process for exporting an image:

1.
2.
3.
4.

Select the object or objects on the page you want to export
Select the Export menu, or "Ctrl + Shift + E", enter a file name, and select file type
from the drop down list. The main export type will display the above preview dialog.
In this Preview dialog adjust the settings if you want, or skip this if you're happy with
the default settings
EXPORT

For most commonly used JPEG and PNG formats, at step 2 you can instead use the
direct operations available in the FILE MENU : EXPORT JPEG and EXPORT PNG . The export
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dialog shown includes a “Settings” button which takes you to the export settings dialog
shown above.
Most export settings are remembered for the next time you export. For example if you
adjust the JPEG quality, the next time you export a JPEG it will remember the last quality
setting.
Exported Image Size
When you export the normal default size is the same as you see on screen at 100%
zoom. The pixel size is shown under the preview window. You can adjust the pixel
dimensions either by adjusting the object size on the page before you export, or by
entering alternative pixel or dpi values in the BITMAP SIZE tab.

Preview Controls
These buttons alter the preview of the images, but do not affect the exported file:


ZOOM TOOL :



PUSH TOOL :



ZOOM TO FIT :



ZOOM TO 100%:



ZOOM TO RESOLUTION OF IMAGE

Click on a preview to zoom in. Shift-click to zoom out. Drag
over an area of the preview to zoom into that area.
Lets you drag the image around in the preview window.
Scales the preview image to fit the window.
Scales the image to full-size (100%).

(1:1): Has no effect for GIFs. Scales the
image so one pixel in the bitmap is one pixel on screen. This is useful for
previewing detail in the bitmap.

The following tool is only relevant to files using less than 256 colors (but you will see the
result when you have the PALETTE OPTIONS tab selected):
COLOR SELECTOR :

Moving the pointer over the image highlights the color under
the pointer. Click to select that color in the palette. You can then use PALETTE
OPTIONS buttons (described below) to alter that color.
The preview button is available on all tabs of this dialog. It updates the preview
windows to reflect any changes you have made to the export options.
PREVIEW:

Palette Options tab
This tab allows you to alter the color settings of your exported image.

Dithering & Palette
The DITHERING and PALETTE options only apply when you export with 256 color or less,
and affect how the image is displayed and its color palette. It is recommended to always
use an OPTIMIZED PALETTE . Set DITHER to none, which produces smaller files but may be
banded, or ERROR DIFFUSION , which creates higher quality results, but larger files.
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Color Depth
Choose the number of colors your bitmap requires. The more colors, the larger the file
(usually), and the higher the quality. The TRUE COLOR option supports up to 16 millions
colors. TRUE COLOR + ALPHA includes semi-transparent features such as soft shadows
and transparency. For applications that support alpha-channel PNG files this is the
recommended format.
If you choose 256 colors of less, you have the option to use simple transparency (Wine
glass icon-see below). This doesn't support semi-transparent pixels, only "on/off" fully
opaque or fully transparency pixels, and so can produce jagged edges.

Max Colors
If you select a Color Depth of 256 or less you can control exactly how many colors are
used in the file. This provides a high degree of control over quality vs. file size. Just enter
the required number of colors and press the PREVIEW button to preview.

Buttons
These buttons (except TRANSPARENT BACKGROUND ) apply when exporting 256 color
images or less. These files are created with a limited palette of colors, and these controls
provide a great degree of control over those palette colors. See COLOR SELECTOR above
on how to select a color, or click on a color in the COLOR PALETTE ).

Lock a Color
You can specify the number of colors you want in the palette of exported bitmaps. You
may want to ensure that certain colors always appear in the palette; you can lock these
colors. Click on a color to select it, then select the LOCK button. A small square appears
in the bottom left of the color to tell you it is a locked color.

Make a Palette Color Web Safe
When clicked this button will shift the selected color to be one of the 216 common web
browser palette colors. This is a legacy system that is no longer particularly important or
relevant, as nearly all computers can display millions of colors, and there's no benefit in
restricting web graphics to only this limited palette.

Make the Image Background Transparent
Make any areas not covered by the selected objects transparent. Selecting this option
automatically makes one entry in the palette transparent.

Make a Palette Color Transparent
Make this color entry transparent. Note the difference between this option, which makes
parts of the selected objects transparent, and Make The Image Background
Transparent which makes those areas behind the selected objects transparent.

Importing and Exporting
Delete a Palette Color
Delete this color from the palette. Any areas in the bitmap that use the deleted color then
use the nearest color in the palette. The fewer colors in the palette, the smaller the
bitmap file.

Restore a Previously Deleted Color
Undelete a deleted color.

Add system colors
Adds 28 colors to the palette. These colors are the regular Windows system colors and a
number of primary colors. This ensures the palette includes a spread of colors and may
improve the quality of the image, particularly if it contains a wide range of colors. You
may need to experiment with this option to get the best results.

Bitmap Size tab
With this tab, you can change the size of the exported image.

Bitmap Size and Resolution
You can change the size of the exported bitmap by changing:


Type the required width or height into one of the fields. Note that the aspect ratio
of the bitmap is fixed, so changing one dimension automatically changes the other.
SIZE is more suitable than SCALE if you want to create a bitmap of a particular size in
pixels.
 SCALE: (Dimmed for JPEG & PNG). This lets you scale the bitmap up or down by a
percentage. SCALE is more suitable than Size if you want, for example, a bitmap 50%
bigger than the original.
 RESOLUTION: (Dimmed for GIF & BMP) Type the resolution into the DPI field. If you are
exporting an image for viewing on screen (e.g. a website), you do not normally need a
setting higher than 96dpi. (If you need to export for a Retina device you can
automatically export a higher resolution 192dpi version as well).
SIZE:

Area to Save
The bitmap can be created using one of these areas of the document:




PAGE :

The whole page area.
The area covered by objects.
SELECTION : The area covered by the objects in the selection. Only available when
objects are selected.

DRAWING :

Anti-aliasing
Anti-aliasing improves the appearance of graphics by smoothing jagged edges:
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MAINTAIN SCREEN ANTI-ALIASING :

The exported bitmap uses the exact same
positioning as shown on screen, and so has identical anti-aliasing. This can result in
the edges of objects being slightly blurred because they do not fall exactly on pixel
boundaries.
 MINIMIZE VISIBLE ANTI-ALIASING : This will slightly reposition the objects by fractions of a
pixel to minimize the anti-aliasing around the edge of the exported bitmap. If in doubt
which option to use, select this.

Put HTML Image Tag on Clipboard
This lets you save out the basic HTML IMG tag information when you save the bitmap.
You can then paste the tag into your text or external HTML page editor.

Also export Retina (192dpi) bitmap
With this option checked you can simultaneously export a 192 dpi high definition Retina
image. This saves you exporting twice if you have a need to provide a 96dpi as well as a
192dpi resolution image for Retina devices. For JPEG and PNG the operation is only
valid when you have the 96dpi option selected.
See High resolution images (on page 414) for more info on Retina images.

Options tab
With this tab you can alter JPEG compression and turn on progressive/interlacing for the
GIF and PNG options if required.
JPEG Quality: (JPEG only) A low setting will result in a small file with a loss in quality
whereas a high value will give only slight file size reductions, but high quality. Note that a
setting of 100% will still compress the file. A setting of 85% gives good compression
without causing a noticeable loss in quality for most uses.
Interlaced: (GIF and PNG only) This is like a JPEG. In the browser the picture first
appears as a low resolution image. As more of the file loads, the resolution increases.
Transparent: (GIF and PNG only) This makes any areas not covered by the selected
objects transparent. Selecting this option automatically makes one entry in the palette
transparent.
Export each layer to a file of its own: (GIF and PNG only) Selecting this option when
exporting a design that contains multiple layers results in a separate file being exported
for each layer. The names of each layer (as set in the Page & Layer Gallery) are used to
name the exported files.

Image Map tab
An image map lets you have "clickable" areas on the graphic when displayed in a
browser. Clicking one of these areas jumps to a new web page. If you want to create an
image map, use "Utilities -> Web Address" to add web addresses (URLs) to the different
parts of your drawing.
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Export Image Map to Clipboard: This copies the image map HTML to the clipboard so
you can paste it into your text or web page editor. There is an option on the BITMAP Size
tab to save the HTML IMG tab to the clipboard. Selecting either of these clipboard
options automatically deselects the other option.
Export Image Map to File: This copies the image map text to a file. You can either:


INSERT IMAGE MAP INTO EXISTING FILE :

This inserts the image map into the specified
file. If the file already contains an image map with the same name, the existing image
map is replaced. If this is a new image map, it is inserted at the end of the file.
 REPLACE EXISTING FILE : This overwrites any existing contents of the file. This option is
useful if you want to save the image map text for use later.
Note that opening this file in a browser displays a blank window, i.e. you don't see the
graphic. The reason is that the file does not include the IMG tag needed to display the
graphic. The IMG tag might look like this: <img src="file name.gif" usemap="#example"
/>.
Adobe Dreamweaver Integration: With this option selected, the bitmap in
Dreamweaver is linked to the original Designer Pro document. If you later need to edit
the bitmap, Dreamweaver can load Xara Designer Pro X and display the original
document.
Image Map Options


NAME :

Image maps are named. (Names must be unique within a document.) If you are
merging this image map into an existing file, you can either type in a new map name or
choose the name of an existing map. This lets you replace an existing map with new
data.
 APPROXIMATE CURVES WITH LINES : Image map polygons are a series of straight lines
and this option lets you select how closely any curves in the clickable areas are
followed. (Note that circles are a special case in image maps.) Very closely gives the
best approximation. This increases the size of your web page and so makes it slower
to download.
 SAVE ALL CLICKABLE AREAS AS RECTANGLES : Ignore the shape of clickable areas.
Save all clickable areas as simple rectangles that totally enclose the clickable area.

Browser Preview tab
Using the A and B preview boxes in the EXPORT dialog box (shown above), you can
select the best compromise of file size and quality for web graphics. However the best
test is checking how the graphic looks in a web browser. This tab provides a number of
options for that preview. Click the BROWSER PREVIEW button to launch your web browser
and preview the graphics before exporting.
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Other bitmaps Export dialog box
Bitmaps other than GIF, PNG BMP and JPEG (for example TIF) use this
box. Not all options apply to all types of bitmap:

EXPORT

dialog

Bitmap size and resolution
Lower resolutions produce smaller files but at reduced image quality. The best resolution
depends on where the bitmap will be used. For display on screen a resolution of 96 DPI
is adequate. For printing, higher resolutions are required.
Experience shows that it is rarely necessary to output bitmaps at more than 300 DPI
(especially when anti-aliased) even for highest quality typeset results.
Enlarging or reducing the displayed image changes the apparent resolution. For
example, a 100 DPI bitmap displayed at half size has an apparent resolution of 200 DPI.
Conversely, enlarging the image reduces the apparent resolution.
You can also specify the size in pixels. Either choose from the menu or type a value into
any of the text boxes.

Compression
The compression options vary depending on the bitmap type. BMP files offer RLE
compression. TIF files offer LZW compression, or for monochrome (1-bit) you also get a
choice of HUFFMAN , GROUP 3 FAX , GROUP 4 FAX, ORPACKBITS COMPRESSION .
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Save Spread/Save Drawing/Save Selection
You can:
 Save the entire area (the spread). This can create very large files especially if you
select more than 256 colors.
 Or save the area covered by the drawing.
 Or save the area containing all the selected objects. Everything within the area is
saved including any unselected objects.

Working with Templates
Using the templates available in the Online Content Catalog is the quickest and easiest
way to create high quality designs.
To load a template, open the Content Catalog and double click on a template thumbnail
in one of the design categories. Once loaded, you can customize the template to produce
your own personalized high-quality design. Typically you’ll want to replace any photos
with your own, enter your own text and perhaps change the color scheme, all of which is
trivial in Xara Designer Pro X. This chapter describes how to do these customizations
easily.

Replacing photos
To replace a photo simply drag your own image file (JPEG, GIF, PNG, BMP) from your
Windows File Explorer and drop it on top of the picture that you want to replace. Your
photo will automatically be scaled appropriately to replace the template photo. The new
photo will be selected together with the smartphoto adjustment handles (on page 351)
enabling you to easily adjust the position and scale of your photo if desired (see below).
Alternatively you can load your photos into the current design using "FILE" > "IMPORT" .
This adds a new photo object to your design and also adds it into the BITMAP GALLERY
(on page 331). Remove the new photo from the page by selecting it and pressing
"Delete". Then drag your photo from the BITMAP GALLERY and drop it onto a template
photo to replace it, as described above.
There is also the option of importing stock photos from the Online Content Catalog. You
can either browse the catalog from the File menu. "FILE" > "NEW FROM CONTENT
CATALOG". Or you can replace a photo by right-clicking it, and then choosing "REPLACE
PHOTO" > "WITH STOCK PHOTO" from the context menu.
By default when you replace a photo, any other copies of that photo on the current page
are also replaced. This is usually what you will want, because some templates have
multiple copies of the same photo which need to be replaced, including some on hidden
layers. E.g. perhaps a large version of a photo and a thumbnail version of the same
photo. However if you want more control over the photo replacement, hold down CTRL
while dropping your photo and then you’ll be asked which instances of the photo you
want to replace.
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Note: Normally you should not replace photos by first deleting the template photo as this
will also delete the shape that holds the photo, which determines its size. If you have
deleted a photo in this way, use the Undo function ("Ctrl + Z") to restore it and replace
the image as described above instead..

Adjusting a photo in its frame
You’ll often want to adjust the position, scale and rotation of a photo in its frame. Select
the photo - you will see the smartphoto adjustment handles appear allowing you to rotate
and scale the picture, move it within it's outline frame, resize the frame and even round
its frame edges.

Editing photos
The easiest and most convenient way to edit photos in your design is to use the built-in
PHOTO TOOLS . These can be found on the Photo Tools fly-out bar on the main toolbar.

Use the Photo Enhance Tool to perform the most common adjustments to your photo,
such as adjusting brightness, contrast and saturation. You can also crop photos while in
this tool by just dragging on the photo. Or go into the dedicated Clip Tool for more
clipping options. The Clone Tool is useful for removing unwanted parts of an image nondestructively, by copying one part of a photo to another. There are also tools for
intelligently resizing an image, removing red eye effects, making panoramas, correcting
perspective and other photo editing functions.
See the Photo Tool chapter (on page 364) for full details.

Changing colors
Editing theme colors individually
To edit a template’s theme colors, right click on one of the larger square named color
patches on the left of the Color Line (on page 190) at the bottom of the window and
choose Edit in the menu that appears. This opens the Color Editor (on page 193). There
will usually be several named theme colors in the Color Line - hover the mouse pointer
over the color to see the tooltip showing the color name. Sometimes there will also be
several colors linked to a theme color that will change at the same time; these are shown
on the Color Line with smaller color squares, but normally you won’t need to edit these
because they change automatically with the main theme colors.
You can also click on any object in the design to select it and then click a named or
palette color on the Color Line to change the object’s color. If the object is not just a
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single color (such as a button made up of a group of different colored shapes) a ‘replace
colors’ dialog will appear with a list of the colors used in the object. You can choose
which color you want to replace with your chosen color. This way you can, for example,
make a button that uses Theme Color 1, use Theme Color 2 instead.
Once you’ve changed the theme colors in your document, if you then paste in or import
templates which still use the original theme colors, you’ll be presented with a choice. You
may want to import the new objects with their original colors, in which case choose the
‘Don’t match’ option. But more likely you’ll want them to be changed to match the colors
you’ve chosen for your document, in which case choose the ‘Match’ option. The color
matching prompt is shown whenever you import objects which share a color name with
the colors already in your document, where the actual color values differ. See Color
Handling (on page 189) for more information.

Page background color
If you drag a color from the Color Line over the page, and drop it, it will set the page
background to that color.

Once you’ve set the color this way, if you want you can refine it using the color editor.
Right click on the page and choose CHANGE PAGE BACKGROUND from the menu. The
color editor appears allowing you to edit the page color.
When working with website documents, setting the page background color actually sets
the background color for the whole browser window when you view your exported
website.
To set a repeating background texture, drag the photo or bitmap onto your
document. Open the Bitmap Gallery, scroll to the photo you just loaded, click on it
to select it, then click the Background button on the Gallery, and choose the SET
PAGE BACKGROUND option.
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Changing text
Double click on the text you want to edit to go into the
TEXT TOOL icon on the main Toolbar.

TEXT TOOL ,

or just click the

You can drag over the text to select it and then type to replace it, just as in a Word
Processor.
To change the font, drag select the region of text to be changed and select from the font
dropdown menu on the InfoBar
You can add new passages of text to the design by just clicking and typing, or, to create
a block of text with a set width and height, click and drag diagonally on the page while in
the TEXT TOOL and then enter your text into the text frame that appears. You can easily
make a passage of text automatically flow around photos and other objects on your
page. All you have to do is right click on an object and choose “REPELLING & ANCHORING ”
to make that object repel text that is underneath it. See the Repelling Text section (on
page 237) of the TEXT TOOL help for details.
Or you can anchor an object to a particular point in text, so that the object follows the text
as the anchor point moves. Right click on it and choose ANCHOR TO TEXT. After
anchoring, move the object to where you want it relative to the text, using the SELECTOR
TOOL. Now as you edit the text and the anchor point moves, the anchored object moves
too. See the Text Tool chapter (on page 240) for more details.

Adding Pages
You can easily add more pages to your design to create multi-page web sites or multipage documents. Simply drag a page template from the Designs Gallery (on page 27)
onto your document and it will be added as a new page immediately following the current
page.
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Changing the blank template document
The blank template documents are the options available under " FILE" > "NEW" .
Pre-designed templates are available from the
"NEW FROM ONLINE CONTENT CATALOG ").

ONLINE CONTENT CATALOG

(or "FILE " >

To add a template document:

1.
2.
3.

Open an existing document ("FILE " > "OPEN ", or "Ctrl + O") or create a new
one with the NEW button on the Standard control bar or "Ctrl + N".
Make any required changes (these could be changing the page size,
adding a logo or adding a message). You can edit the template document
just like an ordinary document.
FILE

SAVE TEMPLATE

To make your new template the default template (i.e. which is there when you first open
Designer Pro, and which appears when you press "Ctrl + N") check the USE AS DEFAULT
TEMPLATE option when saving the template.

Displaying your own icons in browser tabs: favicons
You may want to display your own customized icon, for example, a logo, on your site's
page tabs when they are displayed in a web browser. Designer Pro allows you to do this
by applying the name 'favicon' to your custom tab icon.
To create a 'favicon', draw or drag on to a web page the image that you want to use. The
image can be any size as it will be scaled to the right size automatically when displayed
in a browser.
Click it then click the Names button to the right of the SELECTOR TOOL InfoBar.

In the Names dialog, type 'favicon' into the APPLY NAMES box and click ADD then CLOSE .

Preview your website in your choice of web browser. The easiest way is to click one of
the Preview icons and in the Xara Designer Pro X preview window, and then choose one
of the web browsers in the top right of the preview window.
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Your web page tab is displayed with the custom icon, as shown in the example below.

You can only use one favicon per website. Publish your website and view it to see your
favicon.

Options in the Utilities menu
Keyboard shortcut: "Ctrl + Shift + O" or right click the page/pasteboard and choose

PAGE

OPTIONS.

This menu option opens the OPTIONS dialog box. This lets you set various options for
Designer Pro.

Customizing Designer Pro
General tab
This page describes the General tab of the Utilities, Options dialog

Current layer always visible and editable
With this option selected, selecting a layer in the PAGE & LAYER GALLERY automatically
makes it visible and editable.
With this option unset, the visible and editable states of a layer remain unchanged when
you select that layer.
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Give new objects most recent attributes (GNOMRA)
Examples of attributes are line width, dash pattern, arrowheads, color, fill color and type
of fill.
With this option set, new objects take the attributes of the object that was last drawn or
selected. For example, you might give an existing shape a red fill and green line color. If
you then draw a new shape it will also have a red fill and green line color. See Current
attributes (on page 102) for a full description of current attributes and this option.
This option is on by default.

Ask before setting current attribute
This applies when changing a current attribute (this happens when you change an
attribute with no objects selected). With this option set, you are asked to confirm whether
you want to change the attribute. With this option unset, the change is made without
confirmation.

Make groups be transparent as a whole.
See Transparency for more on transparencies.
When applying transparency to a group of objects, by default Designer Pro will apply the
transparency to the group as if it were one object (i.e. you will not see individual
transparencies within the group). Unselecting this option will make Designer Pro add
transparency to each object in the group separately.

Maintain imported layer names
With this option set, layer information is preserved when you import templates or other
files. With IMPORT LAYERS INTO THE ACTIVE LAYER instead selected, all imported objects
appear in the current layer and the layering information in the incoming data is ignored.
IMPORT LAYERS INTO NEW LAYERS will create a layer for each imported layer.
IMPORTANT: Note that you should not change this setting if you use any of the web
templates in the ONLINE CONTENT CATALOG /DESIGNS GALLERY. Most web templates have
multiple layers which are used to implement mouseover effects. These typically have
layers MouseOff and MouseOver and so when importing these designs it’s important that
these layers are preserved and merged with the same layers in your document.

Recent files
The File menu shows a list of the most recently loaded or saved files in its ‘Open recent’
sub-menu. This list gives a quick way to reload any of those files. This option lets you
change the number of files listed (between 1 and 20 files).
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Marquee Object Selection
This option enables you to change the default setting for marquee selection (on page
123) (where you drag a selection rectangle over the objects you want to select). So you
can choose to have objects touching the selection rectangle selected or only the objects
wholly inside the rectangle.

Legacy web browser compatible line lengths
Older web browsers were not able to render text very accurately. When you asked for a
certain font size they rounded it up or down, often displaying the wrong size and width
(compared to the original font design, and how Designer Pro, Word, PDF and all modern
DTP programs would display it).
Older versions of Designer Pro attempted to compensate for these inaccuracies, by
providing a LEGACY WEB BROWSER LINE LENGTH COMPATIBILITY option which meant the
text was slightly differently formatted - line lengths would be different compared to normal
print documents, or the same text in Word, or PDF documents.
Most modern web browsers are getting better at rendering text accurately - you can now
specify any px or pt font size, even fractional sizes, and the text will for the most part, be
rendered accurately*. The text formatting should be the same as in print documents,
PDF, and page layout documents. This includes auto-kerning, manual kerning and
tracking (letter spacing).
If you load an older Designer Pro web document, a dialog will appear prompting you to
update the text formatting. This in effect prepares your web document so that it will
display accurately on most modern web browsers.

A consequence of updating the formatting to support the more modern browsers is that
text may re-flow because of slightly different line lengths, causing text columns to be
slightly longer or shorter than before. Once you update formatting the document will
remain like this and you will not be asked again.
To turn formatting back to the old style use the GENERAL TAB of "UTILITIES" > "OPTIONS"
dialog and make sure that the LEGACY WEB BROWSER LINE LENGTH COMPATIBILITY option
is checked. Or if you are loading an older document into Designer Pro just choose the
KEEP ORIGINAL FORMATTING option.
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*As of writing the Apple Safari and Chrome browsers when used on mobile devices such
as phones and tablets still round font sizes to the nearest whole pixel size.

Document type
This determines the type of document, as indicated by the icon in the document’s tab.
 Print – Used for documents that are intended for print work. This type is not normally
used in Designer Pro, but other products in the Designer product range work with print
documents.
 Website – Use this type of document for creating websites and web graphics. This is
the most common document type Designer Pro is used with.
 Photo – If you open a JPEG photo in Designer Pro, the document type is Photo. Such
a document doesn’t have a defined page area for example. See the Photo Handling
(on page 322) chapter for details.
 Animation – Used for animation documents. See the Animations (on page 519)
chapter for details.
 Presentation (Web) – These are specialized website documents that make a
presentation. See the Web Presentations (on page 498) chapter for more information.
Normally you don’t need to change the document type as the type is established when
you first create it (for example using a template from the Designs Gallery, or choosing a
blank document from the FILE ->NEW MENU ). But it’s sometimes useful to convert between
print, website and presentation documents if the purpose for which your document was
created changes. You can’t convert to or from Photo or Animation documents.

Word compatible line spacing
This option is on by default in all blank print documents, and it's best to leave it checked if
you are planning on exporting a print document in Word (docx) format. The option makes
Designer Pro render text line spacing in a way that more closely matches an exported
Word document.

Angle constraint
This applies when rotating or moving an object with "Ctrl" pressed.
You can either select from the menu or type in a value in degrees.

Nudge size
This applies when moving objects using the arrow keys on the keyboard.
This text box defines how far the object moves for each key press. If the document uses
scaled units (for example, 1inch to 1mile), this text box shows the distance in the scaled
units.
When nudging, "Ctrl" and "Shift" increase the nudge distance by five and ten times,
respectively.
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Duplication distance
"EDIT" > "DUPLICATE " (Ctrl + D) creates a duplicate which is offset from the original
object. These text boxes set the offset distance.
Positive values create the duplicate above or to the right of the original object.
Negative values create the duplicate below or to the left.

Grid and Ruler tab
This page describes the Grid and Ruler tab of the Utilities, Options dialog

Grid and Ruler spacing
defines the distance between the major grid and ruler divisions. The
units used for the grid and rulers are defined by the units you use for the major spacing.
For example entering a major grid spacing of 2CM will set the grid and ruler units to
centimeters regardless of the page units specified in the units options.
MAJOR SPACING

Grid type
Xara Designer Pro X allows the use of a standard
grid.

RECTANGULAR

grid or an ISOMETRIC
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Origin (0,0 point)
Normally, the origin for the grid and rulers is at the bottom left-hand corner of the page. If
you wish to move it to a different location, change the origin value.

Coordinate Direction
Here you can change the direction of page coordinates so that, for example, Y values
increase as you go down the page. This is useful when you want the 0,0 point to be the
top left corner and increase down the page like it does for HTML.

Internet tab
This page describes the Internet tab of the Utilities, Options dialog

Internet Cache
When Xara Designer Pro X downloads gallery items from the Internet, it stores them in a
reserved area of disk memory called a "cache". When Xara Designer Pro X uses these
items in the future, it can load them directly from the cache, which is much more efficient
than downloading over the Internet.
indicates the amount of cache space currently in use. This gives an idea
as to whether the cache size is correct. That is, if cache usage is consistently nearing
100% the cache size should be increased if possible. A larger cache size does not affect
the program adversely or take up unnecessary space on the drive. We recommend a
cache size of 15 - 20 MB. The minimum cache size is 500KB, the maximum is the free
CACHE USAGE
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space on the drive when the size is set. Anything outside these limits generates an error.
You can type in byte values directly (800000). For kilobytes or megabytes, follow the
value with K or M (500K or 8M).
The EMPTY CACHE button removes all files from the cache except a few essential data
files needed by Xara Designer Pro X (this means that cache usage might not return to
0% after emptying). To use a file that has been removed from the cache, you have to
download it again.

Connection Type
Over faster modems, ISDN, and networks, Xara Designer Pro X can speed up
downloads by using multiple connections. These multiple connections are invisible to you
and you just see an increase in speed.
If you connect to the internet using a dial-up modem, select the appropriate speed option.
If you are not sure about your modem, use the default setting. If you connect to the
Internet using broadband (like ADSL or cable), select dual ISDN or better.

Proxy Server Settings
If your computer is using an Internet proxy, then it will list its details here. This
information is not relevant to most users.
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Mouse tab
This page describes the Mouse tab of the Utilities, Options dialog

Mouse button function
Designer Pro gives you a range of possible actions when you click either the left or right
mouse buttons. For example, if you're left-handed, you may prefer to use the right-hand
button as the normal button. You would therefore assign the normal click to the right
mouse button (you can also set both buttons to have the same action if you wish).
Possible actions:








Normal click - At least one button should always be assigned as the normal click.
"Shift + click".
"Ctrl + click".
"Alt + click".
Display a pop-up menu (see below).
Toggle full-screen mode (described in Document Handling (on page 37)).
Zoom in or out -click to zoom in, "Shift + click" to zoom out (described in Document
Handling (on page 38)).
 PUSHTOOL (as if you pressed "Shift + F8")

Customizing Designer Pro
The pop-up menu contains options suitable for the object you click on. For example, for
most object types the menu contains CUT, COPY, PASTE, DELETE, DUPLICATE, CLONE
(these are described in Object Handling (on page 74)).
MOUSE WHEEL MOVEMENT:

You can change the mouse wheel action here between

Scrolling and Zooming.
Click RESET DEFAULTS to return to the original button assignments. This has immediate
effect; you don't need to click OK or APPLY NOW .
The Windows Control Panel also lets you swap the left and right mouse buttons.

Magnetic Snap Radii
Snapping is described in Object Handling (on page 74).
These text boxes define how close you can drag an object before it snaps to a magnetic
object. These are distances on the screen and independent of any document scaling.
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Page Size tab
This page describes the Page Size tab of the Utilities, Options dialog

These options apply only to the selected document.

Paper
Options relating to setting the page size (paper, orientation, spread) are described in
“changing the page size” in Document Handling (on page 40).
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If the Lock page size option is turned on, you can't resize a page by dragging the bottom
or right edges and any PUSH objects that get pushed off the bottom edge of the page will
not cause the page to grow.

Page
OUTER MARGIN

sets the size of the margin (or Pasteboard) around the page.

determines the bleed area size around your document. This area (typically 13mm) is important for format filling prints in print shops. Read more in the "Changing the
page size" section in the chapter Document Handling (on page 42)!
BLEED

sets whether a shadow is displayed under the page (this is only onscreen, it is not exported or printed).
SHOW PAGE SHADOW

If you select DOUBLE PAGE SPREAD you can create a document consisting of two pages.
This option adds a second page to your document.
When this option is selected, each double page spread is
printed and exported (for example to PDF) to a single page, just as it appears in Xara
Designer Pro X.
PRINT/EXPORT WHOLE SPREAD:

When this option is selected, each double page spread
is printed and exported as 2 separate pages, just as if they were designed as separate
pages in Xara Designer Pro X.
PRINT/EXPORT INDIVIDUAL PAGES:

Document
When this option is selected, all the pages in your
multi-page document will be given the same dimensions. So if you change the
dimensions on one page, all the other pages will update too. This is normally required
when working on print documents, because typically each page will need to print to the
same paper size.
ALL PAGES IN DOCUMENT THE SAME:

When this option is selected, all pages in your multi-page
document will have the same layers. If you add or delete layers from one page, all the
other pages are similarly updated. . Additionally, the contents of background layers are
synchronised across all pages so that every page has the same background design
(change the background design on one page and all pages update). In website
documents you need to make sure this option is not selected if you want different popup
layers on different pages of your site. See the Page & Layer Gallery (on page 181)
chapter for information about Layers.
SAME LAYERS ON ALL PAGES:

Auto-fit to Page...
The AUTO-FIT TO PAGE... button will open the AUTO-FIT TO PAGE dialog. This enables the
automatic repositioning and scaling of page content to fit a new page size. The dialog
also lets you fine tune the position of document content. This may sometimes be
necessary especially with items around the margins of the document like headers,
footers etc.
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See the Auto-fit to Page (on page 111) section in the Object Handling (on page 74)
chapter for details.
.

Backups Tab
This tab allows you to turn the automatic backup facility on and off. This facility saves a
copy of all your modified open documents at regular intervals. It’s recommended that you
work with this backup option turned on, so your work is saved regularly. You can also
choose whether you are prompted about unsaved documents when closing the program,
or if instead all open documents should be backed up and restored for you when you
next start up.
See the Document Handling chapter (on page 51) for full details about these facilities.

Effects & Plug-ins tab
This page describes the Effects & Plug-ins tab of the Utilities, Options dialog

For more on Live Effects refer to Live Effects (on page 384).

Photoshop Plug-ins
Clicking SETUP lets you add and remove folders of Live Effects plug-ins.

Effects
Here you can set the default resolution of Live Effects and locked effects.

Customizing Designer Pro
New Effects Are Locked By Default
This will make any Live Effects you create locked by default, so they will not change if
you move or resize them.

Default Live Effect resolution
If a Live Effect resolution is set to AUTOMATIC , then any Live Effects on an object will, by
default, be produced at screen resolution. If you wish to print your design you can set
one Live Effect to a higher DPI and all effects on that object (as long as the other effects
are set to automatic) will automatically be rendered at the highest DPI. It won't then be
necessary to alter each effect one by one. Or you can set a different default in this
window, and all Live Effects will be created at that resolution.

Default Locked effect resolution
This is the default resolution for locked effects. If you wish to change the DPI of a locked
effect, you need to recreate that effect. Please note: this only applies to locked effects,
and does not apply to a locked Live Effect.

Photo Editing
This page describes the Photo Editing of the Utilities, Options dialog
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Photo Editing
You can choose what should happen when you save a Photo Document with a modified
photo in it. By default the original photo file is preserved in a .xar file in a "Masters" subfolder and the original opened photo file is overwritten. You can choose to have the
original photo file saved in the "Masters" folder instead, or you can choose to not have
the original photo preserved at all. See the Editing Photo Files (on page 359) section of
the Photo Handling chapter for details.

Editing Bitmaps
Here you can select the bitmap editor that you want to use to edit bitmaps in Xara
Designer Pro X.
See Integration with external Photo Editors (on page 349) in the Photo Handling chapter
for details.

Bitmap transfer
Always use bmp
Images will always be transferred as bmp files. This is the fastest way to transfer images
to and from the bitmap editor, but bmp does not support transparency. So if you want to
edit bitmaps that include some transparency, or you want to introduce some
transparency while editing the image, don’t use this option.
Always use png
Images will be transferred to the bitmap editor as uncompressed png files, preserving
any transparency in the image. Most editors will return images as compressed png files
in this case and this may be slow for large images. Use this option if you want to edit
24bpp (opaque) bitmaps, but you want to introduce some transparency while editing in
the bitmap editor.
Automatic
This is the default option. Xara Designer Pro X will automatically decide whether to use
bmp or png to transfer the bitmap to the bitmap editor. If the bitmap does not have any
transparency (24bpp) bmp will be used. Otherwise png will be used. This option should
be fine for most editing, but if you want to introduce some transparency to your image
while editing it, choose the png option instead.

Customizing Designer Pro
Scaling tab
This page describes the Scaling tab of the Utilities, Options dialog

Described in Measurement Units in Document Handling (on page 58).

623

624

Customizing Designer Pro
Tune-ups tab
This page describes the Tune-ups tab of the Utilities, Options dialog

Redraw
The value set in this option is used when redrawing the document on the screen and
during exporting and printing. Normally automatic gives the best results, but if you have
an old computer with limited memory you can specify a lower value. This may, however,
slow down redraws.

Gallery cache
When displaying items in a gallery, Designer Pro reads the information off disk into a
cache. This speeds up gallery redraw speed for recent items.
The default value is generally suitable. You may want to reduce it if memory is tight, or
increase it if you use galleries frequently.

Undo size
Applies only to the selected document-described in Undo & Redo (on page 73).
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Cache Control
Complex objects including layers, groups, bevels, shadows, blends, molds, contours,
ClipViews and Live Effects can be cached as bitmaps when they are rendered. This
means that the next time these objects need to be redrawn, the bitmap can often be used
instead of re-rendering the objects, making redraws and object drags very much faster.
The difference is particularly noticeable with complex documents.
Since caching involves storing additional bitmaps in memory, it has the potential to
increase the amount of memory used by Xara Designer Pro X significantly. Therefore in
this dialog you can turn caching on and off and you can also control how much memory
is used for caching when it's turned on. Increase the percentage memory figure to make
Xara Designer Pro X cache more objects in your design, generally making redraws and
object drags faster at the expense of larger memory usage. Or reduce it to lower the
amount of memory that Xara Designer Pro X uses for caching. In complex designs, some
cacheable objects will not be cached if there is insufficient memory to do so.
This dialog also shows you how much memory is currently being used for caching.
Live drag is described in Document Handling (on page 36).
Note: Cached bitmaps will only be used during object dragging if you use LIVE DRAG . If
you have LIVE DRAG turned off, then as you would expect you will just see the outlines of
objects when moving them.
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Units tab
This page describes the Units tab of the Utilities, Options dialog

Described in Measurement Units in Document Handling (on page 56).
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View tab
This page describes the View tab of the Utilities, Options dialog

Display
Show progress bar: During long operations Designer Pro can display a progress bar on
the status line. If instead you'd prefer an hourglass to replace the mouse pointer until the
operation is completed, uncheck the SHOW PROGRESS BAR setting.
The hourglass and progress bar are for information only-they have no effect on the
document itself.
Interactive fill dragging: Interactive fill dragging allows you to see how fills and
transparencies look as you drag the fill handles. This is on by default.

Dithering
These options set the dithering method used to display your document on the screen.
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It is recommended that you leave this on its default setting.

Bitmaps
These options apply only to the current document. They have no affect on any other
documents currently loaded.
When Xara Designer Pro X scales a bitmap, it usually smoothes
(interpolates) between the individual pixels to give a smooth look to the bitmap. Usually
this gives the best results. Check this option if you if you do not want this effect.
NEVER SMOOTH:

Some features such as shadows and bevels are created
using bitmaps. Xara Designer Pro X calculates the resolution of these bitmaps when they
are displayed. However, when you perform actions on shadows and bevels such as
CONVERT TO EDITABLE SHAPES , COMBINE SHAPES , EXPORT AS EPS and EXPORT AS FLASH ,
Xara Designer Pro X creates a new bitmap using the resolution you specify here. For onscreen use (such as web page graphics) 96 DPI is the best value. For work that will be
printed, you may need a higher value. Changes to this value apply to new autogenerated bitmaps; it has no effect on existing bitmaps.
DPI WHEN AUTO-GENERATED:

The 3 radio button group allows you to choose how large photos should be handled
when you import them. Given the large size of digital camera photos, often if you’re
working on a document the photo you import will be many times the size of your page.
This is the default option. Large
images are scaled down to a more manageable 500 pixels wide, or whatever size you
set here. The document zoom is not altered.
RESIZE LARGE IMPORTED IMAGES DOWN TO ... PIXELS:

With this option the DPI of the image is
ignored and it is loaded as if the DPI is 96 (screen 1:1 size). So if an image is 1000 pixels
wide, it will display as 1000 pixels wide in Xtreme Pro. Also Xara Designer Pro X will
automatically zoom out if required, so that the whole photo fits into the view.
IMPORT ALL PHOTOS AT 96DPI (1:1 AT 100% ZOOM):

With this option, any DPI value specified inside
the image itself is read and the image is imported at that DPI. Note that some digital
cameras write incorrect or unhelpful DPI values into photos and so this option may not
always give you the results you expect.
IMPORT AT DPI SPECIFIED IN THE IMAGE:

Note that the above import options do not apply to photo documents. Photos are always
imported/opened at their full size in photo documents.

Color
COLOR LINE SIZE: This

lets you select the size of the color bar at the bottom of the screen.
A scroll bar is displayed when the number of colors is wider than the width of the color
bar.
EDIT LOCAL COLORS IN:

This affects the color model displayed when editing a local color.
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Automatic displays the color model of the original color style that the local color is based
upon. For example, the HSV color model for a color style defined in HSV. This is
important if you need to ensure your objects are in CMYK, for example.
The other options let you select which of the four color models (RGB, CMYK, HSV,
grayscale) to always use by default.
This option is to turn off the color-line right-click menu (on page
190) and make right click set the line color, as in earlier versions of Xara Designer Pro X.
RIGHT CLICK ON COLOR:

When this option is selected, any
unused named colors in your document will be deleted when you save/load. This
prevents your Color Line becoming cluttered with named colors which are not used in the
design. This is particularly useful when loading older designs, because earlier versions of
Xara Designer Pro X used to create named colors implicitly. So many older designs
contain numerous unused named colors. Load them with this option turned off and it’s
hard to identify the important used named colors on the COLOR LINE from the unused
ones.
DELETE UNUSED COLORS WHEN SAVING AND LOADING:

Control bars
You can move Designer Pro's control bars to different places around the window, reorder the buttons, create new control bars, move or copy buttons between control bars
and many other operations.
You cannot change the tool-dependent InfoBar or the contents of the fly-out bars which
are on the main toolbar and top bars.

Full screen mode
Designer Pro has two configurations of control bars:
 One configuration appears when the window is its normal size.
 The second configuration appears after you choose "WINDOW " > "FULL SCREEN ".
Any changes to one configuration of control bars (for example, resizing or moving) have
no effect on the other configuration. Changes to individual buttons (for example, setting
an option) apply in both normal and full screen modes.
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Displaying & hiding control bars
The display of control bars is controlled by
the CONTROL BARS dialog box ("WINDOW" >
"CONTROL BARS ").
Against the name of each control bar is a
check box. A tick in the check box shows
that the control bar is currently displayed.
Click on the required control bar's check
box to display or hide that bar.

You can also quickly turn CONTROL BARS on or off if you right-click in any empty area at
the top of the program window. Use the drop-down menu to choose which bars you want
to display.

Docked and free floating control bars
Normally, control bars are docked (attached to the edges of the window). Moving the
window also moves docked control bars.
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Control bars can also be floating. These do not follow movements of the window.

Floating control bar

Docked control bar

You can hide a floating control bar either using the
above) or by clicking its CLOSE icon.

CONTROL BARS

dialog box (described

To make a control bar float, drag it away from the edge of the window either onto the
editing area or off the Designer Pro window.
To dock a control bar, drag it over:
 The edge of the window.
 Or the menu bar.
 Or another control bar.
A floating control bar has a double line outline while dragging. This changes to a single
line when in a docking position. If you want the control bar to remain floating, hold down
"Ctrl" while dragging.

Resizing a control bar
Move the pointer over the edge of the control bar. It changes to a double-headed arrow.
You can now drag the edge to resize the control bar.

Creating new control bars
To create a new control bar:
 Drag a button onto the editing area or off the window. This opens a new control bar
containing the button.
Or click NEW on the CONTROL BARS dialog box. This lets you create a new control bar and
allocate a name to it. The new control bar is empty. You can then drag buttons to it.
Moving buttons is described below.

Deleting control bars
You can only delete control bars that are empty. Therefore move any buttons to another
control bar. Close the control bar (either click on the CLOSE icon or use the CONTROL
BARS dialog box). The control bar is automatically deleted when you quit Designer Pro.
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Changing the size of buttons
Buttons can be large or small as selected in the CONTROL BARS dialog box.

Moving buttons and tools
To move buttons or tools:

1.
2.

Move the mouse pointer over the button you want to move.
Hold down "Alt" (left ALT) to move the button or "AltGr" (right ALT) to copy the
button when used on user-defined control bars and other control bars. Although on
the predefined "Button palette" both ALT-keys do only copy the button.

3.
-

A different place on the same control bar.
Or another control bar.
Or onto the editing area/off Designer Pro to create a new control bar.

You cannot move buttons onto or off the InfoBar.

Hiding buttons and tools
Move the unwanted buttons or tools to another control bar and then hide that control bar
(described above).
If you need the button or tool in the future, use the
the control bar.

CONTROL BARS

dialog box to redisplay

You cannot delete buttons or tools.

Fly-out menus
Some buttons have a small black triangle which indicates that there is a fly-out bar, which
appears when the mouse pointer is held over the button for a short period. You cannot
customize the contents of these flyout bars, but you can drag the button as a whole onto
and off bars, just as you do with ordinary buttons.

Gallery docking and undocking
It is possible to dock one or more galleries on either side of the Designer Pro window.
See moving and docking a gallery (on page 61).

Restoring the default control bars/galleries
Choose "WINDOW" > "CONTROL BARS" and click RESET to restore the control bar setup to
the default setting.

Menus and Keyboard Shortcuts

Menus and Keyboard Shortcuts
Introduction
This chapter describes the operations available on each of the menus and those
available via keyboard shortcuts. In many cases the operations described in this chapter
apply to the selected object. In most cases, the described action also applies when you
have several selected objects. We use selected object as shorthand for selected object
or objects.
Often you can select options from either a menu, a control bar or a keyboard shortcut.
Where a button on a control bar and/or keyboard shortcut exists, these are shown after
the menu name. For example, the following means there is a button on the STANDARD
control bar that has the same effect as selecting new, or you can use the shortcut "Ctrl +
N".
New (Standard control bar or "Ctrl + N")

File menu
New (Standard control bar or Ctrl+N)
Opens a new document.

New from Content Catalog (Shift+Ctrl+Alt+K)
Opens the Online Content Catalog. Choose SmartShapes, templates, widgets and clipart
from the catalog's web, layout and photo and graphic categories.

Open (Standard control bar or Ctrl+O)
Opens a new editing window and loads a file into it. This file can be:
 An Designer Pro .xar file to view or edit an existing Designer Pro document,
 Or any of the other import formats (see Importing & Exporting (on page 562) for a list
of formats). This opens a new document showing the drawing in the file.

Open recent
A list of the most recently loaded or saved files. Provides a quick way to reload any of
these files.
You can change the number of files in this list (refer to Customizing Designer Pro (on
page 607) for details).
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Close (Ctrl+W)
Closes the current editing window. Designer Pro remains loaded. You are warned if the
file has unsaved changes.

Save (Standard control bar or Ctrl+S)
Saves the selected document.

Save As
Lets you save the selected document under a different name or to a different directory or
drive.

Load / Save Translation
These options can be used to help produce documents translated into different
languages. SAVE TRANSLATION exports all the text in the current document into an XML
format that can be imported by external translation tools. The translation tools export a
similar XML file, with the text replaced with the translated text. This can be applied to the
same document in Designer using LOAD TRANSLATION , and the text in the current
document is replaced with the translated text.
translation, load translation, save translation, XML

Save All
Saves all loaded documents.

Save Template
Saves the selected document as a template document (see Customizing Designer Pro
(on page 607)).

Import (Ctrl+Alt+I)
Loads a file into the selected document. The file can be any of the import formats (see
Importing & Exporting (on page 562) for more information).
Note the difference between OPEN and IMPORT : both load a variety of file formats but
OPEN opens a new document. IMPORT loads the file into the current open document.

Import from Web Address (Ctrl+Alt+W)
Import text and graphics directly from web pages on the Internet into your document.
Enter the URL (web address) of the site you wish to import into the dialog box.

Export (Ctrl+Shift+E)
Or right click and choose EXPORT .
Lets you export the document in any of the export formats supported by Designer Pro
(see Importing & Exporting (on page 562) for a list of formats).
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Export JPEG
Lets you export selected objects, a page or the whole document as a JPEG.

Export PNG
Lets you export selected objects, a page or the whole document as a PNG.

Export PDF
Lets you export the selected document as a PDF. See Exporting PDF files (on page 578)
for more information.

Preview web page (Shift + F5)
Export and preview the current page of the current website document.
You can also preview your page by clicking the web page preview button on the
Web toolbar.
Click a browser type at the top of the preview window to preview your page in your
preferred browser.
Previews your page in Google Chrome

Previews your page in Mozilla Firefox

Previews your page in Internet Explorer

Previews your page in Opera

Previews your page in Safari

Previews your page in MS Edge (Windows 10 only)

Preview Website
Export and preview all the pages within your website. The pages are exported to the
same location they were last exported to (overwriting .htm files as necessary without
prompting), or to a temporary location if it has not yet been exported as a website. Then
a browser window is shown displaying the page of the website from which you launched
the preview window.
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You can also preview your website by clicking the button on the
Web toolbar.
You can navigate through the pages of your website using the
navigation 'arrow' buttons at the top of the preview window, and click
the 'home' button on the left to return to the page that was initially
viewed in the preview.
Click a browser type at the top of the preview window to preview your website in your
preferred browser.
Previews your page in Google Chrome

Previews your page in Mozilla Firefox

Previews your page in Internet Explorer

Previews your page in Opera

Previews your page in Safari

Previews your page in MS Edge (Windows 10 only)

Export Website
Also in Export toolbar.

Export the current document as HTML.

Publish Website
This performs the same operation as the button on the Web toolbar. It exports
and then publishes the current document as a website to your web space.
If you haven’t already entered the FTP details for your web space, the PUBLISH tab of the
WEB PROPERTIES dialog will be displayed first. You can then publish the website to your
web space. A progress indicator appears during the publishing operation.

Preview supersite
Preview the current print document as a supersite.
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You can also preview your page by clicking the web page preview button on the
Web toolbar.
Click a browser type at the top of the preview window to preview your page in your
preferred browser.
Previews your page in Google Chrome

Previews your page in Mozilla Firefox

Previews your page in Internet Explorer

Previews your page in Opera

Previews your page in Safari

Previews your page in MS Edge (Windows 10 only)

Export supersite
Export the current print document as a supersite. See Supersites (on page 470) for more
details.

Publish supersite
Exports and then publishes the current print document as a supersite to your web space.
If you haven’t already entered the FTP details for your web space, you will be prompted
to do so. You can then publish the supersite to your web space. A progress indicator
appears during the publishing operation.

Preview Flash
This option is only enabled when the current document is an animation document. It
exports your animation as Flash and brings up a pop-up window showing your Flash
animation running. The window also includes basic information about your Flash
animation, such as the size of the Flash file.
The button on the animation toolbar is a quicker way to invoke this operation.
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Export Animation
Also in the animation toolbar displayed under the standard toolbar in an
animation document.

Export an animation for use in a website.

Export image in slices (Ctrl+I)
This exports the selected objects as several sections (see Web Graphics (on page 576)
for more information).

Document Info
This displays an information box about the selected document. It includes a
comprehensive amount of information about the document including which fonts,
together their permissions are included, as well as which Live Effects plug-ins are used.

Page Options
Also right click and choose PAGE OPTIONS .
Allows you to edit the page layout, size, etc.

Print (Ctrl+P)
Sets options relating to printing the document and lets you print the document (refer to
Printing (on page 543) for more information).

Exit
Closes all windows and removes Designer Pro from memory. You are warned if any files
have unsaved changes.

Edit menu
Undo (Standard control bar or Ctrl+Z)
Undo the previous operation. The description of this option reflects the last operation
performed. For example, UNDO CUT (refer to Undo & Redo (on page 73)).

Redo (Standard control bar or Ctrl+Y)
Cancel the last UNDO command. The description of this option reflects the last UNDO
operation (refer to Undo & Redo).

Cut (Edit control bar or Ctrl+X)
Cut the selected object to the clipboard (refer to Object Handling (on page 76)).
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Copy (Edit control bar or Ctrl+C)
Copy the selected object to the clipboard. The object remains in place in the document
(refer to Object Handling (on page 76)).

Paste (Edit control bar or Ctrl+V)
Or right click and choose PASTE .
Paste the clipboard contents into the selected document (refer to Object Handling (on
page 76)).
Sometimes, when you paste the contents of the clipboard into a document, it could be
inserted using several different formats. If this is the case the PASTE SPECIAL dialog box
will appear so you can choose a format. See Cut Copy and Paste (on page 76) in the
Object Handling (on page 74) chapter for more detail.

Paste unformatted text
Pastes any text on the clipboard into your document without any formatting.

Paste in place (Ctrl+Shift+V)
The same as Paste, except your object will be pasted in the exact same position from
which you copied it. This is useful for moving objects from one layer or page to another,
without changing its X/Y position

Paste format/attributes (Ctrl+Shift+A)
Preserves the format (e.g., font and font size) or style attributes (e.g., line and fill color) of
the pasted object.

Paste position
This option applies the position of a copied object on the clipboard to a currently selected
object, which moves to the exact same position as the copied object.

Paste size
This option applies the size of a copied object on the clipboard to a currently selected
object, which resizes around its center to the exact size of the copied object.

Paste size and position
As the name suggests, this option applies both the size and exact position of the object
on the clipboard, to the selected object.

Paste replacing selection
This is similar to PASTE POSITION , except that the copied object on the clipboard replaces
the currently selected object and retains the deleted item's position. The copied object is
pasted into the center position of the deleted object.

639

640

Menus and Keyboard Shortcuts
Paste in current layer
The same as PASTE IN PLACE, except your object will only be pasted into the current
layer.

Paste in place in current layer
The same as PASTE IN CURRENT LAYER, except your object will be pasted into the current
layer in the exact same position from which you copied it.

Paste opacity mask (Ctrl+Shift+M)
See Opacity Masks

Paste opacity mask in place
The same as PASTE OPACITY MASK , except your opacity mask will be pasted in the exact
same position from which you copied it. This is useful for moving opacity masks from one
layer or page to another, without changing its X/Y position.

Paste on all pages
Pastes the copied object at the same size and position on all pages of the document.

Delete (Edit & Standard control bars or Delete)
Or right click and choose DELETE .
Delete the selected object (refer to Object Handling (on page 74)).

Select All (Ctrl+A)
Select all objects in editable layers (editable and locked layers are described in Layers
(on page 181)).

Clear Selection / Reset current attributes (Esc)
Deselect all objects. If nothing is selected, the current attributes (on page 102) are set
back to its default values. You can easily get this by pressing ESC twice.

Find/Replace (Ctrl+Alt+F)
Find/Replace for text objects, see chapter Text Handling, section Find & Replace (on
page 232).

Duplicate (Edit control bar or Ctrl+Alt+D)
Or right click and choose DUPLICATE .
Copy the selected object placing the copy slightly offset from the original. The copy
becomes the selected object. The offset distance can be customized (see Customizing
Designer Pro (on page 613)).
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Clone (Ctrl+K)
Like DUPLICATE copies the selected object, but places the copy directly over the original.
The copy becomes the selected object.

Pages
Or right click and choose PAGES .
The Pages submenu lets you add or remove pages from your multi-page document,
duplicate the current page or move the current page up and down. Read more on multipage documents in Multi-page Documents.

Arrange menu
Move to Layer in Front (Arrange control bar or Ctrl+Shift+U)
Or right click and choose ARRANGE > MOVE TO LAYER IN FRONT .
Move the selected object forward by one layer. The selected object becomes the back
object in the new layer. In an animation document, this option is MOVE TO NEXT FRAME .

Bring to Front (Arrange control bar or Ctrl+F)
Or right click and choose ARRANGE > BRING TO FRONT .
Move the selected object to the front of all other objects in the same layer. See Object
Handling (on page 74) for more information.

Move Forwards (Arrange control bar or Ctrl+Shift+F)
Or right click and choose ARRANGE > MOVE FORWARDS .
Move the selected object one step towards the front (refer to Object Handling (on page
74)).

Move Backwards (Arrange control bar or Ctrl+Shift+B)
Or right click and choose ARRANGE > MOVE BACKWARDS .
Move the selected object one step towards the back (refer to Object Handling (on page
74)).

Put to Back (Arrange control bar or Ctrl+B)
Or right click and choose ARRANGE > PUT TO BACK .
Move the selected object behind all others in the same layer (refer to Object Handling (on
page 74)).

641

642

Menus and Keyboard Shortcuts
Move To Layer Behind (Arrange control bar or Ctrl+Shift+D)
Or right click and choose ARRANGE > MOVE TO LAYER BEHIND .
Move the selected object one layer backwards. The selected object becomes the front
object in the new layer. In an animation document, this option is MOVE TO PREVIOUS
FRAME .

Group (Arrange control bar or Ctrl+G)
Or right click and choose GROUP .
Group the selected objects together to appear as a single object (refer to Object
Handling (on page 74)).

Ungroup (Arrange control bar or Ctrl+U)
Or right click and choose UNGROUP .
Split the group or groups into separate objects. Dimmed unless the selected object is a
group. Or, for several selected objects, there is at least one group.

Apply soft group (Ctrl+Alt+G)
Or right click and choose APPLY SOFT GROUP .
Make the selected objects form a soft group. Unlike groups, soft groups can include
objects on different layers. Refer to Object Handling (on page 98) for details.

Remove soft group (Ctrl+Alt+U)
Or right click and choose REMOVE SOFT GROUP .
Disband the selected soft group, so the objects are separately selectable objects again.

Apply/Remove ClipView (Q/Alt+Q)
This option reads:



APPLY CLIPVIEW

when there are two or more objects selected.
when there is a ClipView selected.

REMOVE CLIPVIEW

For APPLY CLIPVIEW , the rear object in the selection (the object behind the other selected
objects) 'clips' or 'masks' the other objects (the effect is similar to viewing the other
objects through a window the shape of the rear object). REMOVE CLIPVIEW removes any
clipping applied to the objects in the ClipView. See Object Handling (on page 104).

Apply opacity mask
Shortcut to quick apply an opacity mask, see Opacity masks in chapter Transparency
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Flatten photo group
Converts a photo group to a single bitmap.

Alignment (Ctrl+Shift+L)
Or right click and choose ALIGN .
Used to align several objects. Has no effect when a single object is selected (refer to
Object Handling (on page 99) for more information).

Join Shapes (Arrange control bar or Ctrl +J)
Used to create holes within shapes (refer to Shape Handling (on page 167) for more
information).

Break Shapes (Arrange control bar)
Cancels a JOIN SHAPES command (refer to Shape Handling (on page 164) for more
information).

Combine Shapes (Arrange control bar)
The Combine Shapes sub-menu lets you:






Add shapes together.
Or subtract the top shape from the other shapes.
Or discard parts of other shapes not covered by the top shape.
Or use the top shape to slice the other shapes.
Or use intersecting shapes to create slices of the grouped shapes.

Only shapes in the selection are combined. Unselected shapes do not change (refer to
chapter Shape handling (on page 164) for more information).

Convert Line to Shape
This option converts a line into a shape.

Convert to Editable Shapes (Arrange control bar Ctrl+Shift+S)
Convert predefined objects such as rectangles, ellipses, and text into shapes, i.e.
Designer Pro no longer sees them as rectangles, ellipses or text but as a collection of
straight and curved lines.

Create Bitmap Copy (Ctrl+Shift+C)
CREATE BITMAP COPY

creates a bitmap version (on page 357) of the selected objects.

Fit Text to Curve/Remove Text From Curve
Or right click and choose FIT TEXT TO CURVE/REMOVE TEXT FROM CURVE .
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Lets you fit a line of text to an arbitrary curve or remove text from a curve (see Text
Handling for more information).

Repelling and Anchoring
Or right click and choose REPEL TEXT UNDER , ANCHOR TO TEXT or REPELLING AND
ANCHORING .
Make the object repel underlying text, and anchor an object within a column of text. See
Repelling text objects (on page 237) and Anchored Graphics (on page 240) for details.

Create Navigation Bar
This command allows you to create a navigation bar from a single button. Read more in
chapter Navigation bars (on page 484).

Repeating object
The Repeating object sub-menu lets you:


REPEAT ON ALL PAGES (SHIFT+CTRL+ALT+R)

The selected object will be copied to the

same place on all pages.


Turns off the repeating nature of the object either for the selected object only, or all copies of the object.
STOP REPEATING (SHIFT+CTRL+ALT+O)

See Repeating objects (on page 106) for more information.

Live copy
The LIVE COPY sub-menu lets you:


CREATE LIVE COPY (SHIFT+CTLR+ALT+C) -

the selected object is turned into an instance

of a live copy


turns off the the live copy object, either for the selected object only,
or all copies of the object.
STOP LIVE COPY -

See Live Copies (on page 109) for more information.

Insert menu
From Content Catalog (Shift+Alt+I)
Opens the Online Content Catalog. Choose templates, widgets and clipart from the
catalog's web, layout and photo and graphic categories.

Image
 From file - browse your computer to load an image file into the selected document.
 From Web address - extracts all images from a specified web site. (Ctrl+Alt+W)
 Screen Capture - Opens the Screen Capture Tool (on page 345).

Menus and Keyboard Shortcuts
 From Camera - Detects a web camera or other Windows associated video capture
device attached to your computer and inserts a still image into the document.

Shape










Rectangle - inserts a rectangle into the current document (Shift+R)
Ellipse - inserts an ellipse into the current document (Shift+Ctrl+Alt+E)
Spiral - inserts a spiral into the current document
More Shapes - opens the Other Shapes section of Smart Shapes in the Online
Content Catalog
Arrows - opens the Arrows section of Smart Shapes in the Online Content Catalog
Text Panel - inserts a text panel into the current document (Shift+C)
Photo text panel - inserts a Photo text panel into the current document
More Text Panels - opens the Text Panels section of the Online Content Catalog
Speech Bubble - inserts a speech bubble into the current document

See Shape Handling (on page 152) for more information.

Text Box
Inserts a text box into the current document.

Symbol
Inserts a Symbol (on page 215) into your document either as a character font or as a
shape.

Charts
Opens the Charts section of the ONLINE CONTENT CATALOG.

New Page
 New blank page - inserts a new blank page into the document after the current or
selected page.
 Duplicate page - inserts a duplicate page into the document after the current or
selected page.
 From Content Catalog - opens the Online Content Catalog

Page number
Inserts a page number and specifies its position. See Adding page numbers (on page
261) for more info.

Rule-off
Inserts a rule at the text carat. The rule can be modified using the Freehand and Brush
Tool

Lorem Ipsum Text
Inserts a block of dummy Lorem Ipsum text at the text carat position. Alternatively use
the shortcut Ctrl + Shift + L.
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Table of Contents...
Builds a table of contents (TOC) automatically and inserts it at the text caret.

Break
Use BREAK to split the text according to the following options.






MOVE TO NEXT PAGE (CTRL + ENTER)
MOVE TO NEXT PAGE (LEFT) -

in double page spreads
in double page spreads

MOVE TO NEXT PAGE (RIGHT) -

MOVE TO NEXT COLUMN (CTRL + SHIFT + ENTER)
MOVE BELOW EMBEDDED GRAPHIC

Utilities menu
Galleries
Color Gallery (Galleries control bar or F9)
Displays or hides the COLOR GALLERY (see Color Handling (on page 189)).

Page & Layer Gallery (Galleries control bar or F10)
Displays or hides the PAGE & LAYER GALLERY . Only used in non-animation documents
(see Layers (on page 181)).

Bitmap Gallery (Galleries control bar or F11)
Displays or hides the BITMAP GALLERY (see Bitmap Handling (on page 331)).

Line Gallery (Galleries control bar or Shift+F12)
Displays or hides the LINE GALLERY (see Drawing Lines (on page 144)).

Fonts Gallery (Galleries control bar or Shift+F9)
Displays or hides the FONTS GALLERY (see Text Handling (on page 209)).

Designs Gallery (Galleries control bar or Shift+F10)
Displays or hides the DESIGNS GALLERY (see Importing and Exporting (on page 562)).

Fill Gallery (Galleries control bar or Shift+F11)
Displays or hides the FILL GALLERY (see Bitmap Handling (on page 331)).

Frame Gallery (Galleries control bar or Shift+F12)
Displays or hides the FRAME GALLERY . Only used in animation documents (see Web
Graphics).

Menus and Keyboard Shortcuts
Name Gallery (Galleries control bar or Ctrl+Shift+F9)
Displays or hides the NAME GALLERY (see Document Handling (on page 68)).

Color Editor (Ctrl+E)
Or right click and choose FILL COLOR .
Opens the COLOR EDITOR (refer to Color Handling).

Names
Or right click and choose NAMES .
Opens the Apply/remove names dialog (on page 70).

Imagesetting
See Imagesetting (on page 551) for details.

Web Properties (Ctrl+Shift+W)
Opens the WEB PROPERTIES dialog, which allows web features such as links, popup
layers, anchors, etc. to be added to your document.
See Web Properties Dialog (on page 445) for details!

Website Variants






Allows the selected object to be shared with all variants, if
the object is not available to be shared then there is an option to create a non-shared
copy of the object in the other variants.
DELETE FROM ALL VARIANTS: Deletes the selected object from all variants.
STOP SHARING WITH VARIANTS: Stops the selected object being shared with all variants.
COPY PAGE TO ALL VARIANTS: Copies a selected page to all variants.
WEBSITE VARIANTS: Opens the Website Variants (on page 411) dialog.
SHARE WITH ALL VARIANTS:

Bitmap-Editor
When a bitmap is selected, this opens the BITMAP EDITOR . In the Program Options
("Utilities -> Options -> Effects & Plug-ins Tab") you can also choose the enclosed
MAGIX Photo Designer 7 or any other program for bitmap editing. For further information
on the bitmap editor, read the program help or the electronic manual (PDF) of the
according program.

Optimize Photo
Or right click and choose OPTIMIZE PHOTO .
Optimize bitmap resolution for use in Xara Designer Pro X designs. See Photo
Optimization (on page 354) for details.
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Optimize all Images
Optimizes all photos and bitmaps in the design. See Photo Optimization (on page 354).

Bitmap Tracer
Opens the TRACER dialog box (see Bitmap Handling (on page 360)).

Animation
This menu is only available in animation documents and offers three choices:


ANIMATION PROPERTIES :

With this dialog box you can change the options for the
animation and for each frame.
 PREVIEW ALL FRAMES : Use this to preview all the frames of your animation. This is not
very useful for Flash animations as it shows only the key frames with no tweening.
 PREVIEW GIF ANIMATION IN BROWSER: This item creates an animated GIF file from the
frames in your document and opens it in your web browser so you can see what it
looks like. There is a button on the animation bar for quick access to this operation.
 PREVIEW FLASH ANIMATION IN BROWSER: Pops up a window displaying your animation
as Flash, as it will appear in a web browser when you export. Use this to preview
Flash animations. There is a button on the animation bar for quick access to this
operation.

Screen Capture
Open the Screen Capture Tool (on page 345).

Check spelling as you type
This option activates the SPELL CHECKER (on page 228) in the TEXT TOOL .

Customize Key Shortcuts
This command allows you to change the keyboard shortcuts. See Integrated key shortcut
utility (on page 658) in Menus and Keyboard shortcuts for details.

Auto-Fit to page...
Open the Auto-fit to Page... (on page 111) dialog.

Options (Ctrl+Shift+O)
Or right click and choose PAGE OPTIONS .
Opens the OPTIONS dialog box (described in Customizing Designer Pro (on page 607)).

Share Menu
If you have compatible MAGIX and other applications installed, the Share menu will
include options to send the selected image to those applications.

Menus and Keyboard Shortcuts
Window menu
Show Mask or Region (Standard control bar or Ctrl+M)
Toggle the visibility of the current mask or region. See Masks & Regions (on page 307)
for details!

Invert Mask or Region (Ctrl+Shift+I)
Inverts the current mask or region. See the Masks (on page 307) chapter for details!

Clear Mask or Region (Ctrl+D)
Deletes the current mask or region. See the Masks (on page 307) chapter for details!

Clear Selection / Reset current attributes (Esc)
Deselect all objects. If nothing is selected, the current attributes (on page 102) are set
back to its default values. You can easily get this by pressing ESC twice.

Multiple Page View
Or right click and choose MULTIPLE PAGE VIEW .
By default Designer Pro shows only the current page of the currently open document.
Choosing multiple page view shows all the pages in your document.

New View
Opens a new window onto the selected document.

Arrange Views
Displays all Designer Pro windows as tiles.

Cascade
Displays all Designer Pro windows stacked behind each other so that the title bars are
visible.

Arrange Icons
Tidies up any icons for minimized Designer Pro windows.

Control Bars
Displays the CONTROL BARS dialog box (described in Customizing Designer Pro (on page
629)).

Bars
Menu entries to switch on and off the most important control bars.
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Quality (Standard control bar)
Selects how objects are displayed from wire frame to anti-aliased (see Document
Handling (on page 58)).

Show Printer Colors
Allows you to simulate what the document will look like when printed. This doesn't alter
your document, and is just a different way of viewing it on screen.
In Xara Designer Pro & Photo & Graphic Designer you can also show CMYK color
separations (on page 551) here.

Show Document Tabs
Toggles display of the document tabs that provide quick access to each open document
at the top of the Designer Pro window.
Clicking on a tab makes that document the selected document. A "*" after the document
name indicates that it currently has unsaved changes.

Full Screen (8 on numeric keypad)
Toggles between full-screen and normal screen modes.

Show Grid (#)
Or right click and choose SHOW GRID/GUIDES > SHOW GRID .
Makes the on-screen grid visible (see Document Handling (on page 54)).

Show Guides (1 on numeric keypad)
Or right click and choose SHOW GRID/GUIDES > SHOW GUIDES .
Displays or hides the Guides layer which contains all guidelines and guide objects.

Show Print Borders
Most printers have a non-printing margin (the print border) around the edge of the paper.
With SHOW PRINT BORDERS selected two rectangles are displayed on screen. One shows
the edge of the paper, the other shows the printable area.

Snap to Grid (. on numeric keypad)
Or right click and choose SNAP TO > SNAP TO GRID .
With this option set, an object snaps to any grid point it is dragged close to (see
Document Handling (on page 32)).

Snap to Guides (2 on numeric keypad)
Or right click and choose SNAP TO > SNAP TO GUIDES .

Menus and Keyboard Shortcuts
With this option set, an object snaps to any guide it is dragged close to (see Object
Handling (on page 74)).

Snap to Objects (* on numeric keypad)
Or right click and choose SNAP TO > SNAP TO OBJECTS .
With this option selected, dragging a handle close to another object snaps the handle to
the object; see Object Handling (on page 74) for more details. You can also adjust the
snapping distance; see Customizing Designer Pro (on page 607) for more details.

Documents Loaded
A list of the currently open documents. Clicking on a name makes that document the
selected document ("Ctrl + F6" also switches between open documents). A "*" after the
document name indicates that it currently has unsaved changes.

Help menu
Xara Designer Pro X help
Use the command <PROGRAMMNAME > HELP in the HELP menu to open the start page of
the program Help. Here you can work through the Help step-by-step and jump to specific
sections via the tree structure on the left-hand side.

Help
This command is available at almost every point of this program and opens the program
Help at the corresponding topic. Use this command to get help on any function of Xara
Designer Pro X.
Shortcut:

F1

Introductions...
Opens the Online Content Catalog at the "FIRST LOOK" > "INTRODUCTION" folder. This
folder contains the Introductory tutorial documents that appear when you first load
Designer Pro.

Movies
A list of movies to help you make the most out of Designer Pro.

More Designer Pro
In this menu there are useful internet links to Xara’s website and useful online resources.

Tip of the Day
See the tip of the day. There is also a check box below the Tip of the Day where you
select whether or not you see a tip each time you start Designer Pro.
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Register
"Help -> Register" allows you to register your Xara Designer Pro X software.
You will normally only see this option if you are installing from CD for the first time. The
register option allows you to register your software if you purchased your CD from
somewhere other than Xara, for example, from a reseller. If you purchased the software
from Xara directly, and/or registered in the past, you can click "Register Now" to stop any
further registration messages appearing.

Check for updates
Opens a dialog box giving you access to TalkGraphics, The Outsider
http://www.xara.com/outsider/, The XaraXone, The Xara Gallery
http://www.xara.com/gallery/, and the Support http://support.magix.net site.

Affiliate program
If you didn’t sign up for the affiliate program when you unlocked Xara Designer Pro X,
you can use this option to join the program or to change the affiliate option you chose
previously. Select this option to bring up the affiliate dialog, which tells you all about the
affiliate program. You can start earning commission from your Xara Designer Pro X
website, or have it donated to charity, just by choosing from the three options shown in
the dialog.

Download content installer
This option is only available after purchasing and activating the trial version of this
program. It downloads additional content that’s not included in the trial installer, such as
Live Effect plug-ins, fonts for the Fonts Gallery, fills for the Fills gallery and spell-checker
dictionaries for other languages.

Info pop-ups
At several places in Designer Pro, when you chose a specific tool, introductory usage
hints are displayed in a pop-up message. You can disable each pop-up by checking
DON'T SHOW ME AGAIN in the message window. With TURN ALL ON all messages are
enabled again, with TURN ALL OFF all messages are turned off.

About Xara Designer Pro X
Displays copyright info and version number of Xara Designer Pro X.
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Key shortcuts
Summary of shortcuts on the numeric keypad
+
/

Makes a copy while dragging, resizing, skewing, and so on. The original object
doesn‘t change.
Toggles leaving line widths unchanged during scaling and scaling with changing
line widths.

-

Toggles leaving fills unchanged during moves, scaling, skewing, etc.

*

Toggles object magnetic snap on and off.
Toggles snap to guides on and off.
Toggles snap to grid on and off.

2
.

The tools
Selector Tool
Region Painter Tool
Freehand Region Tool
Rectangle Region Tool
Mask Painter Tool
Invert region or mask
Show/hide region or mask

F2 or V or Alt + S
Alt + F3
Alt + F5
Alt + F6
Alt + F7
Ctrl + F1
Ctrl + H

Clear region or mask

Alt + F1

Freehand & Brush Tool
Shape Tool
Erase background
Rectangle Tool
Ellipse Tool
QuickShape Tool
Text Tool
Fill Tool
Transparency Tool
Shadow Tool
Bevel Tool
Contour Tool
Blend Tool
Mold Tool
Live Effects Tool
Photo Tool
Extrude Tool
Push Tool

F3 or N
F4
Ctrl + Shift + Alt + P
Shift + F3 or M
Shift + F4 or L
Shift + F2
F8 or T
G
F6
Ctrl + F2
Ctrl + F3
Ctrl + F7
F7 or W
Shift + F6
Ctrl + F5
P
E
Shift + F8 or H or Alt + X (or the Space bar
when not in the Text Tool)
Shift + F7 or Z or Alt + Z

Zoom Tool
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The galleries
Fonts Gallery
Clipart Gallery
Fill Gallery
Frame Gallery
Color Gallery
Page & Layer Gallery
Bitmap Gallery
Line Gallery
Name Gallery

Shift + F9
Shift + F10
Shift + F11
Shift + F12
F9
F10
F11
Ctrl + F9
Ctrl + Shift + F9

Zooming
Previous zoom
Zoom to selection
Zoom to drawing
Zoom to page
Zoom in (enlarge)
Zoom out (reduce)
Zoom to 100%
Zoom to 200%
Zoom to 300%
Zoom to 400%
Zoom to 50%

Ctrl + R
Ctrl + Shift + Z
Ctrl + Shift + J
Ctrl + Shift + P
Ctrl + + on the numeric keypad
Ctrl + - on the numeric keypad
1
2
3
4
5

You can also zoom and slide the document using a mouse-wheel (Ctrl+Mouse-Wheel
zooms in/out).

Manipulating documents
When in the Text Tool, shortcuts marked with a star (*) have a different action-see below.
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New document
New animation document
Web animation dialog
Open document
Close document
Switch document
Print document
Save document
Import
Import graphics from Web
Add Google fonts

Ctrl + N
Ctrl + Shift + N
Ctrl+Shift+Alt+N
Ctrl + O
Ctrl + W*
Ctrl + Tab
Ctrl + P
Ctrl + S
Ctrl + Alt + I
Ctrl + Alt + W
Ctrl + Shift + Alt + W

Export
Time a document redraw
Show grid
Show guides
Snap to grid
Snap to guides
Snap to objects
Select full screen
Show rulers
Undo
Redo

Ctrl + Shift + E
Ctrl + Shift + T
#
1 on numeric keypad
. on the numeric keypad
2 on the numeric keypad
* on the numeric keypad
8 on the numeric keypad
Ctrl + Shift + R or Ctrl + L*
Ctrl + Z or < or ,
Ctrl + Y or > or .

Manipulating objects
When in the Text Tool, shortcuts marked with a star (*) have a different action-see below.
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Select all
Select next object
Delete the selection
Clear selection/Reset current attributes
Bring object to front
Put object to back
Move object forwards
Move object backwards
Move object to layer in front (drawing documents)
Move object to layer behind (drawing documents)
Move to next frame (animation documents)
Move to previous frame (animation documents)
Group objects
Ungroup objects
Apply Soft Group
Remove Soft Group
Clone object
Duplicate object with offset
Copy object to clipboard
Cut selection to clipboard
Paste object from clipboard
Paste object in original position
Paste opacity mask
Paste attributes
Create bitmap copy
Export sliced image
Add shapes
Subtract shapes
Intersect shapes
Intersect all shapes
Slice shapes
Join Shapes
Apply ClipView
Remove ClipView
Create opacity mask
Ungroup opacity mask
Convert to editable shapes
Open the alignment dialog box
Web address
Repeat on all pages
Stop repeating

Ctrl + A *
Tab
Delete *
Esc
Ctrl + F
Ctrl + B *
Ctrl + Shift + F
Ctrl + Shift + B
Ctrl + Shift + U
Ctrl + Shift + D
Ctrl + Shift + U
Ctrl + Shift + D
Ctrl + G
Ctrl + U
Ctrl + Shift + G
Ctrl + Shift + U
Ctrl + K
Ctrl + Alt+ D
Ctrl + C
Ctrl + X
Ctrl + V
Ctrl + Shift + V
Ctrl + Shift + M
Ctrl + Shift + A
Ctrl + Shift + C
Ctrl + I *
Ctrl + 1
Ctrl + 2
Ctrl + 3
Ctrl + 5
Ctrl + 4
Ctrl + J
Q
Alt + Q
O
Alt + O
Ctrl + Shift + S
Ctrl + Shift + L*
Ctrl + Shift + W
Ctrl + Shift + Alt + R
Ctrl + Shift + Alt + O

Move the selected objects cursor (arrow) keys with the Selector Tool (see Nudging
objects (on page 75) )
Move the selected handles cursors (arrow) keys in tools other than the selector.
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Text Tool
Cursor keys
Home
End
Ctrl + left/right cursor
Ctrl + Home
Ctrl + End
Ctrl + A
Ctrl + B
Ctrl + I
Ctrl + C
Ctrl + L
Ctrl + Return
Ctrl + Shift + Return
Ctrl + Shift + L
Ctrl + V
Ctrl + W
Ctrl + Shift + F1
Ctrl + Ctrl + Shift + Ctrl + <
Ctrl + >
Alt + cursor keys

Delete

Backspace

Shift + cursor keys
Shift + End

Move the text cursor up up, down, left or right
one character at a time.
Move the text cursor to the start of the line.
Move the text cursor to the end of the line.
Move the text cursor left/right one word.
Move the text cursor to the start of the first line in a text
object.
Move the text cursor to the end of the last line in a text
object.
Selects all characters in a text object.
Apply the bold attribute.
Apply the italic attribute.
Copy the selected region of text to the clipboard.
Select all characters in the line containing the text cursor.
Insert page break
Insert column break
Insert 'Lorem ipsum' dummy text
Paste text at the text cursor position (if the clipboard
contains text).
Swap the case of the character to the right of the text cursor.
Toggle text selection between uppercase and lowercase.
Insert Soft Hyphen (appears only when wrapping at line
end).
Insert hard hyphen (dash) to prevent a dash being
misinterpreted as a hyphen at line end.
Increase/Decrease font size of selected text (only if the
selection is all the same point size)
Increase/Decrease kerning/tracking.
Start a new line of text.
Delete the character to the right of the text cursor. If the
cursor is on the end of a text line, join this line to the line
below.
Delete the character to the left of the text cursor. If the
cursor is at the start of a text line, join this line to the line
above.
Select all text between the cursor position and the beginning
of the line.
Select all text between the cursor position and the end of the
line.
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Integrated key shortcut utility
Special characters (in Text Tool)
Ctrl + Space
Ctrl + NumPad –

–

Ctrl + Alt + NumPad –
Ctrl + Alt +.(Full stop)
Ctrl + Alt + C
Ctrl + Alt + R
Ctrl + Alt + T
Ctrl + Alt + B

—
…
©
®
™
•

Hard space (words with hard spaces
between will not wrap at the end of a line)
EN dash (An EN dash is longer than a
minus, and is a more correct ‘dash’)
EM dash (An EM dash is a long dash)
Ellipsis (An ellipsis is three dots)
Copyright
Registered
Trademark
Bullet

Feather Tool
You can control the feather slider with your mouse and keyboard. When the feather text
box or slider are selected:
Mouse wheel up/down
Ctrl + Mouse wheel up/down
Page up/page down keys
Home/end keys

select

increases or decreases feathering
increases or decreases in larger
increments.
increases or decreases in larger
increments.
minimum or maximum feather values.

Other
Color Editor
Options dialog
Xara Designer Pro X Help

Ctrl + E (opens and closes)
Ctrl + Shift + O
F1

Integrated key shortcut utility
This utility provides an easy and direct way to configure key shortcuts. It allows you to
define a shortcut for a command which doesn't have a shortcut by default, or to change a
command's shortcut.

Integrated key shortcut utility
To open the Shortcut Tool, select CUSTOMIZE KEY SHORTCUTS... from the UTILITIES menu.

Command categories
There are many different commands which can be assigned to shortcuts and so they are
split into several categories to help finding a command easier. The command categories
are presented in a dropdown list and the "Commands" list below it lists all the commands
in that category. Many categories correspond with the name of a menu (e.g. File, Edit,
Arrange), so finding a command that is on one of the menus is easy. Choose "All" to
display all available commands in the Commands list.

Commands
The Commands list shows all the commands for the selected category. Where a
command already has a key shortcut, that shortcut is shown in the column to the right of
the command name. Those commands that don't have any shortcut assigned show
nothing in the shortcut column.
If a command has more than one shortcut assigned, then that command will appear
more than once in the list of commands, once for each of its shortcuts.
To assign an additional shortcut to a command which already has a shortcut, select the
command in the list and press the ADD SHORTCUT button.
Press the REMOVE SHORTCUT button below the Commands list to remove the selected
shortcut assignment from the list.
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Integrated key shortcut utility
Key press
Once you've selected a command in the Commands list, assigning a shortcut key to it is
easy. Simply press the key combination that you wish to use for the selected command.
The keypress you choose will then appear in the Keypress field on the Shortcuts Tool
dialog. Note that if the selected command already had a shortcut shown in the
Commands list, that shor-cut is replaced by your new keypress.
If you want to add an additional shortcut, first use the ADD SHORTCUT button under the
Commands list as described in the Commands section above.
Pressing the CLEAR button below the Keypress field removes the shortcut for the
selected command and clears the Keypress field.
After entering a new keypress, check the CLASHES list which is shown below the
Keypress field.

Clashes
A keypress can be used as a shortcut for one command only. If the keypress you chose
for a command shortcut is already assigned to another command, the CLASHES list will
show you this and will allow you to quickly resolve the clash.
If there is more than one command currently associated with the keypress shown in the
Keypress field, the Clashes list shows you all the commands that are currently assigned
to it. You need to remove all but one of the shortcut assignments for the keypress so that
only one command is associated with it.
To do this simply select one of the clashing assignments shown in the Clashes list and
then press the REMOVE CLASH button below it to remove the shortcut assignment.
Once only two assignments are shown in the Clashes list, deleting one of them will leave
you with an empty Clashes list, because there is then only one assignment for the
keypress and so there are no longer any clashes.
Alternatively you may wish to change the shortcut associated with one of the clashing
commands. To do this, select the shortcut in the Clashes list and click the EDIT CLASH
button below it. This automatically locates the command and selects it in the Commands
list on the left, ready for you to define a new keypress for it. Once it's selected, enter the
keypress that you want to use for that command and once again resolve any clashes
shown in the Clashes list.
Once the Clashes list is empty, your new keypress is defined as a shortcut. You can then
either select other commands to which you want to assign shortcuts or commit your
shortcuts changes by pressing OK . You don't need to keep track of all the clashes as you
change shortcuts because when you click OK to commit your changes a check is done to
make sure no clashes remain.

Integrated key shortcut utility
Standard keys / Classic keys
At any time you can press STANDARD KEYS to set all the command shortcuts back to the
default settings for Xara Designer Pro X.
Alternatively press Classic Keys to reset to a keyset that was used by early versions of
Xara Designer Pro X. Over time, as the product has evolved, various standard shortcuts
that are commonly used by other applications have been adopted by Xara Designer Pro
X. Those who have become familiar with Xara’s original shortcuts may prefer to use the
‘classic’ defaults instead.

Save
Use the SAVE button to save the current shortcut definitions as a ".ini" file, without
necessarily applying them so they are used by Xara Designer Pro X you to setup
different sets of shortcut assignments and allows you to share the assignments between
different computers or different users. For example, you could setup shortcut
assignments that make Designer Pro compatible with the shortcuts of another application
and save them in a .ini file so you can share them.

Load
Use the LOAD button to load the shortcuts defined in a .ini file. Once they are loaded, you
can inspect or modify them in the Shortcuts Tool or apply them to Xara Designer Pro X
OK button.

Cancel
Press the CANCEL button to discard all the shortcuts changes you have made since you
opened the Shortcuts Tool.

OK
Use the OK button to commit the changes you have made since you opened the
Shortcuts Tool. If there are any unresolved clashes, you will be told about them at this
point. You are strongly advised to go back and fix any clashes because otherwise your
chosen shortcuts may not work. Click the Back button on the warning alert to go back.
When you do this the first keypress with clashes is automatically selected for you, so you
can quickly resolve it.
If no clashes are reported when you click the OK button, your new shortcuts have been
defined successfully.
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Integrated key shortcut utility
Example
Here's an example of the process you would go through if you wanted to use "Ctrl + P" to
bring up the Print Options dialog.

1.
2.
3.
4.
5.
6.
7.
8.

Bring up the Shortcuts Tool dialog by choosing "Utilities -> Customize Key
Shortcuts".
The Print Options command is in the File menu, so choose the "File" category from
the Commands category list.
Select the Print Options command in the list of commands.
Press "Ctrl + P". You'll see "Ctrl + P" appear in the Keypress field. Also the "Print
Options..." command is now shown as having the "Ctrl + P" shortcut in the
Commands list.
You can also see that a clash has been identified. The Clashes list shows that CtrlP is now assigned to BOTH "Print..." and "Print Options...".
Select "Print..." in the Clashes list and then click the button below it to remove this
shortcut. This eliminates the clash.
Now the Clashes list is empty, indicating that there are no clashes for "Ctrl + P".

Now when you press "Ctrl + P" the Print Options dialog appears.

Temporary key shortcuts
Three of the most commonly used tools (Selector, Push and Zoom) have special
shortcuts that allow quick temporary selection of the tool, and then return to the
previously used tool after use.
What’s more these shortcuts can be used two ways; either as a toggle (press the key
once and it selects the tool, press it again and it returns to the previous) or as a
temporary switch (hold key down and it switches to the tool, and release key to return to
the previous tool).
The default key shortcuts for these tools are:
 "Alt + Z" for Zoom.
 Space or "Alt + X" for Push.
 "Alt + S" for Selector Tool.
These key combinations are deliberately chosen to be near the left hand to make very
easy selection.
Note: If you have a mouse with a scroll wheel or center button, there is a better
temporary shortcut to the Push Tool, namely to press and hold the wheel or button.
Release it to return to the previous tool.

Integrated key shortcut utility
These three commands are listed at the top of the Tool group and described as Switch to
Push tool (Hold Down to Switch and Return), etc. (you can see the full description of the
command in the Status line).
Tip: Long term users of Xara Designer Pro X will notice that the space bar no longer acts
as a temporary Select Tool. This was changed to get a greater workflow compatibility
with Adobe software and MAGIX Photo Designer 7 users will be used to using the space
bar as a temporary Push Tool (although we believe the mouse button short cut is much
better and is a more standard Windows shortcut— see note above).
Long-term users can quickly reconfigure the Spacebar to activate the Selector tool, and
restore several other back-compatible key shortcuts, by clicking the "CLASSIC KEYS"
button. Note that this will reset all your current shortcuts and so we recommend that you
save your current set first by using the "SAVE..." option.
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More about Xara Group

More about Xara Group
About Xara Group Ltd.

Xara is one of the oldest software developers in the UK, with an
uninterrupted history of innovation dating back to 1981.
From Wordwise, one of the earliest microcomputer word processors, to Xara Designer,
the world's fastest, and many believe the world's best drawing and illustration software,
Xara has developed a wide range of products covering the whole realm of publishing
software. Xara has pioneered many technologies taken for granted nowadays. From
developing the world's first check-as-you-type spell checker, to award winning desktoppublishing software, to the first drawing software to provide real-time anti-aliasing and
transparency control, Xara continues to innovate and develop leading edge technical
solutions.
Xara's first Windows illustration software, Xara Studio, was licensed to Corel and
distributed for many years as CorelXARA. Now back under Xara control this product has
been enhanced and relaunched and is now sold in two versions, Xara Photo & Graphic
Designer and Xara Designer Pro, and also forms the basis for Xara Web Designer.
Xara has been involved in the Internet from the very beginning. Xara Networks, a
subsidiary of the Xara Group, was a pioneer Internet provider in the mid 1990s
(subsequently sold). Another early innovation was Xara Online, which provided online
Web Service based web graphic and photo effect add-ons. Xara's most recent
development is Xara Online Designer https://xara.cloud/, a cloud based service which
offers the ability to design rich documents in the web browser, using any device, and in
collaboration with colleagues. Today Xara does all of its business via the web, and has
millions of online customers, worldwide.
Xara is headquartered in the historic house, Gaddesden Place, in the UK, north of
London. You can find details of the many products developed since 1981 here.
In January 2007 Xara was acquired by MAGIX AG and benefits from a distribution
partnership with another wholly owned subsidiary MAGIX Software GmbH. MAGIX has
been a leading international provider of high-quality software, online services and digital
contents for multimedia communications since 1993. Internationally, MAGIX operates

Legal
from branches in the USA, Canada, the UK, Germany, France, Italy and the Netherlands.
The MAGIX product range is targeted towards laymen and professionals alike and goes
beyond the PC range to include seamlessly integrated online and mobile applications.
According to its retail sales figures, MAGIX leads in the multimedia software sector in the
most important European markets, and is one of the most successful competitors in the
USA
Web Links
Xara Home Page - http://www.xara.com
MAGIX Home Page – http://www.magix.com

Legal
Copyright
This documentation is protected by law. All rights, especially the right of duplication,
circulation, and translation are reserved.
No part of this publication may be reproduced in form of copies, microfilms or other
processes, or transmitted into a language used for machines, especially data processing
machines, without the express written consent of the publisher.
All copyrights reserved.
All other product names are trademarks of the corresponding manufacturers. Errors in
and changes to the contents as well as program modifications reserved.
Xara is a registered trademark of Xara Group Ltd.
Xara Group Ltd. is an affiliate company of MAGIX Software GmbH.
MAGIX is a registered trademark of MAGIX Software GmbH.
Other mentioned product names may be registered trademarks of the respective
manufacturer.
This product uses MAGIX patent pending technology.
Copyright © Xara Group Ltd., 1994 - 2017 All rights reserved.
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Our thanks to Alan Burns, Paul Shotan, William Clegg, Gary Bouton,Vladimir
Konstantinovich, Simone Pampado, Andy Jeffery, Dusan Kastelic, and Martin Preismann
among many other individuals who have contributed artwork to the Example Illustrations.
The Geotype font is provided by kind permission of Gary Bouton and remain © Gary
Bouton, see www.theboutons.com. Some fonts copyright © FontBank Inc., all rights
reserved. Other fonts are provided by third parties who retain the copyright.
Xara Designer Pro X uses Font Awesome by Dan Gandy – http://fontawesome.io
http://fontawesome.io
Xara is a trademark of Xara Group Ltd. The contents of this documentation and the
associated Xara Designer Pro X software are the property of Xara Group Ltd and are
copyrighted. Any reproduction in whole or in part is strictly prohibited.
PDFNet SDK is copyright PDFTron TM Systems., 2002-2005, and distributed by Xara
Group Ltd under license. All rights reserved.
Redistributable portions of Microsoft MSVC and MFC are copyright of Microsoft
Corporation. Microsoft, Internet Explorer, Windows and Windows Vista are either
trademarks or registered trademarks of Microsoft Corporation in the United States and/or
other countries.
Adobe, Encapsulated PostScript, Illustrator, Photoshop, Dreamweaver, Fireworks,
Freehand, Flash, PostScript and Type Manager and are either registered trademarks or
trademarks of Adobe Systems Incorporated in the United States and/or other countries.
PANTONE® and other Pantone trademarks are the property of Pantone LLC.
MAGIX is a registered trademark of MAGIX GmbH & Co.
Apple, Macintosh, Retina and TrueType are registered trademarks of Apple Computer,
Inc.
Corel, CorelDRAW and Paintshop Pro are either registered trademarks or trademarks of
Corel Corporation.
Xara Designer Pro X uses the Google Web Fonts API
Xara Designer Pro X uses the FontForge library fontforge.github.io/en-US/
http://fontforge.github.io/en-US/. A copy of the FontForge license is included in
FontForgeLicense.txt in the HelpAndSupport folder of your program installation
Xara Designer Pro X includes MiniWeb HTTP server, available under LGPL from here:
(http://www.sourceforge.net/projects/miniweb/)

Legal
Xara Designer Pro X uses the Mersenne Twister random number generator , Copyright
(C) 1997 - 2002, Makoto Matsumoto and Takuji Nishimura, and 2000 - 2003, Richard J.
Wagner. All rights reserved. Further copyright information can be found in the
MTRand.txt file located in the HelpAndSupport folder of your Designer Pro installation.
Some program code is Copyright (c) 1996 Silicon Graphics Computer Systems, Inc.
Further copyright information can be found in the sg.txt HelpAndSupport folder of your
Designer Pro installation.
Some program code is Copyright (c) 1994 Hewlett-Packard Company. Further copyright
information can be found in the hp.txt HelpAndSupport folder of your Designer Pro
installation.
This software is based in part on the work of the Independent JPEG Group.
Some import and export filters (including PDF) utilize color profiles from Adobe Systems
Inc. The license agreement can be found in the Filters\pdfxfilter\icc folder of your
Designer Proinstallation.
Designer Pro’s PDF Import function uses a separate pdf2xar conversion program, which
itself uses the open source Poppler library (http://poppler.freedesktop.org/
http://poppler.freedesktop.org/). The source for pdf2xar is released by Xara as open
source and is available from http://www.xara.com/pdf-import/.
Xara Designer Pro X uses the zlib compression library www.zlib.net
Xara Designer Pro X uses the ImageMagick library Copyright 1999-2007 ImageMagick
Studio LLC http://www.imagemagick.org. A copy of the ImageMagick license is included
in ImageMagick.txt in the HelpAndSupport folder of your Designer Pro installation.
Designer Pro's spell checker is based on the Open Source Hunspell library used without
any modifications under the Mozilla Public License Version 1.1. You can find a copy of
the Mozilla Public License in the file MPL-1.1.txt in the "dict" folder of your Designer Pro
installation and a copy of the Hunspell source code at http://hunspell.sourceforge.net/
http://hunspell.sourceforge.net/. The Xara Designer Pro X distribution includes various
language dictionaries which are distributed under various different licenses, for use with
the spell checker. See the text files in the "dict" folder of your Designer Pro installation for
details of each license. The Russian dictionary is Copyright (c) 1997-2008, Alexander I.
Lebedev. See README_ru_RU.txt in the “dict” folder of your program installation for
details and license.
Perspective correction photo tool based on ShiftN technology provided by Marcus Hebel,
http://www.shiftn.de: ShiftN version 3.5, May 2009.
Xara Designer Pro X uses the libcurl library curl.haxx.se/libcurl
http://www.curl.haxx.se/libcurl for FTP publishing. A copy of the license for this library is
included in libcurl.txt in the HelpAndSupport folder of your Xara Designer Pro X
installation.
Mehdi plugins © Guessous Mehdi , Redfield plugins © John Redfield.
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3D color editor
3D Extrude Tool

195
406

A
About Presentations
About RWD
About Supersites
About Xara Designer Pro X
About Xara Group Ltd.
Accelerating and Decelerating
Accuracy
Acknowledgements
Adding & editing buttons
Adding a new point handle
Adding arrowheads & tails
Adding code to page head
Adding Hyperlinks
Adding menus and sub-menus
Adding names
Adding new presentation pages
Adding page numbers
Adding Pages
Adding to a gallery
Adding widget placeholders manually
Adjust button widths to labels
Adjusting a photo in its frame
Adjusting brightness
Adjusting painted effects
Adjusting the clip region
Adjusting the left and right margin of text on a curve
Adjusting tolerance and fade
Advanced
Advanced - Editing a Navbar button design
Advanced Flash Commands
Advanced Levels - The Green Line
Advanced options
Advanced presentation information
Advanced text properties
Affiliate program
Aligning

498
410
470
15, 652
664
541
362
666
489
137
132
467
120
490
71
505
261
606
67
517
486
604
392
381
376
226
374
110
494
541
394
291
508
265
652
101

Index
Alignment
Alignment (Ctrl+Shift+L)
All buttons the same width
Alt + S
Alternative Content Aware Scaling
An Example Using a Photo Region
Analytics Tab
Anchored Graphics
Angle constraint
Animated GIFs
Animation
Animation Frame Rate and Tween Steps
Animation Loop and Speed
Animation properties
Animation smoothness
Animation Speed
Animations
Apply directly
Apply opacity mask
Apply soft group (Ctrl+Alt+G)
Apply/Remove ClipView (Q/Alt+Q)
Applying a bevel
Applying a contour to several objects
Applying a font from the Fonts Gallery
Applying a Live Effect
Applying a scaling factor
Applying a shadow
Applying a Text background color
Applying attributes to whole text stories
Applying Enhance
Applying Enhance transparency
Applying fill & line colors by drag & drop
Applying flat transparency
Applying graduated transparency
Applying presentation page transitions
Applying presentation step transitions
Applying settings to popup layers
Applying text attributes
Applying transitions to presentation step links
Applying transparency to several objects
Applying using the clipboard
Arrange Icons
Arrange menu
Arrange Views
Ask before setting current attribute
Attributes
Auto correction
Auto Enhance
Auto Levels
Auto-fit for individual page objects

99
643
486
123
389
336
468
240
612
515
648
532
527
526
536
535
519
290
642
642
642
294
305
269
384
58
298
192
267
370
287
191
284
284
507
506
444
259
506
288
290
649
641
649
610
16
229
367
393
113
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Index
Auto-fit to page...
Auto-fit to Page...
Auto-Fit to page...
Automatic addition of pages
Automatic Backups
Automatic fit
Automatic page linking
Automatic placeholder generation
Automatically flowing text areas
AVI Options

111
43, 619
648
47
51
549
487
512
221
527

B
Backup location
Backup open documents
Backup open documents on program close
Backups on system shut down
Backups Tab
Balancing curves
Bars
Baseline shift
Best fit
Bevel direction
Bevel Type & Size
Bevels
Bitmap coloring
Bitmap Compression
Bitmap fills
Bitmap Properties
Bitmap Quality
Bitmap Size tab
Bitmap Tracer
Bitmap transfer
Bitmap-Editor
Bitmaps
Bleed
Blending & Merging photos
Blending along a curve
Blends
Blends and PDF or PostScript files
Blur the edges of the shadow
Blur/Sharpen
Bold & Italic
Break
Break Shapes (Arrange control bar)
Breaking joined shapes
Brightness Curves
Brightness/Contrast/Color Temperature/Saturation/Hue
Bring to Front (Arrange control bar or Ctrl+F)
Browser Preview tab

52
52
53
54
620
142
16, 649
264
549
295
407
294
277
586
276
333
531
599
648
622
647
288, 628
42
335
319
314
319
299
368
259
646
643
168
395
367
641
601

Index
Brush styles
Brushes
Bullet Lists
Bulleted and Numbered lists
Button Bars (NavBars)
Button design restrictions
Button margins
Button order matches page order
Button spacing
Buttons & Menus

131
147
246
246
438
493
494
486
486
489

C
Cache Control
Cancel
Cascade
Change join type
Change line cap
Change object selection
Change the transparency of the shadow
Changing a straight line to a curve (and vice versa)
Changing background colors
Changing colors
Changing curves
Changing properties or removing a TOC
Changing step order
Changing text
Changing text into editable shapes
Changing the angle of the column
Changing the bevel color or fill effect
Changing the bevel join style
Changing the bevel light source
Changing the bevel shape
Changing the bevel size
Changing the blank template document
Changing the colors in a fill
Changing the contour attribute profile
Changing the contour color
Changing the contour join style
Changing the contour position profile
Changing the default display units
Changing the font on NavBar buttons
Changing the font size
Changing the light elevation (vertical angle)
Changing the light strength (contrast)
Changing the line width (thickness)
Changing the number of steps in a contour
Changing the page size
Changing The Page Size of Templates
Changing the ruler zero points

625
661
649
146
146
123
299
142
201
604
140
234
504
606
268
219
296
297
295
296
296
607
275
304
303
304
304
56
492
259
296
295
143
303
40
30
55
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Index
Changing the shadow color or fill effect
Changing the shadow profile
Changing the size of buttons
Changing the width of the column
Changing the zoom using the zoom InfoBar/control bar
Changing the zoom value
Changing the zoom value using the mouse
Chart SmartShapes
Charts
Check for updates
Check spelling as you type
Chevron Bar and Arrow SmartShapes
Clashes
Clear
Clear Mask or Region (Ctrl+D)
Clear Selection / Reset current attributes (Esc)
Click/Touch animations
Clickable area
Clickable Buttons & Mouse-over Effects
Clip to page edges
Clip Tool
Clipping in Photo Documents
ClipView
Clone (Ctrl+K)
Clone Tool Infobar
Clone Tool Operation Summary
Cloning
Close (Ctrl+W)
Closing a gallery
Closing the document
Collated
Color
Color Blend Effect
Color cast - fixing the white balance
Color Editor (Ctrl+E)
Color Handling
Color line context menu
Color Mode
Color Model
Color separating
Color Transforms—Animating Color Changes
Coloring photos
Colors on the color line
Colors on the screen and on the printer
Column breaks
Combine Shapes
Combine Shapes (Arrange control bar)
Combining shapes
Command categories
Commands

300
300
632
219
39
38
38
157
645
652
648
160
660
376
649
640, 649
421
451
541
453
375
377
104, 310
641
378
379
79
634
68
51
546
628
320
392
647
189
190
576
583
559
540
346
189
195
223
313
643
164
659
659

Index
Common photo functions
Compare & Restoring the original
Condensing and expanding characters (aspect ratio)
Conflicts in page layouts
Connecting text areas—text flow
Connection Type
Constraining the line
Content Aware Photo Resize
Content Aware photo scaling
Content Aware Scaling notes
Content-aware photo zoom
Contouring objects
Contours
Control bars
Control Bars
Convert Line to Shape
Convert to Editable Shapes (Arrange control bar Ctrl+Shift+S)
Converting an existing website into a presentation
Converting contours to shapes
Converting objects or drawings to bitmaps
Converting shadows to shapes
Coordinate Direction
Copy (Edit control bar or Ctrl+C)
Copying 3D extrude attributes
Copying and pasting pages
Copying Live Effects
Copying shadows onto other objects
Copying Shapes To The Mask Layer
Copying Styles
Paste Attributes
Copying text appearances
Copying/Pasting formatted text (RTF)
Copyright
Core Principles
Create Bitmap Copy (Ctrl+Shift+C)
Create Navigation Bar
Creating a graduated color fill
Creating a guideline
Creating a new brush
Creating a new unit
Creating a presentation
Creating a presentation from templates
Creating a shape
Creating a Soft Mask
Creating a Tint, Shade or Linked color
Creating a website
Creating animated GIFs
Creating circles and ellipses
Creating holes in shapes
Creating Live Copies

364
396
265
121
219
615
140
387
312
390
388
302
302
34, 629
649
643
643
503
305
357
300
614
639
409
46
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267
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665
521
643
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94
148
57
500
501
129
310
204
416
525
153
165
110
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Index
Creating new control bars
Creating new named colors
Creating new Styles
Creating Number and Bullet lists
Creating polygons and stars
Creating rectangles and squares
Creating Regions and Masks
Creating rounded corner rectangles
Creating RWD Websites from existing sites
Creating RWD Websites from templates
Creating Soft Groups
Creating the animation
Creating your own color schemes
Creating Your Own Mouseover Buttons
Creating your own Navigation Bars
Creating your own presentation from scratch
Crop and Printer’s Marks
Cropping photos
Cropping photos with a mask
Cropping photos with the Eraser Tool
Cropping, Clipping and Animation Size
Current attributes
Current layer always visible and editable
Custom fit
Custom Output Intent Profiles
Custom tab types
Custom tabs
Customize Key Shortcuts
Customizing Designer Pro
Customizing PDF export using advanced options
Cut (Edit control bar or Ctrl+X)
Cut, copy and delete with a mask
Cut, copy and paste
Cut, Copy, Delete
Cutting objects

631
198
255
505
161
152
308
152
412
411
98
526
197
440
493
501
591
342
342
342
533
102
609
550
593
236
235
648
607
581
638
78
76
311
78

D
Default Live Effect resolution
Default Locked effect resolution
Delete (Edit & Standard control bars or Delete)
Deleting a guideline
Deleting a scaling factor
Deleting a site navigation bar from a page
Deleting a step
Deleting a unit
Deleting control bars
Deleting images from the Gallery
Deleting named colors
Deleting objects

621
621
640
95
58
487
505
57
631
333
201
78

Index
Deleting objects from a step
Deleting points
Deleting presentation pages
Deleting repeating objects
Deleting sections from a gallery
Deleting Styles
Description
Deselecting an object
Designer Pro terminology
Display
Displaying & hiding control bars
Displaying a gallery
Displaying your own icons in browser tabs
favicons
Displaying/hiding rulers
Distorting Objects
Distribute
Dithering
Docked and free floating control bars
Document
Document Encryption and Permissions Password
Document Font embedding
Document handling
Document info
Document Info
Document Permissions Settings
Document type
Documents Loaded
Double page spreads
Double page spreads in multi-page documents
Double-click shortcuts to tools
Download content installer
Dragging the line segment
Drawing & editing straight lines
Drawing Lines and Shapes
Drawing straight segments in the Freehand Tool
Drawing Tools
Drop copy
Duplicate (Edit control bar or Ctrl+Alt+D)
Duplicate, Clone
Duplicating
Duplicating and cloning
Duplication distance

504
138
505
108
68
258
588
125
15
627
630
60
607
55
170
102
627
630
15, 619
595
271
32
15
638
595
612
651
545
44
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652
141
131
127
128
21
75
640
312
79
79
613

E
Easy crop
Edit menu
Edit Navigation Bars
Editing a Scatter brush
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469
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Editing an Art brush
Editing an object’s color
Editing Bitmaps
Editing existing widgets
Editing group contents
Editing inside
Editing inside an opacity mask group
Editing inside groups
Editing lines/shapes with the Freehand & Brush Tool
Editing List items
Editing mold shapes
Editing named colors
Editing Photo Files
Editing Photo Filter Presets
Editing photos
Editing polygons and stars
Editing Regions and Masks
Editing shapes
Editing SmartShapes
Editing stars
Editing text
Editing the contents of a repeating object
Editing the outline of Photos
Editing the parent color
Editing the shapes in a blend
Editing theme colors individually
Effect Painter Tool
Effects
Effects & Plug-ins tab
Embedded JPEG files
Embedding Graphics
Embedding movie, audio, animation and other files
Embedding Movies, Flash And Other Widgets
Enabling Supersites
Enhance
Enhance photo colors
Enhance Tool
Enhancing different colors
Entering dummy text ('Lorem Ipsum')
Entering special characters
Enveloping
Eraser tool
Erasing backgrounds
Erasing while drawing
Example
To resize a photo and save as a new JPEG
Example Graphics
EXIF Tool
Exit
Explore web space

150
192
622
512
96
495
291
96
129
248
175
201
359
349
604
162
309
385
155
163
226
107
341
205
319
604
380
620
620
334
244
513
482
471
287
368
365
373
228
227
174
401
402
128
662
340
23
400
638
480

Index
Export (Ctrl+Shift+E)
Export Animation
Export DPI
Export formats
Export image in slices (Ctrl+I)
Export JPEG
Export PDF
Export PNG
Export supersite
Export the graphic in slices
Export Website
Exporting a Flash File
Exporting a Photoshop PSD file
Exporting a Web document
Exporting a Website
Exporting animations as AVI
Exporting as a bitmap
Exporting as ArtWorks EPS
Exporting as AVI
Exporting as Designer Pro EPS
Exporting as Extended Metafile Format (EMF)
Exporting as Flash
Exporting as Illustrator EPS
Exporting as Microsoft XPS (XML Paper Specification)
Exporting as PDF
Exporting as Windows metafiles (.wmf)
Exporting files
Exporting HTML
Exporting PDF files
Exporting the animation
Exporting to a Word document
Exporting websites with support folders
Exports
Exports, slices, and stretches properties
Extend Selection
Extending a line
Extending the line
Extracting the original JPEG
Extrude Tool InfoBar
Extruding a shape
Extrusion depth

634
638
574
566
638
635
635
635
637
576
636
523
572
570
418
524
571
571
571
571
571
570
571
574
570
571
570
571
578
526
570
51
72
72
124
128
137
335
406
406
407

F
Fast Publish (Only changed files)
Feather
Feather Tool
Feathering
File Embedding
File menu

481
23
658
175
589
633

677

678

Index
File Open Password
Fill quality
Fill Tool
Fill Tool InfoBar
Filling shapes with a bitmap
Fills
Find & Replace
Find/Replace (Ctrl+Alt+F)
Fit Text to Curve/Remove Text From Curve
Fixed, non-scrolling backgrounds
Flash Embedding
Flash files
Flash Options
Flatten photo group
Flipping objects
Flowline SmartShapes
Fly-out menus
Font permissions
Font replacement
Fonts and PDF
Fractal fills
From Content Catalog (Shift+Alt+I)
Full Screen (8 on numeric keypad)
Full screen mode

594
548
22
273
333
75, 273
232
640
643
434
580
514
526
643
87
161
632
271
215
270
278
644
650
629

G
Galleries
Gallery cache
Gallery docking and undocking
General notes on exporting and importing
General Options
General tab
Getting Help
Getting Started
GIF Options
Give new objects most recent attributes (GNOMRA)
Gloss / Matt
Google fonts
Graphical Bullets and Numbered Lists
Grid and Ruler spacing
Grid and Ruler tab
Grid type
Group (Arrange control bar or Ctrl+G)
Group images
Group transparency on blends
Grouping and ungrouping objects
Grouping galleries
Guide Objects and Guidelines

60, 646
624
632
562
590
609
13
17
527
610
409
213
251
613
613
613
642
462
289
95
64
93

Index
H
Handle/resolution
Help
Help menu
Hidden Styles
Hiding buttons and tools
Hiding Layers and Objects
High resolution images
Highlighting text
Highlights brightness
Horizon Straighten
How to creating hanging indents
Hyphenation

288
651
651
258
632
187
414
259
368
352
237
229

I
ICC Profile Embedding
Image
Image Captions
Image Map tab
Image slicing
Image Tab
Imagesetting
Imagesetting dialog
Import (Ctrl+Alt+I)
Import and Export Supported File Formats
Import formats
Import from Web Address (Ctrl+Alt+W)
Important
Important notes when using PANTONE colors
Importing & pasting NavBars
Importing a Photoshop PSD file
Importing a Word document
Importing and Exporting
Importing files
Importing from a website
Importing named colors
Importing Photos
Indents and Outdents
Info pop-ups
InfoBar
Initial and final color tolerance
Initial Photo size
Initial View
Ink-level overprinting
Insert menu
Inserting
Inserting a Flash file into your webpage

593
644
461
600
576
457
551, 647
552
634
563
563
634
572
207
493
567
569
562
566
569
202
327
263
652
35
362
329
588
558
644
511
523

679

680

Index
Inserting a Table of Contents (TOC)
Inserting pages into your document
Inserting Symbols as graphics
Inserting Symbols into text
Inserting using a different web authoring tool
Installing or uninstalling a font
Instant font menu navigation
Integrated key shortcut utility
Integration with external Photo Editors
Internet Cache
Internet tab
Intersecting shapes
Introduction
Introduction to Xara Designer Pro X
Introductions...
Invert Mask or Region (Ctrl+Shift+I)

232
46
217
217
524
270
213
658
349
614
614
165
283, 519, 633
12
651
649

J
Join Shapes (Arrange control bar or Ctrl +J)
Joining shapes
Joining two lines
JPEG Quality
JPEG, PNG, GIF and BMP export dialog overview
Justification
Justification or text alignment

643
167
128
586
596
485
260

K
Keep Lines Together
Keep With Next Paragraph
Kerning
Key press
Key shortcuts

263
263
264
660
653

L
Language selection
Layer Operations
Layer ordering in website documents
Layer Properties
Layering Methods (standard PDF only)
Layers
Layers in PDF documents
Layers, Mouseover (Rollover) & Pop-ups
Legacy web browser compatible line lengths
Legal
Levels Tool notes
Ligatures

228
183
441
184
591
20, 180
183
438
611
665
396
260

Index
Lights
Limit to Browser palette
Line Gallery
Line spacing
Lines, shapes, and objects
Link Tab
Link to anchor
Link to File
Link to heading
Link to web address
Link to...
Linked colors
Linking to next/previous step
Links, Buttons & Navigation Bars
List Styles
Live Copies
Live Copies are Groups
Live copy
Live Effect resolution
Live Effects
Live Font Preview
Live Font Size preview
Load
Load / Save Translation
Local and Global Edits
Local colors and Theme colors
Locally Editable Widgets
Lock Aspect
Lock Aspect button
Locking effects
Locking Layers and Objects
Lorem Ipsum Text

408
195
144
262
16
447
449
449
449
447
448
204
505
437
253
109
109
644
386
384
212
213
661
634
109
196
512
377
85
385
187
645

M
Magnetic Lasso
Magnetic object snapping (snap to objects)
Magnetic Snap Radii
Main toolbar
Maintain imported layer names
Make groups be transparent as a whole.
Make Named Color local to Frame/Layer
Making a photo its full size
Making an object repel
Making shapes editable
Making sharp corners
Making smooth curves
Managing presentation steps
Manipulating documents
Manipulating objects

343
90
617
36
610
610
203
354
238
168
141
141
503
654
655

681

682

Index
Margins and indents
Marquee Object Selection
Marquee selection
Masks vs Photo Regions
Measurement units
Menu separators
Menu Styles
Menus and Keyboard Shortcuts
Merging several shapes into one
Millipoints
Minimum area
Mitred corner / Rounded corner
Mixing curved and straight lines
Mixing individual and group transparencies
Modifying a bevel
More about Xara Group
More Designer Pro
Mouse button function
Mouse tab
Mouseover (Rollover) Buttons
Mouseover Effects
Mouse-over features
Mouse-over properties (Web Animations)
Move Backwards (Arrange control bar or Ctrl+Shift+B)
Move Forwards (Arrange control bar or Ctrl+Shift+F)
Move To Layer Behind (Arrange control bar or Ctrl+Shift+D)
Move to Layer in Front (Arrange control bar or Ctrl+Shift+U)
Movies
Moving Anchored Objects
Moving and docking a gallery
Moving and transforming a site navigation bar
Moving buttons and tools
Moving objects
Moving Objects Between Layers
Moving objects forward and backwards
Moving objects from one step to another
Moving objects selected under or inside
Moving pages within the document
Moving point handles—Shape Editor Tool
Moving the start or end handle of the fill
MP3 files
MP4 & FLV movie files
Multi-column pages
Multi-page Documents
Multiple fit
Multiple Page View
Multiple variants
Multi-stage blends
Multi-stage color graduations
Multi-stage graduated transparency

235
611
123
307
56
490
491
633
165
56
362
409
136
289
294
664
651
616
616
440
439
420
464
641
641
642
641
651
243
61
487
632
74
188
80
504
125
47
138
276
514
514
222
44
550
649
411
317
279
285

Index
N
Names
Names applied
Naming objects
Naming pages
Navbars with different first or last buttons
Navigating between pages
Navigation bar properties dialog
Navigation Bars
Network button
New (Standard control bar or Ctrl+N)
New Effects Are Locked By Default
New from Content Catalog (Shift+Ctrl+Alt+K)
New Page
New page from template
New View
Nib size
Non-destructive editing
Non-destructive photo editing
Non-JPEG Bitmaps
Normal colors
Normal colors, Tints, Shades and Linked colors
Normal/full screen modes
Nudge size
Nudging objects
Number of copies
Numbered Lists

647
71
70
49
496
48
485
484
544
633
621
633
645
47
649
401
405
322
530
203
203
37
612
75
546
247

O
Object Based Design
Object Handling
Object level overprinting
Object types and Animation combinations.
Objects not supported by PDF
Offsetting the top of your page
OK
On canvas editing
On screen printer plate previews
Online editing in the Cloud
On-screen grid
Opacity Masks
Open (Standard control bar or Ctrl+O)
Open link in
Open recent
Opening a second window
Opening an animation document
Opening an existing document

19
74
558
423
578
435
661
492
551
34
54
289
633
451
633
37
526
33

683

684

Index
Operations That Use A Mask
Optimization on import
Optimize all Images
Optimize Photo
Optimizing images
Optimizing Photos and Bitmaps
Options
Options (Ctrl+Shift+O)
Options button
Options dialog box
Options in the Utilities menu
Options tab
Orientation
Origin (0,0 point)
Other
Other bitmaps Export dialog box
Other points to note
Other types of groups
Outer margin
Output Intent Profiles
Output Levels
Output Printer’s Marks
Overprinting

310
328
648
647
398
354
584, 586
648
545
56
608
600
42, 485
614
658
602
488
98
42
592
395
552
557

P
Page
Page & Layer Gallery
Page and Pasteboard Background Layers
Page background color
Page breaks
Page Generation
Page number
Page Options
Page Size
Page Size tab
Page Tab
Pages
Pages with different sizes and layers
Palette Options tab
Panorama Stitching
PANTONE® Colors
Paper
Paper size
Paragraph Spacing
Paragraph Styles and Character Styles
Passes
Paste (Edit control bar or Ctrl+V)
PDF Export
PDF Export Filter Settings

15, 619
49, 177
435
605
224
584
645
638
30
618
455
180, 545, 641
49
597
397
206
618
41
263
252
361
639
577

Index
Document Options
General Options
Layer Options
Objects Options
Pre-Press Options
Security Options
PDF Files
PDF Import
PDF Version compatibility
PDF versions
PDFs for import into Adobe Illustrator (V9 onwards)
Perimeter & Area
Perspective
Perspective Correction Tool
Photo clone tool
Photo Clone Tool
Photo display quality
Photo Documents
Photo Edit Attributes
Photo Editing
Photo enhance tool
Photo Filter Presets
Photo Grids
Photo Groups
Photo Handling
Photo Heal tool
Photo Objects
Photo pop-up
Photo Regions and Masks
Photo resolution
Photos
Photoshop Plug-ins
Placeholder objects
Placeholder Tab
Placing objects onto the Guides Layer
Polygons or stars with rounded corners
Pop-up layer
Pop-up Layers
Pop-up layers and presentation layers
Pop-up photo
Popup Photo Options
Pop-up slider controls
PostScript options
Preparing Your Photo
Presentation website
Pressure sensitive drawing
Preview Controls
Preview Flash
Preview in Browser
Preview supersite

588
583
590
585
592
594
515
568
583
578
582
87
172
399
312
377
338
358
340
621, 622
312
347
323
323
322
379
322
458
307
330
28, 530
620
467
464
94
162
450
441
508
450
459
366
555
388
453
130
597
637
527
636

685

686

Index
Preview web page (Shift + F5)
Preview Website
Previewing a Flash file in Xara Designer Pro X
Previewing and testing Auto-fit pages
Previewing Your Website
Previous & Next
Previous and Current color
Print (Ctrl+P)
Print As
Print button
Print Color Separations
Print films
Print layers
Print Options
Layout tab
Output tab
Print to File
Printer… button
Printing
Printing & color separating
technical details
Printing on all plates
Producing highlight effects
Profile
Profiles
Program Layout
Properties button
Proxy Server Settings
PSD Export settings
Publish supersite
Publish Tab
Publish Website
Publishing to an alternative web host
Publishing to Xara Hosting
Publishing variants
Push objects
Put to Back (Arrange control bar or Ctrl+B)

635
635
523
116
416
364
194
638
547
544
556
554
547
549
547
545
544
543
559
558
317
287
318
17
544
615
572
637
463
636
475
474
414
119
641

Q
Quality (Standard control bar)

650

R
Rasterization
Rasterization Resolution (DPI)
RAW photo import
Reader Display Setup
Recent files

575
586
569
589
610

Index
Recovering backups
Recovering from abnormal program closures
Redefining Text Styles
Redo (Standard control bar or Ctrl+Y)
Redraw
Register
Remove noise
Remove soft group (Ctrl+Alt+U)
Removing a bevel
Removing a ClipView
Removing a contour
Removing a shadow
Removing a standard blend
Removing an anchor
Removing blend from a curve
Removing blends
Removing objects from a group
Removing objects from the document
Removing pages from your document
Removing Soft Groups
Removing Styles
Renaming named colors
Re-ordering colors on the color line
Re-ordering items in the gallery
Repeating object
Repeating Objects
Repelling and Anchoring
Repelling text objects
Replace with Flash
Replace with graphic file
Replace with HTML code
Replacing Bitmap Fills
Replacing colors
Replacing photos
Replacing photos and removing presets
Reset
Resize, rotate and position a photo within its frame
Resizing a control bar
Resizing and re-positioning bitmap fills
Resizing color points
Resizing picture and text
Resizing text areas
Resizing widgets
Responsive web design
Restoring the default control bars/galleries
Retina (enabled by default)
Reveal & Scroll animations
Reverse path
Revisions
RGB and CMYK Blacks

54
53
254
638
624
652
362
642
297
105
306
301
321
243
321
321
96
78
48
98
257
201
190
67
644
106
644
237
465
465
466
277
199
328, 603
348
393
351
631
278
372
116
224
516
410
632
454
421
132
53
560

687

688

Index
Right-click context menus
Rotate by 90° controls
Rotating along a curve
Rotating by exact angles (using the InfoBar)
Rotating objects
Rotating objects in Resize Mode
Rotating using the mouse
Rotation
Rule-off
Rulers
RWD Variants and Backgrounds

24
364
319
83
82
83
82
537
645
55, 234
436

S
Save
Save (Standard control bar or Ctrl+S)
Save All
Save all (on the File menu)
Save As
Save as (on the File menu)
Save option (on the File menu)
Save Publish settings in document
Save Template
Saving & Exporting Photos
Saving & Exporting Your Work.
Saving and transferring files
Saving profiles
Saving the document
Scale Line Widths button
Scale photo to 100%
Scaling (resizing) objects
Scaling groups
Scaling Photos (web documents only)
Scaling tab
Scaling text areas and columns
Scaling using the InfoBar
Scaling using the mouse
Screen Capture
Screen capture utility
Screenshots
Scribble Selection
Searching for an item name
Select All (Ctrl+A)
Select clipped objects
Select clipping shape
Select inside
Select under
Selected document and title bar
Selecting a single object from within a group
Selecting all objects

333, 661
634
634
50
634
50
50
482
634
339
31
386
482
49
84
365
84
86
85
623
86
86
85
648
345
344
124
67
640
105
105
124
124
34
96
125

Index
Selecting and applying an effect
Selecting and layers
Selecting and setting up a printer
Selecting items
Selecting multiple point handles
Selecting objects
Selecting Objects
Selecting objects in the Clipview
Selecting Photos and SmartShapes
Selecting the black, gray and white points
Selecting the start or end object
Selecting the whole text object
Selecting with Soft Groups
Separations dialog
Setting a Bitmap Transparency
Setting the ClipView background color
Setting the page background to a bitmap
Shades
Shadow Tool
Shadows
Shadows brightness
Shape
Shape drawing tools
Shape editing
Shape Handling
Shape Painter tool
Share Menu
Sharing across variants
Show All & Unlock All
Show Document Tabs
Show Grid (#)
Show Guides (1 on numeric keypad)
Show Mask or Region (Standard control bar or Ctrl+M)
Show print borders
Show Print Borders
Show Printer Colors
Simple text
Simulating print colors on screen
Single button NavBars
Site navigation bar
Sketch Mode
Skewing objects
Slices
Slicing complex shapes
Slicing shapes
Sliding the document within the window
Smart Quotes
SmartShapes
Smoothing
Smoothing a line

381
125
543
67
138
123
122
105
125
392
316
227
125
555
333
105
333
204
23
298
367
645
152
404
152
132
648
413
187
650
650
650
649
543
650
650
218
552
488
486
130
171
72
166
166
39
227
154
363
139

689

690

Index
Snap to grid
Snap to Grid (. on numeric keypad)
Snap to Guides (2 on numeric keypad)
Snap to Objects (* on numeric keypad)
Snapping
Snapping and line widths
Snapping modes
Soft edged ClipView
Soft erase
Soft erasing using the Eraser tool
Soft Groups
Soft Groups and Layers
Soft Masks
Solo Mode
Special characters (in Text Tool)
Special Layers
Specifying colors in the Color Editor
Spell checker
Splitting a shape
Spot colors
Stacking Order
Standard keys / Classic keys
Starting a new document
Steps and layers
Sticky and Stretchy object combinations
Sticky Objects
Stop and Goto Commands
Stopping objects repeating
Stretches
Stretching and squashing objects
Stretchy Objects
Style Properties
Styles based on other styles
Subscript & superscript
Summary of shortcuts on the numeric keypad
Supersites
Supersites and PDFs
Support
Support folder contents
Support folder naming
Support folders
Swapping sides of the line
Switching case
Symbol
Symbols
Synchronising text across multiple text objects

89
650
650
651
88
89
92
105
403
291
98
183
310
187
658
186
195
228
142
551
20
661
32
498
430
425
541
108
73
87, 170
428
258
255
261
653
470
472
13
51
50
50
226
227
645
215
234

T
Table of Contents...

646

Index
Tabs
Tabs, Margins and Indents
Template Backgrounds and re-coloring backgrounds
Templates & Site navigation bars
Temporary key shortcuts
Text
Text along a curve
Text areas
Text Box
Text Handling
Text in a column
Text inside groups for websites
Text links
Text options
Text Panel Smartshapes
Text Strikethrough
Text Styles
Text Styles InfoBar
Text Synchronization
Text Tool
Text Underlining
The 6 core types of animation
The Animation Frame Gallery
The Anti-Alias button on the InfoBar
The Bevel Tool
The Bitmap Gallery
The Brightness Levels Dialog
The Color Editor in detail
The Color Gallery
The color line
The color models
The constrain key
The Contour Tool
The Current Layer
The current page
The Drawing tools
The Fill Gallery
The Fill Tool
The Font Menu
The Fonts Gallery
The Frame tab
The Freehand & Brush Tool
The galleries
The indicators
The InfoBar
The Local Designs Gallery
The Mold Tool
The MouseOff and MouseOver Layers
The Name Gallery
The number of steps

235
234
433
487
662
30, 573
225
219
645
209
218
266
266
548
159
259
251
252
99
657
259
520
528
318
294
331
390
193
205
189
196
59
302
181
46
127
280
273
211
268
526
127
654
36
123
27
172
439
68
318

691

692

Index
The Online Content Catalog
The Page & Layer Gallery
The Photo Region and Mask tools
The Photo Tools
The Presentation toolbar
The print dialog box
The Red Eye Tool
The redo command
The Rotate command
The Selector Tool
The Shadow Tool
The Shape Tool
The status line
The Straight Line & Arrow tool
The Text Tool
The tools
The undo command
Theme color schemes
Thumbnail Photos With Pop-ups
TIFF Import
Timeline SmartShapes
Tints
Tip of the Day
To add more objects to a group
To create a group
To draw a curved line segment:
To draw a straight line segment
To export a PDF file
To the end of a line:
To the middle of a line:
To the start of a line:
TOC Text Styles
Trace mode
Tracer
Tracking
Transparency
Transparency and color separations
Transparency and layers
Transparency resolution
Transparency Tool
Transparency types
Tune-ups tab
Turning extrudes on and off
Turning off placeholder re-generation
Turning site navigation bars on and off

25
177
308
364
500
544
382
73
537
122
298
134
36
131
209
653
73
197
442
568
156
203
651
95
95
136
135
580
137
137
137
233
361
360
264
283
559
573
548
22
285
624
407
517
487

U
Un-clip
Undo (Standard control bar or Ctrl+Z)

376
638

Index
Undo and Redo
Undo size
Ungroup (Arrange control bar or Ctrl+U)
Ungrouping objects
Ungrouping, editing and regrouping
Units tab
Untitled documents
Updating a Table of Contents
Updating Text Styles
Updating your NavBar across all pages
URLs in Flash
Use common website link colors
User dictionary
Uses of blends
Using a PANTONE color
Using an existing brush
Using contours to resize objects
Using galleries
Using masks or regions
Using Masks With Content Aware Scaling
Using multiple filters
Using photos as backgrounds
Using photos as fills
Using presets from the Local Designs Gallery
Using template Navigation bars
Using Templates & Clipart
Using Templates, Clipart & Widgets
Using the Blend Tool
Using the curve handle
Using the Eraser Tool
Using the eye-dropper to pick colors
Using the Photo Tools
Using the text boxes on the InfoBar
Using the Zoom Tool
Using Web Animations
Using Windows to capture screenshots
Utilities menu

73
624
642
95
495
626
53
234
254
492
540
451
229
314
207
147
305
65
371
389
348
434
328
347
484
25
416
315
140
401
194
364
139
38
419
344
646

V
Variable width lines
Variants and Navigation bars
Variants and repeating objects
Vertically aligned text
View quality slider
View tab
Viewing a scaled photo at its full size
Viewing blends as outlines
Viewing print colors on screen
Viewing step contents

144
414
413
223
58
627
354
320
208
504

693

694

Index
Viewing the anchor point

243

W
Web Properties (Ctrl+Shift+W)
Web Animations
Web Editable Widgets
Web Export Options
Web Graphics and Websites
Web image type
Web Properties Dialog
Web Safe Fonts
Web Sticky and Stretchy Objects
Website Backgrounds
Website font embedding
Website Link Colors
Website Presentations
Website Publishing
Website Tab
Website Toolbar
Website Variants
Website Widgets
Welcome to Xara Designer Pro X
What Flash can and cannot do
What Xara Designer Pro X features does Flash support?
What you can't do with Xara Designer Pro X Flash
Widget site membership
Widgets & placeholders – it’s all automatic!
Widgets from other widget sites
Widgets from the Online Content Catalog
Width / Height
Window menu
Within
Word and other files
Word compatible line spacing
Word count
Working with Templates

647
419
510
454
410
462
445
212
425
431
271
453
498
474
452
415
647
510
12
519
538
521
512
510
516
510
376
649
100
515
612
225
603

X
X/Y co-ordinates
Xara Designer Pro X help
X-Process effect

37
651
368

Y
Your First Animation

521

Index
Z
Zero-memory Copies
Zoom 1
1 365
Zooming
Zooming / Scrolling / Pushing your page

331
654
18

695

